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Chapter 1

Introduction

This documentation is intended for administrators who are responsible for configuring and 
deploying the Tungsten Printix Cloud Print Management Service for flexible, secure, and mobile 
printing.

If you are not an administrator, see the Printix User Help.

Quick links
Use these links to quickly locate details about typical tasks:
• How Printix works
• Getting started
• Next steps
• Understanding networks
• How to

• How to deploy Printix Client with Microsoft Endpoint Manager
• How to print from home office

• Sign in issues
• Product Support

What is new?
To see what changed:
• Visit our product documentation page to see the latest Release Notes.
• In Printix Administrator, select the Speaker  icon on the left edge of the screen.

The icon is not visible if nothing changed since your last visit or if you already viewed the news.

Features
Make printing part of your cloud-first strategy with Printix Cloud Print Management Service. Instead 
of print servers, use an automated print infrastructure.
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Printix supports Single Sign-On with Microsoft Entra ID and can be deployed with Microsoft 
Endpoint Manager.

Our powerful cloud technology and innovative client technology are scalable by design and can 
handle any number of users and printers. Printix gives you flexible, secure, and mobile printing, and 
you can automate print driver and queue management and eliminate the need for a print server.

• Serverless print infrastructure.
Printix can handle multiple sites and separate networks. You do not have to concern yourself with 
print server scalability, capacity planning, and VPN. Manual effort is not required to maintain the
Printix Client, because it silently updates itself to the latest approved version. Print processing is 
done locally on the computer, so no additional network traffic is needed to transfer print data to a 
print server. The Printix Client can convert existing print queues.

• Driver store: Central print queue and print driver management with driver store in the cloud.
Printix maintains a global driver store with Windows and macOS print drivers. When you start to 
use the Printix Client, it automatically uploads print drivers and puts them in your Printix driver 
store. If no dedicated print driver exists for a particular printer, an appropriate Universal print 
driver is used.

• Microsoft integration and Google integration.
• Authentication with identity providers: Okta and OneLogin.
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• Central web-based management.
With Printix Administrator, you can configure Printix and centrally manage your printers, print 
queues, and print drivers from a web browser. Minutes after a printer has been unboxed and 
connected, it can be added to Printix through phone, tablet, and computer. You can have print 
queues automatically added and removed on users' computers and you can set default printer.

• Delegated print management.
Delegate the responsibility for the management of printers and print queues to the IT personnel 
at the local site by giving them the site manager role.

• Self-service.
Automatic registration of users the first time they sign in to Printix with their Microsoft or Google 
Workspace account. If needed, you can use groups to grant exclusive access to printers and 
deploy printers based on users' group membership. We promote self-service to users, so they 
can add the printers they need to work efficiently. That way, you do not have to deal with group 
policies for printing.

• Easy printer identification.
Printers are easily identified by their three-letter ID. Users do not need to know the printer's IP 
address, share name, or print driver. To make it easy for users to identify printers, you can print 
and mount printer ID signs with QR codes at the printers or mount NFC tags at the printers.

• Secure print.
Supports printing confidential documents. Wait until you are at the printer, then use the Printix 
App on your phone to release your documents. The Printix App is available as an app for Android 
and iOS/iPadOS phones and tablets, and as a web app that runs in a web browser on your phone, 
tablet, and computer. If Printix Go is installed on the printer, you can sign in with card or ID code 
and release documents from the touchscreen control panel of the printer.
• Secure print methods

• Print Later
The ideal method if you need to print confidential documents with finishing options and 
want to ensure your documents print exactly as intended. The document is processed using 
the matching print driver. The document stays in the print queue until you release the 
document. The document can only be released at the selected printer.

• Print Anywhere
With Printix Anywhere, you can roam between printers and release the document at the 
printer you choose. When you submit a document to the Printix Anywhere print queue, 
your document is always kept until you release it. Document is sent as PDF, unless the 
printer does not support PDF printing or Process PDF/XPS is selected. In this case, the 
PDF document is processed using a matching print driver. For users who do not care about 
finishing options, the Printix Anywhere print queue could very well turn out to be the only 
one they need on their computer.

• Must print securely
• Prevent users from submitting documents directly to printers.
• Can be set for all users or users in a group.

• Print Later by default
• Make Print Later the preferred print method.
• Can be set for all users or users in a group.
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• Secure print levels
• Ensure that users are physically present at the printer to release their documents. You can 

require users to identify the printer by scanning the printer's QR code (level 1), NFC tag (level 
2), or by signing in at the printer (with card or ID code) (level 3).

• A minimum secure print level can be set for all users. By default (level 0), users can select a 
printer in the Printix App on their phone, tablet, or computer.

• A higher secure print level can be set for users in a group.
• Reprint.

From your phone or tablet, you can reprint those of your documents that were deleted or printed 
within the previous 12 hours. Even documents you printed directly to the printer can be reprinted 
without going back to your computer and submitting them again.

• Mobile print.
Print from phones and tablets, Android and iOS/iPadOS, to Printix-managed printers enabled for
mobile print.

• Home office printing.
Let employees print on their own printers when working from home on their company laptop. 
This gives employees the flexibility to review, make notations, and proofread documents on 
paper rather than on the screen.
• Data is collected showing what was printed on the printer at home, and can optionally be used 

to reimburse the employee for printing.
• Any existing print queue for the home printer remains untouched and can be used for 

personal printing (data is not collected).
• Capture and workflow.
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On specific MFPs with Printix Go, you can enable and use Printix Capture to deliver scanned 
documents to your selected workflow destination. Alternatively, use the Printix App on your 
phone to capture and deliver images to your selected workflow destination. Tungsten Optical 
Character Recognition (OCR) cloud technology is used to digitize your paper documents and 
deliver them as searchable PDF or Microsoft Word files. Workflow destinations include:
• Connector
• Email
• Microsoft OneDrive
• Microsoft SharePoint Online

Use Printix Administrator to create workflows. A workflow can be made available for all users or 
users in a group.
See also: How to get started with capture and workflow

• Cloud storage.
Optionally, set up and use your own secure cloud storage to store pending documents. 
Documents printed through the cloud or with mobile print from phones and tablets also go 
through your cloud storage.
• Azure Blob Storage
• Google Cloud Storage
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 Captured documents cannot be stored in Google cloud storage. We recommend that you 
use Azure blob storage to avoid getting errors.

• Analytics and reports.
Set up analytics so you can interact with the Printix Power BI report to get insights.

• Cloud Print API.
Intended for use by applications that wish to push print jobs in printer-native or PDF format into 
a Printix print queue, and for organizations who want to manage guest users. You can access the 
API documentation at printix.github.io.

• Supports Windows, Mac, and Chrome OS.
• Print from phones and tablets, Android and iOS/iPadOS.
• Print from Linux computers through Chrome browser.
• Release documents from phones, tablets, and computers.
• Use a phone to scan the printer's QR code or NFC tag.
• Sign in at the printer (with card or ID code) to release documents and access MFP functions, 

such as copy, email, and scan.
• Supports Azure Virtual Desktop, Citrix and RDS.
• Supports zero trust networks.
• Integrates with Universal Print by Microsoft.
• Product Support.

Visit our Knowledge Base to find our guides and FAQ. You can also contact Product Support if you 
have any questions.

• Additional information.
• Pricing
• Terms of service (end-user license agreement)
• Privacy policy
• Printix Security and Privacy
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Microsoft integration

Sign in with Microsoft
• Users are automatically registered the first time they sign in with Microsoft to Printix.
• Single sign-on (SSO) is used when users sign in to Printix with a Microsoft account.
• Supports multiple Microsoft Entra directories per Printix Home.

• Printix Home is the term for what we create for you when you start to use our Printix Cloud 
Print Management Service. In technical cloud terms, this is also referred to as your tenant. 
Printix Home also refers to the internet address used to access your Printix Home in a browser. 
The address acme.printix.net is an example of a Printix Home.

• Supports Microsoft Entra Conditional Access.
• Supports Microsoft Entra guest users, also known as Microsoft Entra business-to-business (B2B) 

collaboration users.
• Users' department is recorded and can be used to post process data for subsequent 

departmental billing.
• If you delete a user in Microsoft Entra ID, the user is also deleted in Printix if Microsoft Entra 

groups are enabled.
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• If you block sign-in for a user in Microsoft Entra ID, the user is signed out from Printix and is not 
able to sign in until the user's account is unblocked in Microsoft Entra ID.

• Administrators can accept Printix for all users.
• Sign-in to the Printix Client is automatic on Microsoft Entra joined Windows 10 and 11 computers 

and works with the Pro, Enterprise, and Education editions. Microsoft does not support Microsoft 
Entra join on Windows Home editions.

• Sign-in to the Printix Client is automatic on Microsoft Entra joined Windows Server 2016, 2019, 
and 2022.

Microsoft Entra enterprise applications and permissions
The Microsoft integration involves adding the following Microsoft Entra enterprise applications.

Do NOT change the privileges of these applications, because it may break functionality.
• Printix: Required to enable Microsoft Entra authentication (signing in with Microsoft).

Required permissions:
• Email - Delegated - View users' email address.
• OpenId - Delegated - Sign users in.
• Profile - Delegated - View users' basic profile.
• User.Read - Delegated - Sign in and read user profile.

• printix-cloud-sync: Required to enable and synchronize Microsoft Entra groups.
Required permissions:
• Directory.Read.All - Application - Read directory data.
• Group.Read.All - Application - Read all groups.
• Member.Read.Hidden - Application - Read all hidden memberships.
• User.Read - Delegated - Sign in and read user profile.
• User.Read.All - Application - Read all users' full profiles.

• Printix Universal Print: Required to integrate with Universal Print by Microsoft.
Required permissions:
• Printer.FullControl.All - Delegated - Register, read, update, and unregister printers.
• Printer.ReadWrite.All - Application - Read and update printers.
• PrinterShare.ReadWrite.All - Delegated - Read and write printer shares.
• PrintJob.ReadWrite.All - Delegated - Read and write print jobs.
• PrintJob.ReadWrite.All - Application - Read and write print jobs.
• PrintTaskDefinition.ReadWrite.All - Application - Read, write and update print task definitions.
• User.Read - Delegated - Sign in and read user profile.
• PrinterProperties.ReadWrite - Delegated - Read and write the properties and attributes of 

users' printers.
• PrinterProperties.ReadWrite - Application - Read and write the properties and attributes of 

printers.
• Printers.Read - Application - Read printers.
• PrintJob.Read - Application - Read the metadata and payload of users' print jobs.

• Printix Capture OneDrive: Required to create a capture workflow for Microsoft OneDrive.
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Required permissions:
• Files.ReadWrite.All - Application - Read and write files in all site collections.
• User.Read - Delegated - Sign in and read user profile.

• Printix Capture SharePoint: Required to create a capture workflow for Microsoft SharePoint 
Online.
Required permissions:
• Sites.ReadWrite.All - Application - Read and write items in all site collections.
• User.Read - Delegated - Sign in and read user profile.

• Azure Blob Storage: Uses access keys for Azure Blob Storage to generate Shared Access 
Signatures (SAS) signed read, write, and delete links for the Azure Blob Storage.

Deploy with Microsoft Endpoint Manager
• Deploy Printix Client for Windows (MSI file) and Printix Client for Mac (PKG file) with Microsoft 

Endpoint Manager.
• Optionally, postpone sign-in to the Printix Client until restart. This method can be used 

to install Printix Client as part of an automated process (such as Windows Autopilot) that 
completely configures a new computer before it is delivered to the user. This way, sign-in is 
postponed until the user starts to use the computer.

• Deploy Printix App for Android and Printix App for iOS/iPadOS with Microsoft Endpoint Manager.

Microsoft Entra groups
• Use Microsoft Entra groups to control access to printers/capture workflows and deploy printers 

based on users' and computers' group membership. Nested groups are not supported.
• Users' and computers' membership of groups is maintained in Microsoft Azure

(portal.azure.com).
• Print queue/group membership is maintained in Printix Administrator by adding groups to 

print queues.
• A print queue that has Exclusive access selected can be accessed ONLY by users in the 

configured groups. This is based only on users' group membership, and not on computers' 
group membership.

• A print queue that has Add print queue automatically selected is automatically added to the 
computer when a user from the configured groups signs in.

• A printer that has Set as default printer selected becomes the default printer for the users 
and computers in the configured group.

Eliminate print server
• Serverless print infrastructure.
• With Printix Administrator, you can configure Printix and centrally manage your printers, print 

queues, and print drivers from a web browser. You can have print queues automatically added 
and removed on users' computers.

• Printix maintains a global driver store with Windows and macOS print drivers. When you start to 
use the Printix Client, it automatically uploads print drivers and puts them in your Printix driver 
store.

33

https://portal.azure.com/


Tungsten Printix Administrator Guide

Azure Virtual Desktop
• Supports Azure Virtual Desktop.
• Supports zero trust networks.

Universal Print
• Integrates with Universal Print by Microsoft.
• Supports Microsoft Dynamics 365 Business Central.

Set up Business Central to use Printix printers (print queues) published with Universal Print by 
Microsoft and thereby print through Printix and use, for example, Secure print.

Secure print
• Supports printing confidential documents. Wait until you are at the printer, then use the Printix 

App on your phone to release your documents.
• The Printix App is available as an app for Android and iOS/iPadOS phones and tablets, and as a 

web app that runs in a web browser on your phone, tablet, and computer.
• If Printix Go is installed on the printer, you can sign in with card or ID code and release 

documents from the touchscreen control panel of the printer.

Mobile print
• Print from phones and tablets, Android and iOS/iPadOS, to Printix-managed printers enabled for

mobile print.

Cloud Print API
• Intended for use by applications that wish to push print jobs in printer-native or PDF format into 

a Printix print queue, and for organizations who want to manage guest users. You can access the 
API documentation at printix.github.io.

Azure Blob Storage
• Enable storage of pending documents in your secure Azure Blob Storage.

• Documents printed through the cloud or with mobile print through phones and tablets 
(Android and iOS/iPadOS) also go through your cloud storage.

Microsoft Power BI
• Set up analytics so you can interact with the Printix Power BI report to get insights.

Available on Microsoft storefronts
• Printix is a preferred solution in Azure AppSource and Marketplace.

Sign up via Microsoft AppSource
1. Sign in to appsource.microsoft.com.
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2. In the search box, enter printix.
3. In the results pane, find Printix Cloud Print Management and select Free trial.
4. If you agree to the terms, select Continue.

You are taken to Printix to complete the setup.
5. When prompted, sign in with your work account.
6. If prompted, select Accept to grant permissions to Printix.

If you see the check box Consent on behalf of your organization, it is because you have 
the global administrator role in Microsoft Entra ID and Printix has not yet been accepted for 
all users. Select Consent on behalf of your organization so Printix can have access to the 
specified resources for all users in your organization. No one else is prompted.

7. Complete the steps presented by the Setup assistant.

Sign up via Microsoft Azure Marketplace
1. Sign in to azuremarketplace.microsoft.com.
2. In the search box, enter printix.
3. In the results pane, find Printix Cloud Print Management and select Free trial.
4. If you agree to the terms, select Continue.

You are taken to Printix to complete the setup.
5. When prompted, sign in with your work account.
6. If prompted, select Accept to grant permissions to Printix.

If you see the check box Consent on behalf of your organization, it is because you have 
the global administrator role in Microsoft Entra ID and Printix has not yet been accepted for 
all users. Select Consent on behalf of your organization so Printix can have access to the 
specified resources for all users in your organization. No one else is prompted.

7. Complete the steps presented by the Setup assistant.
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Google integration

Sign in with Google
• Users are automatically registered the first time they sign in with Google to Printix.
• Single sign-on (SSO) is used when users sign in to Printix with a Google Workspace account.
• Supports multiple Google domains per Printix Home.

• Printix Home is the term for what we create for you when you start to use our Printix Cloud 
Print Management Service. In technical cloud terms, this is also referred to as your tenant. 
Printix Home also refers to the internet address used to access your Printix Home in a browser. 
The address acme.printix.net is an example of a Printix Home.

• If you delete a user in Google Workspace, the user is also deleted in Printix if Google groups are 
enabled.

• If you suspend a user in Google Workspace, the user is signed out from Printix and is not able to 
sign in until the user's account is not suspended in Google Workspace.
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Deploy with an MSI file
• Deploy the Printix Client with any tool that supports MSI.

• Optionally, postpone sign-in to the Printix Client until restart. This method can be used 
to install Printix Client as part of an automated process that completely configures a new 
computer before it is delivered to the user. This way, sign-in is postponed until the user starts 
to use the computer.

Printix Chromebook
With Printix Chromebook, you can:
• Print to Printix-managed printers from Chromebooks and computers with Google Chrome.
• Deploy Chromebook with the Google Admin console (admin.google.com).

Google groups
• Use Google groups to control access to printers and deploy printers based on users' group 

membership. Nested groups are not supported.
• Users' membership of groups is maintained in your Google Admin console (admin.google.com).
• Print queue/group membership is maintained in Printix Administrator by adding groups to 

print queues.
• A print queue that has Exclusive access selected can be accessed ONLY by the users in the 

configured groups.
• A print queue that has Add print queue automatically selected is automatically added to the 

computer when a user from the configured groups signs in.
• A print queue that has Set as default printer selected becomes the default printer for the 

users in the configured group.

 If you need help to set up a group of computers with Google groups, contact Product Support.

Eliminate print server
• Serverless print infrastructure.
• With Printix Administrator, you can configure Printix and centrally manage your printers, print 

queues, and print drivers from a web browser. You can have print queues automatically added 
and removed on users' computers.

• Printix maintains a global driver store with Windows and macOS print drivers. When you start to 
use the Printix Client, it automatically uploads print drivers and puts them in your Printix driver 
store.

Secure print
• Supports printing confidential documents. Wait until you are at the printer, then use the Printix 

App on your phone to release your documents.
• The Printix App is available as an app for Android and iOS/iPadOS phones and tablets, and as a 

web app that runs in a web browser on your phone, tablet, and computer.
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• If Printix Go is installed on the printer, you can sign in with card or ID code and release 
documents from the touchscreen control panel of the printer.

Mobile print
• Print from phones and tablets, Android and iOS/iPadOS, to Printix-managed printers enabled for

mobile print.

Cloud Print API
• Intended for use by applications that wish to push print jobs in printer-native or PDF format into 

a Printix print queue, and for organizations who want to manage guest users. You can access the 
API documentation at printix.github.io.

Google Cloud Storage
• Enable storage of pending documents in your secure Google Cloud Storage.

• Documents printed through the cloud, from Chromebooks, or with mobile print through 
phones and tablets (Android and iOS/iPadOS) also go through your cloud storage.

Google Cloud Partner
• Printix is a Google Cloud Partner.
• Printix is Chrome Enterprise Recommended.

How Printix works
The Printix Cloud Print Management Service is established by deploying the Printix Client on your 
computers (Windows and Mac).

Print driver management
Any printer discovered on your network is displayed to you in our web interface, the Printix 
Administrator. Your configuration data is stored securely in your Printix Home in the cloud, and so 
are print drivers that Printix Client uploads to your Printix driver store. Your Printix Client only works 
with your Printix Home, and users are required to sign in before use.

Print-ready convenience
• Automatically add and remove print queues.
• Add, modify, and delete print driver configurations to configure:

• Device settings (Paper trays, Duplexer, Stapler, Hole punch, and Output bins)
• Printing defaults (Finishing options, Print 2-sided, and Print in black)

• Set default printer.
• Remotely add, update, and delete Printix-managed print queues.
• Use groups to deploy and grant exclusive access to printers based on users' group membership.
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Printing
The secure and flexible methods of printing with Printix are achieved by having the Printix Client 
temporarily store print data encrypted on the computer and informing the Printix Cloud about the 
document. Users can print directly (as usual) or they can print securely and release documents from 
the Printix App on their phone, tablet, and computer. On printers with Printix Go, users can sign in 
with card or ID code and release their documents. Pending documents can also be stored in your 
own, secure cloud storage (Azure Blob Storage or Google Cloud Storage).

Behind the scenes, the process of releasing a document is as follows:

1. The Printix App sends a request to the Printix Cloud to release the document.
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The user's record of pending documents is analyzed to determine where the document is 
stored.

2. Printix Cloud forwards the request to the Printix Client on the user's computer.

3. The Printix Client on the user's computer decrypts the print data and sends it to the designated 
printer.

Capture and workflow
On specific MFPs with Printix Go, you can enable and use Printix Capture to deliver scanned 
documents to your selected workflow destination. Alternatively, use the Printix App on your phone 
to capture and deliver images to your selected workflow destination. The scanned documents 
are encrypted while they are delivered and stored. Tungsten Optical Character Recognition (OCR) 
cloud technology is used to digitize your paper documents and deliver these as searchable PDF or 
Microsoft Word files. Workflow destinations include connector, email, Microsoft OneDrive, and
Microsoft SharePoint Online.

See also: How to get started with capture and workflow.

Security and data protection
While you manage your printers and use our Printix Cloud Print Management Service, we 
register necessary information. This is typically the information you can see either directly or in a 
processed format in Printix Administrator.

Tungsten has ISO/IEC 27001 certification, the internationally recognized standard for information 
security management systems (ISMS).

 Printix meets the exacting compliance requirements of General Data Protection Regulation 
(GDPR).

White paper: Meeting Data Security and Compliance Requirements Using a Smart Cloud Print 
Infrastructure (PDF, 12 pages)

Guide: Printix Security and Privacy Guide (PDF, 11 pages)

• What data is registered in the Printix Cloud?
• Personally Identifiable Information

• Data centers
• Documents
• Communication
• Printing
• Capture and workflow
• Printix Client
• Authorization
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• Authentication
• Authentication flows for Microsoft, Google, and Chrome

What data is registered in the Printix Cloud?
• Printers: Address, vendor, model name, name, MAC address, serial number, properties, page 

counters, consumables data, and statistics.
• Computers: Address, host name, type (laptop, desktop, or server), system (Windows or macOS).
• Networks: Gateway IP and MAC addresses.
• Documents: Name, number of pages, color, 2-sided, and where and when it was submitted, 

printed, and deleted.
• Users:

• Name (for passwords, see Authentication below)
• Email
• Role (user or system manager)
• Department (Microsoft Entra ID only, and can be used to post process data for subsequent 

departmental billing)
• Groups (only the group memberships relevant to Printix functionality are recorded)

Personally Identifiable Information
• Personally Identifiable Information (PII) in the form of a users' name, email, and document 

names are stored in the Printix Cloud. The job history keeps document names for 90 days to 
facilitate Printix troubleshooting. In Printix App and Printix Administrator, users (and system 
managers) can only see the document names of their own documents, and only while the 
document is pending to be released (typically 1 day and maximum 7 days).

• If you enable Cloud storage, the name of pending documents and their users are stored as part 
of the documents' metadata.

• Setting up Analytics with your own Azure SQL database also populates users' name and email 
into the database. Document names are only populated if "Include document name in data 
extract" is selected.

Default setup Custom setup

Printix Cloud + User name and email
+ Document name (90 days)
+ Document files, transit only, no 
storage [1]

+ User name and email
+ Document name (90 days)
- Document files, no transit, no 
storage

Cloud storage N/A + User name (max 7 days)
+ Document name (max 7 days)
+ Document files (max 7 days)

Analytics
Own SQL database

N/A + User name and email
+ Document name (Optional)

[1] Mobile-printed and Chrome-printed documents to be released (with Print Anywhere or Print 
Later) are stored in the Printix Cloud.
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Data centers
Printix is hosted in the EU.
• Secure Microsoft Azure Data Center in the Netherlands [West Europe].

• Configuration data and micro services:
• https://api.printix.net
• https://auth.printix.net
• https://airprint.printix.net
• wss://websocket.proxyendpoint.printix.net

• Secure Amazon Web Services Data Center in Ireland [AWS EU-West-1]. Content Delivery Network 
(CDN) is enabled.
• Captions and graphics

• https://assets.printix.net
• Driver store

• https://drivers.printix.net
• Software packages

• https://software.printix.net
• Web servers for Printix Administrator and Printix App

Example: acme.printix.net. Alias for:
• https://app.printix.net

• Web servers for signing in
• https://sign-in.printix.net

Documents
• Documents are encrypted and stored until they expire and/or get deleted.
• Documents do not leave your network, unless you enable additional functionality or print

through the cloud.
• Documents that go through your own Cloud storage are protected by time- and session-

restricted credentials issued by Printix Cloud. The Printix Client does not store cloud storage 
credentials/keys.

• Advanced Encryption Standard (AES) with a key length of 256 bits is used to encrypt documents.

Communication
• All Printix communication inside and outside the network is secured with encryption and the use 

of HTTPS. TLS 1.2 is used.
• SNMP is used to collect information from printers. Both SNMPv1 and SNMPv3 are supported.
• Print data is sent unencrypted to the printer, but with secure IPPS, it can be sent encrypted to 

printers that support secure IPPS.

Printing
• Printing directly to the printer is just as secure as traditional network printing.
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• With secure print (Print Later or Print Anywhere), you can wait until you arrive at the printer, 
then release the documents using your phone. That way, you prevent others from collecting your 
confidential and sensitive documents.

• With Printix Go, you can sign in at the printer with your card or ID code to release documents. 
Increase security with a 4-digit PIN code for two-factor authentication.
• The message "PIN code disabled" appears after three consecutive, failed sign-in attempts. 

In this case, the user must open the Printix App, reset the PIN code, and enter a new and 
different value. Otherwise, the Printix App displays "The new PIN code must be different from 
the previous one".

Capture and workflow
• Documents scanned with Printix Capture are encrypted while they are transferred to and from 

the Printix Client over HTTPS and also while they are stored.
• Optical Character Recognition (OCR) and conversion to searchable PDF or Microsoft Word file 

happens in the Printix Cloud.
• If an own cloud storage is used, captured documents are sent through your cloud storage. 

After processing (OCR) in the Printix Cloud, the document is written to your cloud storage, and 
from there, it is read by the Printix Cloud destination service and delivered to the destination. 
Capture with mobile requires that you set up Azure Blob Storage for CORS (Cross-origin Resource 
Sharing).

• Captured documents are automatically deleted from cloud storage after 7 days (168 hours).

Printix Client
• The user interface of the Printix Client (PrintixClient.exe) runs under the signed in user's account.
• Printix Service (PrintixService.exe) runs under the local system account and handles the printing 

and the printer installation.
• Both applications write log files.
• The Printix Client silently updates itself to the latest approved version.
• Documents scanned with Printix Capture are encrypted while they are transferred to and from 

the Printix Client over HTTPS and also while they are stored.

Authorization
• Printix uses roles to control what functions a user can perform.
• Users are notified by email when their role is changed.

Authentication
• Users are required to register and sign in to use Printix.
• With Microsoft Entra authentication enabled, users' passwords are handled entirely by Microsoft 

Entra ID.
• Printix reads the users' basic profile (displayed name and email address).

• With Google authentication enabled, users' passwords are handled entirely by Google.
• Printix reads the users' basic profile (displayed name and email address).
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• With OIDC authentication enabled, users' passwords are handled entirely by OIDC.
• Printix reads the users' basic profile (displayed name and email address).

• With Okta authentication enabled, users' passwords are handled entirely by Okta.
• Printix reads the users' basic profile (displayed name and email address).

• With OneLogin authentication enabled, users' passwords are handled entirely by OneLogin.
• Printix reads the users' basic profile (displayed name and email address).

• With Active Directory authentication enabled, users' passwords are not stored by Printix, but can 
be transferred securely with LDAPS to the local Active Directory server for authentication.

• For users who authenticate directly with Printix, passwords are protected through salted 
password hashing. Users can reset their passwords for themselves if they have an email address. 
Passwords must be minimum 6 characters in length and contain uppercase letters, lowercase 
letters, and digits.

• When signing in at the printer is involved (with card or ID code), the registered card numbers and 
PIN codes are protected through salted hashing. ID codes are written as plain text.

Authentication flows
• Microsoft Entra ID

Authentication flow Microsoft Entra ID (HTTPS:443)
• Google Workspace
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Authentication flow Google (HTTPS:443)
• Chromebook
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Authentication flow Chromebook (HTTPS:443)

Network ports
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Secure communication

All Printix communication inside and outside the network is secured with encryption and the use of 
HTTPS (SSL/TLS). Documents are stored encrypted until they expire or get deleted. Documents do 
not need to leave your network.
• HTTPS on TCP port 443

Secure browser communication between the components and identity providers, such as 
Microsoft Entra ID, Google Workspace, Okta, and OneLogin.

These ports must be open within the network:
• SNMP on UDP port 161

Access and collect information from printers through SNMP. Both SNMPv1 and SNMPv3 are 
supported. ICMP message requests and replies must be allowed on the local network, because 
the ping command is used to discover printers.

• RAW print on TCP port 9100
Transfer print data to the printers. Computers with Printix Client must be able to reach the printer 
on the network to allow printing. Print data can also be sent through:
• IPPS and TCP port 443, 631. Use of other port numbers is also supported.
• IPP and TCP port 80, 631. Use of other port numbers is also supported.
• LPR and TCP port 515. Use of other port numbers is also supported.

• TCP port 21335
Forward print data to another computer running Printix Client. Encrypted. It is only used if a 
computer is used for bridging two known networks.

• TCP port 21336
Secure communication to Printix Redirector on a Windows Server.

• UDP port 21337
Printix Discovery Protocol is used to find computers running Printix Client. Not encrypted.

• UDP port 5353
If mobile print is enabled, and is to be used with iOS/iPadOS phones and tablets, then Printix 
Client will broadcast AirPrint printers with the Bonjour networking protocol (Multicast DNS).

The Printix Client requires these ports to be open on the local computer:
• TCP port 21338

Secure communication locally on the computer between the PrintixClient.exe and 
PrintixService.exe processes.

• TCP port 21339
Local communication with HTTP to allow the PrintixService.exe to listen for print data from the 
Windows Print Spooler (spoolsv.exe) and Mac CUPS (org.cups.cupsd).

• TCP port 21343
Local Secure communication with HTTPS to allow the PrintixService.exe to listen for print data 
from the Windows Print Spooler (spoolsv.exe). Enabled with Printix Windows Registry setting
DisableHTTPPrinting.
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If Printix Go is in use, these ports must also be open within the network:
• HTTP port 8091

Printix Client using HTTP to the Fujifilm printer to check the presence of the plug-in.
• HTTPS port 58501

Printix Client using HTTPS to manage the plug-in configuration settings on Fujifilm printers.
• TCP port 7627

SOAP communication from Printix Client to Printix Go on HP printers.
• TCP port 21343

Secure communication through HTTPS from Printix Go printers with Capture to the Printix Client. 
Applies to HP and Konica Minolta printers. Does not apply to Ricoh printers.

• TCP port 50003
SOAP communication from Printix Client to Printix Go on Konica Minolta printers.

• TCP port 51443
Secure communication through HTTPS from Printix Client for Windows to Printix Go on Ricoh
printers. The communication happens during the installation, update, and uninstallation of 
Printix Go and is performed by the Printix Go Ricoh Installer (silently invoked by the Printix 
Client).

If Active Directory authentication is enabled, one of these ports must also be open within the 
network:
• Secure LDAPS on TCP 636
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Authentication of users with secure LDAPS.
• LDAP on TCP port 389

Authentication of users with LDAP.

On Windows, the Printix Client automatically configures the required ports in the local Windows 
firewall. It does so by running the provided open_firewall.cmd file.

Internet endpoints that must be unblocked
Use of a web proxy and/or SSL inspection may prevent signing in to the Printix Client. You MUST 
add the printix.net domain and subdomains as exceptions so traffic is not blocked.

The syntax for adding exceptions varies depending on the software you use. See your security 
software documentation to determine the syntax for specifying a domain and its subdomains. 
These are some common examples of the wildcard syntax:
• *.printix.net
• .printix.net

 We are unable to provide IP address information that we can 100% say will never change. 
Therefore, unblocking (whitelisting) must be by URLs.

The specific Internet endpoints that must be unblocked are as follows:
• Required

These Internet endpoints MUST always be unblocked:
• https://assets.printix.net
• https://api.printix.net
• https://auth.printix.net
• https://sign-in.printix.net
• https://drivers.printix.net
• https://software.printix.net
• wss://websocket.proxyendpoint.printix.net

• Additionally required if documents go through the cloud
These Internet endpoints MUST also be unblocked if documents go through the cloud:
• If you do not add your own cloud storage and just use the Printix-offered cloud storage:

• https://prodenv2printjobs.blob.core.windows.net
• If you add your own Azure Blob Storage, you need to include the URL referencing the 

account name (such as printixcloudstorage):
• https://printixcloudstorage.blob.core.windows.net

• If you add your own Google Cloud Storage, you need to include the URL referencing the 
bucket name (such as printix-cloud-storage):
• https://storage.cloud.google.com/printix-cloud-storage

• Additionally required if you use Printix Go
These Internet endpoints MUST also be unblocked if you use Printix Go:
• https://device-api.printix.net
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• https://on-device-api.printix.net
• https://on-device-printer-sign-in.printix.net
• https://on-device-printer-release-documents.printix.net
• https://on-device-capture.printix.net

• Additionally required if you enable mobile print (Apple AirPrint)
These Internet endpoints MUST also be unblocked if you enable mobile print (Apple AirPrint):
• https://airprint.printix.net

How does the Printix Client find the web proxy?
The Printix Client consists of two components:
• The user interface of the Printix Client (PrintixClient.exe) which runs under the signed in user's 

account.
• The Printix Service (PrintixService.exe) which runs under the local system account, and handles 

the printing.

The Printix Client uses a Windows function WinHttpGetProxyForUrl (implements WPAD) to get the 
proxy settings from the PAC file. It also looks at the proxy settings configured for the user. If it 
finds a suitable set of proxy settings for the user, it remembers them in the registry under the LSA 
user (HKEY_USERS\S-1-5-18\Software\Microsoft\Windows\CurrentVersion\Internet 
Settings\Connections).

How to determine if SSL inspection is used
1. Open a web browser and enter the URL.
2. Select the padlock icon to the left of the address.

If the certificate is intermediate, SSL inspection is used.

Troubleshooting
• I have a web proxy and I cannot sign in to the Printix Client
• I have a web proxy and I cannot install my printer
• I do not recognize the used web proxy
• I have disabled the web proxy, but the computer still does not act as proxy
• I cannot print through the cloud

I have a web proxy and I cannot sign in to the Printix Client
When I sign in to the Printix Client with Microsoft, Google, or email, I return to the sign-in page.

Resolution: You MUST add the required domains (see above) as exceptions so traffic is not blocked.

See also: Sign in issues

I have a web proxy and I cannot install my printer
Print drivers cannot be downloaded from the Printix driver store.
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Resolution: Unblock the Internet endpoint https://drivers.printix.net.

I do not recognize the used web proxy
In this case, the PrintixService.log file contains text such as "running with proxy1: 
http://172.23.100.13:8080/" and "Unable to connect to the remote server."

Resolution: Check if the web proxy is part of the PAC file and if it should be updated or deleted.

I have disabled the web proxy, but the computer still does not act as 
proxy
In this case, the PrintixService.log file may contain errors such as "Proxy: Error event" and
"Exception: proxy error."

Resolution: Follow the steps below to delete settings from the Windows Registry.
1. Press Windows+R.

The Run dialog box appears.
2. Type regedit, then select OK.

Select Yes if prompted.
The Registry Editor appears.

3. Browse to HKEY_USERS\S-1-5-18\Software\Microsoft\Windows\CurrentVersion
\Internet Settings\Connections.

4. Delete the two entries called DefaultConnectionSettings and SavedLegacySettings.
5. Restart the computer.
6. Sign in to the Printix Client again.

I cannot print through the cloud
Use of a web proxy and/or SSL inspection may require additional Internet endpoints to be 
unblocked.

Resolution: Unblock the required Internet endpoints to print through the cloud.

51



Tungsten Printix Administrator Guide

Components

The Printix Cloud Print Management Service consists of these components:
• Printix Cloud

Handles authorization, configuration data, and most of the business logic. Communicates 
securely with the other components through HTTPS.

• Printix Administrator
Centrally configure Printix and manage your printers, print queues, and print drivers. Runs in a 
web browser.

• Printix Client
Automates the creation of print queues and installation of print drivers. Runs on users' Windows 
and Mac computer.

• Printix Chromebook
Print to Printix-managed printers from Chromebooks and computers with Google Chrome.

• Printix App
Release, print, and delete documents. Runs as a mobile app on phones and tablets, or as a web 
app in a web browser.

• Printix Go
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Integrates with your printer's touchscreen control panel, offering secure print release, copy 
control, card-based authentication, and more.

• Printix Redirector
Enable printing to a print queue on a Windows computer, enable third-party pull printing, and 
enable USB printing.

• Printix Configurator
Initially configure Printix with multiple locations (networks) and already deployed printers.

• Printix Power BI report
Provides analytics and a multi-perspective view into your Printix-managed print environment.

• Printix Cloud Print API
Used by applications to push print jobs in printer-native or PDF format into a Printix print 
queue, and by organizations who want to do guest user administration. You can access the API 
documentation at printix.github.io.

System requirements
The system requirements are listed in the Printix Technical Specifications, which you can access 
from the Printix Documentation portal. The document is updated regularly, and we recommend 
that you review it carefully while working with your product.

How to migrate Windows Server Core
Windows Server Core is NOT supported, but you can migrate printers set up on Windows Server 
Core to Printix through a temporary Windows server.

On the Windows Server Core computer:
1. Press Windows+R.

The Run dialog box appears.
2. Type printmanagement.msc, then select OK.
3. In Print Management, open the Action menu and select Export printers to a file.

On the temporary print server:
4. Install the Print Server Role on a new/different Windows Server in the same network as the 

Windows Server Core computer.
5. In Print Management, open the Action menu and select Import printers from a file.
6. Select the file you created in step 2.
7. Install the Printix Client on the print server, then discover the printers.

53

https://printix.github.io/
https://docshield.tungstenautomation.com/Printix/en_US/print/PrintixTechnicalSpecifications_EN.pdf
https://docshield.tungstenautomation.com/Portal/Products/en_US/Printix/Printix.htm


Chapter 2

Getting started

Follow these steps if you use Printix for the first time:
1. Visit printix.net and select Free trial.
2. Enter your Work email.
3. Enter your Full name.
4. Enter a Company name.
5. Select Number of employees, then select the correct range from the list.
6. Select a Country.
7. Optionally, change I am starting this trial as to Service provider.
8. Enter a Subdomain.

The text is used in your Printix web address (your Printix Home), so you can use only: A-z, 0-9, -.
9. Select Start trial.

The page displays Domain reserved if the Printix Home is already in use. If that happens, 
change it and select Start trial again.
You receive an email with the subject Welcome to Printix.

10. Open the email and select Get started.
If you do not see the email within a few minutes, check your spam/junk mail folder. The link in 
the email can only be used once for activation, and it must happen within 72 hours.

11. Complete the steps presented by the Setup assistant.
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Setup assistant

The Setup assistant helps you get started with Printix and move your print management to the 
Printix Cloud.

1. Enter a password, then select Save.
The password is required for signing in to the Printix Client.
• The password must be minimum 6 characters in length and contain uppercase letters, 

lowercase letters, and digits.
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• This step is left out if you use an existing Printix account.
2. Download the Printix Client installer file on a Windows or Mac computer.
3. Open and run the downloaded file to install the Printix Client.

The installation takes a couple of minutes.
4. If you are not prompted to sign in, open the Printix Client menu, then select Sign in.
5. On the sign-in page, enter your email and password.

• If you do not remember your password, select Forgot password.
• If you have issues while signing in to the Printix Client, see Sign in issues.

6. In the Setup assistant, select Discover printers and wait a couple of minutes while the Printix 
Client discovers your printers. Select Close.
• The Printix Client attempts to discover your printers and securely transfer necessary 

information to the Printix Cloud.
• If we did not find any printers, select Add printer  on the Printers page and enter the IP 

address (Example: 192.168.1.10) or hostname of one printer.
• If a printer fails to register, it appears on the Unregistered printers page.

• Additionally, Printix Anywhere is installed.
• Print queues are converted and their name is extended with a three-letter printer ID to make 

it easy to search for and identify printers.
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 If no printers were discovered, select Learn more to read about printer registration 
issues.

To further guide you to a successful trial, you are presented with three other buttons:
7. Select Setup sign in method to open the Setup tab on the Authentication page.

From here, you can easily add and enable sign-in methods, such as: Sign in with Microsoft or
Sign in with Google.

8. Select Implementation to open the Implementation assistant, which simplifies and reduces 
the steps needed to implement Printix.

9. Select Subscription to open the Subscription page, enter billing information, and add a credit 
card to start subscription after trial end.
This is relevant for direct customers only, because customers onboarded by our partners are 
billed through the distributor/partner in question.

 If you need your trial period extended, contact Product Support.
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Start printing
Having installed Printix Client, you can now print to the Printix-managed printers and examine the 
many features that make office printing convenient, secure, and easy to manage. But first, let us 
examine how you can print as usual.

1. On your computer, open the item to print.
2. On the File menu, select Print.

You can notice that nothing has changed, except for the three letters at the end of the printer 
name (ASD, BNM), which indicates that these printers are now managed by Printix. Also, apart 
from the Printix Anywhere printer, you have the exact same printers available to you as you did 
before the installation.

3. Select a Printix printer, then select Print.

Optional customizations
• Subscription email receiver

During the 1-month trial, email reminders are sent when 15, 5, and 1 days remain. These emails 
are, by default, sent to the email address of the user (you) who signed up for the Printix Cloud 
Print Management Service. On the Subscription page, you can change who receives subscription 
emails and future invoices. You can add a credit card at any time to suppress the email reminders. 
You will still get the remaining time of your 1-month trial for free.

• Email message signature
On the Settings page, you can change the signature to include contact details for your Help 
Desk. By default, this is populated with the name and email address of the user (you) who signed 
up for the Printix Cloud Print Management Service.

• Accept Printix for all users
If users sign in with Microsoft, you can grant permission to read users' profiles without 
prompting the individuals in your organization. This provides a much smoother deployment. You 
can also choose to remove the Sign in with email option.

Next steps
Visit the topic below that best suits your current environment and cloud needs:
• Start a trial on a computer

Install Printix on a computer and get hands-on experience.
• Migrate print server to Printix Cloud

Copy an existing print infrastructure to the cloud.
• Migrate multiple sites to Printix Cloud

Add multiple sites and work with networks.
• Build a new site with Printix Cloud

Set up printers and print queues before users move into a new office/site.
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 If you started a trial at home, but it does not work at your company, read this FAQ page.

Start a trial on a computer
Requirements:
• Your computer should be connected to the network you want to use Printix on, such as your 

office network.
• Your computer must have access to at least one printer on the network, and the printer must 

have at least one print queue installed, to experience the various printing features. If you want 
to install on a fresh virtual machine, you should add a printer first, so it can become managed by 
Printix.

Step 1: Install

 To resume the installation, sign in from printix.net or use the links in the email with the subject
Get started with Printix.

1. Download the Printix Client installer file.
2. Open and run the downloaded file to install the Printix Client on your Windows or Mac

computer.
3. Sign in to the Printix Client.

This is automatic if your Windows computer is Microsoft Entra joined.
• If you see Sign in with Microsoft, select it and sign in with your work account.
• If you see Sign in with Google, select it and sign in with your Google Workspace account 

(not @gmail.com).
• Otherwise, enter the Email and Password you used when you registered. If you were not 

prompted to sign in, sign in through the Printix Client menu.
• If you have issues while signing in to the Printix Client, see Sign in issues.

Step 2: Start printing
Having installed Printix Client, you can now print to the Printix-managed printers and examine the 
many features that make office printing convenient, secure, and easy to manage. But first, let us 
examine how you can print as usual.

1. On your computer, open the item to print.
2. On the File menu, select Print.

You can notice that nothing has changed, except for the three letters at the end of the printer 
name (ASD, BNM), which indicates that these printers are now managed by Printix. Also, apart 
from the Printix Anywhere printer, you have the exact same printers available to you as you did 
before the installation.

3. Select a Printix printer, then select Print.
4. Optionally, try the print methods and consider adding 2-3 users.
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Migrate print server to Printix Cloud
Requirements:
• You have access to an administrator account and can sign in to the print servers.
• Follow the recommended Implementation setup.

Step 1: Install the Printix Client on the print server
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When you download the Printix Client software and install it on the print server, we make a copy of 
the current print environment details in the Printix Cloud. We do not change or delete anything on 
the print server.
• The Microsoft Edge web browser's security settings may obstruct the download of the Printix 

Client software. To work around this, you can download it on another computer (without 
installing) and copy it to the print server, so you can run it from there.

• If you have issues while signing in to the Printix Client, see Sign in issues.

During the discovery process, we automatically detect and register printers, print queues, and 
drivers in the Printix Cloud. At the same time, a network called Network1 is created with the 
gateway of the print server's network adapter.

If additional print servers exist, install the Printix Client on each of these to make the copy of your 
print infrastructure as complete as possible. Open the Computer properties page of the print 
server and select Discover printers.
• If not all of your printers are listed on the Printers page, add the missing printers.
• Optionally, rename the printers and print queues.
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Step 2: Deploy the Printix Client to computers

Use your preferred method to deploy the Printix Client, such as Microsoft Endpoint Manager.
• If users sign in with Microsoft, you should accept Printix for all users.
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Step 3: Remove the print server

Before removing the print server, you should verify that the print server's shared printers can be 
paused without causing inconvenience to users. You should also verify that the server does not 
have additional roles, such as Domain Controller and File Server.

Take the server offline. Unplug the network cable and leave it that way for a week or so. If no users 
complain, it is safe to decommission the print server.

You are now on Printix – what has changed?
The user experience for printing is the same. Only the printer name is extended with a three-letter 
printer ID to make it easy to search for and identify printers.
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From an IT management perspective, cloud deployment means less ongoing management, because 
infrastructure is now managed from the cloud.

Migrate multiple sites to Printix Cloud
Migrate multiple sites, such as branch offices and campuses.

Prerequisites:
• Printix is already deployed at the first site.

Step 1: Add site
1. Install the Printix Client on a computer at the site you want to add.

• If you can remotely sign in to the computer as administrator, you can also install and sign in 
to the Printix Client.

• Alternatively, invite a user at the site you want to add. If possible, call and notify the user in 
advance. Wait for this user to install and sign in to the Printix Client. You can also use your 
own email account to send an explanatory message that includes a link to the Printix Client 
download page.

Example:  acme.printix.net/download
The user's computer appears on the Computers page as being on an unknown network.
• Add a network and give the network a descriptive name.
• Add the gateway (LAN and/or Wi-Fi) of the computer to the network.
• Open the Computer properties page of the computer and select Discover printers.

2. If additional sites exist, install the Printix Client on those sites too to copy the print 
infrastructure.

Step 2: Deploy Printix Client to computers
• Use your preferred method to deploy the Printix Client, such as Microsoft Endpoint Manager, and 

get users to print with and use Printix.
• If users sign in with Microsoft, you should accept Printix for all users.

Build a new site with Printix Cloud
If you want to install and configure Printix before users move into a new office/site, follow the steps 
below to build your print infrastructure.

Requirements:
• Be connected to the network at the new site.
• Printers are powered on and are on the network.
• Follow the recommended Implementation setup.
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Step 1: Install
Download the Printix Client software and install it on a computer at the new site. The computer 
should run the same Windows/macOS editions the users will be using.
• Printers are discovered and registered in the Printix Cloud.

Step 2: Set up print queues
Open the Printers page to see the printer properties and print queue properties. If not all of your 
printers are listed on the Printers page, add the missing printers.
• Optionally, rename the printers and print queues.
• Refine the print queue setup by adding print drivers and perform print driver configurations to 

configure installable options (such as Paper trays, Duplexer, Staple, Hole punch, Output bins, and 
Form to tray assignment).

• For each additional Windows/macOS edition to be used in the organization, install the Printix 
Client and add print drivers and perform print driver configurations.

• Test that printing with the added print queues works as intended on the Windows/macOS 
editions to be used.

Step 3: Deploy Printix Client to computers
Use your preferred method to deploy the Printix Client, such as Microsoft Endpoint Manager, and 
get users to print with and use Printix.
• If users sign in with Microsoft, you should accept Printix for all users.

Understanding networks
Consider a company with two sites (Amsterdam and Berlin) with separate networks. No routing 
exists between the two, that is, from Amsterdam, you cannot reach (ping) a printer in Berlin and 
vice versa.

Teach Printix about networks so it can filter which printers are available to users. A user at the 
Amsterdam site will only see printers on that site.

You can optionally allow users to print between networks and print while their computer is on an 
unknown network (for example, during travel or while at home).
• How to work with networks
• About networks
• Example: Company with sites in Amsterdam and Berlin

• User printing while on company network
• User printing while on an unknown network
• Bridging two known networks
• Cloud storage
• Printer availability
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How to work with networks

• How to add a network
• How to modify network name
• How to add an unknown network to a network

• How to add a network/gateway from the computer properties page
• How to add a gateway to a network
• How to delete a gateway from a network
• How to merge networks
• How to enable printing via the cloud

About networks
• You can name networks to reflect the name of company sites or branches (Amsterdam, Berlin).
• The first registered network is named Network1.
• A network in Printix is defined by a collection of one or more gateways (identified by their IP 

address and MAC address).
• A gateway should only be added to a network if routing is possible to the other computers/

printers on the network segments within that network.
• To test, verify you can ping printers/computers on the network.

• A computer is considered to be on the network the gateway is part of.
• A computer can be on multiple networks: one for each active network adapter (LAN and Wi-Fi).
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• A computer that uses a gateway that is not part of a network appears as being on an unknown 
network, and a yellow dot is displayed on the Printix Client icon .

• A computer (laptop or hybrid tablet, such as the Microsoft Surface 3 or higher) appears as being 
on an unknown network when it is powered-on outside a registered network (for example, at 
home or during travel).

• A printer is automatically added to the network you select when you:
• Discover printers
• Add a printer

 If a CSV file with gateway IP and MAC addresses can be provided, then Printix Configurator can 
be used to add networks. That way, you can add networks before computers are on them.
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Example: Company with sites in Amsterdam and Berlin

1. As you first deploy Printix Client in Amsterdam on computer A and discover printer ASD, 
these are recorded as being on the network named Network1.

2. You can modify the network name to change it from Network1 to Amsterdam.

3. When you deploy the Printix Client in Berlin on computer B, it appears as being on an 
unknown network due to the unknown gateway.

4. On the Networks page, you can add a network, name it Berlin, and then add the unknown 
network to the Berlin network.
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By adding networks, you are teaching the system about your company's networks. With 
the new knowledge, the system will attempt to automatically assign computers to the right 
company network in the future.

5. Select Discover printers and select the Berlin network to add printer BNM.
• An employee who brings a laptop from Amsterdam to Berlin does not have to change 

anything, because the laptop is automatically reassigned to the Berlin network.
• Print queues on the Berlin network are automatically added on the employee's computer 

if the Berlin network has Add print queue automatically selected.
• Existing printers, including those added in Amsterdam, appear as offline on the computer.

• When the employee travels back, the laptop is automatically reassigned to the Amsterdam
network. The Berlin print queues that have Remove print queue automatically selected 
are removed automatically from the employee's computer.

• During travel and at the employee's home, the laptop appears as being on an unknown 
network.

Print between networks
Printing is achieved through Printix Cloud and a Printix Client computer on the printer's network. At 
least one of the Printix Client computers on the printer's network should have permanent network 
access. The document remains secure during the transfer over the Internet as the document itself 
and the communication are both encrypted.
• Enable printing via the cloud for printer BNM in Berlin.
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User printing while on company network

The user on computer A in Amsterdam can now add printer BNM and print to it even though it is 
in Berlin.
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User printing while on unknown network

A user working on computer X at home or while traveling can print directly and release documents 
to printer BNM.
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Bridging two known networks

If you have computer C with two network adapters, and it is on both the Amsterdam and the
Berlin networks at the same time, print data from computer A to printer BNM are automatically 
forwarded through computer C instead of through the cloud. Computer C should have permanent 
network access.
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Cloud storage

If you add cloud storage, documents printed through the cloud go through your cloud storage, 
rather than the Printix Cloud. In addition, you can enable storage of pending documents in your 
secure cloud storage.

See also:
• How to add Azure Blob Storage
• How to add Google Cloud Storage
• Which documents go via the cloud?

Printer availability
Based on the network, the Printix Client filters the list of printers you can add. In Amsterdam, you 
see printers on the Amsterdam network. Regardless of the network, the list always includes:
• Printix Anywhere printers.
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• Printers with Via the cloud selected.

ASD BNM Anywhere

Computer A 
(Amsterdam)

+ + +

Computer B (Berlin) – + +

Computer C (Both 
networks)

+ + +

Computer X (Unknown 
network)

– +1 +2

What is a network?
A network in Printix is defined by a collection of one or more gateways (identified by their IP 
address and MAC address). A gateway should only be added to a network if routing is possible to 
the other computers/printers on the network segments within that network.
• A computer is considered to be on the network the gateway is part of.
• A computer can be on multiple networks: one for each active network adapter (LAN and Wi-Fi).
• A computer that uses a gateway that is not part of a network appears as being on an unknown 

network, and a yellow dot is displayed on the Printix Client icon .
• A computer (laptop or hybrid tablet, such as the Microsoft Surface 3 or higher) appears as being 

on an unknown network when it is powered-on outside a registered network (for example, at 
home or during travel).

See also:
• Understanding networks

Teach Printix about networks
If you want to have all printers registered and the network structure in place before you introduce 
users to print with Printix, follow these steps:

1. Follow the recommended Implementation setup.
2. Install the Printix Client on computers.

• Use your preferred method to deploy the Printix Client, such as Microsoft Endpoint Manager.
• If you can remotely sign in to the computer as administrator, you can also install the Printix 

Client. Sign in to the Printix Client.
• Alternatively, invite a user at the site you want to add. If possible, call and notify the user 

in advance. Wait for this user to install and sign in to Printix Client. You can also use your 
own email account to send an explanatory message that includes a link to the Printix Client 
download page. Example: acme.printix.net/download

1 While the computer is on an unknown network, it is possible to print directly and release Print 
Later documents to printer BNM.

2 While the computer is on an unknown network, it is possible to release Print Anywhere 
documents to printer BNM.
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3. As the computers are registered, you can start to build your network structure by adding 
networks.
• When you have added a network, you can discover new printers to add to that network.
• Optionally, rename the printers and print queues.

 If a CSV file with gateway IP and MAC addresses can be provided, Printix Configurator can 
be used to add networks. That way, you can add networks before computers are on them.

4. When you are ready to introduce users to print with Printix, enable the features you disabled in 
step 1 (Implementation setup).

Enable BYOD
You can enable BYOD (Bring Your Own Device) to let users print from their own computer.

If you use Microsoft Entra ID, you can add a guest user in Microsoft Entra ID. Guests can also be 
added by an email invitation. If your guests are subcontractors from the same company, you can 
add the subcontractor company's email domain while you enable self-registration.

 You can also enable mobile print to let users print from their own phone or tablet (Android and 
iOS/iPadOS).

Requirements:
• The user has an email address.
• The user has a personally owned computer (BYOD).
• The Printix Client can be installed on the user's Windows or Mac computer.
• A company computer with Printix Client is powered on at all times and has two network 

interfaces (Wi-Fi and LAN).
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Administrator preparation
1. Install the Printix Client on a computer that is simultaneously on the Guest Wi-Fi network and 

the Printer LAN network.
This computer must be powered on at all times, because it is used to forward the print data to
printer BNM.

2. Use Add network to add the networks Guest Wi-Fi and Printer LAN.
3. Enable printing through the cloud for printer BNM.

For the best user experience, ensure PDF printing is supported by printer BNM.
4. If the user is a guest, add the user by email invitation. You can also enable self-registration.
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User registration
1. Open the email with the subject Welcome to Printix and select the link to Download Printix 

Client.
2. After successful registration, the user also receives an email with the subject Get started with 

Printix with links to the Printix Client and the Printix App.
• The Printix Anywhere printer is automatically added on the user's computer if it is on the 

company network.
• The user can use the Printix Client to add printer BNM after the computer is on the 

company network.

User printing while on company network
• The user can print to Printix Anywhere and subsequently open the Printix App and release the 

documents to printer BNM. The user's computer must be online and on the company network 
(Guest Wi-Fi or Printer LAN) to release the document.

• If the user has used the Printix Client to add printer BNM, the user can:
• Print directly to printer BNM.
• Print Later to printer BNM.

77



Tungsten Printix Administrator Guide

User printing while on an unknown network
The user's computer is on an unknown network when the user is at home, traveling, or otherwise 
not connected to the company network.
• The user cannot release any documents.
• The user can submit documents to the Printix Anywhere printer, but the user cannot release the 

documents.
• The user can print directly to printer BNM.
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See also:
• How to release Print Anywhere documents

Implementation guide
To guide you through the implementation of our Printix Cloud Print Management Service, 
consider the below phases and examples.
• Implementation phases
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Evaluation, proof of concept, implementation, and going live
• Printix Implementation Guide
• Infrastructure implementation
• Additional functionality implementation

• Implementation setup
• Implementation pack

We assign an expert to assist with the technical setup associated with the Printix software.

 If you need your trial period extended, contact Product Support. We need to know your Printix 
Home (acme.printix.net). If you are a Printix partner, you can extend the trial from within the 
Printix Partner Portal.

Implementation phases
1. Evaluation

Start a trial and familiarize yourself with the product through hands-on experience and by 
trying relevant features. Make sure the required ports and Internet endpoints are accessible.

2. Proof of concept
Proceed to do more hands-on practice, perhaps involving the installation on a print server.
• Select an implementation setup.

3. Implementation
• Deploy the Printix Client.
• Define networks.
• Discover printers.
• Convert print queues.
• Go live.

 Questions? Let us have a quick talk. Just submit a support request, write your questions, and 
if you prefer, ask us to schedule an online meeting with you and perhaps the members of your 
team.

Printix Implementation Guide
• Printix Implementation Guide

Describes how to implement Printix.
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Infrastructure implementation

Additional functionality implementation
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Implementation setup
To select the Implementation setup, we recommend that you make these changes to the 
configuration:

1. On the Settings  page:
• Clear Allow users to add printers via Printix Client.
• Set Print queue naming to Printer name without printer ID.
• Clear Create default print queue.
• Clear Convert print queues.
• On the Secure print tab, clear Enable Print Later.

2. On the Printix Anywhere  printer's Print queue properties page:
• Clear Active.
• Clear Add print queue automatically.

Implementation pack
Our Printix implementation pack is designed for customers who want:
• Priority implementation support up to 2 hours
• 12 months priority support and technical assistance

For two hours, within the first 90 days from the start of your Printix subscription service, an 
assigned expert assists you with the technical setup associated with your Printix software.

Organization with multiple sites wants to eliminate print servers
Prerequisites:
• You have access to an administrative account.
• You can sign in to the print servers on the network.
• If the print server's Windows Server OS is old and has not been updated for a while, an out-of-

hours Windows update should be scheduled. Windows update installs a supported web browser 
(such as Microsoft Edge), which is required for Printix to work.

Printix Cloud Print Management Service is a cloud-based, multi-tenant subscription service, 
which runs with Printix Client installed on users' computers (Windows and Mac) and with a copy of 
the print infrastructure. No on-premise servers and databases are required.
• Step 1: Create a new Printix Home
• Step 2: Install the Printix Client on the first print server
• Step 3: Install Printix Client on a print server at a remote site
• Step 4: Add sites without a print server
• Step 5: Deploy to computers
• Step 6: Remove print servers
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Step 1: Create a new Printix Home

Action

Create a new Printix Home.
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Step 2: Install the Printix Client on the first print server

Action
1. Install the Printix Client on the print server.

• The Microsoft Edge web browser security settings may obstruct the download of the Printix 
Client software. To work around this, download it on another computer (without installing), 
then copy it to the print server, so you can run it from there.

• If you have issues while signing in to the Printix Client, see Sign in issues.

 Printix never converts print queues on Windows Servers. Printing through the shared 
print queues on the print server continues to work and restarting the computer is not 
required.
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What happens
• Printers are discovered and registered in the Printix Cloud.
• Print queues are discovered and registered in the Printix Cloud.
• Print drivers are registered for each print queue on the print server.
• Signed and unique print drivers are uploaded to your Printix driver store.
• Printer names are extended with a three-letter printer ID (ASD, BNM).
• Printers that are not online at this time can be added later.
• Network1 is created with the gateway of the print server's network adapter.
• If printers were found through, for example, two network adapters (LAN and Wi-Fi), then 

an additional Network2 is created with the gateway of the other network adapter. If the 
networks are logically the same, that is, computers on Network1 can connect to computers 
on Network2 and vice versa, you should merge the networks.

2. Optionally, modify the network name (Network1) to a descriptive name (Amsterdam).
3. If additional print servers exist on this site, install on these also, to make the copy of the print 

infrastructure as complete as possible.
4. Open the Computer properties page of the print server and select Discover printers.

See also:
• Understanding networks
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Step 3: Install Printix Client on a print server at a remote site

Action
1. Install the Printix Client on the print server.
2. Open the Computer properties page of the print server and select Discover printers.

What happens
• Printers are discovered and registered in the Printix Cloud.
• Print queues are discovered and registered in the Printix Cloud.
• Print drivers are registered for each print queue on the print server.
• Signed and unique print drivers are uploaded to your Printix driver store.
• If printers were found through, for example, two network adapters (LAN and Wi-Fi), then an 

additional Network{N+1} is created with the gateway of the other network adapter.
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3. Optionally, modify the network name to a descriptive name (Berlin).
4. If additional print servers exist on this site, install on these also, to make the copy of the print 

infrastructure as complete as possible.
5. Open the Computer properties page of the print server and select Discover printers.

Step 4: Add sites without a print server

Action
1. Install the Printix Client on a computer at the site you want to add.

• If you can remotely sign in to the computer as administrator, you can also install the Printix 
Client. Sign in to the Printix Client.

• Alternatively, invite a user at the site you want to add. If possible, call and notify the user in 
advance. Wait for this user to install and sign in to the Printix Client. You can also use your 
own email account to send an explanatory message that includes a link to the Printix Client 
download page. Example: acme.printix.net/download

What happens
• The user's computer appears on the Computers page as being on an unknown network.
• If the computer has, for example, two active network adapters (LAN and Wi-Fi), you will see

Unknown Unknown, one for each network adapter.
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2. Add a network and give the network a descriptive name (Copenhagen).
3. Add the gateway (LAN and/or Wi-Fi) of the computer to the network. See How to add an 

unknown network to a network.
4. Discover printers and select the newly added network (Copenhagen).

What happens
• The user's computer appears on the Computers page as being on the Copenhagen

network.
• Printers are discovered and registered in the Printix Cloud.
• Print queues are discovered and registered in the Printix Cloud.
• Print drivers are registered for each print queue on the print server.
• Signed and unique print drivers are uploaded to your Printix driver store.
• Each print queue on the computer that points to a registered printer is converted.

5. If additional sites exist, install on these also, to make the copy of the print infrastructure.
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Step 5: Deploy to computers

Action
1. If not all of your printers are listed on the Printers page, add the missing printers.
2. Optionally, rename printers and print queues.
3. Use your preferred method to deploy the Printix Client, such as Microsoft Endpoint Manager, 

and get users to print with and use Printix.
• If users sign in with Microsoft, you can accept Printix for all users.
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Step 6: Remove print servers

Action
1. Verify that the print servers' shared print queues can be paused without causing inconvenience 

to any users.
2. Verify the server does not have additional roles, such as Domain Controller and File Server.
3. Decommission the print servers.

Impact
• The print server is removed.
• No single point of failure.
• Centralized print queue management.
• Save on infrastructure and support costs.
• Eliminate WAN traffic related to print jobs.
• Track user and usage statistics.
• Track printer statistics.
• Flexible and secure printing (Print Anywhere and Print Later).
• Unlimited scaling at no extra cost.
• Printix software automatically updates itself to the latest approved version.
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Additional features
• Print between networks.
• Enable BYOD.
• Deploy and control access to printers based on users' group membership.

Citrix and RDS
Printing with Printix is also possible if you use Citrix or Remote Desktop Services (RDS) as long as 
you follow the steps below.

Alternatively, if you are using desktop clients, install the Printix Client on each client. All the local 
printers will be mapped into the Citrix terminal session.

1. Install the Printix Client on the Citrix Servers and install Printix Client on at least one computer 
at each site/location.
• See Citrix and RDS profile management on how to include a user's Printix settings in the 

Application Data roaming profile.
• If you intend to deploy by copying an image with an installed Printix Client to another server, 

see How to include Printix Client in a managed image.
2. Add networks to reflect the sites/locations.
3. For each print queue in Printix Administrator, open the Print queue properties page and 

select Via the cloud.
4. Each user running a terminal session (Citrix session) will sign in to the Printix Client and see all 

the printers for the site/location.

Citrix and RDS profile management
To make the Printix Client work, you need to modify the Windows Registry so the user's Printix 
settings are included in the Application Data roaming profile.

1. Press Windows+R.
The Run dialog box appears.

2. Type regedit, then select OK.
Select Yes if prompted.
The Registry Editor appears.

3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\printix.net\Printix Client\.
4. Add a DWORD value named StartAsVDI and give it a Data value that matches your 

environment.
The StartAsVDI can take on these decimal values (hex value in parenthesis):
• 0 (0×00000000)

This is the default. The Printix Client updates itself automatically.
• 1 (0×00000001)
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The Printix Client does NOT update itself automatically. It reads and writes the user's Printix 
settings, including access tokens, in the user's Application Data folder.
• The path to the user's application folder is based on %APPDATA%.

• 2 (0×00000002)
The Printix Client updates itself automatically. It reads and writes the user's Printix settings, 
including access tokens, in the user's Application Data folder.
• The path to the user's application folder is based on %APPDATA%.

• 999 (0×000003e7)
Printix Client does NOT update itself automatically. It reads and writes the user's Printix 
settings, including access tokens, in the user's Application Data folder.
• The path to the user's application folder is based on %USERPROFILE% and then AppData
\Roaming is appended.

 StartAsVDI only takes effect after a restart of the Printix Service and only takes effect for 
new profiles.

Azure Virtual Desktop
Printix printing is also possible if you use Azure Virtual Desktop.

Requirements:
• Printix Client must be installed on the Azure Virtual Desktop computer.
• You must enable printing through the cloud for the printers to be used by the Azure Virtual 

Desktop computers.
• There must be at least one computer online with Printix Client installed on the printer's network. 

Alternatively, you can have a Virtual Printix Client in the cloud (on Azure) that can route (through 
VPN) to all the relevant subnets (VLANs) with printers.

92



Tungsten Printix Administrator Guide

See also:
• How to include Printix Client in a managed image
• Citrix and RDS profile management

Universal Print by Microsoft

Printix integrates with Universal Print by Microsoft and runs on Microsoft Azure.
• Requirements
• Features
• How to assign the Universal Print license to a user
• How to integrate with Universal Print

• How to revoke the integration with Universal Print

Watch this video: Printix Universal Print Integration | Printix Cloud Print Management
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Requirements
• Microsoft Entra ID.
• An active Universal Print license for the same Microsoft Entra ID.
• Any user wishing to manage the universal printers within Universal Print must have the Printer 

Administrator role assigned, or a higher level that contains this role.
• The Universal Print license must be assigned to the printer administrators.

• User's computer is running Windows 10 version 1903 or higher and is either:
• Microsoft Entra joined
• Microsoft Entra registered
• Microsoft Entra hybrid joined

Limitations
• Support is available for one, but not multiple Microsoft Entra directories.
• Only one print queue per printer can be published with Universal Print.
• Documents submitted via Universal Print are tracked as 1-page documents.
• Exclusive access selected on the print queue in Printix Administrator is not carried through to the 

print queue published in Universal Print.
• Status of jobs is Cancelled instead of Completed due to a limitation in Microsoft Graph API.

Features
Enhance your print management capabilities and print experience with Printix flexible printing:
• Secure print

Release documents from your phone with Printix App or from the touchscreen control panel of a 
printer that has Printix Go installed.

• Mobile print
Print from Android and iOS/iPadOS phones and tablets to Printix-managed printers.

• Microsoft Dynamics 365 Business Central
Set up Business Central to use Printix printers (print queues) published with Universal Print by 
Microsoft and thereby print via Printix and use, for example, Secure print. Business Central may 
need permission adjustments for a full integration with Universal Print. See the Microsoft web 
page for further assistance on this where needed.

Additionally, Printix provides:
• Wide operating system support:

• Windows
• Mac
• Chrome OS
• Linux

• Print from computers through Chrome browser.
• Direct IP printing: Keep documents local and print without Internet connection.
• Central print queue and print driver management with driver store in the cloud.
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• Delegated print management.
• Analytics and reports (Microsoft Power BI).

Secure print
Release documents from your phone with the Printix App or from the touchscreen control panel of 
a printer that has Printix Go installed.
• Printix Anywhere

If you publish and share a Printix Anywhere print queue, you can print securely with Universal 
Print and Printix.
• Your submitted document goes to the Microsoft Cloud.
• Printix Cloud is notified about your pending document.
• You can subsequently release the document at any Printix-managed printer. The printer must 

have a print queue that has Via the cloud selected.
• Wait until you are at the printer and then use the Printix App on your mobile device to 

release your documents. The Printix App is available as a mobile app for Android and iOS/
iPadOS phones and tablets, and as a web app that runs in a web browser on your phone, 
tablet, and computer.

• If Printix Go is installed on the printer, you can sign in with card or ID code and release 
documents from the touchscreen control panel of the printer.

• Other Printix printers (ASD, BNM)
Documents will print directly, unless All users must print securely is selected or you are a 
member of a Must print securely group.
• Your submitted document goes to the Microsoft Cloud.
• Printix Cloud is notified about your pending document.
• If the document must be printed securely, you can subsequently release the document at your 

selected printer.
• Wait until you are at the printer, then use the Printix App on your mobile device to release 

your documents. The Printix App is available as a mobile app for Android and iOS/iPadOS 
phones and tablets, and as a web app that runs in a web browser on your phone, tablet, and 
computer.

• If Printix Go is installed on the printer, you can sign in with card or ID code and release 
documents from the touchscreen control panel of the printer.

Mobile print
Print from Android and iOS/iPadOS phones and tablets to Printix-managed printers enabled for
mobile print.

How to assign the Universal Print license to a user
1. Sign in to Microsoft Azure (portal.azure.com) with an account that has administrator access.
2. In the portal menu, select All Services.
3. In the Identity category, select Microsoft Entra ID.
4. On the left pane, select Users.
5. Select a user.
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6. Select Edit properties.
7. On the Settings tab, select the Account enabled check boxes.
8. For the Usage location, select the country of the user, then select Save.

You return to the selected user's overview page.
9. In the left-hand menu, select Licenses.

10. Select Assignments.
11. Select the Universal Print check box, then select Save.

How to integrate with Universal Print
1. Accept integration with Universal Print.
2. Publish print queues with Universal Print.

• Print queue naming
• How to see Printix printers in Universal Print
• How to see print jobs in Universal Print

Accept integration with Universal Print
This has to be done only once and by a global administrator in Microsoft Entra ID.

1. In Printix Administrator on the Authentication page, select the Microsoft Entra ID tab.
Only one directory is supported.

2. For now, it is required that Synchronize groups must be accepted.
3. For Integrate with Universal Print, select Accept.
4. On the Microsoft sign-in page:

• An active Universal Print subscription is required.
• Enter your printer administrator account. You must have the Printer Administrator role to 

manage all aspects of printers in Universal Print.
• Enter your Password.

5. Select Sign in.
Printix prompts you for permission to:
• Read and write print jobs.
• Read and write printer shares.
• Register, read, update, and unregister printers.
• Sign in and read user profile.
• Read, write and update print task definitions.
• Read and update printers.
• Read and write the properties and attributes of users' printers.
• Read printers.
• Read the metadata and payload of users' print jobs.
• Read and write the properties and attributes of printers.
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6. Select Accept to grant these permissions.
In Microsoft Azure, this adds the enterprise application Printix Universal Print.

Publish print queues with Universal Print
After you have accepted integration with Universal Print, you can proceed to publish print queues 
with Universal Print.

 Due to a limitation in Universal Print, it is only possible to publish one Printix print queue per 
printer.

1. In Printix Administrator, open the Print queue properties page.
• It is possible to modify the properties of multiple print queues.

2. Select Publish with Universal Print.
• The name of the print queue MUST be unique within Printix.
• There must NOT be a printer share with the same name in Universal Print.
• It is NOT possible to change the print queue name after the print queue has been published.
• If you unpublish the print queue, the corresponding printer share is deleted in Universal 

Print.
3. Select Save.

• After selecting Save, wait 1–2 minutes for the corresponding printer to be added and the 
print queue to be created as a printer share in Universal Print.

• The name of the printer share contains (UP), which is short for Universal Print.
Example: Printix Anywhere (UP)

Print queue naming
Native, Printix-managed print queue:
• The name cannot be changed but can be managed from Printix Administrator.

Examples: Reception ASD, ASD Reception, and Reception.

• Port is an Internet Port.
Example: http://localhost:21339/ipp/ASD/2114d3f3-e5732…

Printix print queue published with Universal Print:
• The name cannot be changed after it is published. It contains (UP), which is short for Universal 

Print.
Examples: Printix Anywhere (UP), Reception (UP).

• Port is an IPP Port.
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Example: IPP-eb47d31e-16f1-42f3-818s-f74a30c5…
• Driver and Model are Universal Print Class Driver.

In the Windows "Add a device" dialog box, any Universal Print printer appears as a Cloud printer.

In the Windows Printers & scanners dialog box, the Universal Print printers appear with a distinct 
cloud icon.
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How to see Printix printers in Universal Print
Optionally, see the printer share in Universal Print.

1. Open a new browser window and sign in to Microsoft Azure (portal.azure.com) using your 
work account credentials.

2. In the portal menu, select All Services.
3. In the Management and governance category, select Universal Print.
4. On the left pane, select Printer Shares.
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5. Select the printer share.
Example:  Printix Anywhere (UP)

6. Select Access control.

 Printer shares for Printix printers should be managed from Printix Administrator. 
Changes made to, for example, Access control, are not reflected back to Printix.

How to see print jobs in Universal Print
1. On the left pane of the Universal Print page in Microsoft Azure, select Printers.
2. Select the printer.

Example:  Printix Anywhere
3. Select Jobs.
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 Due to a limitation in Microsoft Graph API, it is not possible to change the Status from
Canceled to Completed. Pending update to Microsoft Graph API.

How to revoke the integration with Universal Print
1. Clear Publish with Universal Print for all the print queues that have been published.

• The corresponding printer shares are deleted in Universal Print.
2. Open a new browser window and sign in to Microsoft Azure (portal.azure.com) using your 

work account credentials.
3. In the portal menu, select All Services.
4. In the Identity category, select Microsoft Entra ID.
5. On the left pane, select Enterprise applications.
6. From the list, select Printix Universal Print.
7. On the left pane, select Properties.
8. Select Delete.

102

https://portal.azure.com/


Tungsten Printix Administrator Guide

Zero trust networks

To print a document, a computer with Printix Client must be online on the same network as the 
printer. This may not be possible if printers and computers are required to be kept on separate 
networks. To resolve this, you can run a computer, preferably a server, in the cloud, such as Azure. 
To make the Site A printers available to the computers on the Site A separate computer network, 
select Via the cloud and select On selected networks only and select the Site A computer 
network.

 Printix Go Ricoh can be used to release documents from the cloud without the required 
presence of a computer running Printix Client. This clientless mode is further described in How to 
install Printix Go on a Ricoh printer without using the Printix Client.

The Printix Client is installed on the computer and the computer can route (via VPN) to the printers 
on the printers' networks. By adding the computer to the printers' network, Printix can print on 
those printers, even though no physical computer is connected on the printer network. If you are 
concerned about resilience, you can add additional computers in the cloud.
• How to add a virtual Printix Client to a network
• How to add an additional virtual Printix Client to a network
• How to remove a virtual adapter from a computer
• Allow communication with the printers
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How to add a virtual Printix Client to a network
1. Identify a computer with a network interface that can route (via VPN) to all the relevant subnets 

(VLANs) with printers.
2. Open the Computer properties.
3. In the Network section, select the Gear  next to Virtual adapters to open the Virtual 

network access menu.
4. Select Create new network.
5. Enter the Network name.

Example:  Amsterdam printers
6. Enter the default Gateway IP for the printer network.

Example:  192.168.1.1
You can obtain that from any of the printers on the network:
• Open the printer's web page and sign in as administrator. Look for Network information 

where you can find the Gateway IP.
• At the printer, use the touchscreen control panel. Look for Network information where you 

can find the Gateway IP.
• On most printers, you can print the network configuration. See the printer's documentation.

7. Select Save.

How to add an additional virtual Printix Client to a network
To get resilience, you can add additional computers in the cloud.

1. Open the Computer properties.
2. In the Network section, select the Gear  next to Virtual adapters to open the Virtual 

network access menu.
3. Select Add to network, then select the network.

Example:  Amsterdam printers
4. Select Save.

 After a virtual adapter has been added to a computer, the computer's network 
configuration is no longer automatically updated.

How to remove a virtual adapter from a computer
See also:
• How to delete a gateway from a network

1. Open the Computer properties.
2. Scroll to the Network section, then under Virtual adapters, identify the virtual adapter 

gateway.
Example:  Network: Amsterdam printers

3. Select Delete  next to the virtual adapter.
4. Select I accept and select Confirm.
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The gateway remains listed on the Network properties page.

 After the last virtual adapter has been removed AND the computer (or Printix Service) has 
been restarted, the computer's network configuration is updated automatically.

Allow communication with the printers
These ports must be open to allow communication with the printers:
• SNMP on UDP port 161

Access and collect information from printers via SNMP. Both SNMPv1 and SNMPv3 are supported. 
ICMP message requests and replies must be allowed on the local network, because the ping
command is used to discover printers.

• RAW print on TCP port 9100
Transfer print data to the printers. The computer with Printix Client must be able to reach the 
printer on the network to allow printing. Print data can also be sent via LPR and TCP port 515. Use 
of other port numbers is also supported. Print data can also be sent via:
• IPPS and TCP port 443, 631. Use of other port numbers is also supported.
• IPP and TCP port 80, 631. Use of other port numbers is also supported.
• LPR and TCP port 515. Use of other port numbers is also supported.

See also:
• Network ports
• Cloud storage

SAP printing
Is migration to cloud part of your organization's strategy, but you still need a Windows server to 
print from SAP?

The BECONEX SAP2Printix Connector integrates Printix as external OMS in the SAP system. With 
only a few clicks, you can manage all print jobs directly in the cloud, without the need for servers.

SAP2Printix is compatible with SAP ABAP NetWeaver and any system based on it, including SAP S/4 
HANA On-Prem and SAP S/4 HANA Enterprise Cloud.

If you are interested, contact your Tungsten Sales Team.

See also:

• Tungsten Marketplace | BECONEX SAP2Printix Connector
• Watch video (8:16) on our Demo Center
• Printix Cloud Print API
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Print with Printix
Having installed the Printix Client, you can print to Printix printers.

To print a document:
1. On your computer, open the item to print.
2. On the File menu, select Print.
3. Select a Printix printer, then select Print.

If you cannot find a printer on your computer, see Add printers in Printix Client.

See also:
• How to print from Android phone and tablet
• How to print from iPhone and iPad
• If you use Printix Chromebook: How to print from Chrome

Printix printers
• Specific printer

If you print to a specific printer, you can only release your document at that printer.
When searching for a printer, you can identify each printer by its printer ID. The printer ID is a 
unique, three-letter ID (ASD, BNM) that is automatically added to the name of all Printix printers.
Example: Reception ASD
If you cannot find a specific printer, you can use the Printix Client to add the printer.
To release a document from your selected printer:
• You can Print as normal, without using any Printix applications.
• Alternatively, you can use Print Later and subsequently use the Printix App to release the 

document.
See the steps in the Printix User Help.

• Printix Anywhere
If you print to Printix Anywhere, you can release your document at any Printix printer.
• Print to Printix Anywhere and subsequently use your phone to release the document at any 

Printix (ASD, BNM) printer.
See the steps in the Printix User Help.

Print methods
• Print
• Print Later
• Print Anywhere
• Reprint from your phone
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Print
The document is printed immediately and directly at the selected printer.
• The document is processed using the matching print driver, with full control of finishing options.

Print Later
The ideal method if you need to print confidential documents with finishing options and want to 
ensure your documents print exactly as intended.
• The document can only be released at the selected printer.
• The document is processed using the matching print driver, with full control of finishing options.

See the steps in the Printix User Help.

Print Anywhere
When you submit a document to the Printix Anywhere printer, you can roam between printers and 
release the document at the printer you choose.
• The document can be released to the printer (ASD, BNM, …) you select.
• If the release printer supports PDF, the document is sent directly to the printer.
• If the release printer does not support PDF, the document is processed using a matching print 

driver.

See the steps in the Printix User Help.

Reprint
From your phone, you can reprint those of your documents that were deleted or printed within the 
previous 12 hours.
• Even documents you printed directly to the printer can be reprinted without going back to your 

computer and submitting them again.

See the steps in the Printix User Help.

107

https://docshield.tungstenautomation.com/Printix/en_US/help/user/Printix_user/t_print_later_release_doc.html
https://docshield.tungstenautomation.com/Printix/en_US/help/user/Printix_user/t_print_anywhere.html
https://docshield.tungstenautomation.com/Printix/en_US/help/user/Printix_user/t_how_to_reprint_documents.html


Chapter 3

Printix Administrator

This topic describes the menus and pages of the administrative web interface.
• Printix Administrator is used to configure Printix and manage your printers.
• Only administrators can sign in to the Printix Administrator.

• Administrators are users with the role: system manager or site manager.

Help
Select the Question  icon to display context-sensitive help.
Selecting a link in the help dialog box opens the relevant section in the online Printix Administrator 
Help.

News
1. If visible, select the Speaker  icon to see a short news description.
2. Select Learn more to open the documentation landing page where you can see the latest 

Release Notes.
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Issues
1. If visible, select the Warning  icon to display the type of issues that need to be resolved.
2. Select a type of issue to see more and resolve issues.

Issue types:
• Cloud storage
• Group synchronization
• Payment
• Data extract

Menu
Select Menu  in the top right corner to access functions.
• Dashboard
• Implementation assistant
• Sites
• Networks
• Printers
• Print queues
• Users
• Computers
• Groups
• History
• Authentication
• Subscription
• Settings
• Software
• Support
• Manual
• Language
• Sign out

Dashboard
The Dashboard gives you an overview with status and graphs for print activity, pages printed in 
black, pages printed 2-sided, and secure printed pages.
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System status
Lists the number of:
• Printers
• Users
• Guest users
• Computers
• Unregistered printers

Implementation assistant
Helps you through the implementation of Printix.

Suggestions
Learn about how to create a robust setup and how to deploy Printix.
• Learn more about the next steps

Try the print methods
Experience how you print, including how to release documents from your phone.
• Learn about the print methods

Statistics
Statistics are updated when you reload the page or select a different period:
• Last 7 days
• Last 14 days
• Last 4 weeks

Print activity
Shows the number of pages printed through Printix for the selected period.

Save-O-Meter
Shows the percentage of pages for the selected period that was never collected. By using Secure 
print functionality, you prevent otherwise forgotten documents from being printed, which again 
saves cost and benefits the environment.

Printed in black
Shows the percentage of pages printed in black for the selected period. Improve this by making 
print in black the default. The numbers are based on meter readings Printix Client collects from the 
printers registered in Printix.

Printed 2-sided
Shows the percentage of pages printed 2-sided for the selected period. Improve this by making 
print 2-sided the default. The numbers are based on meter readings Printix Client collects from the 
printers registered in Printix.

Secure print
Shows the percentage of pages for the selected period that have been released or reprinted from 
the Printix App by users. Improve this by making users aware of Print Later and Print Anywhere.
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Implementation assistant
To get here:

Select Menu  > Implementation assistant.

Implementation
• I am ready to deploy

Use a tool (MSI) to deploy Printix Client to computers.

• I wish to involve the first few users only
Invite users by email requesting them to download and install Printix Client on their computer.
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Define networks
1. Select gateway.
2. Register gateway with network.
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See also:
• What is a network?
• Understanding networks

Select gateway
Select how you want to select the gateway.
• I know the computer

• Select Select computer.
• Select or search a list of computers with Printix Client connected to unregistered gateways.

• I know the gateway
• Select Select gateway.
• Select or search a list of unregistered gateways. You can search for the gateway IP address or 

MAC address.
• Add gateway

• Enter the gateway IP address and MAC address.
• Entering the asterisk/star symbol (*) as a wildcard for the MAC address is useful if you use 

network gateways (Fortinet) that after a power cycle changes the MAC address but keeps the IP 
address.
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Register gateway with network
1. Select Create new network or Add gateway to network.

• Create new network
• The selected gateway will be registered with this network.
• Enter network name.
• Optionally, Convert print queues.
• Optionally, Add network to a site.

• Add gateway to network
• The selected gateway will be registered with this network.
• Select network.
• Optionally, Add network to a site.

2. Select Define network.

Sites
To get here:

Select Menu  > Sites .

About sites
In Sites, you can delegate the management of printers and print queues to the IT personnel at 
the local site. With the site manager role, they can do their job without having excess privileges to 
change global settings and printing at other sites.
• Site

• Concept of a site is based on networks.
• Multiple networks can belong to a site.
• A network can belong to one site.
• Printers (and thereby print queues) will belong to the site of their network.

• Site manager group
• A group (in Microsoft Entra ID or Google) whose users get the site manager role for the sites is

added to Printix.

See also:
• What actions can a site manager perform
• How to add a printer to a site
• How to delete a printer
• How to create a site
• How to move a site
• How to delete a site
• How to add a network to a site
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• How to remove a network from a site
• How to add a site manager group to a folder or site
• How to remove a site manager group from a site

Panes

The page has these three panes:
• Tree structure (left pane)

• Tree structure of folders and sites.
• Organize your sites in a flat structure or into a folder structure based on, for example, 

geography, such as Region, Country, or City.
• Maximum 4 levels deep.

• Selected folder or selected site (center pane)
• Site information
• Get started wizard
• Networks added to the site
• Printers on the network

• Search results (right pane)
• Sites matching the current search criteria
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Tree structure (left pane)
Folders and sites that are directly managed by the site manager are displayed in bold.
• Select New folder  to add a new folder.
• Select a folder to open or close the folder and display information about the folder in the center 

pane.
• Right-click the folder to open the Folder menu:

• Select Folder name (Copenhagen) to rename the folder.
• Select Site manager groups to see and remove the associated Site manager groups.
• Select New folder to add a new folder.
• Select Create site to create site.
• Select Add site manager groups to add Site manager groups.
• Select Delete folder to delete folder.

• Select Create site  to create site.
• Select a site to open the site in the center pane.
• Right-click the site to open Site menu:

• Select Site name (Head Office) to rename the site.
• Select Site manager groups to see and remove the associated Site manager groups.
• Select Networks to see and remove networks associated to the site.
• Select Add site manager groups to add Site manager groups.
• Select Add networks to add networks.
• Select Delete site to delete site.

Selected folder (center pane)
Information about the selected folder.
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• Select Site manager groups  to see the list of site manager groups currently assigned for the 
folder:
• Select More  and Remove to remove a site manager group.

 The Site manager groups  icon has a red exclamation mark if a site manager is not assigned 
for the selected folder.

• Select Folder menu  to open the folder menu:
• Select Folder name to rename the folder.
• Select Site manager groups to see and remove the associated Site manager groups.
• Select Add site manager groups to add Site manager groups.
• Select New folder to add a new folder.
• Select Create site to create site.
• Select Delete folder to delete folder.

Selected site (center pane)
Information about the selected site, including networks and printers.
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Site information

• Select Add network  to open the Add network menu:
• Select Add networks to add networks.
• Select Create new network to create a new network.

• Select the site name on the gray background (Head Office) to rename the site.
• Select Site manager groups  to see the list of site manager groups for the site:

• Select More  and Remove to remove a site manager group.

 The Site manager icon has a red exclamation mark if a site manager is not assigned for the 
selected site (not even indirectly).

• Select Site menu  to open the site menu:
• Select Site name to rename the site.
• Select Site manager groups to see and remove the associated Site manager groups.
• Select Networks to see and remove networks associated to the site.
• Select Add site manager groups to add Site manager groups.
• Select Add networks to add networks.
• Select Delete site to delete site.

• Select Search  to search for networks on the site.
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Get started
The 4-step Get started wizard guides you through the setup of the site.

1. Add network.
2. Add computer to network.
3. Discover printers.
4. Add site manager groups.

Networks added to the site

• Select a network name (Head Office) under Networks to display or hide options related to the 
network.

• Select Add printer  to add a printer.
• Select Discover printers  to add printers.

• Select the text under SNMP configuration to change the SNMP configuration. The default text 
is Default.
The SNMP configurations dialog box appears, where you can search for an SNMP configuration 
or create a new one.
For general instructions about creating a new SNMP configuration, see Add SNMP 
configuration. Compared to the general instructions, the only difference here is that the
Networks field is already populated. Site managers cannot change the network, but system 
managers can change it to a global network.
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• Select the text under Computer to change the computer. The default text is Select 
automatically.

• Select Network menu  to open the network menu:
• Select Network name to rename the network.
• Select Settings to open the Network settings dialog box.
• Select Gateways to see list of Gateway IP and Gateway MAC addresses.
• Select Test network to test if communication to the networks' gateways is working.
• Select Computers to see list of Computers that are on the network.
• Select Add printer to add a printer.
• Select Discover printers to add printers.
• Select Add gateway via computer and then select a computer that is on the network.

• Select Search  to search for printers on the network.

Printers on the network

• Select a printer ID (first column. Example: BNM) to open the Printer settings dialog box with
Printer name, Model, and Location.

• Select a print queue (second column. Example: 1 ) to open the Print queues dialog box with a 
list of print queues and their settings.

• Select a status (third column. Example: Error) to open the Printer status dialog box.
• Select a printer name (fourth column. Example: Sales) to open the Printer settings dialog box 

with Printer name, Model, and Location.
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• Select a printer address (fifth column. Example: 192.168.1.49) to open the Printer connection
dialog box with Printer address, MAC, Network, and SNMP configuration.

• Select Printer menu  to open the printer menu:
• Select Settings to open the Printer settings dialog box with Printer name, Model, and

Location.
• Select Connection to open the Printer connection dialog box with Printer address, MAC,

Network, and SNMP configuration.
• Select Print queues dialog box to open the Print queues dialog box with list of print queues 

and their settings.
• Select Status to open the Printer status dialog box.
• Select Delete to delete printer.

• Select Redirect  to open the Printer properties page in a new tab.

Unregistered printers on the network

• Select Printer  to toggle between registered and unregistered printers.
• Select Manual registration if the printer does not support SNMP.
• Select Redirect  to open the Printer issues page in a new tab.

Search results (right pane)
1. Select Search  to search for a site.
2. Enter site name.

The search is not case-sensitive.
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3. Select site to open the site in the center pane.

Networks
To get here:

Select Menu  > Networks .
Lists the networks.
• Select a Network name or select More  and Modify to open the Network properties.
• Select Unknown networks to list the unknown networks.
• Select Refresh  to refresh the list.
• Select More  and Info to see information about the network:

• Name: Name of the network.
• Gateways: List of Gateway IP and MAC addresses.

See also:
• Understanding networks
• How to add a network
• How to modify network name
• How to add an unknown network to a network
• How to add a gateway to a network
• How to delete a gateway from a network
• How to merge networks

Add network
Select Add network  to add a new network.

Search
1. Select Search .
2. Enter part of the network's name, Gateway IP, or MAC address.

The search is not case-sensitive.

Filters
Select Filters.
• Select Network type to filter by this.

• Company (same as if no filter is selected)
• Home office

• Select Mobile print to filter by this.

 Home office networks only appear if you filter for Home office.
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Sort by
The networks are sorted by name in alphabetical order.

Select Network name to toggle the sort order:  or 

Delete
1. To delete a network, select More  and Delete.
2. Select Move printers to another network.

If you clear Move printers to another network, all printers on the network are also deleted.
3. Select a network. Select OK to move the printers to the selected network and delete the 

network.
• Computers that were assigned to the deleted network will appear as being on an unknown 

network. On the computers, a yellow dot is shown on the Printix Client icon  when the 
Printix Client is on an unknown network.

 You cannot delete the default network. Instead, you can rename it and delete or add 
gateways to the network.

Unknown networks
To get here:

1. Select Menu  > Networks .
2. Select Unknown networks.

Lists the unknown networks.

See also:
• Understanding networks
• How to add an unknown network to a network

Search
1. Select Search .
2. Enter gateway IP or MAC address.

The search is not case-sensitive.

Network properties
To get here:

1. Open the Networks page.
2. Select a network.

On the Setup  tab, you can give the network a more descriptive name, control if print queues 
should be converted, and delete gateways.
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Additional tabs:
• Computers
• Printers

Settings
• Network name

You can modify the network name and give it a more descriptive name. The first network is 
named Network1.

• Convert print queues
Select if print queues that point to Printix printers should be converted.
• Yes

Print queues on this network should be converted.
• No

No print queues should be converted.
• Global setting

Print queues should be converted if the global setting Convert print queues is selected on the
Settings page.
You can test conversion of print queues on a single computer.

• Enable mobile print
Select this to allow printing from iOS/iPadOS phones and tablets to mobile print enabled Printix 
print queues. Only available if Enable mobile print is selected on the Settings page's Mobile 
print tab. Printix Client broadcasts these print queues as AirPrint printers. To do the broadcast, 
Printix Client for Windows will automatically install Apple's Bonjour Print Services for Windows 
(2.5 MB). No additional software is required for Printix Client for Mac (Bonjour is part of macOS). 
Print queues that have Enable mobile print selected will be broadcast as AirPrint printers on iOS/
iPadOS phones and tablets as follows:
• A print queue will be broadcast on the printer's network if the network has Enable mobile 

print selected.
• A print queue, that has Via the cloud selected, will be broadcast on all networks that have

Enable mobile print selected.
• A Printix Anywhere print queue will be broadcast on all networks that have Enable mobile 

print selected.
• Mobile-printed Print Anywhere documents can, unless the printer's QR code or NFC tag is 

scanned, be released only to printers that have a print queue with Via the cloud selected.

 Android phones and tablets can print to any mobile print enabled Printix print queue, 
regardless if the network has Enable mobile print selected or cleared.

• Network type
Do NOT select Home office manually. Adding home office groups will select this for relevant 
networks. Only clear Home office if you want to treat the network as a Company network.
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Site
The site the network is part of.

Gateways
List of Gateway IP and Gateway MAC addresses.

Add gateway
1. Select Add gateway.
2. In the Add gateway dialog box:

• Enter IP address.
Example: 192.168.1.1

• Enter MAC.
Example: 54a050e55bc0 or *
Entering the asterisk/star symbol (*) as a wildcard for the MAC address is useful if you use 
network gateways (Fortinet) that, after a power cycle, changes the MAC address but keeps 
the IP address.

3. Select Save.

Delete gateway
1. Identify the Gateway.
2. Select the Delete  icon.
3. Select Confirm.

Test network
Select Test network.
Test will report either OK or Connection failed. It may take minutes rather than seconds if the 
network has many gateways. If no computer is online on the network, it will report No computer is 
online on network.

Computers
Lists the computers that are on this network.

You can see the following information about each computer:
• Hostname
• Status: The status of the computer (Online or Offline).
• Type: The type of the computer (Laptop or Desktop).
• System: The operating system of the computer.
• Version: The version number of the Printix Client running on the computer.

Select Refresh  to refresh the list.
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Printers
Lists the printers that are on this network.

You can see the following information about each printer:
• ID
• Printer name
• Queues
• Status: The status of the printer.
• Network: The network the printer is on.
• Address: Select it to open the printer's web page.
• Created
• Location

Select Refresh  to refresh the list.

Gateway properties
To get here:

1. Open the Networks page.
2. Select Unknown networks.

If no computers are associated with unknown networks, it displays No items match your 
search.

Additional tabs:
• Computers

Select network
1. Select a gateway.
2. On the Setup tab, select Network.

The Select network dialog box appears.
3. Select a network the gateway should be added to.
4. Select Select network.
5. Select Save.

Computers
Lists the computers that are using this gateway.

You can see the following information about each computer:
• Hostname
• Type: The type of the computer (Laptop or Desktop).
• System: The operating system of the computer.
• Version: The version number of the Printix Client running on the computer.
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Select Refresh  to refresh the list.

Printers
Lists the printers.
• Select a printer's Printer name, ID, or select More  and Modify to open the Printer properties

page.
• Select the printer's number of Queues (such as 2) or select More  and Queues to toggle the view 

of print queues.
• Select check boxes of printers and select Modify at the bottom of the screen. Select the check box 

at the top of the list to select all printers.
• Select Refresh  to refresh the list.
• Select More  and Info to see information about the printer:

• ID, Name, Queues, Model, and Location (if any).
• Network: The network the printer is on.
• Printer address: Select it to open the printer's web page.
• Features: Color  printing, 2-sided  printing, and PDF printing.
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View mode

Select the Eye  to control what printer information should be displayed.
The ID and Printer name columns are always shown.
• Default: An overview of printers, their status, and location. Columns:

• Queues, Status, Network, Address, Created, and Location.
• Connection: Useful if you are using SNMP settings and different protocols. Columns:

• Status, Network, Address, MAC address, SNMP configuration, and Protocol.
• Printix Go: Useful for managing Printix Go on your printers. Columns:

• Status, Installation, Vendor, Go version, Go configuration, and Sign in profile.
• Customized: Build your own, customized view mode with the printer information you select.

How to view print queues
• Select the printer's number of Queues (such as 2) or select More  and Queues to toggle the view 

of print queues.
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• Select Print queues  to open the Print queues tab to create, modify, or delete print queues.
• Select a print queue's name (Reception) to open the Print queue properties page.

 Do you see print queues you do not know of? See Why are there additional print queues?.

Add printer
Select Add printer  to add a printer.
Other ways to add printers:
• Select Discover printers to add printers.
• Select Unregistered printers to work with printers that failed to register.

Search
1. Select Search .
2. Enter printer ID, name, location, or address.

The search is not case-sensitive.

Filters
1. Select Filters.

• Select Network to filter by this.
• Select Network type to filter by this.

• Company (Same as if no filter is selected)
• Home office

• Select Created to see printers added within the previous 3, 6, 12, or 24 hours.
• Select Vendors to filter by printer vendor.
• Select Printers with Go to filter by this.
• Select Outdated Go version to filter by this and determine which printers needs to have 

Printix Go updated.
• Select Go configurations to filter by this.
• Select Sign in profiles to filter by this.

2. To remove all filters, select Filters > Clear all filters.

Sort by
1. Select a column title to sort by it.

• Select ID to sort by printer ID.
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• Select Printer name to sort by printer name.
• Select Created to sort printers by the date they were registered.
• Select Location to sort by printer location.

2. Select the column title again to toggle the sort order:  and 

Status

1. To see status details, select the status icon:
•  Ready
•  Warning
•  Error
•  Printer is not monitored or not responding: The status text is the last known status of 

the printer.
• Select Network (Network1) to open the Network properties page.
• Select Computer (COMPIX) to see the Computer properties page.
• Select Printer (ASD) icon to see the Printer properties page.
• See Toner levels in percentage (See the disclaimer in Printer requirements).

2. Optionally, select Refresh  to see the latest status.
3. Optionally, select the communication status icon between Cloud  and Network .
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• It displays Monitored by and the name of the computer (COMPIX) that is monitoring the 
printer (ASD).

• If no computer is online to monitor the printer, it displays Printer is not monitored.
4. Optionally, select the communication status icon between Network  and Printer .

• It displays OK if communication is working.
• It displays Not responding if the printer is disconnected or powered off.
• It displays Missing printer information if the SNMP configuration is wrong.
• It displays This is not a printer if the entered address does not point to a printer.

Delete printer
• To delete a printer, select More  and Delete.

• Before deleting a Ricoh printer, Printix Go must be uninstalled. Otherwise, you might see an 
error message when you next use a Print or Capture workflow on the printer.

• Select check boxes of printers and select Delete .
• Select the check box at the top of the list to select all printers.

 When you delete a printer, the corresponding Printix print queues on users' computers will 
also be deleted by the Printix Client.

Unregistered printers
Printers that fail to register are displayed on this page.

1. Open the Printers  page.
2. Select Unregistered printers.
3. Select the check box of a printer and select Diagnose at the bottom of the screen, or select

More  and select Diagnose.
4. If Network is displayed, select the Modify  icon and select the network where the printer is. 

Select Select network.
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5. If SNMP configuration is displayed, optionally, select the Modify  icon and select the SNMP 
configuration that matches the printer. Select Select SNMP configuration.

6. In Printer address, enter the IP address or hostname of the printer.
Example:  192.168.1.9

7. Select Next.
See also: Printer registration issues
• Select More  and Info to see information about the printer.
• Select Refresh  to refresh the list.

Manual registration
If the printer does not support SNMP, you can manually register the printer.

1. On the Unregistered printers page, select More  and Manual registration, or select a printer 
and select Diagnose at the bottom of the screen and then select Manual registration.

2. In the Manual registration dialog box:
• Enter Name.

Example: Label printer
• Select Vendor.

Example: ZEBRA
Alternatively, select Enter vendor name in the menu and enter the name of the vendor.

• Enter Model.
Example: Z4M

• Select Network.
Example: Network1

• Enter IP address.
• RAW mode via TCP port 9100 (default)

Example: 192.168.1.9
• IPPS via TCP port 443

Example: 192.168.1.9 $$ipps
• LPR via TCP port 515

Example: 192.168.1.9 $$lpr:dlk-1D6FA3-U1
• Enter MAC address.

Example: 0011E5040E34 or 00:11:E5:04:0E:34
• Optionally, enter Serial number.

Example: CN3993Y073
• Optionally, enter Location.

Example: Room A2, Shipping
• If relevant, select Page description language:

• PCL5: Printer Command Language level 5.
• POSTSCRIPT: PostScript Level 1, PostScript Level 2, and PostScript 3.
• PCLXL: Printer Command Language level 6.
• PDF: Portable Document Format.
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• XPS: Open XML Paper Specification.
• UFRII: Ultra Fast Rendering 2, a proprietary language of Canon.

• If relevant, select Color supported.
• If relevant, select 2-sided supported.

3. Select Save.
If needed, you can subsequently make changes on the Printer properties page and the
Features button.

 The printer always appears with status  Ready because the status of the printer is not 
available.

Search
1. Select Search .
2. Enter printer ID.

The search is not case-sensitive.

Sort by
1. Select item to sort by this.
2. Select item again to toggle sort order:  and 

• Select ID to sort by printer ID.
• Select Issue to sort by issue.
• Select Information to sort by information.

Delete
• To delete a printer, select More  and Delete.
• Select the check boxes of printers and select Delete .
• Select the check box at the top of the list to select all printers.

Troubleshooting
• Missing printer information
• Unknown model name

The Printer registration issues above can occur if SNMPv1 is disabled or if the Get Community 
Name is not public. Add an SNMP configuration if the printer is using a different community name 
or has SNMPv3 enabled. To troubleshoot, you can download the command line tool SnmpWalk to 
check that SNMP communication is working.

1. Download SnmpWalk.exe.
2. Extract the contents of the SnmpWalk.zip file.
3. Open a command prompt and browse to the folder where you extracted the SnmpWalk.exe 

file.
4. To get the MIB from the printer with the IP address 192.168.1.9, type: SnmpWalk -

r:192.168.1.9
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In the window, you should start to see listings such as:
OID=.1.0.8802.1.1.1.1.1.2.1.1.1, Type=Integer, Value=1
OID=.1.0.8802.1.1.1.1.1.2.1.2.1, Type=Integer, Value=1

• Printix Support may ask for the output of the SnmpWalk. To pipe the result in to the 
output.txt file, type: SnmpWalk -r:192.168.1.9 > output.txt

Printer properties
On the Setup tab, you can modify the properties of the printer.

Additional tabs:
• Print queues
• Printix Go
• Diagnostics
• History

Modify printer name
1. In Printer name, select the Modify  icon.
2. In the Modify printer name dialog box, edit the Printer name or select one from the Printer 

name suggestions list.
3. Select Save.
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Modify properties for multiple printers

1. On the Printers page, select the check boxes of multiple printers and select Modify.
2. Optionally, select Select network under Network if you want to change this.

If you do not select a network, the printers remain on their current network.
Site managers can only select networks belonging to managed sites.

3. Optionally, select Select SNMP configuration under SNMP configuration if you want to 
change this.
If you do not select an SNMP configuration, the printers continue to use their current SNMP 
configuration.
You can only select global SNMP configurations and SNMP configurations assigned to the 
selected network. If you select a network that does not contain all SNMP profiles of the 
selected SNMP configuration, the SNMP configuration field is set to the default SNMP 
configuration.

4. Optionally, select Select under Protocol if you want to change this.
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If you do not select a protocol, the printers continue to use their current protocol and port.
• Select IPP, and if required, change the Port to a different value than the default port number 

80.
• Select IPPS, and if required, change the Port to a different value than the default port 

number 443.
• For both IPP and IPPS, select Path to modify this if required. If you open the printer's web 

page, you may find information about Port and Path.
• Select LPR and, if required, change the Port to a different value than the default port 

number 515. Optionally, enter a Print queue name.
• Select RAW and, if required, change the Port to a different value than the default port 

number 9100.
5. Enter a Location if you want to modify this.
6. Select Save.

The entered location is saved for the selected printers.

 When you change Network, Protocol, or SNMP configuration, it is recommended to 
verify that printing and printer status still works.

Name
• Printer name

By default, the printer name is set to the model name of the printer. The printer name appears 
on the printer ID sign and in the Printix App. However, users will see the Print queue name on 
their computer and in the Printix Client. If, for example, two active print queues exist, you should 
name them so users will both know the physical printer and be able to determine the difference 
in purpose of the print queues.
Example:
• Printer name Reception has two queues with the Print queue names Reception and Reception 

Staple.
• Reception is the general purpose and the one most frequently used of the two print queues.
• Reception Staple has a print driver configuration that staples together sheets by default.

 Instead of using the printer model as the default value for the printer name, the software 
can use alternatives. For example, the printer's hostname (works for HP) or the printer's device 
name (works for Lexmark). Contact Product Support if you are interested in this. Printix Support 
must enable populatePrinterName for you.

• Model
The model name of the printer.

• Serial number
The serial number of the printer. Select the Modify  icon if you want to add it, change it, and/or 
copy it to the clipboard.
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Location
• Location

Description of the printer's location.
Example: Head Office, Reception

Connection
• MAC address

The hardware address of the printer.
• Printer address

The printer's hostname or IP address. By default, print data is sent as RAW print through TCP port 
9100. Print data can be sent through another port and the LPR (Line Printer Remote) protocol. 
There must be a space between the IP address and $$.
• RAW mode via TCP port 9100 (default)

Example: 192.168.1.94
• RAW mode via another TCP port

Example: 192.168.1.94 $$port:9101
• IPPS via TCP port 443

Example: 192.168.1.94 $$ipps
• IPPS via another TCP port

Example: 192.168.1.94 $$ipps$$port:621
• IPP via TCP port 80

Example: 192.168.1.94 $$ipp
• LPR via TCP port 515

Example: 192.168.1.94 $$lpr:myqueue
• LPR via another TCP port

Example: 192.168.1.94 $$lpr:myqueue$$port:712
• Windows print queue via Printix Redirector

Example: \\computername\printqueuename

 Appending, for example, $$ipps to the Printer address to manually configure protocol and port 
overrides the selection of Protocol and Port.

• Network
The name of the network the printer is on.
Site managers can only select networks belonging to managed sites.

• SNMP configuration
The SNMP configuration. It is blank if the default SNMP configuration is used.
You can only select global SNMP configurations and SNMP configurations assigned to the 
selected network. If you select a network that does not contain all SNMP profiles of the selected 
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SNMP configuration, the SNMP configuration field is set to the default SNMP configuration and 
becomes blank.

• Protocol
The protocol (IPP, IPPS, LPR, RAW) used to send print data to the printer. Select the Modify  icon 
if you want to change it.
For printers registered before April 2021, you should select Contact printer to obtain and update 
the list of protocols supported by the printer. Prior to this, you should ensure the protocols are 
also enabled on the printer.

Registration
• Features

Select Features to see the printer features. If the printer features are not registered correctly, 
change Page description language, Color supported, and/or 2-sided supported to match what 
you know the printer supports. Select Save to save changes.

• Contact printer
Select Contact printer if you need to replace a printer or just want to redo the registration of the 
printer in regards to:
• MAC address: The hardware address obtained from the printer.
• Model: The model name obtained from the printer.
• Serial number: The serial number obtained from the printer.
• Protocol: The protocols (IPP, IPPS, LPR, RAW) supported by the printer. Ensure the protocols 

are also enabled on the printer.
• Features:

• Page description language (PCL5, POSTSCRIPT, PCLXL, PDF, …)
• Color supported
• 2-sided supported

 If your Ricoh printer was installed without the Printix Client, you must obtain the 
registration parameters from this topic and manually enter them before the registration.

Card reader
• Vendor and Created are only available if Printix Go is installed and a card reader is connected to 

the printer.

NFC tag
1. Select Delete NFC tag to unregister the NFC tag.

Only available if the printer has been registered with an NFC tag.
2. Select Yes.

ID sign
1. Select Print printer ID sign.
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2. Use the browser to print the page with the printer ID signs.
3. Mount the printer ID sign with QR code at the printer.

Report
1. Select Download CSV report.
2. The downloaded file can be opened in a text editor.

The file name is: printername.csv.
The first row contains the column headings and the subsequent lines (one per day) contains 
the date and meter readings. If no readings have changed on a particular day, no line is written 
for that day.
• Date: year, month, day
• Toner levels: colorBlack, colorMagenta, colorCyan, colorYellow
• Sheets: sheetsSimplex, sheetsDuplex, sheetsTotal
• Impressions: impressionsMono, impressionsColor, impressionsTotal

Debug printer
Useful to collect events related to the printer, such as configuration modifications and user activity.

1. Select Debug printer.
The Debug log dialog box appears.

2. Select New debug session.
3. Select a duration for the session, then select Begin debug session.

The new session appears in the debug log.
The program starts collecting events related to the printer, such as configuration modifications 
and user activity. The program keeps collecting events until someone cancels the session or 
the duration expires.

4. Optionally, you can cancel the session before the configured duration by selecting it in the 
debug log and selecting End debug session.
Selecting Close closes the dialog box but it does not stop the session. After closing the dialog 
box, you can return at any time by selecting the session in the debug log.

5. Select Download debug log to download the collected logs as a CSV file.
You can download the logs of any session, regardless whether it is ongoing or expired.

 In the downloaded CSV file, error messages are written in English, and special characters 
in card names may be encoded with base 64.

Print queues
Lists a printer's print queues.

To get here:
1. Open the Printers page.

139



Tungsten Printix Administrator Guide

2. Select More  and Queues.
• Select a print queue's Name, or select More  and Modify to open the Print queue 

properties page.
• Select the check boxes of print queues and select Modify at the bottom of the screen. Select 

the check box at the top of the list to select all print queues.
• Select Refresh  to refresh the list.
• Select More  and Info to see information about the print queue:

• Name, Active, Add print queue automatically, Remove print queue automatically, 
and Via the cloud

• Printer 2-sided by default and Print in black by default
• Groups

List of groups the print queue is a member of.
• Mobile print

 Do you see print queues you do not know of? See Why are there additional print queues?

Create print queue
Select Create print queue to create a print queue.

Sort by
1. Select item to sort by this.
2. Select item again to toggle sort order:  and 

• Select Name to sort by print queue name.
• Select Active to sort print queues according to this.
• Select Add print queue automatically to sort print queues according to this.
• Select Remove print queue automatically to sort print queues according to this.
• Select Via the cloud to sort print queues according to this.
• Select Options to sort print queues according to:

• Print 2-sided by default
• Print in black by default

• Select Groups to sort print queues according to group membership.
• How to add groups to a print queue

• Select Mobile print to sort print queues according to this.

Delete
• To delete a print queue, select More  and Delete.
• Select the check boxes of print queues and select Delete  .
• Select the check box at the top of the list to select all print queues.

 When you delete a print queue, the corresponding Printix print queue on users' computers will 
also be deleted by the Printix Client.
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Printix Go

• Select Install to install Printix Go on the printer.
Only available after the printer has been assigned a Go configuration and a Sign in profile.

• Select Uninstall to uninstall Printix Go from the printer.

Go configuration
• Select the Gear  next to Go configuration to open the Go configuration menu:

• Select Create Go configuration to create a new Go configuration.
• Select Assign Go configuration to assign an existing Go configuration to the printer.
• Select Remove Go configuration to remove the Go configuration from the printer.
• Select Modify to modify the Go configuration.

• Select Update if you have modified the Go configuration or assigned another Go configuration.

Sign in profile
• Select the Gear  next to Sign in profile to open the Sign in profile menu:

• Select Create sign in profile to create a new sign in profile.
• Select Assign sign in profile to assign an existing sign in profile to the printer.
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• Select Remove sign in profile to remove the sign in profile from the printer.

Diagnostics

Use the Diagnostics tab to see the Status of a printer:
•  Ready
•  Warning
•  Error
•  Printer is not monitored or not responding: The status text is the last known status of the 

printer.
• Select Network (Network1) to see details about this.
• Select Printer (Reception) to see details about this.
• Select Printer (ASD) icon to open the Printer properties page.
• See Toner levels in percentage (See the disclaimer in Printer requirements).
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Warning status details
Possible causes for printer Warning  status:
• Paper low
• Input tray is empty
• Toner low
• Service required
• Marker supply missing
• Output tray near full
• Overdue preventive maintenance

Error status details
Possible causes for printer Error  status:
• No paper
• No toner

• This status is also reported if any other consumables, besides ink (Black, Cyan, Magenta, and 
Yellow), are empty. The error can also depend on the printing technology and the user's role.

• Door open
• Jammed
• Input tray missing
• Output tray missing
• Output tray full
• Offline

• Printer is not powered on.
• Printer is not connected to the network.
• Printer address has changed.

Printer registration issues
If you are trying to add a printer and have issues, open the Unregistered printers page.

History
On the History tab, you can see when changes were made to the printer.

1. Optionally, select Level to control the amount of information shown.
The levels are as follows: Debug, Info, and Warning. The level is cumulative, that is, if you 
select Debug, you will also see all events logged at the Debug (default), Info, and Warning
level.

2. Optionally, select Date.
3. Choose From date and time.
4. Choose To date and time.
5. Select Apply.

• Select Refresh  to refresh the list.
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 To get insights into what was printed by whom through Printix, you can set up analytics
so you can interact with the Printix Power BI report to get insights. The printer's page 
counters can be obtained by selecting Download CSV report on the Printer properties
page. On the User properties page's History tab, you can see information about the user's 
printing.

Print queues

Lists the print queues.
• Select Print queue name, ID, or select More  and Modify to open the Print queue properties

page.
• Select the print queue's number of Computers  to see the list of computers that have the print 

queue installed.
• Select the check boxes of print queues and select Modify at the bottom of the screen. Select the 

check box at the top of the list to select all print queues.
• Select Refresh  to refresh the list.
• Select More  and Info to see information about the print queue:

• Name: The name of the print queue.
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• ID: The ID of the printer the print queue is pointing.
• Computers: The number of computers that have the print queue installed and managed by 

Printix.
• Groups
• Active
• Add print queue automatically
• Remove print queue automatically
• Via the cloud
• Process PDF/XPS
• Exempt from secure print
• Mobile print
• Publish with Universal Print
• Print in black by default
• Printer 2-sided by default

How to see the computers that have the print queue installed

Select the print queue's number of computers  (such as 217) to see the list of computers that have 
the print queue installed.

 Do you see print queues you do not know of? See Why are there additional print queues?

Search
1. Select Search .
2. Enter print queue name or printer ID.

The search is not case-sensitive.
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Filters

Select Filters.
• Select Network to filter by this.

• A Mobile  icon next to a network indicates the network is Mobile print enabled.
• Select Network type to filter by this.

• Company (Same as if no filter is selected)
• Home office

• Select Computers to filter by the number of computers that have the print queue installed and 
managed by Printix.

• Select Active to filter by this.
• Select Add print queue automatically to filter by this.
• Select Remove print queue automatically to filter by this.
• Select Via the cloud to filter by this.
• Select Process PDF/XPS to filter by this.
• Select Exempt from secure print to filter by this.
• Select Mobile print to filter by this.
• Select Publish with Universal Print to filter by this.
• Select Print 2-sided by default to filter by this.
• Select Print in black by default to filter by this.

How to see the print queues that have Via the cloud selected
1. Select Filters.

146



Tungsten Printix Administrator Guide

2. Select Via the cloud to filter by this.

Sort by
1. Select item to sort by this.
2. Select item again to toggle sort order:  and 

• Select Print queue name to sort by name.

Delete print queue
• To delete a print queue, select More  and Delete.
• Select the check boxes of print queues and select Delete .
• Select the check box at the top of the list to select all print queues.

 When you delete a print queue, the corresponding Printix print queues on users' computers 
will also be deleted by the Printix Client.
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Print queue properties

To get here:
1. Open the Print queues page or the Printers page to view the print queues.
2. Select a print queue.

On the Setup  tab, you can modify the properties of the print queue.
Additional tabs:
• Groups 
• Drivers 
• Computers 
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Modify properties for multiple print queues

1. On the Print queues page, select individual print queues and select Modify.
2. Make your modifications.

See also:
• Modify Via the cloud for multiple print queues

3. Select Save.
The modified settings will be saved for the selected print queues.

 If a Printix Anywhere print queue is among the selected print queues, you cannot modify
Remove print queue automatically.
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Name
• Print queue name

The print queue name cannot contain the characters '\' and ',' and must be unique for the 
printer. Uppercase and lowercase letters are treated the same. The print queue name is what 
users will see on their computer and in Printix Client. If the printer has just one print queue, 
we recommend that you keep the Printer name and print queue name the same. However, if, 
for example, two active print queues exist, you should name them so users will both know the 
physical printer and be able to determine the difference in purpose of the print queues.
Example:
• Printer name Reception has two queues with the Print queue names: Reception and

Reception Staple.
• Reception is the general purpose and the one most frequently used of the two print queues.
• Reception Staple has a print driver configuration that staples together sheets by default.

• Printer name
The name of the printer.

• Model
The model name of the printer.

Settings
• Active

Select this to make the print queue Active so all users can use the print queue. Remember to
print the printer's ID sign and mount this at the printer. That way, users can easily identify the 
physical printer. Deactivating a print queue will not remove the print queue from computers 
where it is already installed. To remove a print queue from computers, you should delete the 
print queue.

 Administrators can always use all print queues. In Printix Client, the administrators will see a 
star ★ after the printer ID if the print queue is not active.
Example: ASD ★ Reception

• Add print queue automatically
Select this to add the print queue automatically on users' computers running Printix Client. Only 
available if the print queue is Active. It may take a few minutes before the print queue is added.
• Print queue is added automatically when the computer is on the same network as the printer

network or if "Via the cloud" is selected for the print queue.
• Print queue is not added automatically while a computer is on an Unknown network.
• Print queue can also be added automatically based on users' and computers' group 

membership.
• Remove print queue automatically

Select this to remove the print queue automatically when the computer connects to another 
registered network. Not available if "Via the cloud" is selected.
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 The print queue is not removed if all the following conditions apply:
• The user is signed in to the Printix Client.
• The user is a member of the print queue's group.
• On the "Groups" tab, "Add print queue automatically" is selected.

• Via the cloud
Select this to allow users to print to the printer even though they are not on the same network as 
the printer.
• On all networks

Print queue will be available via the cloud to all computers on all networks, including 
computers on unknown networks. Not available if "Remove print queue automatically" is 
selected.

• On selected networks only
Print queue will be available via the cloud on the selected networks only. In a zero trust 
networks environment, use this to make the site's printers (on their own printer network) 
available to only the computers on the site's computer network.

• See also: Modify Via the cloud for multiple print queues


• Site managers have the following restrictions:

• The print queue must belong to a managed site.
• Only the "On selected networks only" setting is available, and only networks belonging to 

managed sites can be selected.
• ALL computers get the print queue if both of these are selected: a) "Add print queue 

automatically" and b) "Via the cloud" and "On all networks". If "On selected networks only" is 
selected, all computers on the selected networks get the print queue.

• Process PDF/XPS
Typically, if the destination printer supports PDF, documents printed through Printix Chromebook
and Print Anywhere documents are sent as PDF data to the printer. Select "Process PDF/XPS" to 
force the PDF data to be processed according to the print queue's print driver configuration and 
thereby finishing options. This will typically mean that the PDF print data is converted into for 
example PostScript or PCL in accordance with the print driver's page description language (PDL). 
Printing will take longer, compared to sending the PDF data directly to the printer, because the 
data needs to be processed a second time and also the document is likely to increase in size.
• If the destination printer supports XPS, XPS documents are sent as XPS data to the printer. 

Select "Process PDF/XPS" to force the XPS data to be processed according to the print queue's 
print driver configuration. Contact Product Support if you want to have your Printix Client 
updated.

• See also: How to enable processing of PDF documents.
• Exempt from secure print
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Select this to always have the documents print directly. Settings that would otherwise have the 
user release the documents are ignored. The following Secure print settings are ignored: "All 
users must print securely", "Selected groups must print securely", "All users must Print Later by 
default", "Selected groups must Print Later by default". The following Printix Client settings are 
also ignored: "Preferred print method": "Print Later" and "Ask me to select print method at every 
print". Home office print queues are always "Exempt from secure print".

• Enable mobile print
Select this to allow printing from Android and iOS/iPadOS phones and tablets to this print queue. 
Only available if "Enable mobile print" is selected on the "Settings" page's "Mobile print" tab. On 
Android phones and tablets, the print queue will be available regardless of the Android phone's 
and tablet's network connection (Wi-Fi or mobile network). On iOS/iPadOS phones and tablets on 
a Wi-Fi network, the print queue will be broadcast as an AirPrint printer as follows:
• A print queue will be broadcast on the printer's network, if the network has "Enable mobile 

print" selected.
• A print queue, that has "Via the cloud" selected, will be broadcast on all networks that have

"Enable mobile print" selected.
• A Printix Anywhere print queue will be broadcast on all networks that have "Enable mobile 

print" selected.
• Mobile-printed Print Anywhere documents can, unless the printer's QR code or NFC tag is 

scanned, be released only to printers that have a print queue with "Via the cloud" selected.
• Publish with Universal Print

Select this to publish the print queue as a printer share in Universal Print. Only available if
"Integrate with Universal Print" is enabled. Allow 1-2 minutes before the print queue is created as 
a printer share in Universal Print.
• The name of the printer share will contain (UP), which is short for Universal Print.

Example: Printix Anywhere (UP)
• If the print queue has "Exclusive access" selected in Printix Administrator, this information is 

carried through to Universal Print and reflected on the printer share's Access control settings. 
Otherwise, "Allow access to everyone in my organization" is selected for the printer share in 
Universal Print.

• See also: How to add secure print to Universal Print.
• Process PS

This is available only for Printix Anywhere print queues. If selected and you use PostScript print 
driver the PostScript to PDF conversion component (PS2PDF.dll) with resulting improved color 
and paper size control is used. If not selected, then no conversion to PDF happens.

Options
• Print 2-sided by default

The printer must support automatic printing on both sides. Users can still print on one side only, 
but will have to ask for this at each print. 2-sided printing is also known as: Duplex, Double-sided, 
and Front-and-back. This may not always work (see DISCLAIMER).
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• "Print 2-sided by default" does NOT affect Print Anywhere, because the document is in PDF.
• If a Print Anywhere document is released to a print queue that has "Process PDF/XPS" and

"Print 2-sided by default" selected, the driver will be prompted to print on both sides.

• Print in black by default
The printer must support colored printing. Users can still print in color, but will have to ask for 
this at each print. This may not always work (see DISCLAIMER).

Groups
On the Groups tab, you can add the groups the print queue should be a member of. Only available 
if groups (Microsoft Entra or Google) are enabled.
• Select Add groups to add groups.
• Select Settings for non-groupmembers and Add print queue automatically to enable Add print 

queue automatically on the Setup tab.
• Select Refresh  to refresh the list.
• Select Search  to search for a group by its name or description. The search is not case-sensitive.
• Select More  and Modify to modify a group.

• Select the check boxes of groups and select Modify (N) at the bottom of the screen. N is the 
number of groups selected. Select the check box at the top of the list to select all groups.

• Select More  and Remove to remove a group from the print queue.
• Select the check boxes of groups and select Delete  next to the search bar. Select the check 

box at the top of the list to select all groups.

When you modify a group, you have the following options:
• Set Exclusive access.
• Add print queue automatically.
• Set as default printer.

Exclusive access
• A print queue that has Exclusive access selected for one or more groups. It can be accessed ONLY 

by the users in any of those groups.
• A print queue that does not have Exclusive access selected for any group. It can be accessed by all 

users.
• Printing to a print queue without access results in a message such as: Print to BNM is not 

allowed.

Add print queue automatically
• A print queue that has no groups is automatically added if the global Add print queue 

automatically setting is selected on the Setup tab of the Print queue properties page.
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• A print queue that has Add print queue automatically selected for one or more groups is 
automatically added to the computer when a user in any of those groups signs in.
• Users that are not a member of any of the groups on the Groups page will have the print 

queue added automatically if the global Add print queue automatically setting is selected on 
the Setup tab of the Print queue properties page.

• If none of the groups in a print queue has Add print queue automatically selected, the print 
queue is not installed regardless of the global Add print queue automatically setting.

• A print queue is only added if the user can access it (see Exclusive access above).

Set as default printer
• A print queue that has Set as default printer selected for one or more groups becomes the 

default printer for the users and computers in the group.

 If Set as default printer is selected for multiple print queues, it is random which one is set as 
default. The Printix Client overrides the user's selection of default printer every time the Printix 
Service is started or it receives updates to its list of printers and their configuration.

Drivers

On the Drivers  tab, you can see the list of print drivers.
• Select Show all to show drivers for all Windows and macOS editions.
• Select System, Print driver, or select  and Change print driver .
• Select  and Lock selection of print driver  or Automatic selection of print driver .
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• Windows 11 support. On the Drivers tab on the Print queue properties page: New term

Windows covers Windows 10 ×64 and Windows 11 (Windows 11 ×32 does not exist). This is 
to reflect that print drivers and print driver configurations for Windows 11 are the same for 
Windows 10 ×64.

• Windows Server 2022 support. The term Windows Server covers Windows Server 2016, 
Windows Server 2019, and Windows Server 2022.

• Select Add a new configuration  to add a new print driver configuration.
• Select the Modify  icon to rename the print driver configuration.
• Select the Setup  icon to modify the print driver configuration.
• Select the Delete  icon to delete the print driver configuration.

Update print queue on computers
Select Update print queue on computers.

Configure multiple print queues
Select Distribute print queue configuration.
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Print drivers page

1. Search  for print driver.
The search is not case-sensitive.
• Select Show only uploaded print drivers to list print drivers that have been uploaded and 

added to your Printix driver store.
• If the print driver is uploaded, the date and time of the upload is shown below the print 

driver name.
• Select Filters to filter by Latest version and Language.
• Select  and  Modify to select the Language the print driver is using (Example: Español) 

and write an optional Comment. Unknown language is shown if the language has not been 
confirmed. Universal print drivers often support Multiple languages. Print drivers in the 
Printix driver store that were published before this functionality was introduced (May 2017) 
may be shown as Unknown language, but in most cases, the driver will be in English.

• Select Load more at the bottom of the page to see more drivers.
• Select Refresh  to refresh the list.

2. Select print driver.
• If the printer does not support the print driver's output, then either nothing comes out when 

you print, or you will get pages with lots of weird looking characters.
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• If you cannot find a print driver listed for a specific model, check to see if it is included as 
part of a series of printers. For example, a printer with the model number 603 might use the 
print driver for the "600" or "600 Series."

• If multiple matching print drivers exist and their name includes for example PCL 6 or 
PostScript, then cross-check with the printer's supported formats (page description 
language) listed on the page, for example: POSTSCRIPT, PCLXL (same as PCL 6), …

• Host-based printers (typically cheaper printers) have built-in support for Windows Graphical 
Device Interface (GDI) and rely on the Windows computer to rasterize the pages into dots 
(bitmaps).

3. Select Change print driver.
The print driver selection will be locked .

4. Optionally, use Print test page to make sure the print driver works properly with the printer.

Computers

Lists the Computers that have a print queue installed.
• Select computer's Hostname to open Computer properties.
• Select the computer's number of Tasks  to see the list of tasks for the computer.
• Select Refresh  to refresh the list.
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 A delay of up to 30 minutes may occur before the result of the below Add task is fully reflected 
in Printix Administrator. If a computer is offline, it will pick up on the tasks after it comes online.

Search
1. Select Search .
2. Enter part of the computer's hostname.

The search is not case-sensitive.

Update print queue on computers
Select Update print queue on computers.

Add print queue to computers
Select Add print queue to computers.

Delete
• To delete the print queue, select  and Delete print queue.
• Select the computers and select Delete .
• Select the check box at the top of the list to select all computers.

Users
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Lists the Users .
• Select user's Name or select  and Modify to open User properties.
• Select a user and select Modify at the bottom of the screen.
• Select Refresh  to refresh the list.
• Select  and Info to see information about the user:

• Name, Role, Email, and Sign in method of the user.
• Computers. List of computers the user is signed into.
• Groups. List of groups the user is a member of.

The Sign in method is represented by icons:
• Email  (Printix account)
• Microsoft 
• Google 
• Okta 
• OneLogin 
• Active Directory AD

Add user
Select Add user  to add a user.

Search
1. Select Search .
2. Enter part of the user's name or email.

The search is not case-sensitive.

Filters
Select Filters.
• Select Role to filter by role.

• User
• Guest
• System manager
• Site manager

 Users with the Guest role only appear if you filter for Guest.

Sort by
1. Select item to sort by this.
2. Select item again to toggle sort order:  and 

• Select Name to sort by name.
• Select Email to sort by email address.
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Delete user
• To delete a user, select More  and Delete.
• Select the check boxes of users and select Delete .
• Select the check box at the top of the list to select all users.

• If you delete a user in Microsoft Entra ID or Google Workspace, the user is also deleted in 
Printix.

User properties

On the Setup  tab, you can modify the role of the user.
1. Select Role and thereby what functions the user can perform.
2. Select Save at the bottom of the screen.

An email is sent to the user.
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• You will be signed out of Printix Administrator if your role is changed.
• There must be at least one user with the system manager role.

Additional tabs:
• Managed sites  (only visible to users with site manager role)
• Groups 
• History 

Role

• User
Can use Printix.

• System manager
Full rights in Printix Administrator to control everything, including the roles of users.

• Site manager
Manage printers and print queues at selected sites.
• Only available if user is a member of a Site manager group.

• Guest
Can use Printix.
• The role of a guest cannot be changed.

Sign in method
• Email  (Printix account)
• Microsoft 
• Google 
• Okta 
• OneLogin 
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Notifications
Only available if role is System manager.
• Receive email about

• Select Data breach to be notified about breach of data.
• Select Updated legal documents to be notified about updated versions of: Terms of Service, 

and Privacy Policy.

Computers
List of the computers the user is signed into.

Managed sites

On the Managed sites  tab, you see the sites and site folders where the user is a member of a Site 
manager group.

Selecting a folder or a site opens the Sites page with the selected folder or site displayed. Folders 
and sites that are directly managed by the site manager are displayed in bold.
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Groups

On the Groups  tab, you see the groups that have been added to print queues and which the user 
is a member of. Only available if groups (Microsoft Entra or Google) are enabled.

Search
1. Select Search .
2. Enter name or description.

The search is not case-sensitive.

Sort by
1. Select item to sort by this.
2. Select item again to toggle sort order:  and 

• Select Name to sort by group name.
• Select Description to sort by group description.

History
On the History  tab, you can see what changes were made to the user.

1. Optionally, select Level to control the amount of information shown.
The levels are as follows: Debug, Info, and Warning. The level is cumulative, that is, if you select 
Debug, you will also see all events logged at the Debug (default), Info, and Warning level.

2. Optionally, select Date.
3. Choose From date and time.
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4. Choose To date and time.
5. Select Apply.

• Select Refresh  to refresh the list.

Computers

Lists the Computers .
• Select computer's Hostname or select  and Modify to open Computer properties.
• Select the computer's number of Tasks  to see the list of tasks for the computer.
• Select a computer and select Modify at the bottom of the screen.
• Select Refresh  to refresh the list.
• Select  and Info to see information about the computer:

• Hostname.
• Status. The status of the computer (Online or Offline).
• Network. The network the computer is on.
• Address. List of addresses (IPv4 and IPv6).
• Type and System.
• Version. The version number of the Printix Client running on the computer.
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Search
1. Select Search .
2. Enter part of the computer's hostname.

The search is not case-sensitive.

Filters
Select Filters.
• Select Network to filter by this.
• Select Type to filter by this.

• Desktop
• Laptop
• Server

• Select System to filter by Windows and macOS editions. The term Windows Server is used for 
both Windows Server 2016, Windows Server 2019, and Windows Server 2022.

• Select OS to filter by Windows and macOS.
• Select Act as capture gateway to filter by this.
• Select Act as print gateway to filter by this.
• Select Allow computer to look up users to filter by this.
• Select Online to filter by this Status.

Sort by
1. Select item to sort by this.
2. Select item again to toggle sort order:  and 

• Select Hostname to sort by hostname.

Delete computer
• To delete a computer, select More  and Delete.
• Select the check boxes of computers and select Delete .
• Select the check box at the top of the list to select all computers.

If you delete a computer that is running Printix Client, it will reappear on the list after some time. 
Deleting a computer is relevant if you want to remove computers you suspect are not being used 
anymore. Computers that have not responded in 2 months are automatically deleted.
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Computer properties

To get here:

1. Select Menu  > Computers.

2. Select a computer's Hostname or select More  and then Modify.

On the Setup  tab, you can view the properties of the computer.

Additional tabs:
• Groups 
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• Print queues 
• Tasks 
• Diagnostics 
• History 

Info
• Version

The version number of the Printix Client running on the computer.
• Address

The addresses of the computer.
• SSID

SSID of the Wi-Fi network the computer is connected to.
• External IP

The external IP address of the computer.
• System

The Windows or macOS edition the computer is running.
• Type

The type of the computer (Server, Desktop, and Laptop).
• Status

The status of the computer:
•  Online
•  Offline

• Test connection
Select this to update the connection of the computer. It will respond Test OK if the connection to 
the computer is working.

Network
• Test network

Test if communication to the network's gateways is working. For each registered network 
the computer is on, it will test each registered network's gateways and report either OK or
Connection failed. If the computer has an adapter that is on an Unknown network, testing is not 
supported and the result is marked as - (minus). Testing the network may take minutes rather 
than seconds if the network has many gateways.

• Ping network address
Verify if a printer can be reached by this computer (responds to the ping request). Select the
Printer  icon to select one of the printers on the network or paste the network address from 
the clipboard. On the Printer properties page, Printers page, and Unregistered printers page, 
you can copy the printer's network address to the clipboard by hovering on the address and then 
selecting the appearing Copy address  icon.

• Adapters
Lists the computer's network Adapters (for example, one for LAN and one for Wi-Fi). You can see 
the Gateway IP and Gateway MAC address for each network adapter.
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If the computer is on an Unknown network, you can, for the gateway you want to add, either:
• Select Select network to add the gateway to an existing network.

• Select a network. Optionally, enter part of the network name to search for it. Select Select 
network.

• Site managers can only select networks belonging to managed sites.
• Select Create new network to create a new network with this gateway.

• Enter Network name and select Create new network.
• Virtual adapters

This is relevant if printing must work when no physical computer with Printix Client is online 
on the printer network or if printers and computers are kept on separate networks (zero trust). 
The computer must be able to route (through VPN) to the printers on the printer networks. The 
computer, preferably a server, will typically run in the cloud, for example Azure.

Settings
• Act as capture gateway

Optionally, select Act as capture gateway if the Printix Client on this computer should be 
the preferred choice for handling scanned documents from printers with Printix Capture and 
delivering these to the selected workflow destination. The selected computer should be one 
that is likely to be online. The setting is relevant for Windows computers and is ignored on 
Mac computers. Printix Cloud will otherwise automatically select an online Printix Client on the 
printer's network if none of the preferred computers are online.

• Act as print gateway
If a printer does not support PDF, the PDF document must be processed using a matching print 
driver before it can be sent to the printer. This requirement applies to Print Anywhere documents 
and documents printed through Printix Chromebook. Select Act as print gateway if Printix Client 
on this computer should be the preferred choice for processing and printing the document, and if 
required, add the print queue and print driver. The selected computer should be one that is likely 
to be online. If the computer runs Windows, the document will also be processed according to 
the print queue's print driver configuration and thereby finishing options.

If your school's students are using Printix Chromebook, you can create a robust setup, configuring 
a number of desktop computers that are online anyway, to act as print gateway. That way, PDF 
documents are primarily processed by these computers rather than other computers, such as 
teachers' laptop computers.

 If you are using Groups to grant Exclusive access to print queues that have Process PDF/XPS
selected, or print queues that reference a printer that does not support PDF/XPS printing, then 
you MUST ensure the user signed in to Printix Client on this computer is also a member of those 
groups. Otherwise, the document will not be printed.

• Use computer's static IP address for SSL certificate
Select Use computer's static IP address for SSL certificate if the Printix Client on this computer 
does not have a fully qualified domain name and only has a static IP address. While this setting 
is enabled, Printix Go accesses the Printix Client through its IP address when using a capture 
workflow.
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If the computer's static IP address changes, the Printix Client must be uninstalled and installed 
again.

• Allow computer to look up users
It is only relevant to select this in Azure Virtual Desktop and Remote Desktop Server (RDS) 
environments. If selected, the Printix Client can use alternate methods to establish who the 
printing user is when it is not the signed in user. The method may, for example, involve the 
domain, email address, and the Microsoft Entra user property onPremisesSamAccountName.

Discover
• Discover printers

Select this to discover printers you suspect were not found during the initial discovery.
• You can discover additional printers by installing Printix Client on print servers and then start 

discovery on these.
• The result is securely and silently transferred to the Printix Cloud without any required 

interaction from the user on the computer.
• Computer must be available.

• SNMP configuration
Optionally, select an SNMP configuration.

Groups

On the Groups  tab, you see the groups that have been added to print queues and the groups 
which the computer is a member of. Only available if groups (Microsoft Entra or Google) are 
enabled.
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Print queues

Lists the computer's Print queues .
• Select Refresh  to refresh the list.
• Managed is selected if the print queue is printing through Printix.

 A delay of up to 30 minutes may occur before the result of the below Add, Convert, Update, Set 
as default, and Delete tasks are fully reflected in Printix Administrator. If the computer is offline, it 
will pick up on the tasks after it comes online.

Search
1. Select Search .
2. Enter print queue name.

The search is not case-sensitive.

Add print queues to computer
Select Add print queues to computer.

Convert print queues
Select Convert print queues.
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Use this to test the conversion of print queues before they are enabled on a per network or global 
basis.

Update print queue
Select  and Update print queue.

Set as default printer
Select  and Set as default printer.

Delete
• To delete a print queue, select  and Delete.
• Select the print queues and select Delete .
• Select the check box at the top of the list to select all print queues.

Tasks

Lists the computer's Tasks .

Clear expired tasks
Select Clear expired tasks to delete tasks with status Failed or Timeout.

Search
1. Select Search .
2. Enter task type or status.

The search is not case-sensitive.

Sort by
1. Select item to sort by this.
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2. Select item again to toggle sort order:  and 
• Type

• Add print queue
• Convert print queues
• Delete print queue
• Update print queue

• Created
• Status

• Pending
• Timeout
• Failed

Diagnostics
Select the Diagnostics  tab to collect the latest status from the computer.

Collected
• Collected

The date and time the status was collected. Empty if the computer is not available.

Printers
• Printix printers

Number of print queues handled by Printix. Name starts with the three-letter printer ID.
• Printers in total

Number of print queues defined on this computer, including those used at home or outside the 
company.

Documents
All the statistics are calculated since the last time the Printix Service program was started on the 
computer.
• New

Number of submitted documents.
• Printed in total

Number of documents printed.
• Printed

Number of documents that were printed directly.
• Printed later

Number of documents that were released and printed with Print Later.
• Stored on computer

Number of documents currently stored on the computer.
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Communication
All the statistics are calculated since the last time the Printix Service program was started on the 
computer.
• Proxy

Is Yes if the computer has established secure communication with the Printix Cloud.
• Average response time

Number of milliseconds it takes for Printix Cloud to respond in average.
• Polling tasks

Number of scheduled tasks, such as printer status and statistics reporting.
• Priority tasks

Number of tasks that had to be executed right away, such as sign-in and diagnostics.
• Packages sent

Number of packages sent.
• Packages received

Number of packages received.
• Bytes sent

Number of bytes sent.
• Bytes received

Number of bytes received.

Server responses
List of server responses and their frequency. Server errors are not translated.

Examples:
• OK
• Unauthorized

Printer errors
List of printers with reported errors and the number of errors reported for each printer.

History
On the History  tab, you can see what printed and what changes were made to Printix Client on 
the computer.

1. Optionally, select Level to control the amount of information shown.
The levels are as follows: Debug, Info, and Warning. The level is cumulative, that is, if you select 
Debug, you will also see all events logged at the Debug (default), Info, and Warning level.

2. Optionally, select Date.
3. Choose From date and time.
4. Choose To date and time.
5. Select Apply.

• Select Refresh  to refresh the list.
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Groups

To get here:

Select Menu  > Groups .
Page is only available if groups (Microsoft Entra or Google) are enabled.
• Groups are synchronized automatically at approximately 20 minute intervals. Only changes are 

synchronized.
• Select Resynchronize groups to start a synchronization.
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• Printix will only synchronize users/group membership for users that are registered in Printix 

and for groups after these groups are used within Printix, that is, if users are a member of a 
group that: A) Is used with Print queues, B) Is used with Secure print (that is, Must print securely 
groups, Print Later by default groups, or Secure print level groups), C) Is used with Home office, 
D) Is used with Capture workflows, or E) Is used with Site manager roles.

• See Why does a group have no or missing users?.
• Nested groups are not supported.

See also:
• How to add groups to a print queue
• How to add print queues to a group

Search
1. Select Search .
2. Enter group name or description.

The search is not case-sensitive.

Filters
Select Filters.
• Select Domains to filter by this.
• Select Groups to filter by this.

• Only groups used with Printix
• Only groups not used with Printix
• All available groups

Remove group from list
It is currently not possible to remove a group from the list. After it has been used with Printix 
and thereby is being synchronized, it stays on the list. If it is deleted in Microsoft Entra ID/Google 
Workspace, it is also be removed from the list.
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Group properties

Additional tabs:
• Print queues 
• Users 
• Computers 

Secure print
• Must print securely

Select this if the group's users must print securely.
• Print Later by default

Select this if the groups users will have Print Later as the preferred print method.
• Minimum secure print level

Select the minimum secure print level for the group's users. Default is 0.
• 0: None
• 1: Must scan QR code
• 2: Must scan NFC tag
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• 3: Must sign in at printer

Print queues

On the Print queues  tab, you see the print queues this group has been added to.

See also:
• How to add print queues to a group
• How to add groups to a print queue

To modify print queues:

Select Modify  to add, modify, or delete print queues in regards to the group.
See also: How to add print queues to a group.
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Users

On the Users  tab, you see the users that are a member of this group.
• Synchronize

Select this to manually synchronize the users. Should report "Group synchronization has been 
verified."

 Printix will only synchronize users/group membership for users that are registered in Printix 
and for groups once these groups are used within Printix, that is, if users are a member of a group 
that: A) Is used with Print queues or B) Is used in connection with Secure print (that is, Must print 
securely groups, Print Later by default groups, or Secure print level groups).
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Computers

On the Computers  tab, you see the computers that are a member of this group.
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History

Lists the History .
1. To get here, select Menu  > History .

 Fetching data may be displayed for a little while before you start to see data.

You can also open History  from the Properties page of a selected:
• Printer

See what printed on the printer and what changes were made to the printer.
• User

See what the user did and what changes were made to the user.
• Computer

See what printed and what changes were made to Printix Client on the computer.
2. Select the Type:

• System
Changes to the setup, such as authentication, customization, group synchronization, data 
extraction, and changes to the user's role.

• Printers
Events involving printers.

• Computers
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Events involving computers with Printix Client.
• Users

Events involving users and administrators.
• Documents

Events involving documents (print and capture).
3. Optionally, select Level to control the amount of information shown.

The levels are as follows: Debug, Info, and Warning. The level is cumulative, that is, if you select 
Debug, you will also see all events logged at the Debug, Info (default), and Warning level.

4. Optionally, select Date.
5. Choose From date and time.
6. Choose To date and time.
7. Select Apply.

• Select Refresh  to refresh the list.
• For security and confidentiality reasons, documents are not referenced by their name.

Remote Printix support
The below commands can be issued remotely by Printix support for a selected computer:
• UPLOAD_LOGS_DIRECT

Request the Printix Client on the computer to upload log files.
• TEST_FOR_NEW_SW

Request the Printix Client on the computer to check for new software.
• REINITIALIZE_CONFIGURATION

Request the Printix Client on the computer to get its configuration.
• DISCOVER_ENVIRONMENT

Request the Printix Client on the computer to discover printers.
• GET_DEVICE_STATUS_V2

Request the Printix Client on the computer to get status of printers.
• GET_PRINTER_PARAMETERS

Request the Printix Client on the computer to get printer parameters.
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Authentication

To get here:

Select Menu  > Authentication .

 You can always invite users through email.

Enable one or more of these sign-in methods to offer users a bit of self-service and not have to 
invite them.
• Left pane: Shows a summary of the enabled sign in methods.

• Select Modify  for an enabled method to open the corresponding tab.
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• Sign in with email is enabled by default.
• See also: How to remove sign in with email

• Microsoft Entra ID is automatically enabled if you signed up through Microsoft Azure 
Marketplace or Microsoft AppSource.

• Right pane: Add and enable sign-in methods.
• Select Add 'Sign in with Microsoft' to add your first or an additional Microsoft Entra directory.
• Select Add 'Sign in with Google' to add your first or an additional Google domain.
• Select Add 'Sign in with OIDC' to open the OIDC tab.
• Select Add 'Sign in with Okta' to open the Okta tab.
• Select Add 'Sign in with OneLogin' to open the OneLogin tab.
• Select Active Directory authentication to open the Active Directory tab.
• Select Sign in with email to open the Self-registration tab.

Microsoft Entra ID
On the Microsoft Entra ID tab, you can enable users to sign in with their Microsoft work or school 
account.
• Automatic registration of the user happens the first time the user signs in.
• Microsoft Entra ID is part of Office 365 for business.
• Gives users single sign-on (SSO) to Printix.
• Supports multiple Microsoft Entra directories per Printix Home.
• Passwords are handled entirely by Microsoft Entra ID.
• Supports Microsoft Entra guest users, also known as Microsoft Entra business-to-business (B2B) 

collaboration users.

Google
On the Google tab, you can enable users to sign in with their Google Workspace account (not 
@gmail.com).
• Automatic registration of the user happens the first time the user signs in.
• Gmail service with your email domain is part of Google Workspace.
• Gives users single sign-on (SSO) to Printix.
• Supports multiple Google domains per Printix Home.
• Passwords are handled entirely by Google.

OIDC
On the OIDC tab, you can enable and configure OpenID Connect authentication.
• Automatic registration of the user happens the first time the user signs in.
• Gives users single sign-on (SSO) to Printix.
• Supports multiple OIDC domains per Printix Home.
• Passwords are handled entirely by OIDC.
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Okta
On the Okta tab, you can enable and configure Okta authentication.
• Automatic registration of the user happens the first time the user signs in.
• Gives users single sign-on (SSO) to Printix.
• Supports multiple Okta domains per Printix Home.
• Passwords are handled entirely by Okta.

OneLogin
On the OneLogin tab, you can enable and configure OneLogin authentication.
• Automatic registration of the user happens the first time the user signs in.
• Gives users single sign-on (SSO) to Printix.
• Supports multiple OneLogin domains per Printix Home.
• Passwords are handled entirely by OneLogin.

Active Directory
On the Active Directory tab, you can enable users to sign in with their network user name and 
password.
• Automatic registration of the user happens the first time the user signs in.
• A computer must be online on the network; otherwise, the on-premise Active Directory server 

cannot be contacted for authentication.

Sign in with email
On the Self-registration tab, you can enable users who are not on the network to register 
themselves with their work email address and a password.
• Self-registration of users.
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Microsoft Entra ID

On the Microsoft Entra ID tab, you can enable and configure Microsoft Entra authentication. You 
only need a user account in Microsoft Entra ID to configure Microsoft Entra integration.

See also:
• How to enable Microsoft Entra authentication
• How to accept Printix for all users
• How to enable Microsoft Entra groups
• How to accept integration with Universal Print
• How to grant access to Microsoft OneDrive
• How to grant access to Microsoft SharePoint Online
• How to add guest users to Microsoft Entra ID
• How to add multiple Microsoft Entra directories
• How to switch Microsoft Entra directory
• How to remove sign in with email
• How to deploy Printix Client with Microsoft Endpoint Manager
• How to deploy Printix Client

Microsoft Entra directory
1. Select Connect.
2. On the Microsoft sign-in page:

• Enter your work or school account.
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• Enter your password.
3. Select Sign in.
4. If prompted, select Accept to grant permissions to Printix.

This is necessary for Printix to configure Microsoft Entra integration.
5. Select OK if the connection to Microsoft Entra ID was successful.

From now on, the sign-in page will show Sign in with Microsoft.

6. Optionally, to only allow global administrators to connect a Printix Home to your Microsoft 
Entra directory, select Accept next to Must be global administrator to connect other Printix 
Homes.
You must have the global administrator role in Microsoft Entra ID to do this.

7. It is recommended to accept Printix for all users. Select Accept.
8. Optionally, synchronize groups. Select Accept.
9. Optionally, select Add  to add another Microsoft Entra directory.
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• If more than one Microsoft Entra directories exist, sign-in to Printix Client is no longer 

automatic the first time on Microsoft Entra joined Windows 10 and 11 computers. The user 
must select a directory (acme.com or ajax.com) and then sign in, but only the first time.

• Universal Print is supported for one, but not multiple Microsoft Entra directories.
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Google

On the Google tab, you can enable and configure Google authentication.

See also:
• How to enable Google authentication
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• How to enable Google groups
• Printix Chromebook
• How to remove sign in with email

Google domain
1. Select Connect.
2. On the Google sign-in page, sign in using your Google Workspace account (does not end in 

@gmail.com).
• Enter your account.
• Enter Password.

From now on, the sign-in page will show Sign in with Google.

3. Optionally, synchronize groups. Select Accept.
4. Optionally, select Add  to add another Google domain.

189



Tungsten Printix Administrator Guide

 If more than one Google domains exist, the user must select a domain (acme.com or 
ajax.com) and then sign in, but only the first time.
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OIDC

On the OIDC tab, you can enable and configure the use of identity providers that adhere to 
the OpenID Connect (OIDC) and OAuth 2.0 standard protocols for user authentication and 
authorization. Ping Identity and Amazon are examples of such identity providers.

OIDC
• Name

Enter the name you want users to see when they sign in.
The user will see the button labeled Sign in with {name}. However, if other authentication 
methods are enabled with at least one domain, the user will see a button labeled Sign in with 
OIDC. When the users select this button, a list appears with the name. In the first case, you may 
want to enter the name of the identity provider (such as Ping), and in the latter case, you may 
want to enter the domains so users can differentiate them (such as acme.com and ajax.com).

• Client ID
Enter the Client ID.

• Client Secret
Enter the Client Secret.

• Discovery document url
Enter the URL of the discovery document.
Refer to your identity provider's documentation to obtain the URL.
Sometimes, the URL may also be referred to as the "discovery document uri."
The URL should point to a JSON document.
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Sign in with OIDC
If you see Sign in with OIDC, select this and sign in with your OIDC account.
• Automatic registration of the user happens the first time the user signs in with OIDC to Printix.
• Single sign-on (SSO) to Printix with users' OIDC account.

Okta

On the Okta tab, you can enable and configure Okta authentication.

See also:
• How to enable Okta authentication

Okta domain
• Redirect URI

Copy the Redirect URI value to clipboard so you can paste it as you configure Okta.
• Domain

Your Okta domain (acme.okta.com).
• Client ID

Paste the Client ID value you copied as you configure Okta.
• Client Secret

Paste the Client Secretvalue you copied as you configure Okta.
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• Authorization server
If Okta for your organization is set up with an authorization server, enter the value, otherwise 
leave it empty (default).

Sign in with Okta
If you see Sign in with Okta, select this and sign in with your Okta account.
• Automatic registration of the user happens the first time the user signs in with Okta to Printix.
• Single sign-on (SSO) to Printix with users' Okta account.

OneLogin

On the OneLogin tab, you can enable and configure OneLogin authentication.

See also:
• How to enable OneLogin authentication

OneLogin domain
• Redirect URI

Copy the Redirect URI value to clipboard so you can paste it as you configure OneLogin.
• Domain

Your OneLogin domain (acme.onelogin.com).
• Client ID
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Paste the Client ID value you copied as you configure OneLogin.
• Client Secret

Paste the Client Secret value you copied as you configure OneLogin.

Sign in with OneLogin
If you see Sign in with OneLogin, select this and sign in with your OneLogin account.
• Automatic registration of the user happens the first time the user signs in with OneLogin to 

Printix.
• Single sign-on (SSO) to Printix with users' OneLogin account.
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Active Directory

On the Active Directory tab, you can configure Active Directory authentication. You just need a user 
account in Active Directory to configure this.

See also:
• How to enable Active Directory authentication
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• How to deploy Printix Client

Settings
• Default domain

To improve user experience, enter the default domain so users belonging to the domain can 
sign in with user name. Users not belonging to the domain have to sign in with domainname
\username.

• Active Directory server address
The address of your Active Directory (AD) server.

• Active Directory server port
Default TCP ports:
• Secure LDAPS: 636
• LDAP: 389

• Enable secure LDAPS
Clear this to use the LDAP protocol. Remember to set the port correctly.

• Network
Select the network the Active Directory server is on. A computer with Printix Client must be 
online on that network, otherwise the on-premise Active Directory server cannot be contacted 
for authentication and you will see the message: No connection to Active Directory server. We 
recommend installing the Printix Client on an extra computer with permanent network access. 
You could for example install Printix Client on an existing on-premise server.

• Username
Enter your network user name (not saved) to test the connection.

• Password
Enter your network password (not saved) to test the connection. The password must not contain 
the character hash (#).

 Signing in with user name (Active Directory sAMAccountName) is supported by the web Printix 
App, but not the Printix App for Android and iOS/iPadOS. Sign-in with user name is not supported 
if you sign in through printix.net.
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Self-registration

On the Self-registration tab, you can add approved email domains.

See also:
• How to enable self-registration
• How to remove sign in with email
• How to deploy Printix Client

Settings
• Enable self-registration

Select this to enable self-registration. Remember to add email domain.
• Sign in with email

This is selected by default. Familiarize yourself with the consequences of clearing this.

Domain
• Email must end with

To prevent unauthorized users from registering, the last part of their email address must be an 
approved email domain.

• Add email domain?
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Select this to enter additional email domains. The first approved email domain is by default based 
on the work email that was used to sign up for this product. For example, the work email domain: 
acme.com.

 Do NOT allow email domains, such as gmail.com, outlook.com, yahoo.com, or similar email 
service domains, because this removes control over who can sign in.

Users without an approved email domain can be added with invitation. In any case, the user will 
receive a confirmation email message, and to complete the registration, the user must select the 
link in the email within 72 hours.
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Subscription
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• You can pay by credit card, or contact Product Support to enquire about an invoicing option/

annual payment by credit card or bank transfer (no cheques). If your Printix Home was 
created by a Printix partner, the payment is handled through the partner, and the Billing and
Transaction tabs are not present.

• The Subscription page is only accessible to users with the system manager role. If someone 
from your finance department needs access to change the credit card, you need to change their 
role to system manager.

To get here:

Select Menu  > Subscription.
On the Billing tab, you can manage your subscription.
Additional tabs:
• Transactions
• History
• Legal documents

See also:
• How to change who receives subscription emails
• How to cancel subscription

Billing information
• Legal company name or organization name

The company name to be included on invoices. State your exact/legal company name.
• Finance email

The email address to which billing information is sent.
• Finance contact name

The name of the person receiving billing information. The name will be stated on the invoice in 
the "att:" field.

• Country code
Two-letter country code. Germany for example, use DE.

• VAT number
The value added tax identification number. Do NOT include the country code here, only the 
numbers, without spaces. See also: VAT number equivalent for select countries.

• Billing address
The address to be included in invoices. Typically the company address. The address has to 
correspond to the entered company name and VAT number.

VAT number equivalent for select countries

Country VAT number equivalent

Australia GST number
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Country VAT number equivalent

Canada GST number

Denmark Momsnummer (CVR)

France Numéro de TVA

Finland ALV numero

Germany Umsatzsteuer-Identifikationsnummer

Italy Partita IVA

Netherlands BTW-nummer

New Zealand GST number

Norway MVA-nummer

Portugal Número de IVA

Romania Cod TVA

Spain Número de IVA

Sweden Momsregistreringsnummer

Türkiye KDV numarası

US TAX ID number
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Credit card

• Billing information
Select Modify  to modify billing information.

• Finance cc emails
Select Modify  to add additional email addresses to be on CC (carbon copy).

• Your order number or reference information
Select Modify  to enter text that will appear on your invoice. You can for example use it to enter 
your order number.
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 European regulatory requirement for Strong Customer Authentication (SCA)

Beginning 14 September 2019, your bank might require you to verify your credit card payments. 
As a result, if you add a new credit or debit card, or register a new account, you may see a pop-
up from your bank that requests a user name and password, a code sent to email or text, or any 
other authentication method supported by your bank. If you have any questions or issues with 
one of these popups, it is best to contact your bank directly, because Printix does not control the 
form. If you have additional questions, contact finance.printix@tungstenautomation.com.

1. Fill in the details:
• Card number

The number of the card.
• MM / YY

The expiration month (MM) and year (YY) of the card.
• CVC

The card security code (CVC) is typically the last three or four digits printed, not embossed 
like the card number, on the signature strip on the back of the card.

2. Select I hereby authorize Printix to take payments from my credit/debit card account in 
accordance with the terms of my agreement with Printix.

3. Select Start subscription.

Transactions
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Lists the transactions.
• Select Retry to try to pay the transaction if it failed.
• Select Change credit card to use another credit card.
• Select the invoice number (19395) to download the invoice.

• Select Authenticate payment to approve payment with the authentication method supported by 
your bank. If you have any questions or issues with one of these popups, it is best to contact your 
bank directly, because Printix does not control the form.
If you have additional questions, contact finance.printix@tungstenautomation.com.

 The Subscription page is only accessible to users with the system manager role. If someone 
from your finance department needs access to change the credit card, you need to change their 
role to system manager.
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History

History of invoices.
1. Select Menu  > Subscription .
2. Select the History  tab.
3. Select the invoice number to open the invoice.

 If the browser's pop-up blocker prevents the invoice from opening, select Allow to see 
the invoice.

In the above example, you can see four entries on the History tab:
• First entry covers the free 1-month trial with 11 users.
• Second entry covers the first period with subscription with 15 users. Invoice has been made 

and can be viewed by selecting the invoice number (15353) in the ID column.
• Third entry covers the second period with subscription with until now 13 users. Invoice is not 

yet made, because the period has not yet ended.

Sort
• Select any of the column headers to sort according to period.
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Legal documents

On the Legal documents  tab, you can accept and access legal documents.
• Printix Security and Privacy
• Terms of Service (end-user license agreement)
• Privacy Policy
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Settings

To get here:

Select Menu  > Settings .
Additional tabs:
• Secure print 
• Printix Go 
• Capture workflows 
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• Cloud storage 
• Analytics 
• Mobile print 
• Home office 
• SNMP 

Deletion
• Mark documents for deletion after

Recommended default is 1 day. The maximum is 7 days.
• Documents can be reprinted until 12 hours after they are marked for deletion.

Printix Client
• Allow users to add printers via Printix Client

Clearing this will remove Printers from the Printix Client menu for users. Administrators will 
always be able to select Printers.

Scenarios where preventing users from adding printers through the Printix Client could be relevant:
• Existing group policies for printing are used to control which user gets which printer, so users do 

not need to be able to add printers themselves. Remember to select Convert print queues.
• Printix Anywhere  is the only print queue users will need, and it is configured to be 

automatically added for everyone.
• All Printix printers are configured to be added automatically, so users do not need to do this.

 Want to ensure users only print to printers through Printix?

Print queue naming
• Printer ID after printer name

The three-letter printer ID is placed at the end.
Example: Reception ASD

• Printer ID before printer name
The three-letter printer ID is placed at the start.
Example: ASD Reception

• Printer name without printer ID
Select this if you do not want users to see the printer ID as part of the printer name.
Example: Reception

All Printix print queues will adopt to the selected naming within a few moments.
• Hide printer ID in Printix Client

Select this if you do not want the three-letter printer ID to appear on the Printix Client Printers
page.
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Migration policy
• Create default print queue

If selected, then when a printer is registered without a print queue, the system will create a 
default print queue and name the print queue the same as the printer model name. When 
migrating print servers, it is recommended to clear this as part of the Implementation setup.

• Convert print queues
Global setting to control if all print queues that point to a Printix printer should be converted. You 
can also set this per network. Before you enable this on a larger scale, you can test conversion 
of print queues on a single computer. At conversion, the port settings are modified to use an
Internet Port and allow printing through Printix.
• Network printers are converted if they are setup with a Standard TCP/IP Port or WSD Port.
• Shared network printers are converted.

Example: Reception on PrintServer becomes Reception ASD, ASD Reception, or Reception 
depending on the choice of Print queue naming.
See also: Why is the shared print queue not converted right away?

• Locally connected printers (USB) are not converted.
• No printers are converted on servers.

• Change print driver
The converted print queue will use the print driver that the printer is setup to use in Printix 
Administrator. If you leave this cleared (default) the print queue will continue to use the current 
print driver and its settings.

Email messages
• Signature

This text is inserted after "Friendly regards" in the email that is sent to users after they register. 
You can change this to include contact details for your Help Desk. By default this is populated 
with the name and email address of the first System manager.
Example: John Smith, john.smith@acme.com

The name and email address of the administrator is used as signature in the email that is sent to a 
user when the administrator adds the user or changes the role of the user.
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Secure print

On the Secure print tab, you can enable and configure the print methods: Print Later and Print 
Anywhere.

To get here:
1. Select Menu  > Settings.
2. Select the Secure print tab.

Secure print
• Enable secure print

Users can choose to print securely and wait to release documents until they are ready to collect 
the documents.

Print Later
• Enable Print Later
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Select this to allow users to print confidential documents and control finishing options.
• Document can be released to the printer it was printed to.
• Document is processed using the matching print driver, with full control of finishing options, 

for example.
• All users must print securely

Select this so all users must release their documents and cannot print directly.
• Can also be set for users in a group.
• Print queues can be exempt from secure print.

• Selected groups must print securely
Select this to select the groups whose users must print securely.
• Select Setup  to open the Groups  menu:

• Select Groups to see currently selected groups.
• Select Add groups to add groups.
• Select Remove groups to remove groups.

• Print queues can be exempt from secure print.
• All users must Print Later by default

Select this if all users should have Print Later as the preferred print method.
• In the event a user wants to submit a document directly to a printer, the user must deselect 

Print Later at every print.
• Can also be set for users in a group.
• Print queues can be exempt from secure print.

• Selected groups must use Print Later by default
Select this to select the groups whose users will have Print Later as the preferred print method.
• Select Setup  to open the Groups  menu:

• Select Groups to see currently selected groups.
• Select Add groups to add groups.
• Select Remove groups to remove groups.

• Print queues can be exempt from secure print.
• Allow direct print if offline

If selected, users who otherwise must use Print Later can print directly without Internet 
connection to the Printix Cloud. This is if the computer and printer are on the same network, that 
is, the document does not need to be printed through the cloud. On the computer, a yellow dot is 
displayed on the Printix Client icon  when the Printix Client is in the state Connection failed and 
cannot register documents with Printix.

 When the Printix Client is offline, a red dot is displayed on the icon  instead. The yellow dot 
can also appear next to the red dot  if additionally, your Printix Client is also on an unknown 
network.

The Select print method dialog box will pop up and allow the user to select Print to submit the 
document directly to the printer. User and usage data is still collected and then sent to the Printix 
Cloud after the Internet connection is back. Print Anywhere does not work without Internet 
connection to the Printix Cloud.
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Print Anywhere
• Enable Print Anywhere

Select this to allow users to print confidential documents.
• Document can be released to any Printix (ASD, BNM, …) printer.
• Document is sent as PDF, except if the printer does not support PDF printing or Process PDF/

XPS is selected. In this case, the PDF document is processed using a matching print driver.
• Print Anywhere does not work without Internet connection to the Printix Cloud.

• Select Setup  to open the Print Anywhere  menu:
• Select Print queues to see available Print Anywhere print queues.
• Select Create print queue to create a Print Anywhere print queue.

1. In the Create print queue dialog box, enter Print queue name.
• Cannot contain the characters '\' and ','
• Must be unique for the printer. Uppercase and lowercase letters are treated the same.

2. Optionally, clear Active to allow administrators (you) to test printing before allowing users to 
add the print queue.

3. Select Save.

Secure print levels


• WARNING: Prior to selecting 1 - Must scan QR code, you should ensure that 1) Printers are 

equipped with a printer ID sign with QR code, and 2) Users have the Printix App installed on a 
phone or tablet.

• WARNING: Prior to selecting 2 - Must scan NFC tag, you should ensure that 1) Printers have 
been registered with NFC tag, 2) Users have the Printix App installed on a phone or tablet.

• Minimum secure print level
The global minimum secure print level. Default is 0 (see table). A higher secure print level can be 
set for selected users in a group.
• 0 - None
• 1 - Must scan QR code
• 2 - Must scan NFC tag
• 3 - Must sign in at printer

• Secure print level groups
• Select Setup  to open the Groups  menu:

• Select Groups to see currently selected groups.
• Select Add groups to add groups.
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• Select Remove groups to remove groups.

Level Printer ID method Printix App Remarks

0 - Installed app and web 
app

• Select a printer in the 
Printix App on the 
user's phone or tablet.

• Select a printer in the 
web Printix App in a 
web browser on the 
user's phone, tablet, or 
computer.

1 QR code Installed app • Scan the printer's QR 
code  with the Printix 
App on the user's 
camera-equipped 
phone or tablet.

2 NFC tag Installed app • Scan the printer's NFC 
tag  with the Printix 
App on the user's NFC-
enabled phone.
• Android 

Most Android 
phones support 
NFC.

• iOS 
Apple iPhone 7 and 
above with iOS 11 or 
higher can be used 
to scan NFC tag.

3 Card or ID code - • Present card or sign 
in with ID code at a
Printix Go-enabled 
printer.

 A user is free to use higher Secure print level printer ID method. For example, a user with 
secure print level 1, must scan QR code to select printer, but can also choose to scan the printer's 
NFC tag. For a user with secure print level 2, printer selecting by QR code scan is not allowed, and 
therefore the user must scan the printer's NFC tag.

Printix Go
• Require PIN code for sign in with card

This is cleared by default. Select this if users are to both present card and enter PIN code to sign 
in to Printix Go-enabled printers.

• Require PIN code for sign in with ID code
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This is selected by default. If users are to only enter ID code to sign in to Printix Go-enabled 
printers, you must contact Product Support so we can change the setting for you. This is for 
security reasons.

• Users who must print securely, will only need to do this for printers with Printix Go
This is cleared by default. Select this so the affected users must release documents they submit to 
printers with Printix Go. These users are thereby exempt from using Printix App on their phone to 
release documents when printing directly to other printers.

Printix Go

On the Printix Go  tab, you can create, modify, and delete sign in profiles and Go configurations.
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To get here:
1. Select Menu  > Settings .
2. Select the Printix Go  tab.

• Select a Go configuration name to open the Go configuration page to see the printers that 
use the Go configuration.

• Select a sign in profile name to open the Sign in profile page to see the printers that use the 
sign in profile.

Create Go configuration
1. In Go configurations, select Create  to create a Go configuration.

• In Name, type a descriptive name for the Go configuration.
• In Description, type an optional description for the Go configuration.
• In Sign in method, optionally, change it from Select automatically to the method you want.
• In Access control, optionally, clear the printer functions that will not require sign in.

• On Konica Minolta, all functions are considered locked as sign-in is required to use any 
function anyway.

• On Ricoh, users can sign in as guest as long as no functions are locked by Access control.
2. Select Save.

Delete Go configuration
1. Select Go configuration setup  to open the Go configuration menu.
2. Select Delete Go configuration.

The option is only available if the Go configuration is not assigned to any printers.
• Select  Printers to see which printers are using the Go configuration.

Create sign in profile
1. In Sign in profiles, select Create  to create a sign in profile.

• In Name, type a descriptive name for the sign in profile.
• In Username, type the user name of an account that can access the printer's web page.

Example: admin
• In Password, type the password of an account that can access the printer's web page.

Example: admin
• In Description, type an optional description for the sign in profile.
• In Add SNMP configuration, select an SNMPv1 configuration that matches what is 

configured on the printer.
• On Xerox, you MUST select an SNMP configuration, AND the Set Community Name

specified in the selected SNMPv1 configuration MUST match the Community Name 
Read/Write configured as part of SNMPv1/v2 on the printer.

2. Select Save.

Delete sign in profile
1. Select Sign in profile setup  to open the Sign in profile menu.
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2. Select Delete sign in profile.
The option is only available if the sign in profile is not assigned to any printers.
• Select  Printers to see which printers are using the Sign in profile.

Go configuration

You can see the printers that use the Go configuration, and you can modify the Go configuration.
• Select Go configuration setup  to open the Go configuration  menu:

• Select Modify to modify the Go configuration.
• Select Assign to printers to assign to and optionally install on multiple printers.
• Select Delete Go configuration to delete the Go configuration. Only available if no printers are 

using the Go configuration.
• Select Go configurations to open the list of Go configurations.
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• Select Update if you have modified the Go configuration and wish to update ALL the listed 
printers. This is required for the printers to start using the modified Go configuration.
• On Ricoh, an Update will also result in an Install. To update from version 0.4.10.0 to version 

2.0.0.27 or later, you MUST do an Uninstall and then an Install.
• Select Printer setup  to open the Printer  menu:

• Select Assign sign in profile to assign a sign in profile to this particular printer.
• Select Update Go configuration to update the Go configuration of this particular printer.
• Select Printer properties to open the Printix Go tab on the Printer properties page.

Go configuration
• Name

Descriptive name of the configuration.
• Description

Optional description of the configuration.
• Sign in method

How will users sign in at the printer.
• Select automatically

Maps to Card if a card reader is connected to the printer. Otherwise, it maps to ID code. 
Mapping changes within 10 seconds after the card reader is either connected or disconnected. 
If it does not change, restart the printer. See also: Printix Go Konica Minolta card reader 
limitations.

• Card
A card reader must be connected to sign in with card.

• ID code
• Card or ID code

If a card reader is not connected, only ID code can be used to sign in.
• Go functions

What Printix functions should be installed on the printer.
• Print: Users can release pending documents with the installed Printix Print function. This is 

always installed.
• Capture: Users can select a workflow and scan documents with the installed Printix Capture 

function.
• Access control

What printer functions require signing in.
• Copy
• Email

• On Ricoh, the access control of Email always matches the settings for Scan. Changing the 
access control of Email has no effect.

• Scan
• Fax
• Print from USB Drive: Users can print from a flash memory or mass storage device.

• On Ricoh, guests can use Print from USB Drive even if it is locked, so changing the access 
control of Print from USB Drive has no effect.
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• Scan to USB Drive: Users can scan to a flash memory or mass storage device.
• On Ricoh, the access control of Scan to USB Drive always matches the settings for Scan. 

Changing the access control of Scan to USB Drive has no effect.
• Everything else: Select this if you want Printix Go to lock access to other functions (besides the 

above ones). Selecting this will also lock access to third-party applications. Submit a support 
request if you want Printix Go to control access to a particular application.
• On Konica Minolta, all functions are considered locked as sign in is required to use any 

function anyway.
• On Ricoh, users can sign in as guest as long as no functions are locked by Access control.

• Email sender
Leave this blank and when using a printer's Email function, the From field will be prefilled with 
the email address of the signed in user. However, this can cause some SMTP servers to reject the 
sending of the scanned documents. In this case, you can type a default sender email address in 
the Email sender field and this will be used as the sender rather than the email address of the 
signed in user.

Sign in profile

You can see the Printers that use the sign in profile.
• Select Sign in profile setup  to open the Sign in profile  menu:

• Select Assign to printers to assign the sign in profile to multiple printers.
• Select Delete sign in profile to delete the sign in profile. Only available if no printers are using 

the sign in profile.
• Select Sign in profiles to open the list of sign in profiles.
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• Select Verify sign in profile to verify the sign in profile on the printers.
• Select Printer setup  to open the Printer  menu:

• Select Change sign in profile to change to another sign in profile.
• Select Remove sign in profile to remove the sign in profile from this printer.
• Select Printer properties to open the Printix Go tab on the Printer properties page.

Capture workflows

On the Capture workflows tab, you can create, modify, and delete workflows.

To get here:
1. Select Menu  > Settings .
2. Select the Capture workflows  tab.

Additional tabs:
• Workflows
• Destination profiles

Search
1. Select Search .
2. Enter a workflow name.

The search is not case-sensitive.

Filters
Select Filters.
• Select Active to filter by this.
• Select Source to filter by this.
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Delete
• To delete a workflow, select  and Delete.
• Select the workflows and select Delete  .
• Select the check box at the top of the list to select all workflows.
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How to create a workflow

1. Select Create workflow.
• How to get started with capture and workflow
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2. Configure the workflow.
• How to create a workflow for email
• How to create a workflow for Microsoft OneDrive
• How to create a workflow for Microsoft SharePoint Online
• How to create a workflow for Connector

3. Select Create.
4. Verify that the workflow works as expected.
5. Activate the workflow.
6. Optionally, make the workflow available to selected groups.
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Workflow properties
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Settings
• Workflow name

The name of the workflow. Must not contain any leading or trailing spaces and must not contain 
the characters: ~ " # % & * : < > ? / \ { | }

• Active
Select this to make the workflow Active so users can use the workflow. This is cleared by default. 
In Printix Go and Printix App, administrators can always see and use all workflows.

• All users can use this workflow
Select this so all users can use the workflow (when it is active). This is selected by default.

• Selected groups can use this workflow
Select this and then add the groups whose users can use the workflow.
• Select Add group to add groups.
• Select X to remove a group.

Source
• Source

Select between:
• Printer 

Printer with Printix Go and Printix Capture.
• Mobile 

Phone or tablet with the Printix App installed. Capture on mobile is intended for text-based 
documents and output is delivered in black and white. Supported image file formats: JPG, PNG, 
and TIFF.

Printer scan settings
• Orientation

The orientation of the original document. Select between Portrait or Select automatically.
• Not all printers support the Select automatically function. For these printers, even though 

Select automatically is configured in the workflow, the printer always switches to the default 
Portrait option.

• On some printers, if Paper size is set to Select automatically, Orientation may be ignored.
• Paper size

The default is Select automatically, but otherwise, select between A3, A4, A5, A6, B4, B5, Ledger,
Legal, Letter, Statement, and Executive.
• Not all paper sizes (for example, Select automatically and A3) might be supported on some 

printers.
• Color

Select between Color, Grey, and Black and white. The default is Grey.
• Resolution

The resolution in dots per inch (dpi). Select between: 200, 300, 400, and 600. The default is 300.
• 2-sided

Select this to scan both sides of the paper. This is cleared by default.
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Destination
• Destination

Select between:
• Email 
• Microsoft OneDrive 
• Microsoft SharePoint Online 
• Connector 

• Email
To prevent sending spam emails, an email recipient MUST either be registered as a user in your 
Printix Home or have the email domain of your organization (Example: @acme.com). If the same 
email recipient is listed multiple times, the user will receive multiple emails.
• To

The default is {user_email}. There must be at least one email recipient. Use comma to separate 
multiple email recipients.

• CC
The default is empty.

• BCC
The default is empty.

• Subject
Enter an optional subject. It is possible to use variables, such as {workflow_name}.

• Microsoft OneDrive
The global administrator in Microsoft Entra ID must Grant access to OneDrive before OneDrive 
becomes available as a destination. Data will be written into the My files folder or subfolders 
thereof according the workflow.
• Destination profile

Select Create destination profile. If you have an existing destination profile that can be used, 
select Select destination profile.
• In Name, type a descriptive name for the destination profile.

• Microsoft SharePoint Online
The global administrator in Microsoft Entra ID must Grant access to SharePoint before SharePoint 
becomes available as a destination.
• Destination profile

Select Create destination profile. If you have an existing destination profile that can be used, 
select Select destination profile.
• In Name, type a descriptive name for the destination profile.
• In Site, select a SharePoint site.
• In Document library, select a SharePoint document library.
• In Folder, browse to the folder within the SharePoint document library.

• Connector
Workflow data will be sent to the connector which stores them on a destination thereof according 
to the connector configuration.
• Destination profile
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Select Create destination profile. If you have an existing destination profile that can be used, 
select Select destination profile.
• In Name, type a descriptive name for the destination profile.
• In Connector URL, enter the URL of the connector.
• In Network, optionally, from the networks configured on the Networks page, select the 

network where the connector is hosted. Leave it blank if the connector is hosted on a public 
URL.

• In Signature algorithm, select the signature algorithm to be used for communication with 
the connector.

• In Shared secrets, add one or more shared secrets for communication with the connector.
• File name

The default is the name of the workflow followed by time. Instead of using the workflow name, it 
is possible to construct the file name based on Variable and Date.

Variables and date

Select and paste variable in fields (folder, file name, or subject). A variable can only be used once in 
a field.
• Variable

• Printer ID. Only relevant if Source is Printer.
Example: ASD
Variable: {printer_id}

• Printer location. Only relevant if Source is Printer.
Example: Head office, Reception
Variable: {printer_location}

• Printer name. Only relevant if Source is Printer.
Example: Reception
Variable: {printer_name}

• User name.
Example: John Smith
Variable: {user_name}

• Workflow name.
Example: Send to email
Variable: {workflow_name}

• Date
Select the date format: {MM_DD_YYYY}, {MM_DD_YYYY_TIME}, {DD_MM_YYYY},
{DD_MM_YYYY_TIME}, {YYYY_MM_DD}, and {YYYY_MM_DD_TIME} (default, example: 
2022-12-31_23-59). Date and time are in UTC (Coordinated Universal Time).

• File name example
• Original example:

{workflow_name}-{yyyy_dd_mm_dd_time}
• Example with prefix text 'test' and {printer_id} variable:

test{workflow_name}-{printer_id}-{yyyy_dd_mm_dd_time}
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File type
• File type

Select between:
• PDF

It is possible to control Image quality and PDF compatibility.
• Image quality

The default is Medium. Select between High, Medium, and Low.
• PDF compatibility

The default is PDF 1.6. Select between: PDF 2.0, PDF 1.7, PDF 1.6, PDF 1.5, PDF 1.4, PDF 1.3,
PDF/A-1b, PDF/A-2b, PDF/A-3b, PDF/A-2u, PDF/A-3u, PDF/A-1a, PDF/A-2a, PDF/A-3a.

• Language for OCR use
The default is English. Select Select language to select the languages for OCR use.

• Microsoft Word
The format is .docx. It is possible to control Image quality.
• Image quality

The default is Medium. Select between High, Medium, and Low.
• Language for OCR use

The default is English. Select Select language to select the languages for OCR use.

 Only select languages for OCR use if they are included in the documents. In particular, setting 
an Asian language for non-Asian texts (and vice versa) is likely to produce unusable results.

Image processing
If Source is Mobile, then image processing is controlled on the mobile.
• Delete blank pages

Select this to have blank pages deleted. This is cleared by default.
• Rotation

Select between Rotate automatically, 0°, 90°, 180°, and 270°. The default is Rotate automatically. 
The rotation is performed before any OCR.

• Deskew
Select this if you want captured images to be deskewed automatically. This is cleared by default.

• Crop
Select this if you want captured images to be cropped automatically. This is cleared by default.
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Destination profiles

Shows the Destination profiles and you can Create, Modify, and Delete destination profiles.
• Select Create destination profile to create a destination profile.
• Select Name or select  and Modify to open the Destination profile.

Destination profile
A destination profile is used for these workflow destinations:
• Connector

The destination profile consists of:
• A descriptive Name for the destination profile
• A Connector URL for communicating with the connector
• Optionally, a pre-configured Network where the connector is hosted
• A Signature algorithm for communicating with the connector
• One or more Shared secrets for communicating with the connector

• Microsoft OneDrive
The global administrator in Microsoft Entra ID must grant access to OneDrive before OneDrive 
becomes available as a destination.
The destination profile consists of:
• A descriptive Name for the destination profile
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• Microsoft SharePoint Online
The global administrator in Microsoft Entra ID must grant access to SharePoint before SharePoint 
becomes available as a destination.
The destination profile consists of:
• A descriptive Name for the destination profile
• A SharePoint Site
• A SharePoint Document library
• A Folder within the SharePoint document library

Delete destination profile
• To delete a destination profile, select  and Delete.
• Select the destination profiles and select Delete .
• Select the check box at the top of the list to select all destination profiles.

 A destination profile can only be deleted when no workflows are using the destination profile.

How to create a destination profile
1. Select Create destination profile.
2. Select Sign in method.

If only one is available, it is selected automatically.
3. Select Destination.

If only one is available, it is selected automatically.
• How to create a destination profile for Microsoft SharePoint Online
• How to create a destination profile for Microsoft OneDrive
• How to create a destination profile for Connector
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Cloud storage

Enable storage of pending documents in your own secure cloud storage.

To get here:
1. Select Menu    > Settings  .
2. Select the Cloud storage  tab.

Benefits:
• Availability will increase as users can release Print Anywhere and Print Later documents 

while their computer is offline. A Printix Client still needs to be online on the printer's 
network to release the documents.

• Performance will improve, because you can set up your own cloud storage that is closer to 
your users.

• Security will improve, because documents are stored in your own cloud storage.

 Currently, only the first active cloud storage is used.

See also:
• How to add Azure Blob Storage
• How to add Google Cloud Storage
• Which documents go via the cloud?
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Cloud storage
• Type

The type of cloud storage.
• Cloud storage

The name of the cloud storage.
• Active

Currently, only the first active cloud storage is used.
• Documents

The Types of printed documents that the cloud storage is used for:  Print Anywhere ,  Print Later ,
Via the cloud , Chrome print, orMobile print.
• Hover over the text Types: n to see the types of the printed documents the cloud storage is 

used for.
• Capture

The Sources of captured documents that the cloud storage is used for: Printer or Mobile.
• Hover over the text Sources: n to see the sources of the captured documents the cloud storage 

is used for. You will only see Mobile: Yes if you have set up Azure Blob Storage for CORS (Cross-
origin Resource Sharing). Otherwise, documents captured with mobile will go via the Printix 
Cloud.

• Last verified
The last time the cloud storage was verified (happens automatically every 30 minutes). Select 
and Test to check and verify the cloud storage instantly.

Deactivate
Select  and Deactivate to deactivate a cloud storage.
No new documents will be written to this storage.

Delete
1. Select  and Delete to delete a cloud storage.
2. Select Confirm.

Options
After you have added cloud storage, documents printed Via the cloud (including Chrome print) or 
as Mobile print from phones and tablets, Android and iOS/iPadOS, will go via your cloud storage, 
rather than the Printix Cloud. In addition you can enable storage of pending documents in your 
secure cloud storage:
• Store Print Anywhere documents

Select this if you want Print Anywhere documents to be stored in the cloud.
• Store Print Later documents

Select this if you want Print Later documents to be stored in the cloud. Be aware that Print Later 
documents are typically larger in size compared to Print Anywhere documents.
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Which documents go via the cloud?
Printing Printix Cloud Own cloud storage

Print Anywhere Documents are stored on the 
computer that submitted the 
document. If the release printer is 
on another network the document 
is sent via Printix Cloud at the time 
of the release.

Documents are stored on the 
computer that submitted the 
document and if Store Print 
Anywhere documents is selected, 
the documents are also stored in 
your cloud storage.

Print Later Documents are stored on the 
computer that submitted the 
document. If the release printer is 
on another network the document 
is sent via Printix Cloud at the time 
of the release.

Documents are stored on the 
computer that submitted the 
document and if Store Print 
Later documents is selected, the 
documents are also stored in your 
cloud storage.

Via the cloud Documents are sent via Printix 
Cloud.

Documents are sent via your cloud 
storage.

Chrome print Documents are sent via Printix 
Cloud. Documents to be released 
(Print Anywhere and Print Later) 
are stored in the Printix Cloud.

Documents are sent via your cloud 
storage. Documents to be released 
(Print Anywhere and Print Later) 
are stored in your cloud storage.

Mobile print Documents are sent via Printix 
Cloud. Documents to be released 
(Print Anywhere and Print Later) 
are stored in the Printix Cloud.

Documents are sent via your cloud 
storage. Documents to be released 
(Print Anywhere and Print Later) 
are stored in your cloud storage.

Capture Printix Cloud Own cloud storage

Capture at the printer Captured documents are sent via 
Printix Cloud.

Captured documents are sent 
via your cloud storage. After 
processing (OCR) in the Printix 
Cloud the document is written 
to your cloud storage, and from 
there it is read by the Printix Cloud 
destination service and delivered 
to the destination. Captured 
documents will not be stored on 
Google Cloud Storage.

Capture with mobile Captured documents are sent via 
Printix Cloud.

Captured documents are sent 
via your cloud storage. After 
processing (OCR) in the Printix 
Cloud the document is written 
to your cloud storage, and from 
there it is read by the Printix Cloud 
destination service and delivered 
to the destination. Capture with 
mobile requires that you set up 
Azure Blob Storage for CORS
(Cross-origin Resource Sharing). 
Captured documents will not be 
stored on Google Cloud Storage.
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• Documents are automatically deleted from your cloud storage after the number of days (1, 3, 5 

or 7) selected for Mark documents for deletion after. However, documents are kept for another 
12 hours to allow reprint from the Recents page in the Printix App. So, after the document no 
longer appears on the Recents page, it has been deleted permanently and also from your cloud 
storage.

• Captured documents are automatically deleted from cloud storage after 7 days (168 hours) as 
the defined time-to-live.

To reduce Internet network traffic, it will always try to retrieve the release document from the 
computer that submitted the document if the computer is online, and it is on the same network as 
the printer. Otherwise, it will retrieve it from the cloud storage.

Documents that go through your own cloud storage are protected by time- and session-restricted 
credentials issued by the Printix Cloud. Printix Client does not store cloud storage credentials/keys.
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Print via own cloud storage

Print via Printix Cloud

Capture with own cloud storage

 Capture with mobile requires that you set up Azure Blob Storage for CORS (Cross-origin 
Resource Sharing). Captured documents will not be stored on Google Cloud Storage.
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Capture with Printix Cloud

Analytics
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On the Analytics  tab, you can configure access to data for analysis and reporting. Data can be 
extracted into your own database or you can choose to access it from the Printix Cloud. Data can be 
viewed and analyzed with Printix Power BI solution or a tool of your own.

To get here:
1. Select Menu    > Settings  .
2. Select the Analytics  tab.

Printix database Own database

Data is kept for 30 days 90 days or forever

Data extracts 2 times per day 4 times per day

 Using your own database is strongly advised if your combined number of users, 
computers, and groups are in the ten thousands.

See also:
• How to extract data to Printix database
• How to extract data to own database
• How to set up Power BI
• How to interact with the Printix Power BI report
• How to include scan details in data extracts

Database
• Database server address

The address of the database server.
• Database name

The name of the database.
• Database server port

TCP port to access the database. The default is 1433.
• Username

The user name used to access the database.
• Password

The password used to access the database.

Test database connection
Select Test to test the connection to the database.

Deactivate extraction to database
Select Deactivate to stop extracting data to the database.
You can select Activate if you want to start the extraction of data again.
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Delete database extraction profile
1. Select Deactivate to stop extracting data to the database.
2. Select Delete to delete the database extraction profile.

The deletion of your Printix database happens automatically after you cancel subscription. 
If you are using your own database, you are responsible for deleting the actual database 
yourself.

How to extract data to Printix database

1. On the Settings  page, select the Analytics  tab.
2. In the Printix database section, select Create.
3. When the database is created, you will see:

• Database server address: The address of the database server.
• Database name: The name of the database.
• Database server port: TCP port 1433.
• Username: The username used to access the database.
• Password: The password used to access the database.

4. Optionally, select Include document name in data extract.
5. Select Activate to start extracting data to the database.
6. Copy the configuration items one by one and use them to set up the Printix Power BI solution

or a tool of your own.
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 If required, you can select Reset password  to generate a new password. Access to the 
database will stop working until you have updated the Printix Power BI solution or your own 
tool with the new password.
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How to extract data to own database

• Create the Azure SQL Database you want to use for this purpose.
• A good starting point is a database with 20 DTUs (Database Transaction Units).

• The database user should have the database role db_owner. Alternatively, you can give the 
database user these three fixed database roles: db_datareader, db_datawriter, and db_ddladmin. 
Specifically, the database user needs at least these database privileges:
• CREATE TABLE
• GRANT SELECT ON DATABASE
• GRANT INSERT ON DATABASE
• GRANT UPDATE ON DATABASE
• GRANT DELETE ON DATABASE

• Firewall rules. By making Azure SQL accept 0.0.0.0 as a firewall source, it will enable Printix (an 
Azure service) to pass through the server-level firewall rule and attempt to connect to the Azure 
SQL database.

1. On the Settings  page, select the Analytics  tab.
2. In the Own database section:

• In Database server address, enter the address of the database server.
• In Database name, enter the name of the database.
• In Database server port, enter the TCP port to access the database. The default is 1433.
• In Username, enter the username to access the database. See database role above.
• In Password, enter the password to access the database.

3. Select Create.
4. By default, data is kept for 90 days. Optionally, select Keep data forever.
5. Optionally, select Include document name in data extract.
6. Select Activate to start extracting data to the database.
7. Copy the configuration items one by one and use them to set up the Printix Power BI solution

or a tool of your own.

239

https://docs.microsoft.com/en-us/sql/relational-databases/security/authentication-access/database-level-roles?view=sql-server-2017
https://docs.microsoft.com/en-us/azure/sql-database/sql-database-firewall-configure


Tungsten Printix Administrator Guide

Modify own database
1. Select Deactivate to stop extracting data to the database.
2. Select Modify to modify the database.
3. Select Save.

You can select Activate if you want to start the extraction of data again.
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How to include scan details in data extracts
Printix Power BI version 2.0 introduces the new page User - Scan Details. If you have had Analytics 
enabled prior to the release of Power BI version 2.0 (March 2023) and you want to include scan 
details in the extracted data going forward, then you need to:

1. Write down the details from the current configuration as you will need them in step 4:
• Database server address
• Database name
• Database server port
• User name
• Password

2. Select Deactivate to stop extracting data to the database.
3. Select Delete to delete the database extraction profile.
4. Select Create to create the database again (enter the information you wrote down in step 1).

This will modify the database to record scan details also.
5. Select Activate to start the extraction of data again.

Scan details are recorded for:
• Printix Go printers that have been updated to and use Printix Capture.

See also:
• How to get started with capture and workflow

Power BI
• Power BI Template (PBIT)

You can download a template file for Power BI. See How to set up Power BI.

Mobile print

On the Mobile print  tab, you can enable mobile print to allow printing from phones and tablets, 
Android and iOS/iPadOS.
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To get here:
1. Select Menu    > Settings  .
2. Select the Mobile print  tab.

See also:
• Requirements
• How to enable via the cloud for a print queue
• How to enable mobile print
• How to enable mobile print for a print queue
• How to enable mobile print for a network
• Troubleshooting
• How to print from Android phone and tablet
• How to print from iPhone and iPad

• How to get your AirPrint password

Requirements
We advise you add your own secure cloud storage:
• Azure Blob Storage
• Google Cloud Storage

Android 
• User must be signed in to Printix App for Android.
• The print queue must have selected Via the cloud and Enable mobile print.

Get Printix App for Android

iOS/iPadOS 
• User must be signed in to Printix App for iOS/iPadOS.
• The print queue must have selected Enable mobile print.
• The print queue name must only contain: A-z,0-9,-

Get Printix App for iOS/iPadOS
• The iOS/iPadOS phone or tablet must be connected to and within range of a Wi-Fi network that is 

mobile print enabled by Printix.
• The URL https://airprint.printix.net via TCP port 443 must be unblocked.
• Network allows the Bonjour networking protocol via UDP port 5353 (Multicast DNS).
• A computer (with Printix Client) must be online on the Wi-Fi network to broadcast the AirPrint 

printers.
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How to enable via the cloud for a print queue
1. Open the Print queue properties page.
2. Select Via the cloud.
3. Select Save.

How to enable mobile print
1. Select Menu    > Settings  .
2. Select the Mobile print  tab.
3. Select Enable mobile print.
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4. Select Save.
5. Proceed to:

• Enable mobile print for a print queue, for example Printix Anywhere and
• Enable mobile print for a network (required for iOS/iPadOS)

How to enable mobile print for a print queue
1. Open the Print queue properties page.
2. Select Enable mobile print.
3. Select Save.

 For iOS/iPadOS phones and tablets, you must also enable mobile print for the network.

Android 
• The availability of mobile print enabled print queues depends on the print queues' Via the 

cloud setting:
• If Via the cloud is configured to work on all networks, mobile print enabled print queues 

are available regardless of the Android phone's or tablet's network connection (Wi-Fi or 
mobile network).

• If Via the cloud is configured to work on selected networks only, mobile print enabled 
print queues are only available on selected networks. If print queues do not appear as 
expected, it can be, for example, because a computer on the selected networks has more 
than one network adapter, and thereby, potentially operates on multiple networks. To 
work around this, configure Via the cloud work on all networks for the print queue.

• Mobile-printed Print Anywhere documents can, unless the printer's QR code or NFC tag is 
scanned, be released only to printers that have a print queue with Via the cloud selected.

iOS/iPadOS 
• Mobile print enabled print queues will be available and broadcast as AirPrint printers as 

follows:
• A print queue will be broadcast on the printer's network, if the network has Enable 

mobile print selected.
• A print queue, that has Via the cloud selected and is configured to work on all networks, 

will be broadcast on all networks that have Enable mobile print selected.
• A print queue, that has Via the cloud selected and is configured to work on selected 

networks only, will be broadcast only on the selected networks that have Enable mobile 
print selected.

• A Printix Anywhere print queue will be broadcast on all networks that have Enable mobile 
print selected.

• Mobile-printed Print Anywhere documents can, unless the printer's QR code or NFC tag is 
scanned, be released only to printers that have a print queue with Via the cloud selected.

How to enable mobile print for a network
1. Open the Network properties page.
2. Select Enable mobile print.
3. Select Save.
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 Broadcast of AirPrint printers will happen when one of the computers on the network has 
been restarted or the Printix Service has been restarted. The Printix Service log of a computer 
that broadcast will say: Starting Bonjour Service Manager

Troubleshooting
• Nothing is printed
• I cannot find any Printix printers on my Android phone or tablet
• I cannot find any Printix AirPrint printers on my iPhone or iPad
• How to check broadcast of Printix AirPrint printers
• When I want to print, then what user name and password do I enter?
• When I select Print on my iPhone or iPad, it says: You do not have permission to use this printer.
• When I select Print on my Mac to a Bonjour/AirPrint added printer, it says: Hold for 

Authentication.

Nothing is printed
• No computer with Printix Client is online on the printer's network.

Resolution: Make sure a computer with Printix Client is online on the same network as the printer.
• If you printed to a Printix Anywhere printer, you have to release the document before it is printed.

Resolution: Use Printix App to release the document.
• Computers are referencing different Printix Homes.

Resolution: Ensure that all computers are using the one and same Printix Home.

I cannot find any Printix printers on my Android phone and tablet
Resolution: Confirm the following requirements.
• Ensure that the requirements for mobile printing from Android phones and tablets are fulfilled.
• Ensure that you are signed in to the Printix App for Android on your Android phone or tablet.
• Ensure that the print queue is mobile print enabled.

I cannot find any Printix AirPrint printers on my iPhone or iPad
Resolution: Confirm the following requirements.
• Ensure that the requirements for mobile printing from iPhone and iPad are fulfilled.
• Ensure that you are signed in to the Printix App on your iPhone or iPad.
• Ensure that the iPhone or iPad is connected to and within range of a Wi-Fi network that is known 

to Printix.
• Ensure that the iPhone or iPad is not in Low Power Mode, because low power mode prevents the 

Printix App from running in the background.
• Ensure that the print queue is mobile print enabled.
• Ensure that the network is mobile print enabled.
• Ensure that a computer with Printix Client is online on the Wi-Fi network.
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If the computer was running before Enable mobile print was selected for the network, you 
should restart the Printix Service so it broadcast the printers. The Printix Service log of a 
computer that broadcast will say: "Starting Bonjour Service Manager."

How to check broadcast of Printix AirPrint printers
To troubleshoot and check the broadcast of the AirPrint printers, you can go to Apple App Store and 
download Discovery - DNS-SD Browser from Tildesoft.

1. Open Discovery - DNS-SD Browser.
2. Select Internet Printing Protocol over HTTPS.
3. You should see the Printix AirPrint printers.

The print queue name must only contain: A-z,0-9,-
4. Select a printer to see the TXT record for the printer.

When I want to print, what user name and password do I enter?
Enter a Username, which can be any string (such as noname). In Password, you must Paste the 
AirPrint password you get from the Printix App for Android or iOS/iPadOS. The combined user name 
and password must not exceed 180 characters.

Resolution: See: How to get your AirPrint password.

 If you leave the Username empty on an iPad, the Password required for {printer} dialog box 
will appear every time you print to the printer.
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When I select Print on my iPhone or iPad, it displays "You do not have 
permission to use this printer"
The print queue has Exclusive access selected for one or more groups, and you are not a member of 
any of those groups.

Resolution: Select a printer you do have access to, or contact your administrator.

When I select Print on my Mac to a Bonjour/AirPrint added printer, it displays
"Hold for Authentication"
• The AirPrint password was not correct.

Resolution: Enter the correct AirPrint password. The user name is not used, but it must be at least 
one character. The combined user name and password must not exceed 180 characters.

• The print queue has Exclusive access selected for one or more groups, and you are not a member 
of any of those groups.
Resolution: Select a printer you do have access to, or contact your administrator.

Home office

On the Home office  tab, you can enable home office printing so employees can print on their 
printer at home when they are working at home on their company laptop. This gives the employee 
the flexibility to review, make notations, and proofread documents on paper rather than on the 
screen.
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To get here:
1. Select Menu    > Settings  .
2. Select the Home office  tab.

See also:
• How to print from home
• How to print to home office printer

Benefits
• Employee can review, make notations, and proofread documents on paper rather than on the 

screen.

248

https://docshield.tungstenautomation.com/Printix/en_US/help/user/Printix_user/c_how_to_print_to_home_office_printer.html


Tungsten Printix Administrator Guide

• Print queue for the printer at home is added automatically on the company laptop.
• See also: Printer requirements

• Data is collected showing what was printed on the printer at home.
• Data can be used to reimburse the employee for printing.

How to enable home office printing
Home office printing is enabled by making a group (Microsoft Entra) with the relevant computers. 
Name the group for example: Home office computers.

 Do NOT enable home office printing until you have finished registering the Company 
networks. Otherwise, you risk that company networks get registered as Home office networks.

1. Select Add home office groups .
2. Select the group (Home office computers) to make the computers in the group adhere to home 

office behavior.
• Select Search  to search by group name.

The search is not case-sensitive.
3. Select Save.

 As groups are synchronized automatically at approximately 20 minute intervals, it can 
take up to 20 minutes before the computer's group membership is registered by Printix.

Remove home office group
Select Remove .

Home office behavior
Characteristics of a home office computer.
• When computer is on an unknown network.

• Automatically create home office network and set Network type to: Home office.
• Automatically discover printers when computer is on the home office network.

• Naming of home office networks.
• Network name contains the computer name.

Example: COMPIX@home
• A number is appended to the network name for any subsequent home office networks created 

by the computer.
Example: COMPIX@home1

• Naming of home office print queues.
• A parenthesis with the first part of the Printix Home (acme.printix.net) is appended to the 

printer name.
Example: myprinter (acme).

• Showing the three letter printer ID (BNM) is controlled by Print queue naming.
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Example: myprinter (acme) BNM.
• For print queues on home office networks.

• Printix-managed home office print queue, myprinter (acme), can be used for work related 
printing. Data is collected, and can optionally be used to reimburse the employee for printing.

• Any existing print queue (myprinter) for the home printer remains untouched and can be used 
for personal printing (data is not collected).

• Add print queue automatically is selected by default.
• Remove print queue automatically is selected by default.
• Other users cannot see the home office print queue, because their computer is not on the 

home office network.
• Clean up.

• A home office network that has not been used for 2 months is deleted automatically, and so 
are the Printix-managed printers and print queues on that network.

SNMP

On the SNMP tab, you can add, modify, and delete SNMP configurations. SNMP is only used to get/
read information from printers. No set/write SNMP operations are performed.

To get here:
1. Select Menu    > Settings .
2. Select the SNMP tab.

See also:
• How to add an SNMPv1 configuration
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• How to add an SNMPv3 configuration
• How to add printers
• How to discover printers

The list of SNMP configurations has the following columns:
• Name: The configuration name.
• Networks: Displays Global if the configuration is assigned to all networks. Otherwise, displays 

the number of assigned networks.
• Version: Displays V1 or V3 depending on the configuration version.
• Default: The default configuration displays a check mark. Other configurations are blank.
• Get Community Name: The community name of the printer.

The following functions are available:

• Select the check boxes of multiple SNMP configurations to work with multiple SNMP 
configurations at the same time.
Select the check box in the header row to select all available check boxes. This option not 
available if none of the SNMP configurations have a check box.
The default SNMP configuration does not have a check box.

• Select Plus  to start adding a new SNMP configuration.
The Add SNMP configuration dialog box appears.

• Select Refresh  to reload the list of SNMP configurations.
The list is automatically refreshed after creating, updating, or deleting an SNMP configuration.

• Select Search  and enter the first few letters of an SNMP configuration to search for it.
The search is not case-sensitive.

• In the Networks column, select a number to display a dialog box with the list of assigned 
networks.
Each network is displayed together with its IP and MAC addresses.
You can select Networks  to go to the Networks page.

• Select a specific column title to sort by it:
• Select Name to sort by name.
• Select Version to sort by version. Items with the same version are automatically sorted by 

name.
• Select Get Community Name to sort by community name. Items with the same community 

name are automatically sorted by name.
• Select an SNMP configuration's Name or select More  and SNMP configuration to open the SNMP 

configuration page.
• Select the check boxes of SNMP configurations and select Delete  to delete SNMP 

configurations.
• You can delete a single SNMP configuration by selecting More  and Delete.
• You can also delete a configuration after selecting More  and SNMP configuration. See SNMP 

configuration.
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Site managers can add, modify, and delete SNMP configurations. However, it is limited what site 
managers can do.
• Site managers can see the following SNMP configurations, which they can assign to printers:

• SNMP configurations with Global networks assigned
• SNMP configurations with at least one managed network assigned

• Site managers can add, select, modify, and delete the following SNMP configurations:
• SNMP configurations with only managed networks assigned

Add SNMP configuration
When the Add SNMP configuration dialog box appears, select the version of the SNMP 
configuration to add:
• Version 1
• Version 3

Version 1
• Configuration name

The name of the SNMP configuration.
• Get Community Name

The default is public. On some printers, this may also be known as Community Name Read 
Only.

• Set Community Name
On some printers, this may also be known as Community Name Read/Write.

• Networks
• If the configuration should be assigned to all networks, set it to Global.
• If the configuration should be assigned to specific networks only, select Select, then select the 

appropriate networks.

Version 3
• Configuration name

The name of the SNMP configuration.
• Username

The SNMP user name can contain up to 31 characters in length and include any combination of 
alphanumeric characters (uppercase letters, lowercase letters, and digits). Space is not allowed.

• Security level
Select one of the following security levels for communication:
• No authentication and no privacy
• Authentication and no privacy
• Authentication and privacy

Depending on the selected security level, it is required to also configure Authentication and
Privacy protocol.

• Networks
• If the configuration should be assigned to all networks, set it to Global.
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• If the configuration should be assigned to specific networks only, select Select, then select the 
appropriate networks.

Authentication
• Authentication protocol

Select one of the hashing algorithms:
• SHA (Secure Hash Algorithm)
• MD5 (Message-Digest algorithm 5)

• Authentication key
The key used with the selected authentication protocol.

Privacy protocol
• Privacy protocol

Select one of the encryption algorithms:
• DES (Data Encryption Standard)
• AES (Advanced Encryption Standard)

• Privacy key
The key used with the selected privacy protocol.

Context name

The context name depends on the printer vendor.

See also:
• Printer vendor’s SNMPv3 context names
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SNMP configuration

• You can see the properties of the selected SNMP configuration. For the description of each 
property, see SNMP.

• You can modify or delete the SNMP configuration.
• You can see the printers that use the selected SNMP configuration.

• You can Search for a printer in the list. The search is not case-sensitive.
• Selecting a printer from the list opens the printer's Printer properties page.

Modify
1. Under SNMP configuration, select the Wrench  and select Modify.
2. Make your modifications and select Save.

 When you modify an SNMP configuration, we recommend that you verify that printing 
and printer status still work.

Delete
1. Under SNMP configuration, select the Wrench  and select Delete.
2. Select Confirm to delete the SNMP configuration.
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Software
To get here:

Select Menu    > Software  .

Windows
• Printix Client

Automates the creation of print queues and installation of print drivers. The MSI arguments are 
relevant if you want to deploy Printix Client with Microsoft Endpoint Manager.

• Printix Redirector
Use this to enable printing to a print queue on a Windows computer, enable third-party pull 
printing, and enable USB printing.

• Printix Configurator
Use this to initially configure Printix for customers with multiple locations (networks) and a large 
number of already deployed printers.

• Printix Client (MSI)
Use this for automatic deployment with Microsoft Endpoint Manager.
Select the relevant MSI argument to copy it to the clipboard.
• Sign in after installation

Sign-in will occur right after Printix Client is installed. This is the default behavior.
• Sign in postponed until restart

Deploy Printix Client without starting the user interface (PrintixClient.exe). This method 
can be used to install Printix Client as part of an automated process (such as Windows 
Autopilot) that completely configures a new computer before this is delivered to the user. This 
way, sign in is postponed until the user starts to use the computer. Only the Printix Service 
(PrintixService.exe) is started. The computer with Printix Client will only be registered and listed 
in Printix Administrator after a user has signed in.

• Kiosk ID
Making Printix Client for Windows run as kiosk on a computer is relevant if multiple users need to 
operate and print from the computer without being signed in with a personal account.

Mac
• Printix Client

Automates the creation of print queues and installation of print drivers.

Chrome Web Store
• Printix Chromebook

Print to Printix-managed printers from Chromebooks and computers with Google Chrome.
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Apple App Store
• Printix App

Release, print, and delete documents on iPhone and iPad.
Get Printix App for iOS/iPadOS

Google Play Store
• Printix App

Release, print, and delete documents on Android phone and tablet.
Get Printix App for Android

Printix Cloud Print API
• Printix Cloud Print API

Intended for use by applications that wish to push print jobs in printer-native or PDF format into 
a Printix print queue, and for organizations who want to do guest user administration. For a 
detailed explanation, see printix.github.io.

1. Select Printix Cloud Print API.
2. In Name, type a name.

Example:  acme (first part of your Printix Home)
The name you enter will appear as a user on the Users page and with the role Cloud Print API 
user. Deleting this user revokes the matching Client ID / Client Secret pair.

3. Select I accept and select Submit to get the Client ID and Client Secret for the required
authentication with the API.
• Select the Client ID value to copy it to the clipboard.
• Select the Client Secret value to copy it to the clipboard.
• Select the Tenant ID value to copy it to the clipboard.

Printix Go
• Kyocera (PKG)

Use this to install Printix Go on a Kyocera printer.
• Ricoh (ZIP)

Use this to install Printix Go on a Ricoh printer without using the Printix Client.
The clientless Printix Go Ricoh has limited functions compared to the typical installation.

• Ricoh Installer (ZIP)
Use this to install Printix Go on a Ricoh printer without using the Printix Client.
The clientless Printix Go Ricoh has limited functions compared to the typical installation.
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Capture Connector API
Intended for use by applications that wish to integrate with Printix Capture to process and deliver 
documents and metadata to custom systems. For a detailed explanation, see How to get started 
with Capture Connector API.

• Sample Connector .NET (ZIP)
Use this sample connector to process documents created by Printix Capture and store them and 
their metadata on a pre-configured network share.

• Source code .NET (ZIP)
Use this sample connector source for reference how to create your own application in .NET to 
integrate with Capture Connector API to process documents and metadata.

• Source code Java (ZIP)
Use this sample connector source for reference how to create your own application in Java to 
integrate with Capture Connector API to process documents and metadata.

• Source code Node.js (ZIP)
Use this sample connector source for reference how to create your own application in Node.js to 
integrate with Capture Connector API to process documents and metadata.

• Source code Python (ZIP)
Use this sample connector source for reference how to create your own application in Python to 
integrate with Capture Connector API to process documents and metadata.

Power BI
• Power BI Template (PBIT)

You can download a template file for Power BI. See How to set up Power BI.
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Support

To get here:

Select Menu    > Support  .

How to get support
1. Fill out the form.

To help us investigate and hopefully reproduce the issue, we urge you to include as much 
detail as possible, such as:
• The name of the involved user, computer, printer, and print queue.
• Can the issue be reproduced, or does it happen randomly?
• When did the issue occur?

2. As Priority, optionally, select Urgent, High, Normal (default), or Low.
3. Select Send.

 Update notifications are sent through email. If you do not receive notifications, ask your 
internal IT department or service provider to assist you.

After the support request is opened, you can subsequently add attachments, such as images to 
the confirmation email you receive from Product Support.

See also:
• Troubleshooting
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Roles

See what functions you can perform based on your role:

System manager Site manager User Guest

Printix Administrator Sign in Sign in - -

Sites All View only - -

Networks All View only - -

Printers All Site managed printers - -

Print queues All Site managed print 
queues

- -

Users All View only - -

Computers All View only - -

History All History for site managed 
printers

- -

Groups All Add and remove groups 
for site managed print 
queues

- -

Authentication All View only - -

Subscription All - - -

Settings All View only (No access to
Analytics tab)

- -

Software Download Download - -

Support Submit Submit - -

Printix Client Sign in Sign in Sign in Sign in [1]

Printix App Sign in Sign in Sign in Sign in [1]

Printix Go Sign in Sign in Sign in Sign in

Print Print Print Print Print

Capture Capture Capture Capture Capture

[1] Guests require a password to sign in, which can be configured to be automatically generated 
with the Printix Cloud Print API.
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See also:
• How to change the role of a user
• How to create a site
• How to add a site manager group to a folder or site

System manager
As System manager, you have full rights in Printix Administrator to control everything, including the 
roles of all other users.
• Open Printix Administrator
• Manage sites
• Manage networks
• Manage printers
• Manage print queues
• Manage users
• Manage computers
• Manage groups
• Manage the roles of all other users
• Manage subscription

Site manager
As Site manager, you can sign in to Printix Administrator and have management access to the sites
you have rights to. See the sections below to see the actions you can take as Site manager.

Printers
• Discover printers on networks belonging to managed sites.
• Add printer on networks belonging to managed sites.
• Modify printer on networks belonging to managed sites.
• Delete printer on networks belonging to managed sites.
• Delete unregistered printers.
• Register NFC tag for printers belonging to managed sites.
• Delete NFC tag from printers belonging to managed sites.

SNMP configurations
• See SNMP configurations with Global networks assigned.
• See SNMP configurations that have at least one managed network.
• Add an SNMP configuration that only has managed networks.
• Modify an SNMP configuration that only has managed networks.
• Delete an SNMP configuration that only has managed networks.
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Print queues
• Add print queue to printers belonging to managed sites.
• Modify print queue of printers belonging to managed sites.
• Delete print queue of printers belonging to managed sites.
• Configure multiple print queues belonging to managed sites.
• Add print queues to computers belonging to managed sites.
• Update print queues on computers belonging to managed sites.
• Convert print queues on computers belonging to managed sites.
• Set printer as default for a print queue on a computer belonging to managed sites.

History
• See history for printers belonging to managed sites.
• See history for computers belonging to managed sites.

Groups
• Add group to print queues belonging to managed sites.
• Remove group from print queues belonging to managed sites.

User
As a User, you can use Printix to:
• Print
• Capture

As a User, you cannot sign in to Printix Administrator.

Guest
Guests can be registered and administrated with the Printix Cloud Print API. Guest users can be 
automatically deleted after a specific period of time.

Guest users can use Printix to:
• Print
• Capture

Guests cannot sign in to Printix Administrator, but administrators can see guests on the list of users.
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Print drivers

Printix maintains a global driver store with Windows and macOS print drivers. When users start 
to use the Printix Client, it automatically uploads print drivers and puts them in your Printix driver 
store. If a particular printer has no dedicated print driver, an appropriate Universal print driver may 
be used.

Printix Client for Mac uses Apple's Generic PostScript Printer and Generic PCL Printer if the printer 
has no dedicated or Universal print driver.

You can add a print driver to your Printix driver store to deal with these scenarios:
• Newly released printer

The printer is just released, and therefore, the print driver is not among the print drivers in the 
driver store.

• Selected print driver lacks features
The selected print driver (such as a universal/generic print driver) does not fully support the 
features of the printer.

• Selected print driver lacks language support
The selected print driver does not support the language required. Some Asian countries for 
example require special print driver packages for language support.

• No print driver was selected for the printer
If the printer does not support PostScript, PCL6, or PCL5, then a Universal print driver is not 
available, and you have to use a dedicated print driver from the printer vendor.

 We do not recommend use of Windows class drivers. Class drivers are not uploaded to the 
Printix driver store, because they are supposedly distributed with Windows, but availability varies 
depending on the version of Windows. We recommend use of the printer vendor supplied print 
drivers and universal print drivers, because these offer advanced features and better control 
compared to class drivers.

See also:
• How to add a print driver
• How to change the print driver
• How to work with print driver configurations
• How to add an EFI Fiery printer
• Universal print drivers
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Universal print drivers
The major printer vendors supply universal print drivers:
• Canon generic print driver
• HP universal print driver
• HP DesignJet universal print driver
• Konica Minolta universal print driver
• Kyocera classic universal print driver
• Lexmark universal print driver
• Ricoh universal print driver
• Toshiba universal print driver
• Xerox global print driver

See the above sections for instructions on how to configure:
• Installable Options (such as Paper trays, Duplexer, Staple, Hole punch, and Output bins)
• Form to tray Assignment
• Printing defaults (such as Finishing options, Print 2-sided, and Print in black)

Canon generic print driver
The Canon generic print driver is available for:
• PCL6

Print driver name: Canon Generic PCL6 Driver
• PostScript

Print driver name: Canon Generic PS3 Driver
• UFR II

Print driver name: Canon Generic UFR II Driver

 If possible, ALWAYS select the print driver name that includes a version number. This is to 
mitigate that Windows cannot differentiate between versions of the print driver unless the version 
is reflected in the print driver name.

Language support:
• All (+23) languages within the print driver.

Select a language on the Device Settings tab in the Printer properties dialog box. Select
Language Settings.

Configuration
In Printix Administrator, you can add a new print driver configuration. The temporary printer's
Printer properties dialog box will open automatically. Proceed to make the configuration:

1. In the Printer properties dialog box, select the Device Settings tab.
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2. Select Device Information to ask the printer. If you cannot contact the printer, select the
Device type manually.
Example:  A3, Color

3. Optionally, adjust:
• Finishing settings
• Paper source settings
• Department ID management

This feature is NOT supported with Printix as the IDs cannot be verified by the printer, 
because after being converted by Printix, the print queue is using a local IPP port.

4. Select Apply.
5. Optionally, open the Advanced tab and select Printing Defaults to configure per-printer 

defaults.
6. Select OK.

HP universal print driver
The HP Universal Print Driver (UPD) is available for:
• PCL5

Print driver name: HP Universal Printing PCL5
• PCL6

Print driver name: HP Universal Printing PCL6
• PostScript

Print driver name: HP Universal Printing PS


• If possible, ALWAYS select the print driver name that includes a version number. This is to 

mitigate that Windows cannot differentiate between versions of the print driver unless the 
version is reflected in the print driver name.

• Install the HP Universal Print Driver in Traditional mode.
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Configuration

In Printix Administrator, you can add a new print driver configuration. The temporary printer's
Printer properties dialog box will open automatically. Proceed to make the configuration:

1. In the Printer properties dialog box, select the Device Settings tab.
2. Select Automatic Configuration and select Update Now. If you cannot contact the printer, 

you can manually configure:
• Installable Options
• Form to Tray Assignment
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 After you select Update Now, the Printer properties dialog box closes automatically, 
preventing you from making additional changes. To make additional changes, you can
modify the print driver configuration.

3. Select Device Type and select Color if it is a color printer. Otherwise, select Monochrome.
If you leave it at Auto Detect, then whenever you open Printing preferences, it will also open 
a Validating the selected printer dialog box, which will take time and eventually fail.

4. Select Apply.
5. Optionally, open the Advanced tab and select Printing Defaults to configure per-printer 

defaults.
6. Select OK.
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HP DesignJet universal print driver
The HP DesignJet Universal Print Driver is available for:
• HPGL

Print driver name: HP DesignJet Universal Print Driver HPGL

 If possible, ALWAYS select the print driver name that includes a version number. This is to 
mitigate that Windows cannot differentiate between versions of the print driver unless the version 
is reflected in the print driver name.

Configuration
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In Printix Administrator, you can add a new print driver configuration. The temporary printer's
Printer properties dialog box will open automatically. Proceed to make the configuration:

1. In the Printer properties dialog box, select the Device Settings tab.
2. Select Current Model and select the model that matches your printer.
3. Select Apply.
4. Optionally, open the Advanced tab and select Printing Defaults to configure per-printer 

defaults.
5. Select OK.

Konica Minolta universal print driver
The Konica Minolta universal print driver is available for:
• PCL

Print driver name: KONICA MINOLTA Universal PCL
• PostScript

Print driver name: KONICA MINOLTA Universal PS

 If possible, ALWAYS select the print driver name that includes a version number. This is to 
mitigate that Windows cannot differentiate between versions of the print driver unless the version 
is reflected in the print driver name.

Language support:
• Uploaded with print driver. Need additional languages? Install the print driver with the required 

language and add the Windows print driver to your Printix driver store.
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Configuration

In Printix Administrator, you can add a new print driver configuration. The temporary printer's
Printer properties dialog box will open automatically. Proceed to make the configuration:

1. In the Printer properties dialog, select the Configure tab.
2. If Model is Baseline, then select Select Model. Select Auto or select the model. Select OK.
3. Select Obtain Device Information. Select Yes to update the printer information. If you cannot 

contact the printer, you can manually configure:
• Device Option and the corresponding Setting
• Paper Tray Settings
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4. Select Apply.
5. On the Configure tab, select Obtain Settings. Clear Auto and select OK.
6. Optionally, open the Advanced tab and select Printing Defaults to configure per-printer 

defaults.
For example, on the Quality tab, you can change Select Color from Auto Color to Gray Scale, 
so users will print in black by default.

7. Select OK.

 Enabling Account Track in the print driver will ONLY work with print driver configurations 
that are uploaded from a computer. This is because when you set up the Account Track
and enter Department Name and Password, the Konica Minolta print driver stores this 
information in Windows Registry and it uses the print queue name to generate the hash / 
encrypted value.

Kyocera classic universal print driver
The Kyocera classic universal print driver is available for:
• PCL 5

Print driver name: Kyocera classic universaldriver
• PCL 6

Print driver name: Kyocera classic universaldriver PCL6
• KPDL (Kyocera's version of PostScript)

Print driver name: Kyocera classic universaldriver KPDL

 If possible, ALWAYS select the print driver name that includes a version number. This is to 
mitigate that Windows cannot differentiate between versions of the print driver unless the version 
is reflected in the print driver name.

Language support:
• Uploaded with print driver. Need additional languages? Install the print driver with the required 

language and add the Windows print driver to your Printix driver store.
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Configuration

In Printix Administrator, you can add a new print driver configuration. The temporary printer's
Printer properties dialog box will open automatically. Proceed to make the configuration:

1. In the Printer properties dialog box, select the Extended Settings tab.
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2. Select Set up and enter the IP address of the printer and select OK. If you cannot contact the 
printer, you can manually configure:
• Extended Settings. Change No finisher to, for example, 1000 sheet finisher to get access 

to Punch unit type and Staple unit.
• B/W or Colour printer.

3. Select Apply.
4. Optionally, open the Device Settings tab to configure Installable Options and Form to Tray 

Assignment.
5. Optionally, open the Advanced tab and select Printing Defaults to configure per-printer 

defaults.
Printing defaults include Advanced Document Settings (such as Print 2-sided and Print in 
black) and, for example, Finishing Options.
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6. Select OK.

Lexmark universal print driver
The Lexmark universal print driver v2 supports more than 60 printer models and is available for:
• PCL 5

Print driver name: Lexmark Universal v2
• PCL XL

Print driver name: Lexmark Universal v2 XL
• PostScript Level 3

Print driver name: Lexmark Universal v2 PS3

 If possible, ALWAYS select the print driver name that includes a version number. This is to 
mitigate that Windows cannot differentiate between versions of the print driver unless the version 
is reflected in the print driver name.
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Language support:
• All (+22) languages within the print driver.

Select a language on the Configuration tab in the Printer properties dialog box.

Configuration

In Printix Administrator, you can add a new print driver configuration. The temporary printer's
Printer properties dialog box will open automatically. Proceed to make the configuration:

1. In the Printer properties dialog box, select the Configuration tab.
2. Select Update now - Ask printer. If you cannot contact the printer, select Set Printer Model.
3. Clear Update configuration from printer.
4. Optionally, adjust Configuration Options.
5. Select Apply.
6. Optionally, open the Advanced tab and select Printing Defaults to configure per-printer 

defaults.
7. Select OK.
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Ricoh universal print driver
The Ricoh universal print driver is available for:
• PCL6

Print driver name: RICOH PCL6 UniversalDriver or PCL6 Driver for Universal Print.
• PostScript

Print driver name: RICOH PS UniversalDriver or PS Driver for Universal Print.


• If possible, ALWAYS select the print driver name that includes a version number. This is to 

mitigate that Windows cannot differentiate between versions of the print driver unless the 
version is reflected in the print driver name.

• Instructions should also be applicable to supported printers from: Gestetner, Nashuatec, NRG, 
Infotec, Lanier, and Savin.

Language support:
• All (+22) languages within the print driver.

Select a language on the Advanced Options tab in the Printer properties dialog box.
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Configuration

In Printix Administrator, you can add a new print driver configuration. The temporary printer's
Printer properties dialog box will open automatically. Proceed to make the configuration:

1. In the Printer properties dialog box, select the Accessories tab.
2. If Select Model is auto, then select the model.
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3. Select Update Now. Select Yes to update the device information. If you cannot contact the 
printer, you can manually configure:
• Options and the corresponding Setting
• Input Tray Settings

4. Clear Automatically update printer information.
5. Select Apply.
6. Optionally, open the Advanced tab and select Printing Defaults to configure per-printer 

defaults.
7. Select OK.

Toshiba universal print driver
The Toshiba universal print driver is available for:
• PCL

Print driver name: Toshiba Universal Printer 2
• PostScript

Print driver name: Toshiba Universal PS3
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 If possible, ALWAYS select the print driver name that includes a version number. This is to 
mitigate that Windows cannot differentiate between versions of the print driver unless the version 
is reflected in the print driver name.

Configuration

In Printix Administrator, you can add a new print driver configuration. The temporary printer's
Printer properties dialog box will open automatically. Proceed to make the configuration:

1. In the Printer properties dialog box, select the Device Settings tab.
2. If Model is Universal, then select a model.
3. Select Update Now to update the printer information.
4. Select Apply.
5. On the Device Settings tab, clear Update Automatically and select Apply.
6. Open the Advanced tab and select Printing Defaults to configure per-printer defaults.
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7. Select the Others tab and clear SNMP Communication. Select Apply.
8. Select OK.

 Configuration of Account Settings in the print driver will ONLY work with print driver 
configurations that are uploaded from a computer. This is because when you set up the
Account Settings and enable User Authentication and perhaps select Private Print 
Restriction and Hold Print Restriction, the Toshiba print driver stores this information in 
Windows Registry and it uses the print queue name to generate the hash / encrypted value.

Xerox global print driver
The Xerox global print driver (X- GPD) is available for:
• PCL 5

Print driver name: Xerox Global Print Driver PCL 5
• PCL 6

Print driver name: Xerox Global Print Driver PCL 6
• PostScript
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Print driver name: Xerox Global Print Driver PS

 If possible, ALWAYS select the print driver name that includes a version number. This is to 
mitigate that Windows cannot differentiate between versions of the print driver unless the version 
is reflected in the print driver name.

Language support:
• All languages within the print driver.

Select a language on the Administration tab in the Printer properties dialog box.

Configuration
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In Printix Administrator, you can add a new print driver configuration. The temporary printer's
Printer properties dialog box will open automatically. Proceed to make the configuration:

1. In the Printer properties dialog box, select the Administration tab.
2. Change Configuration from Basic Printing Mode to the model of your printer.

Example:  Xerox Color C70
3. Select Apply.
4. In the Printer properties dialog box, select the Configuration tab.

5. Configure the Installable Options.
6. Change Connection to Off.

Otherwise, Windows may report: Printer Status is not available at this time.
7. Select Apply.
8. Optionally, open the Advanced tab and select Printing Defaults to configure per-printer 

defaults.
9. Optionally, open the Administration tab and change Configuration to another print mode.
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10. Select OK.
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Printix Client

With the Printix Client, you can automate the creation of print queues and the installation of print 
drivers. The Printix Client runs on Windows and Mac computers.

No manual effort is required to maintain the Printix Client, because it silently updates itself to the 
latest certified version.

See also:
• How to open the Printix Client
• How to sign in to Printix Client
• How to add printers
• Printix Client menu
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Client menu

Menu on Windows

Open the Printix Client to see the menu:
• Printers

Add printer and install print driver. Not available if Allow users to add printers via Printix Client
is cleared. Administrators will always be able to select Printers.

• See what's printing
Displays a list of the documents the Printix Client is printing.

• Release and print documents
Opens the Printix App in a web browser. Not available if Print Later is disabled.

• Preferred print method: Print
Prints your document directly to the selected printer. Not available if Print Later is disabled, if the 
user must print securely, or if the user must use Print Later by default.

• Preferred print method: Print Later
Stores the printed document until you release the document (with Print Later or Print Anywhere) 
using your phone, tablet, or computer. Not available if Print Later is disabled, if the user must 
print securely, or if the user must use Print Later by default.

• Ask me to select print method at every print
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Select this option to have the Select print method dialog box appear every time you print. Not 
available if Print Later is disabled or if the user must print securely.

• Show print notification
Select this option to display a print notification every time you print.

• Open Printix Administrator
Only available if you have an administrative role.

• Help
Open the User Help in a web browser.

• Sign in
Sign in is required the first time you use the Printix Client. If you are already signed in, your name 
is displayed.
Example: Sign in as another user (Now: John Smith (Microsoft))

How to see diagnostics
• A yellow dot is displayed on the Printix Client icon  when the Printix Client is on an unknown 

network.
• A red dot is displayed on the Printix Client icon  if connection failed to the Internet or the Printix 

Cloud.
• The yellow and red dots are both displayed on the Printix Client icon  if both problems occur at 

the same time.
• A red circle with a line is displayed on the Printix Client icon  when the Printix Client is unable to 

connect to the Printix Service on the computer.
• The Printix Client has a hidden Diagnostics  menu you can select to see:

• Tenant: Your Printix Home (acme.printix.net) and your id (cbfce0b5-da2a-4cb6-b7f7-
a04ee31cac90)

• Version: Version of the Printix Client software
• Printers: Number of Printix print queues and print queues in total

Access the hidden Diagnostics through the client menu:

On Windows
1. Hold the Ctrl key while you open the client menu.

Help is toggled to Diagnostics.
2. Select Diagnostics.

On Mac
1. Open the client menu.
2. Press the Option key to toggle Help.

On a Windows keyboard, the Alt key corresponds to the Option key.
3. Select Diagnostics.
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See what's printing

To access this page:
1. Open the Printix Client menu.
2. Select See what's printing.

Documents are only visible for a short period of time, unless they are queued behind other 
documents or waiting for the printer to become available.
• Printer

Name of the printer.
• Document name

File name for the document.
• Pages

Number of pages in the document.
• Size

Size of the document.
• Started

The date and time the document was submitted.
• Status

Indicates the current state, such as:
• Waiting

Waiting for the printer to become ready.
• Waiting to reserve printer

Another Printix user is printing on this printer, and during this time, the printer is 
reserved. As soon as that user's documents are printed, the printer is no longer reserved. 
If no communication occurs, the printer reservation is automatically cleared after 5 
minutes. By reserving the printer, other users' documents are not intermixed with your 
documents, which reduces the risk of mistakenly collecting other users' documents from 
the printer's output bin.

• Connecting
Connecting to the printer.

• Printing
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The document is being transferred to the printer and printed.
• Error

An error has occurred.
• Printer error

An error has occurred on the printer. Check its status and resolve the error, typically by 
restarting the printer.

Managed print queues
Print queues managed by Printix (and thereby printed through Printix) have the following 
characteristics:

Windows 
• Printer name cannot be changed and will typically include the three-letter printer ID.
• Port is an Internet Port and cannot be changed, and the Security options defaults to: Use 

anonymous account.
• Port examples:

• http://localhost:21339/ipp/ASD/2114d3f3-e5732…
• https://localhost:21343/ipp/ASD/2114d3f3-e5732…

Mac 
• Name can be changed (not recommended) and will typically include the three-letter printer ID.
• Device Name is the three-letter printer ID followed by a colon (:) and a unique identifier for the 

print queue.
Example: ASD:2114d3f3-e5732…

Windows Registry settings overview
These Windows Registry settings are used by the Printix Client:
• KioskMode
• DisableHTTPPrinting
• DiscoverPrintersByHostname
• EnableHTTPPrint
• ForceAzurePrt
• ForceOfflineMode
• useGroupPermissions
• StartAsVDI

KioskMode
• Purpose: Make Printix Client run as kiosk.
• Printix Windows Registry: HKEY_LOCAL_MACHINE\SOFTWARE\printix.net\Printix Client\
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• Value name: KioskMode
• Value type: String
• Value:

• Enter your Kiosk ID.
Example: K08fLFIswGHM9KOXBGjGKfrCFravIo01DmNwSBc9jo6YoKgd

DisableHTTPPrinting
• Purpose: Control if communication locally for between the Windows Print Spooler (spoolsv.exe) 

and PrintixService.exe should be with HTTP (default) or secure with HTTPS.
• Printix Windows Registry: HKEY_LOCAL_MACHINE\SOFTWARE\printix.net\Printix Client\
• Value name: DisableHTTPPrinting
• Value type: DWORD
• Value – Decimal values (hex value in parenthesis):

• 0 (0×00000000): Local communication with HTTP (TCP port 21339) to allow the 
PrintixService.exe to listen for print data from the Windows Print Spooler (spoolsv.exe).

• 1 (0×00000001): Local secure communication with HTTPS (TCP port 21343) to allow the 
PrintixService.exe to listen for print data from the Windows Print Spooler (spoolsv.exe).

 With a value of 1, Printix Client will, within 10 minutes, convert Printix printers to use TCP 
port 21343 instead of the previously used TCP port 21339. Printix printers will be converted 
back to use HTTP printing within 10 minutes after the registry has been changed back to 0 from 
1.

• Requirements:
• Printix Client version 1.3.1245 or higher, but lower than version 2.3.

Starting from version 2.3, HTTPS is used for printing by default. To enable HTTP printing, 
configure the EnableHTTPPrint setting.

 If Microsoft's Windows Registry DWORD value name DisableHTTPPrinting in 
HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows NT\Printers\ has a value of 1, it 
disables both HTTP and HTTPS printing for the Windows Print Spooler and thereby Printix printing 
altogether. It is not possible to use Printix printing on Windows if a group policy (GPO) disables 
HTTP printing.

DiscoverPrintersByHostname
• Purpose: Control if and how Discover printers requests are handled by the computer.

By default, the computer accepts the Discover printers requests and examines the list of 
installed print queues and network subnet information to broadcast for and ping printers, 
collect information through SNMP, and register the discovered printers in the Printix Cloud by IP 
address.
If Printix Home is configured to discover printers by hostname, you can use this Windows 
Registry setting to control which computer should accept Discover printers requests. The 
computer examines the list of installed print queues, uses the print queue's hostname to ping 
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the referenced printers, collect information through SNMP, and register the printers in the Printix 
Cloud by hostname.

• Printix Windows Registry: HKEY_LOCAL_MACHINE\SOFTWARE\printix.net\Printix Client\
• Value name: DiscoverPrintersByHostname
• Value type: DWORD
• Value – Decimal values (hex value in parenthesis):

• 0 (0×00000000): If Printix Home is configured to discover printers by hostname, the computer 
ignores any Discover printers requests.

• 1 (0×00000001): If Printix Home is configured to discover printers by hostname, the computer 
accepts any Discover printers requests.

• Requirements:
• Printix Home is configured to discover printers by hostname. See also: How to discover printers 

by hostname.
• Printix Client version for Windows is 1.4.0.80 or higher, version for Mac is 1.4.0.53 or higher.

EnableHTTPPrint
This setting can also be configured on Mac computers. See Mac local settings overview.
• Purpose: Configure whether HTTP or HTTPS is used for printing.
• Printix Windows Registry: HKEY_LOCAL_MACHINE\SOFTWARE\printix.net\Printix Client\
• Value name: EnableHTTPPrint
• Value type: DWORD
• Value – Decimal values (hex value in parenthesis):

• 0 (0×00000000): IPPS ports are used for printing (default behavior).
• 1 (0×00000001): IPP ports are used for printing.

• An HTTP listener is also opened on port 21339 (besides the existing HTTPS listener).
• The Printix print queues are configured with IPP port, so the submitted print jobs arrive on 

the HTTP channel.

When the this registry setting is changed, the changes take effect after 10 minutes, or if the 
Printix Service (or the computer) is restarted.

• Requirements:
• Printix Client version 2.3 or higher. Starting from version 2.3, HTTPS is used for printing by 

default.

ForceAzurePrt
• Purpose: Make Printix Client believe the computer supports SSO. Relevant if a group policy blocks 

Printix Client from running the dsregcmd command, which is used to determine if the computer 
supports SSO.

• Printix Windows Registry: HKEY_LOCAL_MACHINE\SOFTWARE\printix.net\Printix Client\
• Value name: ForceAzurePrt
• Value type: DWORD
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• Value – Decimal values (hex value in parenthesis):
• 0 (0×00000000): Computer is not Microsoft Entra joined and SSO (Single Sign-on) will not work.
• 1 (0×00000001): Computer is Microsoft Entra joined and SSO (Single Sign-on) will work.

ForceOfflineMode
This setting can also be configured on Mac computers. See Mac local settings overview.
• Purpose: Force Printix Client into offline mode. To force computers into offline mode, see the

knowledge base for instructions. To see how Printix behaves in offline mode, see What if the 
Internet connection is lost.

• Printix Windows Registry: HKEY_LOCAL_MACHINE\SOFTWARE\Policies\printix.net\Printix Client\
• Value name: ForceOfflineMode
• Value type: DWORD
• Value – Decimal values (hex value in parenthesis):

• 0 (0×00000000): Disable offline mode.
• 1 (0×00000001): Enable offline mode.

• Requirements:
• Printix Client version 1.3.1286 or higher.

useGroupPermissions
• Purpose: Use this to control which print queues are available to the signed in user.
• Printix Windows Registry: HKEY_LOCAL_MACHINE\SOFTWARE\printix.net\Printix Client\
• Value name: useGroupPermissions
• Value type: DWORD
• Value – Decimal values (hex value in parenthesis):

• 0 (0×00000000): Printix Client will make all installed print queues available to the signed in user.
• 1 (0×00000001): Printix Client will look at the users' group membership and only make print 

queues with Exclusive access available to the signed in user. This is done by setting the 
security privileges on the print queues accordingly. The groups MUST be in both Active 
Directory and Microsoft Entra ID.

StartAsVDI
• Purpose: Make Printix Client work with a managed image, which is typically used in connection 

with: Azure Virtual Desktop, Citrix, Remote Desktop Services (RDS), and VMware Horizon VDI.
• Printix Windows Registry: HKEY_LOCAL_MACHINE\SOFTWARE\printix.net\Printix Client\
• Value name: StartAsVDI
• Value type: DWORD
• Value – Decimal values (hex value in parenthesis):

• 0 (0×00000000): Printix Client will run as normal.
• 1 (0×00000001): Printix Client will NOT update itself automatically. It will read and write the 

user's Printix settings, including access tokens, in the user's Application Data folder.
• The path to the user's application folder is based on %APPDATA%.
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• 2 (0×00000002): Printix Client will update itself automatically. It will read and write the user's 
Printix settings, including access tokens, in the user's Application Data folder.
• The path to the user's application folder is based on %APPDATA%.

• 999 (0×000003e7): Printix Client will NOT update itself automatically. It will read and write the 
user's Printix settings, including access tokens, in the user's Application Data folder.
• The path to the user's application folder is based on %USERPROFILE% and then AppData
\Roaming is appended.

 StartAsVDI only takes effect after a restart of the Printix Service and only takes effect for new 
profiles.

Mac local settings overview
A shell script is available to change some local settings of the Printix Client. You can access it from /
Applications/Printix\ Client.app/Contents/MacOS/ModifyPrintixRegistry.sh.

Use the ModifyPrintixRegistry.sh <SettingName> <Value> script to modify the following 
Printix settings:
• EnableHTTPPrint
• EnableSecureMode
• ForceOfflineMode

EnableHTTPPrint
• Purpose: Configure whether HTTP or HTTPS is used for printing.
• Value name: EnableHTTPPrint
• Value – Decimal values (hex value in parenthesis):

• 0 (0×00000000): IPPS ports are used for printing (default behavior).
• 1 (0×00000001): IPP ports are used for printing.

• An HTTP listener is also opened on port 21339 (besides the existing HTTPS listener).
• The Printix print queues are configured with IPP port, so the submitted print jobs arrive on 

the HTTP channel.

When the this registry setting is changed, the changes take effect after 10 minutes, or if the 
Printix Service (or the computer) is restarted.

• Requirements:
• Printix Client version 2.3 or higher.
• The EnableSecureMode setting must have a value of 1.

Example:

To use HTTP for printing:

ModifyPrintixRegistry.sh EnableHTTPPrint 1
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EnableSecureMode
• Purpose: Control if communication with the Printix Service should be with HTTP (default) or 

secure with HTTPS.
• Value name: EnableSecureMode
• Value – Decimal values (hex value in parenthesis):

• 0 (0×00000000): IPP, HTTP, and port 21339 are used (default behavior).
• 1 (0×00000001): IPPS, HTTPS, port 21343, and certificates are used.

ForceOfflineMode
• Purpose: Force Printix Client into offline mode. To force computers into offline mode, see the

knowledge base for instructions. To see how Printix behaves in offline mode, see What if the 
Internet connection is lost.

• Value name: ForceOfflineMode
• Value – Decimal values (hex value in parenthesis):

• 0 (0×00000000): Disable offline mode.
• 1 (0×00000001): Enable offline mode.

• Requirements:
• Printix Client version 1.3.1286 or higher.

Example:

To force the Printix Client into offline mode:

ModifyPrintixRegistry.sh ForceOfflineMode 1

How to enable use of HTTPS between Print Spooler and Printix 
Client

 Starting from Printix Client version 2.3, HTTPS is used for all communication on Windows by 
default. To change back to HTTP, configure the EnableHTTPPrint setting. To learn more about the 
respective settings on Mac, see Mac local settings overview.

All Printix communication inside and outside the network is secured with encryption and the use of
HTTPS. Follow these steps to allow the PrintixService.exe to listen for print data from the Windows 
Print Spooler (spoolsv.exe) with HTTPS (TCP port 21343). Requires Printix Client for Windows version 
1.3.1245 or higher.

1. Press Windows+R.
The Run dialog box appears.

2. Type regedit, then select OK.
Select Yes if prompted.
The Registry Editor appears.
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3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\printix.net\Printix Client\.
4. Add the DWORD value name DisableHTTPPrinting and give it the value 1.

Printix printers will within 10 minutes be converted to use HTTPS printing and have their Port
changed from, for example: http://localhost:21339/ipp/ASD/2114d3f3-e5732… to https://
localhost:21343/ipp/ASD/2114d3f3-e5732…


• With a value of 1, the Printix Client will, within 10 minutes, convert Printix printers to use 

TCP port 21343 instead of the previously used TCP port 21339. Printix printers will be 
converted back to use HTTP printing within 10 minutes after the registry has been changed 
back to 0 from 1.

• If Microsoft's Windows Registry DWORD value name DisableHTTPPrinting in
HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows NT\Printers\ has 
a value of 1, it disables both HTTP and HTTPS printing for the Windows Print Spooler and 
thereby Printix printing altogether. It is not possible to use Printix printing on Windows if a 
group policy (GPO) disables HTTP printing.

How to discover printers by hostname
By default, Printix discovers printers through the print queues installed on the computer and also 
broadcasts for printers based on network subnet information. By default, the discovered printers 
are registered in the Printix Cloud by their IP address instead of their hostname for the following 
reasons:
• Reverse Domain Name System (DNS) lookup is not always working.
• Because Printix also supports hostnames, you can open the Printer properties page at any time 

and modify the Printer address to be the printer's hostname instead of the IP address.

Discovering printers by hostname is relevant for organizations where printers do not have static IP 
addresses and their DNS is up-to-date with their printers' hostnames and IP addresses (achievable 
if their DHCP servers use DNS dynamic updates). The organization must have a process to add 
new print queues (referencing the printers by hostname) on Windows print servers first, before 
subsequently registering those print queues in the Printix Cloud when Discover printers is started 
on the relevant print server.

If your organization wants to discover printers by hostname only, perhaps because the printers' IP 
addresses are not static, submit a support request to have your Printix Home configured to discover 
printers by hostname.

Requirements
• Printix Home is configured to discover printers by hostname. See also: How to enable discover 

printers by hostname.
• Printix Client version for Windows is 1.4.0.80 or higher, version for Mac is 1.4.0.53 or higher.
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• Network must support ping of printers by hostname. This implies that the organization's Domain 
Name System (DNS) must be up-to-date with the printer's IP addresses and hostnames. Can be 
archived by having DHCP servers do DNS dynamic updates.

• The recommended way of registering new print queues (printers) in Printix is to have the new 
print queues added on a particular Windows computer (print server) and then subsequently start 
the Discover printers from that particular computer. The particular Windows computer must 
have DiscoverPrintersByHostname set to 1.

• The Printix Administrator offers a number of ways to discover printers, but going forward, it 
is recommended to only start Discover printers from the Computer properties page of the 
particular computers that have DiscoverPrintersByHostname set to 1.
• Discover printers on the Computer properties page (recommended) only takes effect if the 

computer has DiscoverPrintersByHostname set to 1.
• Discover printers on the Printers page only takes effect if the computer that receives the task 

has DiscoverPrintersByHostname set to 1.
• Discover printers on the Sites page only takes effect if the computer that receives the task has

DiscoverPrintersByHostname set to 1.
• An entry will be written in History whenever a Discover printers request is rejected. It looks as 

follows: Computer COMPIX is not configured to discover printers by hostname.

How to enable discovering printers by hostname
1. Submit a support request requesting to have your Printix Home configured to discover printers 

by hostname.
2. Create a semi-colon (;) separated CSV file with the printers' original address, network name, 

and new address.
The CSV file must have the following format:
address; network; new_address
192.168.1.10; Network1; domain.name1.com
192.168.1.11; Network1; domain.name2.com

3. Change the printers' network address from IP address to hostname with Printix Configurator.
See How to change the network address of multiple printers with Printix Configurator.

4. When you have confirmation that changes have been made, you can proceed.
For each computer (typically a server) on which print queues are maintained and referenced 
by hostname, you must install the Printix Client and then add the Windows Registry setting
DiscoverPrintersByHostname:

5. Press Windows+R.
The Run dialog box appears.

6. Type regedit, then select OK.
Select Yes if prompted.
The Registry Editor appears.

7. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\printix.net\Printix Client\.
8. Add the DWORD value name DiscoverPrintersByHostname, and give it the value 1.

Start discovery from a particular computer (print server)
1. Open the Computers  page.

295



Tungsten Printix Administrator Guide

2. Select the computer (print server) and select Modify.
Optionally, Filter on Type and select Server.

3. On the Computer properties page, scroll to the Discover section.
Optionally, select an SNMP configuration.

4. Select Discover printers.
5. Select Confirm.

How to change the network address of multiple printers with Printix 
Configurator

 This feature requires Printix Configurator version X or higher.

If you have already registered many printers and do not want to manually change their IP address 
to hostname on the Printer properties page, use Printix Configurator to update the printers:

1. Open the Printix Configurator.
2. Import printers from the Printix Cloud.
3. Import the updated address of the printers from a CSV file.

For this, you need to create a semi-colon (;) separated CSV file (see how to format the CSV file) 
with the printers' original address, network name, and new address. This will be used once to 
update the printers' IP address to their hostname.

4. Upload the updated printers to the Printix Cloud.
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Printix Client as kiosk
Making Printix Client run as kiosk on a computer is relevant if multiple users need to operate and 
print from the computer without being signed in with a personal account.

Features
• Sign-in is not required.
• Print only. No Print Later. No Secure print.
• Printix Anywhere print queues are not installed, and if they are installed, they are deleted.
• Fewer menu items in the Printix Client menu.
• When the computer is registered, a user is created.

• Role is Kiosk user (cannot be changed).
• Name of the user is generated as name@computer (Example: admin@COMPIX).

How to make Printix Client run as kiosk
This is relevant if you want to make an already installed Printix Client run as kiosk.

1. Press Windows+R.
The Run dialog box appears.

2. Type regedit, then select OK.
Select Yes if prompted.
The Registry Editor appears.

3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\printix.net\Printix Client\.
4. Create the new string value named KioskMode and set the value to your kiosk ID.

Example:  K08fLFIswGHM9KOXBGjGKfrCFravIo01DmNwSBc9jo6YoKgd
5. Restart the Printix Service.
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How to deploy Printix Client as kiosk with Microsoft Endpoint Manager
Follow the normal steps, but in step 12, the Command line arguments need to include an 
extra :kiosk: value.
• Example: WRAPPED_ARGUMENTS=/id:cbd7e0b5-da2a-4cb6-b7f7-

a04ee31cac90:kiosk:K08fLFIswGHM9KOXBGjGKfrCFravIo01DmNwSBc9jo6YoKgd

The :kiosk: value is your kiosk ID. After deployment, the :kiosk: value is saved in the Windows 
Registry.

If you want to deploy and have sign-in postponed until restart, then :oms is appended.
• Example: WRAPPED_ARGUMENTS=/id:cbd7e0b5-da2a-4cb6-b7f7-

a04ee31cac90:kiosk:K08fLFIswGHM9KOXBGjGKfrCFravIo01DmNwSBc9jo6YoKgd:oms

How to get the kiosk ID
1. Open the Software  page.
2. Select Kiosk ID.
3. In Name, type a name for the kiosk ID.

The name is not linked to anything, so you can enter anything.
Example:  acme

4. Select I accept and select Submit to create the kiosk ID.
5. Select the kiosk ID value to copy it to the clipboard.

Save the kiosk ID in a secure place, because you will need it to deploy the Printix Client as kiosk.

Printix Client menu

Menu on Windows

• See what's printing
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Shows a list of the documents the Printix Client is printing.

• Show print notification
Select this to show the Print notification dialog box every time you print.

• Help
Opens the Printix User Help in a web browser.

Install the Printix Client
With the Printix Client, you can automate the creation of print queues and the installation of print 
drivers.
• Install Printix Client for Windows
• Install Printix Client for Mac

Install the Printix Client for Windows

Download the installer file
These steps help you download the .exe file. You can download the Microsoft Installer (MSI) 
package from the Software page in Printix Administrator.

On your Windows computer:
1. Open a web browser and enter the Printix Home URL for your organization followed by /

download.
Example:  acme.printix.net/download

2. Select Download Printix Client.

 Do not rename the installer file, because it prevents the Printix Client from working with 
your Printix Home.

Install the Printix Client
Printix Client requires .NET Runtime 6.

Open and run the file you downloaded:
1. Double-click CLIENT_{home}_{id}.EXE.

 Microsoft Defender SmartScreen may prevent the installer from running. You can safely 
select Run anyway and proceed with the installation of the Printix Client.

If a User Account Control dialog box appears, select Yes when prompted to allow the Printix 
Client Setup program to make changes on this computer.

2. Change the setup language if required. Select OK.
The Setup - Printix Client wizard appears.
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3. Select Next.
4. Select Install.

The installation is started.
5. After the installation is complete, select Finish.

Sign in

 Sign-in to the Printix Client is automatic on Microsoft Entra joined Windows 10 and 11 
computers and works with the Pro, Enterprise, and Education editions. Microsoft does not support 
Microsoft Entra join on Windows Home editions.

Sign in to the Printix Client.
• Sign-in is required the first time you start the Printix Client.
• After signing in to the Printix Client, you can close the browser window.

You can open the Printix Client  from the notification area.

Install the Printix Client for Mac

Download the installer file
On your Mac computer:

1. Open a web browser and enter the Printix Home URL for your organization followed by /
download.
Example:  acme.printix.net/download

2. Select Download Printix Client.


• Do not rename the installer file, because it prevents the Printix Client from working with 

your Printix Home.
• On Mac computers running macOS 10.15.1 or higher, you may get the message: Printix 

Client.pkg can't be opened because Apple cannot check it for malicious software. See:
FAQ - Printix Client for Mac will not install on macOS.

• Mac computers with Apple M2 require Printix Client for Mac version 1.3.1239 or higher. 
Submit a support request if you need a newer version.
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Install the Printix Client
Open and run the file you downloaded:

1. Open the Downloads folder, which is typically available from the Dock at the bottom of the 
screen.

2. Double-click CLIENT_{home}_{id}.DMG.
After a few seconds, the Printix Client dialog box appears.

3. Hold down the Control ^ key and right-click the Cardboard box  (Printix Client.pkg), then 
select Open With > Installer.
A warning message appears.

4. Select the option (typically Open or OK) to continue the installation.
5. If the Install Printix Client dialog box does not appear, repeat steps 2 to 4 or change your 

system settings as described in the related Apple documentation.

 Printix is an identified Apple developer and the Printix Client software is signed with our 
Apple developer ID.

6. In the Install Printix Client dialog box, select Continue. If you are prompted to select a 
destination, select Install for all users of this computer, then select Continue.

7. Select Install.
8. Enter your password to allow installation. Select Install Software.
9. Select Close to finish installing the Printix Client.
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Sign in

 It may take about a minute before the Sign in dialog box appears.

Sign in to the Printix Client.
• Sign-in is required the first time you start the Printix Client.
• After signing in to the Printix Client, you can close the browser window.

You can open the Printix Client  from the menu bar at the top of the screen.

How and how often is Printix Client updated
Computers will silently update themselves to the latest approved version listed on the Software
page. Upon regular intervals and at restart, PrintixService.exe checks whether a newer version is 
available, and if one is available, it downloads it from software.printix.net and silently installs on 
top of itself. PrintixService.exe runs under the system account. Whenever we make available a new 
Printix Client version to a customer, the computers update within 1-2 hours or as they come online. 
However, the Printix Client may sometimes update at a slower pace.

Customers are typically updated 1-3 times a year. A new version of Printix Client is typically 
deployed to customers in stages:
• First, Printix Client is deployed to new customers only and perhaps to selected partners or 

customers who need new features and/or fixes.
• Gradually, we will update the remaining customers as we grow confidence in the version. The 

whole deployment may span several months but can also be faster if the fixes are critical.

If you have submitted a support request that requires a new version of Printix Client, we may first 
supply that version to you with a download link, so it can be installed on selected computers to 
verify the resolution to the issue. If you accept, we can proceed and make the Printix Client available 
to your Printix Home on the Software page where you can also see the version.

 When a new version of Printix Client is made available, new versions are typically also made 
available for Printix Redirector and Printix Configurator.

See also:
• How to see the version of Printix Client
• How to submit a support request

302

https://knowledge.tungstenautomation.com/bundle/z-kb-articles-salesforce6/page/36505.html


Chapter 7

Printix Chromebook

Print to Printix-managed printers from Google Chrome.
• Features
• Requirements
• Install Printix Chromebook
• How to deploy Printix Chromebook
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• How to print from Chrome
• Available print settings
• Select print method

• Troubleshooting

Features
Users can select Printix printers that are configured to print Via the cloud (On all networks). 
The document is uploaded to the Printix Cloud and then forwarded to a Printix Client computer 
(Windows or Mac) on the printer's network. The document remains secure during the transfer over 
the Internet as the document itself and the communication are both encrypted.
• Gives users single sign-on (SSO) to Printix with their Google Workspace account or Microsoft 

account.
• Enable Google groups to give Exclusive access to print queues based on users' group 

membership.
• Manual effort is not required to maintain Printix Chromebook, because it silently updates itself to 

the latest approved version.

Requirements
• Subscription to Printix Cloud Print Management Service (printix.net).
• Gmail service with email domain that is part of Google Workspace.
• Any Internet-connected:

• Chromebook running: Google Chrome version 63 or higher.
• Computer (Windows, macOS, or Linux) with Chrome or Microsoft Edge browser.

• Signed in to the Printix extension.
• At least one Printix Client computer (Windows or Mac) is online on the printer's network.
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Troubleshooting
• You are not signed in
• Pick your Printix Home
• No printers are listed with the Printix logo
• Nothing is printed
• Text is missing on printout
• Why are some print settings not there
• How to get Printix Chromebook logs

You are not signed in
You have selected the Printix icon in the Chrome browser, but you are not signed in.
• Resolution for user: Sign in to the Printix extension.
• Resolution for administrator: If you are still seeing this error even though you are signed 

in, check that you have a Printix Home (example: acme.printix.net), and check that Google 
authentication is enabled. Otherwise, submit a support request.

Pick your Printix Home
You are prompted to Pick a Printix Home if Google Workspace is used by multiple Printix Homes. If 
you want to change to another Printix Home, select Change home .

No printers are listed with the Printix logo
• The printer is not listed with the Printix logo as expected.

Resolution: Open Printix Administrator and check the following:
• The print queue has Via the cloud (On all networks) selected.

• The Printix extension is not installed.
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Resolution: Install or deploy the Printix extension.

• You are not signed in to the Google Chrome browser.
Resolution: Sign in to the browser with your Google Workspace account. Check that Google 
authentication is enabled.

Nothing is printed
No computer with Printix Client is online on the printer's network.

Resolution: Make sure a computer with Printix Client is online on the same network as the printer. 
You can configure selected computers to Act as print gateway.

Text is missing on printout
This typically happens when printing web pages with complex layouts.

Resolution: In the Print dialog box, select Background graphics.

Why are some print settings not there
See Available print settings and How to control the default and available paper sizes.

Install Printix Chromebook
1. Open the Chrome Web Store and search for Printix.
2. Select Add to Chrome.
3. Select Add extension.

Printix has now been added.
4. To see a list of extensions, open Chrome and type chrome://extensions, then press Enter.

 Chromebooks are not listed in Printix Administrator, only computers running Printix 
Client.

See also:
• How to deploy Printix Chromebook
• How to print from Chrome
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How to deploy Printix Chromebook

1. Sign in to the Google Admin console (admin.google.com) using your administrator account 
(does not end in @gmail.com).

2. On the left-hand menu, select Devices > Chrome > Apps and extensions > Users and 
browsers.

3. In the Organizational units section, select the organizational unit where you want to deploy 
Printix.

4. Optionally, if you want users to sign in with Windows, then on the right pane, scroll down to
Policy for extensions and select Upload from file . Select the configuration file you created 
and select Open.

5. Select Force installation.
6. Select Save.

 Chromebooks are not listed in Printix Administrator, only computers running Printix 
Client.

Configuration file
If you want users to Sign in with Windows, a configuration file must be created and uploaded. If no 
configuration file is uploaded, users will still have single sign-on (SSO) to Printix with their Google 
Workspace account. The configuration file must be in JSON format and should be saved as a .txt file.
{ 
  "signIn": { 
    "Value": { 
      "tenant": "acme.printix.net", 
      "tenantId": "cbd7e0b5-da2a-4cb6-b7f7-a04ee31cac90", 
      "method": "both" 

307

https://admin.google.com/


Tungsten Printix Administrator Guide

    } 
  }
}

Values:

• tenant
The value tenant is your Printix Home. Example: acme.printix.net.

• tenantId
The value tenantId should be your Printix ID as shown on the Software page's MSI parameter 
section. Example: cbd7e0b5-da2a-4cb6-b7f7-a04ee31cac90.

• method
Configures the sign-in method. Values:
• azure

Users can sign in with their Microsoft work or school account. Requires that you enable 
Microsoft Entra authentication.

• azure SSO
Select this if users' Microsoft work or school account is used for single sign-on (SSO) to users' 
Google Workspace account. Requires that you enable Microsoft Entra authentication.

• google
Users can sign in with their Google Workspace account (not @gmail.com). Requires that you
enable Google authentication.

• okta
Users can sign in with their Okta account. Requires that you enable Okta authentication.

• onelogin
Users can sign in with their OneLogin account. Requires that you enable OneLogin 
authentication.

• both
Users can sign in with their Microsoft work or school account, Google Workspace account, 
or their Printix account. Requires that you enable Microsoft Entra authentication and enable 
Google authentication.

How to control the default and available paper sizes
If you want Letter to be the default, write NA_LETTER first. Google Chrome does the sorting of the 
paper sizes.
{ 
 "paperSizes": { 
 "Value": ["NA_LETTER", "NA_LEGAL"] 
  }
}

Paper size Value

A3 ISO_A3

A4 ISO_A4
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Paper size Value

A5 ISO_A5

B4 ISO_B4

B5 ISO_B5

B4 (JIS) JSI_B4

B5 (JIS) JSI_B5

Executive NA_EXECUTIVE

Legal NA_LEGAL

Letter NA_LETTER

Statement NA_STATEMENT

Tabloid NA_TABLOID

How to print from Chrome
1. Verify that the Printix extension for Google Chrome is installed.
2. Sign in to the Printix extension.

3. Open the item to print in the Google Chrome browser.
4. Select Print on the Chrome menu (or press Ctrl+P).
5. Select the current Destination, then select See more.
6. In the Select a destination dialog box, select a Printix printer as identified by the text Printix

 on its right.
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Print Anywhere documents printed from Chrome can, unless the printer's QR code or NFC 
tag is scanned, be released only to printers that have a print queue with Via the cloud (On all 
networks) selected.

7. Optionally, modify the available settings or set the print method to Print or Print Later.
8. Select Print.
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Available settings
The available settings depend on the properties of the Printix printer:
• Pages

Always available.
• Copies

Always available.
• Layout

Available, unless the document is a PDF, or if the printer supports PDF printing and Process PDF/
XPS is disabled.

• Color
Available, unless the printer does not support color, or if the printer supports PDF printing and
Process PDF/XPS is disabled.

Select More settings to access the following settings:
• Paper size

Always available.
• Pages per sheet

Available, unless the printer does not support it.
• Margins

Available, unless the document is a PDF.
• Scale

Always available.
• Options

• Print on both sides
Available, unless the printer does not support two-sided printing.

• Headers and footers
Available, unless the document is a PDF.

• Background graphics
Available, unless the document is a PDF.

 The Printix Client considers the user's choice of print settings: Paper size, Color, and Two-
sided. The Two-sided print setting is not considered for Print Anywhere.

Select print method
You can select a print method from Google Chrome without opening the Printix Client menu.

 Not available for Print Anywhere. Not available if Print Later is disabled or if the user Must 
print securely or Must Print Later by default.

1. Select More settings, then select Advanced settings.
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2. In the Advanced settings dialog box, select a print method:
• Print: The document is printed immediately at the selected printer.
• Print Later: Printix App must be used to release the document at the selected printer.

3. Select Apply.
4. Select Print.
5. If required, open the Printix App or sign in at the printer to release the document.

How to get Printix Chromebook logs
If advised to do so, follow these instructions and submit to support.

1. Get the Printix.log file.
2. Get the DevTools information.

Get the Printix.log file
1. Hold the Ctrl key and select the Printix  icon.

The Printix - options tab appears.
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2. Select Download.
3. Attach the Printix.log file to your support request.

Get the DevTools information
1. Open Chrome and enter chrome://extensions, then press Enter.

2. Enable Developer mode in the top right corner.
3. In the Printix extension, select background page.

The DevTools dialog box appears.
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4. Select the Network tab.
5. Print a document if this was the issue.

The communication can now been seen in the DevTools dialog box.
6. Select the printjobs item and make a readable screen shot of the content of the Headers and

Response tabs.
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Printix App

The Printix App is used to release, print, and delete documents. The Printix App is available as a web 
app that runs in a web browser or as a mobile app:
• Get Printix App for Android
• Get Printix App for iOS/iPadOS

You can open the web app by selecting Release and print documents in the Printix Client menu or 
by entering {your Printix Home}.printix.net in a web browser.

Compared to the web app, the mobile app offers these advantages:
• Only sign in once.
• Integrated QR code scanning.
• Integrated NFC tag scanning.
• Printing to Printix-managed printers is enabled for mobile print.
• Can be deployed with Microsoft Endpoint Manager.

• How to deploy Printix App for Android with Microsoft Endpoint Manager
• How to deploy Printix App for iOS/iPadOS with Microsoft Endpoint Manager
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 For the best user experience, we recommend that you enable your own, secure cloud storage
so users can release documents even when their computer is offline.

See the Printix User Help to read about:
• Printing with Printix
• How to open Printix App
• How to release documents
• How to reprint documents
• How to delete documents

Microsoft Entra Conditional Access
Follow the steps below if users get the message "Your sign-in was successful but does not meet the 
criteria to access this resource."

These steps are also helpful to control how authorized users access your cloud apps, including 
Printix.

1. Open a new browser window and sign in to Microsoft Azure (portal.azure.com) using your 
work account credentials.

2. In the portal menu, select All Services.
3. In the Identity category, select Microsoft Entra ID.
4. Under Feature highlights, select Conditional Access.
5. Select Policy Snapshot or View all policies.
6. Select the name of a policy.

Example:  Exclude Printix
7. Under Assignments and Target resources, select the blue text.

Example:  All cloud apps
8. Select the Exclude tab.
9. Under Select excluded cloud apps, select the blue text.

Example:  None
10. Select Printix and select Select.
11. Under Access controls and Grant, select the blue text.

Example:  0 controls selected
12. Select the controls to be enforced, then select Select.
13. Select Save.

 To be listed as a cloud app, Printix must be accepted for all users.

See also:
• What is conditional access in Microsoft Entra ID?
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Chapter 9

Printix Go

Printix Go is an application that integrates with your printer's touchscreen control panel, offering 
secure print release, copy control, card-based authentication, and more.
• Features
• Requirements

• Printix Go supported printers and MFPs
• Brother
• Epson
• Fujifilm
• HP
• HP Workpath
• Konica Minolta
• Kyocera
• Lexmark
• Ricoh
• Xerox

• Card readers and cards
• Install Printix Go

• Install Printix Capture

Watch this video: Printix Go Configuration | Printix Cloud Print Management.

 If you wish to use Printix Go, submit a request and the responsible sales manager at Printix 
will contact you shortly.

• How to install Printix Go on multiple printers
• How to update Printix Go
• How to sign in with ID code at the printer
• How to sign in with card at the printer
• How to release documents at the printer
• How to capture at the printer
• How to sign out
• How to register card
• How to manage cards
• How to reset ID code or PIN code
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• How to see and reset ID code
• How to create and reset PIN code
• How to uninstall Printix Go
• How to uninstall Printix Go from multiple printers
• Printix Go issues

Features
• Swipe your card to sign in at the printer to release documents.
• Control access to multifunction printer (MFP) functions: Copy, Copy in color, Email, Scan, …
• Increase security with PIN code (4-digit) for two-factor authentication.
• Alternatively, sign in without card by entering ID code and PIN code on the printer's touchscreen 

control panel.
• Use existing or new card readers.
• Self-service card registration and management.
• Multiple cards per user.
• Install from the Printix Administrator.

 For best user experience, we recommend that you enable your own secure cloud storage, so 
users can release documents even when their computer is offline.

Requirements
Supports selected printers with touchscreen control panel from:
• Brother
• Epson
• Fujifilm
• HP
• HP Workpath
• Konica Minolta
• Kyocera
• Lexmark
• Ricoh
• Xerox
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• Support for printer vendors is subject to demand. Contact Product Support to hear about 

support for other vendors.
• Printix Go on a printer can only be used with one Printix Home. If multiple companies need to 

use the same printer, another option could be to add multiple Microsoft Entra directories or
multiple Google domains.

Printix Go supported printers and MFPs
Printix Go is available for these vendors:
• Brother
• Epson
• Fujifilm
• HP
• HP Workpath
• Konica Minolta
• Kyocera
• Lexmark
• Ricoh
• Xerox

Features
• Present card to sign in at the printer to release documents.
• Printix functions: Print (release documents). Capture (deliver scanned documents to your 

selected workflow destination).
• Control access to multifunction printer (MFP) functions: Copy, Copy in color, Email, Scan, …
• Increase security with PIN code (4-digit) for two-factor authentication.
• Alternatively, sign in without card by entering ID code and PIN code on the printer's touchscreen 

control panel.
• Use existing or new card readers.
• Self-service card registration and management.

Vendor Sign in 
with card

Register 
card

Print Capture Access 
control

Printer’s 
scan to 
email 
function

Remote 
control 
panel

Brother Yes [1] Code and 
QR code

Yes – All functions No prefill Yes

Epson Yes Code and 
QR code

Yes – Per function From is 
prefilled

No
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Vendor Sign in 
with card

Register 
card

Print Capture Access 
control

Printer’s 
scan to 
email 
function

Remote 
control 
panel

Fujifilm Yes Code and 
QR code

Yes – All functions From is 
prefilled

No

HP Yes [2] Code and 
QR code

Yes Yes Per function To and
From is 
prefilled

Yes

HP 
Workpath

Yes [2] Code and 
QR code

Yes – Per function To and
From is 
prefilled

Yes

Konica 
Minolta

Yes [3] Code and 
QR code

Yes Yes All functions 
[4]

To and
From is 
prefilled

Yes

Kyocera Yes Code and 
QR code

Yes Yes All functions 
[5]

From is 
prefilled

Yes

Lexmark Yes [6] Code and 
QR code

Yes – Per function To and
From is 
prefilled

Yes

Ricoh Yes Code and 
QR code

Yes Yes All functions 
[7]

To and
From is 
prefilled

Yes

Xerox Yes [8] Code Yes – Per function No prefill Yes

[1] Brother: Card readers must be enabled on the printer's web page before installing Printix Go.

[2] HP and HP Workpath: Users cannot sign in with card while a native printer function, such as 
Copy, is in use.

[3] Konica Minolta: Printers may require installation of card reader driver.

[4] Konica Minolta: Users can sign in as guest to use functions not locked by Access control.

[5] Kyocera: Users can sign in as guest to use functions not locked by Access control.

[6] Lexmark: Printix may have issues registering card readers if Keyboard Emulation Reader 
Driver is installed on the printer. Seen with Elatec (VID 0×09D8, PID 0×0410).

[7] Ricoh: Users can sign in as guest to use functions not locked by Access control.

[8] Xerox: Xerox VersaLink requires installation of the Xerox USB Card Reader.

Requirements
• Printer administrator password must be set and cannot be blank on the printer.
• Printer's DNS server must be configured.
• It is generally recommended to use the latest printer firmware version.
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• In addition to the required Internet endpoints, these must also be unblocked to allow Printix Go 
to communicate to Printix Cloud (how to test):
• https://device-api.printix.net
• https://on-device-api.printix.net
• https://on-device-printer-sign-in.printix.net
• https://on-device-printer-release-documents.printix.net
• https://on-device-capture.printix.net

Vendor Notes Platform Additional network 
ports

Printix Client 
presence

Brother – BSI (2022) – Install [1], Update, 
Uninstall

Epson – EOP version 1.1 – Install, Update, 
Uninstall, Sign in [2], 
Printing

Fujifilm – AIP version 7 – Install, Update, 
Uninstall, Sign in, 
Printing

HP – OXPd, FutureSmart 
4 or 5 firmware

SSL on TCP port
7627 – Printix Client 
to printer. HTTPS 
on TCP port 21343
– Printer (with 
Capture) to Printix 
Client

Install, Update, 
Uninstall, Sign in [3], 
Printing, Capture

HP Workpath – Workpath, 
FutureSmart 5.4 
firmware

– Install [4], Update, 
Uninstall, Sign in, 
Printing

Konica Minolta [5] OpenAPI 5.1 or 
higher

SSL on TCP port
50003 – Printix 
Client to printer. 
HTTPS on TCP port
21343 – Printer (with 
Capture) to Printix 
Client

Install, Update, 
Uninstall, Sign in [6], 
Printing, Capture

Kyocera – HyPAS Generation 
2 or higher, Java VM 
1.8 or higher and 
OSGi Release 4 or 
higher

– Install [7], Update, 
Uninstall, Sign in, 
Printing, Capture

Lexmark – eSF version 6.x – Install, Update, 
Uninstall, Sign in [8], 
Printing

Ricoh [9] SOP Generation 2 or 
higher

HTTPS on TCP port
51443 – Printix 
Client to printer

Install [10a], 
Update, Uninstall, 
Sign in [10b], 
Printing, Capture
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Vendor Notes Platform Additional network 
ports

Printix Client 
presence

Xerox [11] EIP version 3.7 or 
higher

– Install, Update, 
Uninstall, Sign in 
[12], Printing

[1] Brother: Simultaneous sign-in profile verifications, installations, updates, and uninstallations can 
impact the performance of the affected computers. To lessen the impact, install the Printix Client on 
more computers on the network.

[2] Epson: Printer will say NO ACTIVE WS. If you sign in anyway, you will get a 401 error. If you 
present card, nothing happens.

[3] HP: If you sign in, printer will say NO ACTIVE WS. If you sign in anyway, you will get a wrong auth 
context error. If you present card, nothing happens.

[4] HP Workpath: First, install Printix Go through the HP Command Center, then install Printix Go 
through the Printix Administrator to configure it to work with your Printix Home.

[5] Konica Minolta: Can be used in Europe and US only. Contact Product Support if you need it 
in other regions and let us know the country (new solution key required from Konica Minolta). 
Important to prepare the printer in regards to SSL/TLS, Web browser, and OpenAPI.

[6] Konica Minolta: Printer will say NO ACTIVE WS. If you sign in anyway, you will get a wrong auth 
context error. If you present card, screen blinks and returns to sign-in page.

[7] Kyocera: First, install Printix Go through the KYOCERA Net Viewer, then install Printix Go through 
the Printix Administrator to configure it to work with your Printix Home.

[8] Lexmark: Printer will say NO ACTIVE WS. If you sign in anyway, you will get a wrong auth context 
error. If you present card, sign in works, but when you select Print, the printer will say NO ACTIVE 
WS.

[9] Ricoh: SSL/TLS must be enabled for IPv4 on the printer and communication must be set to
Ciphertext/Cleartext. For Ricoh SOP printers Generation 2, web server password must be the 
default password.

[10a] Ricoh: Computer with Printix Client for Windows must be online on the printer's network 
during install, update and uninstall of Printix Go Ricoh. Printix Client for Mac does not support 
install, update and uninstall of Printix Go Ricoh.

[10b] Ricoh: Printer will say NO ACTIVE WS. If you present card, sign in works, but when you select
Print, you are returned to the sign-in page.

[11] Xerox: The Sign in profile must reference an SNMPv1 configuration where the Set Community 
Name specified in the selected SNMPv1 configuration MUST match the Community Name Read/
Write configured as part of SNMPv1/v2 on the printer.

[12] Xerox: If you sign in, print will timeout and say Could not log in. If you present card, nothing 
happens.

See also:
• Printix Go issues
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About the Internet endpoints device-api.printix.net and on-device-
api.printix.net
Printix transitioned from using the Internet endpoint device-api.printix to on-device-api.printix.net.

Vendor device-api.printix.net on-device-api.printix.net

Brother not used used

Epson used now –

Fujifilm not used used

HP used now required to use capture

HP Workpath not used used

Konica Minolta used now required to use capture

Kyocera not used used

Lexmark used now –

Ricoh used now required to use capture

Xerox used now –

Printix Go Brother supported printers and MFPs

Requirements
• Printer's date and time must match the local time.
• Printer administrator password must be set and cannot be blank.
• Computer with Printix Client must be online on the printer's network during installation and use 

of Printix Go.
• The Printix Client must be online on at least one Windows computer or server that has .NET 

Framework 4.8 installed. You can check your .NET version in the registry database under this 
path: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\NET Framework Setup\NDP\v4\Full.

• The minimum required version of Printix Client is 2.3.0.211 on every computer on the network. 
At least one of them must run Windows.

• In addition to the required Internet endpoints, this endpoint must also be unblocked to allow 
Printix Go to communicate with Printix Cloud (how to test):
• https://on-device-api.printix.net

Next steps
1. Verify that your printer is supported.
2. Prepare Brother printer for Printix Go.
3. Install Printix Go.
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DISCLAIMER
We make all attempts to keep the product compatibility information current. However, we make no 
warranties, express or implied, with respect to printer vendor's products or the interoperation with 
Printix Go.

The list of supported printers is as follows:
• Printers
• MFPs
• Supported card readers

Printers
• HL-EX415DW
• HL-J6000CDW, HL-J6000DW
• HL-J6010DW
• HL-J6100DW
• HL-J7010CDW
• HL-L6310DW
• HL-L6410DN, HL-L6412DW, HL-L6415DN, HL-L6415DW, HL-L6418DW
• HL-L8360CDW, HL-L8360CDWT
• HL-L9310CDW
• HL-L9410CDN
• HL-L9430CDN
• HL-L9470CDN

MFPs
• DCP-L5500DN, DCP-L5502DN
• DCP-L5510DN, DCP-L5510DW, DCP-L5512DN, DCP-L5518DN
• DCP-L5600DN, DCP-L5602DN
• DCP-L5610DN
• DCP-L5650DN, DCP-L5652DN
• DCP-L5660DN, DCP-L5662DN
• DCP-L6600DW
• DCP-L8410CDW
• MFC-8530DN
• MFC-8535DN
• MFC-8540DN
• MFC-J5945DW
• MFC-J5955DW
• MFC-J6945DW, MFC-J6947DW
• MFC-J6955DW, MFC-J6957DW
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• MFC-J6997CDW, MFC-J6999CDW
• MFC-J7500CDW
• MFC-J7600CDW
• MFC-L5700DN, MFC-L5700DW, MFC-L5702DW
• MFC-L5710DN, MFC-L5710DW, MFC-L5715DN, MFC-L5715DW, MFC-L5717DW, MFC-L5718DN
• MFC-L5728DW
• MFC-L5750DW, MFC-L5755DW
• MFC-L5800DW, MFC-L5802DW
• MFC-L5850DW
• MFC-L5900DW, MFC-L5902DW
• MFC-L5912DW, MFC-L5915DW
• MFC-L6700DW, MFC-L6702DW
• MFC-L6710DW
• MFC-L6720DW
• MFC-L6750DW
• MFC-L6800DW, MFC-L6800DW CONSIP, MFC-L6800DW CSP2
• MFC-L6810DW
• MFC-L6820DW
• MFC-L6900DW, MFC-L6900DWG, MFC-L6900DWX, MFC-L6902DW
• MFC-L6910DN, MFC-L6912DW, MFC-L6915DN, MFC-L6915DW
• MFC-L6950DW
• MFC-L6970DW
• MFC-L8610CDW
• MFC-L8690CDW
• MFC-L8900CDW
• MFC-L9570CDW, MFC-L9577CDW
• MFC-L9610CDN
• MFC-L9630CDN
• MFC-L9670CDN

Supported card readers
Card readers with the below vendor ID (VID) and product ID (PID) are supported.

Vendor VID PID Protocol Comment Brother

Baltech 0×13AD 0×9CAA KBD Kofax Equitrac 
(see part 
numbers)

Yes

Baltech 0×13AD 0×9CA5 Binary Kofax Equitrac 
(see part 
numbers)

No

Brother - - - Brother internal 
card reader

Yes
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Vendor VID PID Protocol Comment Brother

Elatec 0×09D8 0×0206 Binary TWN3 Mifare 
USB (Kofax 
SafeCom)

No

Elatec 0×09D8 0×0310 KBD TWN3 Mifare 
USB Keyboard 
emulating

Yes

Elatec 0×09D8 0×0406 Binary TWN4 Mifare 
USB (Kofax 
SafeCom)

No

Elatec 0×09D8 0×0410 KBD TWN4 Mifare 
USB

Yes

Fujifilm 0×076B 0×5128 KBD Fujifilm ICCR-B No

HID 0×076B 0×5427 Custom report HID OMNIKEY 
5427G2

No

HID 0×076B 0×5428 KBD HID OMNIKEY 
5427G2 
(keyboard)

No

HP 0×03F0 0×0045 MFP24 X3D03A HP USB 
Universal Card 
Reader

No

HP 0×0C27 0×3BFA KBD Y7C05A HIP2 
Keystroke 
Reader

No

Inepro 0×1DA6 0×0110 KBD Inepro SCR708.I 
RFID Reader
Inepro SPIDER 
RFID Reader

No

rf IDEAS 0×0C27 0×0104 Binary pcProx Card 
Reader (Kofax 
SafeCom)

No

rf IDEAS 0×0C27 0×3BFA KBD pcProx Card 
Reader

No

rf IDEAS 0×0C27 0×3BFA KBD RDR-30MR1CKU-
MXS
RDR-800R1AKU
RDR-80541AKU-
RSOP
RDR-805R1AKU
RDR-805R1AKU-
G3

Yes
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Printix Go Epson supported MFPs

Requirements
• As a general rule, Printix Go supports Epson MFPs that are compatible with Epson Open Platform 

(EOP) version 1.1.
• Open Platform must be activated. This is done with a product key based on the printer's serial 

number.
• Printer's date and time must match the local time.
• Printer administrator password must be set and cannot be blank.
• Printer's DNS server must be configured.
• Computer with Printix Client must be online on the printer's network during installation and use 

of Printix Go.
• In addition to the required Internet endpoints, these must also be unblocked to allow Printix Go 

to communicate to the Printix Cloud (how to test):
• https://device-api.printix.net
• https://on-device-api.printix.net
• https://on-device-printer-sign-in.printix.net
• https://on-device-printer-release-documents.printix.net
• https://on-device-capture.printix.net

 Printix Go installation (including update and uninstall) will cause the Epson printer's network 
interface to restart, leaving it disconnected from the network for about 1 minute.

Next steps
1. Verify that your printer is supported.
2. How to prepare Epson printer for Printix Go.
3. Install Printix Go.

 Upon entering a wrong ID code (and/or PIN code) during sign-in, the Epson printer will 
say: Please try to reload the page or contact your administrator.

DISCLAIMER
We make all attempts to keep the product compatibility information current. However, we make no 
warranties, express or implied, with respect to printer vendor's products or the interoperation with 
Printix Go.

 Printers are supported even if the actual model name as shown in Printix Administrator and as 
product name on printer's configuration and web (EWS) pages differ from below. If in doubt about 
the model name, search on the number in the name (Example: WF-C17590).

• WorkForce Enterprise MFPs
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• WorkForce Pro MFPs
• EcoTank Pro MFPs
• Supported card readers

WorkForce Enterprise MFPs
• WorkForce Enterprise AM-C4000
• WorkForce Enterprise AM-C5000
• WorkForce Enterprise AM-C6000
• WorkForce Enterprise WF-C17590 Series
• WorkForce Enterprise WF-C20590 Series
• WorkForce Enterprise WF-C20600 Series
• WorkForce Enterprise WF-C20750 Series
• WorkForce Enterprise WF-C21000 Series
• WorkForce Enterprise WF-M20590 Series
• WorkForce Enterprise WF-M21000 Series

WorkForce Pro MFPs
• WorkForce Pro WF-6590 Series
• WorkForce Pro WF-8590 Series
• WorkForce Pro WF-C5790 Series
• WorkForce Pro WF-C579R Series
• WorkForce Pro WF-C5890 Series
• WorkForce Pro WF-C8690 Series
• WorkForce Pro WF-C869R Series
• WorkForce Pro WF-C878R Series
• WorkForce Pro WF-C879R Series
• WorkForce Pro WF-M5799 Series
• WorkForce Pro WF-R5690 Series

EcoTank Pro MFPs
• EcoTank Pro ET-16680 Series
• EcoTank Pro ET-M16680 Series
• EcoTank Pro L15180 Series
• EcoTank Pro M15180 Series

Supported card readers
Card readers with the below vendor ID (VID) and product ID (PID) are supported.
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Vendor VID PID Protocol Comment Epson

Baltech 0×13AD 0×9CAA KBD Kofax Equitrac 
(see part 
numbers)

Yes

Baltech 0×13AD 0×9CA5 Binary Kofax Equitrac 
(see part 
numbers)

Yes

Brother - - - Brother internal 
card reader

No

Elatec 0×09D8 0×0206 Binary TWN3 Mifare 
USB (Kofax 
SafeCom)

Yes

Elatec 0×09D8 0×0310 KBD TWN3 Mifare 
USB Keyboard 
emulating

Yes

Elatec 0×09D8 0×0406 Binary TWN4 Mifare 
USB (Kofax 
SafeCom)

Yes

Elatec 0×09D8 0×0410 KBD TWN4 Mifare 
USB

Yes

Fujifilm 0×076B 0×5128 KBD Fujifilm ICCR-B No

HID 0×076B 0×5427 Custom report HID OMNIKEY 
5427G2

No

HID 0×076B 0×5428 KBD HID OMNIKEY 
5427G2 
(keyboard)

No

HP 0×03F0 0×0045 MFP24 X3D03A HP USB 
Universal Card 
Reader

No

HP 0×0C27 0×3BFA KBD Y7C05A HIP2 
Keystroke 
Reader

Yes

Inepro 0×1DA6 0×0110 KBD Inepro SCR708.I 
RFID Reader
Inepro SPIDER 
RFID Reader

Yes

rf IDEAS 0×0C27 0×0104 Binary pcProx Card 
Reader (Kofax 
SafeCom)

No

rf IDEAS 0×0C27 0×3BFA KBD pcProx Card 
Reader

Yes
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Vendor VID PID Protocol Comment Epson

rf IDEAS 0×0C27 0×3BFA KBD RDR-30MR1CKU-
MXS
RDR-800R1AKU
RDR-80541AKU-
RSOP
RDR-805R1AKU
RDR-805R1AKU-
G3

No

Printix Go Fujifilm supported printers and MFPs

Requirements
• As a general rule, Printix Go supports Fujifilm printers and MFPs that support the AIP 7 

framework and embedded web browser 5.
• Printer's date and time must match the local time.
• Printer administrator password must be set and cannot be blank.
• HTTP port 8091 and HTTPS port 58501 must be open.
• Computer with Printix Client must be online on the printer's network during installation and use 

of Printix Go.
• The minimum required version of Printix Client is 2.2.0.12 on every computer on the network. 

At least one of them must run Windows.
• In addition to the required Internet endpoints, these must also be unblocked to allow Printix Go 

to communicate with Printix Cloud (how to test):
• https://on-device-api.printix.net
• https://api.printix.net
• https://on-device-printer-sign-in.printix.net
• https://on-device-printer-release-documents.printix.net

Next steps
1. Verify that your printer is supported.
2. Prepare your Fujifilm printer for Printix Go.
3. Install Printix Go.

DISCLAIMER
We make all attempts to keep the product compatibility information current. However, we make no 
warranties, express or implied, with respect to printer vendor's products or the interoperation with 
Printix Go.
• Supported Fujifilm printers
• Supported Fujifilm MFPs
• Supported card readers
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Supported Fujifilm printers
• Fujifilm ApeosPrint 4830
• Fujifilm ApeosPrint 5330
• Fujifilm ApeosPrint 6340
• Fujifilm ApeosPrint C3530
• Fujifilm ApeosPrint C4030
• Fujifilm ApeosPrint C5240, C5570

Supported Fujifilm MFPs
• Fujifilm Apeos 1860
• Fujifilm Apeos 2560
• Fujifilm Apeos 3060, 3560, 3570
• Fujifilm Apeos 4570, 4830
• Fujifilm Apeos 5330, 5570, 5580
• Fujifilm Apeos 6340, 6580
• Fujifilm Apeos 7580
• Fujifilm Apeos C2060, C2360, C2560, C2570
• Fujifilm Apeos C3060, C3070, C3530, C3570
• Fujifilm Apeos C4030, C4570
• Fujifilm Apeos C5240, C5570
• Fujifilm Apeos C6570, C6580
• Fujifilm Apeos C7070, C7580
• Fujifilm Apeos C8180
• Fujifilm ApeosPro C650
• Fujifilm ApeosPro C750
• Fujifilm Revoria Press E1100, E1110, E1125, E1136

Supported card readers
Card readers with the below vendor ID (VID) and product ID (PID) are supported.

Vendor VID PID Protocol Comment Fujifilm

Baltech 0×13AD 0×9CAA KBD Kofax Equitrac 
(see part 
numbers)

No

Baltech 0×13AD 0×9CA5 Binary Kofax Equitrac 
(see part 
numbers)

Yes

Brother - - - Brother internal 
card reader

No
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Vendor VID PID Protocol Comment Fujifilm

Elatec 0×09D8 0×0206 Binary TWN3 Mifare 
USB (Kofax 
SafeCom)

No

Elatec 0×09D8 0×0310 KBD TWN3 Mifare 
USB Keyboard 
emulating

Yes

Elatec 0×09D8 0×0406 Binary TWN4 Mifare 
USB (Kofax 
SafeCom)

No

Elatec 0×09D8 0×0410 KBD TWN4 Mifare 
USB

Yes

Fujifilm 0×076B 0×5128 KBD Fujifilm ICCR-B Yes

HID 0×076B 0×5427 Custom report HID OMNIKEY 
5427G2

No

HID 0×076B 0×5428 KBD HID OMNIKEY 
5427G2 
(keyboard)

Yes

HP 0×03F0 0×0045 MFP24 X3D03A HP USB 
Universal Card 
Reader

No

HP 0×0C27 0×3BFA KBD Y7C05A HIP2 
Keystroke 
Reader

Yes

Inepro 0×1DA6 0×0110 KBD Inepro SCR708.I 
RFID Reader
Inepro SPIDER 
RFID Reader

No

rf IDEAS 0×0C27 0×0104 Binary pcProx Card 
Reader (Kofax 
SafeCom)

No

rf IDEAS 0×0C27 0×3BFA KBD pcProx Card 
Reader

No

rf IDEAS 0×0C27 0×3BFA KBD RDR-30MR1CKU-
MXS
RDR-800R1AKU
RDR-80541AKU-
RSOP
RDR-805R1AKU
RDR-805R1AKU-
G3

No
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Printix Go HP supported printers and MFPs

What is the difference between Printix Go HP Workpath and Printix Go 
HP?
Printix Go HP Workpath started in 2022 needs to be installed on the printer from HP Command 
Center, followed by a subsequent configuration to make it work with your Printix Home. The 
configuration is done from Printix Administrator by performing an installation of Printix Go. 
Printix Go HP started in 2020 uses HP's device layer in the Open Extensibility Platform ( OXPd) and 
installation and configuration is handled solely within Printix Administrator.

Both HP platforms (Workpath and OXPd) are supported, but only one Printix Go must be installed 
on your HP printer. You can check the list of supported card readers and cards.

Requirements
• As a general rule, Printix Go supports HP printers and MFPs that run FutureSmart 4 firmware 

(version 4.10.0.1 or later) or FutureSmart 5 firmware. Uses HP's device layer in their Open 
Extensibility Platform (OXPd).
• HP documentation on: HP Enterprise, HP Managed - Update the printer firmware.
• HP documentation on: HP FutureSmart - Latest Firmware Versions.

 HP FutureSmart version 5.7.1.1 is reported to cause errors on HP LaserJet Managed and 
HP PageWide Managed MFPs. For these MFPs, ensure that you do not install this firmware.

• If your model is not on the list, visit HP Customer Support (support.hp.com), find your model, 
and expand the Firmware section. The Firmware is typically named: FutureSmart Bundle 
Version. If it is named differently, it is not running FutureSmart.

• Printer's date and time must match the local time.
• Printer administrator password must be set and cannot be blank.
• Computer with Printix Client must be online on the printer's network during installation and use 

of Printix Go.
• Printix Capture:

• Computer with Printix Client version 1.3.1253.0 or higher for Windows must be online on the 
printer's network during the use of Printix Capture.

• Computer must have a fully qualified domain name (FQDN).
If the computer is running on a VM, see the Microsoft documentation: Create a fully qualified 
domain name for a VM in the Azure portal.

• It must be possible to ping computers by hostname. This is a requirement because the printer/
computer scan connection uses secure HTTPS communication, and to avoid having to renew 
certificates whenever the computer changes IP address it must be possible to reference the 
computer by hostname.

• In addition to the required Internet endpoints, these must also be unblocked to allow Printix Go 
to communication to Printix Cloud (how to test):
• https://device-api.printix.net

333

https://support.hp.com/us-en/document/ish_4158468-4158516-16
https://support.hp.com/us-en/document/ish_4025423-4025481-16
https://support.hp.com/
https://learn.microsoft.com/en-us/azure/virtual-machines/create-fqdn
https://learn.microsoft.com/en-us/azure/virtual-machines/create-fqdn


Tungsten Printix Administrator Guide

• https://on-device-api.printix.net
• https://on-device-printer-sign-in.printix.net
• https://on-device-printer-release-documents.printix.net
• https://on-device-capture.printix.net

Next steps
Even if an HP printer supports both HP platforms (Workpath and OXPd), only one Printix Go must be 
installed. If required, do an uninstallation first.

1. Verify that your printer is supported.
2. Install Printix Go.

DISCLAIMER
We make all attempts to keep the product compatibility information current. However, we make no 
warranties, express or implied, with respect to printer vendor's products or the interoperation with 
Printix Go.

 Printers are supported even if the actual model name as shown in Printix Administrator and 
as product name on printer's configuration and web (EWS) pages, does not contain the terms
Enterprise and Managed. Example: HP Color LaserJet MFP M577 is the model name reported 
by the printer, but in the list below and on hp.com, you will see HP Color LaserJet Enterprise MFP 
M577 and HP Color LaserJet Managed MFP M577. If in doubt, search for the number in the name 
(Example: M577).

• MFPs
• HP LaserJet Enterprise
• HP LaserJet Managed
• HP OfficeJet Enterprise and Managed
• HP PageWide Enterprise and Managed

• Printers
• HP LaserJet Enterprise
• HP LaserJet Managed
• HP OfficeJet Enterprise and Managed
• HP PageWide Enterprise and Managed

• Supported card readers

MFPs

HP LaserJet Enterprise
• HP Color LaserJet Enterprise MFP 5800
• HP Color LaserJet Enterprise MFP 6800
• HP Color LaserJet Enterprise MFP 6801
• HP LaserJet Enterprise MFP M430
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• HP LaserJet Enterprise MFP M431
• HP Color LaserJet Enterprise MFP M480
• HP LaserJet Enterprise 500 MFP M525
• HP LaserJet Enterprise Flow MFP M525
• HP LaserJet Enterprise MFP M527
• HP LaserJet Enterprise MFP M528
• HP Color LaserJet Enterprise MFP M575
• HP Color LaserJet Enterprise MFP M575 Flow
• HP Color LaserJet Enterprise MFP M577
• HP Color LaserJet Enterprise MFP M578
• HP LaserJet Enterprise MFP M630
• HP LaserJet Enterprise MFP M631
• HP LaserJet Enterprise MFP M632
• HP LaserJet Enterprise MFP M633
• HP LaserJet Enterprise M680 MFP
• HP LaserJet Enterprise M681 MFP
• HP LaserJet Enterprise M682 MFP
• HP LaserJet Enterprise 700 MFP M725
• HP LaserJet Enterprise 700 Color MFP M775
• HP Color LaserJet Enterprise MFP M776
• HP LaserJet Enterprise Flow MFP M830
• HP Color LaserJet Enterprise Flow MFP M880
• HP Color LaserJet Enterprise MFP X57945
• HP Color LaserJet Enterprise MFP X58045
• HP Color LaserJet Enterprise MFP X67755
• HP Color LaserJet Enterprise MFP X67765

HP LaserJet Managed
• HP LaserJet Managed MFP E42540
• HP Color LaserJet Managed MFP E47528
• HP LaserJet Managed MFP E52545
• HP LaserJet Managed MFP E52645
• HP Color LaserJet Managed MFP E57540
• HP LaserJet Managed MFP E62555
• HP LaserJet Managed MFP E62565
• HP LaserJet Managed MFP E62575
• HP LaserJet Managed MFP E62655
• HP LaserJet Managed MFP E62665
• HP LaserJet Managed MFP E62675
• HP Color LaserJet Managed MFP E67550
• HP Color LaserJet Managed MFP E67560
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• HP Color LaserJet Managed MFP E67650
• HP Color LaserJet Managed MFP E67660
• HP LaserJet Managed MFP E72425-E72430
• HP LaserJet Managed MFP E72525-E72535
• HP LaserJet Managed MFP E73025
• HP LaserJet Managed MFP E73030
• HP LaserJet Managed MFP E73035
• HP LaserJet Managed MFP E73130
• HP LaserJet Managed MFP E73140
• HP Color LaserJet Managed MFP E77422-E77428
• HP Color LaserJet Managed MFP E77822-E77830
• HP Color LaserJet Managed MFP E78223-E78228
• HP Color LaserJet Managed MFP E78323-E78330
• HP Color LaserJet Managed MFP E78523
• HP Color LaserJet Managed MFP E78528
• HP Color LaserJet Managed MFP E78625
• HP Color LaserJet Managed MFP E78630
• HP Color LaserJet Managed MFP E78635
• HP LaserJet Managed MFP E82540
• HP LaserJet Managed MFP E82550
• HP LaserJet Managed MFP E82560
• HP LaserJet Managed MFP E82650
• HP LaserJet Managed MFP E82660
• HP LaserJet Managed MFP E82670
• HP Color LaserJet Managed MFP E87640
• HP Color LaserJet Managed MFP E87650
• HP Color LaserJet Managed MFP E87660
• HP Color LaserJet Managed MFP E87740
• HP Color LaserJet Managed MFP E87750
• HP Color LaserJet Managed MFP E87760
• HP Color LaserJet Managed MFP E87770
• HP LaserJet Managed MFP M525
• HP LaserJet Managed Flow MFP M525
• HP LaserJet Managed MFP M527
• HP LaserJet Managed Flow MFP M527
• HP Color LaserJet Managed MFP M575
• HP Color LaserJet Managed Flow MFP M575
• HP Color LaserJet Managed MFP M577
• HP Color LaserJet Managed Flow MFP M577
• HP LaserJet Managed MFP M630
• HP LaserJet Managed Flow MFP M630
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• HP Color LaserJet Managed MFP M680
• HP Color LaserJet Managed Flow MFP M680
• HP LaserJet Managed MFP M725
• HP Color LaserJet Managed MFP M775
• HP LaserJet Managed Flow MFP M830
• HP Color LaserJet Managed Flow MFP M880

HP OfficeJet Enterprise and Managed
• HP OfficeJet Enterprise Color MFP X585
• HP OfficeJet Managed Color MFP X585
• HP OfficeJet Managed Color Flow MFP X585

HP PageWide Enterprise and Managed
• HP PageWide Enterprise Color MFP 586
• HP PageWide Managed Color MFP E58650
• HP PageWide Enterprise Color MFP 780
• HP PageWide Enterprise Color MFP 785
• HP PageWide Managed Color MFP P77440
• HP PageWide Managed Color MFP E77650
• HP PageWide Managed Color MFP E77660
• HP PageWide Managed Color MFP P77940
• HP PageWide Managed Color MFP P77950
• HP PageWide Managed Color MFP P77960

Printers

HP LaserJet Enterprise
• HP Color LaserJet Enterprise 5700
• HP Color LaserJet Enterprise 6700, 6701
• HP LaserJet Enterprise M507
• HP Color LaserJet Enterprise M555
• HP LaserJet Enterprise M605
• HP Color LaserJet Enterprise M651
• HP Color LaserJet Enterprise M653
• HP LaserJet Enterprise M806
• HP Color LaserJet Enterprise M855
• HP Color LaserJet Enterprise M856

HP LaserJet Managed
• HP LaserJet Managed E50045
• HP LaserJet Managed E50145
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• HP Color LaserJet Managed E55040
• HP LaserJet Managed E60055
• HP LaserJet Managed E60065
• HP LaserJet Managed E60075
• HP LaserJet Managed E60155
• HP LaserJet Managed E60165
• HP LaserJet Managed E60175
• HP Color LaserJet Managed E65050
• HP Color LaserJet Managed E65060
• HP Color LaserJet Managed E65150
• HP Color LaserJet Managed E65160
• HP Color LaserJet Managed E85055
• HP Color LaserJet Managed M651
• HP Color LaserJet Managed X55745
• HP Color LaserJet Managed X65445
• HP Color LaserJet Managed X65465

HP OfficeJet Enterprise and Managed
• HP OfficeJet Enterprise Color X555

HP PageWide Enterprise and Managed
• HP PageWide Enterprise Color 556
• HP PageWide Managed Color E55650
• HP PageWide Enterprise Color 755
• HP PageWide Enterprise Color 765
• HP PageWide Managed Color E75160
• HP PageWide Managed Color P75250

Supported card readers
Card readers with the below vendor ID (VID) and product ID (PID) are supported.

Vendor VID PID Protocol Comment HP

Baltech 0×13AD 0×9CAA KBD Kofax Equitrac 
(see part 
numbers)

No

Baltech 0×13AD 0×9CA5 Binary Kofax Equitrac 
(see part 
numbers)

Yes

Brother - - - Brother internal 
card reader

No

Elatec 0×09D8 0×0206 Binary TWN3 Mifare 
USB (Kofax 
SafeCom)

Yes
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Vendor VID PID Protocol Comment HP

Elatec 0×09D8 0×0310 KBD TWN3 Mifare 
USB Keyboard 
emulating

Yes

Elatec 0×09D8 0×0406 Binary TWN4 Mifare 
USB (Kofax 
SafeCom)

Yes

Elatec 0×09D8 0×0410 KBD TWN4 Mifare 
USB

Yes

Fujifilm 0×076B 0×5128 KBD Fujifilm ICCR-B No

HID 0×076B 0×5427 Custom report HID OMNIKEY 
5427G2

No

HID 0×076B 0×5428 KBD HID OMNIKEY 
5427G2 
(keyboard)

No

HP 0×03F0 0×0045 MFP24 X3D03A HP USB 
Universal Card 
Reader

Yes

HP 0×0C27 0×3BFA KBD Y7C05A HIP2 
Keystroke 
Reader

Yes

Inepro 0×1DA6 0×0110 KBD Inepro SCR708.I 
RFID Reader
Inepro SPIDER 
RFID Reader

Yes

rf IDEAS 0×0C27 0×0104 Binary pcProx Card 
Reader (Kofax 
SafeCom)

Yes

rf IDEAS 0×0C27 0×3BFA KBD pcProx Card 
Reader

Yes

rf IDEAS 0×0C27 0×3BFA KBD RDR-30MR1CKU-
MXS
RDR-800R1AKU
RDR-80541AKU-
RSOP
RDR-805R1AKU
RDR-805R1AKU-
G3

No
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Printix Go HP Workpath supported printers and MFPs

What is the difference between Printix Go HP Workpath and Printix Go 
HP?
Printix Go HP Workpath started in 2022 needs to be installed on the printer from HP Command 
Center, followed by a subsequent configuration to make it work with your Printix Home. The 
configuration is done from Printix Administrator by performing an installation of Printix Go.
Printix Go HP started in 2020 uses HP's device layer in the Open Extensibility Platform (OXPd) and 
installation and configuration is handled solely within Printix Administrator.

Both HP platforms (Workpath and OXPd) are supported, but only one Printix Go must be installed 
on your HP printer. You can check the list of supported card readers and cards.

Requirements
• As a general rule, Printix Go supports HP printers and MFPs that run FutureSmart 5.4 firmware or 

higher.
• HP documentation on: HP Enterprise, HP Managed - Update the printer firmware.
• HP documentation on: HP FutureSmart - Latest Firmware Versions.

 HP FutureSmart version 5.7.1.1 is reported to cause errors on HP LaserJet Managed and 
HP PageWide Managed MFPs. For these MFPs, ensure that you do not install this firmware.

• To support HP Workpath, some MFPs require installation of additional 2GB DIMM memory. See 
the HP documentation on: HP Workpath compatible devices.

• If your model is not on the list, then visit HP Customer Support (support.hp.com), find your 
model, and expand the Firmware section. The Firmware is typically named: FutureSmart 
Bundle Version. If it is named differently, it is not running FutureSmart.

• Printer's date and time must match the local time.
• Printer administrator password must be set and cannot be blank.
• Printer's DNS server must be configured.
• Computer with Printix Client version 1.3.1190 or higher must be online on the printer's network 

during installation and use of Printix Go.
• In addition to the required Internet endpoints, these must also be unblocked to allow Printix Go 

to communication to Printix Cloud (how to test):
• https://device-api.printix.net
• https://on-device-api.printix.net
• https://on-device-printer-sign-in.printix.net
• https://on-device-printer-release-documents.printix.net
• https://on-device-capture.printix.net
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Next steps
Even if an HP printer supports both HP platforms (Workpath and OXPd), only one Printix Go must be 
installed. If required, do an uninstallation first.

1. Verify that your printer is supported and has the required amount of memory.
2. Enable the HP Workpath platform on the printer.
3. Install Printix Go HP Workpath from HP Command Center.
4. Install Printix Go.

This will configure Printix Go to work with your Printix Home.

DISCLAIMER
We make all attempts to keep the product compatibility information current. However, we make no 
warranties, express or implied, with respect to printer vendor's products or the interoperation with 
Printix Go.

 Printers are supported even if the actual model name (as shown in Printix Administrator and 
as product name on printer's configuration and web (EWS) pages), does not contain the terms
Enterprise and Managed. Example: HP LaserJet MFP M725 is the model name reported by the 
printer, but in the list below and on hp.com, you will see HP LaserJet Enterprise 700 MFP M725 and 
HP LaserJet Managed MFP M725. If in doubt, search on the number in the name (Example: M725).

• HP LaserJet printers
• HP LaserJet A4 MFPs
• HP PageWide A4 MFPs
• HP LaserJet A3 MFPs
• HP PageWide A3 MFPs
• Supported card readers

HP LaserJet printers
• HP Color LaserJet Enterprise 5700
• HP Color LaserJet Enterprise 6700
• HP Color LaserJet Enterprise 6701
• HP Color LaserJet Managed X55745
• HP Color LaserJet Managed X65445
• HP Color LaserJet Managed X65465

HP LaserJet A4 MFPs
• HP Color LaserJet Flow E57540
• HP Color LaserJet Flow E67560
• HP Color LaserJet Flow E67660
• HP Color LaserJet Flow MFP M577
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• HP Color LaserJet Flow MFP M578
• HP Color LaserJet Flow MFP M681
• HP Color LaserJet Flow MFP M682
• HP Color LaserJet Flow MFP M776
• HP Color LaserJet MFP 5800
• HP Color LaserJet MFP 6800
• HP Color LaserJet MFP 6801
• HP Color LaserJet MFP E57540
• HP Color LaserJet MFP E67550
• HP Color LaserJet MFP E67650
• HP Color LaserJet MFP E78223
• HP Color LaserJet MFP E78228
• HP Color LaserJet MFP M577
• HP Color LaserJet MFP M578
• HP Color LaserJet MFP X57945
• HP Color LaserJet MFP X58045
• HP Color LaserJet MFP X67755
• HP Color LaserJet MFP X67765
• HP LaserJet MFP E62665
• HP LaserJet MFP E72425
• HP LaserJet MFP E72430
• HP LaserJet MFP M528
• HP LaserJet MFP M631
• HP LaserJet MFP M632
• HP LaserJet MFP M633
• HP LaserJet MFP M634
• HP LaserJet MFP M635
• HP LaserJet MFP M636

HP PageWide A4 MFPs
• HP PageWide Color Flow E58650
• HP PageWide Color Flow MFP 586
• HP PageWide Color MFP 586
• HP PageWide Color MFP E58650

HP LaserJet A3 MFPs
• HP Color LaserJet Flow E77822
• HP Color LaserJet Flow E77825
• HP Color LaserJet Flow E77830
• HP Color LaserJet Flow E78323
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• HP Color LaserJet Flow E78325
• HP Color LaserJet Flow E78330
• HP Color LaserJet Flow E87640
• HP Color LaserJet Flow E87650
• HP Color LaserJet Flow E87660
• HP Color LaserJet Managed MFP E78625
• HP Color LaserJet Managed MFP E78630
• HP Color LaserJet Managed MFP E78635
• HP Color LaserJet Managed MFP E87740
• HP Color LaserJet Managed MFP E87750
• HP Color LaserJet Managed MFP E87760
• HP Color LaserJet Managed MFP E87770
• HP Color LaserJet MFP E77822
• HP Color LaserJet MFP E77825
• HP Color LaserJet MFP E77830
• HP Color LaserJet MFP E78323
• HP Color LaserJet MFP E78325
• HP Color LaserJet MFP E78330
• HP Color LaserJet MFP E87640
• HP Color LaserJet MFP E87650
• HP Color LaserJet MFP E87660
• HP Color LaserJet MFP M681
• HP Color LaserJet MFP M776
• HP LaserJet Flow MFP E52645
• HP LaserJet Flow MFP E62565
• HP LaserJet Flow MFP E62575
• HP LaserJet Flow MFP E62665
• HP LaserJet Flow MFP E62675
• HP LaserJet Flow MFP E72525
• HP LaserJet Flow MFP E72530
• HP LaserJet Flow MFP E72535
• HP LaserJet Flow MFP E82540
• HP LaserJet Flow MFP E82550
• HP LaserJet Flow MFP E82560
• HP LaserJet Flow MFP M528
• HP LaserJet Flow MFP M631
• HP LaserJet Flow MFP M632
• HP LaserJet Flow MFP M633
• HP LaserJet Flow MFP M634
• HP LaserJet Flow MFP M635
• HP LaserJet Flow MFP M636
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• HP LaserJet Managed MFP E73130
• HP LaserJet Managed MFP E73135
• HP LaserJet Managed MFP E73140
• HP LaserJet Managed MFP E82650
• HP LaserJet Managed MFP E82660
• HP LaserJet Managed MFP E82670
• HP LaserJet MFP E52645
• HP LaserJet MFP E62555
• HP LaserJet MFP E62565
• HP LaserJet MFP E62655
• HP LaserJet MFP E72525
• HP LaserJet MFP E72530
• HP LaserJet MFP E72535
• HP LaserJet MFP E82540
• HP LaserJet MFP E82550
• HP LaserJet MFP E82560
• HP PageWide Color MFP 774
• HP PageWide Color MFP 779
• HP PageWide Color MFP P77940
• HP PageWide Color MFP P77950
• HP PageWide Color MFP P77960

HP PageWide A3 MFPs
• HP PageWide Color Flow E77650
• HP PageWide Color Flow E77660
• HP PageWide Color Flow MFP 785
• HP PageWide Color MFP 780
• HP PageWide Color MFP E77650
• HP PageWide Color MFP E77660

Supported card readers
Card readers with the below vendor ID (VID) and product ID (PID) are supported.

Vendor VID PID Protocol Comment HP Workpath

Baltech 0×13AD 0×9CAA KBD Kofax Equitrac 
(see part 
numbers)

No

Baltech 0×13AD 0×9CA5 Binary Kofax Equitrac 
(see part 
numbers)

Yes

Brother - - - Brother internal 
card reader

No
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Vendor VID PID Protocol Comment HP Workpath

Elatec 0×09D8 0×0206 Binary TWN3 Mifare 
USB (Kofax 
SafeCom)

Yes

Elatec 0×09D8 0×0310 KBD TWN3 Mifare 
USB Keyboard 
emulating

Yes

Elatec 0×09D8 0×0406 Binary TWN4 Mifare 
USB (Kofax 
SafeCom)

Yes

Elatec 0×09D8 0×0410 KBD TWN4 Mifare 
USB

Yes

Fujifilm 0×076B 0×5128 KBD Fujifilm ICCR-B No

HID 0×076B 0×5427 Custom report HID OMNIKEY 
5427G2

No

HID 0×076B 0×5428 KBD HID OMNIKEY 
5427G2 
(keyboard)

No

HP 0×03F0 0×0045 MFP24 X3D03A HP USB 
Universal Card 
Reader

Yes

HP 0×0C27 0×3BFA KBD Y7C05A HIP2 
Keystroke 
Reader

Yes

Inepro 0×1DA6 0×0110 KBD Inepro SCR708.I 
RFID Reader
Inepro SPIDER 
RFID Reader

No

rf IDEAS 0×0C27 0×0104 Binary pcProx Card 
Reader (Kofax 
SafeCom)

No

rf IDEAS 0×0C27 0×3BFA KBD pcProx Card 
Reader

Yes

rf IDEAS 0×0C27 0×3BFA KBD RDR-30MR1CKU-
MXS
RDR-800R1AKU
RDR-80541AKU-
RSOP
RDR-805R1AKU
RDR-805R1AKU-
G3

No
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Printix Go Konica Minolta supported printers and MFPs

Requirements
• As a general rule, Printix Go supports Konica Minolta printers and MFPs that support Konica 

Minolta OpenAPI 5.1 or later and are either generation 5 or generation 6 models.
• Konica Minolta printers and MFPs are also supported when sold under the Develop and Olivetti 

brands in Europe.
• It is highly recommended to use one of the tested printer firmware versions that are listed below. 

If you run into issues, try updating the printer's firmware to the latest version.
• Printix Go Konica Minolta can be used in Europe and Americas only. Contact Product Support

if you need it in other regions and tell us the country name (new solution key required from 
Konica Minolta).

• Use SSL/TLS is enabled.
• Web browser is enabled and cookies are enabled for the web browser.
• OpenAPI is installed and configured for SSL on TCP port 50003.
• No other authentication app is configured.

• If another authentication app is installed, Printix Go will attempt to uninstall it during 
installation. If an authentication app is installed, the "Verify sign in profile" results written in the
History tab will include an entry such as this: Existing authentication app found.

• Printer's date and time must match the local time.
• Printer's certificate must not be expired.
• Printer administrator password must be set and cannot be blank.
• Printer's DNS server must be configured.
• Computer with Printix Client must be online on the printer's network during installation and use 

of Printix Go.
• Printix Capture:

• Computer with Printix Client version 1.3.1253.0 or higher for Windows must be online on the 
printer's network during the use of Printix Capture.

• Computer must have a fully qualified domain name (FQDN).
If the computer is running on a VM, see the Microsoft documentation: Create a fully qualified 
domain name for a VM in the Azure portal.

• It must be possible to ping computers by hostname. This is a requirement because the printer/
computer scan connection uses secure HTTPS communication, and to avoid having to renew 
certificates whenever the computer changes IP address, it must be possible to reference the 
computer by hostname.

• In addition to the required Internet endpoints these must also be unblocked to allow Printix Go 
to communication to Printix Cloud (how to test):
• https://device-api.printix.net
• https://on-device-api.printix.net
• https://on-device-printer-sign-in.printix.net
• https://on-device-printer-release-documents.printix.net
• https://on-device-capture.printix.net
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 Printix Go installation (including update and uninstall) and use of printer's touchscreen control 
panel (including sign in and print) is likely to fail and result in error messages if an administrator is 
signed in to the printer's web pages at the same time.

Next steps
1. Verify that your printer is supported.
2. Prepare Konica Minolta printer for Printix Go.
3. Install Printix Go.

DISCLAIMER
We make all attempts to keep the product compatibility information current. However, we make no 
warranties, express or implied, with respect to printer vendor's products or the interoperation with 
Printix Go.

 Printers are supported even if the actual model name as shown in Printix Administrator and as 
product name on printer's configuration and web (EWS) pages, does not contain the term bizhub. 
Example: KONICA MINOLTA C368 Series is the model name reported by the printer, but in the list 
below you will see bizhub C368. If in doubt, search on the number in the name (Example: C368).

• Color MFPs
• Monochorme MFPs
• Color printers
• Supported card readers

Color MFPs
Color MFPs ROM version Function version

bizhub C287 / C227 GCC-Y0 4.2

bizhub C368 / C308 / C258 GCC-X4 4.2

bizhub C658 / C558 / C458 GCC-Y1 4.2

bizhub C659 / C759 GCC-Y1 4.2

bizhub C3351 / C3851 GCC-X4 4.2

bizhub C3851FS GCC-X4 4.2

bizhub C360i / C300i / C250i G00-M2 4.2

bizhub C450i G00-M2 2.2

bizhub C650i / C550i G00-M2 2.2

bizhub C750i G00-M2 2.2

bizhub C3350i / C3320i G00-M2 2.2

bizhub C4050i G00-M2 2.2
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Color MFPs ROM version Function version

bizhub C4000i / C3000i G00-M2 2.2

Monochorme MFPs
Monochrome MFPs ROM version Function version

bizhub 367 / 287 / 227 GCC-Y0 4.2

bizhub 308 / 368 GCC-X4 4.2

bizhub 308e / 368e GCF-Y1 4.2

bizhub 458 / 558 GCC-X4 4.2

bizhub 458e / 558e / 658e GCC-Y1 4.2

bizhub 808 / 908 GCC-Y1 4.2

bizhub 4752 / 4052 GCC-X4 4.2

bizhub 360i / 300i G00-M2 2.2

bizhub 450i G00-M2 2.2

bizhub 650i / 550i G00-M2 2.2

bizhub 750i G00-M2 2.2

bizhub 4050i G00-M2 2.2

bizhub 4700i / 4750i G00-M2 2.2

Color printers
Color printers ROM version Function version

bizhub C3300i G00-M2 2.2

bizhub C4000i G00-M2 2.2

Supported card readers
Card readers with the below vendor ID (VID) and product ID (PID) are supported.

Vendor VID PID Protocol Comment Konica Minolta3

Baltech 0×13AD 0×9CAA KBD Kofax Equitrac 
(see part 
numbers)

Yes

Baltech 0×13AD 0×9CA5 Binary Kofax Equitrac 
(see part 
numbers)

No

Brother - - - Brother internal 
card reader

No

3 Printers may require the installation of a card reader driver.
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Vendor VID PID Protocol Comment Konica Minolta3

Elatec 0×09D8 0×0206 Binary TWN3 Mifare 
USB (Kofax 
SafeCom)

No

Elatec 0×09D8 0×0310 KBD TWN3 Mifare 
USB Keyboard 
emulating

No

Elatec 0×09D8 0×0406 Binary TWN4 Mifare 
USB (Kofax 
SafeCom)

No

Elatec 0×09D8 0×0410 KBD TWN4 Mifare 
USB

No

Fujifilm 0×076B 0×5128 KBD Fujifilm ICCR-B No

HID 0×076B 0×5427 Custom report HID OMNIKEY 
5427G2

Yes

HID 0×076B 0×5428 KBD HID OMNIKEY 
5427G2 
(keyboard)

Yes

HP 0×03F0 0×0045 MFP24 X3D03A HP USB 
Universal Card 
Reader

No

HP 0×0C27 0×3BFA KBD Y7C05A HIP2 
Keystroke 
Reader

No

Inepro 0×1DA6 0×0110 KBD Inepro SCR708.I 
RFID Reader
Inepro SPIDER 
RFID Reader

No

rf IDEAS 0×0C27 0×0104 Binary pcProx Card 
Reader (Kofax 
SafeCom)

No

rf IDEAS 0×0C27 0×3BFA KBD pcProx Card 
Reader

No

rf IDEAS 0×0C27 0×3BFA KBD RDR-30MR1CKU-
MXS
RDR-800R1AKU
RDR-80541AKU-
RSOP
RDR-805R1AKU
RDR-805R1AKU-
G3

No

3 Printers may require the installation of a card reader driver.
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Printix Go Kyocera supported MFPs

Requirements
• As a general rule, Printix Go supports Kyocera printers and MFPs that are compatible with 

Kyocera's software development platform HyPAS (Hybrid Platform for Advanced Solutions) 
generation 2 or higher and the WebKit browser.
• Kyocera printers and MFPs are also supported when sold under the UTAX and Triumph-Adler 

brands.
• KYOCERA Net Viewer version 6.3 or higher MUST be used to install Printix Go.
• Card Authentication Kit must be installed on Kyocera MFPs to support card readers.
• Printer's date and time must match the local time.
• Printer administrator password must be set and cannot be blank.
• Printer's DNS server must be configured.
• Computer with Printix Client version 1.3.1190 or higher must be online on the printer's network 

during installation and use of Printix Go.
• In addition to the required Internet endpoints, these must also be unblocked to allow Printix Go 

to communicate with the Printix Cloud (how to test):
• https://device-api.printix.net
• https://on-device-api.printix.net
• https://on-device-printer-sign-in.printix.net
• https://on-device-printer-release-documents.printix.net
• https://on-device-capture.printix.net

Next steps
1. Verify that your printer is supported.
2. Prepare Kyocera printer for Printix Go.

This involves using KYOCERA Net Viewer to install Printix Go.
3. Install Printix Go.

This configures Printix Go to work with your Printix Home.

DISCLAIMER
We make all attempts to keep the product compatibility information current. However, we make no 
warranties, express or implied, with respect to printer vendor's products or the interoperation with 
Printix Go.


• Kyocera printers and MFPs have different models when sold under the UTAX and Triumph-Adler 

brands.

• Supported printers and MFPs
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• Supported card readers

Supported printers and MFPs

Kyocera Triumph-Adler UTAX Minimum required 
firmware

ECOSYS MA3500cifx P-C3567i MFP P-C3567i MFP -

ECOSYS MA3500cix P-C3563i MFP P-C3563i MFP -

ECOSYS MA4000cifx P-C4067i MFP P-C4067i MFP -

ECOSYS MA4000cix P-C4063i MFP P-C4063i MFP -

ECOSYS MA4500ix P-4532i MFP P-4532i MFP -

ECOSYS MA4500ifx P-4539i MFP P-4539i MFP -

ECOSYS MA5500ifx P-5539i MFP P-5539i MFP -

ECOSYS MA6000ifx P-6039i MFP P-6039i MFP -

TASKalfa 2553ci 2507ci 2507ci -

TASKalfa 2554ci 2508ci 2508ci -

TASKalfa 308ci 302ci 302ci 3.5.0040

TASKalfa 3253ci 3207ci 3207ci -

TASKalfa 3553ci N/A N/A -

TASKalfa 3554ci 3508ci 3508ci -

TASKalfa 358ci 352ci 352ci -

TASKalfa 4003i N/A N/A -

TASKalfa 4004i N/A N/A -

TASKalfa 4054ci 4008ci 4008ci -

TASKalfa 408ci 402ci 402ci 2.4.0020

TASKalfa 5003i 5057i 5057i -

TASKalfa 5004i 5058i 5058i -

TASKalfa 5054ci 5008ci 5008ci -

TASKalfa 508ci 502ci 502ci -

TASKalfa 6003i 6057i 6057i -

TASKalfa 6004i 6058i 6058i -

TASKalfa 6054ci 6008ci 6008ci -

TASKalfa 7003i 7057i 7057i -

TASKalfa 7004i 7058i 7058i -

TASKalfa 7054ci 7008ci 7008ci -

TASKalfa 7353ci 7307ci 7307ci 2.3.0080

TASKalfa 8003i 8057i 8057i -
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Kyocera Triumph-Adler UTAX Minimum required 
firmware

TASKalfa 8353ci 8307ci 8307ci 2.3.0080

TASKalfa 9003i N/A N/A -

TASKalfa MA3500ci 358ci 358ci -

TASKalfa MA4500ci 458ci 458ci -

TASKalfa MZ3200i 3263i 3263i -

TASKalfa MZ4000i 4063i 4063i -

TASKalfa PA4500ci P458ci P458ci -

Supported card readers
Card readers with the below vendor ID (VID) and product ID (PID) are supported.

Vendor VID PID Protocol Comment Kyocera

Baltech 0×13AD 0×9CAA KBD Kofax Equitrac 
(see part 
numbers)

No

Baltech 0×13AD 0×9CA5 Binary Kofax Equitrac 
(see part 
numbers)

No

Brother - - - Brother internal 
card reader

No

Elatec 0×09D8 0×0206 Binary TWN3 Mifare 
USB (Kofax 
SafeCom)

No

Elatec 0×09D8 0×0310 KBD TWN3 Mifare 
USB Keyboard 
emulating

Yes

Elatec 0×09D8 0×0406 Binary TWN4 Mifare 
USB (Kofax 
SafeCom)

No

Elatec 0×09D8 0×0410 KBD TWN4 Mifare 
USB

Yes

Fujifilm 0×076B 0×5128 KBD Fujifilm ICCR-B No

HID 0×076B 0×5427 Custom report HID OMNIKEY 
5427G2

No

HID 0×076B 0×5428 KBD HID OMNIKEY 
5427G2 
(keyboard)

No

HP 0×03F0 0×0045 MFP24 X3D03A HP USB 
Universal Card 
Reader

No
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Vendor VID PID Protocol Comment Kyocera

HP 0×0C27 0×3BFA KBD Y7C05A HIP2 
Keystroke 
Reader

Yes

Inepro 0×1DA6 0×0110 KBD Inepro SCR708.I 
RFID Reader
Inepro SPIDER 
RFID Reader

No

rf IDEAS 0×0C27 0×0104 Binary pcProx Card 
Reader (Kofax 
SafeCom)

No

rf IDEAS 0×0C27 0×3BFA KBD pcProx Card 
Reader

Yes

rf IDEAS 0×0C27 0×3BFA KBD RDR-30MR1CKU-
MXS
RDR-800R1AKU
RDR-80541AKU-
RSOP
RDR-805R1AKU
RDR-805R1AKU-
G3

No

Printix Go Lexmark supported printers and MFPs

Requirements
• As a general rule, Printix Go supports Lexmark printers and MFPs that are compatible with 

Lexmark Embedded Solutions Framework (eSF) version 6.x.
• Latest Lexmark printer firmware version.

• See also: Lexmark documentation on: How to Check, Download, and Update with the Latest 
Lexmark Printer Firmware

• Printer's date and time must match the local time.
• Printer administrator password must be set and cannot be blank.
• Printer's DNS server must be configured.
• Computer with Printix Client must be online on the printer's network during installation and use 

of Printix Go.
• In addition to the required Internet endpoints, these must also be unblocked to allow Printix Go 

to communication to Printix Cloud (how to test):
• https://device-api.printix.net
• https://on-device-api.printix.net
• https://on-device-printer-sign-in.printix.net
• https://on-device-printer-release-documents.printix.net
• https://on-device-capture.printix.net
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Next steps
1. Verify that your printer is supported.
2. Prepare Lexmark printer for Printix Go.
3. Install Printix Go.

DISCLAIMER
We make all attempts to keep the product compatibility information current. However, we make no 
warranties, express or implied, with respect to printer vendor's products or the interoperation with 
Printix Go.

 Printers are supported even if the actual model name as shown in Printix Administrator and 
as product name on printer's configuration and web (EWS) pages differ from below. Example: 
Lexmark CX622ade is the model name reported by the printer, but in the list below, you will see 
CX622. If in doubt, search for the number in the name (CX622).

• MFPs
• Printers
• Supported card readers

MFPs
• CX522
• CX532
• CX622, CX625
• CX635
• CX725
• CX730, CX735
• CX820, CX825
• CX860
• CX920, CX921, CX922, CX923, CX924, CX927
• CX930, CX931, CX942, CX943, CX944

• MX432
• MX522
• MX532
• MX622
• MX632
• MX721, MX722
• MX822, MX826
• MX931

• XC2235
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• XC4140, XC4143
• XC4150, XC4153
• XC4240
• XC4342, XC4352
• XC6152
• XC8155
• XC8160
• XC9225, XC9235, XC9245, XC9255, XC9265
• XC9325, XC9335, XC9445, XC9455, XC9465

• XM1246
• XM3142
• XM3250
• XM5365, XM5370
• XM7355, XM7370

Printers
• C2240
• C4150
• C4342, C4352
• C6160

• CS622
• CS632
• CS720, CS725, CS727, CS728
• CS730, CS735, CS737
• CS820, CS827
• CS921, CS923, CS927
• CS943

• M3250
• M5255, M5270

• MS622
• MS632
• MS822, MS826

Supported card readers
Card readers with the below vendor ID (VID) and product ID (PID) are supported.
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Vendor VID PID Protocol Comment Lexmark4

Baltech 0×13AD 0×9CAA KBD Kofax Equitrac 
(see part 
numbers)

Yes

Baltech 0×13AD 0×9CA5 Binary Kofax Equitrac 
(see part 
numbers)

No

Brother - - - Brother internal 
card reader

No

Elatec 0×09D8 0×0206 Binary TWN3 Mifare 
USB (Kofax 
SafeCom)

Yes

Elatec 0×09D8 0×0310 KBD TWN3 Mifare 
USB Keyboard 
emulating

Yes

Elatec 0×09D8 0×0406 Binary TWN4 Mifare 
USB (Kofax 
SafeCom)

Yes

Elatec 0×09D8 0×0410 KBD TWN4 Mifare 
USB

Yes

Fujifilm 0×076B 0×5128 KBD Fujifilm ICCR-B No

HID 0×076B 0×5427 Custom report HID OMNIKEY 
5427G2

No

HID 0×076B 0×5428 KBD HID OMNIKEY 
5427G2 
(keyboard)

No

HP 0×03F0 0×0045 MFP24 X3D03A HP USB 
Universal Card 
Reader

No

HP 0×0C27 0×3BFA KBD Y7C05A HIP2 
Keystroke 
Reader

Yes

Inepro 0×1DA6 0×0110 KBD Inepro SCR708.I 
RFID Reader
Inepro SPIDER 
RFID Reader

Yes

rf IDEAS 0×0C27 0×0104 Binary pcProx Card 
Reader (Kofax 
SafeCom)

Yes

rf IDEAS 0×0C27 0×3BFA KBD pcProx Card 
Reader

Yes5

4 Printix may have issues registering card readers if "Keyboard Emulation Reader Driver" is 
installed on the printer. Seen with Elatec (VID 0×09D8, PID 0×0410).

5 Not all Lexmark printers support this card reader.
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Vendor VID PID Protocol Comment Lexmark4

rf IDEAS 0×0C27 0×3BFA KBD RDR-30MR1CKU-
MXS
RDR-800R1AKU
RDR-80541AKU-
RSOP
RDR-805R1AKU
RDR-805R1AKU-
G3

No

How to identify the eSF version
If the eSF version is 6 or higher:

1. Open the printer's web page and sign in as administrator.
2. Select Apps.
3. Select App Framework Configuration.
4. Look for Embedded Solutions and identify the Version.

How to identify an older eSF version
If the eSF version is earlier (not supported by Printix Go):

1. Open the printer's web page and sign in as administrator.
2. Select Reports.
3. Select Device Settings (Menu Settings).
4. Scroll down and look for Embedded Solutions and identify the Framework version.

Printix Go Ricoh supported printers and MFPs
• Installation on one printer at a time from the "Printer properties" page is supported. Installation 

on multiple printers from the Printix Go tab on the Settings page is not supported.
• If you intend to install on a Gestetner, Infotec, Lanier, NRG, or Savin branded printer, you should 

do a Contact printer from the Printer properties page prior to installation. Failing to do so on 
printers registered with Printix before October 2021 may result in "Verify sign in profile" failing 
even though the user name and password are correct.

Requirements
• As a general rule, Printix Go supports Ricoh printers and MFPs that support Ricoh SOP (Smart 

Operating Platform) Generation 2 or higher. Ricoh printers and MFPs are also supported when 
sold under the Gestetner, Infotec, Lanier, NRG, and Savin brands.
• It is highly recommended to use the latest firmware version.

• On newer models, we recommend that you enable Ricoh Always Current Technology (ACT).
• Printer's date and time must match the local time.
• Printer administrator password must be set and cannot be blank.

4 Printix may have issues registering card readers if "Keyboard Emulation Reader Driver" is 
installed on the printer. Seen with Elatec (VID 0×09D8, PID 0×0410).
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• Printer's DNS server must be configured.
• SSL/TLS must be enabled for IPv4 on the printer and communication must be set to Ciphertext/

Cleartext.
• HTTP for Port 80 for IPv4 must be open.
• For Ricoh SOP printers Generation 2, web server password must be the default password.
• Computer with Printix Client for Windows must be online on the printer's network during 

installation, update, and uninstallation of Printix Go.
• Computer with Printix Client must be online on the printer's network during the use of Printix Go.
• Printix Capture:

• Computer with Printix Client version 1.3.1253.0 or higher for Windows must be online on the 
printer's network during the use of Printix Capture.

 Printix Client for Mac does not support installation, update, and uninstallation of Printix Go 
Ricoh, and therefore, a computer with Printix Client for Windows must be online on the printer's 
network during installation, update, or uninstallation of Printix Go Ricoh.

• In addition to the required Internet endpoints, these must also be unblocked to allow Printix Go 
to communicate to Printix Cloud (how to test):
• https://device-api.printix.net
• https://on-device-api.printix.net
• https://on-device-printer-sign-in.printix.net
• https://on-device-printer-release-documents.printix.net
• https://on-device-capture.printix.net

Third-party application dependencies
• Adaptable Authentication API (AAA) 2.1.0 Ricoh SmartSDK
• RXOP 3.8.8

• RXSP servlet 3.8.8 or 1.3 depending on printer configuration

Next steps
1. Verify that your printer is supported.
2. Install Printix Go.

See also: How to install Printix Go on a Ricoh printer without using the Printix Client
3. Change the inactivity timeout of your printer to avoid errors.

DISCLAIMER
We make all attempts to keep the product compatibility information current. However, we make no 
warranties, express or implied, with respect to printer vendor's products or the interoperation with 
Printix Go.
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• The MFPs and printers marked with a star do not support installation without the Printix Client.

• MFPs
• Printers
• Supported card readers

MFPs
• Ricoh IM 2500
• Ricoh IM 3000
• Ricoh IM 350 *
• Ricoh IM 370
• Ricoh IM 370F
• Ricoh IM 3500
• Ricoh IM 4000
• Ricoh IM 430 *
• Ricoh IM 460F
• Ricoh IM 5000
• Ricoh IM 550
• Ricoh IM 600
• Ricoh IM 6000
• Ricoh IM 7000
• Ricoh IM 8000
• Ricoh IM 9000

• Ricoh IM C2000
• Ricoh IM C2010
• Ricoh IM C2500
• Ricoh IM C2510
• Ricoh IM C300
• Ricoh IM C3000
• Ricoh IM C3010
• Ricoh IM C3500
• Ricoh IM C3510
• Ricoh IM C400
• Ricoh IM C4500
• Ricoh IM C4510
• Ricoh IM C530F *
• Ricoh IM C530FB *
• Ricoh IM C5500
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• Ricoh IM C5510
• Ricoh IM C6000
• Ricoh IM C6010
• Ricoh IM C6500
• Ricoh IM C8000
• Ricoh IM CW2200 *

• Ricoh MP 2555 *
• Ricoh MP 305+ *
• Ricoh MP 3055 *
• Ricoh MP 3555 *
• Ricoh MP 402 *
• Ricoh MP 4055 *
• Ricoh MP 501 *
• Ricoh MP 5055 *
• Ricoh MP 601 *
• Ricoh MP 6055 *
• Ricoh MP 6503 *
• Ricoh MP 7503 *
• Ricoh MP 9003 *

• Ricoh MP C2004 *
• Ricoh MP C2504 *
• Ricoh MP C3004 *
• Ricoh MP C306 *
• Ricoh MP C307 *
• Ricoh MP C3504 *
• Ricoh MP C406Z *
• Ricoh MP C407 *
• Ricoh MP C4504 *
• Ricoh MP C501 *
• Ricoh MP C5504 *
• Ricoh MP C6004 *
• Ricoh MP C6503 *
• Ricoh MP C8003 *

• Ricoh Pro C5200 *
• Ricoh Pro C5210 *
• Ricoh Pro C5300S *
• Ricoh Pro C5310S *
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Printers
• Ricoh SP 8400DN *

• Ricoh SP C840DN *
• Ricoh SP C842DN *

Supported card readers
Card readers with the below vendor ID (VID) and product ID (PID) are supported.

Vendor VID PID Protocol Comment Ricoh

Baltech 0×13AD 0×9CAA KBD Kofax Equitrac 
(see part 
numbers)

No

Baltech 0×13AD 0×9CA5 Binary Kofax Equitrac 
(see part 
numbers)

Yes

Brother - - - Brother internal 
card reader

No

Elatec 0×09D8 0×0206 Binary TWN3 Mifare 
USB (Kofax 
SafeCom)

No

Elatec 0×09D8 0×0310 KBD TWN3 Mifare 
USB Keyboard 
emulating

Yes

Elatec 0×09D8 0×0406 Binary TWN4 Mifare 
USB (Kofax 
SafeCom)

No

Elatec 0×09D8 0×0410 KBD TWN4 Mifare 
USB

Yes

Fujifilm 0×076B 0×5128 KBD Fujifilm ICCR-B No

HID 0×076B 0×5427 Custom report HID OMNIKEY 
5427G2

No

HID 0×076B 0×5428 KBD HID OMNIKEY 
5427G2 
(keyboard)

No

HP 0×03F0 0×0045 MFP24 X3D03A HP USB 
Universal Card 
Reader

No

HP 0×0C27 0×3BFA KBD Y7C05A HIP2 
Keystroke 
Reader

Yes
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Vendor VID PID Protocol Comment Ricoh

Inepro 0×1DA6 0×0110 KBD Inepro SCR708.I 
RFID Reader
Inepro SPIDER 
RFID Reader

Yes

rf IDEAS 0×0C27 0×0104 Binary pcProx Card 
Reader (Kofax 
SafeCom)

No

rf IDEAS 0×0C27 0×3BFA KBD pcProx Card 
Reader

Yes

rf IDEAS 0×0C27 0×3BFA KBD RDR-30MR1CKU-
MXS
RDR-800R1AKU
RDR-80541AKU-
RSOP
RDR-805R1AKU
RDR-805R1AKU-
G3

Yes

Printix Go Xerox supported printers and MFPs

Requirements
• As a general rule, Printix Go supports Xerox printers and MFPs that support Xerox EIP (Extensible 

Interface Platform) version 3.7 or higher.
• We highly recommend to use the latest firmware version.

• Printer's date and time must match the local time.
• Printer administrator password must be set and cannot be blank.
• Printer's DNS server must be configured.
• Computer with Printix Client must be online on the printer's network during installation and use 

of Printix Go.
• The Sign in profile must reference an SNMPv1 configuration where the Set Community Name

specified in the selected SNMPv1 configuration MUST match the Community Name Read/Write
configured as part of SNMPv1/v2 on the printer.

• TLS 1.2 must be enabled and TLS 1.3 must be disabled on Xerox MFPs.
• In addition to the required Internet endpoints, these must also be unblocked to allow Printix Go 

to communication to Printix Cloud (how to test):
• https://device-api.printix.net
• https://on-device-api.printix.net
• https://on-device-printer-sign-in.printix.net
• https://on-device-printer-release-documents.printix.net
• https://on-device-capture.printix.net
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Next steps
1. Verify that your printer is supported.
2. If you use a Xerox AltaLink printer, prepare the Xerox printer for Printix Go.
3. Install Printix Go.

DISCLAIMER
We make all attempts to keep the product compatibility information current. However, we make no 
warranties, express or implied, with respect to printer vendor's products or the interoperation with 
Printix Go.
• MFPs
• Printers
• Supported card readers

MFPs
• Xerox AltaLink B8045 / B8055 / B8065 / B8075 / B8090
• Xerox AltaLink B8145 / B8155 / B8170

• Xerox AltaLink C8030 / C8035 / C8045 / C8055 / C8070
• Xerox AltaLink C8130 / C8135 / C8145 / C8155 / C8170

• Xerox VersaLink B405
• Xerox VersaLink B415
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• Xerox VersaLink B605
• Xerox VersaLink B615
• Xerox VersaLink B625

• Xerox VersaLink B7030 / B7035
• Xerox VersaLink B7125 / B7130 / B7135

• Xerox VersaLink C415
• Xerox VersaLink C505
• Xerox VersaLink C605
• Xerox VersaLink C625

• Xerox VersaLink C7000 / C7020 / C7025 / C7030
• Xerox VersaLink C7120 / C7125 / C7130

Printers
• Xerox B410*
• Xerox C410*

• Xerox VersaLink B400
• Xerox VersaLink B600
• Xerox VersaLink B620

• Xerox VersaLink C400
• Xerox VersaLink C500
• Xerox VersaLink C600
• Xerox VersaLink C620

• Xerox VersaLink C8000
• Xerox VersaLink C9000

 The Xerox B410 and C410 models use Printix Go Lexmark. To configure these printers, refer to 
online documentation about Lexmark Go.

Supported card readers
Card readers with the below vendor ID (VID) and product ID (PID) are supported.

Vendor VID PID Protocol Comment Xerox6

Baltech 0×13AD 0×9CAA KBD Kofax Equitrac 
(see part 
numbers)

No

6 Xerox VersaLink requires the installation of a Xerox USB Card Reader.
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Vendor VID PID Protocol Comment Xerox6

Baltech 0×13AD 0×9CA5 Binary Kofax Equitrac 
(see part 
numbers)

On request7

Brother - - - Brother internal 
card reader

No

Elatec 0×09D8 0×0206 Binary TWN3 Mifare 
USB (Kofax 
SafeCom)

No

Elatec 0×09D8 0×0310 KBD TWN3 Mifare 
USB Keyboard 
emulating

Yes

Elatec 0×09D8 0×0406 Binary TWN4 Mifare 
USB (Kofax 
SafeCom)

No

Elatec 0×09D8 0×0410 KBD TWN4 Mifare 
USB

Yes

Fujifilm 0×076B 0×5128 KBD Fujifilm ICCR-B No

HID 0×076B 0×5427 Custom report HID OMNIKEY 
5427G2

Yes

HID 0×076B 0×5428 KBD HID OMNIKEY 
5427G2 
(keyboard)

No8

HP 0×03F0 0×0045 MFP24 X3D03A HP USB 
Universal Card 
Reader

No

HP 0×0C27 0×3BFA KBD Y7C05A HIP2 
Keystroke 
Reader

Yes

Inepro 0×1DA6 0×0110 KBD Inepro SCR708.I 
RFID Reader
Inepro SPIDER 
RFID Reader

Yes

rf IDEAS 0×0C27 0×0104 Binary pcProx Card 
Reader (Kofax 
SafeCom)

No

rf IDEAS 0×0C27 0×3BFA KBD pcProx Card 
Reader

Yes

6 Xerox VersaLink requires the installation of a Xerox USB Card Reader.
7 Requires a Printix Go Xerox future version where development task (TFS 142150/PP-7537) is 

resolved. Speak to your sales representative.
8 Has been reported as not working on Xerox VersaLink C7020 and C7025, but should work 

according to Xerox documentation (card reader.pdf version 4.3 from August 2021).
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Vendor VID PID Protocol Comment Xerox6

rf IDEAS 0×0C27 0×3BFA KBD RDR-30MR1CKU-
MXS
RDR-800R1AKU
RDR-80541AKU-
RSOP
RDR-805R1AKU
RDR-805R1AKU-
G3

No

Card readers and cards
Card readers are typically connected to the printer through USB. Selected printers (HP) may have a 
hardware integration pocket that makes it possible to mount a card reader inside the printer and be 
connected typically with a USB mini connector. Readers can be keyboard (KBD) emulating and non-
keyboard emulating.

Baltech card reader part numbers

 The part number is shown on the card reader label (see examples).

Part number Card reader description

Y591-E141-XXX USB Card Reader – MiFare

Y591-E125-XXX USB Card Reader – HID/Indala/EM Marin/Hitag

Y591-ELG2-XXX USB Card Reader – Legic

Y591-EMUL-XXX USB Card Reader – Multi-Card

Y591-ELGI-XXX USB Card Reader – Ext iClass and Legic

Y591-EMSI-XXX USB Card Reader – Multi-Card with iClass SEOS

Y591-MMUL-XXX USB Micro Multi-Card Reader

Y591-MLGI-XXX USB Micro iClass and Legic Card Reader

Y591-MMSI-XXX USB Micro iClass SEOS Reader

Y591-MLG2-XXX USB Micro Legic Card Reader

Y591-BMUL-XXX USB Card Reader – Multi-Card BC

Y591-BMSI-XXX USB Card Reader – Multi-Card with iClass SEOS BC

6 Xerox VersaLink requires the installation of a Xerox USB Card Reader.
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External Baltech card readers (Gen 2)

Internal Baltech card readers (Micro)

How to find the card reader’s vendor ID and product ID
1. On your Windows computer, open the Device Manager.
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2. Connect the card reader to the USB port.
3. Select Human Interface Devices.

Depending on the card reader, you may need to select Ports (COM & LPT) instead.
4. Double-click the device of interest to open Properties.

 Finding the card reader's VID/PID can be a bit tricky. Try to connect/disconnect it from the 
USB port and see which device disappears and reappears. Alternatively, check them all.

5. Select the Details tab.
6. In the Property list, select Device instance path.

The USB HID VID and PID are displayed.
Example: USB\VID_09D8&PID_0420

See also:
• How to find the card reader IDs on Lexmark printers

Types of card readers
• Proximity card readers
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Contactless card readers that uses Radio Frequency Identification (RFID) technology. Some 
readers support both low frequency (125kHz) and high frequency (13.56MHz) and multiple
protocols within those frequencies, including popular ones, such as: Mifare, HID Prox, EM, Hitag, 
iClass, Indala, Legic, and many more. The user presents the card (keyfob or tag) by holding it near 
the reader so it can scan it.

 Printix does NOT sell card readers and cards. See the documentation provided by the supplier 
of your card reader.

Troubleshooting card readers
• Card reader does not work with a printer
• Card reader does not work with a particular card
• Multiprotocol cards
• Present one card at a time
• Card needs to be registered again and again
• HP printer says: USB error
• Unsupported card reader does not display a message on an HP Workpath printer

Card reader does not work with a printer
First, verify that the connected card reader has been registered:

1. Open the Printer properties page and look for the Card reader section.
If you see no entry, try to power cycle the printer.

If the printer does not support keyboard emulation and the reader does, then it will not work, and 
vice versa. To establish if the reader supports keyboard emulation, connect the reader to the USB 
port of a Windows computer.

1. Open Notepad.
2. Present the card to the reader.

The card number is written if the reader is setup for keyboard emulation. Otherwise, it will not 
write anything.

Card reader does not work with a particular card
If the reader works with some cards but not with others, there could be a number of reasons:
• The card is defect. A proximity card contains an antenna and if the card appears worn and 

perhaps bent, the antenna may have been damaged.
• The protocol needed to read the card has been disabled.
• The card is using a protocol that is not supported.
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Multiprotocol cards
If you suspect a card is a multiprotocol card, it is always good to present the card in two different 
ways to the reader:
• Move the card slowly towards the reader.
• Drop the card quickly and directly onto the top of the reader.

If, for example, the card supports both HID iClass and HID Prox, dropping the card quickly will 
(depending on the reader) result in two beeps and both card numbers being read. Presenting the 
card slowly will return only the HID Prox card number (as it has a better reading range).

Present one card at a time
If you are storing multiple proximity cards in a wallet and is placing the wallet on top of the card 
reader, it will vary which card is read. The same applies if you have multiple key fobs chained 
together. You should present only one card (or key fob) at a time.

Card needs to be registered again and again
If your card number is randomized, you will be prompted to register the card over and over even 
when you are at the same printer. This can for example be the case for HID iCLASS Seos cards.

Unsupported card reader does not display a message on an HP 
Workpath printer
When an unsupported card reader is plugged on to an HP Workpath printer, and a card is swiped, 
no error or any other message is displayed on the device or in the logs.

Proximity protocols

High frequency (13.56 MHz)
• IS014443A

• Mifare Classic
• Mifare Mini
• Mifare DESFIRE EV1
• Mifare Plus S,X
• Mifare Pro X
• Mifare SmartMX
• Mifare Ultralight
• Mifare Ultralight C
• SLE44R35
• SLE66Rxx (my-d move)
• Legic Prime
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• Legic Advant
• Pay Pass

• IS014443B
• Calypso
• CEPAS
• Moneo
• Pico Pass
• SRI512, SRT512
• SRI4K, SRIX4K

• IS018092/ECMA-340
• Sony Felica
• NFC Forum Tag 2-4

• IS015693
• EM4×33
• EM4×35
• HID iClass
• ICODE SLI
• M24LR16/64
• MB89R118/119
• Pico Pass
• Tag-it
• SRF55Vxx (my-d vicinity)

Low frequency (125 KHz)
• AWID
• Casi Rusco
• Cotag
• EM4100, 4102, 4200
• EM4150
• EM4305
• FDX-B
• G-Prox
• HID Prox
• Hitag 1, 2, S
• Indala
• IoProx
• Keri
• Miro
• Nexwatch
• Paxton Net2
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• Pyramid
• Q5
• T5557
• T5567
• TITAN
• UNIQUE
• ZOODIAC

Why card numbers are not imported
Sometimes we get the question: Can card numbers be imported?

Reasons why Printix does not offer import of card numbers:
• Card reader compatibility

Card readers can return card numbers in different formats. This is likely to depend on the card 
reader type and also how the card reader is configured. The returned format is likely to not match 
a potentially imported card number. So, importing is not sufficient, because some sort of card 
number conversion algorithm would also be required. If different card readers return different 
formats, multiple algorithms would potentially be required.

• Use of other means of identification
Instead of being restricted to only use the imported number from the supplied card, the users 
can use other types of cards to register themselves at the printer. So if the user have forgotten 
their work/school supplied card, they can just use another proximity card. Users can typically use 
proximity enabled credit/debit cards, cards used for public travel, club membership cards, and 
more.

With self-service, users can register and manage multiple cards.

 For security reasons, the registered card numbers (and PIN codes) are protected through 
salted hashing. Printix does not store the card numbers directly. When a card number is read, it is 
compared with the saved salted hashing value to verify if the card is known and establish who the 
card belongs to, and hence sign in the user at the printer.

Make a link on your Intranet
If your Intranet already features one or more pages with instructions on printing in your company, 
we recommend you to update these pages and include a link to the Printix App Cards and codes
page.

The link to the Cards and codes page is the Printix Home of your company (acme) followed by this 
string:

?registrationCode=FORGOT_CODE

Example: https://acme.printix.net?registrationCode=FORGOT_CODE

That way, users can select the link, sign in to the Printix App, and type the 6-digit card registration 
code they wrote down when they presented their card at the printer.
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 The card registration code is valid for 1 hour.
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Install Printix Go

To install Printix Go, a Sign in profile and a Go configuration must be created and assigned. Also, it 
must be a Printix Go supported printer.

1. Open Printer properties and select the Printix Go  tab.
2. Select Sign in profile setup  to open the Sign in profile menu.
3. Select Create sign in profile. If you have an existing sign in profile that can be used, then 

select Assign sign in profile.
• In Name, type a descriptive name for the sign in profile.

• On Kyocera, you can enter any user name and password, because sign-in credentials are 
created with KYOCERA Net Viewer. However, assigning a profile is necessary to install 
Printix Go on the printer.

• In Username, type the user name of an administrator account that can access the printer's 
web pages. The user name cannot be blank.

• In Password, type the password of an administrator account that can access the printer's 
web pages. The password cannot be blank.

• In Description, type an optional description for the sign in profile.
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• In Add SNMP configuration, select an SNMPv1 configuration that matches what is 
configured on the printer.
• On Xerox, you MUST select an SNMP configuration, AND the Set Community Name

specified in the selected SNMPv1 configuration MUST match the Community Name 
Read/Write configured as part of SNMPv1/v2 on the printer.

• If you do not want to assign the created sign in profile now, clear Assign to printer.
4. Select Save.
5. Select Verify sign in profile.

The printer must be online.
• On Brother, ensure that nobody is using the printer during verification. Otherwise, the user's 

processes are cancelled.
6. Select Go configuration setup  to open the Go configuration menu.
7. Select Create Go configuration. If you have an existing Go configuration that can be used, 

then select Assign Go configuration.
• In Name, type a descriptive name for the Go configuration.
• In Description, type an optional description for the Go configuration.
• In Sign in method, optionally, change it from Select automatically to the method you want.
• In Access control, optionally, select the printer functions that will require sign-in.

• On Konica Minolta, all functions are considered locked as sign-in is required to use any 
function anyway.

• On Kyocera, users can sign in as guest to use functions not locked by Access control.
• On Ricoh, users can sign in as guest to use functions not locked by Access control.

• In Email sender, optionally, type a default sender email address and this will be used as the 
sender rather than the email address of the signed in user doing a scan to email.

• If you do not want to assign the created Go configuration now, clear Assign to printer.
8. Select Save.
9. Select Install to install Printix Go on the printer.

It can take up to a minute before the Printix Print icon appears on the touchscreen control 
panel of the printer.
• On Brother, ensure that nobody is using the printer during installation. Otherwise, the user's 

processes are cancelled.
• On Epson, the network interface restarts, leaving the printer disconnected from the network 

for about 1 minute.
• On Fujifilm, the printer restarts itself twice during installation.
• On HP, select Reset on the printer if the Printix Print icon does not appear.
• On HP Workpath, first, install Printix Go through the HP Command Center, then install 

Printix Go through the Printix Administrator to configure it to work with your Printix Home.
• On Kyocera, first, install Printix Go through the KYOCERA Net Viewer, then install Printix Go 

through the Printix Administrator to configure it to work with your Printix Home.
• On Lexmark, you need to manually restart the printer after installation. Otherwise, you 

cannot use the Printix application on the printer.
• On Ricoh, a computer with Printix Client for Windows must be online on the printer's 

network during the installation, update, or uninstallation of Printix Go Ricoh.
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• On Ricoh, the Status changes to Installing as the installation takes 10–25 minutes (printer 
restarts 2 times). If the installation fails, the status will change to Failed. Otherwise, it will 
change to Installed. See also: Printix Go troubleshooting - Ricoh.

• On Ricoh, the inactivity timeout must be changed after installation.
• On Xerox VersaLink, you need to manually restart the printer after installation. Otherwise, 

you will get the message Could not log in.
10. Optionally, refresh the page to verify that the Status changed from Unknown to Installing or

Installed.
It can take up to a minute for the update to finish, so only refresh the page after enough time 
passed.
If the status becomes Failed, check if updating to the latest printer firmware version solves the 
problem.

 Install only becomes available after the printer has been assigned a Go configuration
and a Sign in profile (verified as described in step 5).

See also:
• Printix Go troubleshooting

Sign in profile
Name
Descriptive name of the sign in profile.

Description
Optional description of the sign in profile.

Username
The user name of an administrator account that can access the printer's web pages. The user name 
cannot be blank.

Password
The password of an administrator account that can access the printer's web pages. The password 
cannot be blank.

SNMP configuration
On Brother, the v1/v2 and v3 protocols are supported. An SNMP configuration must be selected 
in the sign-in profile and the specified parameters must match the parameters of the printer. The 
parameters of the printer can be found on the Setup tab of the Printer properties page.
On Xerox, the Set Community Name specified in the selected SNMPv1 configuration MUST match 
that configured on the printer.

Printer administrator default user name and password
Table with default user name and password.
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Vendor User name Password Notes

Brother A password MUST be set. 
Contact your Brother 
technician to get the 
default password.

Epson - - No default, but a user 
name and password 
MUST be set.

Fujifilm x-admin 11111 A user name and 
password MUST be set.

HP - - No default, but a user 
name and password 
MUST be set.

HP Workpath - - No default, but a user 
name and password 
MUST be set.

Konica Minolta A user name and 
password MUST be set. 
Contact your Konica 
Minolta technician to get 
the default user name 
and password (model 
dependent).

Kyocera - - A user name and 
password MUST be set.

Lexmark - - No default, but a user 
name and password 
MUST be set.

Ricoh - - No default, but a user 
name and password 
MUST be set.

Xerox A user name and 
password MUST be 
set. Contact your Xerox 
technician to get the 
default user name and 
password.

 For Ricoh SOP printers Generation 2, web server password must be the default password.

Go configuration
• Name

Descriptive name of the configuration.

• Description
Optional description of the configuration.
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• Sign in method
How will users sign in at the printer.
• Select automatically

Maps to Card if a card reader is connected to the printer. Otherwise, it maps to ID code. 
Mapping changes within 10 seconds after the card reader is either connected or disconnected. 
If it does not change, a restart of the printer may be required.
See also: Printix Go Konica Minolta card reader limitations

• Card
• ID code
• Card or ID code

• Access control
What printer functions will require sign-in.
• Copy
• Email
• Scan

• On Ricoh, if Scan is locked but Email and/or Scan to USB Drive are unlocked, guests cannot 
use the Email and Scan to USB Drive functions. Conversely, if Scan is unlocked but Email and
Scan to USB Drive are locked, guests can use the Email and Scan to USB Drive functions.

• Fax
• Print from USB Drive

Users can print from a flash memory or mass storage device.
• Scan to USB Drive

Users can scan to a flash memory or mass storage device.
• Everything else

Select this if you want Printix Go to lock access to other functions (besides the above ones). 
Selecting this will also lock access to third-party applications. Submit a support request if you 
want Printix Go to control access to a particular application.
• On Konica Minolta, all functions are considered locked as sign-in is required to use any 

function anyway.
• On Kyocera, users can sign in as guest to use functions not locked by "Access control."
• On Ricoh, users can sign in as guest to use functions not locked by "Access control."

• Email sender
Leave this blank and when using a printer's Email function, the From field will be prefilled with 
the email address of the signed in user. However, this can cause some SMTP servers to reject the 
sending of the scanned documents. In this case, you can type a default sender email address in 
the Email sender field and this will be used as the sender rather than the email address of the 
signed in user.

Printer default sender email address
Table with the corresponding parameter names typically holds the value for the default sender 
email address.
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Vendor Email sender Notes

Brother - -

Epson Sender's Email Address -

Fujifilm E-mail Address -

HP Default From -

HP Workpath Default From -

Konica Minolta Device Mail Address Alternatively, Admin Email 
Address

Kyocera Sender's Email Address Alternatively, the address of a user 
specified on the printer's web page

Lexmark Reply address -

Ricoh Administrator Email Address -

Xerox Device Email -

How to install Printix Go on multiple printers
• How to install Printix Go on multiple printers from the Printers page
• How to assign a Go configuration to multiple printers
• How to assign a sign in profile to multiple printers

How to install Printix Go on multiple printers from the Printers page
1. Select Printers .
2. Select the eye icon in the table header and set the view mode to Printix Go.

3. Select the check box next to the printers you wish to install.
4. Select Actions above the table, then select Install.

• On Brother, ensure that nobody is using the printer during installation. Otherwise, the user's 
processes are cancelled.
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• On Ricoh, a computer with Printix Client for Windows must be online on the printer's 
network during the installation of Printix Go Ricoh.

• On Ricoh, the installation takes 10–25 minutes (printer restarts 2 times).
5. Select Install again.
6. After 30 seconds passed, refresh the page and verify that the installation succeeded.

• On HP Workpath, right after this step, also install Printix Go through the HP Command 
Center.

• On Kyocera, right after this step, also install Printix Go through the KYOCERA Net Viewer.

 If the printer does not behave as normal after the installation, restart the printer.

How to assign a Go configuration to multiple printers
1. Select  Menu > Settings .
2. Select the Printix Go  tab.
3. Select the name of a Go configuration (Example: Copy is unlocked) to open the Go 

configuration page.
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4. Select the gear icon  in the top left cell to open the Go configuration  menu.
5. Select Assign to printers.

The printers MUST have a sign in profile.
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6. Select Vendors, then select the printer vendor:
• Brother
• Epson
• Fujifilm
• HP
• HP Workpath
• Konica Minolta
• Kyocera
• Lexmark
• Ricoh
• Xerox

 For Ricoh printers, consider making separate configurations, so in the future, when you 
want to Update the Printix Go Ricoh software, this can be done in stages, yet efficiently. This 
is because the Ricoh printer will restart once, and this takes 5–10 minutes, and during this 
period, the printer is unavailable to users.

7. Optionally, select Networks and then select the networks that includes the printers you wish 
to install Printix Go on.

8. Optionally, clear Exclude printers with Printix Go installed.
• The printers matching the filtered criteria will appear in the Selected printers list on the left.
• Optionally, move printers to the Excluded printers list on the right.

9. If you want to not only assign the Printix Go configuration to the printers, but also install them, 
then select Install on printers.
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10. Select Assign.
• The assignment/installation is done in sequence. If it fails on one printer, it will just proceed 

to the next printer.
• The screen will automatically update as assignment/installations are completed.
• On Ricoh, a computer with Printix Client for Windows must be online on the printer's 

network during install of Printix Go Ricoh.

How to assign a sign in profile to multiple printers
1. Select  Menu > Settings .
2. Select the Printix Go  tab.
3. Select the name of a sign in profile (Example: Main office) to open the Sign in profile page.

4. Select Sign in profile setup  to open the Sign in profile  menu.
5. Select Assign to printers.
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6. Select Vendors, then select the printer vendor:
• Brother
• Epson
• Fujifilm
• HP
• HP Workpath
• Konica Minolta
• Kyocera
• Lexmark
• Ricoh
• Xerox

7. Optionally, select Networks, then select the networks that include the printers you wish to 
assign the sign in profile to.

8. Optionally, clear Exclude printers with sign in profile.
• The printers matching the filtered criteria will appear in the Selected printers list on the left.
• Optionally, move printers to the Excluded printers list on the right.

9. Select Assign.
• The assignment is done in sequence. If it fails on one printer, it will just proceed to the next 

printer.
10. Optionally, select Verify sign in profile.

• On Brother, ensure that nobody is using the printer during verification. Otherwise, the user's 
processes are cancelled.
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• The verification is done in sequence. If it fails on one printer, it will just proceed to the next 
printer.
• Sign in profile user name and password cannot be blank.

• The screen will automatically update as verifications are completed.

How to update Printix Go
The table below shows the effect of doing an Update for Printix Go.
• Update printers from view mode on the printers page

Printers with an outdated Go version are listed with their version number in orange.
• Update a single printer
• Update multiple printers

Vendor Go version Capture version Go 
configuration

Go software Side effect on 
printer

Brother 2.3.0.0 - Updates n.a. Brother 
printer's screen 
is updated 
within a few 
seconds.

Epson 2.3.0.0 - Updates n.a. Epson printer's 
screen is 
updated within 
a few seconds. 
Network 
interface 
restarts leaving 
it disconnected 
from the 
network for 
about 1 minute.

Fujifilm 2.3.0.3 - Updates n.a. Fujifilm 
printer's screen 
is updated 
within a few 
seconds.

HP 2.3.0.0 2.3.0.0 Updates n.a. HP printer's 
screen is 
updated within 
a few seconds.

HP Workpath 2.3.0.10 - Updates n.a. HP printer's 
screen is 
updated within 
a few seconds.
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Vendor Go version Capture version Go 
configuration

Go software Side effect on 
printer

Konica Minolta 2.3.0.0 2.3.0.0 Updates n.a. Konica Minolta 
printer's screen 
is updated 
within a few 
seconds.

Kyocera 2.3.0.5 2.3.0.5 Updates n.a. Kyocera 
printer's screen 
is updated 
within a few 
seconds.

Lexmark 2.3.0.4 - Updates Updates Lexmark 
printer's screen 
is updated 
within a few 
seconds.

Ricoh 2.1.3.21 2.1.3.19 Updates Updates Ricoh printer 
restarts twice 
(can take 10–25 
minutes).

Xerox 2.3.0.0 - Updates n.a. Xerox printer's 
screen is 
updated within 
a few seconds, 
but VersaLink 
printers needs 
to be manually 
restarted 
(can take 2–3 
minutes).

Update printers from view mode on the printers page
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 To update Kyocera printers, instead of following the steps below, you need to reinstall Printix 
Go Kyocera in both the Printix Administrator and the KYOCERA Net Viewer.

1. Open the Printers page and select  View mode.
2. Select Printix Go.
3. Select Confirm.
4. Optionally, select printers.

Printers with an outdated Go version are listed with their version number in orange.
5. Select Actions in the upper left corner and select Update.
6. Select Update.

• On Brother, ensure that nobody is using the printer during the update. Otherwise, the user's 
processes are cancelled.

• On Ricoh, a computer with Printix Client for Windows must be online on the printer's 
network during the uninstallation of Printix Go Ricoh.

• On Ricoh, to update from version 0.4.10.0 to version 2.0.0.27 or higher, you MUST do an
Uninstall and then an Install.

Update a single printer

 To update Kyocera printers, instead of following the steps below, you need to reinstall Printix 
Go Kyocera in both the Printix Administrator and the KYOCERA Net Viewer.

1. Open Printer properties and select the Printix Go  tab.
2. Select Update.

• On Brother, ensure that nobody is using the printer during the update. Otherwise, the user's 
processes are cancelled.

It can take up to a minute for the update to finish, but the update status does not change 
without refreshing the page.
• On Ricoh, a computer with Printix Client for Windows must be online on the printer's 

network during the uninstallation of Printix Go Ricoh.
• On Ricoh, the installation takes 10–25 minutes.
• On Ricoh, to update from version 0.4.10.0 to version 2.0.0.27 or higher, you MUST do an

Uninstall and then an Install.

Update multiple printers

 To update Kyocera printers, instead of following the steps below, you need to reinstall Printix 
Go Kyocera in both the Printix Administrator and the KYOCERA Net Viewer.

1. Select  Menu > Settings .
2. Select the Printix Go  tab.
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3. Select Go configuration name (Example: Copy is unlocked) to open the Go configuration
page.

4. Select Update.
• On Brother, ensure that nobody is using the printer during the update. Otherwise, the user's 

processes are cancelled.
• On Ricoh, a computer with Printix Client for Windows must be online on the printer's 

network during the uninstallation of Printix Go Ricoh.
• On Ricoh, to update from version 0.4.10.0 to version 2.0.0.27 or higher, you MUST do an

Uninstall and then an Install.

 For Ricoh printers, consider making separate configurations, so in the future, when you 
want to update the Printix Go Ricoh software, this can be done in stages, yet efficiently. This 
is because the Ricoh printer will restart twice and this takes 10–25 minutes, and during this 
period, the printer is unavailable to users.
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How to install Printix Capture

1. Select Capture in the Go functions settings in the Go configuration.
2. Select Save.
3. Proceed to Install Printix Go.

• If Printix Go it is already installed, then do an Update on the printer as this is required 
to make Printix Go on the printer reference the Internet endpoint https://on-device-
api.printix.net instead of the legacy endpoint https://device-api.printix.net.

• On Ricoh, a computer with Printix Client for Windows must be online on the printer's 
network during the installation, update, or uninstallation of Printix Go Ricoh.

• On Ricoh, to update from version 0.4.10.0 to version 2.0.0.27 or higher, you MUST do an
Uninstall and then an Install.

See also:
• How to get started with capture and workflow
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How to sign in with an ID code at the printer
These are generic instructions. For vendor-specific instructions, see: Brother, Epson, Fujifilm, HP,
Konica Minolta, Kyocera, Lexmark, Ricoh, or Xerox.

 If users are to enter only an ID code to sign in, you as an administrator must submit a support 
request so we can deactivate the setting Require PIN code for sign in with ID code. For security 
reasons, this policy applies to all users.

1. Enter your ID code (6 digits) on the touchscreen.
• Select the Eye  to see the digits entered.
• If you do not know your ID code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your ID code.

2. Enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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See also:
• How to see and reset ID code
• How to create and reset PIN code

How to sign in with card at the printer
These are generic instructions. For vendor-specific instructions, see: Brother, Epson, Fujifilm, HP,
Konica Minolta, Kyocera, Lexmark, Ricoh, or Xerox.

1. Swipe your card at the card reader on the printer.
• Before 60 seconds have elapsed, select the Printix Print  icon.
• A computer with Printix Client must be online on the printer's network. Otherwise, nothing 

happens when the card is swiped.
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2. If prompted, enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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See also:
• How to register card
• How to create and reset PIN code

How to release documents at the printer
These are generic instructions. For vendor-specific instructions, see: Brother, Epson, Fujifilm, HP,
Konica Minolta, Kyocera, Lexmark, Ricoh, or Xerox.

1. Sign in to the printer.
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2. Select the Printix Print  icon.
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3. Select the documents to release, or select Select all (the check box in the top right corner).
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4. Select Print at the bottom of the screen.

Delete documents
• Select the documents to delete and select Delete .
• Documents are automatically deleted if you do not print them within a specified period (default is 

24 hours).

How to capture at the printer
These are generic instructions. For vendor-specific instructions, see: HP, Konica Minolta, Kyocera, or
Ricoh.

The capture process consists of three steps:
• Scan and upload

As soon as the document is scanned and uploaded, you are returned to the list of workflows, 
while the processing and delivery continue in the background.

• Processing
The scanned document is processed by Optical Character Recognition (OCR) and a searchable 
PDF or Microsoft Word file is created.
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• Delivery
The document is sent in email, transferred to a cloud destination (OneDrive or SharePoint), or 
transferred to a Connector destination.

1. Sign in to the printer.
2. Select the Printix Capture  icon.

A list of capture workflows appears.
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3. Select the appropriate workflow.
If you are signed in with the System manager role, the Active information (Yes or No) is 
displayed.

4. Confirm the details of the workflow and place the document in the printer:
• Place multi-page documents in the Automatic Document Feeder (ADF).

Ensure pages are in the correct order.
• Place one-page documents on the printer's flatbed glass.

Scanning multiple pages from the flatbed glass is not supported.
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5. Select Start to start scanning.
• If you do not want to start the scan, select X to cancel and return to the list of workflows.
• On Ricoh, you cannot log out from the printer while the printer is scanning.
• As soon as the document is scanned and uploaded, you are returned to the list of workflows, 

while the processing and delivery continue in the background.

How to sign out
These are generic instructions. For vendor-specific instructions, see: Brother, Epson, Fujifilm, HP,
Konica Minolta, Kyocera, Lexmark, Ricoh, or Xerox.

You can sign out from the printer using these methods:
• Automatic sign-out if no activity.

• If the printer does not register key presses or touchscreen activity for a set amount of time, 
you are signed out automatically.

• Select Sign out on the printer's Home screen.
• To access the printer's Home screen, select the Home button.

• Swipe your card at the card reader on the printer.
• If you were already signed in, you are signed out. If another user was signed in, that user is 

signed out and you must swipe your card again to sign in.

400



Tungsten Printix Administrator Guide

How to register a card
You can register multiple cards. When your card is registered, the date and time of the registration 
is recorded together with the card number. If different card readers are used, the same card can be 
registered with different formats (card numbers). In this situation, you can register the same card 
with each type of card reader.

These are generic instructions. For vendor-specific instructions, see: Brother, Epson, Fujifilm, HP,
Konica Minolta, Kyocera, Lexmark, Ricoh, or Xerox.

1. Swipe the card at the card reader on the printer.

A 6-digit card registration code appears. The code is valid for 1 hour.
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2. Register your card using one of the following methods:
• Scan the QR code with the camera on your phone.
• Scan the QR code with the Printix App on your phone.
• Register the card without a phone.

• Make a note of the 6-digit card registration code and enter it later in the web Printix App 
on your computer.

Scan the QR code with the camera on your phone
1. Use the camera on your phone or tablet to scan the QR code displayed on the printer's 

touchscreen.
Scanning the QR code opens the web Printix App in your browser and registers the card. You 
may be prompted to sign in to the web Printix App.
• With iOS/iPadOS 11 or higher, you can use the camera to scan the QR code.
• With the Google application installed on your Android phone or tablet, you can perform a 

Google screen search to scan the QR code.
• If your QR scanner app (not part of Printix) prompts you to open the link in a browser, select 

that option.
2. Select Close.

Scan the QR code with the Printix App on your phone
If you are using the Printix App on your phone or tablet, you can:

1. Open the Printix App for Android or iOS/iPadOS.
2. Select Menu  > Cards and codes.
3. Select Register card.
4. Select Scan , then point the camera to the QR code displayed on the printer's touchscreen.

Alternatively, you can enter the 6-digit card registration code you saw previously and select
Save.

How to register a card without a phone
You can register multiple cards. When your card is registered, the date and time of the registration 
is recorded together with the card number. If different card readers are used, the same card can be 
registered with different formats (card numbers). In this situation, you can register the same card 
with each type of card reader.

1. Swipe the card at the card reader on the printer.
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A 6-digit card registration code appears. The code is valid for 1 hour.

2. Make a note of the card registration code.

Enter card registration code on your computer
1. Open the Printix App.

• Alternatively, visit printix.net and select Sign in.
• You are not required to use a phone, because you can also open the Printix App on your 

computer:
• Open the Printix Client menu and select Release and print documents.
• Open a web browser and enter the Printix Home URL for your work or school.

Example: https://acme.printix.net
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2. Select Menu  > Cards and codes.
3. Select Register card.
4. Enter the 6-digit card registration code you saw previously and select Save.
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How to manage cards

You can see a list of registered cards and delete cards you no longer use.
1. Sign in to the Printix App.
2. Select Menu  > Cards and codes.

• Select Register card to register a card.
• Select Delete  next to a card to delete it.

See also:
• How to see and reset ID code
• How to create and reset PIN code

How to reset the ID code or PIN code
You can reset the ID code or PIN code from the Cards and codes menu in the Printix App . The 
printer's sign-in screens that prompt for the ID code and PIN code also include a Forgot code
button.
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1. Select Forgot code.
A new screen appears with a QR code and the text: Scan QR code or visit {acme.printix.net}.

2. Use your phone or tablet to scan the QR code to open the Cards and codes menu in the Printix 
App.
• With iOS/iPadOS 11 or higher, you can use the camera to scan the QR code.
• If the Google application is installed on your Android phone or tablet, you can perform a 

Google screen search to scan the QR code.
• If your QR scanner app (not part of Printix) prompts you to open the link in a browser, select 

that option.

 The message PIN code disabled appears after three consecutive, failed sign-in attempts. 
In this case, you must open the Printix App, reset the PIN code, and enter a new and different 
value. Otherwise, the Printix App displays The new PIN code must be different from the 
previous one.

See also:
• How to see and reset ID code
• How to create and reset PIN code
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How to see and reset the ID code

Use the ID code to sign in at printers that have Printix Go installed.
1. Sign in to the Printix App.
2. Select Menu  > Cards and codes.
3. Select Create next to ID code to get an ID code.
4. If you see PIN code required, select Create, enter a new PIN code (4 digits), then select Save.

• Select Reset next to ID code and enter a new ID code to replace the old one.
• Select Delete  next to your ID code to delete it.
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How to create and reset the PIN code

The PIN code is the same whether you sign in with an ID code or card.
1. Sign in to the Printix App.
2. Select Menu  > Cards and codes.
3. Select Create next to PIN code.
4. Enter a new PIN code (4 digits), then select Save.

• Select Reset next to PIN code and enter a new PIN code to replace the old one.
• Select Delete  next to your PIN code to delete it.

 The message PIN code disabled appears after three consecutive, failed sign-in attempts. 
In this case, you must open the Printix App, reset the PIN code, and enter a new and different 
value. Otherwise, the Printix App displays The new PIN code must be different from the 
previous one.
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How to uninstall Printix Go

1. Select Printers .
2. Select the Printer name of the relevant printer to open the Printer properties page.
3. Select the Printix Go tab.
4. Select Uninstall. Optionally, after a minute passed, refresh the page and verify that the Status

changed from Installed to Uninstalled.
Do not attempt to sign in to the printer before this step is complete. Otherwise, the printer 
may not function properly.
• On Brother, ensure that nobody is using the printer during uninstallation. Otherwise, the 

user's processes are cancelled.
• On HP Workpath, right after this step, also uninstall Printix Go through the HP Command 

Center.
• On Kyocera, right after this step, also uninstall Printix Go through the KYOCERA Net Viewer.
• On Ricoh, a computer with Printix Client for Windows must be online on the printer's 

network during the uninstallation of Printix Go Ricoh.
• On Ricoh, the uninstallation takes 5–10 minutes.
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• On Xerox VersaLink, you need to manually restart the printer after uninstallation. Otherwise, 
you will get the message Internal Server Error.

 If the printer does not behave as normal after the uninstallation, restart the printer.

How to uninstall Printix Go from multiple printers
1. Select Printers .
2. Select the eye icon in the table header and set the view mode to Printix Go.
3. Select the check box next to the printers you wish to uninstall.
4. Select Actions above the table, then select Uninstall.

• On Brother, ensure that nobody is using the printer during uninstallation. Otherwise, the 
user's processes are cancelled.

• On Ricoh, a computer with Printix Client for Windows must be online on the printer's 
network during the uninstallation of Printix Go Ricoh.

5. Select Uninstall again.
6. After 30 seconds passed, refresh the page and verify that the uninstallation succeeded.

• On HP Workpath, right after this step, also uninstall Printix Go through the HP Command 
Center.

• On Kyocera, right after this step, also uninstall Printix Go through the KYOCERA Net Viewer.
• On Ricoh, the uninstallation takes 5–10 minutes.

 If the printer does not behave as normal after the uninstallation, restart the printer.

Printix Go Brother - How to
How to sections for Brother:
• How to use Printix Go on Brother printers
• How to remotely access control panel on Brother printers

See also:
• Printix Go troubleshooting

How to prepare Brother printer for Printix Go
1. Open the printer's web page.
2. Select the Network tab, then right under it, select the Security tab.
3. Select CA Certificate in the menu.
4. Ensure that the printer has maximum 8 CA certificates installed.
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Printix Go will attempt to add two more certificates during installation. However, if the 
maximum number of certificates (10) is reached before the two certificates are added, the 
installation fails.

5. On the Administrator tab, select Solutions Application Entry in the menu.
6. Ensure that maximum 9 menus are not empty.

Printix Go will attempt to add one more menu during installation. However, if the maximum 
number of menus (10) is reached before the new menu can be added, the installation fails.


• The Login and Logout applications will be overridden during installation.
• An additional solution shortcut will be added during installation.

Enable card readers for Brother printer
Before the installation of Printix Go, ensure that all card readers are enabled.

1. Open the printer's web page and sign in as administrator.
2. On the Administrator tab, select External Card Reader in the menu.
3. Ensure that no card readers are listed under Card Reader Registration.
4. If you made changes, select Submit.

How to use Printix Go on Brother printers
• Sign in with an ID code at a Brother printer
• Sign in with card at a Brother printer
• Release documents at a Brother printer
• Sign out from a Brother printer
• Register card on a Brother printer

See also:
• How to manage cards
• How to reset the ID code or PIN code
• How to see and reset the ID code
• How to create and reset the PIN code

Sign in with an ID code at a Brother printer
1. When the printer's touchscreen control panel displays Press OK to sign in or Present card or 

press OK, select OK.
2. Select ID code.

• If you do not know your ID code:
• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 

or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your ID code.
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3. Enter your ID code (6 digits) on the touchscreen.
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4. Enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• If you do not know your PIN code:

• Return to the screen where you selected ID code, but instead of selecting ID code, select
Forgot code to open a new screen with a QR code. Use the camera on your phone or 
tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.

Sign in with card at a Brother printer
1. When the printer's touchscreen control panel displays Present card or press OK, swipe your 

card at the card reader on the printer.
• A computer with Printix Client must be online on the printer's network. Otherwise, nothing 

happens when the card is swiped.
2. If prompted, enter your PIN code (4 digits) on the touchscreen.

• The PIN code is the same whether you sign in with an ID code or card.
• If you do not know your PIN code:

• Return to the screen where the control panel displays Present card or press OK, select
OK, then select Forgot code to open a new screen with a QR code. Use the camera on 
your phone or tablet to scan the QR code to open the Cards and codes menu in the
Printix App, or browse to the URL provided to reset your PIN code.
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Release documents at a Brother printer
1. Sign in to the printer.
2. Select Solutions.
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3. Select Select to print to only release specific documents, or select Print all to release all 
documents.

4. Select the documents to release, or select Select all.
The other documents are not visually marked with a check mark if you use Select all.

415



Tungsten Printix Administrator Guide

5. Select OK at the bottom of the screen.

Delete documents
1. Sign in to the printer.
2. Select Solutions.
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3. Select Select to delete.
4. Select the documents to delete, or select Select all.
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5. Select OK at the bottom of the screen.

Sign out from a Brother printer
You can sign out from the printer using these methods:
• Automatic sign-out if no activity.

• If the printer does not register key presses or touchscreen activity for a set amount of time, 
you are signed out automatically.

• Select the signed in user's name in the upper left corner.

Register card on a Brother printer
You can register multiple cards. When your card is registered, the date and time of the registration 
is recorded together with the card number. If different card readers are used, the same card can be 
registered with different formats (card numbers). In this situation, you can register the same card 
with each type of card reader.

1. Swipe the card at the card reader on the printer.

A 6-digit card registration code appears. The code is valid for 1 hour.
Make a note of the 6-digit card registration code and enter it later in the web Printix App on 
your computer.
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2. Register your card using one of the following methods:
• Scan the QR code with the camera on your phone.
• Scan the QR code with the Printix App on your phone.
• Register the card on your computer.

Scan the QR code with the camera on your phone
1. Use the camera on your phone or tablet to scan the QR code displayed on the printer's 

touchscreen.
Scanning the QR code opens the web Printix App in your browser and registers the card. You 
may be prompted to sign in to the web Printix App.
• With iOS/iPadOS 11 or higher, you can use the camera to scan the QR code.
• With the Google application installed on your Android phone or tablet, you can perform a 

Google screen search to scan the QR code.
• If your QR scanner app (not part of Printix) prompts you to open the link in a browser, select 

that option.
2. Select Close.

Scan the QR code with the Printix App on your phone
If you are using the Printix App on your phone or tablet, you can:

1. Open the Printix App for Android or iOS/iPadOS.
2. Select Menu  > Cards and codes.
3. Select Register card.
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4. Select Scan , then point the camera to the QR code displayed on the printer's touchscreen.
Alternatively, you can enter the 6-digit card registration code you saw previously and select
Save.

Register the card on your computer
1. Open the Printix App.
2. Select Menu  > Cards and codes.

3. Select Register card.
4. Enter the 6-digit card registration code you saw previously and select Save.

How to remotely access control panel on Brother printers
1. Open the printer's web page and sign in as administrator.
2. On the Administrator tab, select Remote Panel in the menu.

Printix Go Epson - How to
How to sections for Epson:
• How to prepare Epson printer for Printix Go
• How to install card reader on Epson printers
• How to use Printix Go on Epson printers
• How to set up scan to email on Epson printers

See also:
• Printix Go troubleshooting
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How to prepare Epson printer for Printix Go
Before installing Printix Go, the printer needs to be set up correctly.

1. Activate Epson Open Platform.

 Printix Go installation (update and uninstallation too) causes the Epson printer's network 
interface to restart, leaving it disconnected from the network for about 1 minute.

To activate Epson Open Platform:
1. Obtain the serial number for the printer.

• In Printix Administrator on the Printer properties page, you can see the Serial number, 
and you can select the  Modify icon to copy it to the clipboard.

• Alternatively, you can find it on the back or on a sticker (bar code) on the bottom of the 
printer, or with the warranty supplied with the printer.

2. To obtain the product key, visit openplatform.epson.biz/license-op/inputInformation.html.
• In Serial number, type the serial number you obtained.

Example: X6GN001097
• In Introduction destination information, enter your answers.

3. Select Next.
4. Verify the information you have entered, then select Issue.
5. Select Export CSV to save the product keys to a file.
6. Open the printer's web page.
7. Select the Epson Open Platform tab.
8. In Enter product key, paste the product key that was generated based on this printer's serial 

number.
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9. Select Next.
10. Select OK.
11. Select the Epson Open Platform tab. Select Product key.

When Authentication System is displayed under the Epson Open Platform Settings menu, 
Epson Open Platform is activated.

How to install card reader on Epson printers
1. Locate the USB type-A port:

• WorkForce Enterprise MFPs: Front Side
• WorkForce Pro MFPs: Rear Side
• EcoTank Pro MFPs: Front Side

2. Connect the card reader.

 If you connect a card reader to the wrong port, you get the message: The connected 
device is not supported. Check the printer manual or contact your Epson Local Support 
Team.

Card reader cable connected on Epson WF-C5790

 Disconnecting a card reader does not remove it from the Printer properties page.

How to use Printix Go on Epson printers
• Sign in with an ID code at an Epson printer
• Sign in with card at an Epson printer
• Release documents at an Epson printer
• Sign out from an Epson printer
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• Register card on an Epson printer

See also:
• How to manage cards
• How to reset ID code or PIN code
• How to see and reset ID code
• How to create and reset PIN code

Sign in with an ID code at an Epson printer
1. Enter your ID code (6 digits) on the touchscreen.

• Select the Eye  to see the digits entered.
• If you do not know your ID code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your ID code.

2. Enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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Sign in with card at an Epson printer
1. Swipe your card at the card reader on the printer.

• A computer with Printix Client must be online on the printer's network. Otherwise, nothing 
happens when the card is swiped.
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2. If prompted, enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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Release documents at an Epson printer
1. Sign in to the printer.
2. Before 60 seconds have elapsed, select the Home icon on the printer.
3. Select the documents to release, or select Select all (the check box in the top right corner).
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4. Select Print at the bottom of the screen.

Delete documents
• Select the documents to delete and select Delete .
• Documents are automatically deleted if you do not print them within a specified period (default is 

24 hours).

Sign out from an Epson printer
You can sign out from the printer using these methods:
• Automatic sign-out if no activity.

• If the printer does not register key presses or touchscreen activity for a set amount of time, 
you are signed out automatically.

• Select Sign out on the printer's Home screen.
• To access the printer's Home screen, select the Home button.

• Swipe your card at the card reader on the printer.
• If you were already signed in, you are signed out. If another user was signed in, that user is 

signed out and you must swipe your card again to sign in.

Register card on an Epson printer
You can register multiple cards. When your card is registered, the date and time of the registration 
is recorded together with the card number. If different card readers are used, the same card can be 
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registered with different formats (card numbers). In this situation, you can register the same card 
with each type of card reader.

1. Swipe the card at the card reader on the printer.

A 6-digit card registration code appears. The code is valid for 1 hour.
2. Register your card using one of the following methods:

• Scan the QR code with the camera on your phone.
• Scan the QR code with the Printix App on your phone.
• Register the card without a phone.

Make a note of the 6-digit card registration code and enter it later in the web Printix App on 
your computer.

Scan the QR code with the camera on your phone
1. Use the camera on your phone or tablet to scan the QR code displayed on the printer's 

touchscreen.
Scanning the QR code opens the web Printix App in your browser and registers the card. You 
may be prompted to sign in to the web Printix App.
• With iOS/iPadOS 11 or higher, you can use the camera to scan the QR code.
• With the Google application installed on your Android phone or tablet, you can perform a 

Google screen search to scan the QR code.
• If your QR scanner app (not part of Printix) prompts you to open the link in a browser, select 

that option.
2. Select Close.

Scan the QR code with the Printix App on your phone
If you are using the Printix App on your phone or tablet, you can:

1. Open the Printix App for Android or iOS/iPadOS.
2. Select Menu  > Cards and codes.
3. Select Register card.
4. Select Scan , then point the camera to the QR code displayed on the printer's touchscreen.

Alternatively, you can enter the 6-digit card registration code you saw previously and select
Save.
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How to set up scan to email on Epson printers
After configured, you can sign in to the printer, select Scan and then the Email function.

Use the below steps to set up scan to email so users can scan and send emails to your company's 
Microsoft 365 or Office 365 mailboxes. The steps are in accordance with option 2, as described in 
Microsoft documentation: How to set up a multifunction device or application to send email using 
Microsoft 365 or Office 365.

1. Open a new browser window and sign in to Microsoft 365 admin center
(admin.microsoft.com).

2. On the navigation menu, select Show all.
3. Select Settings and then Domains.
4. On the DNS records tab, select your domain.

Example:  acme.com
5. Write down the MX record POINTS TO ADDRESS value.

You need the MX record in step 9.
Example:  acme-com.mail.protection.outlook.com

6. Open the printer's web page and select Administrator Login.
7. Select the Network tab.
8. In the menu under Email Server, select Basic.
9. On the Email Server > Basic page:

• In Authentication Method, select Off.
• In Sender's Email Address, type a sender email address.
• In SMTP Server Address, type the value you obtained in step 5.

Example: acme-com.mail.protection.outlook.com
• In SMTP Server Port Number, leave the value at 25.
• In Secure Connection, select STARTTLS.
• In Certificate Validation, select Enable.
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10. Select OK.
After a few seconds, the message appears: Setup complete.

11. Select Connection Test and then Start to test the connection.
After a few seconds, the message appears: Connection test was successful.

12. Remember to select Administrator Logout and then select OK to exit the printer's web pages.


• Email might be sent to recipients' junk mail folders. To avoid this, go to your domain registrar's 

website to update your DNS records. Edit your sender policy framework (SPF) record to include 
your public IP address. See the Microsoft documentation: Step-by-step instructions for direct 
send.

• If your email did not arrive, remember to check your spam/junk mail folder. See also: How to 
troubleshoot scan to email.

Email sender
When you are signed in with Printix, your email address is automatically prefilled in the From field. 
Some SMTP servers will reject sending the scanned documents if the email sender (From field) 
does not have a specific value. To work around this, you can specify the Email sender in the Go 
configuration.
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Printix Go Fujifilm - How to
How to sections for Fujifilm:
• How to prepare Fujifilm printer for Printix Go
• How to use Printix Go on Fujifilm printers
• How to set inactivity timeout on Fujifilm printers
• How to set up scan to email on Fujifilm printers

See also:
• Printix Go troubleshooting

How to prepare Fujifilm printer for Printix Go
1. Make sure no other application is installed on the printer that changes how users sign in to the 

printer.
Printix does not support having more than one type of authentication software.

2. Before adding the printer to Printix, find a network where every computer runs the minimum 
required version of the Printix Client.

3. Add the printer to the selected network.

a. Go to the Printers page, select the Eye  in the upper right corner of the table, then 
select Printix Go.

b. Find the printer and make sure that the detected vendor type is FUJIFILM. If the vendor 
type is UNKNOWN, the network has a workstation that runs an inappropriate version of 
the Printix Client.

Verify the version of Printix Go
1. Open the printer's web page as an administrator.
2. Select the System tab.
3. Select Plug-in Settings.
4. In the Plug-in Name list, select Printix Go, then select Show.

The Information tab appears, which contains the Version.

Configure Printix Go for the printer
1. While you are still in the Information tab, select the Configuration tab.
2. Configure the following settings as needed.

If you are satisfied with the default settings, you can leave the settings unchanged.
• Https port: A custom port for communication between the printer and Printix Go.
• Swipe ignore interval: This interval determines how many seconds must pass between 

using cards at the printer. Card swipes are not processed within the specified interval.
• Device log enabled: Select this option to store the log files of the printer. The log files are 

only useful for troubleshooting purposes. Select Download device log to download the 
stored log files.
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• Http log enabled: Ensure this option is cleared.
3. Select Apply.
4. If you changed the Https port:

a. Close the Plug-in Settings dialog box.

b. Select the Network tab.

c. Select Protocols.

d. Select HTTP.

e. Change the Port Number (HTTPS) value to match the Https port you configured in step
2.

f. Select Save.

How to use Printix Go on Fujifilm printers
• Sign in with an ID code at a Fujifilm printer
• Sign in with card at a Fujifilm printer
• Release documents at a Fujifilm printer
• Sign out from a Fujifilm printer
• Register card on a Fujifilm printer

See also:
• How to manage cards
• How to reset the ID code or PIN code
• How to see and reset the ID code
• How to create and reset the PIN code

Sign in with an ID code at a Fujifilm printer
1. Enter your ID code (6 digits) on the touchscreen.

• Select the Eye  to see the digits entered.
• If you do not know your ID code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your ID code.
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2. Enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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Sign in with card at a Fujifilm printer
1. Swipe your card at the card reader on the printer.

• Before 60 seconds have elapsed, select the Printix Print  icon.
• A computer with Printix Client must be online on the printer's network. Otherwise, nothing 

happens when the card is swiped.
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2. If prompted, enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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Release documents at a Fujifilm printer
1. Sign in to the printer.
2. Select the Printix Print  icon.
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3. Select the documents to release, or select Select all (the check box in the top right corner).

4. Select Print at the bottom of the screen.
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Delete documents
• Select the documents to delete and select Delete .
• Documents are automatically deleted if you do not print them within a specified period (default is 

24 hours).

Sign out from a Fujifilm printer
You can sign out from the printer using these methods:
• Automatic sign-out if no activity.

• If the printer does not register key presses or touchscreen activity for a set amount of time, 
you are signed out automatically.

• Select Sign out on the printer's Home screen.
• To access the printer's Home screen, select the Home button.

• Swipe your card at the card reader on the printer.
• If you were already signed in, you are signed out. If another user was signed in, that user is 

signed out and you must swipe your card again to sign in.

Register card on a Fujifilm printer
You can register multiple cards. When your card is registered, the date and time of the registration 
is recorded together with the card number. If different card readers are used, the same card can be 
registered with different formats (card numbers). In this situation, you can register the same card 
with each type of card reader.

1. Swipe the card at the card reader on the printer.

A 6-digit card registration code appears. The code is valid for 1 hour.
Make a note of the 6-digit card registration code and enter it later in the web Printix App on 
your computer.
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2. Register your card using one of the following methods:
• Scan the QR code with the camera on your phone.
• Scan the QR code with the Printix App on your phone.
• Register the card on your computer.

Scan the QR code with the camera on your phone
1. Use the camera on your phone or tablet to scan the QR code displayed on the printer's 

touchscreen.
Scanning the QR code opens the web Printix App in your browser and registers the card. You 
may be prompted to sign in to the web Printix App.
• With iOS/iPadOS 11 or higher, you can use the camera to scan the QR code.
• With the Google application installed on your Android phone or tablet, you can perform a 

Google screen search to scan the QR code.
• If your QR scanner app (not part of Printix) prompts you to open the link in a browser, select 

that option.
2. Select Close.
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Scan the QR code with the Printix App on your phone
If you are using the Printix App on your phone or tablet, you can:

1. Open the Printix App for Android or iOS/iPadOS.
2. Select Menu  > Cards and codes.
3. Select Register card.
4. Select Scan , then point the camera to the QR code displayed on the printer's touchscreen.

Alternatively, you can enter the 6-digit card registration code you saw previously and select
Save.

Register the card on your computer
1. Open the Printix App.
2. Select Menu  > Cards and codes.

3. Select Register card.
4. Enter the 6-digit card registration code you saw previously and select Save.

How to set inactivity timeout on Fujifilm printers
1. Sign in to the printer's web page.
2. In the System menu, select Timeouts.
3. In System timeout, enter the number of seconds.

How to set up scan to email on Fujifilm printers
These steps are required to complete the setup of Scan to Email.
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Enable email port for sender
1. Sign in to the printer as a system administrator.
2. Select Tools.

The Tools screen appears.
3. Select System Settings.
4. Select Connectivity & Network Setup from the Group menu.
5. Select Port Settings from the Features menu.
6. Use the Up or Down button to select the Send E-mail option, then select Change Settings.
7. Make sure Port Status is set to enabled. Alternatively, select Port Status, then select Change 

Settings.
8. Select Enabled.
9. Select Save.

10. Select Close twice to return to the Tools screen.

Set the printer’s email address
1. On the Tools screen, select Machine E-mail Address / Host Name from the Features menu.

The Machine E-mail Address / Host Name screen appears.
2. Select E-mail Address, then select Change Settings.
3. Use the keyboard on the touchscreen to enter the email address.
4. Select Save.
5. Select Close to return to the Tools screen.

Set the email server
1. On the Tools screen, select Outgoing / Incoming Email Settings from the Features menu.
2. Select SMTP Server Settings from the Group menu.
3. Using the Up or Down button, scroll down to select SMTP Server Name / IP Address.
4. Select Change Settings.
5. Enter the Server Name / IP Address and the other SMTP server details.
6. If required, use the keyboard on the touchscreen to enter the SMTP AUTH / SMTP Password.
7. Select Save.
8. Select Close repeatedly to return to the home screen.

After a few seconds, the printer automatically restarts itself to update the new settings.

Printix Go HP - How to
How to sections for HP:
• How to use Printix Go on HP printers
• How to set inactivity timeout on HP printers
• How to set up scan settings on HP printers
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• How to set up scan to email on HP printers
• How to remotely access control panel on HP printers
• How to reset to factory settings on HP printers
• How to install card reader on HP printers
• How to set up SSL/TLS communication on HP printers
• How to enable the HP Workpath platform
• How to install HP Workpath on printers through HP Command Center
• How to sign in as an administrator on HP Workpath printers

See also:
• Printix Go troubleshooting

How to use Printix Go on HP printers
• Sign in with an ID code at an HP printer
• Sign in with card at an HP printer
• Release documents at an HP printer
• Capture at an HP printer
• Sign out from an HP printer
• Register card on an HP printer

See also:
• How to manage cards
• How to reset the ID code or PIN code
• How to see and reset the ID code
• How to create and reset the PIN code

Sign in with an ID code at an HP printer
1. Enter your ID code (6 digits) on the touchscreen.

• Select the Eye  to see the digits entered.
• If you do not know your ID code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your ID code.
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2. Enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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Sign in with card at an HP printer
1. Swipe your card at the card reader on the printer.

• Before 60 seconds have elapsed, select the Print  icon.
• A computer with Printix Client must be online on the printer's network. Otherwise, nothing 

happens when the card is swiped.
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2. If prompted, enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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Release documents at an HP printer
1. Sign in to the printer.
2. Before 60 seconds have elapsed, select the Print  icon.

On HP Workpath printers, the icon is called Printix Go.
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3. Select the documents to release, or select Select all (the check box in the top right corner).
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4. Select Print at the bottom of the screen.

Delete documents
• Select the documents to delete and select Delete .
• Documents are automatically deleted if you do not print them within a specified period (default is 

24 hours).

Capture at an HP printer
The capture process consists of three steps:
• Scan and upload

As soon as the document is scanned and uploaded, you are returned to the list of workflows, 
while the processing and delivery continue in the background.

• Processing
The scanned document is processed by Optical Character Recognition (OCR) and a searchable 
PDF or Microsoft Word file is created.

• Delivery
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The document is sent in email, transferred to a cloud destination (OneDrive or SharePoint), or 
transferred to a Connector destination.

1. Sign in to the printer.
2. Select the Capture  icon.

A list of capture workflows appears.
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3. Select the appropriate workflow.
If you are signed in with the System manager role, the Active information (Yes or No) is 
displayed.

4. Confirm the details of the workflow and place the document in the printer:
• Place multi-page documents in the Automatic Document Feeder (ADF).

Ensure pages are in the correct order.
• Place one-page documents on the printer's flatbed glass.

Scanning multiple pages from the flatbed glass is not supported.
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5. Select Start to start scanning.
• As soon as the document is scanned and uploaded, you are returned to the list of workflows, 

while the processing and delivery continue in the background.
• If you do not want to start the scan, select X to cancel and return to the list of workflows.

Sign out from an HP printer
You can sign out from the printer using these methods:
• Automatic sign-out if no activity.

• If the printer does not register key presses or touchscreen activity for a set amount of time, 
you are signed out automatically.

• Select Sign out on the printer's Home screen.
• To access the printer's Home screen, select the Home button.

• Swipe your card at the card reader on the printer.
• If you were already signed in, you are signed out. If another user was signed in, that user is 

signed out and you must swipe your card again to sign in.
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Register card on an HP printer
You can register multiple cards. When your card is registered, the date and time of the registration 
is recorded together with the card number. If different card readers are used, the same card can be 
registered with different formats (card numbers). In this situation, you can register the same card 
with each type of card reader.

1. Swipe the card at the card reader on the printer.

A 6-digit card registration code appears. The code is valid for 1 hour.

2. Register your card using one of the following methods:
• Scan the QR code with the camera on your phone.
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• Scan the QR code with the Printix App on your phone.
• Register the card without a phone.

Make a note of the 6-digit card registration code and enter it later in the web Printix App on 
your computer.

Scan the QR code with the camera on your phone
1. Use the camera on your phone or tablet to scan the QR code displayed on the printer's 

touchscreen.
Scanning the QR code opens the web Printix App  in your browser and registers the card. You 
may be prompted to sign in to the web Printix App.
• With iOS/iPadOS 11 or higher, you can use the camera to scan the QR code.
• With the Google application installed on your Android phone or tablet, you can perform a 

Google screen search to scan the QR code.
• If your QR scanner app (not part of Printix) prompts you to open the link in a browser, select 

that option.
2. Select Close.

Scan the QR code with the Printix App on your phone
If you are using the Printix App on your phone or tablet, you can:

1. Open the Printix App for Android or iOS/iPadOS.

2. Select Menu  > Cards and codes.
3. Select Register card.
4. Select Scan , then point the camera to the QR code displayed on the printer's touchscreen.

Alternatively, you can enter the 6-digit card registration code you saw previously and select
Save.
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How to set inactivity timeout on HP printers

1. Open the printer's web page and sign in as administrator.
2. On the General tab, select Display Settings in the menu.
3. In Inactivity Timeout, enter the number of seconds.

The default is 60 seconds.
4. Select Apply.

How to set up scan settings on HP printers
Scan settings of Printix Capture workflows are independent from the printer. Users can select scan 
settings that might not be supported by the printer, which means that the printer might override 
the requested scan parameters to complete the workflow.

The Printix workflow settings cover only a subset of the scan features that the printer has. This 
implies that the printer simplifies some settings when they are applied. The most affected settings 
are the paper feeding options and also the orientation to some extent.

Printix queries the available scan capabilities from the printer. When a scan request is made, 
each scan setting (other than "Select automatically") is checked whether it is supported by the 
capabilities of the printer. When a scan setting is not supported, two things can happen:
• For the 2-sided and Orientation settings, the default settings are used.
• For other settings, the closest values are used that are higher than the requested ones.
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Paper feeding options
The HP platform supports short edge feeding for all paper sizes, but on certain printer models, long 
edge feeding is only allowed for A4 and Letter size papers. To avoid losing data in the output image, 
short edge feeding is required.

Select automatically
Some printer models support setting the "Orientation" and "Paper size" to "Select automatically". If
"Select automatically" is not supported, the default values are going to be used.

 Because "Select automatically" uses the default values, it can result in a partially scanned 
image.

How to set up scan to email on HP printers

After configured, you can sign in to the printer, select Scan and then the Scan to Email function. 
Your own email address is typically pre-filled in the To and From fields. That way, it is very easy to 
have the scanned documents send to your mailbox as attachments.
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Use the below steps to set up scan to email so users can scan and send emails to your company's 
Microsoft 365 or Office 365 mailboxes. The steps are in accordance with option 2, as described in 
Microsoft documentation: How to set up a multifunction device or application to send email using 
Microsoft 365 or Office 365.

1. Open a new browser window and sign in to Microsoft 365 admin center
(admin.microsoft.com).

2. On the navigation menu, select Show all.
3. Select Settings and then Domains.
4. On the DNS records tab, select your domain.

Example:  acme.com
5. Write down the MX record POINTS TO ADDRESS value.

You need the MX record in step 9.
Example:  acme-com.mail.protection.outlook.com

6. Open the printer's web page and sign in as administrator.
7. On the Scan/Digital Send tab, select Email setup in the menu.
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8. In the section Outgoing Email Servers (SMTP), select Add.

9. Select I know my SMTP server address or host name and type the value you obtained in step 
5.
Example:  acme-com.mail.protection.outlook.com

10. Select Next.
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11. In Set the basic information necessary to connect to the server, configure the following:
• In Port Number, leave the value at 25.
• In Split emails if larger than (MB), leave the value at 0.
• Select Enable SMTP SSL /TLS Protocol and then clear Validate certificate for outgoing 

server connections.
12. Select Next.

13. Select Server does not require authentication.
14. Select Next.

15. In Server Usage, only select the functions you will use.
16. Select Next.
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17. In Send Test Email, type a company email address (such as: john.smith@acme.com) and select
Test.

18. Select Finish.

 Email might be sent to recipients' junk mail folders. To avoid this, go to your domain 
registrar's website to update your DNS records. Edit your sender policy framework (SPF) 
record to include your public IP address. See the Microsoft documentation: Step-by-step 
instructions for direct send.
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 If you email did not arrive, remember to check your spam/junk mail folder. See also: How 
to troubleshoot scan to email.

19. Select Enable scan to Email.
20. Proceed to configure if email fields should be pre-filled and editable. We recommend:

• In From, select User's address (sign-in required) and clear User editable.
21. Select Apply.

How to remotely access control panel on HP printers
1. Opent the printer's web page and sign in as administrator.
2. On the Information tab, select Remote Control-Panel in the menu.
3. Select Launch Private Remote Control-Panel.

How to reset to factory settings on HP printers

1. Open the printer's web page and sign in as administrator.
2. On the General tab, select Reset Factory Settings in the menu.
3. In the section Reset Firmware, select Reset.
4. Select Reset again.

The printer restarts.
5. Set the printer's date and time correctly.

After the reset, follow the instructions on the printer's touchscreen to set the date and time 
and other settings. You MUST set this correctly, otherwise, Printix Go will not work.
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How to set HP printer password

1. Open the printer's web page (to set a password, because this is required for Printix Go 
installation).

2. On the Security tab:
• In New Password, type the password.
• In Verify Password, type the password.

3. Select Apply.

How to install card reader on HP printers
1. Locate an available USB Type-A port on the back of the printer or on the side of the printer's 

touchscreen control panel.
2. Connect the card reader to the USB Type-A port.

• On the Printer properties page, Card reader reader should show Vendor and Created for 
the installed card reader. If it does not, a restart of the printer may be required.

• If the Sign in method in the Printix Go configuration is Select automatically, it should map 
to Card if a card reader is connected to the printer. Otherwise, it maps to ID code. Mapping 
changes within 10 seconds after the card reader is either connected or disconnected. If it 
does not change, a restart of the printer may be required.

• If Printix Go is not yet installed, the HP printer may say: USB error.

Printer has a Hardware Integration Pocket
1. Locate the Hardware Integration Pocket (HIP) on the printer.

• See also: HP documentation on: Install the HP Proximity card reader, X3D03A
2. Remove the HIP cover by using a thin, flat-blade screwdriver along either the short edge of the 

HIP cover to gently pry the cover off. Set the cover aside.
3. Locate the USB mini-A port.
4. Connect the card reader to the USB mini-A port.
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How to set up SSL/TLS communication on HP printers
1. Open the printer's web page and sign in as administrator.
2. On the Networking tab, select Secure Communication in the menu.
3. In SSL/TLS Protocol, set Max TLS version to TLS 1.3.

Printix Go uses the highest level of TLS that the device supports. If the device does not support 
TLS 1.3, the communication falls back to TLS 1.2.

4. Select Apply.

 TLS 1.3 is supported by Windows 11 and Windows Server 2022 . On older versions, you 
may see TLS 1.2 communication between the printer and the Printix Client even if TLS 1.3 is 
enabled.

How to enable the HP Workpath platform
1. Open the printer's web page and sign in as administrator.
2. On the Security tab, select General Security in the menu if it is not already selected.
3. In HP Workpath platform, select Enable.
4. Select Restart.

If you install HP Workpath on an HP OXPd printer, you also need to perform the following 
steps:

5. Uninstall Printix Go from Printix Administrator.
6. Install Printix Go again.

Without performing these steps, you might get the following error message when selecting 
the Printix Print  icon on the printer:
This item is restricted. Try using another account, or contact the system administrator or 
the person who set up the product.

How to install HP Workpath on printers through HP Command Center
Before working with HP Command Center, it is necessary to create an HP account by registering on 
the HP Command Center (hpcommandcenter.com).

1. Enable the HP Workpath platform on the printer.
2. Go to the printer and select the HP Command Center application.

3. Select Continue.
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4. When the printer prompts you to sign in, follow the on-screen instructions to sign in with your 
phone or computer.

5. When you get a message to Continue on your device, go back to the printer and wait until the 
screen refreshes.

6. Select Demo Pool for the Account, then select Add.
7. Select Exit.

The printer is added to HP Command Center.
8. Sign in to the HP Command Center (hpcommandcenter.com).
9. Select Accounts and select the Demo Pool where the printer was added in step 5.

10. In Solutions, select Printix, then select Manage.

11. Select Install.
12. Select the printers you wish to install, then select Next and Install.

 If the Status of the printer you wish to install displays Incompatible device, wait a few 
minutes, refresh the page, and try again.

13. Return to the Demo Pool and verify the status of the installation.
Initially, the status of the installation will be In process. Refresh the page after a few minutes, 
and the status should change to Succeeded.
The printer is now installed in HP Command Center.

14. Install Printix Go to configure Printix Go to work with your Printix Home.

How to uninstall HP Workpath from a printer through HP Command 
Center

1. Uninstall Printix Go from your printer.
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2. Sign in to the HP Command Center (hpcommandcenter.com).
3. Select Accounts and select the Demo Pool where the printer is.
4. In Solutions, select Printix, then select Manage.

5. Select Uninstall.
6. Select the printer you wish to uninstall, then select Next and Uninstall.
7. Return to the Demo Pool and verify the status of the uninstallation.

Initially, the status of the installation will be In process. Refresh the page after a few minutes, 
and the status should change to Succeeded.

How to sign in as an administrator on HP Workpath printers
When first signing in to an HP Workpath printer, no option is available to sign in as an 
administrator. To enable signing in to the printer as an administrator:

1. Sign in to the printer's web page as an administrator.
2. On the Security tab, select Access Control in the menu.
3. In Enable and Configure Sign-in Methods, select Setup next to the Printix sign-in method.
4. In Accessory Sign-in Method Setup, unselect Enable Printix, then select OK.

You return to the Access Control menu. We recommend to wait 1 minute before proceeding to 
the next step.

5. Go back to Accessory Sign-in Method Setup, select Enable Printix, then select OK.
After these steps are done, the printer's web page can be closed.

6. On the printer's sign-in screen, select Administrator Access Code for the Access Type.
7. Enter your access code, then select Sign In.
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Printix Go Konica Minolta - How to
How to sections for Konica Minolta:
• How to prepare Konica Minolta printer for Printix Go
• How to install card reader on Konica Minolta printers
• How to use Printix Go on Konica Minolta printers
• How to set up scan settings on Konica Minolta printers
• How to set up scan to email on Konica Minolta printers
• How to sign in as guest on Konica Minolta printers
• How to remotely access control panel on Konica Minolta printers

See also:
• Printix Go troubleshooting

How to prepare Konica Minolta printer for Printix Go
Before installing Printix Go, the printer needs to be set up correctly. The printer needs to be 
powered on and off during this process:

1. SSL setting
2. Enable web browser
3. OpenAPI setting
4. TCP socket setting
5. Verify access to printer
6. Additional steps to use card reader:

• May require update to the latest printer firmware version
• Installation of card reader driver

 Printix Go installation (including update and uninstall) and use of printer's touchscreen 
control panel (including sign in and print) is likely to fail and result in error messages if an 
administrator is signed in to the printer's web pages at the same time.

SSL setting
1. Open the printer's web page and log in as administrator.
2. Select Security in the main menu.
3. In PKI Settings, select SSL Setting.
4. On the SSL Setting page:

• In Mode using SSL/TLS, select Admin Mode and User Mode.
• In Encryption Strength, leave it at the default.
• In SSL/TLS Version Settings, you can leave it at the default (all selected), but we recommend 

you clear versions older than TLSv1.2.
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5. Select OK.
• The web browser will change the URL to https:// and may ask you to log in again.
• The web browser may ask you to confirm an invalid certificate.

Enable web browser
1. Open the printer's web page and log in as administrator.
2. Select Network in the main menu.
3. Select Web Browser Setting.
4. In Web Browser Setting, select Web Browser Setting.
5. On the Web Browser Setting page:

• In Web Browser, select Enable.
6. Select OK.

OpenAPI setting
1. Open the printer's web page and log in as administrator.
2. Select Network in the main menu.
3. In OpenAPI, select OpenAPI Setting.
4. On the OpenAPI Setting page:

• In Use SSL/TLS, select SSL Only.
• In Port No. (SSL), type 50003.
• In Client Certificates, select Do not request.
• In Validity Period, select Do Not Confirm.
• In CN, select Do Not Confirm.
• In Key Usage, select Do Not Confirm.
• In Chain, select Do Not Confirm.
• In Expiration Date Confirmation, select Do Not Confirm.

5. Select OK.
6. Remember to select Logout and then select OK to exit the printer's web pages, because 

otherwise, the Printix Go installation (including update and uninstall) is likely to fail and result 
in error messages.

TCP socket setting
1. Open the printer's web page and log in as administrator.
2. Select Network in the main menu.
3. Select TCP Socket Setting.
4. Select Use SSL/TLS.
5. In Port No. (SSL/TLS), type 59159.
6. Select OK.
7. Remember to select Logout and then select OK to exit the printer's web pages, because 

otherwise, the Printix Go installation (including update and uninstall) is likely to fail and result 
in error messages.
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 If the TCP socket setting is not configured correctly, the History may include entries 
such as OpenAPI communication returned 'SSL' (FAIL).

Verify access to printer
1. Open the printer's web page and on the URL /OpenAPI/DeviceDescription/.

Example:  https://192.168.1.10/OpenAPI/DeviceDescription/
2. You should see an XML file that includes the tag <OpenApiVersion>.

How to install card reader on Konica Minolta printers
A Konica Minolta field service engineer needs to be involved to enable the use of a card reader.

Connect the card reader directly to the external USB port located at the rear, next to the network 
port. It may be necessary to remove the right-rear cover to access the USB port. The below card 
readers are supported but require the installation of a driver.

Vendor VID PID Comment Card reader driver

HID 0×076B 0×5427 HID OMNIKEY 
5427G2 (Also known 
as AU-205H GEN2)

HID Global, 
OMNIKEY 5427CK

HID 0×076B 0×5428 HID OMNIKEY 
5427G2 in keyboard 
mode (Also known 
as AU-205H GEN2)

HID Global, 
OMNIKEY 5427CK

Limitations with card reader support
Existing installations with Printix Go Konica Minolta need to update to the released Printix Go 
Konica Minolta version 1.1.0.0 or higher. Limitations:
• It is not possible to detect if a card reader has been connected or disconnected. We have been 

unsuccessful at using OpenAPI functions for this. As a consequence:
• The Printer properties page will not show that a card reader is connected.
• The Sign in method in the printer's Go configuration should be set to either Card or Card or 

ID code. The method Select automatically will not detect the card reader.
• The History tab on the "Print properties" page will, however, include an entry about the 

installed card reader driver right after a "Verify sign in profile" is performed.
Example: Card reader driver found: HID Global, OMNIKEY 5427CK 0000000000000000 1.4.0Lx 
(SUCCESS)

• It may be necessary to restart the printer whenever a card reader is connected or 
disconnected.

• To sign out, you should use the printer's Access button. The method of swiping a card at the 
printer's card reader to sign out is not recommended, because the flow cannot detect if the card 
belongs to perhaps an already signed in user.

• To install a card reader driver, the help of a Konica Minolta technician is required. Your printer 
must be able to access service mode.
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 If the Konica Minolta printer issues 4 beeps after powering on, it indicates that the connected 
card reader is not compatible with the installed card reader driver.

Enable/disable card reader
1. Open the printer's web page and log in as administrator.
2. Select User Auth/Account Track in the main menu.
3. Select Authentication Card ID Number and change Authentication Card ID Number from

Ignore to Notify to enable the card reader.
• To disable the card reader, change Authentication Card ID Number to Ignore.

4. Select OK.

Disable external keyboard
If a keyboard (KBD) emulating card reader is used (and the card reader driver is Unspecified, 
Keyboard Emulation Card Reader) and "External keyboard" is allowed, then if copy screen is open, 
the Copies field will get populated with card data if during this time, the card is presented to the 
card reader. To resolve this, disable external keyboard.

1. Open the printer's web page and log in as administrator.
2. Select Security in the main menu.
3. Select USB Connection Permission setting and change External Keyboard from Allow to

Restrict.
4. Select OK.

How to use Printix Go on Konica Minolta printers
• Sign in with an ID code at a Konica Minolta printer
• Sign in with card at a Konica Minolta printer
• Release documents at a Konica Minolta printer
• Capture at a Konica Minolta printer
• Sign out from a Konica Minolta printer
• #unique_971
• Sign in as guest on a Konica Minolta printer

See also:
• How to manage cards
• How to reset the ID code or PIN code
• How to see and reset the ID code
• How to create and reset the PIN code
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Sign in with an ID code at a Konica Minolta printer

1. Enter your ID code (6 digits) on the touchscreen.
• Select the Eye  to see the digits entered.
• If you do not know your ID code:

• Select Forget code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the  Printix App , or 
browse to the URL provided to reset your ID code.
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2. Enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forget code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the  Printix App , or 
browse to the URL provided to reset your PIN code.
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Sign in with card at a Konica Minolta printer

1. Swipe your card at the card reader on the printer.
• Before 60 seconds have elapsed, select the Printix Print  icon.
• A computer with Printix Client must be online on the printer's network. Otherwise, nothing 

happens when the card is swiped.
2. If prompted, enter your PIN code (4 digits) on the touchscreen.

• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forget code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the  Printix App , or 
browse to the URL provided to reset your PIN code.
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Release documents at a Konica Minolta printer

1. Sign in to the printer.
• Before 60 seconds have elapsed, select the Printix Print  icon.
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2. Select the documents to release, or select Select all (the check box in the top right corner).

3. Select Print at the bottom of the screen.
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Delete documents
• Select the documents to delete and select Delete .
• Documents are automatically deleted if you do not print them within a specified period (default is 

24 hours).

Capture at a Konica Minolta printer
The capture process consists of three steps:
• Scan and upload

As soon as the document is scanned and uploaded, you are returned to the list of workflows, 
while the processing and delivery continue in the background.

• Processing
The scanned document is processed by Optical Character Recognition (OCR) and a searchable 
PDF or Microsoft Word file is created.

• Delivery
The document is sent in email, transferred to a cloud destination (OneDrive or SharePoint), or 
transferred to a Connector destination.

1. Sign in to the printer.

2. Select the Printix Capture  icon.
A list of capture workflows appears.
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3. Select the appropriate workflow.
If you are signed in with the System manager role, the Active information (Yes or No) is 
displayed.

4. Confirm the details of the workflow and place the document in the printer:
• Place multi-page documents in the Automatic Document Feeder (ADF).

Ensure pages are in the correct order.
• Place one-page documents on the printer's flatbed glass.

Scanning multiple pages from the flatbed glass is not supported.
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5. Select Start to start scanning.
• As soon as the document is scanned and uploaded, you are returned to the list of workflows, 

while the processing and delivery continue in the background.
• If you do not want to start the scan, select X to cancel and return to the list of workflows.

Sign out from a Konica Minolta printer
You can sign out from the printer using these methods:
• Automatic sign-out if no activity.

• If the printer does not register key presses or touchscreen activity for a set amount of time, 
you are signed out automatically.

• Select the printer's Access button.

Swiping your card at the printer's card reader to sign out is not recommended, because the printer 
cannot detect if the card belongs to an already signed in user.

Register card on a Konica Minolta printer
You can register multiple cards. When your card is registered, the date and time of the registration 
is recorded together with the card number. If different card readers are used, the same card can be 
registered with different formats (card numbers). In this situation, you can register the same card 
with each type of card reader.

1. Swipe the card at the card reader on the printer.
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A 6-digit card registration code appears. The code is valid for 1 hour.

2. Register your card using one of the following methods:
• Scan the QR code with the camera on your phone.
• Scan the QR code with the Printix App on your phone.
• Register the card without a phone .

Make a note of the 6-digit card registration code and enter it later in the web Printix App on 
your computer.
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Scan the QR code with the camera on your phone
1. Use the camera on your phone or tablet to scan the QR code displayed on the printer's 

touchscreen.
Scanning the QR code opens the web Printix App in your browser and registers the card. You 
may be prompted to sign in to the web Printix App.
• With iOS/iPadOS 11 or higher, you can use the camera to scan the QR code.
• With the Google application installed on your Android phone or tablet, you can perform a 

Google screen search to scan the QR code.
• If your QR scanner app (not part of Printix) prompts you to open the link in a browser, select 

that option.
2. Select Close.

Scan the QR code with the Printix App on your phone
If you are using the Printix App on your phone or tablet, you can:

1. Open the Printix App for Android or iOS/iPadOS.
2. Select Menu  > Cards and codes.
3. Select Register card.
4. Select Scan , then point the camera to the QR code displayed on the printer's touchscreen.

Alternatively, you can enter the 6-digit card registration code you saw previously and select
Save.

Sign in as guest on a Konica Minolta printer
1. On the sign-in page, select Guest  in the upper right of the printer's touchscreen control 

panel.
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2. Select a function to use, such as Copy if that is available.

How to set up scan settings on Konica Minolta printers
Scan settings of Printix Capture workflows are independent from the printer. Users can select scan 
settings that might not be supported by the printer, which means that the printer might override 
the requested scan parameters to complete the workflow.

The Printix workflow settings cover only a subset of the scan features that the printer has. This 
implies that the printer simplifies some settings when they are applied. The most affected settings 
are the paper feeding options and also the orientation to some extent.

Printix queries the available scan capabilities from the printer. When a scan request is made, 
each scan setting (other than "Select automatically") is checked whether it is supported by the 
capabilities of the printer. When a scan setting is not supported, two things can happen:
• For the 2-sided and Orientation settings, the default settings are used.
• For other settings, the closest values are used that are higher than the requested ones.

Paper feeding options
The Konica Minolta platform supports short edge feeding for all paper sizes, but on certain low-end 
printer models, long edge feeding is only allowed for A4 and Letter size papers. To avoid losing data 
in the output image, short edge feeding is required.

 Images that are scanned from the glass may come out upside down. This behavior is model-
specific. To avoid misoriented images, use the auto-rotate feature of the OCR engine.

Select automatically
If either "Orientation" or "Paper size" is set to "Select automatically", the printer automatically sets 
proper values for scanning.

How to set up scan to email on Konica Minolta printers
After configured, you can sign in to the printer, select the Scan or Scan/Fax function.

Use the below steps to setup scan to email so users can scan and send emails to your company's 
Microsoft 365 or Office 365 mailboxes. The steps are in accordance with option 2, as described in 
Microsoft documentation: How to set up a multifunction device or application to send email using 
Microsoft 365 or Office 365.

 Printix Go installation (including update and uninstall) and use of Printix Go on printer's 
touchscreen control panel (including sign in and print) is likely to fail and result in error messages
if an administrator is signed in to the printer's web pages at the same time.

1. Open a new browser window and sign in to Microsoft 365 admin center (admin.microsoft.com).
2. On the navigation menu, select Show all.
3. Select Settings and then Domains.
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4. On the DNS records tab, select your domain.
Example:  acme.com

5. Write down the MX record POINTS TO ADDRESS value.
You need the MX record in step 9.
Example:  acme-com.mail.protection.outlook.com

6. Open the printer's web page and log in as administrator.
7. Select Network in the main menu.
8. In E-mail Setting, select E-mail TX (SMTP).
9. On the E-mail TX (SMTP) page:

• In SMTP Server Address, select Please check to enter host name and type the value you 
obtained in step 5.
Example: acme-com.mail.protection.outlook.com

• In Port Number, leave the value at 25.
• In Use SSL/TLS, select Start TLS.
• In Port No.(SSL), set the value to 465 or 587.
• In POP before SMTP, select OFF.
• If SMTP Authentication is selected, clear it.

10. Select OK.
After a few seconds, the message appears: Completed.

11. Select OK.
12. Remember to select Logout and then select OK to exit the printer's web pages, because 

otherwise, use of printer's touchscreen control panel (including sign-in and print) is likely to fail 
and result in error messages.

480



Tungsten Printix Administrator Guide


• Email might be sent to recipients' junk mail folders. To avoid this, go to your domain 

registrar's website to update your DNS records. Edit your sender policy framework (SPF) 
record to include your public IP address. See the Microsoft documentation: Step-by-step 
instructions for direct send.

• If your email did not arrive, remember to check your spam/junk mail folder. See also: How 
to troubleshoot scan to email.

Me button and Email sender
The Konica Minolta Email function features a Me button. Select this to scan to yourself. As you are 
signed in with Printix, your email address is automatically prefilled in the To and From fields.

Some SMTP servers will reject sending the scanned documents if the email sender (From field) 
does not have a specific value. To work around this, you can specify the Email sender in the Go 
configuration. However, this means the Me button will also have the To field configured with this 
email address, and therefore will not work as intended. In this case, you either have to select the 
receiver from the printer's Address book or you have to enter the receiver email address on the 
printer's control panel.

Another possible work-around to get the Me button working is to:
1. Open the printer's web page and log in as administrator.
2. Select Security in the main menu.
3. Select Restrict User Access.
4. In Registering and changing addresses, select Allow.
5. In Changing the "from" address, select Admin. E-mail Address to prohibit the change of 

"From" address and use the administrator's address.

How to sign in as guest on Konica Minolta printers
Follow these steps to sign in as guest on Konica Minolta printers when Printix Go is installed.

1. On the sign-in page, select Guest  in the upper right of the printer's touchscreen control 
panel.
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2. Select a function to use, such as Copy if that is available.
The accessible functions depend on the Access control settings in the Go configuration. Sign-
in as guest is not available if all functions, including Everything else, are locked.

Function Access control unlocked Access control locked

Copy As guest Only Printix signed in user

Email As guest Only Printix signed in user

Scan As guest Only Printix signed in user

Fax As guest Only Printix signed in user

Print from USB Drive As guest Only Printix signed in user

Scan to USB Drive As guest Only Printix signed in user

Everything else As guest Only Printix signed in user

How to remotely access control panel on Konica Minolta printers

Enable remote access on the printer
1. Open the printer's web page and log in as administrator.
2. Select Network in the main menu.
3. In Remote Panel Settings, select Remote Panel Server Settings.
4. Change Server Setting from NO to YES to enable remote access to the control panel.

Make a note of the Port No.(SSL) (50443).
5. Select OK.

482



Tungsten Printix Administrator Guide

Remotely access the printer’s control panel
Open a web browser and enter the printer's IP address (Example: https://192.168.1.10) followed 
by :50443/panel/top.html as in the following example:
https://192.168.1.10:50443/panel/top.html

Printix Go Kyocera - How to
How to sections for Kyocera:
• How to prepare Kyocera printer for Printix Go
• How to use Printix Go on Kyocera printers
• How to change the language of a Kyocera printer
• How to set inactivity timeout on Kyocera printers
• How to set up scan to email on Kyocera printers
• How to sign in as guest on Kyocera printers
• How to remotely access control panel on Kyocera printers
• How to set up SSL/TLS communication on Kyocera printers

See also:
• Printix Go troubleshooting

How to prepare Kyocera printer for Printix Go

Download the Kyocera ZIP file
1. Open the Software  page.
2. Scroll to the Printix Go section and select Kyocera (ZIP) to download it.
3. Unpack the downloaded ZIP file.

The unpacked folder contains two package files, which you will need later for installation.

Install Printix Go Kyocera with KYOCERA Net Viewer
Printix Go Kyocera is installed with the Kyocera application KYOCERA Net Viewer obtained from the 
Kyocera website. We recommend to always use the latest version of the KYOCERA Net Viewer.

1. Make sure the printer is powered on and ready.
2. Run the KYOCERA Net Viewer.
3. Use the Add devices wizard to add the necessary printers. To open the wizard, in the Device

menu, select Discovery and then Add devices.
4. Follow the Add devices wizard.

In Communication Settings, the following must be configured:
• Select the check box for TLS.
• Set a Login User Name and a Password.
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5. Select the printers where Printix Go Kyocera is to be installed.
6. In the Device menu, select Applications.
7. Select Install New, browse to the package files that you saved in step 3, then select the file 

with PrintixGoPrint in its name.
8. Optionally, if you want to use capture functionality, select Install New again, browse to the 

same package files, then select the file with PrintixGoCapture in its name.
9. Activate both applications without a license key.

10. Install Printix Go to configure Printix Go to work with your Printix Home.

How to uninstall Printix Go from a Kyocera printer
Printix Go must be uninstalled from both the Printix Administrator and the KYOCERA Net Viewer.

1. Uninstall Printix Go from the Printix Administrator.
2. Run the KYOCERA Net Viewer.
3. In the Device menu, select Applications.
4. Uninstall the Printix Go print and capture applications.

You only need to uninstall capture if you installed it in step 8.

How to update Printix Go Kyocera
1. Uninstall Printix Go as described above.

Printix Go is uninstalled from both the Printix Administrator and the KYOCERA Net Viewer.
2. Download the latest version of the Kyocera ZIP file.
3. Reinstall Printix Go in both the KYOCERA Net Viewer and in Printix Administrator as described 

above.
Use the newly downloaded Kyocera ZIP file for the installation in the KYOCERA Net Viewer.

How to use Printix Go on Kyocera printers
• Sign in with an ID code at a Kyocera printer
• Sign in with card at a Kyocera printer
• Release documents at a Kyocera printer
• Capture at a Kyocera printer
• Sign out from a Kyocera printer
• Register card on a Kyocera printer
• Sign in as guest on a Kyocera printer

See also:
• How to manage cards
• How to reset the ID code or PIN code
• How to see and reset the ID code
• How to create and reset the PIN code
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Sign in with an ID code at a Kyocera printer
1. Enter your ID code (6 digits) on the touchscreen.

• Select the Eye  to see the digits entered.
• If you do not know your ID code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your ID code.

2. Enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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Sign in with card at a Kyocera printer
1. Swipe your card at the card reader on the printer.
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2. If prompted, enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.

Release documents at a Kyocera printer
1. Sign in to the printer.
2. Select the Printix Print  icon.
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3. Select the documents to release, or select Select all (the check box in the top right corner).

4. Select Print at the bottom of the screen.
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Delete documents
• Select the documents to delete and select Delete .
• Documents are automatically deleted if you do not print them within a specified period (default is 

24 hours).

Capture at a Kyocera printer
The capture process consists of three steps:
• Scan and upload

As soon as the document is scanned and uploaded, you are returned to the list of workflows, 
while the processing and delivery continue in the background.

• Processing
The scanned document is processed by Optical Character Recognition (OCR) and a searchable 
PDF or Microsoft Word file is created.

• Delivery
The document is sent in email, transferred to a cloud destination (OneDrive or SharePoint), or 
transferred to a Connector destination.

1. Sign in to the printer.
2. Select the Printix Capture  icon.

A list of capture workflows appears.
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3. Select the appropriate workflow.
If you are signed in with the System manager role, the Active information (Yes or No) is 
displayed.

4. Confirm the details of the workflow and place the document in the printer:
• Place multi-page documents in the Automatic Document Feeder (ADF).

Ensure pages are in the correct order.
• Place one-page documents on the printer's flatbed glass.

Scanning multiple pages from the flatbed glass is not supported.
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5. Select Start to start scanning.
• As soon as the document is scanned and uploaded, you are returned to the list of workflows, 

while the processing and delivery continue in the background.
• If you do not want to start the scan, select X to cancel and return to the list of workflows.

Sign out from a Kyocera printer
You can sign out from the printer using these methods:
• Automatic sign-out if no activity.

• If the printer does not register key presses or touchscreen activity for a set amount of time, 
you are signed out automatically.

• Select Sign out on the printer's Home screen.
• To access the printer's Home screen, select the Home button.

• Swipe your card at the card reader on the printer.
• If you were already signed in, you are signed out. If another user was signed in, that user is 

signed out and you must swipe your card again to sign in.

Register card on a Kyocera printer
You can register multiple cards. When your card is registered, the date and time of the registration 
is recorded together with the card number. If different card readers are used, the same card can be 
registered with different formats (card numbers). In this situation, you can register the same card 
with each type of card reader.

1. Swipe the card at the card reader on the printer.
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A 6-digit card registration code appears. The code is valid for 1 hour.

2. Register your card using one of the following methods:
• Scan the QR code with the camera on your phone.
• Scan the QR code with the Printix App on your phone.
• Register the card without a phone.

Make a note of the 6-digit card registration code and enter it later in the web Printix App on 
your computer.

Scan the QR code with the camera on your phone
1. Use the camera on your phone or tablet to scan the QR code displayed on the printer's 

touchscreen.
Scanning the QR code opens the web Printix App in your browser and registers the card. You 
may be prompted to sign in to the web Printix App.
• With iOS/iPadOS 11 or higher, you can use the camera to scan the QR code.
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• With the Google application installed on your Android phone or tablet, you can perform a 
Google screen search to scan the QR code.

• If your QR scanner app (not part of Printix) prompts you to open the link in a browser, select 
that option.

2. Select Close.

Scan the QR code with the Printix App on your phone
If you are using the Printix App on your phone or tablet, you can:

1. Open the Printix App for Android or iOS/iPadOS.
2. Select Menu  > Cards and codes.
3. Select Register card.
4. Select Scan , then point the camera to the QR code displayed on the printer's touchscreen.

Alternatively, you can enter the 6-digit card registration code you saw previously and select
Save.

Sign in as guest on a Kyocera printer
1. On the sign-in page, select Guest  in the upper right of the printer's touchscreen control 

panel.

2. Select a function to use, such as Copy if that is available.

How to change the language of a Kyocera printer
1. Sign in to the printer's web page as an administrator.
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2. Select Device Settings and System in the menu.
3. In General, set the preferred Language, then select Submit.

The language does not change immediately in two scenarios:
• If a user is not signed in to the printer, select the refresh icon  on the printer to update the 

language.
• While a user is releasing documents from the printer, go back to the home screen to update 

the language.

How to set inactivity timeout on Kyocera printers
1. Open the printer's web page and log in as an administrator.
2. In Device Settings, select Energy Saver/Timer.
3. In Panel Reset Timer under Timer Settings, enter the number of seconds.

The default is 90 seconds.
4. Select Submit.

 During card registration on Kyocera printers, the printer screen does not reset even after 
a timeout occurs, which can be a security issue.

How to set up scan settings on Kyocera printers
Scan settings of Printix Capture workflows are independent from the printer. Users can select scan 
settings that might not be supported by the printer, which means that the printer might override 
the requested scan parameters to complete the workflow.

The Printix workflow settings cover only a subset of the scan features that the printer has. This 
implies that the printer simplifies some settings when they are applied. The most affected settings 
are the paper feeding options and also the orientation to some extent.

Printix queries the available scan capabilities from the printer. When a scan request is made, each 
scan setting (other than Select automatically) is checked whether it is supported by the capabilities 
of the printer. When a scan setting is not supported, the following things can happen:
• For Orientation, Portrait is used if Auto is not supported, and if Portrait or Landscape is not 

supported, the other setting is used.
• For Paper size, the closest supported paper width is used from the same oriented paper sizes.
• For Color, Grey is used if Color is not supported, and Black and white is used if Grey is not 

supported.
• For Resolution, the closest value is used. If two values are the closest, the higher value is used.
• For Duplex, if 2-sided is not supported, 1-sided is used.

Paper feeding options
If you scan a two-sided document, add the paper to the Automatic Document Feeder (ADF). If you 
scan a one-sided document, put the paper on the glass.
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Select automatically
If either Orientation or Paper size is set to Auto, the printer automatically sets proper values for 
scanning.

How to set up scan to email on Kyocera printers
Use the below steps to set up scan to email so users can scan and send emails to your company's 
Microsoft 365 or Office 365 mailboxes. The steps are in accordance with option 2, as described in 
Microsoft documentation: How to set up a multifunction device or application to send email using 
Microsoft 365 or Office 365.

1. Open a new browser window and sign in to Microsoft 365 admin center
(admin.microsoft.com).

2. On the navigation menu, select Show all.
3. Select Settings and then Domains.
4. On the DNS records tab, select your domain.

Example:  acme.com
5. Write down the MX record POINTS TO ADDRESS value.

You need the MX record in step 8.
Example:  acme-com.mail.protection.outlook.com

6. Open the printer's web page and log in as administrator.
7. In the Function Settings menu, select E-mail.
8. In SMTP, make the following changes:

• In SMTP Server Name, enter the value you obtained in step 5.
Example: acme-com.mail.protection.outlook.com

• In SMTP Port Number, leave the value at 25.
• In Authentication Protocol, select Off.

9. Under E-mail Send Settings for SMTP Authentication and Sender Address, select one of the 
following:
• Use Device Setting: The printer fills in the From address with the address you enter in

Sender Address.
• Use Login User Information: The printer fills in the From address with the address of the 

signed in user.
10. Select Submit.
11. In SMTP, select Test to test your connection.
12. After the test is finished, select OK.
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• Emails might be sent to the recipients' junk mail folder. If your email did not arrive, 

remember to check the spam/junk mail folder. See also: How to troubleshoot scan to 
email.

• To avoid this, go to your domain registrar's website to update your DNS records. Edit your 
sender policy framework (SPF) record to include your public IP address. See the Microsoft 
documentation: Step-by-step instructions for direct send.

How to sign in as guest on Kyocera printers
1. On the sign-in page, select Guest  in the upper right of the printer's touchscreen control 

panel.

2. Select a function to use, such as Copy if that is available.
The accessible functions depend on the Access control settings in the Go configuration. 
Signing in as a guest is not available if all functions, including Everything else, are locked.

How to remotely access control panel on Kyocera printers
1. Open the printer's web page and log in as administrator.
2. In the Network Settings menu, select Protocol.
3. Make sure Enhanced VNC (RFB) over SSL is turned on.
4. Download and install VNC Viewer from the Internet.
5. In VNC Viewer, select the File menu and then New connection.
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6. In VNC Server, enter the IP address or the hostname of the Kyocera printer you wish to access.
If you enter the IP address, also enter the port of the printer: {IP.address}:{port}.

7. Select OK.
The printer appears in VNC Viewer.

8. Double-click the printer you wish to remotely access.

How to set up SSL/TLS communication on Kyocera printers
To be able to install and uninstall Printix Go on Kyocera printers, SSL/TLS communication must be 
configured correctly.

These steps are safety requirements. Printers without a correctly configured SSL/TLS 
communication are not supported.

1. Open the printer's web page and log in as administrator.
2. On the menu, select Security Settings, and then Network Security.

• In SSL, On should be selected by default.
• In TLS Version for both Serverside Settings and Clientside Settings, make sure TLS1.2 and

TLS1.3 are selected.
Printix Go uses the highest level of TLS that the device supports. If the device does not 
support TLS 1.3, the communication falls back to TLS 1.2.

3. Select OK.

Printix Go Lexmark - How to
How to sections for Lexmark:
• How to prepare Lexmark printer for Printix Go
• How to use Printix Go on Lexmark printers
• How to set inactivity timeout on Lexmark printers
• How to set up scan to email on Lexmark printers
• How to remotely access control panel on Lexmark printers
• How to reset to factory settings on Lexmark printers
• How to find the card reader IDs on Lexmark printers
• How to get Lexmark logs

See also:
• Printix Go troubleshooting

How to prepare Lexmark printer for Printix Go

Create a local admin account on the printer
1. Open the printer's web page and sign in as administrator.
2. On the menu, select Settings.
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3. Select Security.
4. Select Login Methods.
5. In the Local Accounts section, select Add User.
6. Select User Name/Password.
7. In the Edit User Name/Password Account dialog box, enter the user information.
8. In Permissions Groups, select Admin.

• It is the same account you need to reference in the Sign in profile .
• If another permission group is used than Admin, you must ensure that Access Controls as 

a minimum has Security Menu selected under Administrative Menus and Import / Export 
All Settings selected under Device Management.

9. Select Save.

Enable HTTPS through the printer’s web page
1. Open the printer's web page and sign in as administrator.
2. On the menu, select Settings.
3. Select Network/Ports.
4. Select HTTP/FTP Settings.
5. Select Enable HTTPS.
6. Select Save.

How to use Printix Go on Lexmark printers
• Sign in with an ID code at a Lexmark printer
• Sign in with card at a Lexmark printer
• Release documents at a Lexmark printer
• Sign out from a Lexmark printer
• Register card on a Lexmark printer

See also:
• How to manage cards
• How to reset the ID code or PIN code
• How to see and reset the ID code
• How to create and reset the PIN code

Sign in with an ID code at a Lexmark printer
1. Enter your ID code (6 digits) on the touchscreen.

• Select the Eye  to see the digits entered.
• If you do not know your ID code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your ID code.
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2. Enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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Sign in with card at a Lexmark printer
1. Swipe your card at the card reader on the printer.

• Before 60 seconds have elapsed, select the Printix Print  icon.
• A computer with Printix Client must be online on the printer's network. Otherwise, nothing 

happens when the card is swiped.
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2. If prompted, enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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Release documents at a Lexmark printer
1. Sign in to the printer.
2. Before 60 seconds have elapsed, select the Printix Print  icon.
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3. Select the documents to release, or select Select all (the check box in the top right corner).

4. Select Print at the bottom of the screen.
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Delete documents
• Select the documents to delete and select Delete .
• Documents are automatically deleted if you do not print them within a specified period (default is 

24 hours).

Sign out from a Lexmark printer
You can sign out from the printer using these methods:
• Automatic sign-out if no activity.

• If the printer does not register key presses or touchscreen activity for a set amount of time, 
you are signed out automatically.

• Select Sign out on the printer's Home screen.
• To access the printer's Home screen, select the Home button.

• Swipe your card at the card reader on the printer.
• If you were already signed in, you are signed out. If another user was signed in, that user is 

signed out and you must swipe your card again to sign in.

Register card on a Lexmark printer
You can register multiple cards. When your card is registered, the date and time of the registration 
is recorded together with the card number. If different card readers are used, the same card can be 
registered with different formats (card numbers). In this situation, you can register the same card 
with each type of card reader.

1. Swipe the card at the card reader on the printer.

A 6-digit card registration code appears. The code is valid for 1 hour.
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Make a note of the 6-digit card registration code and enter it later in the web Printix App on 
your computer.

2. Register your card using one of the following methods:
• Scan the QR code with the camera on your phone.
• Scan the QR code with the Printix App on your phone.
• Register the card without a phone.

Scan the QR code with the camera on your phone
1. Use the camera on your phone or tablet to scan the QR code displayed on the printer's 

touchscreen.
Scanning the QR code opens the web Printix App in your browser and registers the card. You 
may be prompted to sign in to the web Printix App.
• With iOS/iPadOS 11 or higher, you can use the camera to scan the QR code.
• With the Google application installed on your Android phone or tablet, you can perform a 

Google screen search to scan the QR code.
• If your QR scanner app (not part of Printix) prompts you to open the link in a browser, select 

that option.
2. Select Close.

Scan the QR code with the Printix App on your phone
If you are using the Printix App on your phone or tablet, you can:

1. Open the Printix App for Android or iOS/iPadOS.
2. Select Menu  > Cards and codes.
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3. Select Register card.
4. Select Scan , then point the camera to the QR code displayed on the printer's touchscreen.

Alternatively, you can enter the 6-digit card registration code you saw previously and select
Save.

How to set inactivity timeout on Lexmark printers
1. Open the printer's web page and log in as administrator.
2. On the menu, select Settings.
3. Select Device.
4. Change Screen Timeout to the number of seconds you want the timeout to be.

The default is 60 seconds.
5. Select Save.

How to set up scan to email on Lexmark printers
Use the below steps to set up scan to email so users can scan and send emails to your company's 
Microsoft 365 or Office 365 mailboxes. The steps are in accordance with option 2, as described in 
Microsoft documentation: How to set up a multifunction device or application to send email using 
Microsoft 365 or Office 365.

1. Open a new browser window and sign in to Microsoft 365 admin center
(admin.microsoft.com).

2. On the navigation menu, select Show all.
3. Select Settings and then Domains.
4. On the DNS records tab, select your domain.

Example:  acme.com
5. Write down the MX record POINTS TO ADDRESS value.

You need the MX record in step 9.
Example:  acme-com.mail.protection.outlook.com

6. Open the printer's web page and log in as administrator.
7. On the menu, select Settings.
8. Select E-mail.
9. Select E-mail Setup.

• In Primary SMTP Gateway, type the value you obtained in step 5.
Example: acme-com.mail.protection.outlook.com

• In Primary SMTP Gateway Port, leave the value at 25.
• In Use SSL/TLS, select Negotiate.
• In SMTP Authentication, select No authentication required.
• In User-Initiated Email, select User Session E-mail address and Password.
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10. Select Save.

507



Tungsten Printix Administrator Guide


• Email might be sent to recipients' junk mail folders. To avoid this, go to your domain 

registrar's website to update your DNS records. Edit your sender policy framework (SPF) 
record to include your public IP address. See the Microsoft documentation: Step-by-step 
instructions for direct send.

• If your email did not arrive, check your spam/junk mail folder. See also: How to 
troubleshoot scan to email.

How to sign in as administrator on Lexmark printers

 This functionality requires Printix Go Lexmark version 2.0.0.5.

Follow these steps to sign in as an administrator on Lexmark printers when Printix Go is installed.
1. On the sign-in page, touch the Printix bar on top of the printer's touchscreen five times.

The printer's login page appears.
2. Select the drop-down menu and change the LOGIN METHOD from Printix to User Name/

Password.
3. Enter User Name on the touchscreen.
4. Enter Password on the touchscreen.
5. Select Log In to log in as an administrator.

How to remotely access control panel on Lexmark printers
1. Open the printer's web page and log in as administrator.
2. In the Settings menu, select Device.
3. Select Remote Operator Panel.
4. In Launch Remote Operator Panel, select Launch.

How to reset to factory settings on Lexmark printers
1. Open the printer's web page and log in as administrator.
2. On the menu, select Settings.
3. Select Device.
4. Select Restore Factory Defaults.
5. Select Restore all settings.
6. Select Start.

This will restart the printer, restore all printer settings, fax settings, network settings, and app 
settings to their factory default configurations, and remove all non-standard apps.

7. Select Start.
The printer will restart.

8. Set date and time.
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How to find the card reader IDs on Lexmark printers
1. Connect the card reader to the USB port on the Lexmark printer.
2. Open the printer's web page by entering the printer's address followed by /se.

Example:  192.168.1.10/se
3. Select Embedded Solutions.
4. Select USB Information to see the below information about the card reader:

• Name
• Vendor ID
• Product ID
• Serial number

 Printix may have issues registering card readers if Keyboard Emulation Reader Driver is 
installed on the printer. Seen with Elatec (VID 0×09D8, PID 0×0410).

How to get Lexmark logs
1. Open the printer's web page by entering the printer's address followed by /se.

Example:  192.168.1.10/se
2. Select Embedded Solutions.
3. Select Set Logging level, then Yes, and then Submit.
4. Select Go back to main menu to return to the Embedded Solutions page.
5. Select Clear Log File, then Yes, and then Submit.
6. Attempt to reproduce the issue.
7. On the Embedded Solutions page, select Log File.

The log will be shown in the web browser, it can copied to a .txt file and then saved/sent.

Printix Go Ricoh - How to
How to sections for Ricoh:
• How to install Printix Go on a Ricoh printer without using the Printix Client
• How to set inactivity timeout on Ricoh printers
• How to use Printix Go on Ricoh printers
• How to set up scan settings on Ricoh printers
• How to set up scan to email on Ricoh printers
• How to install card reader on Ricoh printers
• How to set up SSL/TLS communication on Ricoh printers
• How to sign in as machine administrator on Ricoh printers
• How to sign in as guest on Ricoh printers
• How to remotely access control panel on Ricoh printers
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• How to get logs from Ricoh printers

See also:
• How to use Single Sign-On with Ricoh Adaptable Authentication API
• Printix Go troubleshooting

How to install Printix Go on a Ricoh printer without using the Printix 
Client

Printix Go Ricoh can be used to release documents from the cloud without the required presence of 
a computer running Printix Client.

Ricoh printers in clientless mode must be added using manual registration or added with Printix 
Configurator. This is because the Discover printers function cannot be used. Once added, proceed 
to install Printix Go Ricoh using the supplied command line tool Printix Go Ricoh Installer for 
Windows. This will also set the required SP modes on the printer. Alternatively, a Ricoh technician 
can set the documented SP modes on the printer, install the supplied Printix Go Ricoh files via the 
printer's web page, and then restart the printer.

Requirements
• In your Cloud storage settings, ensure that "Store Print Anywhere documents" and "Store Print 

Later documents" are selected.
• Ricoh printers and MFPs that support Ricoh SOP (Smart Operating Platform) Generation 2.5 or 

later. Ricoh printers and MFPs are also supported when sold under the Gestetner, Infotec, Lanier, 
NRG, and Savin brands.
• We highly recommend to use the latest firmware version.

• Printer's date and time must match the local time.
• Printer administrator password must be set and cannot be blank.
• Printer's DNS server must be configured.
• SSL/TLS must be enabled for IPv4 on the printer and communication must be set to Ciphertext/

Cleartext.
• HTTP for Port 80 for IPv4 must be open.
• Printix Go Ricoh version 2.1.3.17 or higher.
• Printix Go Ricoh Installer for Windows version 2.1.3.17 or higher.

• In addition to the required internet endpoints, these must also be unblocked to allow Printix Go 
to communicate with the Printix Cloud (how to test):
• https://device-api.printix.net
• https://on-device-api.printix.net
• https://on-device-printer-sign-in.printix.net
• https://on-device-printer-release-documents.printix.net

• If Universal Print by Microsoft is used:
• Universal Print subscription, which is assigned to your account.
• Printer administrator or global administrator role in Microsoft Entra ID.
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• Configure a printer in Microsoft Entra ID to print documents as PDF.

Third-party application dependencies
• Adaptable Authentication API (AAA) 2.1.0 Ricoh SmartSDK
• RXOP 3.8.9

• RXSP servlet 3.8.8 or 1.3 depending on printer configuration

Limitations
• Generation 2 or older printers and MFPs do not support installation without the Printix Client.
• The "Verify sign in profile" button in Printix Administrator does not work without Printix Client.
• Changes to sign-in method, email sender, and access control parameters do not take effect 

without reinstalling Printix Go.
• Direct printing and reprinting are not supported.
• If the user actively signs out of the printer while printing documents (by pressing the Sign out

button or by presenting a card to the printer), only those documents are printed that the printer 
already started printing. (While documents are being printed, the user cannot be signed out 
passively due to a timeout or inactivity.) When the user signs in again, the unprinted documents 
are still in the print queue, so they can be printed again.

• Capture is not supported.
• It is not possible to release documents through the Printix Cloud Print API.
• Printer status, toner levels, and meter readings are not reported.
• Registration parameters must be entered manually to contact the printer.
• Release of documents is not supported for Printix App on your phone, tablet, or computer.
• Printix Go Ricoh Installer is not available for macOS (use a Windows computer instead).

 The printed document must be in PDF, PCL, or PostScript format. Refined Printing Command 
Stream (RPCS) is not supported.

Next steps
• Verify that your printer is supported.
• Prepare Printix Go Ricoh files for installation.

This involves downloading and extracting files and modifying the DALP file.
• Create a designated network.
• Manual registration of printer.
• Create Sign in profile and Go configuration.
• Install Printix Go. Select one of the below methods:

• Using Printix Go Ricoh Installer for Windows running on a Windows computer on the 
designated network.

• Via the printer's web page. Requires a Ricoh technician to set the documented SP modes on 
the printer, install the supplied Printix Go Ricoh files via the printer's web page, and then 
restart the printer.

• Configure a printer in Microsoft Entra ID to print documents as PDF.
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See also:
• Troubleshooting

Prepare Printix Go Ricoh files for installation
• Obtain Client ID, Client Secret, and Tenant ID
• Download Printix Go Ricoh file
• Modify the Printix Go Ricoh DALP file

Obtain Client ID, Client Secret, and Tenant ID
1. Open the Software page.
2. Select Printix Cloud Print API.
3. In Name, type a name.

Example:  GoCloud
The name you enter will appear as a user on the Users page and with the role Cloud Print API 
user. Deleting this user revokes the matching Client ID / Client Secret pair, which means the
DALP file can no longer be used for installation.

4. Select I accept and select Submit to get the Client ID, Client Secret, and Tenant ID for the 
required modification of the Printix Go Ricoh DALP file.
• Select the Client ID value to copy it to the clipboard and save it so it can be entered in step 4

of modifying the DALP file.
• Select the Client Secret value to copy it to the clipboard and save it so it can be entered in 

step 5 of modifying the DALP file.
• Select the Tenant ID value to copy it to the clipboard and save it so it can be entered in step

6 of modifying the DALP file.

Download Printix Go Ricoh file
1. Open the Software page.
2. Scroll to the Printix Go section at the bottom and select Ricoh (ZIP) to download it.
3. Extract all files from the ZIP file to a convenient location on your computer.

Modify the Printix Go Ricoh DALP file
1. Open the DALP file with a text editor, such as Notepad.
2. In the app-extension section at the bottom, add additional tags and enter values relevant to 

your Printix Home.
3. Add EnableRegistration and give it the value true.
4. Add ClientID and paste the value you obtained in step 4.

Example:  236b1f58-adab-4888-ba05-acfc9a804523
5. Add ClientSecret and paste the value you obtained in step 4.

Example:  gR6tGBiQnaHiOEEXL6di4CLc8dOZALnLb4FhAOxip3D1nD47
6. Add TenantId and paste the value you obtained in step 4.

Example:  cbd7e0b5-da2a-4cb6-b7f7-a04ee31cac90
7. Add TenantUrl and paste its value.

Example:  https://acme.printix.net
8. Save the modified DALP file.
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9. Create a new ZIP file that includes the modified DALP file and the original APK file and give it 
another name.
You can include the text "modified" at the end of the name.
Example:  Example of a modified DALP file:
Example of a modified DALP file:
<?xml version="1.0" encoding="utf-8"?>
<dalp spec="3.0" version= "1.0" href="printix-go-ricoh.dalp"> 
    <product-id>1667825665</product-id> 
    <information> 
        <title>Printix Go</title> 
        <vendor>printix.net</vendor> 
        <application-ver>201.3.17</application-ver> 
    </information> 
    <information locale="en_US"> 
        <title>Printix Go</title> 
        <vendor>printix.net</vendor> 
        <application-ver>201.3.17</application-ver> 
        <description type="outline">Printix Go app</description> 
        <e-mail>support@printix.net</e-mail> 
    </information> 
    <resources> 
        <apk href="./printix-go-ricoh.apk"/> 
    </resources> 
    <apk_app_info> 
        <need_reboot>false</need_reboot> 
        <need_activate>false</need_activate> 
    </apk_app_info> 
    <dalpfile-save save= "true"/> 
    <app-extension> 
      <ClientVersion>2.1.3.17</ClientVersion> 
      <EnableRegistration>true</EnableRegistration>    
      <ClientID>236b1f58-adab-4888-ba05-acfc9a804523</ClientID>  
      <ClientSecret>gR6tGBiQnaHiOEEXL6di4CLc8dOZALnLb4FhAOxip3D1nD47</
ClientSecret>  
      <TenantId>cbd7e0b5-da2a-4cb6-b7f7-a04ee31cac90</TenantId>    
      <TenantUrl>https://acme.printix.net</TenantUrl>   
    </app-extension>
</dalp>

Create a designated network
1. Open the Networks page.
2. Select Add network .
3. In the Create new network dialog box, enter a Network name.

Example:  No Printix Client Network
4. Select OK.
5. Select Network name or select  and Modify to open Network properties.
6. Select Add gateway.
7. In the Add gateway dialog box:

• Enter IP address.
Example: 0.0.0.0

• Enter MAC.
Example: 000000000000
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 If you need to create multiple networks, you can continue to give them IP address 0.0.0.0, 
but you need to give a different MAC.
Example: No Printix Client Network 1, IP address: 0.0.0.0, MAC: 000000000001

All printers you add to the designated network must be added with the methods described in 
this topic.

Manual registration of printer
1. Open the Printers page.
2. Select Add printer .
3. In Network, select the Modify  icon to select the network (such as "No Printix Client 

Network") where the printer is. Select Select network.
4. In Printer address, enter the IP address (such as 192.168.1.9) or hostname of the printer.
5. Select Add.

The added printer appears on the Unregistered printers page with the expected issue: No 
Printix Client acts as proxy on this network.

6. Select Unregistered printers on the Printers page.
7. Select  and Manual registration for the recently added printer that failed to register. 

Alternatively, select the printer and select Diagnose at the bottom of the screen, then select
Manual registration.

8. In the Manual registration dialog box:
• Enter Name.

Example: RICOH IM C3000
• Select Vendor.

Example: Ricoh
Alternatively, select Enter vendor name in the menu and enter the name of the vendor.

• Enter Model.
Example: RICOH IM C3000
On Ricoh, the Model name is listed on the printer's Device Info web page.

• Select Network.
Example: No Printix Client Network

• Enter IP address.
Example: 192.168.1.9
This is also the IP address/hostname that must be specified to PrintixGoRicohInstaller.exe -i 
<machine-address>.

• Enter MAC address.
Example: 0011E5040E34 or 00:11:E5:04:0E:34
On Ricoh, the Mac address is listed on the printer's Interface Settings web page.

• Enter Serial number.
Example: 3101R411098
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On Ricoh, the serial number known as the Machine ID and is listed on the printer's Device 
Info web page.

• Optionally, enter Location.
Example: Room A2, Shipping

• If relevant, select Page description language:
• PCL5: Printer Command Language level 5.
• POSTSCRIPT: PostScript Level 1, PostScript Level 2 and PostScript 3.
• PCLXL: Printer Command Language level 6.
• PDF: Portable Document Format.
• XPS: Open XML Paper Specification.
• UFRII: Ultra Fast Rendering 2, a proprietary language of Canon.

• If relevant, select Color supported
• If relevant, select 2-sided supported

9. Select Save.
If needed, you can subsequently make changes on the Printer properties page and the
Features button.

 The printer always appears with status  Ready because the status of the printer is not 
available.

Create Sign in profile and Go configuration
1. Open Printer properties and select the Printix Go tab.
2. Select Sign in profile setup  to open the Sign in profile menu.
3. Select Create sign in profile. If you have an existing sign in profile that can be used, select

Assign sign in profile instead.
• In Name, type a descriptive name for the sign in profile.
• In Username, type the username of an administrator account that can access the printer's 

web pages. The username cannot be blank.
This is also the username that must be specified to PrintixGoRicohInstaller.exe -u <admin-
user>.

• In Password, type the password of an administrator account that can access the printer's 
web pages. The password cannot be blank.
This is also the password that must be specified to PrintixGoRicohInstaller.exe -p <admin-
password>.

• In Add SNMP configuration, leave it as is.
• In Description, type an optional description for the sign in profile.

4. Select Save.
It is not possible to Verify sign in profile, because the printer is on a network without Printix 
Client.

5. Select Go configuration setup  to open the Go configuration menu.
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6. Select Create Go configuration. If you have an existing Go configuration that can be used, 
select Assign Go configuration instead.
• In Name, type a descriptive name for the Go configuration.
• In Description, type an optional description for the Go configuration.
• In Sign in method, optionally, change it from Select automatically to the method you want.
• In Go functions, ensure that Capture is cleared.
• In Access control, optionally, check the printer functions that require sign-in.

• On Ricoh, users can sign in as guest to use functions not locked by Access control.
• In Email sender, optionally, type a default sender email address, and this will be used as the 

sender rather than the email address of the signed in user doing a scan to email.
7. Select Save.

Install Printix Go using Printix Go Ricoh installer for Windows
• Download Printix Go Ricoh installer for Windows
• Install Printix Go using the Printix Go Ricoh installer

See also:
• Update Printix Go using the Printix Go Ricoh installer
• Uninstall Printix Go using the Printix Go Ricoh installer

Download Printix Go Ricoh installer for Windows
1. Open the Software page.
2. Scroll to the Printix Go section at the bottom and select Ricoh Installer (ZIP) to download it.
3. Extract all files from the ZIP file to a convenient location on your computer.

Install Printix Go using the Printix Go Ricoh installer
1. Select the Start icon and click in the Search box.
2. Type cmd into the search box.
3. Right-click Command Prompt in the search window and select Run as administrator.
4. Change directory to the folder with the extracted PrintixGoRicohInstaller.

The installation path needs to be to the ZIP file with the modified DALP file.
5. Run the command:

PrintixGoRicohInstaller.exe -i <printer-address> -u <admin-username> -p <admin-
password> -m installall -f <printix-go-ricoh-x.x.x.x.zip>

Example:  Example of output from the command:
Example of output from the command:
Deploy Printix App Printix Go(1.0.0)!
Deploy Printix App Printix Go(1.0.0) successful!

• The Printix Print icon automatically appears on the printer's touchscreen.
• A status page with configuration status is displayed during the configuration. It is closed 

upon a successful configuration, and the sign-in page is loaded.
• Shortly after the printer is automatically restarted, the printer's history is modified as 

follows: Finished install (SUCCESS).
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Update Printix Go using the Printix Go Ricoh installer
This command cannot be used to update Printix Go on printers that have Printix Capture installed. 
If you run the following command to update Printix Go on a printer connected to the Printix Client, 
the printer loses its connection to the Printix Client.

1. Run the command:
PrintixGoRicohInstaller.exe -i <printer-address> -u <admin-username> -p <admin-
password> -m reinstallapp -f <printix-go-ricoh-x.x.x.x.zip>

Example:
PrintixGoRicohInstaller.exe -i 192.168.1.9 -u admin -p 123test -m reinstallapp -f D:\printix-go-
ricoh-2.1.3.17-modified.zip

Uninstall Printix Go using the Printix Go Ricoh installer
1. Run the command:

PrintixGoRicohInstaller.exe -i <printer-address> -u <admin-username> -p <admin-
password> -m uninstall

Example:  PrintixGoRicohInstaller.exe -i 192.168.1.9 -u admin -p 123test -m uninstall
2. After the uninstallation is complete, open Printer properties and select the Printix Go tab, 

then select Uninstall.
The printer's history is modified as follows: Finished uninstall (SUCCESS).

Install Printix Go via the printer’s web page
• Ricoh technician to set the documented SP modes on the printer
• Restart the printer via the printer’s web page
• Manually install Printix Go via the printer’s web page
• Reinstall Printix Go after updating sign-in method, sender address, or access control parameters

Ricoh technician to set the documented SP modes on the printer
Change SP modes

1. Select SP Direct.
SP Direct changes color to black.

2. Press 5401230 on the keypad, then press # on the keypad.
SP Direct changes color to white.

3. Press 0 on the keypad. Press # to confirm changes.
The 0 changes to a 1.

4. Select SP Direct.
SP Direct changes color to black.

5. Press 5490001 on the keypad, then press # on the keypad.
SP Direct changes color to white.

6. Press 1 on the keypad. Press # to confirm changes.
The 0 changes to a 1.

7. Select SP Direct.
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SP Direct changes color to black.
8. Press 542041 on the keypad, then press # on the keypad.

SP Direct changes color to white.
9. Press 1 on the keypad. Press # to confirm changes.

The 0 changes to a 1.

Set administrator authentication mode
1. Sign in to the printer as an administrator.
2. Open the Settings.

It may not be on the first page of the printer.
3. Select System Settings.
4. On the left pane, select Settings for Administrator.
5. Scroll down and select Authentication/Charge.
6. Select Administrator Authentication/User Authentication/App Auth.
7. Select Administrator Authentication Management.
8. Under User Management, set Administrator Authentication to On.
9. Under Machine Management, set Administrator Authentication to On.

10. Select OK to save.

Set address book
1. Sign in to the printer as an administrator.
2. Open the Settings.

It may not be on the first page of the printer.
3. Select Address Book.
4. Select Management.
5. Scroll down and select Auto Delete User in Address Book.
6. Set it to On.
7. Select OK to save.

Set user authentication mode
1. Sign in to the printer as an administrator.
2. Open the Settings.

It may not be on the first page of the printer.
3. Select System Settings.
4. On the left pane, select Settings for Administrator.
5. Scroll down and select Authentication/Charge.
6. Select Administrator Authentication/User Authentication/App Auth.
7. Select User Authentication Management.
8. Set User Authentication Management to Custom Authentication.
9. Select OK to save.
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Restart the printer via the printer’s web page

 It is better to physically power the printer off and on.

1. Sign in to the printer's web page as an administrator.
2. On the menu, select Device Management > Reset the Machine.
3. Select OK.

Manually install Printix Go via the printer’s web page
1. Sign in to the printer's web page as an administrator.
2. On the menu, select Device Management > Configuration.
3. Under Extended Feature Settings, select Install.
4. Select Local File.
5. Select Choose File.
6. Select the ZIP file with the modified DALP file.

Example:  printix-go-ricoh-2.1.3.17-modified.zip
7. Select Display Extended Feature List.

After a few seconds, you are presented with options to install.
8. Select Printix Go.
9. Select Install.

10. Select OK to confirm.

Reinstall Printix Go after updating sign-in method, sender address, or access 
control parameters
If you only want to update the sign-in method, sender address, or access control parameters in 
Printix Administrator, you can use this method to reinstall Printix Go without needing to set your SP 
modes again.

1. Uninstall Printix Go from the printer using Printix Administrator.
2. Make your changes to the sign-in method, sender address, or access control parameters in 

Printix Administrator.
Do not select Install in Printix Administrator after you made your changes. Printix Go is 
reinstalled in a different location.

3. Manually install Printix Go via the printer's web page.
4. Restart the printer via the printer's web page.

The printer is configured with your latest updates while it is restarted.

Configure a printer in Microsoft Entra ID to print documents as PDF
This is relevant if Universal Print by Microsoft is also used. The user may otherwise receive an error 
message during printing if the printer is not configured in Microsoft Entra ID.

1. Open a browser window and sign in to Microsoft Azure (portal.azure.com), using your work 
account credentials.
You must have the global administrator role in Microsoft Entra ID.
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2. In the portal menu, select All Services.
3. In the Management and governance category, select Universal Print.
4. On the left pane, select Document conversion.
5. Verify that Document conversion is set to Enabled.
6. On the left pane, select Printers.
7. Select the printer to configure.
8. On the left pane, select Properties.
9. Select the Printer defaults tab.

10. Change the Content type to application/pdf.
11. Select Save.

Troubleshooting
• After restarting the printer, the printer's control panel displays an error code next to the printer's 

status
• Capture fails with the error: Invalid Print Secret or Permission denied
• The printer does not start printing or suddenly stops printing without displaying an error 

message
• The printer says documents are being printed, but nothing is printed, and no error message is 

displayed

After restarting the printer, the printer's control panel displays an error code 
next to the printer's status
Changes made to the printer's configuration only take effect after restarting the printer. During the 
restart, if a change cannot properly take effect, an error code appears next to the printer's status.

In the following examples, the status of the printer is Configuration aborted or Configuration 
successful with warnings.

Example:
• Status: Configuration aborted in Step: Register the device with Printix. Error Code: RGRS
• Status: Configuration finished successfully with warnings. Code: WHSMT. Press Login 

button to continue

Resolution: See the table below for the solutions of each error code.

Alternatively, if the configuration finished with warnings, you can ignore the warnings and press the
Login button to continue.

If you see an error code that is not listed, try restarting your printer. If that does not solve the 
problem, collect the error logs and contact support.
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Error code Error description Resolution

BTAU Authorization failed. Client ID
or Client Secret is incorrect. It is 
possible that you used the wrong
Tenant ID or you altered the 
values obtained in step 4.

Verify that you used the exact 
values obtained in step 4. If you 
find a mistake, restart the process 
with the correct values. Otherwise, 
generate a new Client ID, Client 
Secret, and Tenant ID.

DV1 DALP file validation error. Client 
ID or Client Secret is not in the 
correct format.

Fix the Client ID or Client Secret
to have the correct format.

DV4 DALP file validation error. Tenant 
ID is blank.

Use the Tenant ID obtained in step
4.

DV5 DALP file validation error. The
Tenant ID is not a valid UUID.

Use a valid Tenant ID. You can 
obtain a new ID in step 4.

DV6 DALP file validation error. The
Tenant URL does not comply with 
the URL format. It may have a typo.

Verify that the URL does not have a 
typo.

FIWS Failed to write configuration 
settings to the device.

Restart the printer. If the problem 
persists, collect the error logs and 
contact support.

LKM Unable to lock the printer, because 
the printer is busy.

Restart the printer. If that does not 
solve the problem, uninstall Printix 
Go from the printer and install 
it again. If the printer cannot be 
restarted, contact Ricoh support. If 
the printer can be restarted but the 
problem persists, contact support.

MT An HTTP request to the server or 
printer failed or timed out after 
repeating the designated number 
of tries.

Make a note of the step where 
the configuration is aborted. The 
aborted step is next to the error 
code.
If the aborted step was one of the 
following, the problem is with the 
Printix Cloud:
• Register device with Printix
• Get authentication token
• Notify Printix Cloud

If you see any other step, the 
problem is with the printer.
In either case, uninstall Printix 
Go, restart the printer, then install 
Printix Go again.
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Error code Error description Resolution

RGIP The printer was registered with 
invalid parameters.
• Cannot find a printer matching 

the serial number.
• Invalid or no Sign in profile.
• Invalid or no Go configuration.

Verify that you registered the 
printer with the serial number 
that is seen on the printer. Ensure 
that valid Sign in profile and Go 
configuration are assigned to the 
printer.

SNPI Unable to get the serial number of 
the printer.

Restart the printer. If the problem 
persists, contact support. If we 
are unable to help, contact Ricoh 
support.

WHSAU The home screen icon cannot be 
placed, because the printer cannot 
read the password from the server, 
or the password is incorrect.

Manually register the printer again 
and verify that the user name and 
password in the Sign in profile are 
correct. If the problem persists, 
contact support.

WHSMT The home screen icon cannot be 
placed, because the server is busy.

Try the following steps:

1. Restart the printer.

2. Uninstall Printix Go.

3. Restart the printer again.

4. Install Printix Go again.

If the problem persists, collect the 
error logs and contact support. 
If we are unable to help, contact 
Ricoh support.

Capture fails with the error: Invalid Print Secret or Permission denied
Capture is not supported. Attempting to use Capture results in the Invalid Print Secret error 
message being displayed.

If Capture was installed, the Capture icon persists on the printer even after uninstalling the 
Go configuration. When attempting to select the persisting Capture icon after uninstalling it, a
Permission denied error message is displayed.

Because the icon cannot be removed, the only workaround is to not select it.

The printer does not start printing or suddenly stops printing without 
displaying an error message
When attempting to print without the Printix Client, error messages are not displayed if the paper 
runs out or is jammed.

Resolution: Press the Check Status button on the bottom of the screen to see the possible errors 
and fix the errors accordingly.
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The printer says documents are being printed, but nothing is printed, and no 
error message is displayed
This issue occurs if the printer's network cable is disconnected.

Resolution 1: Ensure that the printer's network cable is firmly connected, and check that the LED by 
the printer's cable socket is on.

Resolution 2: You can configure the printer to display an error message even if the printer is not 
connected:

1. Sign in to the printer as an administrator.
2. Open the Settings.

It may not be on the first page of the printer.
3. Select System Settings.
4. On the left pane, select Network/Interface.
5. Set Unconnected Network Instruction Screen to Display.

How to set inactivity timeout on Ricoh printers
After installing Printix Go on a Ricoh printer, the inactivity timeout must be changed to avoid errors.

1. Open the printer's web page and sign in as administrator.
2. Select Device Management > Configuration.
3. Select Timer.
4. If Auto Logout Timer is enabled, make note of its number of seconds.

The default is 180 seconds.
5. In Sleep Mode Timer, enter the desired number of minutes.

If Auto Logout Timer is enabled, ensure that the time entered in Sleep Mode Timer is longer 
than the time entered in Auto Logout Timer.

 Sleep Mode Timer uses minutes and Auto Logout Timer uses seconds to indicate time.

6. Select OK.

How to use Printix Go on Ricoh printers
• Sign in with an ID code at a Ricoh printer
• Sign in with card at a Ricoh printer
• Release documents at a Ricoh printer
• Capture at a Ricoh printer
• Sign out from a Ricoh printer
• Register card on a Ricoh printer
• Sign in as guest on a Ricoh printer

See also:
• How to manage cards
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• How to reset the ID code or PIN code
• How to see and reset the ID code
• How to create and reset the PIN code

Sign in with an ID code at a Ricoh printer
1. Enter your ID code (6 digits) on the touchscreen.

• Select the Eye  to see the digits entered.
• If you do not know your ID code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your ID code.

2. Enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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Sign in with card at a Ricoh printer
1. Swipe your card at the card reader on the printer.

• A computer with Printix Client must be online on the printer's network. Otherwise, nothing 
happens when the card is swiped.

• If another user was signed in, swiping your card started to sign out that user. Wait until the 
sign-out process is completed, then swipe your card again.
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2. If prompted, enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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Release documents at a Ricoh printer
1. Sign in to the printer.
2. Select the Printix Print  icon.
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3. Select the documents to release, or select Select all (the check box in the top right corner).

4. Select Print at the bottom of the screen.
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Delete documents
• Select the documents to delete and select Delete .
• Documents are automatically deleted if you do not print them within a specified period (default is 

24 hours).

Capture at a Ricoh printer
The capture process consists of three steps:
• Scan and upload

As soon as the document is scanned and uploaded, you are returned to the list of workflows, 
while the processing and delivery continue in the background.

• Processing
The scanned document is processed by Optical Character Recognition (OCR) and a searchable 
PDF or Microsoft Word file is created.

• Delivery
The document is sent in email, transferred to a cloud destination (OneDrive or SharePoint), or 
transferred to a Connector destination.

1. Sign in to the printer.
2. Select the Printix Capture  icon.

A list of capture workflows appears.
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3. Select the appropriate workflow.
If you are signed in with the System manager role, the Active information (Yes or No) is 
displayed.

4. Confirm the details of the workflow and place the document in the printer:
• Place multi-page documents in the Automatic Document Feeder (ADF).

Ensure pages are in the correct order.
• Place one-page documents on the printer's flatbed glass.

Scanning multiple pages from the flatbed glass is not supported.
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5. Select Start to start scanning.
• If you do not want to start the scan, select X to cancel and return to the list of workflows.
• You cannot log out from the printer while the printer is scanning.
• As soon as the document is scanned and uploaded, you are returned to the list of workflows, 

while the processing and delivery continue in the background.

Sign out from a Ricoh printer
You can sign out from the printer using these methods:
• Automatic sign-out if no activity.

• If the printer does not register key presses or touchscreen activity for a set amount of time, 
you are signed out automatically.

• Select Sign out on the printer's Home screen.
• To access the printer's Home screen, select the Home button.

• Swipe your card at the card reader on the printer.
• If you were already signed in, you are signed out. If another user was signed in, that user is 

signed out and you must swipe your card again to sign in.

Register card on a Ricoh printer
You can register multiple cards. When your card is registered, the date and time of the registration 
is recorded together with the card number. If different card readers are used, the same card can be 
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registered with different formats (card numbers). In this situation, you can register the same card 
with each type of card reader.

1. Swipe the card at the card reader on the printer.

A 6-digit card registration code appears. The code is valid for 1 hour.

Make a note of the 6-digit card registration code and enter it later in the web Printix App on 
your computer.

2. Register your card using one of the following methods:
• Scan the QR code with the camera on your phone.
• Scan the QR code with the Printix App on your phone.
• Register the card without a phone.

Scan the QR code with the camera on your phone
1. Use the camera on your phone or tablet to scan the QR code displayed on the printer's 

touchscreen.
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Scanning the QR code opens the web Printix App in your browser and registers the card. You 
may be prompted to sign in to the web Printix App.
• With iOS/iPadOS 11 or higher, you can use the camera to scan the QR code.
• With the Google application installed on your Android phone or tablet, you can perform a 

Google screen search to scan the QR code.
• If your QR scanner app (not part of Printix) prompts you to open the link in a browser, select 

that option.
2. Select Close.

Scan the QR code with the Printix App on your phone
If you are using the Printix App on your phone or tablet, you can:

1. Open the Printix App for Android or iOS/iPadOS.
2. Select Menu  > Cards and codes.
3. Select Register card.
4. Select Scan , then point the camera to the QR code displayed on the printer's touchscreen.

Alternatively, you can enter the 6-digit card registration code you saw previously and select
Save.

Sign in as guest on a Ricoh printer
This option requires Printix Go Ricoh version 2.0.0.27 or higher.

1. On the sign-in page, select Guest  in the upper right of the printer's touchscreen control 
panel.

2. Select a function to use, such as Copy if that is available.
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How to set up scan settings on Ricoh printers
When creating a capture workflow in Printix Administrator, the "Orientation" and "Paper size"
settings have the following constraints on Ricoh printers:

The Orientation setting must match the feeding direction of the paper.
• If you scan a portrait document, set the orientation to Portrait, and add the paper to the 

Automatic Document Feeder (ADF) with its long edge first.

• If you scan a landscape document, set the orientation to Landscape, and add the paper to the 
ADF with its short edge first.

If these instructions are not followed, content will be missing in the output image.

 If the Orientation is set to "Select automatically", Ricoh printers do not detect the actual 
orientation of the document, so they use the default Portrait setting. Do not use "Select 
automatically" on Ricoh printers if you want to scan a landscape document.

If the "Paper size" setting of your Ricoh printer supports Auto Detect, the printer can automatically 
select a combination of orientation and paper size that adjusts to the feeding direction of the paper 
and does not result in content loss on the output image.

Ricoh printers do not support ISO B4 and Statement paper sizes. If this paper size is selected in 
Printix, the Ricoh printer will attempt to use Auto Detect.

Using Auto Detect is the only way to scan an unsupported paper size. If your Ricoh printer does not 
support Auto Detect but you try to use it anyway, your printer sets the "Paper size" to Letter (8.5 × 
11 inches) if the printer is in North America or A4 (8.3 × 11.7 inches) if the printer is anywhere else in 
the world.
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To know whether your printer supports Auto Detect, see your Ricoh printer's documentation.

How to set up scan to email on Ricoh printers
Use the below steps to set up scan to email so users can scan and send emails to your company's 
Microsoft 365 or Office 365 mailboxes. The steps are in accordance with option 2, as described in 
Microsoft documentation: How to set up a multifunction device or application to send email using 
Microsoft 365 or Office 365.

1. Open a new browser window and sign in to Microsoft 365 admin center
(admin.microsoft.com).

2. On the navigation menu, select Show all.
3. Select Settings and then Domains.
4. On the DNS records tab, select your domain.

Example:  acme.com
5. Write down the MX record POINTS TO ADDRESS value.

You need the MX record in step 11.
Example:  acme-com.mail.protection.outlook.com

6. Open the printer's web page and log in as administrator.
7. On the menu, select Device Management and then Configuration.
8. In the Scanner section, select General Settings.
9. For Login User Address Priority, select On.

10. Select OK.
You return to the Configuration page.

11. In the Device Settings section, select E-mail.
• In Administrator Email Address, optionally, type the email address to be used as the 

default From address.
• In Auto Specify Sender Name, select On and the signed in user's email address is set as the

From address (sender). Select Off and the Administrator Email Address will be set as the
From address (default sender).

• In SMTP Server Name, type the value you obtained in step 5.
Example: acme-com.mail.protection.outlook.com

• In SMTP Port No, leave the value at 25.
• In SMTP Authentication, select Off.

12. Select OK.


• Email might be sent to recipients' junk mail folders. To avoid this, go to your domain 

registrar's website to update your DNS records. Edit your sender policy framework (SPF) 
record to include your public IP address. See the Microsoft documentation: Step-by-step 
instructions for direct send.

• If your email did not arrive, remember to check your spam/junk mail folder. See also: How 
to troubleshoot scan to email.
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Prefill From
As you are signed in with Printix, your email address is not automatically prefilled in the From field.

Some SMTP servers will reject sending the scanned documents if the email sender (From field) 
does not have a specific value, that is, the Administrator Email Address that can be specified in 
step 8 above. Also, the Ricoh printer must be brought into Service Program Mode to change the SP 
5-860-022 (SMTP Auth From Field Replacement) to 1.

 The instructions and code required to bring a printer into SP mode depend on the model. You 
may need to contact your Ricoh technician.

Address book
With Printix Go Ricoh version 2.0.0.27 or higher signed in users are identified by their email address 
(such as john.smith@acme.com) instead of previously by their name (such as John Smith). First time 
a user signs in after an update from an earlier Printix Go version, such as 0.4.10.0, a new entry is 
created in the Ricoh printer's address book and the columns Name and Email Address will both 
show the user's email address. Any previous address book entry of the user (by name) is no longer 
used and can be deleted by the administrator. Ricoh truncates the name to between 15 and 20 
characters depending on the platform limitations.
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How to install card reader on Ricoh printers

Connect the card reader
1. Remove the bracket on the right side of the printer's touchscreen control panel.
2. Locate the USB mini-B port.
3. Connect the card reader to the USB mini-B port.
4. Mount the bracket again.
5. If Printix Go is already installed, select Update on the Printix Go tab for it to become aware of 

the card reader. The same applies if the card reader is replaced with another type. Otherwise,
Install Printix Go.
• On the Printer properties page, Card reader should show Vendor and Created for the 

installed card reader. If it does not, a restart of the printer may be required.
• If Sign in method in the Printix Go configuration is Select automatically, then it 

should map to Card if a card reader is connected to the printer. Otherwise, it maps to ID 
code. Mapping changes within 10 seconds after the card reader is either connected or 
disconnection. If it does not change, a restart of the printer may be required.


• The USB type-A port on the left side of the printer's touchscreen control panel is reserved 

for the use of USB drives (memory sticks).
• The USB type-A port on the rear of the printer cannot be used, even though it may have 

worked with a previously installed, third-party Pull printing solution, such as PaperCut. The 
card reader itself is likely to work with Printix Go but you need a converter cable and then 
connect it to the USB mini-B port as shown in the images.
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Card reader cable connected on Ricoh IM C3000

Card reader cable connected on Ricoh MP C3004

Configure card reader and card reader settings
Printix Go automatically configures the card reader and its settings during an installation or an 
update. The manual steps below are only relevant if the automatic configuration does not work.

1. Manually configure card reader.
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2. Manually configure card reader settings.

Manually configure card reader
1. Open the printer's web page and log in as administrator.
2. On the menu, select Device Management, and then Configuration.
3. In the Device Settings section, select Program/Change USB Device List.
4. Enter Vendor ID and Product ID of the card reader into that list.
5. Select OK.

Manually configure card reader settings
1. Select User Tools.
2. Select System Settings.

Depending on the model:
• Select Screen Device Settings Information.
• Select Network Interface.

3. Select External Interface Software Settings.
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4. In Select IC Card Reader, select Proximity Card Reader.

 For the following card reader, ensure that Do not Use is selected instead:

Vendor VID PID Protocol

Baltech 0×13AD 0×9CA5 Binary

5. In Bluetooth Software Settings, ensure that Do not Use is selected.
6. Connect the card reader if it is not already connected.
7. Select Proximity Card Reader Software Settings.
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8. The panel should show information about the card reader (Vendor ID and Product ID).

9. Select OK.
10. Manually power off and power on the printer.
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How to set up SSL/TLS communication on Ricoh printers
To be able to install and uninstall on Ricoh printers, SSL/TLS communication must be configured 
correctly.

1. Open the printer's web page and log in as administrator.
2. On the menu, select Device Management, and then Configuration.
3. In the Security section, select Network Security.

• In HTTP for Port 80, select Open.
• In SSL/TLS for IPv4, select Active.
• In Permit SSL/TLS Communication, select Ciphertext/Cleartext.
• In SSL/TLS Version for TLS1.2, select Active.

4. Select OK.
In addition to the above on Ricoh SOP printers Generation 2, TLS1.2(SSL Server) must also be 
enabled.

5. Open the printer's web page and log in as administrator.
6. On the menu, select Device Management, and then Configuration.
7. In the Extended Feature Settings section, select Administrator Tools.
8. In the Select Available Functions section for TLS1.2(SSL Server), select Active.
9. Select Apply.
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How to set the web server password on Ricoh printers
To be able to install and uninstall on Ricoh SOP Generation 2 printers, the web server password 
must be the default (ricoh).

 If you know printers that do not have SDK /J installed, you can avoid needing the web server 
password on those printers.

1. Open the printer's web page and log in as administrator.
2. On the menu, select Device Management, and then Configuration.
3. In the Extended Feature Settings section, select Administrator Tools.
4. In the Web Service Settings section:

• In Remote Installation Password, select Change and change the Password back to the 
default, which is: ricoh.

5. Select Apply.

How to sign in as machine administrator on Ricoh printers
Follow these steps to sign in as an administrator on Ricoh printers when Printix Go is installed.

On the sign-in page, touch the upper left corner of the printer's touchscreen five times.
An icon  will briefly appear.
This takes you to the printer's home page where you can access Settings for Administrator.
Accessing the Settings requires you to log in as an administrator. See your printer's operating 
instructions about accessing Settings for Administrator.

How to sign in as guest on Ricoh printers
Follow these steps to sign in as guest on Ricoh printers when Printix Go is installed. This requires 
Printix Go Ricoh version 2.0.0.27 or higher.

 The "Access control" settings in the Go configuration MUST have at least one function unlocked
 for sign-in as guest to be available. If all functions are locked, the button to sign in as guest 

does not appear.

1. On the sign-in page, select Guest  in the upper right of the printer's touchscreen control 
panel.
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2. Select the function you wish to use, for example, Copy.

How to remotely access control panel on Ricoh printers
1. Open the printer's web page and log in as administrator.
2. On the menu, select Device Management, and then Remote Panel Operation.

How to get logs from Ricoh printers

Ricoh printers
1. Open the printer's web page and log in as administrator.
2. In the address, delete what comes after the printer's IP address and insert:

/web/entry/df/websys/direct/getSysInfo.cgi

Example:  https://192.168.1.10/web/entry/df/websys/direct/getSysInfo.cgi
3. Set Number of days to 1 (the same day you experienced issue with the installation or use of 

Printix Go).
4. Select Calculate (might take a few minutes).
5. Select Start to obtain a tar file (MachineInfo_xxx.tar).
6. Make the tar file available to us through a link. If it is smaller than 6 MB, you can attach it to 

your support request.

Ricoh SOP printers Generation 2
1. Open the printer's web page and log in as administrator.
2. In the address, delete what comes after the printer's IP address and insert:

/web/entry/df/websys/direct/getSysInfo.cgi
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Example:  https://192.168.1.10/web/entry/df/websys/direct/getSysInfo.cgi
3. Set Number of days to 1 (the same day you experienced issue with the installation or use of 

Printix Go).
4. Select Download (might take a few minutes) to obtain a tar file (MachineInfo_xxx.tar).
5. Make the tar file available to us through a link. If it is smaller than 6 MB, you can attach it to 

your support request.

Printix Go Xerox - How to
How to sections for Xerox:
• How to use Printix Go on Xerox printers
• How to configure SNMPv1/v2 on Xerox printers
• How to install card reader on Xerox printers
• How to set up scan to email on Xerox printers
• How to set inactivity timeout on Xerox printers
• How to sign in as machine administrator on Xerox printers
• How to remotely access control panel on Xerox printers

See also:
• Printix Go troubleshooting

How to prepare Xerox printer for Printix Go

 These preparations are only necessary for the following printers and MFPs: AltaLink models 
and EC8036/EC8056 models.

1. Open the printer's web page and log in as admin.
2. Select the Properties tab.
3. On the menu, select Login/ Permissions/ Accounting, then select Login Methods.
4. Make sure Xerox Secure Access is configured.

How to use Printix Go on Xerox printers
• Sign in with an ID code at a Xerox printer
• Sign in with card at a Xerox printer
• Release documents at a Xerox printer
• Sign out from a Xerox printer
• Register card on a Xerox printer

See also:
• How to manage cards
• How to reset the ID code or PIN code
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• How to see and reset the ID code
• How to create and reset the PIN code

Sign in with an ID code at a Xerox printer

 The authentication on Xerox AltaLink printers has a different visual design than on other Xerox 
printers, but they have the same functions.

1. Select the Keyboard icon in the top right corner.

2. Enter your ID code (6 digits) on the touchscreen.
• If you do not know your ID code:

• Open the Cards and codes menu in the Printix App.
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3. Enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• If you do not know your PIN code:

• Open the Cards and codes menu in the Printix App.
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Sign in with card at a Xerox printer
1. Swipe your card at the card reader on the printer.

• Before 90 seconds have elapsed, select the Printix Print  icon.
• A computer with Printix Client must be online on the printer's network. Otherwise, nothing 

happens when the card is swiped.
2. If prompted, enter your PIN code (4 digits) on the touchscreen.

• The PIN code is the same whether you sign in with an ID code or card.
• If you do not know your PIN code:

• Open the Cards and codes menu in the Printix App.
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Release documents at a Xerox printer
1. Sign in to the printer.
2. Before 90 seconds have elapsed, select the Printix Print  icon.

3. Select the documents to release, or select Select all (the check box in the top right corner).
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4. Select Print at the bottom of the screen.

Delete documents
• Select the documents to delete and select Delete .
• Documents are automatically deleted if you do not print them within a specified period (default is 

24 hours).

Sign out from a Xerox printer
You can sign out from the printer using these methods:
• Automatic sign-out if no activity.

• If the printer does not register key presses or touchscreen activity for 90 seconds, you are 
signed out automatically.

• Select Sign out on the printer's Home screen.
• To access the printer's Home screen, select the Home button.

• Swipe your card at the card reader on the printer.
• If you were already signed in, you are signed out. If another user was signed in, that user is 

signed out and you must swipe your card again to sign in.

Register card on a Xerox printer
You can register multiple cards. When your card is registered, the date and time of the registration 
is recorded together with the card number. If different card readers are used, the same card can be 
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registered with different formats (card numbers). In this situation, you can register the same card 
with each type of card reader.

1. Swipe the card at the card reader on the printer.

A 6-digit card registration code appears. The code is valid for 1 hour.
2. Make a note of the 6-digit card registration code and select Home to close the screen.

Alternatively, you can close the screen by:
• Selecting Exit and then Cancel.
• Selecting No/Yes and then OK.

Enter card registration code in the Printix App
1. Open the Printix App.

• Alternatively, visit printix.net and select Sign in.
• You are not required to use a phone, because you can also open the Printix App on your 

computer:
• Open the Printix Client menu and select Release and print documents.
• Open a web browser and enter the Printix Home URL for your work or school.
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Example: https://acme.printix.net

2. Select Menu  > Cards and codes.
3. Select Register card.
4. Enter the 6-digit card registration code you saw previously and select Save.

How to configure SNMPv1/v2 on Xerox printers
1. Open the printer's web page and log in as admin.
2. On the menu, select System.
3. Select Connectivity.
4. In the Protocols section, select SNMP.
5. Select SNMPv1/v2.
6. In the Community Names section:

• In Community Name Read/Write, type set community name (private).
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7. Select OK.
8. Select OK again.

How to install card reader on Xerox printers

Activate card reader plug-in on VersaLink printers
You need to install the Xerox USB Card Reader plug-in as follows:

Download the USB Card Reader plug-in
1. Visit support.xerox.com.
2. Search for the model of your printer.

Example:  VersaLink C7020
3. Open the Drivers & Downloads tab.
4. Select the result that links to a web page with downloads in its title.

Example:  VersaLink C7020/C7025/C7030 Multifunction Printer
5. Scroll to the Firmware section.

It is the last section on the web page, all the way at the bottom.
6. Locate Card Reader Plug-ins (current version is 12).
7. Select I agree to the Terms and Conditions.
8. Select Download.
9. Extract all files from the zip file to a convenient location on your computer.
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Install the USB Card Reader plug-in
1. Open the printer's web page and log in as admin.
2. On the menu, select System.
3. Select Plug-In Settings.

The Plug-In Settings dialog box appears.
4. Next to Plug-ins, select Add.
5. Browse to the location of the Xerox USB Card Reader .jar file you previously extracted from 

the .zip file.
Example:  Xerox_USB_Card Reader_v3.0.11_sig.jar

6. Select OK.
7. Connect the card reader.
8. Select Close.
9. Restart the printer to activate the plug-in.

10. When the system is back online, return to the Plug-In Settings dialog box and ensure that the 
USB Card Reader plug-in is Activated.
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Limitations with card reader support
It is not possible to detect if a card reader has been connected or disconnected. We have been 
unsuccessful at using the EIP functions for this. As a consequence:
• The Printer properties page will not show that a card reader is connected.
• The Sign in method in the printer's Go configuration should be set to either Card or Card or ID 

code. The method "Select automatically" will not detect card reader.

Connect the card reader
Images are from a Xerox VersaLink C7020. Instructions may differ for other models.

1. Locate the Hardware Integration Pocket (HIP) on the printer (typically to the left of the 
touchscreen control panel).

2. Raise the touchscreen control panel to its upright position.
3. Remove the HIP cover by pressing the tap. Set the cover aside.

4. Locate the USB Type-A port.
5. Connect the card reader to the USB Type-A port.
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How to set up scan to email on Xerox printers
Use the below steps to set up scan to email so users can scan and send emails to your company's 
Microsoft 365 or Office 365 mailboxes. The steps are in accordance with option 2, as described in 
Microsoft documentation: How to set up a multifunction device or application to send email using 
Microsoft 365 or Office 365.

1. Open a new browser window and sign in to Microsoft 365 admin center
(admin.microsoft.com).

2. On the navigation menu, select Show all.
3. Select Settings and then Domains.
4. On the DNS records tab, select your domain.

Example:  acme.com
5. Write down the MX record POINTS TO ADDRESS value.

You need the MX record in step 9.
Example:  acme-com.mail.protection.outlook.com

6. Open the printer's web page and log in as admin.
7. On the menu, select Connectivity, and then SMTP.
8. In the Device Email section:

• In Enter email address, type the email address to be used as the default From address.
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9. In the SMTP Server section, select Server Address.
• In Server Address, type the value you obtained in step 5 and select OK.

Example: acme-com.mail.protection.outlook.com
• In Outgoing SMTP Port Number, leave the value at 25.

10. In the Connection Security section:
• Select STARTTLS.

11. In the Outgoing SMTP Authentication section:
• Select SMTP Authentication and select Off.

12. Select OK.

How to set inactivity timeout on Xerox printers
1. Open the printer's web page and log in as admin.
2. On the menu, select System.
3. Select Timeouts.
4. In the Reset Device Control Panel section:

• In System Timeout, type the number of seconds (the default is 90 seconds).
5. Select OK.

How to sign in as machine administrator on Xerox printers
Follow these steps to sign in as machine administrator on Xerox printers when Printix Go is 
installed. You will be asked to enter the same username and password that you used in the Printix 
Go sign in profile.

1. Select the keyboard icon in the top right corner.

557



Tungsten Printix Administrator Guide

2. Enter ID code four zeros (0000) on the touchscreen.

3. Enter Username on the touchscreen.
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This must match what you configured in the Printix Go sign in profile.
4. Enter Password on the touchscreen.

This must match what you configured in the Printix Go sign in profile.

How to remotely access control panel on Xerox printers
1. Open the printer's web page.
2. Select Remote Control Panel.
3. Select Request Session.
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Printix Redirector

Printix Redirector is used to:
• Enable third-party Pull printing

Printing to so-called Follow/Pull print queues from Kofax ControlSuite, PaperCut, SafeCom, 
Equitrac, PrinterLogic, and similar third-party printing solutions.

• Enable USB printing
Printing to locally attached USB printer.
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Printix Redirector ports

• Manual effort is not required to maintain the Printix Redirector, because it silently updates itself 
to the latest approved version.

• Runs as a service under the local system account on a Windows computer.
• TCP port 21336 is used to transfer print data from the computers running Printix Client to the 

Windows computer running Printix Redirector.

Internet endpoints that must be unblocked
Use of a web proxy and/or SSL inspection may prevent Printix Redirector from working. The syntax 
for adding exceptions varies depending on the software you use. See your security software 
documentation to determine the syntax for specifying a domain and subdomains.

See also:
• Internet endpoints that must be unblocked
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Download
1. In Printix Administrator, select   Menu  >  Software .
2. Select Printix Redirector to download it.

 Do NOT rename the file, because it prevents it from working with your Printix Home.

Install
On a Windows computer, open and run the downloaded file:

1. Double-click REDIRECTOR_{home}_{id}.EXE to start the installation.
2. If a User Account Control dialog box prompts you to allow the Printix Client Setup program to 

make changes on this computer, select Yes.
3. Change the setup language if required. Select OK.

The Setup - Printix Redirector wizard appears.
4. Select Next.
5. Select Install.

The installation is started.
6. After the installation is completed, select Finish.

Printix Redirector runs as a service under the local system account.


• Printix Redirector requires .NET Desktop Runtime 6.
• If you are using an earlier version of Printix Redirector than 2.2.0.56, it will only 

automatically update itself if the Printix Client is also installed on the computer.

Ensure a v3 print driver is used
The print driver used by the print queue must be a v3 print driver. If a v4 print driver is used, 
printing through Printix Redirector will not work.

If you are at the printer, you can print a test page and check that the Driver type is Type 3:

1. Open Device and Printers.

2. Right-click the printer and select Printer properties.

3. Select Print Test Page.

4. On the printed page, look in the section: PRINT DRIVER PROPERTIES and check that the
Driver type is Type 3 - User Mode.
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Alternatively, look in the Windows Registry:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Print\Environments
\Windows64\Drivers

• The Version-3 folder lists the v3 print drivers.
• The Version-4 folder lists the v4 print drivers.

1. Open Device and Printers.

2. Right-click the printer and select Printer properties.

3. Open the Advanced tab and check that the Driver is one of those listed in the Version-3 folder 
in the Windows Registry.

Controlling the format of the user name
If you are printing to a Follow/Pull print queue from another print management system, and this 
system does not recognize the user, it could be because the format of the reported user name is 
different.

1. Press Windows+R.
The Run dialog box appears.

2. Type regedit, then select OK.
Select Yes if prompted.
The Registry Editor appears.

3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\printix.net\Printix Redirector
\Settings.
The value UserNameFormat can have these Decimal values (hex values in parenthesis):
• 0 (0×00000000): User name is not modified (this is the default). Use the Printix user name of 

the user signed into Printix Client, Example: john@acme.com. If this is empty, then use the 
name of the user signed into the computer (john).
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• 1 (0×00000001): Remove the domain part (@acme.com) from the Printix user name and only 
return the first part (john).

• 11 (0×0000000b): Replace the @ in the domain name of the Printix user name with a dot. 
(john.acme.com)

• 22 (0×00000016): Use the name (sAMAccountName) of the user signed into the computer 
and ignore the Printix user name.

Feedback from customers indicate that the following values of UserNameFormat are working 
with the below third-party solutions. If you have feedback, contact Product Support.
• Equitrac: 0
• PaperCut: 1
• Streamline NX: 22

A change in the UserNameFormat value takes effect immediately, so it is not necessary to 
restart the Printix Redirector service.
You can consult the Printix Redirector log file to troubleshoot this.

For each document printed, there will be an entry such as the following:
Redirector: UserNameFormat: 11
Redirector: Print job being transferred to PullPrint by [john, john@acme.com, 
 john.acme.com]

• Print queue: PullPrint
• The name of the user signed in to the computer where the document was submitted: john
• The Active Directory user name of the user signed in to the Printix Client where the document 

was submitted: john@acme.com
• The text set on the print job as being the submitting user: john@acme.com

• If UserNameFormat has a decimal value of 1 (0×00000001), it would be: john
• If UserNameFormat has a decimal value of 11 (0×0000000b), it would be: john.acme.com
• If UserNameFormat has a decimal value of 22 (0×00000016), it would be: john

Printix Redirector log files
Log files are stored on the computer.
• Printix Redirector.{number}.log

There will be a maximum of 6 log files with a size of 1 MB each. The log file without a number is the 
current one. Previous versions are numbered 1–5 with 5 being the oldest.

The logs are stored in this folder:
• C:\ProgramData\printix.net\Printix Redirector\Logs

 ProgramData is a Hidden folder, and may not appear in File Explorer when you open Local 
disk (C:). Type: C:\ProgramData to access it.
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How to see which print queues and ports are installed
In the Printix Redirector log file, after a restart, you will find information about what Windows print 
queues are installed on the computer and what ports they are using. Search for getAllQueuesWin.

In the example below, the print queue ZDesigner LP 2844 is connected to a USB port.
getAllQueuesWin: Found 6 installed queues
Service, found queue: OneNote (Desktop), port: nul:
Service, found queue: ZDesigner LP 2844, port: USB001
Service, found queue: ZDesigner ZD410-300dpi ZPL, port: 192.168.1.104
Service, found queue: Printix Anywhere, port: http://localhost:21339/
ipp/000/50f0f9d9-6d25-455f-9028-7cd609dfc4c6
Service, found queue: Reception, port: http://localhost:21339/ipp/ASD/
f20db995-0811-49c4-ad14-9e26234959eb
Service, found queue: Microsoft XPS Document Writer, port: PORTPROMPT:
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Enable third-party Pull printing

If you have a third-party Follow/Pull printing solution, you can still benefit from Printix. Users can 
continue using existing card readers to sign in and release documents from the enabled printers' 
touchscreen control panel. With Printix, you can automatically install the Follow/Pull print queues 
on the users' Windows or Mac computer. Optionally, you can allow users to submit documents from 
home and while traveling.

1. Install Printix Client and Printix Redirector on the (server or desktop) computer that has the 
Follow/Pull print queue installed.
• Ensure a v3 print driver is used

2. In Printix Administrator, open the Printers  page.
3. Select Add .

566



Tungsten Printix Administrator Guide

4. Select the Network of the computer that has the Printix Redirector and print queue installed.
5. In Printer address, type: \\{servername}\{printqueuename}

• The {servername} should be that of the server running Printix Redirector.
Example: myserver

• The {printqueuename} should be the Printer name of the Follow/Pull print queue.
Example: PullPrint

6. Select Add.
• If the printer does not appear in Printix Administrator, look for it on the Unregistered 

printers page of the virtual printer.
• By default, the print name is set to the name of the driver used by the Follow/Pull print 

queue.
• The default print queue is set to the name of the driver used by the Follow/Pull print queue. 

If no print queue exists, create a print queue.
7. In Printix Administrator, open the Print queue properties page of the virtual printer.
8. Clear Active until you are done testing the print queue.
9. Select Exempt from secure print.

Settings that would otherwise have the user release the documents in Printix are ignored, and 
instead, the user will only have to release the document in Kofax ControlSuite or their third-
party Follow/Pull printing solutions.

10. Optionally, for each system:
• Change the print driver to a universal print driver.
• Add a new print driver configuration.

Test printing
1. On your computer, use the Printix Client to add the printer.

In Printix Client, the administrators see a star ★ after the printer ID if the print queue is not 
active.
Example:  ASD ★ Reception

2. Print a document to the added printer.
3. Verify that the document ends up in the third-party printing solution and you can release the 

document with the methods offered by the particular print management system.
• This fails if the format of the user name is not recognized.

4. For the Printix Client running on the Pull Print Server, you can open Computer properties
and select Act as print gateway, so documents printed via the cloud are sent to the Pull Print 
Server rather than through another computer on the network.

Make the printer available to everyone
1. In Printix Administrator, open the Print queue properties page of the virtual printer.
2. Select Active, so all users can use the print queue.
3. Optionally, select Add print queue automatically.
4. Optionally, select Via the cloud to allow users to print to the Follow/Pull print queue even 

though they are not on the same network.
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Troubleshooting
• The added printer remains unregistered
• Wrong format for network printer address (ip address or hostname)
• Wrong format for virtual printer address (\\servername\printqueuename)

The added printer remains unregistered
The printer name is probably wrong. You can consult the Printix Redirector log file to see the printer 
names and copy the right one from the log file.

Resolution:
1. Restart the Printix Redirector service.

A list of the print queues is written at the top of the log file after a restart.
2. Open the log file: C:\ProgramData\printix.net\Printix Redirector\Logs

\PrintixRedirector.log.
3. In the log file, search for getAllQueuesWin.

For each print queue, there will be an entry such as this:
Service, found queue: {printqueuename}, port: {port}

4. Identify the correct {printqueuename} and use that.

See also: How to see which print queues and ports are installed.

Wrong format for network printer address (ip address or hostname)
This message appears if you try to modify the Printer address of a printer that was initially 
registered by IP address or hostname and thereby as a network printer.

Resolution:
• To add a virtual printer, you must add a new printer, and from the very beginning, give it a

Printer address in the format \\{servername}\{printqueuename}.

Wrong format for virtual printer address (\\servername
\printqueuename)
This message appears if you try to modify the Printer address of a printer that was initially 
registered by \\{servername}\{printqueuename} and thereby as a virtual printer.

Resolution:
• To add a network printer, you must add a new printer, and from the very beginning, give it a

Printer address in the form of an IP address or hostname.
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Enable USB printing

Use Printix Redirector to enable printing to a locally attached USB printer.

 Printing to the USB printer only works when the connected computer is online.

1. Install  Printix Client  and Printix Redirector on the (desktop) computer that has the locally 
attached USB printer.
• Ensure a v3 print driver is used.

2. In Printix Administrator, open the Printers  page.
3. Select Add .
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4. Select the Network of the computer that has the USB printer attached and Printix Redirector 
installed.

5. In Printer address, type: \\{computername}\{printqueuename}.
• The {computername} should be that of the computer running Printix Redirector.

Example: mycomputer
• The {printqueuename} should be the Printer name of the USB print queue. Do NOT use a 

possible Share name.
• See also: How to see which print queues and ports are installed.

6. Select Add.
• If the printer does not appear in Printix Administrator, look for it on the Unregistered 

printers page.
• By default, the print name is set to the name of the driver used by the USB print queue.
• The default print queue is set to the name of the driver used by the USB print queue. If no 

print queue exists, create a print queue.
7. Optionally, select Via the cloud to allow users to print to the USB printer even though they are 

not on the network same as the printer.
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Printix Configurator

Printix Configurator for Windows can be used to initially configure Printix for customers with 
multiple locations (networks) and already deployed printers. Printix Configurator will offer to update 
itself to the latest approved version.
• Download
• Sign in
• Networks
• Printers
• Configuration and log files

See also:
• How to add a gateway to an existing network
• How to add a printer
• How to add print queues to computers with Printix Configurator

Download
1. In Printix Administrator, select  Menu   >  Software .
2. Select Printix Configurator to download it.

Sign in
1. To start the Printix Configurator, right-click the EXE file and select Run as administrator.

The Printix Configurator and a browser page appear.
2. Sign in through the browser page.

You must have the System manager role.
3. If prompted, select a Printix Home.

Example:  acme.printix.net
To change language, select Menu  > Language.
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• Printix Configurator requires .NET Desktop Runtime 6.
• If the message You can close this window does not appear in the browser or the Printix 

Configurator still displays Login in progress, the sign-in was not successful. In these cases, 
select Connect in the Printix Configurator and sign in again.

• If you cannot see the name of your Printix Home (acme.printix.net), it could be because 
you are not properly signed in, or because you are using Printix Configurator 1.3.890 or 
lower, and multiple Printix Configurator processes are running. Use the Task Manager to 
end the task, then restart the Printix Configurator.

After a successful sign-in, you can close the browser window.

Networks
Select Networks in the Printix Configurator to configure networks.

It is best to have the networks in place before printers, because then you can choose networks for 
the printers.
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The list contains gateways (IP and MAC address pairs) assigned to networks.

A network can have multiple gateways.

Renaming a network is not possible.

If an IP or a MAC address is updated, that means to add a new gateway to the assigned network 
(instead of updating the original gateway).
• In Edit, you can manually add and manage networks.
• In Import, you can import existing networks from the Printix Cloud or a CSV file.
• In Export, you can export the list of networks to a CSV file.
• In Upload, you can upload the networks to the Printix Cloud.
• Select Help to see a short explanation about the list of networks.
• Select Exit to close the Networks dialog box and return to the Printix Configurator main window.

Network data
• Network name

Example: Amsterdam
• IP address

Example: 192.168.1.1
• MAC

Example: 54a050e55bc0 or 54:a0:50:e5:5b:c0
• Data source

Example: Server
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• Uploaded
Example: Yes

The Data source column displays Manual if the data was manually added (Edit > Add network), CSV
if Import from CSV file was used, and Server if Import from Printix Server was used.

Any invalid component of a network is highlighted in red. You can select Show only invalid items to 
only display networks with validation errors.

Example of validation errors:
• Missing information.
• Multiple networks have the same MAC address.

You can edit a single network by:
• Clicking a network, then selecting Edit > Edit network

If only one network has a check mark, that network is edited regardless of which network was 
clicked.

• Double-clicking anywhere in the network's row

Set up CSV mappings for networks
The CSV file MUST be semi-colon (;) separated. Column headers are optional. Do not put spaces 
before or after a semi-colon.
• If the file contains headers, select CSV file contains headers, and for each Field name, select the 

corresponding CSV header name.
• If the file has no headers, clear CSV file contains headers, and for each Field name, select a 

corresponding Column number.

Select Auto-fill to automatically populate the table. After an auto-fill, make sure the correct 
information is filled in.

574



Tungsten Printix Administrator Guide

Upload networks
After the file content is validated, you can upload the networks to the Printix Cloud.

Printers
Select Printers in the Printix Configurator to configure printers.
• In Edit, you can manually add and manage printers.
• In Import, you can import existing printers from the Printix Cloud or a CSV file, or you can update 

only the network address of already listed printers using a CSV file.
• In Export, you can export the list of printers to a CSV file.
• In Upload, you can upload the printers to the Printix Cloud.
• Select Exit to close the Printers dialog box and return to the Printix Configurator main window.

575



Tungsten Printix Administrator Guide

Printer data
• Printer name

Example: Reception
• Vendor

Example: HP
• Model

Example: HP Officejet Color X555
• Address

Example: 192.168.1.94
• Network

Example: Amsterdam
• MAC

Example: F0921C637CA2 or F0:92:1C:63:7C:A2
• Serial number

Example: CN3993Y073
• Page description language (PDL)

Example: [PCL5,POSTSCRIPT,PDF]
• Color

Example: True
• Duplex

Example: False
• Data source

Example: Server
• Uploaded

Example: Yes

 It is assumed printers are using the default SNMP configuration.

The Data source column displays Manual if the data was manually added (Edit > Add printer), CSV if
Import from CSV file was used, and Server if Import from Printix Server was used.

Any invalid component of a printer is highlighted in red. You can select Show only invalid items to 
only display printers with validation errors.

Example of validation errors:
• Missing information.
• Multiple printers have the same MAC address.

You can edit a single printer by:
• Clicking a printer, then selecting Edit > Edit printer

If only one printer has a check mark, that printer is edited regardless of which printer was clicked.
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• Double-clicking anywhere in the printer's row

Set up CSV mappings for printers
The CSV file MUST be semi-colon (;) separated. Column headers are optional.
• If the file contains headers, select CSV file contains headers, and for each Field name, select the 

corresponding CSV header name.
• If the file has no headers, clear CSV file contains headers, and for each Field name, select a 

corresponding Column number.

Select Auto-fill to automatically populate the table. After an auto-fill, make sure the correct 
information is filled in.

Upload printers
After the file content is validated, you can upload the printers to the Printix Cloud.
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Configuration and log files
Configuration files and logs are stored on the computer in the ProgramData folder.

 ProgramData is a hidden folder, and may not appear in File Explorer when you open Local 
disk (C:). You can access it by entering C:\ProgramData in the address bar.

Configuration files
Configuration files are stored on the computer in this folder:
• C:\ProgramData\printix.net\Printix Configurator\Configuration

There will be up to 3 configuration files per Printix Home you have been configuring. The {id} is the 
Printix ID (tenant ID).
• PrintixConfigurator_{id}.dta
• CSVNetworkMapping_{id}.dta
• CSVPrinterMapping_{id}.dta

Log files
The logs are stored in this folder:
• C:\ProgramData\printix.net\Printix Configurator\Logs

There will be a maximum of 6 log files with a size of 1 MB each. The log file without a number is the 
current one. Previous versions are numbered 1–5 with 5 being the oldest.
• PrintixConfigurator_{user}.{number}.log

How to add a gateway to an existing network
1. Sign in to  Printix Configurator .

You must have the System manager role.
2. Select Networks to configure networks.
3. Select Edit > Add network. You can also create a CSV file.

The CSV file MUST be semi-colon (;) separated. Do not put spaces before or after a semi-colon.
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4. In the Add new network dialog box:
• Enter the Network name. This must match the name of the network you want to add the 

gateway to.
Example: Network1

• Enter the Gateway IP address.
Example: 192.168.1.1

• Enter the Gateway MAC address.
Example: 54a050e55bc0 or *
Entering the asterisk/star symbol (*) as a wildcard for the MAC address is useful if you use 
network gateways (Fortinet) that, after a power cycle, change the MAC address but keep the 
IP address.

5. Select Add.
6. Select Upload > Upload to Printix Server.
7. Open the Printix Administrator to verify that the gateway has been added to the network.
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How to add a printer
The below process can be used to add a label printer that is connected with USB to, for example, a 
D-Link print server. In case the D-Link print server is using the LPR protocol, the print queue name
used to reach the specific USB port on the D-Link print server.

 You can also use the process below to add printers that do not support SNMP. However, the 
printer will always appear with status  Ready because the status of the printer is not available.

1. Sign in to  Printix Configurator .
You must have the System manager role.
Steps 2–4 are necessary, so you can select the printer's Network in step 8.

2. Select Networks to configure networks.
3. Select Import > Import from Printix Server.
4. Select Yes.
5. Select Exit.
6. Select Printers to configure printers.
7. Select Edit > Add printer. You can also create a CSV file.

The CSV file MUST be semi-colon (;) separated. Do not put spaces before or after a semi-colon.
See an example of a printer CSV file.
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8. In the Add new Printer dialog box:
• Enter Printer name.

Example: Label printer
• Enter Vendor.

Example: DYMO
• Enter Model.

Example: LabelWriter 450
• Enter network Address.

• RAW mode via TCP port 9100 (default)
Example: 192.168.1.9

• IPPS via TCP port 443
Example: 192.168.1.9 $$ipps

• LPR via TCP port 515
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Example: 192.168.1.9 $$lpr:dlk-1D6FA3-U1
• Select Network.

Example: Network1
• Enter MAC address.

Example: 0011E5040E34
• Optionally, enter Serial number.

Example: CN3993Y073
• If relevant, select a Page description language:

• PCL5: Printer Command Language level 5.
• POSTSCRIPT: PostScript Level 1, PostScript Level 2 and PostScript 3.
• PCLXL: Printer Command Language level 6.
• PDF: Portable Document Format.
• XPS: Open XML Paper Specification.
• UFRII: Ultra Fast Rendering 2, a proprietary language of Canon.

• If relevant, select Color supported.
• If relevant, select Duplex supported.

9. Select Add.
10. Select Upload > Upload to Printix Server.
11. Open Printix Administrator to verify that the printer has been registered.

We recommend you to check that a print queue is also created and that the selected print 
drivers are the ones you want to use.

How to add print queues to computers with Printix 
Configurator

Use a CSV file with computers and print queues to add print queues to computers. Only if Printix 
Administrator has a matching Hostname of a computer and a matching print queue name, will the 
computer have the print queue added. Uppercase and lowercase letters are treated the same. The 
adding of the print queue is done as a task. If a computer is offline, it picks up on the tasks after it 
comes online.

 You must use the -q2c (Queue to Computer) argument to have Printix Configurator offer this 
functionality.

See also:
• How to automatically add and remove print queues

Requirements
• The CSV file MUST be semi-colon (;) separated.

• Column headers are not allowed.
• Do not have spaces before or after a semi-colon.
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• To not be rejected as an invalid format, each row in the CSV file MUST have the same number 
of semi-colons. Padding with semi-colon may be necessary as demonstrated by this example:
• computer1;queueA;queueB;
• computer2;queueA;queueB;queueC;
• computer3;queueC;

• Hostnames of the computers must be unique within your Printix Home.
• Print queue names must be unique within your Printix Home.
• A print driver must be selected for the print queue for the relevant systems (Windows, macOS,

…).
• Print queue is added regardless whether it is Active.

 Ensure that you use Printix Configurator version 1.3.1250, which was released on 2022.12.22. If 
you use an earlier version, you get the error: Login failed (get token).

Create shortcut with -q2c argument
1. Right-click PrintixConfigurator.exe and select Create shortcut.
2. Right-click the shortcut and select Properties.
3. Select the Shortcut tab.
4. In the Target section, add -q2c like this: PrintixConfigurator.exe -q2c.

Start Printix Configurator
1. Right-click the Printix Configurator shortcut file and select Run as administrator.
2. Sign in.

You must have the System manager role.
3. If prompted, select a Printix Home.

Example:  acme.printix.net
To change language, select Menu  > Language.
After signing in to Printix Configurator, you can close the browser window.
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Import CSV file

1. In Enter CSV file, select the field and browse to the CSV file you wish to use. Alternatively, you 
can paste the path to the CSV file.
• Example content for the template file: Compix;Reception;Reception Staple.
• Uppercase and lowercase letters are treated the same.
• To not be rejected as an invalid format, each row in the CSV file MUST have the same 

number of semi-colons. Padding with semi-colon may be necessary.
2. Select Open.
3. Select Exit.

For troubleshooting, you can check the Printix Configurator log files. Output from a successful 
configuration is written as follows:
Read X computers from CSV file
Validating configuration...
Start applying configuration...
Done  applying configuration

 A delay of up to 30 minutes may occur before the result of the import is fully reflected in 
Printix Administrator. If a computer is offline, it will pick up on the tasks after it comes online.

If a print queue does not install, check the History on the computer for any hints on perhaps issues 
with the print driver and then try to change the print driver.
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Product Support

On the Printix - Quick Links page, you can contact Technical Support to help with your Printix issues.

In the Quick Links, select Contacting Support, then follow the instructions on the newly opened 
page.

If you cannot open a support ticket through Printix Administrator, see the Alternate method to 
open a technical support case for Printix section near the bottom of the page.
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How to

This topic contains easy-to-follow step-by-step procedures that are grouped by the following 
categories:
• Sign in
• Printers, print queues, and print drivers
• Users
• Deployment
• Networks and sites
• Groups
• Printix Go
• Capture and workflow
• Cloud storage
• Analytics and reports
• Troubleshooting

 If you have any questions or feedback, contact us or submit a support request and we will get 
back to you.

Sign in
• How to sign in
• How to reset your password
• How to add or change credit card
• How to change who receives subscription emails
• How to cancel subscription
• How to move your subscription to a Printix partner
• How to change the language
• How to open Printix Administrator
• How to open the Printix Client

Printers, print queues, and print drivers
• How to open the printer’s web page
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• How to add printers
• How to test if a printer can be reached
• How to give a printer a static IP address
• How to discover printers
• How to add an SNMPv1 configuration
• How to add an SNMPv3 configuration
• How to add an EFI Fiery printer
• How to create print queues
• How to activate a print queue
• How to automatically add and remove print queues
• How to add a print queue to computers
• How to test conversion of print queues on a single computer

• How to change the print driver
• How to add a print driver
• How to see uploaded print drivers
• How to work with print driver configurations
• How to add a new print driver configuration on Mac
• How to configure multiple print queues
• How to update print queues on computers
• How to create Printix Anywhere print queue
• How to configure Printix Anywhere print queue to use universal print driver

• How to search for printers
• How to use view mode on the Printers page
• How to print printer ID sign
• How to scan QR codes
• How to scan NFC tag
• How to register printer with NFC tag

• How to set the default printer
• How to print from home office
• How to print 2-sided by default
• How to print in black by default
• How to control if Print Anywhere documents should come out in color or black

• How to increase secure printing
• How to enable secure print
• How to enable Print Later
• How to enable Print Anywhere
• How to enable processing of PDF documents
• How to enable mobile print
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• How to add secure print to Universal Print

• How to use Single Sign-On with Ricoh Adaptable Authentication API
• How to use Single Sign-On with Kofax AutoStore
• How to use Single Sign-On with Tungsten TotalAgility
• How to print from Kofax Output Manager

• How to replace a printer
• How to remove printers
• How to remove print drivers
• How to install print drivers that are not signed by Microsoft

Users
• How to add users
• How to enable Microsoft Entra authentication
• How to enable Google authentication
• How to enable Okta authentication
• How to enable OneLogin authentication
• How to enable self-registration
• How to remove sign in with email
• How to add guest users to Microsoft Entra ID
• How to add multiple Microsoft Entra directories
• How to switch Microsoft Entra directory
• How to change the role of a user
• How to search for users

Deployment
• How to deploy Printix Client
• How to deploy Printix Client with Microsoft Endpoint Manager
• How to deploy Printix Client for Mac with Microsoft Endpoint Manager
• How to deploy Printix Client for Mac with Jamf Pro
• How to deploy Printix Client for Mac with Addigy
• How to include Printix Client in a managed image
• How to deploy Printix App for Android with Microsoft Endpoint Manager
• How to deploy Printix App for iOS/iPadOS with Microsoft Endpoint Manager
• How to search for computers
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Networks and sites
• How to work with sites
• How to add a site manager group to a folder or site
• How to remove a site manager group from a site
• How to add a network
• How to modify network name
• How to add an unknown network to a network
• How to add a gateway to a network
• How to delete a gateway from a network
• How to merge networks
• How to enable printing via the cloud

Groups
• How to work with groups
• How to enable Microsoft Entra groups
• How to enable Google groups
• How to add groups to a print queue
• How to add print queues to a group

Printix Go
• Install Printix Go
• How to install Printix Go on multiple printers
• How to update Printix Go
• How to install Printix Capture
• How to sign in with an ID code at the printer
• How to sign in with card at the printer
• How to release documents at the printer
• How to capture at the printer
• How to sign out
• How to register a card
• How to register a card without a phone
• How to manage cards
• How to reset the ID code or PIN code
• How to see and reset the ID code
• How to create and reset the PIN code
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• How to delegate printing
• How to uninstall Printix Go
• How to uninstall Printix Go from multiple printers

• How to test communication to Printix Cloud from the printer
• How to troubleshoot scan to email
• How to investigate Printix Go screen layout issues
• How to prepare Epson printer for Printix Go
• How to install card reader on Epson printers
• How to use Printix Go on Epson printers
• How to set up scan to email on Epson printers

• How to use Printix Go on HP printers
• How to set inactivity timeout on HP printers
• How to set up scan settings on HP printers
• How to set up scan to email on HP printers
• How to remotely access control panel on HP printers
• How to reset to factory settings on HP printers
• How to install card reader on HP printers
• How to set up SSL/TLS communication on HP printers
• How to enable the HP Workpath platform
• How to install HP Workpath on printers through HP Command Center
• How to sign in as an administrator on HP Workpath printers

• How to prepare Konica Minolta printer for Printix Go
• How to install card reader on Konica Minolta printers
• How to use Printix Go on Konica Minolta printers
• How to set up scan settings on Konica Minolta printers
• How to set up scan to email on Konica Minolta printers
• How to sign in as guest on Konica Minolta printers
• How to remotely access control panel on Konica Minolta printers

• How to prepare Kyocera printer for Printix Go
• How to use Printix Go on Kyocera printers
• How to change the language of a Kyocera printer
• How to set inactivity timeout on Kyocera printers
• How to set up scan to email on Kyocera printers
• How to sign in as guest on Kyocera printers
• How to remotely access control panel on Kyocera printers
• How to set up SSL/TLS communication on Kyocera printers

• How to prepare Lexmark printer for Printix Go
• How to use Printix Go on Lexmark printers
• How to set inactivity timeout on Lexmark printers
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• How to set up scan to email on Lexmark printers
• How to remotely access control panel on Lexmark printers
• How to reset to factory settings on Lexmark printers
• How to find the card reader IDs on Lexmark printers
• How to get Lexmark logs

• How to use Printix Go on Ricoh printers
• How to set up scan settings on Ricoh printers
• How to set up scan to email on Ricoh printers
• How to install card reader on Ricoh printers
• How to set up SSL/TLS communication on Ricoh printers
• How to set the web server password on Ricoh printers
• How to sign in as machine administrator on Ricoh printers
• How to sign in as guest on Ricoh printers
• How to remotely access control panel on Ricoh printers
• How to get logs from Ricoh printers

• How to prepare Xerox printer for Printix Go
• How to use Printix Go on Xerox printers
• How to configure SNMPv1/v2 on Xerox printers
• How to install card reader on Xerox printers
• How to set up scan to email on Xerox printers
• How to set inactivity timeout on Xerox printers
• How to sign in as machine administrator on Xerox printers
• How to remotely access control panel on Xerox printers

Capture and workflow
• How to get started with capture and workflow
• How to create a workflow for Connector
• How to create a workflow for email
• How to create a workflow for Microsoft OneDrive
• How to create a workflow for Microsoft SharePoint Online
• How to activate a workflow
• How to make a workflow available to selected groups
• How to grant access to Microsoft OneDrive
• How to grant access to Microsoft SharePoint Online

• How to install Printix Capture
• How to capture at the printer
• How to capture with Android phone and tablet
• How to capture with iPhone and iPad
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Cloud storage
• How to add Azure Blob Storage
• How to set up Azure Blob Storage CORS
• How to add Google Cloud Storage

Analytics and reports
• How to set up analytics
• How to set up Power BI
• How to publish to Power BI on the web
• How to interact with the Printix Power BI report

Troubleshooting
• Troubleshooting
• How to see what happened
• How to stop and start Printix Service
• How to see the version of Printix Client
• How to start the Print Spooler
• How to uninstall the Printix Client
• How to submit a support request
• How to do a network trace
• How to get Printix App logs
• How to get Windows logs
• How to get Mac logs
• How to get Printix Client logs

How to sign in

Sign in with Microsoft
If you see Sign in with Microsoft, select it to sign in with your Microsoft work or school account.
• The user is automatically registered the first time the user signs in with Microsoft to Printix.
• Single sign-on (SSO) to Printix with users' Microsoft account.
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• Automatic sign-in to Printix Client on Microsoft Entra joined Windows 10 and Windows 11 
computers.
• Works with Windows editions: Pro, Enterprise, and Education. Microsoft does not support 

Microsoft Entra join on Windows Home editions.
• Automatic sign-in to Printix Client on Microsoft Entra joined Windows Server 2016, 2019, and 

2022.

Sign in with Google
If you see Sign in with Google, select it to sign in with your Google Workspace account (not 
@gmail.com).
• The user is automatically registered the first time the user signs in with Google to Printix.
• Single sign-on (SSO) to Printix with users' Google Workspace account.

Sign in with OIDC
If you see Sign in with OIDC, select it to sign in with your OIDC account.
• The user is automatically registered the first time the user signs in with OIDC to Printix.
• Single sign-on (SSO) to Printix with users' OIDC account.

 On the Printix App for Android and iOS/iPadOS, to sign in with OIDC, select Alternate sign in, 
enter your Printix Home (such as acme.printix.net), then select OK. Then, you can select a sign-in 
method that is enabled, such as OIDC.

Sign in with Okta
If you see Sign in with Okta, select it to sign in with your Okta account.
• The user is automatically registered the first time the user signs in with Okta to Printix.
• Single sign-on (SSO) to Printix with users' Okta account.

 On the Printix App for Android and iOS/iPadOS, to sign in with Okta, select Alternate sign in, 
enter your Printix Home (such as acme.printix.net), then select OK. Then, you can select a sign-in 
method that is enabled, such as Okta.

Sign in with OneLogin
If you see Sign in with OneLogin, select it to sign in with your OneLogin account.
• The user is automatically registered the first time the user signs in with OneLogin to Printix.
• Single sign-on (SSO) to Printix with users' OneLogin account.

 On the Printix App for Android and iOS/iPadOS, to sign in with OneLogin, select Alternate sign 
in, enter your Printix Home (such as acme.printix.net), then select OK. Then, you can select a sign-
in method that is enabled, such as OneLogin.

593



Tungsten Printix Administrator Guide

Sign in with email
If you registered with your email address, select Sign in with email and enter your email address 
as the user name. If Active Directory authentication is enabled, you can sign in with your network 
user name and password.

 On the Printix App for Android and iOS/iPadOS, to sign in with email, select Alternate sign in, 
enter your Printix Home (such as acme.printix.net), then select OK. Then, you can select a sign-in 
method that is enabled, such as email (Printix account).

Alternate sign in

 If you have signed into the Printix App with your work or school account, but you are signed 
into the Printix Client with a different email address, you are not able to release the documents 
you printed, because they belong to your other account. To avoid confusion, use only one sign-in 
method.

• If you have issues while signing in to the Printix Client, see Sign in issues.
• After successful sign-in to Printix Client, you can close the browser window.
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New user
New users can be registered as follows:
• Automatic registration

Requires one of these methods to be enabled:
• Microsoft Entra authentication

User must have a Microsoft account.
• Google authentication

User must have a Google Workspace account.
• Active Directory authentication

User must have a network user name and password.
• Self-registration

User must have a work email address. Self-registration must be enabled.
• Invitation

User must have an email address. Have a System manager, or another user with an 
administrative role, add the user.

How to reset your password
If you forget your network password, contact your administrator or use the following procedure to 
reset it.

To change your password, or if you have forgotten your password:
1. On the sign-in page, select Forgot password.

This option is not supported for the Printix App for Android and iOS/iPadOS.
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2. On the Reset password page, enter the email address used when you registered.
3. Select Send.

An email is sent to you. If you do not see the email within a few minutes, check your spam/junk 
mail folder.

4. Open the email with the subject Reset password instructions and select Reset password.
If you ignore the email, your password is not changed.

5. On the Reset password page, enter your new password.
6. Select Reset.

How to add or change credit card
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How to add credit card
1. Open  Printix Administrator .
2. Select  Menu   >  Subscription .
3. Select Add credit card.
4. Fill in the details:

• Card number
The number of the card.

• MM / YY
The expiration month (MM) and year (YY) of the card.

• CVC
The card security code (CVC) is typically the last three or four digits printed, not embossed 
like the card number, on the signature strip on the back of the card.

5. Select I hereby authorize Printix to take payments from my credit/debit card account in 
accordance with the terms of my agreement with Printix.

6. Select Save.

How to change credit card
1. Open  Printix Administrator .
2. Select  Menu   >  Subscription .
3. Select Change credit card.
4. Fill in the details:

• Card number
The number of the card.

• MM / YY
The expiration month (MM) and year (YY) of the card.

• CVC
The card security code (CVC) is typically the last three or four digits printed, not embossed 
like the card number, on the signature strip on the back of the card.

5. Select I hereby authorize Printix to take payments from my credit/debit card account in 
accordance with the terms of my agreement with Printix.

6. Select Save.
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How to change who receives subscription emails

Invoices and payment information are by default sent to the email address of the first registered 
user. However, in Finance email, you can change this.

1. Open Printix Administrator .
2. Select  Menu   >  Subscription .
3. Enter a Finance email.
4. Select Save.
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How to cancel subscription
You can cancel at any time. Cancellation is effective at the end of your current subscription period.
• For monthly subscription

Cancellation is effective at the end of the month for which you have paid. Use the form on the 
Printix Administrator Support page to submit a support request informing us that you want to 
cancel your subscription. Cancellation is effective at the end of the month for which you have 
paid.

• For annual subscription
Cancellation is effective at the end of the year for which you have paid. Contact 
finance.printix@tungstenautomation.com.

How to move your subscription to a Printix partner
If your subscription is directly with Printix, you can submit a support request from within Printix 
Administrator requesting that you wish your subscription to be changed from direct to a Printix 
partner. Specify which partner you wish to change to.

The same goes if you wish to change from one Printix partner to another Printix partner. Specify 
which partner you wish to change to.

How to change the language
The default language is based on the language of your browser and computer OS.

If you change the language in the Printix App or in Printix Administrator, the selected language is 
stored in your profile.

The selected language is stored as browser data for these pages:
• Sign-in page
• Download page

Change the language for Printix App and Printix Administrator
1. Select Menu  > Language.
2. Select the language to use.

• If you are signed in, your choice of language is stored as part of your profile.
• Otherwise, it is stored as browser data.
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Change the language for Printix Client
Language is inherited from the computer OS. If the OS language is not among the supported 
languages, it uses the language saved as part of the user's profile in Printix. If no language is saved 
in the user's profile, English is used. To change the language in your profile, you need to sign in to 
the Printix App or Printix Administrator and change the language there.

How to open Printix Administrator
You can open the Printix Administrator in multiple ways on your computer, tablet, and phone.
• Visit printix.net and select Sign in. If you have the system manager role, you can select Printix 

Administrator to open this.
You are prompted to select a Printix Home if you:
• Sign in with Microsoft, and Microsoft Entra ID is used with multiple Printix Homes.
• Sign in with Google, and Google Workspace is used with multiple Printix Homes.
• Sign in with email, and your account is registered with multiple Printix Homes.

• On your computer, open the Printix Client menu and select Open Printix Administrator.
• Select the Printix Administrator link in the email with the subject Get started with Printix.
• Open a web browser and enter the Printix Home of your work or school (acme) followed by /

admin.
Example: https://acme.printix.net/admin
Do not put www in front of the address, because your browser will report the page as not private, 
untrusted, or as having problems with the security certificate.

• Bookmark Printix Administrator in your web browser.

Add to Home screen
Add Printix Administrator to the Home screen on your phone or tablet:
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Android 
1. On the Chrome for Android browser, select Menu.
2. Select Add to homescreen.

iOS/iPadOS 
1. On the Safari browser's toolbar, select the Share icon .

On iPhone and iPod Touch, the bar is at the bottom. On iPad, the bar is at the top.
2. Select the Add to Home Screen icon in the Share menu.

How to open the Printix Client
• Open the Printix Client on Windows
• Open the Printix Client on Mac

Windows
1. Locate the task bar.

You may need to select the arrow next to the notification area.

2. Select the Printix  icon.
If it does not appear, install the Printix Client.
The Printix Client menu appears.
• If you are already signed in, your name appears next to Sign in as another user. Otherwise, 

select Sign in.
• If you have issues while signing in to the Printix Client, see Sign in issues.

Mac
On the menu bar, select the Printix  icon.
If it does not appear, install the Printix Client.
The Printix Client menu appears.
• If you are already signed in, your name appears next to Sign in as another user. Otherwise, 

select Sign in.
• If you have issues while signing in to the Printix Client, see Sign in issues.
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How to open the printer’s web page
Printers that have a direct network connection often include a built-in web server that lets you 
manage the printer from any browser on the network.

1. Open a web browser and enter the printer's IP address (Example: 192.168.1.10) or hostname in 
the address bar.

2. After the printer's web page has loaded, you typically need to locate and select Sign in or
Login and then enter the printer's administrator user name and password.
See the documentation that came with your printer to determine the default administrator 
user name and password.

How to add printers

Add printers in Printix Administrator

• If you add the printer by IP address, make sure to give it a static IP address.
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• If the added printer does not appear after a few seconds, look for it on the Unregistered printers
page.

1. Open the Printers  page.
2. Select Add printer .
3. In Network, select the Modify  icon, then select the network where the printer is. Select

Select network.
Site managers can only select networks belonging to managed sites.

4. In SNMP configuration, optionally, select the Modify  icon, then select the SNMP 
configuration that matches the printer. Select Select SNMP configuration.
You can only select global SNMP configurations and SNMP configurations assigned to the 
selected network. If you select a network that does not contain all SNMP profiles of the 
selected SNMP configuration, the SNMP configuration field is set to the default SNMP 
configuration.

5. In Printer address, enter the IP address (such as 192.168.2.10) or hostname of the printer.
6. Select Add.
7. Optionally, open the Print queue properties page to perhaps:

• Change the Print queue name.
• Select Add print queue automatically.

To create additional print queues for the printer, open the Printer properties page, select the
Print queues tab, and select Create print queue.

See also:
• How to give a printer a static IP address
• How to discover printers
• How to activate a print queue

Add printers in Printix Client
• Add printers on Windows 
• Add printers on Mac 

Add printers in Printix Client for Windows

1. Select the arrow next to the notification area on the task bar.
2. Select the Printix Client icon .

The Printix Client menu appears.
3. Select Printers.
4. Select the printers you wish to install.

• If you see too many printers to choose from, you can do a Search .
• The search is not case-sensitive.
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• Administrators can always use all print queues. A star ★ appears after the printer ID if the 
print queue is not active.
Example: ASD ★ Reception.

5. Select Add.
After installation, the printers are listed as either Installed  or with Error  (installation 
failed).

6. Select Finish.
The print driver is downloaded to this installation folder:
• C:\Windows\System32\DriverStore\FileRepository

Add printers in Printix Client for Mac
1. On the menu bar, select the Printix Client icon .

The Printix Client menu appears.
2. Select Printers.
3. Select the printers you wish to install.

• If you see too many printers to choose from, you can do a Search .
• The search is not case-sensitive.
• Administrators can always use all print queues. A star ★ appears after the printer ID if the 

print queue is not active.
Example: ASD ★ Reception.

4. Select Add.
After installation, the printers are listed as either Installed  or with Error  (installation 
failed).

5. Select Finish.

How to ensure users only print to printers through Printix
On Windows, you can make a group policy and deploy the PowerShell script to users' computers. 
Printix Client will still be able to add printers, because it is running under the local system account.

Printers & scanners
Users will not be able to select "Add a printer or scanner" in "Printers & scanners." A note will say:
"Some settings are hidden or managed by your organization."
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Devices and printers
If users select "Add a printer" in "Devices and printers", they will get a "Restrictions" dialog box 
saying: "This operation has been cancelled due to restrictions in effect on this computer. Please 
contact your system administrator."

PowerShell script
$RegKey = "HKCU:\Software\Microsoft\Windows\CurrentVersion\Policies"
If(Test-Path ($RegKey + "\Explorer"))
{
$RegKey = "HKCU:\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer" 
  ##Enabled 
  New-ItemProperty -path $RegKey -name NoAddPrinter -value 1 -PropertyType DWord -Force
}
else
{
New-Item -path $RegKey -name Explorer
$RegKey = "HKCU:\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer" 
  ##Enabled 
  New-ItemProperty -path $RegKey -name NoAddPrinter -value 1 -PropertyType DWord

605



Tungsten Printix Administrator Guide

}

How to test if a printer can be reached
Use one of the below methods to verify if a printer can be reached by a computer (responds to the 
ping request). Make sure the printer is powered on and connected to the network.

Ping printer from Computer properties page
1. Open the Computer properties page.
2. Select Ping IP address.
3. Select the Printer  icon to select one of the printers on the network or paste the IP address 

from the clipboard.
On the Printer properties page, Printers page, and Unregistered printers page, you can 
copy the printer's IP address to the clipboard by hovering on the address, then select the 
appearing Copy IP address  icon.

Ping printer from Windows computer
Open a Command prompt and type: ping {192.168.1.10}
{192.168.1.10} is the printer IP address.

Ping printer from Mac computer
Open a Terminal and type: ping {192.168.1.10}
{192.168.1.10} is the printer IP address.

How to give a printer a static IP address
If a printer's IP address is not static, the IP address may eventually be changed by your DHCP 
server. The IP address may change after the printer has been to sleep, been powered off, or 
disconnected from the network. How quickly it happens depends on the lease time set in the DHCP 
server.

If the printer's IP address changes, all print queues that point to the network printer will stop 
working and show the printer as offline.

The above is a universal challenge with network connected printers referenced by IP address. Best 
practice is to either 1) Reserve the printer's IP address in your DHCP server, or 2) If your network 
can resolve the printer's hostname, then enter the hostname, and not the IP address, when you add 
the printer.

Configure your DHCP server to reserve the IP address based on the printer's:
• MAC address

Example and different formats:
F0921C637CA2
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F0:92:1C:63:7C:A2
F0-92-1C-63-7C-A2

The MAC and IP address appear on the printer's network configuration page. The MAC address is 
also known as the Physical address or the Hardware address. See the printer manual on how to 
print its configuration pages. On some printers, you can determine the IP address from its control 
panel menus.

When you reserve the printer's IP address in the DHCP server, you can choose to give the printer 
another IP address. If you do so, remember to: 1) Restart the printer so it gets the new IP address. 
2) Update the Printer address in Printix Administrator on the Setup  tab on the Printer 
properties page.
• Large organization

Probably a person or a team is responsible for the DHCP servers. Contact that person or team, 
and provide the printer's MAC address so an IP address can be reserved for the printer.

• Small organization
Your DHCP server is probably running inside your router equipment. You can access the web 
interface of most routers through: 192.168.1.1
See the router manual on how to reserve an IP address. Alternatively, try to search the Internet 
for instructions, because these will vary. Search for: Static IP address and the router's mark and 
model.

How to discover printers
Use "Discover printers" to add printers you suspect were not found during the initial discovery. The 
result is securely and silently transferred to the Printix Cloud without any required interaction.

To discover printers by hostname instead, see How to discover printers by hostname.
1. Open the Printers  page.
2. Select Discover printers.
3. Under Network, select a network.

Site managers can only select networks belonging to managed sites.
4. Optionally, under SNMP configuration , select an SNMP configuration.

You can only select global SNMP configurations and SNMP configurations assigned to the 
selected network. If you select a network that does not contain all SNMP profiles of the 
selected SNMP configuration, the SNMP configuration field is set to the default SNMP 
configuration.

5. Select Discover printers.
Discovered printers:
• After a few moments, select Refresh  on the Printers  page.
• If no new printers appear, look for them on the Unregistered printers page. Otherwise, 

it may be that the printers are perhaps already registered, or they are on another network 
subnet.
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To start discovery from a particular computer (print server)
1. Open the Computers  page.
2. Select the computer (print server) and select Modify.

Optionally, select Filters > Type > Server to find it.

3. On the Computer properties page, scroll to the Discover section.
Optionally, select an SNMP configuration.
You can only select global SNMP configurations and SNMP configurations assigned to any of 
the computer's networks.

4. Select Discover printers.
5. Select Confirm.

Discover printers on another network subnet
Use Printix Administrator to add one of the printers on the other network subnet, then repeat the 
discovery.

1. Obtain the address of one of the printers on the other network subnet.
2. Add that printer in Printix Administrator.
3. Start the discovery again.

See also:
• How to add printers
• How to activate a print queue
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How to add an SNMPv1 configuration

1. Select Menu    > Settings .
2. Select the SNMP tab.
3. Select Plus  to start adding a new SNMP configuration.
4. Select Version 1.
5. In Configuration name, enter a name for the configuration.
6. In Get Community Name, enter the community name exactly as it is on the printers.
7. In Set Community Name, enter the community name exactly as it is on the printers.
8. In Networks:

• If the configuration should be assigned to all networks, set it to Global.
• If the configuration should be assigned to specific networks only, select Select, then select 

the appropriate networks.
9. Select Save.

609



Tungsten Printix Administrator Guide

How to add an SNMPv3 configuration

1. Select Menu  Settings .
2. Select the SNMP tab.
3. Select Plus  to start adding a new SNMP configuration.
4. Select Version 3.
5. In Configuration name, enter a name for the configuration.
6. In Username, enter the SNMP user name exactly as it is on the printers.
7. Select a Security level for communication:

• No authentication and no privacy
• Authentication and no privacy
• Authentication and privacy

8. If required, select an Authentication protocol, and in Authentication key, enter the key.
9. If required, select a Privacy protocol, and in Privacy key, enter the key.

10. In Context name, enter the context name as it is on the printers.
11. In Networks:

• If the configuration should be assigned to all networks, set it to Global.
• If the configuration should be assigned to specific networks only, select Select, then select 

the appropriate networks.
12. Select Save.
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Printer vendor’s SNMPv3 context names
For most printer vendors, the context name can be left blank. For HP, it must be Jetdirect.

Vendor Context name

Brother user-defined

Dell

Epson EPSON

Fuji Xerox

HP Jetdirect

Konica Minolta user-defined

Kyocera

Lanier GWNCS

Lexmark

Ricoh GWNCS

Samsung

Sharp mfpdirect

Toshiba MFP

Xerox

How to add an EFI Fiery printer
If a printer is using an EFI Fiery Controller, also known as a Raster Image Processor (RIP), you should 
follow these instructions to get the printer added in Printix Administrator.

Before you begin, obtain the following information:
• IP address of the Fiery Controller

Printix may not recognize it as a printer, so it will not appear after a "Discover printers."

Add the EFI Fiery printer
1. Open a web browser and enter the IP address of the Fiery Controller and sign in.
2. Select the Configure tab.
3. Select Network and then SNMP.

• If required, add an SNMP configuration in Printix Administrator that corresponds to the Fiery 
Controller's SNMP settings.

4. In Printix Administrator, open the Printers  page.
5. Select Add printer .
6. In Network, select the Modify  icon to select the network where the Fiery Controller is. 

Select Select network.
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7. In SNMP configuration optionally, select the Modify  icon to select the SNMP configuration 
you perhaps added in step 3. Select Select SNMP configuration.

8. In Printer address, enter the IP address (example: 192.168.1.10) or hostname of the Fiery 
Controller.

9. Select Add.

Configure the print queue
Configure the print queue for the Fiery Controller so it:
• Uses the print driver for the printer with the Fiery Controller.

• If required, add the print driver to your Printix driver store.
• The model name of the registered printer may indicate a Fiery Controller is in use.

Example: Xerox Color C70 with Xerox EXC70 Fiery Integrated Controller

1. In Printix Administrator, proceed to How to configure print driver configuration on a Windows 
computer.
The temporary printer's Printer properties dialog box opens automatically.

2. Select the Accessories tab.
3. Select Two-Way Communication, and in Print IP Address or DNS Name, enter the IP address 

of the Fiery Controller.
Example:  192.168.1.10

4. Select Update.
5. After all Installed Options are registered correctly, clear Two-Way Communication, because 

this is not supported when the printer is managed by Printix.
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6. Select Apply.
7. Optionally, open the Advanced tab and select the Printing Defaults button to configure per-

printer defaults.

 The print driver configuration stores the Printing Defaults. It does NOT store Printing 
Preferences.

8. Select OK.

How to create print queues
1. On the Printer properties page, select the Print queues  tab.
2. Select Create print queue .
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3. In the Create print queue dialog box, enter a print queue name.
• Cannot contain the characters "\" and ",".
• Must be unique for the printer. Uppercase and lowercase letters are treated the same.
• The print queue name is what users will see on their computer and in Printix Client. If, for 

example, two active print queues exist, you should name them so users will not only know 
the physical printer, but also be able to determine the difference in purpose of the print 
queues.
Example:
• The printer named Reception has two queues with the print queue names: Reception and 

Reception Staple.
• Reception is for general purpose and the one most frequently used of the two print 

queues.
• Reception Staple has a print driver configuration that will staple sheets together by 

default.
4. Optionally, clear Active to allow administrators (you) to test printing before allowing users to 

add the print queue.
5. Select Confirm.

• All print queues are created with the IPPS port. Existing print queues are converted to IPPS port, 
including any print queues that are converted to Printix print queues.

• See also:
• How to create Printix Anywhere print queue
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How to activate a print queue
1. Open the Workflow properties  page.
2. Select Active.
3. Select Save.

It is recommended to mount the printer ID sign at the printer, so it is easy for users to identify 
the printer.
Clearing Active will not remove the print queue from computers where it is already installed. 
To remove a print queue from computers, delete the print queue.
Print queues that are not active can only be used by you as an administrator:
• You can select the printer in Printix App.
• You can add the printer in Printix Client.
• The three-letter printer ID has a star ★ at the end in Printix Client.

Example: ASD ★ Reception
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How to automatically add and remove print queues

1. On the Print queues page, select individual print queues and select Modify.
2. Select Add print queue automatically to add the selected print queues automatically on 

users' computers running Printix Client.
Only available if the print queue is Active.
• Print queue is added automatically when the computer is on the same network as the 

printer network or if Via the cloud is selected for the print queue.
• Print queue is not added automatically while a computer is on an unknown network.
• Print queue can also be added automatically based on users' and computers' group 

membership.
3. Optionally, select Remove print queue automatically to remove the print queues 

automatically when the computer connects to another registered network.
Not available if Via the cloud is selected.
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 The print queue is not removed if all the following conditions apply:
• The user is signed in to the Printix Client.
• The user is a member of the print queue's group.
• On the "Groups" tab, "Add print queue automatically" is selected.

4. Select Save.
• It may take a few minutes before the print queue is added (driver may need to be 

downloaded).
• If the computer is offline, it will add the print queue when it comes online.

See also:
• How to add print queues to computer
• How to add a print queue to computers
• How to add print queues to computers with Printix Configurator
• How to work with print driver configurations
• Add printer issues
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How to add print queues to computer

1. On the Computer properties page, select the Print queues  tab.
2. Select Add print queues to computer.
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3. Select the print queues to select the print queues to be added on the computer.
A star ★ appears after the printer ID if the print queue is not active.

4. Select Add.

 Print queues are added after the computer is on a known network.

Search
1. Select Search .
2. Enter print queue name or printer ID.

The search is not case-sensitive.

Filters
Select Filters.
• Select Network to filter by this. The same network as the computer is selected by default.
• Select Active to filter by this.
• Select Add print queue automatically to filter by this.
• Select Remove print queue automatically to filter by this.
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• Select Via the cloud to filter by this.
• Select Print 2-sided by default to filter by this.
• Select Print in black by default to filter by this.

How to add a print queue to computers

1. On the Print queue properties page, select the Computers  tab.
2. Select Add print queue to computers.
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3. Select the computers to have the print queue added to these computers.
4. Select Add.

 Print queues are added after the computer is on a known network.

Search
1. Select Search .
2. Enter part of the computer's hostname.

The search is not case-sensitive.

Filters
Select Filters.
• Select Network to filter by this.
• Select Type to filter by this.

• Desktop
• Laptop
• Server
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• Select System to filter by Windows and macOS editions.
• Select OS to filter by Windows and macOS.

How to test conversion of print queues on a single computer
Before you enable this on a larger scale, you can test conversion of print queues on a single 
computer. At conversion, the port settings are modified to use an Internet port and allow printing 
through Printix.
• Network printers are converted if they are set up with a Standard TCP/IP Port or WSD Port.
• Shared network printers are converted.

Example: Reception on PrintServer becomes Reception ASD, ASD Reception, or Reception 
depending on the choice of print queue naming.
See also: Why is the shared print queue not converted right away?

• Locally connected printers (USB) are not converted.
• No printers are converted on servers.

1. On the Computer properties page, select the Print queues  tab.
2. Select Convert print queues.
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 A delay of up to 30 minutes may occur before the result of the Convert print queues task 
is fully reflected in Printix Administrator. If the computer is offline, it will pick up on the tasks 
after it comes online.

Why is the shared print queue not converted right away?
These conditions must be met before the shared print queue is converted:
• The name of the print queue (Reception) must match.

Example: Reception on PrintServer
• The computer must be on the same network as the printer, or the print queue has "Via the cloud"

selected.

If a shared print queue has been added since Printix Client was started, it will not be converted until 
the computer is restarted or the user signs out of the computer and signs in to the computer again.

Restart the computer.

Alternatively, follow these steps:

On your Windows  computer:
1. Open the Task Manager.
2. Select the Details tab.
3. Select PrintixClient.exe and select End task. Select End process.
4. Select the Start  button. In the Search box, type: Printix. Select Printix Client in the list that 

appears.

On your Mac  computer:
1. Select the search icon in the top right corner.
2. Type: terminal, and select Enter.
3. In the Terminal window, type the relevant command:

• Stop Printix Client UI with the unload command by typing:
launchctl unload /Library/LaunchAgents/net.Printix.UI.plist

• Start Printix Client UI with the load command by typing:
launchctl load /Library/LaunchAgents/net.Printix.UI.plist

How to change the print driver
If you are not satisfied with the default choice of print driver, you can change it. If you want to use a 
print driver that is not in the Printix driver store, you can add the print driver yourself by making a 
printer use it on the Windows or macOS edition in question.

1. On the Print queue properties page, select the Drivers  tab.
2. Identify the System.
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Example:  Windows 10 ×64
3. Select  and Change print driver .
4. On the Print drivers page, Search  for print driver.

The search is not case-sensitive.
• Select Back to return to the Print queue properties page.
• Select Refresh  to refresh the list.
• Select Load more at the bottom of the page to see more drivers.
• If the print driver is uploaded, the date and time of the upload is shown below the print 

driver name.

 If possible, ALWAYS select the print driver name that includes a version number. This is 
to mitigate that Windows cannot differentiate between versions of the print driver unless the 
version is reflected in the print driver name. This is particularly important when working with
universal print drivers.

5. Select the print driver.
• It may take up to 10 minutes before an uploaded print driver is available on the Print 

drivers page.
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• If the print driver does not match the printer's page description language (PCL, PCLXL, 
POSTSCRIPT), you will either not get any print at all or lots of pages with weird looking 
characters.

• If you cannot find a print driver listed for a specific model, check to see if it is included as 
part of a series of printers. For example, a printer with the model number 603 might use the 
print driver for the 600 or 600 Series.

• If multiple matching print drivers exist and their name includes for example PCL 6 or 
PostScript, then cross-check with the printer's supported formats (page description 
language) listed on the Printix Print drivers page, for example: POSTSCRIPT, PCLXL (same as 
PCL 6).

• If the print driver has two editions, one with a version number, then always select the print 
driver that includes a version number.

• Host-based printers (typically cheaper printers) has built-in support for Windows Graphical 
Device Interface (GDI) and rely on the Windows computer to rasterize the pages into dots 
(bitmaps).

6. Select Change print driver. The print driver selection will be locked .
7. Optionally, print a test page to make sure the print driver works properly with the printer.

How to tell if your Windows is 64-bit or 32-bit
1. Open the File Explorer.
2. Right-click This PC and select Properties.
3. Look at System type to see if you are running a 64-bit Operating System or a 32-bit Operating 

System.

How to print a test page

Windows 
1. Open Device and Printers.
2. Right-click printer and select Printer properties.
3. Select Print Test Page.

Mac 
1. Select Apple menu  > System Settings, then select Printers & Scanners.
2. Select the printer and select Print Queue.
3. On the menu bar, select the Printer menu and select Print Test Page.

Mac  (macOS version 12 or lower)
1. Select Apple menu  > System Preferences, then select Printers & Scanners.
2. Select the printer and select Open Print Queue.
3. On the menu bar, select the Printer menu and select Print Test Page.
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Build your Printix driver store
During the implementation phase, you will build your Printix driver store, as you:
• Install Printix Client on existing Windows print servers

After installation of Printix Client on the server, Printix Client will upload print drivers. Print 
drivers that are installed but not used by a print queue, are not uploaded. Print queues are not 
converted on servers. Only x64 print drivers are uploaded from the print server. If you need x32 
print drivers, these would need to be uploaded from a computer running the corresponding 
Windows 32-bit Operating System.

• Deploy Printix Client
As Printix Client is deployed on computers that run Windows 32-bit Operating System and 
macOS, Printix Client will upload these print drivers. Print drivers that are installed but not used 
by a print queue are not uploaded.

See also:
• How to add a print driver
• How to work with print driver configurations
• Print drivers
• Universal print drivers

How to add a print driver
Install a TCP/IP print queue that uses the print driver you want to add to Printix. After adding the 
print queue, Printix Client will automatically upload the new print driver to your Printix driver store, 
as soon as the Printix Service is restarted either manually or by restarting the computer.

 Printix Client will look at the installed print queues and their print drivers. It will NOT look at 
print drivers that are not in use.

1. On your Windows computer, either insert the print driver CD or download the print driver from 
the printer vendor's web site.

2. Install the printer using the CD and/or:
• Add a printer on Windows 
• Add a printer on Mac 

3. Optionally, use Print test page to verify that the print driver works and is compatible with the 
printer.

4. Stop and start the Printix Service.
If a new print driver is found it will be uploaded to your driver store.
• It may take up to 10 minutes before the uploaded print driver is available on the Print 

drivers page.
• You should repeat the above steps for the additional Windows and/or Mac editions used in 

your organization.
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• If a particular printer has no dedicated print driver, an appropriate Universal print driver 
may be used.

Add a printer on Windows

1. Open Devices and Printers in Windows.
2. Select Add a printer.
3. Select The printer that I want isn't listed.
4. Select Add a printer using a TCP/IP address or hostname. Select Next.
5. As Device type, select TCP/IP Device.
6. Clear Query the printer and automatically select the driver to use.
7. Enter Hostname or IP address of the printer.

The print driver will still be uploaded if you enter an address that does not point to the printer, 
but you will not be able print a test page to verify the print driver works with the printer.

8. Select Next.
9. Select Have Disk.

10. Browse to the folder where you installed/unpacked the print driver and browse through the 
folders until you locate an .inf file.

627



Tungsten Printix Administrator Guide

11. Select Open.
12. Select OK.
13. Select the printer. Select Next.
14. If asked, select Replace the current driver. Select Next.
15. Select Next to start the installation of the printer.
16. Select Do not share this printer. Select Next.
17. Select Finish.
18. Stop and start the Printix Service.

Add a printer on Mac
1. Select Apple menu  > System Settings, then select Printers & Scanners.
2. Select Add Printer and select Scanner or Fax.
3. Select the IP (globe icon) tab.
4. In Address, enter the IP address of the printer.

The print driver will still be uploaded if you enter an address that does not point to the printer, 
but you will not be able print a test page to verify the print driver works with the printer.

 On rare occasions, the upload of print driver may not happen due to unfortunate timing 
of events if Convert print queues is selected. To work around this problem, just enter an IP 
address that does not point to the printer (such as 1.2.3.4).

5. In Protocol, select Internet Printing Protocol - IPP.
6. In Use, select Select Software to open the Printer Software dialog box.
7. Select the print driver and select OK.
8. Select Add to add the printer with the selected print driver.
9. Stop and start the Printix Service.
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Add a printer on macOS version 12 or lower

1. Select Apple menu  > System Preferences, then select Printers & Scanners.
2. Select Add (+) and select Add Printer or Scanner.
3. Select the IP tab.
4. In Address, enter the IP address of the printer.

The print driver will still be uploaded if you enter an address that does not point to the printer, 
but you will not be able print a test page to verify the print driver works with the printer.

 On rare occasions, the upload of print driver may not happen due to unfortunate timing 
of events if Convert print queues is selected. To work around this problem, just enter an IP 
address that does not point to the printer (such as 1.2.3.4).

5. In Protocol, select Internet Printing Protocol - IPP.
6. In Use, select Select Software to open the Printer Software dialog box.
7. Select the print driver and select OK.
8. Select Add to add the printer with the selected print driver.
9. Stop and start the Printix Service.
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 With Printix Client for Mac version 1.3.1002 (2021-02-08), the packaging of print driver 
files was modified to properly handle the use of symbolic links (soft links). Relatively few print 
drivers use symbolic links. Use of an incompletely packaged print driver for printing could 
result in the message: Stopped - 'Filter' failed. If you experience this, check the date of the
uploaded print driver and change to the newest, that is, the one that was uploaded after 
updating to Printix Client for Mac version 1.3.1002 or higher.

How to see uploaded print drivers

1. On the Printer queue properties page, select the Drivers  tab.
2. Identify the System.

Example:  Windows 10 ×64
3. Select  and Change print driver .
4. Select Show only uploaded print drivers to list print drivers that have been uploaded and 

added to your Printix driver store.
• Search  for print driver. The search is not case-sensitive.
• Select Load more at the bottom of the page to see more drivers.
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• Select Refresh  to refresh the list.
• Select  and  Modify to select the Language the print driver is using (Example: Español) 

and write an optional Comment. Unknown language is shown if the language has not been 
confirmed. Select Other language if the language is not among the 18 languages, then 
write the language as a Comment. Universal print drivers often support multiple languages. 
Print drivers in the Printix driver store that were published before this functionality was 
introduced (May 2017) may be shown as Unknown language, but in most cases, the driver 
will be in English.


• If possible, ALWAYS select the print driver name that includes a version number. This is to 

mitigate that Windows cannot differentiate between versions of the print driver unless the 
version is reflected in the print driver name. This is particularly important when working 
with universal print drivers.

• With Printix Client for Mac version 1.3.1002, the packaging of print driver files was 
modified to properly handle the use of symbolic links (soft links). Relatively few print 
drivers use symbolic links. Use of an incompletely packaged print driver for printing could 
result in the message: Stopped - 'Filter' failed. If you experience this, check the date of 
the uploaded print driver and change to the newest, that is, the one that was uploaded 
after updating to Printix Client for Mac version 1.3.1002 or later.

How to work with print driver configurations

Instead of using the print driver's factory default settings, you can add your own print driver 
configuration. When the printer is added on the user's computer, the configuration is added as well. 
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That way, the user does not have to make these configuration changes. If you are satisfied with the 
print driver's factory defaults, you do not need to make a print driver configuration.

Watch this video: Printix Tutorial Series Part 5 - Working with print driver configurations.

 The print driver configuration stores the Printing Defaults. It does NOT store Printing 
Preferences.

Print driver configuration consists of:
• Device Settings

Specifies the availability of Installable Options (such as Paper trays, Duplexer, Staple, Hole 
punch, and Output bins), and for example, Form to tray Assignment. If the print driver is a 
Universal print driver, you may have to select a Configuration tab and perhaps also set the
Printer model.

• Printing defaults
Open the Advanced tab and select the Printing Defaults button to configure per-printer 
defaults. Printing defaults include Advanced Document Settings (such as Print 2-sided, and Print 
in black), and for example, Finishing Options.

See also:
• How to add a new print driver configuration
• How to rename a print driver configuration
• How to modify a print driver configuration
• How to delete a print driver configuration
• How to configure Printix Anywhere print queue to use universal print driver
• Universal print drivers

How to add a new print driver configuration
Windows 

Print driver configurations can be made using these methods:
• Configure on computer: The print driver configuration is interactively configured on a computer 

in the Windows "Printer properties" dialog box of a temporarily added Windows printer.
• The computer must be online and MUST be on the same network as the printer.
• The print driver configuration is made interactively in the Windows "Printer properties" dialog 

box.
• You and only you (same user as in Printix Administrator) must be signed in to Printix Client on 

the computer.
• Upload from computer: The print driver configuration is uploaded from the selected Windows 

computer.
• The computer must be online and the print queue MUST be installed on the computer already.
• The print driver configuration is made in advance in the Windows "Printer properties" dialog 

box.
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• We do not recommend use of Windows class drivers. Class drivers are not uploaded to the 

Printix driver store, because they are supposedly distributed with Windows, but availability may 
vary depending on the version of Windows. We recommend use of the printer vendor supplied 
print drivers and universal print drivers, because these offer advanced features and better 
control compared to class drivers.

• Use the Upload from computer method if you want to configure print driver provided 
document release (aka. Private print, Hold print, PIN print, …) or other account based 
features. The print drivers encrypt these sensitive settings based on the print queue name. 
Encryption is used with universal print drivers from: Konica Minolta and Toshiba.

Mac 
• Upload from computer: Print driver configuration is uploaded from the selected macOS 

computer.
• The computer must be online and the print queue MUST be installed on the computer already.
• The print driver configuration is made in advance with CUPS.

How to configure print driver configuration on a Windows computer
1. Open the Print queue properties  page.
2. Select the Drivers  tab.
3. Identify the System.

Example:  Windows 10 ×64
4. Select Add a new configuration .

 For best user experience, open Printix Administrator on the same computer you want to 
make the print driver configuration on.

5. In the Add a new print driver configuration dialog box:
• Select Configure on computer to make the configuration in a temporary printer's 

properties dialog.
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• Enter Configuration name.
Example: A4, Tray 2+3, Stapler

• Select the Computer you want to use to make the configuration. You and only you must be 
signed in to the computer.

• You cannot select computers where other users are also signed in.
Example: COMPIX (Users: 2)

• If the Select computer list is empty, it is because you are not signed in to the Printix Client 
on a computer that matches the System (Windows 10 ×64).

• For best user experience, open Printix Administrator on the same computer you want to 
modify the print driver configuration on.

• If you are remotely signing in to the computer, we recommend that you also open Printix 
Administrator on the computer.

6. Select Confirm.
7. On the computer Printix Client, open the Print driver configuration dialog box to show the 

progress:
• Downloading print driver

This may take several minutes depending on the size of the print driver and the speed of 
your Internet connection.

• Adding temporary printer

 If the Print driver configuration dialog box closes unexpectedly, it could be because the 
print driver did not install in a timely manner. Wait a few minutes to allow the print driver to 
be installed and then try again. Inform Product Support if it still fails.
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8. Make your changes in the PRINTER_TMPxxxx properties dialog box.
Make sure to make your changes within 10 minutes, because the dialog box is closed 
automatically.
• Your view of the dialog box may be blocked by other windows. Press Alt+Tab to switch 

between windows.
9. Open the Device Settings tab to configure Installable Options and Form to Tray 

Assignment.
• See the section Print drivers for detailed instructions.

10. Open the Advanced tab and select the Printing Defaults button to configure per-printer 
defaults.
• See the section Print drivers for detailed instructions.

 The print driver configuration stores the Printing Defaults. It does NOT store Printing 
Preferences.

635



Tungsten Printix Administrator Guide

11. Select OK.
• Saving print driver configuration

The print driver configuration is uploaded to the Printix Cloud.
• Deleting printer PRINTER_TMPxxxx

The temporary printer is removed from the computer.
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12. In Printix Administrator:
• The print driver configuration is selected.
• The print driver selection is locked .

13. Use Update print queues to make the changes take effect on computers where the print 
queue is already installed.

How to upload print driver configuration from a Windows computer

 The print driver configuration stores the Printing Defaults. It does NOT store Printing 
Preferences.

1. Open the Print queue properties  page.
2. Select the Drivers  tab.
3. Identify the System.

Example:  Windows 10 ×64
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4. Select Add a new configuration .

5. In the Add a new print driver configuration dialog box:
• Select Upload from computer.
• Enter Configuration name.

Example: A4, Tray 2+3, Stapler
• Select an online Computer you want to upload the configuration from.
• The print queue MUST be installed on the computer already.
• Optionally, select Filter to filter on the type of computer (Desktop, Laptop, and Server).

6. Select Confirm.
The print driver configuration is uploaded to the Printix Cloud.

7. In Printix Administrator:
• The print driver configuration is selected.
• The print driver selection is locked .

8. Use Update print queues to make the changes take effect on computers where the print 
queue is already installed.

How to rename a print driver configuration
1. On the Print queue properties page, select the Drivers  tab.
2. Identify the System.

Example:  Windows 10 ×64
3. Select the Modify  icon.
4. Edit the Configuration name.
5. Select Save.

How to modify a print driver configuration
1. On the Print queue properties page, select the Drivers  tab.
2. Identify the System.

Example:  Windows 10 ×64
3. Select the Setup  icon.
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4. In the Modify print driver configuration dialog box, follow the same steps as in How to add a 
new print driver configuration.

 The print driver configuration stores the Printing Defaults. It does NOT store Printing 
Preferences.

How to delete a print driver configuration
1. On the Print queue properties page, select the Drivers  tab.
2. Identify the System.

Example:  Windows 10 ×64
3. Select the Delete  icon.
4. Select Yes to delete the configuration.

How to add a new print driver configuration on Mac
Instead of using the print driver's factory default settings, you can add your own print driver 
configuration. When the printer is added on the user's computer, the configuration is added as well. 
That way, the user does not have to make these configuration changes. If you are satisfied with the 
print driver's factory defaults, you do not need to make a print driver configuration.

How to upload print driver configuration from a macOS computer

1. Open the Print queue properties  page.
2. Select the Drivers  tab.
3. Identify macOS as the System.
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4. Select Add a new configuration .
You can make the print driver configuration with CUPS.

5. In the Add a new print driver configuration dialog box:
• Enter Configuration name.

Example: A4, Tray 2+3, Stapler
• Select an online Computer you want to upload the configuration from.
• The print queue MUST be installed on the computer already.
• Optionally, select Filter to filter on the type of computer (Desktop, Laptop, and Server).

6. Select Confirm.
The print driver configuration is uploaded to Printix Cloud.

7. In Printix Administrator:
• The print driver configuration is selected.
• The print driver selection is locked .

8. Use Update print queues to make the changes take effect on computers where the print 
queue is already installed.

Make the print driver configuration with CUPS
On your Mac  computer with the Printix printer installed:

1. Open a web browser and type:
http://localhost:631/printers/

2. The web interface of the macOS printing system (CUPS) opens on the Printers page.
If you see the message Web Interface is Disabled, enable the CUPS web interface.

3. Select the Printix printer you want to configure.
Example:  ASD Reception
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4. Change Administration to Set Default Options.
5. The Set Printer Options page opens.

• On the General tab, make your changes to the printing defaults.
• Select Set Default Options.

6. Depending on the print driver, you may see additional tabs, such as Options Installed.
• If relevant, make your changes to the options installed.
• Select Set Default Options.
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Enable the CUPS web interface
On your Mac  computer:

1. Select the search icon in the top right corner.
2. Type: terminal, and select Enter.
3. In the Terminal window, type:

cupsctl WebInterface=yes

How to configure multiple print queues

If you have a lot of printers of the same model and need to make the same configuration change 
on all of them, you can save time with Distribute print queue configuration. The destination print 
queues will be set up with same print drivers and print driver configurations as selected for the 
originating print queue.

 If possible, ALWAYS select the print driver name that includes a version number. This is to 
mitigate that Windows cannot differentiate between versions of the print driver unless the version 
is reflected in the print driver name. This is particularly important when working with universal 
print drivers.
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Watch this video: Printix Tutorial Series Part 6 - Distributing print driver configurations
1. On the Print queue properties page, select the Drivers  tab.
2. Select Distribute print queue configuration.

 Only if the print driver is Locked will this also become the print driver in the destination 
print queue. Otherwise, the destination print queue will be set to Automatic selection of 
print driver, in which case, Printix will select a print driver based on the printer model.

3. Select the print queues to receive the print queue configuration.
A star ★ appears next to the printer ID if the print queue is not active.

4. Select Distribute.

 To have already installed print queues adopt the new configuration, see How to update 
print queues on computers.

Search
1. Select Search .
2. Enter print queue name or printer ID.
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The search is not case-sensitive.

Filters
Select Filters.
• Select Network to filter by this. The same network as the computer is selected by default.
• Select Active to filter by this.
• Select Add print queue automatically to filter by this.
• Select Remove print queue automatically to filter by this.
• Select Via the cloud to filter by this.
• Select Print 2-sided by default to filter by this.
• Select Print in black by default to filter by this.

How to update print queues on computers
If you have changed print driver or made print driver configuration changes, you must use Update 
print queue to have these changes take effect on already installed print queues. The print queue 
on the destination computer will be removed and then added again with new print driver and/or 
print driver configuration.

Update print queue on a computer
1. On the Computer properties page, select the Print queues  tab.
2. To update a print queue, select  and Update print queue.
3. Select Confirm.

Update print queues on multiple computers
1. On the Print queue properties page, select one of these tabs:

• Drivers 
• Computers 

2. Select Update print queue on computers.
The button is only available if at least one computer has the print queue installed.

3. Select Confirm.

644



Tungsten Printix Administrator Guide

How to create Printix Anywhere print queue

1. On the Settings page, select the Secure print  tab.
2. Ensure that Enable Print Anywhere is selected.
3. Select Setup  to open the Print Anywhere  menu.
4. Select Create print queue to create a Print Anywhere print queue.
5. In the Create print queue dialog box, enter Print queue name.

• Cannot contain the characters "\" and ",".
• Must be unique for the printer. Uppercase and lowercase letters are treated the same.

6. Optionally, clear Active to allow administrators (you) to test printing before allowing users to 
add the print queue.

7. Select Save.

• All print queues are created with the IPPS port. Existing print queues are converted to IPPS port, 
including any print queues that are converted to Printix print queues.

• See also:
• How to configure Printix Anywhere print queue to use universal print driver
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How to configure Printix Anywhere print queue to use 
universal print driver

If you have a homogeneous printer fleet, you can choose to change the print driver for the Printix 
Anywhere print queue to a universal print driver that supports your registered printers. By default, 
the Printix Anywhere print queue sends data to the printer as PDF without control of finishing 
options and number of copies (always 1). Changing it to use a universal print driver is required to 
configure the "Device settings" and "Printing defaults" and set the "Number of copies."

Prerequisites
• Printer fleet is homogeneous

Printers are preferably from the same printer vendor, possibly also limited to a few printer 
models.

• Universal print driver
Choose your preferred printer vendor's universal print driver. The print driver's format (page 
description language, for example: PostScript or PCL) MUST be supported by all printers. 
Otherwise, users will either not get any print at all or lots of pages with weird looking characters.

Configuration of universal print driver
1. Identify the universal print driver you want to use.
2. Identify a registered printer you want to use to make the print driver configuration.

• The computer you use must be able to connect to the printer.
• To achieve maximum control with finishing options, select a printer that has the most

Installable options (such as Paper trays, Duplexer, Staple, Hole punch, and Output bins). 
If the user has selected hole punch and releases the document to a printer that does not 
support hole punch, the document is printed anyway (without holes).

3. Create a print queue for the identified printer without making it active. Name it for example:
Anywhere setup.

4. For each system:
• Change print driver to the universal print driver.
• Add a new print driver configuration.

5. When done, use Distribute print queue configuration to apply the Anywhere setup print 
queue configuration to the Printix Anywhere print queue.

6. Use Update print queues to make the changes take effect on computers where the Printix 
Anywhere print queue is already installed.

How to search for printers
Use Search  to find printers.
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Search for printers in Printix Administrator
1. Open the Printers  page.
2. Select Search .

Enter printer ID, name, location, or address.
The search is not case-sensitive.

Search for printers in Printix Client
1. Open the  Printix Client  menu.
2. Select Printers.
3. Select Search for printer.
4. Enter printer ID, name, or location.

The search is not case-sensitive.
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How to use view mode on the Printers page

Select  View mode to control what printer information should be shown. The "ID" and "Printer 
name" columns are always shown.
• Default: An overview of printers, their status, and location. Columns:

• Queues, Status, Network, Address, Created, and Location.
• Connection: Useful if you are using SNMP settings and different protocols. Columns:

• Status, Network, Address, MAC address, SNMP configuration, and Protocol.
• Printix Go: Useful for managing Printix Go on your printers. Columns:

• Status, Installation, Vendor, Go version, Go configuration, and Sign in profile.
• Customized: Create your own customized view mode with the printer information you select.

How to use the Printix Go view
1. Select  View mode.
2. Select Printix Go.
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3. Select Confirm.
4. Optionally, select printers.
5. Select Actions in the upper left corner and select between:

• Install
• Update (printers with an outdated Go version are listed with their version number in 

orange)
• Uninstall

A new dialog box appears.
6. If you selected Install, you can also Assign Go configuration and Assign sign in profile.

Make your selections.
7. Select the action to be performed (Install, Update, or Uninstall).

 You can install, update, and uninstall 20 printers at a time, but we recommend to restrict 
it to 5 for the time being. This is to prevent the browser from clogging up and becoming 
unresponsive while the requests are being fulfilled. We are currently working on a task-based 
feedback data-flow that removes the current limitation.

How to create a customized view
1. Select  View mode.
2. Select Customized.
3. Build you view mode by dragging items from the Options list to the Selected list.

Available Options:
• Card readers

The card readers connected to the printer. Hover over the text to see the Vendor ID (VID) 
and Product ID (PID) of the card reader.

• Created
The date the printer was registered

• Go configuration
The name of the Printix Go configuration.

• Go version
The version of the Printix Go software.

• IP address
The printer's hostname or IP address.

• Location
The location of the printer.

• MAC address
The hardware address of the printer.

• NFC tag
If the printer has been registered with an NFC tag.

• Network
The name of the network the printer is on.
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• Protocol
The protocols (IPP, IPPS, LPR, RAW) supported by the printer.

• Queues
The number of print queues.

• SNMP
The name of the SNMP configuration.

• Serial number
The serial number of the printer.

• Sign in profile
The name of the Printix Go sign in profile.

• Status
The staus of the printer

• Toner
Toner levels in percentage (see Disclaimer).

• Vendor
The name of the printer vendor.

4. Select Confirm.

How to print printer ID sign
The printer ID sign makes it easy to identify the physical printer. By scanning the QR code, you 
can open the Printix App and select the printer in one go. The name of all Printix printers is 
automatically extended with a unique, three-letter ID, also known as the printer ID.

If you want customized printer ID signs and/or print on adhesive labels, then use Download 
printer ID sign. The CSV file can be used with, for example, Microsoft Word to design and control 
what information you want on the ID sign. Insert, for example, help desk contact information and 
your company logo.

1. Open the Printers  page.
2. Select one or more printers and select Modify.
3. Select Print printer ID sign. Use the browser to print the page with the printer ID signs.

If you selected multiple printers, you can select Download printer ID sign to make customized 
printer ID signs.

See also:
• How to scan QR codes
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Mounting the printer ID sign

Printer ID sign mounted on printer

• If you printed on adhesive labels, mount the label on the printer itself or on a surface at the 
printer.

• Otherwise, use a scissor to cut out the slip with the three-letter ID and QR code. Use adhesive or 
double-adhesive tape to mount the ID sign on the printer.

• If you have adhesive pockets to hold business cards (90mm x 50mm) or credit cards (85mm x 
55mm), you can mount these and put the ID sign inside.

Customized printer ID signs
1. Open the Printers  page.
2. Select multiple printers and select Modify.
3. Select Download printer ID sign to download the CSV file: signIds.csv.

The first row contains the column headings and the subsequent lines (one per printer) contain 
the data:
• url: The content URL for the QR code (https://acme.printix.net/qrRedirect/printers/ASD)
• signId: The three-letter printer ID (ASD, BNM, …)
• name: The printer name (Reception)
• modelname: The printer model (HP Officejet Color X555)
• location: The location (Head Office, Reception)

Microsoft Word
Use Microsoft Word to design a customized printer ID sign and print on adhesive labels.

1. Open Microsoft Word and start a new document.
2. Select Mailings.
3. Select Start Mail Merge and select Labels.
4. Select your Label Options and select OK.
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5. Select Select Recipients and select Use an Existing List.
6. Browse to and select the downloaded signIds.csv file. Select Open.
7. Select Insert Merge Field to insert, for example, signID and name.

To insert the QR code, press Ctrl+F9 and insert: MERGEBARCODE url QR \h 1 \q L
If you want to change the size of the QR code image, right-click the field code, select Edit 
barcode and then select Advanced at the bottom of the screen.

8. Select Preview Results.
9. Save the document, so you can use it to reprint labels or make new ones.

10. Print the labels.

Bulk QR Code Generator
To get the QR codes as PNG files:

1. Open your browser and go to qrexplore.com/generate.
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2. Select Treat as CSV.
3. Insert the printers' url and signId values from the downloaded signIds.csv file.
4. Optionally, change Pixels per block from the default 5, which would result in a 165 × 165 

image, to, for example, 3 (99 × 99) or 2 (66 × 66).
A value of 20 will give an image of 660 × 660.

5. Select Generate Codes.
6. Select Download .zip file.
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How to scan QR codes

Printix App for Android and iOS/iPadOS

1. Open the Printix App on your phone or tablet.
2. To print all matching documents (Print Anywhere and Print Later), select the QR code  icon at 

the top of the page.
To print selected documents (Print Anywhere or Print Later), you can A) Select the QR code 
icon at the top of the page or, B) Select Scan at the bottom of the page.
• Android 

If asked, select Allow to allow the Printix App to take pictures and record video.
• iOS/iPadOS 
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If asked, select OK to allow the Printix App to access the camera to scan QR codes.
3. Use the camera to scan the QR code on the printer ID sign.

• The message Invalid QR code will appear if the QR code does not reference a printer.
• The message Document is not for this printer will appear if the scanned QR code does not 

match the selected Print Later documents. Select Close.
4. If multiple print queues exist for this printer, you may be prompted to select one. You are not 

prompted if only one of these print queues is marked as favorite .
Selected documents will start to print.

Printix App
1. Use the camera to scan the QR code on the printer ID sign.

• With iOS/iPadOS 11 or higher, you can use the camera app to scan the QR code.
• With Google App installed on your Android phone or tablet, you can activate Google Screen 

search to scan the QR code.
• If your QR Scanner App (not part of Printix) offers you to open the link in a browser, then 

choose this.
2. Sign in to the Printix App.
3. Select the Print Anywhere document.

• If multiple print queues exist for this printer, the print queue is automatically selected 
among these print queues.

4. Select Print.
Selected documents will start to print.

655



Tungsten Printix Administrator Guide

How to scan NFC tag

1. Open the Printix App on your phone or tablet.
• Android 

Most Android phones support NFC.
• iOS 

Apple iPhone 7 and above with iOS 11 or higher can be used to scan NFC tag.
2. To print all matching documents (Print Anywhere and Print Later), select the NFC tag  icon at 

the top of the page.
To print selected documents (Print Anywhere or Print Later) you can A) Select the NFC tag 
icon at the top of the page or, B) Select Scan at the bottom of the page.

3. Phone shows: Ready to scan.
Hold the phone close to the NFC tag to scan this.
• For optimal scanning, the distance to the NFC tag should be less than 4 cm.
• The phone's NFC detection area depends on the mark and model, and is typically on the 

backside near the top of the phone.
• The message Invalid NFC tag will appear if the NFC tag is not registered with a printer.
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• The message Document is not for this printer will appear if the scanned NFC tag does not 
match the selected Print Later documents. Select Close.

4. If multiple print queues exist for this printer, you may be prompted to select one. You are not 
prompted if only one of these print queues is marked as favorite .
Documents will start to print.

Why does Android phone show: New tag collected?
The message "New tag collected" may appear if an Android  phone is held near an NFC tag 
without the Printix App Scan button or NFC tag  icon has first been selected. Just ignore the 
message by selecting Back and proceed to select the Scan button or the NFC tag  icon.

How to control available printer ID methods
1. Open the Printix App on your phone or tablet.
2. Select Menu  in the top right corner.
3. Select Printer ID method.
4. Select the methods you want to be available:

• QR code 
• NFC tag 

Not available if the phone is not NFC-enabled.
5. Select OK.

How to register printer with NFC tag

1. Open the Printix App on your Android phone.
You MUST have the system manager role.
• Android 

Most Android phones support NFC.
• iOS 
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Apple iPhone 7 and newer with iOS 13 or higher can register NFC tags with Printix App 
version 2.1.6 or higher.

2. Select Menu  in the top right corner.
3. Select Register NFC tag .
4. Select the printer to register with the NFC tag.
5. Select OK.
6. Phone shows: Ready to scan

Hold the phone close to the NFC tag to scan this.
• For optimal scanning, the distance to the NFC tag should be less than 4 cm.
• The phone's NFC detection area depends on the make and model and is typically on the 

backside near the top of the phone.
• After registration, the NFC tag is locked and cannot be written to again.
• When the NFC tag is registered, the NFC tag's UID is written to the NFC tag as an NFC Data 

Exchange Format (NDEF) message so iPhones can read the UID.
• The message Already registered with printer ASD will appear if the NFC tag is already 

registered with a printer.
7. Phone shows: Done. Select Close.
8. Mount the NFC tag on the printer.

Adhesive NFC stickers are the best for this purpose.
Watch this video: Printix - Secure Printing using NFC stickers

How to unregister NFC tag
1. In Printix Administrator, open the Printer properties page.
2. To unregister, select Delete NFC tag.
3. Select Yes.

What NFC tags should I use?
The NFC tag should be empty and not locked, so it can be programmed by the Printix App. Printix 
App has been tested with NFC tags in the form of stickers with these NFC chips:
• NXP NTAG213
• NXP NTAG215
• NXP NTAG216

Printix does not sell NFC tags. Adhesive NFC stickers are priced at around 0.25 - 0.50 € / USD. You 
can buy these on the Internet.
• shopnfc.com
• zipnfc.com

 If your printer is equipped with built-in NFC chip, it is most likely locked by the printer vendor 
and programmed to instruct you to download an App made by the printer vendor, and therefore 
cannot be used to register the printer with Printix.
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Troubleshooting

Phone stays in "Ready to scan" when I try to register NFC tag
Test if the Android phone can scan the NFC tag while the Printix App is closed. If the phone does not 
show the message "New tag collected", then it could be because the phone is not NFC enabled.

Test if this is also the case after you have restarted the phone.

Printix App shows error message
If the NFC tag is not compatible with Printix, you may see one of these messages:
• Tag does not have an id, and cannot be registered
• Write tag, error:
• Register tag to server, error:

Contact Product Support with additional details.

What is written on the NFC tag
If you have issue with an NFC tag, you can install the third-party App NFC tools and use it to read
the data that is written to the NFC tag. If the tag is locked, then Writable is No.
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How to set the default printer
With Printix, you can set the default printer as follows:
• Set default printer for the members of a group
• Remotely set default printer on a selected computer

See also:
• How a user can set default printer on Windows
• How a user can set default printer on Mac
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Set default printer for the members of a group
This is useful if you have, for example, a laboratory or classroom with a group of computers and you 
want to set a default printer for those computers.

1. Open the Print queue properties page.
2. Select the Groups  tab.

Only available if groups (Microsoft Entra or Google) are enabled.
3. For the group in question:

• Select Exclusive access if you want to give the users in the group exclusive access to the 
print queue. Does not apply to computers in the group.

• Select Add print queue automatically if you want the print queue to be added 
automatically to the computer if the computer is a member of the group, when a user in that 
group signs in.

• Select Set as default printer if you want the print queue to become the default printer for 
the users and computers in the group.

 If Set as default printer is selected for multiple print queues, it will be random which 
one is set as default. Printix Client will override the user's selection of default printer every 
time the Printix Service is started and or it receives updates to its list of printers and their 
configuration.
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Remotely set default printer on a selected computer
This is just done once, and the user can subsequently change the default printer on the computer.

1. On the Computer properties page, select the Print queues  tab.
2. To set a print queue as default, select  and Set as default printer.
3. Select Confirm.

• The default print queue will be set once for all users signed in on the computer.
• The task is pending for 72 hours.
• The default print queue is set for: Printix Anywhere print queues, print queues that have Via 

the cloud selected, and print queues pointing to a printer that is on the same network as 
the computer. The command has no effect if the computer is not on the same network as 
the printer. The command is not available if the print queue is not managed by Printix.

How a user can set default printer on Windows
By default, Windows will manage the default printer.
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If you set the default printer with Printix, Windows will stop managing the default printer on the 
computer in question, that is, "Let Windows manage my default printer" becomes cleared in the
"Printers & scanners" dialog box.
• When Windows is not managing default printers, the user can set the default printer manually.
• Alternatively, set it from the Control panel.
• The check box "Let Windows manage my default printer" can also be set from the Windows 

Registry.

Set manually

1. Press Windows+I.
The Settings window appears.

2. Select Devices (or Bluetooth & devices on Windows 11).
3. Select Printers & scanners.
4. Select the printer and select Manage.
5. Select Set as default.
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Set from the Control panel

1. Open the Control Panel and select Devices and Printers.
2. Right-click the printer and select Set as default printer.

Set from the Windows Registry

1. Press Windows+R.
The Run dialog box appears.

2. Type regedit, then select OK.
Select Yes if prompted.
The Registry Editor appears.

3. Browse to HKEY_CURRENT_USER\SOFTWARE\Microsoft\Windows NT\CurrentVersion
\Windows.

4. The value named LegacyDefaultPrinterMode can have these values:
• 0 - Let Windows manage my default printer is selected.
• 1 - Let Windows manage my default printer is cleared.
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How a user can set default printer on Mac
1. Select Apple menu  > System Settings, then select Printers & Scanners.
2. Select the menu labeled Default Printer and select the preferred printer.

If you select Last Printer Used, the computer remembers the printer you used last at your 
current network location.

How a user can set default printer on macOS version 12 or lower
1. Select Apple menu  > System Preferences, then select Printers & Scanners.
2. Select the menu labeled Default Printer and select the preferred printer.

If you select Last printer used, the computer remembers the printer you used last at your 
current network location.

How to print from home office
Printix offers these methods to print from home.
• Via VPN connection
• Via the cloud
• Home office network

• Print to home office printer
• Print to company printer
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Via VPN connection

• If the VPN connection lets the home office computer reach the printer on the company network, 
the user can print directly to it.

• The home office computer will appear as being on an unknown network, and a yellow dot is 
overlaid on the Printix Client icon .
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Via the cloud

• If the print queue has Via the cloud selected and a computer is online on the company network, 
the user can print directly and release documents to the printer at work.

• The home office computer will appear as being on an unknown network, and a yellow dot is 
overlaid on the Printix Client icon .

Home office network
•
•
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Print to home office printer

• Discover and register home printers with the Home office printing feature.
• Print to the Printix-managed home office printer.

• Data is collected showing what was printed on the printer at home.
• Data can be used to reimburse the employee for printing.

• The home office computer will appear as being on the home office network.
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Print to company printer

• If the print queue has Via the cloud selected and a computer is online on the company network, 
the user can print directly and release documents to the printer on the company network.

• The home office computer will appear as being on the home office network.
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How to print 2-sided by default

The Dashboard shows the percentage of pages Printed 2-sided for the selected period. 2-sided 
printing is also known as: Duplex, Double-sided, and Front-and-back. The numbers are based on 
meter readings Printix Client collects from the printers registered in Printix.

You can improve cost savings by making the print driver print 2-sided by default. Has effect only if 
the printer supports automatic printing on both sides. Users can still print on one side only, but will 
have to ask for this at each print.

1. Open the Print queue properties page.
2. Select Print 2-sided by default.
3. Select Save.


• Print 2-sided by default does NOT have effect on Print Anywhere, because the document 

is in PDF.
• If a Print Anywhere document is released to a print queue that has Process PDF/XPS and

Print 2-sided by default selected, then the driver will be prompted to print on both sides.

DISCLAIMER
• We cannot guarantee "Print 2-sided by default" will work, because it partially depends on the 

used print driver. Therefore, we cannot be held responsible if it does not work as expected.
• If it does not work, you can try to achieve this with print driver configuration.
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How to print in black by default

The Dashboard shows the percentage of pages Printed in black for the selected period. The 
numbers are based on meter readings Printix Client collects from the printers registered in Printix.

You can improve cost savings by making the print driver print in black by default. Has effect only if 
the printer support color. Users can still print in color, but will have to ask for this at each print.

1. Open the Print queue properties page.
2. Select Print in black by default.
3. Select Save.

DISCLAIMER
• We cannot guarantee "Print in black by default" will work, because it partially depends on the 

used print driver. Therefore, we cannot be held responsible if it does not work as expected.
• If it does not work, you can try to achieve this with print driver configuration.

How to control if Print Anywhere documents should come out 
in color or black

When you submit a document to the Printix Anywhere printer, your document is always kept for 
later release through your phone, tablet, or computer.
• On Windows, the document is sent as PDF and processed using the Microsoft Print to PDF print 

driver.
• On Mac, the document is sent as PostScript using the Generic PostScript Printer print driver.
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The Microsoft Print to PDF print driver supports selection of paper size and orientation, but it 
does not support color control. The resulting PDF file will in most cases be in color. However, the 
application you use to print may offer color control, and if so, this will take effect as normal. Here 
are some examples:
• Microsoft Word

Offers no color control. Resulting PDF is always in color.
• Microsoft PowerPoint

Offers you to select between: "Color", "Grayscale", and "Pure Black and White."
• Microsoft Edge Browser

Offers you to select between: "Color" and "Black and White."
• Chrome Browser

Offers you to select between: "Color" and "Black and White."
• Adobe Acrobat Reader

Offers you to check: "Print in grayscale (black and white)."

After a color document has been saved as a grayscale PDF or a black and white PDF, it cannot be 
converted back to color. However, other ways also exist to get, for example, a Microsoft Word color 
document out in black and white:
• Release the document on a printer that does not support color.
• For a color printer, make a print queue that has a print driver configuration that prints in black by 

default. If the printer supports PDF printing, then make sure that Process PDF/XPS is selected, so 
the PDF document is processed using a matching print driver and its print driver configuration.

If you define both a black and a color print queue, that is, multiple print queues exist for this printer,
Printix App prompts you to select one. You will not be asked if only one of these print queues is 
marked as "favorite" . If you are using Printix Go and releasing the document from the printer's 
touchscreen control panel, then it will just select one of the print queues without asking.

Printix Client will, when required the first time, automatically download, and use the latest version 
of the PostScript to PDF conversion component (PS2PDF.dll). The component install in the folder:
• C:\Program Files\printix.net\Printix Client\ps

See also:
• How to work with print driver configurations
• How to configure Printix Anywhere print queue to use universal print driver
• How to create Printix Anywhere print queue
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How to increase secure printing

The Dashboard shows the percentage of pages for the selected period that have been released or 
reprinted from the Printix App by users from their phone, tablet, or computer.

You can improve document security and cost savings by increasing the percentage of documents 
which are released through phone. On the Secure print  tab, you can configure who "Must print 
securely" and who "Must Print Later by default." These settings can be set for all users or selected 
users in a group.

Use the communication channels available (Email, Intranet, …) to inform users about the possibility 
to release and reprint documents from their phone. In your communication, you can reference 
these sections in the Printix User Help:
• Printing with Printix
• How to open Printix App
• How to release documents at the printer
• How to reprint documents

Benefits
• Reduced printing saves on paper and toner

By not printing documents that never get collected anyway, your company saves money on 
paper, toner, maintenance, and electricity.

• Avoid stressful print and sprint
Wait until you have arrived at the printer, then release the documents through your phone. That 
way, you prevent others from collecting your confidential and sensitive documents.

• Make fewer visits to the printer
Submit documents for printing, but postpone the actual collection of the documents until it suits 
you to release them.

• Delete documents you regret printing
From your computer, tablet or phone you can easily delete documents you did not need 
anyway. Without Printix, such documents would go straight from the printer's output bin to the 
wastepaper basket without having been used.

• Reprint recent documents
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Because documents can be restored until 12 hours after they are marked for deletion, you can 
reprint documents straight from your phone. No need to walk back to your computer and print 
the document all over again.

How to enable secure print

The ideal method if you need to print confidential documents.
1. Select Menu    > Settings  .
2. Select the Secure print  tab.
3. For this to have an effect, you should proceed to select one or both of the below options:

• Enable Print Later
The ideal method if you need to print confidential documents with finishing options and 
want to ensure your documents print exactly as intended.

• Enable Print Anywhere
With Printix Anywhere, users can roam between printers and collect their document at the 
printer they choose. When you submit a document to Printix Anywhere, your document is 
always kept until you release it.
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How to enable Print Later

The ideal method if you need to print confidential documents with finishing options and want 
to ensure your documents print exactly as intended. The document can only be released at the 
selected printer.

1. Select Menu    > Settings  .
2. Select the Secure print  tab.
3. Select Enable secure print.
4. Select Enable Print Later.

• All users must print securely
Select this so all users must release their documents and cannot print directly.
• Can also be set for users in a groups.

• Selected groups must print securely
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Select this to select the groups whose users must print securely.
• Select Setup  to open the Groups  menu:

• Select Groups to see currently selected groups.
• Select Add groups to add groups.
• Select Remove groups to remove groups.

• All users must Print Later by default
Select this if all users should have Print Later as the preferred print method.
• If a user wants to submit a document directly to a printer, the user must deselect Print 

Later at every print.
• Can also be set for users in a groups.

• Selected groups must Print Later by default
Select this to select the groups who's users will have Print Later as the preferred print 
method.
• Select Setup  to open the Groups  menu:

• Select Groups to see currently selected groups.
• Select Add groups to add groups.
• Select Remove groups to remove groups.

The Printix Client automatically adapts to the configuration changes within a few moments.
Using Print Later is described in the Printix User Help.
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How to enable Print Anywhere

The ideal method if you need to print confidential documents with finishing options and want 
to ensure your documents print exactly as intended. The document can only be released at the 
selected printer.

1. Select Menu    > Settings  .
2. Select the Secure print  tab.
3. Select Enable secure print.
4. Select Enable Print Anywhere.

• Document can be released to any Printix (ASD, BNM, …) printer.
• Document is sent as PDF, except if the printer does not support PDF printing or Process 

PDF/XPS is selected. In this case, the PDF document is processed using a matching print 
driver.

5. Select Setup  and then Create print queue to create a Print Anywhere print queue.
6. In the Create print queue dialog box, enter Print queue name.

677



Tungsten Printix Administrator Guide

Example:  Printix Anywhere
• Cannot contain the characters "\" and ",".
• Must be unique for the printer. Uppercase and lowercase letters are treated the same.

7. Optionally, clear Active to allow administrators (you) to test printing before allowing users to 
add the print queue.

8. Select Save.
• If you want to add print queue automatically, then select Setup  and then Print queues

and then select Print queue name (Printix Anywhere) to open the Print queue properties
page and select Add print queue automatically and select Save.

Using Print Anywhere is described in the: Printix User Help

How to create an additional Print Anywhere print queue
1. Select Setup  and then Create print queue to create an additional Print Anywhere print 

queue.
2. In the Create print queue dialog box, enter Print queue name.

• Cannot contain the characters "\" and ",".
• Must be unique for the printer. Uppercase and lowercase letters are treated the same.

3. Optionally, clear Active to allow administrators (you) to test printing before allowing users to 
add the print queue.
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4. Select Save.

How to enable processing of PDF documents
Typically, if the destination printer supports PDF, documents printed through Printix Chromebook, 
printed from phone or tablet (Mobile print) and Print Anywhere documents, are sent as PDF data 
to the printer. Select Process PDF/XPS to force the PDF data to be processed according to the print 
queue's print driver configuration and thereby finishing options. This will typically mean that the 
PDF print data is converted into for example PostScript or PCL in accordance with the print driver's 
page description language (PDL).

1. Open the Print queue properties page.
2. Select Process PDF/XPS.
3. Select Save.

• Printing will take longer, compared to sending the PDF or XPS document directly to the 
printer, because the document needs to be processed a second time and also the document 
is likely to increase in size, which will also slow the printing.

• If you are using groups to grant exclusive access to print queues that have Process PDF/
XPS selected, or print queues that reference a printer that does not support PDF or XPS 
printing, then we advise that you appoint one or more computers to Act as print gateway
and ensure the users signed in to Printix Client on those computers are also a member of 
those same groups. Otherwise, the document will no be printed.

How to enable mobile print

1. Check the requirements.
2. Enable mobile print.

See also:
• How to print from Android phone and tablet
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• How to print from iPhone and iPad
• How to get your AirPrint password

• Troubleshooting

How to print from Android phone and tablet
1. On your Android phone or tablet, open the app you want to print from.

• To find the print option, select the Menu  icon at the upper-right corner.
• If you cannot find the print option, read the app's documentation.

2. Select Print.
• Select the down arrow to the right of the currently selected printer (Save as PDF) and choose 

your Printix printer. Select the printer.
• Optionally, choose the number of copies and other print options.
• If this is the first time you are printing to this printer, a Use Printix App? dialog box may 

appear. Select OK.
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3. Select the Print icon to print.
Document is printed. The document will be pending you releasing it from the Printix App if:
• You print to a Printix Anywhere printer. Print Anywhere documents can be released only to 

printers that have a print queue with Via the cloud selected.
• You are subject to Must print securely or Must Print Later by default.

How to print from iPhone and iPad
1. On your iPhone or iPad, open the app you want to print from.

• To find the print option, select the app's Share  icon or select More .
• If you cannot find the print option, read the app's documentation. Not all apps support 

AirPrint.
2. Select Print .

• Select Select printer and choose a Printix printer.
• Optionally, choose the number of copies and other print options.
• If this is the first time you are printing to this printer, it will appear locked and a Password 

required for {printer} dialog box will appear. To unlock the printer, you need to enter your
AirPrint password which you can get from the installed Printix App for iOS.
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3. Select Print in the upper-right corner.
Document is printed.
The document will be pending you releasing it from the Printix App if:
• You print to a Printix Anywhere printer. Print Anywhere documents can be released only to 

printers that have a print queue with Via the cloud selected.
• You are subject to Must print securely or Must Print Later by default.

How to get your AirPrint password
1. On your iPhone or iPad, open the Printix App for iOS.
2. Select Menu  in the top right corner.
3. Select AirPrint password .

If you cannot find this menu item, close and reopen the Printix App.
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4. Copy the password to the clipboard.
5. Switch back to the Password required for {printer} dialog box.

• Select the Home button twice. Swipe left or right to find the app. Select the app.
• iPhone X: Swipe up from the bottom to the middle of your screen and hold until you see the 

App Switcher. Swipe left or right to find the app. Select the app.
6. Paste the password into the Password field.

• Select and hold the Password field until the text magnifies.
• When it shows up, you can remove your finger and select Paste.
• Enter a Username, which can be any string (Example: noname).

 If you leave the Username empty on an iPad, the Password required for {printer} dialog 
box will appear every time you print to the printer.
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7. Select OK.

 You only have to do this once per AirPrint printer. The AirPrint password is personal, but is 
the same for all AirPrint printers.

How to add secure print to Universal Print
Publish and share the Printix Anywhere print queue so you can print securely with Universal Print 
and Printix.

1. In Printix Administrator on the Authentication  page, select the Microsoft Entra ID tab.
2. If Integrate with Universal Print shows Accept again, then integration is already accepted. 

Otherwise, select Accept and proceed to sign in and accept integration with Universal Print.
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3. In Printix Administrator, open the Print queue properties page of the Printix Anywhere print 
queue.
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4. Select Publish with Universal Print.
5. Select Save.

• Allow 1–2 minutes before the Printix Anywhere (UP) print queue is created as a printer share 
in Universal Print.

6. Use Microsoft Endpoint Manager (Intune) to deploy the Printix Anywhere (UP) print queue to 
computers, or have users add it themselves.
In the Windows Add printer dialog box, any Universal Print printer appears as a Cloud printer.
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7. You can subsequently release the document to any Printix-managed printer.
The printer must have a print queue that has Via the cloud selected.
• Wait until you are at the printer, then use the Printix App on your mobile device to release 

your documents. The Printix App is available as a mobile app for phones and tablets, or as a 
web app that runs in a web browser on your phone, tablet, and computer.

• If Printix Go is installed on the printer, you can sign in with card or ID code and release 
documents from the touchscreen control panel of the printer.

In the Windows Printers & scanners dialog box, the Universal Print printers appear with a 
distinct cloud icon.

688



Tungsten Printix Administrator Guide

How to use Single Sign-On with Ricoh Adaptable 
Authentication API

The Ricoh Adaptable Authentication API (AAA) makes it possible for third-party applications to use 
Single Sign-On (SSO), as long as they support Ricoh AAA. With AAA, login and logout notifications 
appear in these third-party applications when the Printix user logs in and out of the printer.

To use SSO with Printix, third-party applications must be able to copy the user information that AAA 
provides within the login notification. AAA provides the following user information:

Field Description

Identity The identity of the user in domain\username format

Display name Full name of the user

Email Email address of the user

AAA does not provide passwords to third-party applications.
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How to use Single Sign-On with Kofax AutoStore
While you are logged in to Printix Go on a printer, AutoStore uses your login details to automatically 
log you in to AutoStore. If your user data exists in AutoStore, Single Sign-On (SSO) will be successful. 
When you log out of Printix Go, you are also logged out of AutoStore. The device reset timer will log 
you out of both Printix Go and AutoStore at a pre-determined interval.

AutoStore issues
• Single Sign-On with AutoStore fails on an HP Workpath printer
• Unauthorized users can use Single Sign-On with AutoStore on a Kyocera printer

Single Sign-On with AutoStore fails on an HP Workpath printer
While using the Kofax Unified Client on an HP Workpath printer, if you select Home during 
identification, the identification process is not canceled. After this, if a user attempts to use SSO with 
AutoStore, the SSO fails.

Resolution: Cancel the identification process first, then open the Kofax Unified Client again. After 
this, the SSO should be successful.

Unauthorized users can use Single Sign-On with AutoStore on a 
Kyocera printer
If the authentication is set to Windows in AutoStore, unauthorized users can successfully use SSO. 
The system does not verify whether the user belongs to the LDAP or the domain. The user is logged 
directly into AutoStore, similarly to how it would be if the authentication was set to None.

How to use Single Sign-On with Tungsten TotalAgility
While you are logged in to Printix Go on a printer, Tungsten TotalAgility uses your login details to 
automatically log you in to TotalAgility. If your user data exists in TotalAgility, Single Sign-On (SSO) 
will be successful. When you log out of Printix Go, you are also logged out of TotalAgility. The device 
reset timer will log you out of both Printix Go and TotalAgility at a pre-determined interval.

Vendor-specific information
• HP Workpath
• Kyocera
• Ricoh
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HP Workpath
To use SSO with TotalAgility on an HP Workpath printer, the name of the user should follow the 
"domain\username" format during TotalAgility resource creation. If the domain name has multiple 
levels, use only the first level.

For example, if the domain is acme.com, users should only have "acme" as the domain name. 
However, if the domain is qa.example.com, users should only have "qa" as the domain.

When editing the user name on the TotalAgility server, make sure the user is associated to the
Device Users group on the Membership tab.

Kyocera
To use SSO with TotalAgility on a Kyocera printer, the name of the user should follow the 
"full.domain\username" format during TotalAgility resource creation.

For example, if the domain name is qa.example.com, the full domain name is "qa.example.com".

When editing the user name on the TotalAgility server, make sure the user is associated to the
Device Users group on the Membership tab.

Ricoh
To use SSO with TotalAgility on a Ricoh printer, the name of the user should match the Printix user's 
email address during TotalAgility resource creation.

For example, if the Printix user's email address is john.smith@example.com, the TotalAgility user 
name should be "john.smith@example.com".

When editing the user name on the TotalAgility server, make sure the user is associated to the
Device Users group on the Membership tab.

How to print from Kofax Output Manager
 It is recommended to have the Printix Client installed on the same OM servers that host the 
IPP destination, because this simplifies the architecture and avoids complexity.

On the computer that has the Printix-managed print queue installed:
1. Right-click the print queue and select Printer properties.
2. Select the Ports tab.
3. Select Configure Port and copy the port value.

Example:  http://localhost:21339/ipp/ASD/2114d3f3-e5732…
In Printix Administrator:

4. Open the Computer properties page of the computer that has the print queue installed.
5. Select Allow computer to look up users.
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In Kofax Output Manager:
6. Create a Destination.
7. Select IPP as Type.
8. In the Server list, select the computer where the Printix-managed print queue is installed.
9. Paste the port value you copied in step 3.

You may have to replace localhost with the computer name.

How to replace a printer

 It is best practice to do this outside office hours, especially if the replacement printer is a 
different model or from another printer vendor, because you may want to change print drivers 
and or update print queues (steps 6–8).

1. Unbox and connect the replacement printer.
2. In Printix Administrator, open the Printer properties page.
3. Change Printer address and/or Network to that replacement printer.

If the printer address is to be the same as the old printer, make sure the old printer is powered 
off, and if/when you power the old printer on again, you should ensure that it gets a different 
IP address (to avoid conflict). If you intend to use the old printer with Printix, perhaps on a 
different network, then you can use Add printer to register it with Printix.

4. If required, change the SNMP configuration to match that of the replacement printer.
5. Select Contact printer to read the properties of the replacement printer, including:

• MAC address: The hardware address of the printer.
• Model: The model name of the printer.

692

https://docshield.tungstenautomation.com/ControlSuite/en_US/1.4.0-mayave5tcn/help/CS/OutputManager/Source/AdminGuide/Dita.en/Working_destinations_adding_destinations.html


Tungsten Printix Administrator Guide

• Serial number: The serial number of the printer.
• Protocol: The protocols (IPP, IPPS, LPR, RAW) supported by the printer. Ensure the protocols 

are also enabled on the printer.
• Features:

• Page description language (PCL5, POSTSCRIPT, PCLXL, PDF, …)
• Color supported
• 2-sided supported

If the replacement printer is a different model or from another printer vendor, proceed to:
6. If required, change the Protocol.

The default is RAW on port 9100.
7. Change print driver.
8. If required, make new print driver configurations.
9. Use Update print queues to make the changes take effect on computers where the print 

queue is already installed.

How to remove printers
If you no longer use a printer, you can delete it from your list of printers.

Windows
1. Open the Control Panel and select Devices and Printers.
2. Select the printer and select Remove device.

Mac
1. Select Apple menu > System Settings > Printers & Scanners.
2. Select the printer and select Remove Printer.

Mac (macOS version 12 or lower)
1. Select Apple menu > System Preferences > Printers & Scanners.
2. Select the printer and select Delete.

How to remove print drivers
If the Printix Client has issues adding a print queue on a Windows computer, it may be that a 
previously installed version of the print driver has an issue. If advised, perform the below steps, 
then try to add the print queue again.

Delete the Printix driver cache
Delete the folder: C:\Windows\Temp\Printix-drivercache
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Remove driver and driver package
1. Open Devices and Printers.
2. Select a printer.
3. Select Print server properties.

4. In the Print Server Properties dialog box, select the Drivers tab.
5. Select the print drivers you want to remove.

These would be the print drivers that do not install.
6. Select Remove.
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7. In the Remove Driver And Package dialog box, select Remove driver and driver package.
8. Select OK.
9. Select Yes to confirm that you want to delete the selected print driver package.

10. Restart the computer.
11. Try to Add the printer again through the Printers menu in the Printix Client.

How to install print drivers that are not signed by Microsoft
Printix Client is not able to install an unsigned print driver until the Authenticode signature 
has been installed. Follow the instructions below to install the Authenticode signature on each 
computer, or add it to a group policy.
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Extract the certificate
1. Locate the security catalog file (*.cat).

It can be found in the folder with the rest of the print driver files.
2. Right-click the .cat file and select Open.
3. In the Security Catalog dialog on the General tab, select View Signature at the bottom.
4. In the Digital Signature Details dialog on the General tab, select View Certificate.
5. In the Certificate dialog, select the Details tab. Select Copy to file at the bottom.
6. In the Certificate Export Wizard, select Next.
7. In Export file format, leave the choice to the default selected. Select Next.
8. In File to export, provide a location and file name for the certificate. Select Next.
9. Select Finish.

10. Select OK.

Import the certificate
• Add certificate to a computer
• Add certificate to domain group policy

Printix should now be able to install the print drivers silently without security prompts blocking the 
installation, and the computer failing to install printer driver: -2,147,467,259.

Add certificate to a computer
1. Browse to the location of the extracted print driver files.
2. Open the .cat file in the driver installation files folder.
3. In the Security Catalog dialog on the General tab, select View Signature at the bottom.
4. In the Digital Signature Details dialog on the General tab, select View Certificate.
5. In the Certificate dialog on the General tab, select Install Certificate at the bottom.
6. In the Certificate Import Wizard, select Local Machine. Select Next.
7. Select Place all certificates in the following store and select Browse.
8. In the Select Certificate Store dialog, select Show physical stores.
9. Scroll to the top and select Trusted Root Certification Authorities.

10. Select Next.
11. Select Finish.

Add certificate to domain group policy
1. On a Windows server, open the Group Policy Management Console.
2. Locate and right-click the domain group policy, then select Edit.
3. Select Computer Configuration > Policy > Windows Settings > Security Settings > Public 

Key Policies.
4. Right-click Trusted Publishers and select Import.
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Step through the import wizard, provide the location and name of the certificate when asked, 
then Finish the wizard. Other than the .cat file, no other settings should be changed.

How to add users
Users can be added and registered as follows:
• Automatic registration

For users to be registered automatically requires one of these methods:
• Microsoft Entra authentication

User must have a Microsoft work or school account. Microsoft Entra guest users, also known as 
Microsoft Entra business-to-business (B2B) collaboration users, are also supported.

• Google authentication
User must have a Google Workspace account.

• OIDC authentication
User must have an OIDC account.

• Okta authentication
User must have an Okta account.

• OneLogin authentication
User must have a OneLogin account.

• Active Directory authentication
User must have a network user name and password.

• Guest registration with API
User must have an email address and be registered with the Printix Cloud Print API.

• Self-registration
User must have a work email address. Self-registration must be enabled.

• Invitation
User must have an email address.


• If you are using Okta for signing in to Microsoft Entra ID (Office 365), you can enable the 

integration with Microsoft Entra ID, which will handle the delegation to Okta without Printix 
having to know about Okta. You can also enable integration with Google Workspace.

• We can integrate with additional cloud-based Identity Providers (IdP) and Directory-As-A-
Services (DAAS). Contact Product Support regarding your business case for this. Technically, the 
integration is preferred to occur with OpenID Connect 1.0 (OIDC).
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Automatic registration

Microsoft Entra authentication
If Microsoft Entra authentication is enabled, users are automatically registered the first time they 
sign in with their Microsoft work or school account.

User performs these steps:
1. On the sign-in page, select Sign in with Microsoft.

If you were already signed in to the browser with your work or school account, you are signed 
in automatically.

2. On the Microsoft sign-in page:
• Enter your work or school account.
• Enter your password.

3. Select Sign in.
4. If prompted, select Accept to grant permissions to Printix.

You are not prompted if Printix has been accepted for all users.
The user is automatically registered.
If you registered with your email address, select Sign in with email and enter your email 
address and password.
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Google authentication
If Google authentication is enabled, users are automatically registered the first time they sign in 
with their Google Workspace account.

User performs these steps:
1. On the sign-in page, select Sign in with Google.

If you were already signed in to the browser with your work or school account, you are signed 
in automatically.

2. On the Google sign-in page:
• Enter your work or school account.
• Enter your password.

3. Select Sign in.
The user is automatically registered.
If you registered with your email address, select Sign in with email and enter your email 
address and password.

OIDC authentication
If OIDC authentication is enabled, users are automatically registered the first time they sign in with 
their OIDC account.
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User performs these steps:
1. Select Sign in with OIDC.

If you were already signed in to the browser with your OIDC account, you are signed in 
automatically.

2. On the OIDC sign-in page:
• Enter your account name.
• Enter Password.

3. Select Sign in.
The user is automatically registered.

Okta authentication
If Okta authentication is enabled, users are automatically registered the first time they sign in with 
their Okta account.
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User performs these steps:
1. Select Sign in with Okta.

If you were already signed in to the browser with your Okta account, you are signed in 
automatically.

2. On the Okta sign-in page:
• Enter your account name.
• Enter Password.

3. Select Sign in.
The user is automatically registered.

OneLogin authentication
If OneLogin authentication is enabled, users are automatically registered the first time they sign in 
with their OneLogin account.
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User performs these steps:
1. Select Sign in with OneLogin.

If you were already signed in to the browser with your OneLogin account, you are signed in 
automatically.

2. On the OneLogin sign-in page:
• Enter your account name.
• Enter Password.

3. Select Sign in.
The user is automatically registered.

Active Directory authentication
If Active Directory authentication is enabled, users are automatically registered the first time they 
sign in with their network user name and password.
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User performs these steps:
1. On the sign-in page:

• Enter Username.
• Enter Password.

2. Select Sign in.
The user is automatically registered and receives the email with the subject: Get started with 
Printix.

Guest registration with API
You can use the Printix Cloud Print API to automatically register guest users. Guest users can be 
automatically deleted after a specific period of time. The user must not already be registered.

Self-registration
If self-registration is enabled, users can register themselves by their work email address.

User performs these steps:
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1. Open a web browser and enter the Printix Home (acme.printix.net).
2. On the sign-in page, select Menu  in the top right corner.
3. Select Register .

• Self-registration is also possible from the Printix Client sign-in page.

4. On the Register page:
• Enter Email.

5. Select Register.
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The user receives an email with the subject Welcome to Printix.
6. Open the email and select Get started.

If the email does not arrive within a few minutes, check the spam/junk mail folder.
After successful registration, the user receives an email with the subject Get started with 
Printix and is prompted to download the Printix Client.

Invitation
Users with an email address can be invited by administrators.

Add user from Printix Administrator
Administrator performs these steps:

1. Open the Printix Administrator .
2. Open the Users  page.
3. Select Add user .
4. If required, change the Role of the user.
5. Enter the user's email address.
6. Select Add.

The user receives an email with the subject Welcome to Printix.
• If the email does not arrive within a few minutes, ask the user to check the spam/junk mail 

folder.
• On the Users page, the invited user is listed at the top of the page with a ? until registration 

is completed.
• The invitation is valid for 72 hours.
• Select  and Info to see when the invitation expires.

The invited user must do the following depending on the invitation method:
• If the invited user has a Microsoft work or school account, the user performs these steps:

1. Read the email with the subject Welcome to Printix and select the link to Download Printix 
Client.

2. In the Printix Client, select Sign in with Microsoft.
• If the invited user has a Google Workspace account, the user performs these steps:

1. Read the email with the subject Welcome to Printix and select the link to Download Printix 
Client.

2. In the Printix Client, select Sign in with Google.
• If the invited user has an Okta account, the user performs these steps:

1. Read the email with the subject Welcome to Printix and select the link to Download Printix 
Client.

2. In the Printix Client, select Sign in with Okta.
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• If the invited user has a OneLogin account, the user performs these steps:

1. Read the email with the subject Welcome to Printix and select the link to Download Printix 
Client.

2. In the Printix Client, select Sign in with OneLogin.
• Other invited users perform these steps:

1. Read the email with the subject Welcome to Printix and select Get started to register.

2. After a successful registration, the user is prompted to Download Printix Client. If the role 
is system manager, the user is prompted to sign in to Printix Administrator.
• The user also receives the email with the subject Get started with Printix with links to the 

Printix Client and the Printix App.

How to enable Microsoft Entra authentication
Enable this to allow users to sign in with their Microsoft work or school account and get single sign-
on (SSO) to Printix. You just need a user account in Microsoft Entra ID to configure Microsoft Entra 
integration.

1. On the Authentication page, select the Microsoft Entra ID tab.
2. Select Connect.
3. On the Microsoft sign-in page:

• Enter your work or school account.
• Enter your password.

4. Select Sign in.
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5. If prompted, select Accept to grant permissions to Printix.
This is necessary for Printix to configure Microsoft Entra integration.

 It is a known issue that Microsoft prompts you for permission to Maintain access to 
data you have given it access to even though Printix does not require offline access. You 
can read more about this issue here. For the sign-in process, Printix does not request (or 
get) a refresh token, only an access token, which is ignored. The only token actually used 
for signing in is the ID token, which contains user information (user name and email). 
Printix stores this token, then checks the token signature to verify the token was granted by 
Microsoft Entra ID.

In Microsoft Azure, this adds the enterprise application Printix.
• If you see the check box Consent on behalf of your organization, it is because you have 

the global administrator role in Microsoft Entra ID, and Printix has not yet been accepted for 
all users. Select Consent on behalf of your organization so Printix can have access to the 
specified resources for all users in your organization. Noone else will be prompted.

6. Select OK if the connection to Microsoft Entra ID was successful.
From now on, the sign-in page will show Sign in with Microsoft.
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See also:
• How to deploy Printix Client with Microsoft Endpoint Manager
• How to deploy Printix Client
• How to enable Microsoft Entra groups
• How to revoke the acceptance of Printix
• How to find out if the computer supports SSO
• How to add multiple directories
• How to remove sign in with email
• Troubleshooting sign-in

How to accept Printix for all users

1. Select Accept next to Accept for all users to grant permission to read users' profiles without 
prompting the individual in your organization.
You must have the global administrator role in Microsoft Entra ID to do this.

2. On the Microsoft sign-in page:
• Enter your work or school account. You must have the global administrator role in Microsoft 

Entra ID to grant permission to read users' profiles.
• Enter your password.

3. Select Sign in.
4. Printix will ask you to accept permissions for your organization to:

• Sign in and read user profile.

708



Tungsten Printix Administrator Guide

• Subsequent deletion or modification of the used global administrator Microsoft Entra ID 
account will not affect the already consented application permissions.

5. Select Accept to grant these permissions, so Printix can have access to the specified resources 
for all users in your organization.
Noone else will be prompted.
If this is successful, you will see the message: Accepted for all users.

6. Optionally, remove the Sign in with email option.

How to revoke the acceptance of Printix
1. Open a new browser window and sign in to Microsoft Azure (portal.azure.com) using your work 

account credentials.
2. In the portal menu, select All Services.
3. In the Identity category, select Microsoft Entra ID.
4. On the left pane, select Enterprise applications.
5. Select the Printix application.

You can use the search bar to quickly find this option.
6. On the left pane, select Properties.
7. Select Delete.

How to find out if the computer supports SSO
Open a command prompt as administrator and run the command: dsregcmd /status

1. Select the Start icon and select in the Search box.
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2. Type cmd into the search box.
3. Right-click Command Prompt in the search window and select Run as administrator.
4. Type: dsregcmd /status
5. Scroll to the SSO State section and look for:

• AzureAdPrt: TRUE

If the AzureAdPrt value is FALSE, the computer is not Microsoft Entra joined and SSO (single 
sign-on) will not work.

If a group policy blocks Printix Client from running the dsregcmd command, you can modify 
Windows Registry to inform Printix Client that SSO is supported.

How to modify the Windows Registry to support SSO
1. Press Windows+R.

The Run dialog box appears.
2. Type regedit, then select OK.

Select Yes if prompted.
The Registry Editor appears.

3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\printix.net\Printix Client\.
4. Add the DWORD value named ForceAzurePrtand and give it the value 1 (0×00000001).

In the PrintixClient log file (PrintixClient- user . number .log), you can also search for the text:
• Azure: Token available = True

SSO (single sign-on) will not work if you see:
• Azure: Token available = False

How to add multiple directories
Select Add  to add another Microsoft Entra directory.
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 If more than one Microsoft Entra directories exist, sign-in to the Printix Client is no longer 
automatic the first time on Microsoft Entra joined Windows 10 and 11 computers. The user must 
select a directory (acme.com or ajax.com) and then sign in, but only the first time.
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Troubleshooting sign-in
• Sign-in page does not show: Sign in with Microsoft
• Permission denied
• Not authorized. You do not have permission to use Printix Administrator
• Microsoft Entra authentication has been disabled and is now enabled again, and I want to accept 

Printix for all users again
• You can't access this application. Printix needs permission to access resources in your 

organization that only an admin can grant

Sign-in page does not show: Sign in with Microsoft
Microsoft Entra authentication is not enabled.

Resolution: You may have forgotten to select Save after you connected to Microsoft Entra ID. If it 
still does not show, refresh the browser (Ctrl+F5).

Permission denied
After you select Accept for all users and Sign in, you get Permission denied.

Resolution: You must sign in with a global administrator role in Microsoft Entra ID after you select
Accept for all users.

Not authorized. You do not have permission to use Printix 
Administrator
The first time you sign in with Microsoft, a new user is automatically created for you. This new user 
is not authorized to sign in to Printix Administrator.

Resolution: Sign in with email to Printix Administrator, and change the role of the newly created 
user to system manager. From now on, you can sign in with your work or school account.

Microsoft Entra authentication has been disabled and is now enabled 
again, and I want to accept Printix for all users again
If you disable Microsoft Entra authentication and want to withdraw the acceptance of Printix, you 
must do this from within Microsoft Entra ID. If you have withdrawn the acceptance of Printix and 
now want to accept Printix again, select Accept again.
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You can’t access this application. Printix needs permission to access 
resources in your organization that only an admin can grant
After attempting to sign in with Microsoft, you are told you cannot access Printix.

Resolution: Follow the steps below to allow users to consent to apps accessing company data on 
their behalf. You must have the global administrator role in Microsoft Entra ID to make this change. 
Printix will read the users' basic profile (display name and email address).

1. Sign in to portal.azure.com.
2. In the portal menu, select All Services.
3. In the Identity category, select Microsoft Entra ID.
4. On the left pane, select Enterprise applications.
5. On the left pane, select Consent and permissions.
6. Set User consent for applications to Allow user consent for apps or Allow user consent for 

apps from verified publishers, for selected permissions (Recommended).
7. Select Save.

It may take up to 15 minutes before the change takes effect.

How to enable Google authentication
Enable this to allow users to sign in with their Google Workspace account to Printix.
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1. On the Authentication  page, select the Google tab.
2. Select Enable Google authentication.
3. Select Connect.
4. On the Sign in with Google page, sign in using your Google Workspace account (does not end 

in @gmail.com).
• Enter your account.
• Enter Password.

From now on, the sign-in page will show Sign in with Google.

See also:
• Printix Chromebook
• How to enable Google groups
• How to remove sign in with email

How to add multiple domains
Select Add  to add another Google domain.
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 If more than one Google domains exist, the user must select a domain (acme.com or ajax.com) 
and then sign in, but only the first time.
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How to enable Okta authentication
Before enabling Okta authentication, it is necessary to configure Okta.

1. Open a new browser window and sign in to Okta Console (okta.com) using your Okta 
administrator account credentials.

2. In the Okta Console, select Admin.
3. In the Okta Admin console, select Applications, and then Applications.
4. Select App Application.
5. Select Create New App.
6. In the Create a New Application Integration dialog box:

• In Platform, select Web.
• In Sign in method, select OpenID Connect.

7. Select Create.
The Create OpenID Connect Application pane appears.

8. In Application name, type: Printix
9. In Application logo, select Browse files.

• We recommend this PNG (420 × 120):
• https://assets.printix.net/img/logo/logo420×120.png

10. In Login redirect URIs, select + Add URI.
• Paste the Redirect URI value you can copy to the clipboard on the Okta tab on 

the Authentication  page in Printix Administrator. Alternatively, type: https://
auth.printix.net/identity-providers/okta/signin/response

11. Leave Logout redirect URIs empty (it is not used). Select Save.
12. On the General tab in the Client Credentials section:

• Copy the Client ID. You need to paste it in step 19.
• Copy the Client Secret. You need to paste it in step 20.

13. On the General tab in the General Settings | APPLICATION section:
• Ensure Authorization Code is selected.

14. On the General tab in the General Settings | USER CONSENT section:
• Optionally, clear Require consent.
• In Terms of Service URI, optionally, type: https://printix.net/terms
• In Policy URI, optionally, type: https://printix.net/privacy
• In Logo URI, optionally, type: https://assets.printix.net/img/logo/
logo420×120.png

15. Select Save.
Now that Okta is configured, the following steps describe how to enable Okta 
authentication.

716

https://okta.com/
https://assets.printix.net/img/logo/logo420x120.png


Tungsten Printix Administrator Guide

16. In Printix Administrator on the Authentication  page, select the Okta tab.
17. Select Connect.
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18. In Domain, enter your Okta domain (acme.okta.com).
19. In Client ID, paste the value you copied in step 12.
20. In Client Secret, paste the value you copied in step 12.
21. If Okta, for your organization, is set up with an Authorization Server, then enter the value, 

otherwise, leave it empty (default).
22. Select Connect.
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How to add multiple domains

Select Add  to add another Okta domain.

How to enable OneLogin authentication
Before enabling OneLogin authentication, it is necessary to configure OneLogin.

1. Open a new browser window and sign in to the OneLogin portal (onelogin.com) using your 
OneLogin administrator account credentials.

2. In the OneLogin portal, select Administration.
3. In the OneLogin Administration panel, select Applications.
4. Select Add App.
5. In Search, type OIDC and select the OpenId Connect app.
6. In Display name, type: Printix.
7. Upload icons:

• For Rectangular icon, we recommend this SVG:
https://assets.printix.net/img/logo/logo-simple.svg

• For Square icon, we recommend this SVG:
https://assets.printix.net/img/logo/px-logo-circle.svg

8. In Description, optionally, type: Printix Cloud Print Management Service

719

https://onelogin.com/
https://assets.printix.net/img/logo/logo-simple.svg
https://assets.printix.net/img/logo/px-logo-circle.svg


Tungsten Printix Administrator Guide

9. Select Save.
10. On the menu, select Configuration.

In Redirect URI, paste the Redirect URI value you can copy to the clipboard on the OneLogin
tab on the Authentication  page in Printix Administrator.
Alternatively, type: https://auth.printix.net/identity-providers/onelogin/signin/response

11. Select Save.
12. On the menu, select SSO.
13. Copy the Client ID.

You need to paste it in step 22.
14. Select Show client secret and copy the Client Secret.

You need to paste it in step 23.
You can leave the remaining settings at the defaults.

15. If you face any sign-in issues with OneLogin:

a. Log in to the OneLogin portal as an administrator.

b. Go to Users > Users > Applications.

c. In the Applications table, select the application you configured.

d. Select Save.
Now that OneLogin is configured, the following steps describe how to enable OneLogin 
authentication.

16. In Printix Administrator on the Authentication  page, select the OneLogin tab.

17. Select Connect.
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18. In Domain, enter your OneLogin domain (acme.onelogin.com).
19. In Client ID, paste the value you copied in step 13.
20. In Client Secret, paste the value you copied in step 14.
21. Select Connect.
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How to add multiple domains

Select Add  to add another OneLogin domain.

How to enable Active Directory authentication
Enable this to allow users to sign in with their network user name and password. You just need a 
user account in Active Directory to configure this.

1. On the Authentication  page, select the Active Directory tab.
2. Select Enable Active Directory authentication.
3. In the Settings section:

• In Default domain, enter the default domain, so users belonging to the domain can sign in 
with user name. Users not belonging to the domain would have to sign in with domainname
\username.

• In Active Directory server address, enter the address of your Active Directory (AD) server.
• In Active Directory server port, enter 636 for secure LDAPS (default). If you clear Enable 

secure LDAPS, you should enter 389 (default for LDAP).
• In Network, select the Modify  icon to select the network where the Active Directory 

server is.
4. Enter your network Username and Password (not saved).
5. Select Test and save.
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If the test is successful, you will see the message Settings tested OK. Otherwise, correct the 
settings and repeat the test. If settings are wrong, users cannot sign in with their network user 
name and password.

See also:
• How to deploy Printix Client

Troubleshooting sign-in
• Not authorized. You do not have permission to use Printix Administrator
• No connection to Active Directory server

Not authorized. You do not have permission to use Printix 
Administrator
The first time you sign in with Active Directory, a new user is automatically created for you. This new 
user is not authorized to sign in to Printix Administrator.

Resolution: Sign in with email to Printix Administrator, and change the role of the newly created 
user to system manager. From now on, you can sign in with your network user name and password.

No connection to Active Directory server
A computer with Printix Client must be online on the same network as the on-premise Active 
Directory server, otherwise, authentication is not possible and you will see the message: No 
connection to Active Directory server.

Resolution: Make sure the selected network is the right one and a computer with Printix Client is 
permanently running on that network.
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How to enable self-registration

Enable this to allow users to self-register using their work email address.
1. On the Authentication  page, select the Self-registration tab.
2. Select Enable self-registration.
3. Select Save in the Settings section.
4. Select Add email domain? to enter additional email domains.

Do NOT add email domains, such as gmail.com, outlook.com, yahoo.com, or similar email 
service domains, because this removes control over who can sign in.

5. Select Save in the Domain section.

See also:
• How to add users; Self-registration
• How to add users; Invitation
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How to remove sign in with email

This will remove the "Sign in with email" option from Printix Administrator, Printix Client, Printix 
Configurator, and the Printix App web app. The "Sign in with email" option is always available on the 
Printix App for Android and iOS/iPadOS and when signing in from printix.net.

1. On the Authentication  page, select the Self-registration tab.
2. Clear Sign in with email.
3. Select Save.

 If you need to sign in with email to Printix Administrator, you can sign in from printix.net.

Do NOT remove the Sign in with email option if you have selected:
• Enable self-registration
• Enable Active Directory authentication
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How to add guest users to Microsoft Entra ID

Printix supports guest printing, that is, you can allow a guest, that is, a user that is not a member of 
your organization, to print through Printix, including the use of secure print and mobile print.

1. Open a new browser window and sign in to Microsoft Azure (portal.azure.com) using your 
work account credentials.

2. In the portal menu, select All Services.
3. In the Identity category, select Microsoft Entra ID.
4. On the left pane, select Users.
5. Select New guest user.
6. Enter Email address.
7. Select Invite.

• If you Delete a guest user (John Silver) in Microsoft Entra ID, the user is also deleted in 
Printix.

• If you Block sign in for a guest user in Microsoft Entra ID, the user is signed out from Printix 
and will not be able to sign in until the user's account is unblocked in Microsoft Entra ID.

See also:
• Microsoft documentation on:

Microsoft Entra business-to-business (B2B) collaboration user

How to add multiple Microsoft Entra directories
This is useful for separate companies, sharing office space and printers, because they can use the 
one and same Printix Home and only need to set up and manage printers and print queues once. 
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Furthermore, Microsoft Entra users' Department is recorded and can be used to post process data 
for subsequent departmental/company billing.

1. On the Authentication  page, select the Microsoft Entra ID tab.
2. Select Add  to add another Microsoft Entra directory.


• If more than one Microsoft Entra directories exist, then sign-in to Printix Client is no longer 

automatic the first time on Microsoft Entra joined Windows 10 computers. The user must 
select a directory (acme.com or ajax.com) and then sign in, but only the first time.

• Universal Print is supported for one, but not multiple Microsoft Entra directories.
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How to switch Microsoft Entra directory
You have an existing Microsoft Entra directory that is added to Printix, and now want to switch to a 
new Microsoft Entra directory.

See also: Microsoft documentation: Change your organization connection to another Microsoft 
Entra ID

 It is best practice to do this outside office hours. Users must sign in to Printix Client and Printix 
App again. Any pending documents from users are lost. The group-related setup that was made 
with the previous Microsoft Entra ID is broken and needs to be set up again.

• Ensure you are a member of the old Microsoft Entra directory and the new Microsoft Entra ID.
• You must have the global administrator role in the new Microsoft Entra ID to:

• Accept for all users
• Enable Microsoft Entra groups

• When you switch Microsoft Entra ID, the use of groups in the old Microsoft Entra ID breaks in 
Printix. You will have to set up the use of groups with the new Microsoft Entra directory (step 6).

1. On the Authentication  page, select the Microsoft Entra ID tab.
2. Select Add  to add the new Microsoft Entra directory.
3. Ensure that you can Sign in with Microsoft (your account in the new Microsoft Entra ID) and 

have the system manager role in Printix Administrator.
4. On the Authentication  page on the Microsoft Entra ID tab, select Delete  to delete the 

old Microsoft Entra directory.
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5. Users must sign in to Printix Client and Printix App again.
Future improvement (TFS 149792/PP-6583) is pending and will expire the sign in of the old 
Microsoft Entra directory users and thereby force a sign out/sign in.

6. In Printix Administrator, set up the use of groups with the new Microsoft Entra directory.
Future improvement (TFS 149793/PP-6584) is pending and will automate the removal of the old 
Microsoft Entra groups.

How to change the role of a user
As a system manager, you can change the role of all other users except guest users.

1. Open the Users  page.
2. Select the user and select Modify.
3. On the Setup  tab, select the role and select Save.

An email is sent to the user when the role is changed.

 The user will have to sign in after a change of role.

How to search for users
Use Search  to find users.

1. Open the Users  page.
2. Select Search .
3. Enter part of the user's name or email.

The search is not case-sensitive.
• Select a user's Name or select  and Modify to open the User properties.
• Select  and Info to see information about the user:

• Sign in method lists the user's sign-in methods.
• Computers lists the computers the user is signed in to.
• Groups lists the groups the user is a member of.
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How to deploy Printix Client
After you have added the first users, you should consider using the below methods to deploy Printix 
Client and get users to print with and use Printix.
• Let users download Printix Client and register themselves
• Deploy Printix Client automatically with Microsoft Endpoint Manager
• Deploy Printix Client for Mac with Microsoft Endpoint Manager
• Deploy Printix Client automatically with Group Policies
• Deploy Printix Client and have sign-in postponed until restart
• Deploy Printix Client for Mac
• Manually install Printix Client remotely

Let users download Printix Client and register themselves
The Printix Download page is the Printix Home of your company (acme) followed by /download.

Example: https://acme.printix.net/download
• Make a group email to users
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Use organization's email system to write and send an email to the group of relevant recipients, 
perhaps all users in the organization. In the email, you can include links to the Printix Download 
page, User Manual, and/or relevant Intranet pages.

• Make a link on your Intranet
Perhaps your Intranet already features one or more pages with instructions on how to locate and 
install printers in your company. You can update these pages and include the link to the Printix 
Download page and User Manual.

If you have enabled self-registration, you can also provide users with a link to the Printix Download
page. After the completed installation of Printix Client, the user has to select  Menu   > Register

 , and then enter work email address, and follow the steps in the email to register.

Deploy Printix Client automatically with Microsoft Endpoint Manager
You can automatically deploy Printix Client with Microsoft Endpoint Manager. If you also enable 
Microsoft Entra authentication, users are automatically registered the first time they sign in with 
their Microsoft work or school account.

See also: How to deploy Printix Client with Microsoft Endpoint Manager

Deploy Printix Client automatically with Group Policies
You can automatically deploy Printix Client with Group Policies in Active Directory. If you also enable 
Active Directory authentication, users are automatically registered the first time they sign in with 
their network user name and password.

Download the Printix Client Microsoft Installer (MSI) package:
1. Open the Software  page.
2. Select Printix Client (MSI).
3. After download, move the MSI file to a shared folder that is available to all users.

 Do NOT rename the file, because it will prevent it from working with your Printix Home. 
Some deployment tools, such as Cisco Meraki, requires the file extension to be renamed, so 
the extension is in lowercase (.msi).

To install it silently, use the msiexec command and run it as administrator, that is, under the 
local system account.
• msiexec /i CLIENT_{home}_{id}.MSI /quiet

After installation, the Printix ID is saved in Windows Registry.

Deploy Printix Client and have sign-in postponed until restart
Use the /oms (On Machine Start) argument to deploy Printix Client without starting the user 
interface (PrintixClient.exe). Only the Printix Service (PrintixService.exe) is started.
• msiexec /i CLIENT_{home}_{id}.MSI /quiet WRAPPED_ARGUMENTS=/oms

The computer with Printix Client will only be registered and listed in Printix Administrator after a 
user has signed in. Start the user interface (PrintixClient.exe) to get the user to sign in.
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This method can be used to install Printix Client as part of an automated process (such as Windows 
Autopilot) that completely configures a new computer before this is delivered to the user. This way, 
sign in is postponed until the user starts to use the computer.

Deploy Printix Client for Mac
How to deploy the embedded Printix Client.pkg file:

1. Open the Software  page.
2. Select Printix Client.
3. Open Downloads, for example from the Dock at the bottom of the screen.
4. Double-click CLIENT_{home}_{id}.DMG.

After a few seconds, the Printix Client dialog box appears.

5. Copy the cardboard box icon (Printix Client.pkg) to a temporary location.
6. Extend the name of the copied package file to have a similar name as the DMG file (Printix 

Client_{home}_{id}.pkg).
7. Use whatever tool you have to deploy the package file.

The macOS bundle identifiers are:
• Printix Client bundle ID: net.printix.UI
• Printix Service bundle ID: net.printix.MacService

See also:
• How to deploy Printix Client for Mac with Microsoft Endpoint Manager
• How to deploy Printix Client for Mac with Jamf Pro
• How to deploy Printix Client for Mac with Addigy

Manually install Printix Client remotely
If you can remotely sign in to a computer as administrator, you can also install Printix Client. If any 
users are signed in, you should ask them to sign out first. Otherwise, these signed in users cannot 
print to Printix printers until they sign out of the computer and sign in again. You can sign out these 
users, but they may lose unsaved data. If you restart the computer after Printix Client is installed, it 
will also sign out the users from the computer.
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How to sign out users from a Windows computer
1. Sign in to the computer as administrator.
2. Open the Task Manager.
3. Select the Users tab.
4. Select the user and select Sign out.

How to sign out users from a Mac computer
1. Sign in to the computer as administrator.
2. Select the search icon in the top right corner or press Command+Space.
3. In Spotlight Search, type: activity monitor, and press Enter.
4. In Activity Monitor, use the search box in the upper right corner and type: loginwindow.
5. Double-click the login window process of the user to be signed out and select Quit.
6. Select Force Quit. You may be prompted to enter your Password.

How to deploy Printix Client with Microsoft Endpoint Manager
You can automatically deploy Printix Client with Microsoft Endpoint Manager. If you also enable 
Microsoft Entra authentication, users are automatically registered the first time they sign in to 
Printix Client with their Microsoft work or school account. Can I use Microsoft Intune for Education?

 Sign-in to the Printix Client is automatic on Microsoft Entra joined Windows 10 and 11 
computers and works with the Pro, Enterprise, and Education editions. Microsoft does not support 
Microsoft Entra join on Windows Home editions.

The Printix Client Microsoft Installer (MSI) package and MSI arguments are available on the
Software  page.
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• MSI arguments
Select the relevant one to copy it to the clipboard.
• Sign in after installation

Sign-in will occur right after Printix Client is installed. This is the default behavior.
• Sign in postponed until restart

Deploy Printix Client without starting the user interface (PrintixClient.exe). This method 
can be used to install Printix Client as part of an automated process (such as Windows 
Autopilot) that completely configures a new computer before this is delivered to the user. This 
way, sign in is postponed until the user starts to use the computer. Only the Printix Service 
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(PrintixService.exe) is started. The computer with Printix Client will only be registered and listed 
in Printix Administrator after a user has signed in.

 If users have issues while signing in to the Printix Client after deployment, see Sign in issues.

1. Open the Software  page.
2. Select Printix Client (MSI).

This downloads the Microsoft Installer (MSI) package.
Example:  CLIENT_{acme.printix.net}_{cbd7e0b5-da2a-4cb6-b7f7-a04ee31cac90}.MSI

3. Open a new browser window and sign in to Microsoft Endpoint Manager admin center
(endpoint.microsoft.com) using your work account credentials.

4. In the Microsoft Endpoint Manager admin center, select Apps.
5. On the Apps | Overview blade, under By platform, select Windows.
6. On the Windows | Windows apps blade, select Add.
7. In the Select app type pane, under the Other app types, select Line-of-business app.
8. Select Select to select App package file.
9. In the Add app pane, select Select app package file.

10. In the App package file pane, select the browse button, then select the 
CLIENT_{home}_{id}.MSI file you downloaded in step 2.
Example:  CLIENT_{acme.printix.net}_{cbd7e0b5-da2a-4cb6-b7f7-a04ee31cac90}.MSI
The app details will be displayed.

11. Select OK on the App package file pane to add Printix Client.
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12. On the App information page:
• In Name, optionally, edit the text: Printix Client.
• In Description, optionally, edit the text: Printix Client.
• In Publisher, type: Printix.
• App install context is set to Device context and cannot be changed.
• For Ignore app version, select Yes as the Printix Client automatically updates to the latest 

version.
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• In Command line arguments, paste the MSI arguments you copied to the clipboard on the
Software page.
Example: WRAPPED_ARGUMENTS=/id:cbd7e0b5-da2a-4cb6-b7f7-a04ee31cac90
• The /id value is your Printix ID as show in the name of the MSI file you downloaded in step 

2.
• After deployment, the /id value is saved in the Windows Registry.
• If you want to deploy and have sign-in postponed until restart, :oms is appended.

Example: WRAPPED_ARGUMENTS=/id:cbd7e0b5-da2a-4cb6-b7f7-a04ee31cac90:oms
• In Category, select Productivity.
• For Show this as a featured app in the Company Portal, select No.
• In Information URL, optionally, type: https://printix.net
• In Privacy URL, optionally, type: https://printix.net/privacy
• In Developer, optionally, type: Printix
• In Owner, optionally, type: Printix
• In Notes, optionally, type any notes you want to associate with this app.
• Optional Logo. Select Select image to select for example an image with the Printix logo.

13. Select Next.
14. Select the Required or Available for enrolled devices.
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15. Select Next to display the Review + create page.
16. Review the values and settings you entered.
17. When you are done, select Create to add Printix Client to Intune.


• As an administrator, you may want to deploy Microsoft .NET Desktop Runtime 6 to 

computers before deploying Printix Client. Otherwise the installation/update will fail.
• If the Printix Client does not deploy and your Microsoft Entra tenant's MDM authority is 

unknown, check the Microsoft documentation: Set MDM authority to Intune.

Can I use Intune for Education?
Intune for Education (part of Microsoft Education, Windows 10 (version 1703 or higher)) is a simple 
but powerful solution for managing policies, apps and settings for your classroom devices. As a 
subscriber to Microsoft Intune for Education you have also access to Microsoft Endpoint Manager.
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To deploy Printix Client to classroom devices you need to open Microsoft Endpoint Manager (not
Intune for Education) and follow the above instructions. This is because Intune for Education does 
not allow you to specify Command line arguments.

Where to find the Printix ID in Windows Registry?
1. Press Windows+R.

The Run dialog box appears.
2. Type regedit, then select OK.

Select Yes if prompted.
The Registry Editor appears.

3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\printix.net\Printix Client\Tenant.
4. The value TenantId should be your Printix ID as shown in the name of the MSI file you 

downloaded in step 2.
Example:  cbd7e0b5-da2a-4cb6-b7f7-a04ee31cac90
The value TenantName is typically your Printix Home (acme.printix.net), however, it may say 
Printix Auto Name when installation is through MSI/Microsoft Endpoint Manager.

How to deploy Printix Client for Mac with Microsoft Endpoint 
Manager

You can automatically deploy Printix Client for Mac with Microsoft Endpoint Manager.
1. Open the Software  page.
2. Select Printix Client to download it.
3. Open Downloads, for example from the Dock at the bottom of the screen.
4. Double-click CLIENT_{home}_{id}.DMG.

After a few seconds, the Printix Client dialog box appears.

5. Copy the cardboard box icon (Printix Client.pkg) to a temporary location.
6. Extend the name of the copied package file to have a similar name as the DMG file (Printix 

Client_{home}_{id}.pkg).
7. Open a new browser window and sign in to Microsoft Endpoint Manager admin center

(endpoint.microsoft.com) using your work account credentials.
8. In the Microsoft Endpoint Manager admin center, select Apps.
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9. On the Apps | Overview blade, under By platform, select macOS.
10. On the macOS | macOS apps blade, select Add.
11. In the Select app type pane, under the Other app types, select Line-of-business app.
12. Select Select to select App package file.
13. In the Add app pane, select Select app package file.
14. In the App package file pane, select the browse button. Then, select the package file you 

renamed in step 6 (Printix Client_{home}_{id}.pkg).
The app details will be displayed.

15. Select OK on the App package file pane to add Printix Client.
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16. On the App information page:
• In Name, optionally, edit the text: Printix Client_{home}_{id}.pkg.
• In Description, optionally, edit the text: Printix Client_{home}_{id}.pkg (1.3.1235).
• In Publisher, type: Printix.
• In Minimum operating system, select macOS Sierra 10.12.
• In Install as managed, select No.
• For Ignore app version, select Yes as the Printix Client automatically updates to the latest 

version.
• In Category, select Productivity.
• For Show this as a featured app in the Company Portal, select No.
• In Information URL, optionally, type: https://printix.net
• In Privacy URL, optionally, type: https://printix.net/privacy
• In Developer, optionally, type: Printix
• In Owner, optionally, type: Printix
• In Notes, optionally, type any notes you want to associate with this app.
• Optional Logo. Select Select image to select for example an image with the Printix logo.

17. Select Next.
18. Select the Required or Available for enrolled devices.
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19. Select Next to display the Review + create page.
20. Review the values and settings you entered.
21. When you are done, select Create to add Printix Client to Intune.

Troubleshooting

 Up to 8 hours after installation, the Microsoft Company Portal may still show the Printix 
Client.pkg as Downloading even though the download and installation is complete. This is 
because Microsoft relies on an 8-hour synchronization interval. If you sync the Mac computer 
from Microsoft Endpoint Manager, the Company Portal will update and show the correct state 
(Installed).
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How to deploy Printix Client for Mac with Jamf Pro
You can automatically deploy Printix Client for Mac with Jamf Pro.

 These instructions apply to Jamf Pro version 10.25. It may be different in other versions, but 
the principle is the same.

1. Open the Software  page.
2. Select Printix Client to download it.
3. Open Downloads, for example from the Dock at the bottom of the screen.
4. Double-click CLIENT_{home}_{id}.DMG.

After a few seconds, the Printix Client dialog box appears.

5. Copy the cardboard box icon (Printix Client.pkg) to a temporary location.
6. Extend the name of the copied package file to have a similar name as the DMG file (Printix 

Client_{home}_{id}.pkg).
7. Open a new browser window and sign in to Jamf Pro.
8. In Jamf Pro, select Computers.
9. On the Computers page, select Management Settings. Under Computer Management, 

select Packages.
10. Select New to add a new package.
11. Under Filename, select Upload, then select the package file you renamed in step 6 (Printix 

Client_{home}_{id}.pkg).
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12. Navigate to Computers, Policies and select New to add a new policy.
13. In the Options tab, specify the following settings:

• In Display name, type: Printix Client_{home}_{id}.
• In Trigger, select Recurring Check-in.
• In Execution frequency, select Once per computer.

14. Select Packages and select Configure.
15. Find the newly added Printix Client_{home}_{id}.pkg file and select Add to add it to the policy.
16. On the Scope tab, set the appropriate inclusions and exclusions.
17. Select Save.

How to deploy Printix Client for Mac with Addigy
1. Open the Software  page.
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2. Select Printix Client for MAC to download it.
Take note of the version number of the downloaded file, because it will be needed later.

3. Open Downloads, for example, from the Dock at the bottom of the screen.
4. Double-click CLIENT_{home}_{id}.DMG.

After a few seconds, the Printix Client dialog box appears.

5. Copy the cardboard box icon (Printix Client.pkg) to a temporary location.
6. Extend the name of the copied package file to have a similar name as the DMG file (Printix 

Client_{home}_{id}.pkg).
7. Log in to your Addigy environment and select Catalog, and then Software.
8. On the Smart Software tab, select New.
9. Enter a Software name and the Version you copied in step 2.

10. For the Installation Files, upload and select the package file you renamed in step 6.
Follow the instructions on the file selection screens until you return to the Installation Files.
The file is selected if green text displays Apps found.

11. Save the changes.
12. Go to Policies and add a preferred policy from the catalog.
13. Select Deploy.

How to include Printix Client in a managed image
To make Printix Client work with a managed image, you need to modify the Windows Registry 
before you create the managed image.

1. Install the Printix Client, so it becomes part of the new managed image.
A managed image is typically used in connection with:
• Azure Virtual Desktop
• Citrix
• Remote Desktop Services (RDS)
• VMware Horizon VDI

2. Produce an image without the trace of previously registered computers.
• Must include user's Printix settings in the Application Data roaming profile with Windows 

Registry setting StartAsVDI (step 8 below).
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• Optionally, control access to print queues with Windows Registry setting
useGroupPermissions (step 9 below).

3. Before you start to use the new image, delete the computer in Printix Administrator.
After a short time, the computers will register and appear in Printix Administrator.

Produce an image without the trace of previously registered computers 
(WSid)

If an image is produced after a user has signed in, and subsequently installed on another computer, 
then there will be an unwanted condition where these computers will have the same WSId. This 
will result in the computers fighting for connection and they will try to update the same computer 
properties in the Printix Cloud. To resolve the issue you need follow the steps below to make an 
image, where no computer (WSid) has been registered.

1. Open the Task Manager.
2. Select the Details tab.
3. Select PrintixClient.exe and select End task. Select End process.
4. Select PrintixService.exe and select End task. Select End process.
5. In the Registry Editor, browse to: HKEY_LOCAL_MACHINE\SOFTWARE\printix.net\Printix 

Client\

6. Delete the Printix Client folders:
• \RT
• \WS

7. Verify that these folders are still there:
• \CurrentVersion
• \Printers
• \Tenant
• \Users

8. In the Printix Client folder, add the DWORD value name StartAsVDI.
The StartAsVDI can take on these decimal values (hex value in parenthesis):
• 0 (0×00000000)

This is the default. Printix Client will update itself automatically.
• 1 (0×00000001)

Printix Client will NOT update itself automatically. It will read and write the user's Printix 
settings, including access tokens, in the user's Application Data folder.
• The path to the users application folder is based on %APPDATA%.

• 2 (0×00000002)
Printix Client will update itself automatically. It will read and write the user's Printix settings, 
including access tokens, in the user's Application Data folder.
• The path to the users application folder is based on %APPDATA%.

• 999 (0×000003e7)

746



Tungsten Printix Administrator Guide

Printix Client will NOT update itself automatically. It will read and write the user's Printix 
settings, including access tokens, in the user's Application Data folder.
• The path to the user's application folder is based on %USERPROFILE% and then AppData

\Roaming is appended.
9. In the Printix Client folder, add the DWORD value name useGroupPermissions.

It can take on these decimal values (hex value in parenthesis):
• 0 (0×00000000)

This is the default. Printix Client will make all installed print queues available to the signed in 
user.

• 1 (0×00000001)
Printix Client will look at the users' group membership and only make print queues with
Exclusive access available to the signed in user. This is done by setting the security privileges 
on the print queues accordingly. The groups MUST be in both Active Directory and
Microsoft Entra ID.

10. Produce the image.

How to see the value of APPDATA
Open a command prompt and type: echo %APPDATA%
• Typically, this will give the result:
C:\Users\{username}\AppData\Roaming

Example: C:\Users\John\AppData\Roaming
• If the AppData folder is redirected, this will give the result:
\\{servername}\{folder}Redirect$\{username}\Application Data

Example: \\myserver.acme.com\myfolderRedirect$\John\Application Data

The below is the example of the Printix-relevant path and subfolders that must be included in the 
roaming profile.
• %APPDATA%\printix

Example: \\myserver.acme.com\myfolderRedirect$\John\Application Data\printix

747



Tungsten Printix Administrator Guide

How to deploy Printix App for Android with Microsoft Endpoint 
Manager

1. Open a new browser window and sign in to Microsoft Endpoint Manager admin center
(endpoint.microsoft.com) using your work account credentials.

2. In the Microsoft Endpoint Manager admin center, select Apps.
3. On the Apps | Overview blade, under By platform, select Android.
4. On the Android | Android apps blade, select Add.
5. In the Select app type pane, under the Store app app types, select Android store app.
6. In the Add app pane, select Search the App store.
7. In search, type: Printix App
8. Select Printix App and select Select.
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9. On the App information page:
• In Name, type: Printix App
• In Description, optionally, type: Use the Printix App to release documents on Printix-

managed printers.
• In Publisher, type: Printix
• In Appstore URL, type: https://play.google.com/store/apps/details?id=net.printix.printixapp
• In Minimum operating system, select Android 6.0 (Marshmellow).
• In Category, select Productivity.
• For Show this as a featured app in the Company Portal, select Yes.
• In Information URL, optionally, type: https://printix.net
• In Privacy URL, optionally, type: https://printix.net/privacy
• In Developer, optionally, type: Printix
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• In Owner, optionally, type: Printix
• In Notes, optionally, type any notes you want to associate with this app.
• Optional Logo. Select Select image to select, for example, an image with the Printix logo.

10. Select Next.
11. Select the Required or Available for enrolled devices.

12. Select Next to display the Review + create page.
13. Review the values and settings you entered.
14. When you are done, select Create to add Printix App to Microsoft Endpoint Manager.

How to deploy Printix App for iOS/iPadOS with Microsoft 
Endpoint Manager

1. Open a new browser window and sign in to Microsoft Endpoint Manager admin center
(endpoint.microsoft.com) using your work account credentials.
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2. In the Microsoft Endpoint Manager admin center, select Apps.
3. On the Apps | Overview blade, under By platform, select iOS/iPadOS.
4. On the iOS/iPadOS | iOS/iPadOS apps blade, select Add.
5. In the Select app type pane, under the Store app app types, select iOS store app.
6. In the Add app pane, select Search the App store.
7. In search, type: Printix App
8. Select Printix App and select Select.
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9. On the App information page:
• In Name, optionally, edit the text: Printix App
• In Description, optionally, edit the text: Use the Printix App to release documents on Printix-

managed printers.
• In Publisher, leave it at: Printix.
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• In Appstore URL, leave it at: https://apps.apple.com/us/app/printix-app/
id1391512097?uo=4

• In Minimum operating system, select iOS 11.0.
• In Applicable device type, leave it at: 2 selected (iPad, iPhone, and iPod).
• In Category, select Productivity.
• For Show this as a featured app in the Company Portal, select Yes.
• In Information URL, optionally, type: https://printix.net
• In Privacy URL, optionally, type: https://printix.net/privacy
• In Developer, optionally, type: Printix
• In Owner, optionally, type: Printix
• In Notes, optionally, type any notes you want to associate with this app.
• Optional Logo. Leave it at the Printix logo.

10. Select Next.
11. Select the Required or Available for enrolled devices.
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12. Select Next to display the Review + create page.
13. Review the values and settings you entered.
14. When you are done, select Create to add Printix App to Microsoft Endpoint Manager.

How to search for computers
Use Search  to find computers.

1. Open the Computers  page.
2. Select Search .
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3. Enter part of the computer's hostname or IP address.
The search is not case-sensitive.

How to work with sites

By optionally creating Sites , you can:
• Delegate management tasks to the IT personnel at the local site

Administrators with the role site manager can manage printers and printing in Printix 
Administrator without having excess privileges to change global settings and printing at other 
sites.

• Visualize the print infrastructure
In Printix Administrator, browse sites to see the organization of printers and print queues.

See also:
• What actions can a site manager perform
• How to add a printer to a site
• How to delete a printer

 System manager role is required to add, modify, and delete sites and networks and manage 
site manager groups.

• How to create a site
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• How to move a site
• How to delete a site
• How to add a network to a site
• How to remove a network from a site
• How to add a site manager group to a folder or site
• How to remove a site manager group from a site

What actions can a site manager perform
A site manager  can perform these actions:

Printers
• Discover printers on networks belonging to managed sites.
• Add printer on networks belonging to managed sites.
• Modify printer on networks belonging to managed sites.
• Delete printer on networks belonging to managed sites.
• Delete unregistered printers.
• Register NFC tag for printers belonging to managed sites.
• Delete NFC tag from printers belonging to managed sites.

Print queues
• Add print queue to printers belonging to managed sites.
• Modify print queue of printers belonging to managed sites.
• Delete print queue of printers belonging to managed sites.
• Distribute print queue configuration from any print queue belonging to managed sites.
• Add print queues on computers belonging to managed sites.
• Update print queues on computers belonging to managed sites.
• Convert print queues on computers belonging to managed sites.
• Set printer as default for a print queue on a computer belonging to managed sites.

History
• See history for printers belonging to managed sites.

Groups
• Add group to print queues belonging to managed sites.
• Remove group from print queues belonging to managed sites.

 A "Permission denied" dialog box will appear if a site manager performs an unauthorized 
action.
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How to add a printer to a site
1. Open the Sites  page.
2. Select the site.
3. In the center pane, select a network name to open the network.

• Select Add printer  to add a printer.
• Select Discover printers  to add printers.

 Printers will belong to the site of their network.

How to delete a printer
1. Open the Sites  page.
2. Select the site.
3. In the center pane, select a network name to open the network.
4. Select Printer setup  to open the Printer  menu.
5. Select Delete to delete printer.

 When you delete a printer, the corresponding Printix print queues on users' computers 
will also be deleted by the Printix Client.

How to create a site
1. Open the Sites  page.
2. Select Create site .
3. In the Create site dialog box, enter Site name.
4. Select OK.
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5. Select the new site and complete the Get started wizard:

a. Add network.

b. Add computer to network.

c. Discover printers.

d. Add site manager groups.

How to move a site
1. Open the Sites  page.
2. In the left pane (tree structure), select the site you want to move and drag and drop it to the 

new position.

How to delete a site
1. Open the Sites  page.
2. Select the site.
3. In the center pane, select Site setup  to open the Site  menu and select Delete site.

How to add a network to a site
1. Open the Sites  page.
2. Select the site.
3. In the center pane, select Add network .

If it is a new network, select Create new network and name it. Otherwise, select Add 
networks. Alternatively, right-click the site and select Add networks, or select Site setup  to 
open the Site  menu and select Add networks.

4. Select the networks to be added to the site.
• Select Search  to search by network name.

The search is not case-sensitive.
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5. Select Save.

How to remove a network from a site
1. Open the Sites  page.
2. Select the site.
3. In the center pane, select Site setup  to open the Site menu and select Networks.

Alternatively, right-click the site and select Networks.
4. For the network to be removed, select More  and Remove to remove the network.

How to add a site manager group to a folder or site
1. Ensure you have enabled groups (Microsoft Entra or Google).
2. Open the Sites  page.
3. Select the folder or site.
4. In the center pane, select Setup  to open the Folder  menu and select Add site manager 

groups.
Alternatively, right-click the folder or site and select Add site manager groups.

5. Select Search  to search by group name.
The search is not case-sensitive.

6. Select the groups to add whose users will have the site manager role.
7. Select Save.

See also:
• How to work with sites

How to remove a site manager group from a site
1. Open the Sites  page.
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2. Select the site.
3. In the center pane, select Site setup  to open the Site  menu and select Site manager 

groups.
Alternatively, right-click the site and select Site manager groups.

4. Select More  and Remove  to remove the group.
Alternatively, remove the user from the group (Microsoft Entra or Google).

See also:
• How to work with sites

How to add a network

1. Open the Networks  page.
2. Select Add network .
3. In the Create new network dialog box, enter Network name.
4. Select OK.

Next, you need to select the gateway (and thereby the computers) that should be part of the 
network.

5. Select Unknown networks.
If no computers are associated with unknown networks, it will say: No computers on 
unknown networks.
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 The gateway with the most computers is at the top, and is probably the one you want to 
add to the network.

6. Select the gateway (identified by IP and MAC address).
7. On the Gateway properties page, select the newly added network.
8. Select Save.

How to add a network/gateway from the computer properties page
This alternative method is useful if many unknown networks exist.
• The method assumes you know of a computer that is on the network you want to add.

1. If you know the name of the computer, go to step 5. Otherwise, Search for the user whose 
computer is on the unknown network.

2. Enter part of the user's name or email.
The search is not case-sensitive.

3. Select  and Info to see information about the user.
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4. Select the Computer (COMPIX) link to open the Computer properties page.
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5. On the Computer properties page, you can, for the gateway you want to add, either:
• Select Select network to add the gateway to an existing network.

• Select network. Optionally, enter part of the network name to Search for it. Select Select 
network.

• Select Create new network to create a new network with this gateway.
• Enter Network name and select Create new network.

 A computer with multiple network interfaces (Wi-Fi and LAN) will be listed with a gateway 
for each of these.
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How to manually add a gateway
If you know the IP and the MAC address of the gateway, you can either:
• Use Add gateway on the Network properties page.
• Use Printix Configurator to add the gateway to an existing network.

How to modify network name
1. Open the Networks  page.
2. Select the network.
3. Select Modify.
4. On the Network properties page, edit the Network name.
5. Select Save.

How to add an unknown network to a network

1. Open the Networks  page.
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2. Select Unknown networks.
• If no computers are associated with unknown networks, it will say: No computers on 

unknown networks.
• If many unknown networks exist, you can add a gateway from the computer properties 

page.
• Alternatively, use the Add gateway button on the Network properties page.

3. Select the gateway (identified by IP and MAC address) to open the Gateway properties page.

4. In Network, select the Modify  icon to select network.
5. Select network. Optionally, enter part of the network name to Search for it. Select Select 

network.
6. Select Save.

 You can select the Computers  tab to see the computers that are using this gateway.
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How to add a gateway to a network
Alternatively to the below method, you can choose to add a gateway from the computer properties 
page.

1. Open the Networks  page.
2. Select the network.
3. Select Modify.
4. On the Network properties page, identify the Gateways section.
5. Select Add gateway.
6. In the Add gateway dialog:

• Enter IP address.
Example: 192.168.1.1

• Enter MAC.
Example: 54a050e55bc0, 54:a0:50:e5:5b:c0, or *
Entering the asterisk/star symbol (*) as a wildcard for the MAC address is useful if you use 
network gateways (Fortinet) that after a power cycle changes the MAC address but keeps the 
IP address.

7. Select Save.

How to delete a gateway from a network
1. Open the Networks  page.
2. Select the network.
3. Select Modify.
4. On the Network properties page, identify the Gateways section.
5. Select the Delete  icon.
6. Select Confirm.

How to merge networks
If two networks (Network1 and Network2) are logically the same, that is computers on the 
network Network1 can connect to computers on the network Network2, and vice versa, then you 
should merge the networks:

1. Delete the gateway from the network Network2.

a. Open the Networks  page.

b. Select the network Network2.

c. Select Modify.

d. On the Network properties page, identify the Gateways section.
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e. Select the Delete  icon.
Make a note of the IP and MAC, because this is the same gateway you need to select in 
step 14.

f. Select Confirm.
2. Add the gateway to the network Network1.

a. Open the Networks  page.

b. Select Unknown networks.
If no computers are associated with unknown networks, it will say: No computers on 
unknown networks.

c. Select the gateway (identified by IP and MAC address).

d. On the Gateway properties page, select the network Network1.

e. Select Save.
3. Delete the network Network2.

a. Open the Networks  page.

b. Select the network Network2 and select Delete.

c. Select Move printers to another network.

d. Select network Network1. Select OK to move the printers to network Network1 and 
delete the network Network2.
• If you clear Move printers to another network, all printers on the network will also be 

deleted.

How to enable printing via the cloud
Typically, for printing to function, a user's computer must be on the same company network as the 
printer. By enabling printing via the cloud, users can print to this printer while they are on another 
company network.

1. Open the Print queue properties page.
2. Select Via the cloud.

• Can only be modified if you have the role: System manager.
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3. By default, On all networks is selected and the print queue will be available via the cloud to 
all computers on all networks, including computers on unknown networks. Select On selected 
networks only if the print queue is to be available via the cloud on the selected networks only. 
In a zero trust networks environment, use this to make the site's printers (on their own printer 
network) available to only the computers on the site's computer network.

4. Select Save.

See also: Networks

Users whose computer is on an unknown network, perhaps while they are working at home or 
traveling, can print directly to the printer. A user who attempts to release a document while the 
computer is on an unknown network will see the message: "Unable to perform action while Printix 
Client is on an unknown network."
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Modify Via the cloud for multiple print queues

If you are modifying multiple print queues, the following rules apply:
• If you select Via the cloud, all selected print queues will have Via the cloud selected and On all 

networks selected.
• If you clear Via the cloud, all selected print queues will have Via the cloud cleared.
• If you select On all networks, all selected print queues that have Via the cloud selected will have

On all networks selected.
• If you select On selected networks only, all selected print queues that have Via the cloud

selected will have On selected networks only selected.
• If you select Networks setup  to open Networks  menu, all selected print queues will have 

the selected networks when you select Save.
• Add to network: In the left pane, select network (all networks are shown).
• Remove from network: In the right pane, select X to remove (only networks where the 

selected print queues are added are shown).
• A print queue is always available on the network of the corresponding printer.
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How it works
Printing is achieved through Printix Cloud and a Printix Client computer on the printer's network. At 
least one of the Printix Client computers on the printer's network should have permanent network 
access. The document remains secure during the transfer over the Internet as the document itself 
and the communication are both encrypted.

If the release printer support PDF printing, the document is sent to the printer. If the release 
printer does not support PDF printing, then, if needed, a print queue is added automatically, so the 
document can be processed using a matching print driver. Adding the print queue on the computer 
may take 1-5 minutes depending on the print driver. During this time, the Printix App will show the 
state "Working on it", before transitioning to "Printing" and then "Printed". The print queue is kept 
after printing, so it does not have to be added again when subsequent Print Anywhere documents 
are released to this printer.

How to check if the printer supports PDF
1. Open the Printers  page.
2. Select  and Info to see information about the printer.
3. On the Printer Info page, the Feature section shows PDF if PDF printing is supported.

How to work with groups
Groups can be used to control access to printers and deploy printers based on users' and 
computers' group membership.
• About groups
• Exclusive access examples

• Hide print queues from users
• How to enable Microsoft Entra groups
• How to enable Google groups
• How to add groups to a print queue
• How to add print queues to a group
• How to make a workflow available to selected groups
• Groups page
• Group properties

• Settings, secure print tab
• Settings, Printix Go tab
• Settings, Capture workflows tab

• Group properties, Print queues tab
• Print queue properties, Groups tab

• Group properties, Users tab
• User properties, Groups tab
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• Group properties, Computers tab
• Computer properties, Groups tab

About groups


• Printix will only synchronize users/group membership for users that are registered in Printix 

and for groups after these groups are used within Printix, that is, if users are a member of a 
group that: A) Is used with Print queues, B) Is used with Secure print, that is (Must print securely 
groups, Print Later by default groups, or Secure print level groups), C) Is used with Home office, 
D) Is used with Capture workflows, or E) Is used with site manager roles.

• Why does a group have no or missing users?
• Nested groups are not supported.

• Microsoft Entra groups
• Users' membership of groups is maintained in Microsoft Azure (portal.azure.com)
• Computers that are registered with Microsoft Entra ID can have their membership of (device) 

groups maintained in Microsoft Endpoint Manager admin center (endpoint.microsoft.com) 
or Microsoft Azure. See also: Microsoft documentation on: Add groups to organize users and 
devices
• Computer groups are used only in connection with Home office and print queue properties

Add print queue automatically and Set as default printer.
• Groups are synchronized automatically at approximately 20 minute intervals. Only changes 

are synchronized.
• Nested groups are not supported.
• Enable dynamic memberships to manage memberships through the rules you specify.
• See the Microsoft Entra ID documentation.

• Google groups
• Users' membership of groups is maintained in your Google Admin console

(admin.google.com).
• Groups are synchronized automatically at approximately 20 minute intervals. Only changes are 

synchronized.
• Nested groups are not supported.
• Computer groups are not supported.
• See the Google Workspace Administrator Help.

• Print queues
• Print queue/group membership is maintained in Printix Administrator by adding groups to 

print queues.
• A print queue that has Exclusive access selected for one or more groups can be accessed ONLY 

by the users in any of those groups.
• A print queue that does not have Exclusive access selected for any group can be accessed by all 

users.
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• Printing to a print queue without access will result in a message such as: Print to BNM is not 
allowed.

• A print queue that has Add print queue automatically will be added automatically to the 
computer when a user in any of those groups signs in.

• A print queue that has Set as default printer selected will become the default printer for the 
users and computers in the group.

• A print queue can be Exempt from secure print.

Access to print queues is obviously also subjected to restrictions imposed by networks .

Exclusive access examples
Shows how access to print queues within a network can be controlled for five users, four print 
queues (ASD, BNM, CVB, and DFG) and three groups (G1, G2 and G3).

• Jane (member of the groups G1 and G2) is allowed to use print queue: ASD, BNM, CVB, and DFG.
• Paul (member of the group G1) is allowed to use print queue: ASD, BNM, and DFG.
• Mary (member of the groups G2 and G3) is allowed to use print queue: ASD, CVB, and DFG.
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If Mary attempts to print to the BNM print queue, she will see the message: Print to BNM is not 
allowed.

• John (member of the group G3) can use print queue: DFG.
• Bob (not a member of any group) can use print queue: DFG.

ASD BNM CVB DFG

Jane + + + +

Paul + + – +

Mary + – + +

John – – – +

Bob – – – +

Hide print queues from users
Printix Client can be configured with useGroupPermissions to set security privileges on print 
queues. Exclusive access groups on print queues will now limit the security privileges accordingly, 
and only users being members of the Exclusive access groups will be able to see and print to the 
restricted print queues. Otherwise, all installed print queues is made available to the signed in user.

1. Press Windows+R.
The Run dialog box appears.

2. Type regedit, then select OK.
Select Yes if prompted.
The Registry Editor appears.

3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\printix.net\Printix Client\.
4. In the Printix Client folder, add the DWORD value name useGroupPermissions.

It can take on these decimal values (hex value in parenthesis):
• 0 (0×00000000)

This is the default. Printix Client will make all installed print queues available to the signed in 
user.

• 1 (0×00000001)
Printix Client will look at the users' group membership and only make print queues with
Exclusive access available to the signed in user.
The groups MUST be in both Active Directory and Microsoft Entra ID.

How to enable Microsoft Entra groups
If you have enabled Microsoft Entra authentication, you can use Microsoft Entra groups to deploy 
and control access to printers and to control access to capture workflows based on users' group 
membership. You must have the global administrator role in Microsoft Entra ID to synchronize 
groups.
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 Nested groups are not supported.

1. On the Authentication page, select the Microsoft Entra ID tab.
2. Select Accept next to Synchronize groups.
3. On the Microsoft sign-in page:

• Enter your administrator account. You must have the global administrator role in Microsoft 
Entra ID to synchronize groups.

• Enter Password.
4. Select Sign in.
5. Printix will ask you to accept permissions for your organization to:

• Sign in and read user profile
• Read directory data
• Read all groups
• Read all hidden memberships
• Read all users' full profiles
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6. Select Accept to grant these permissions, so Printix can synchronize groups.
If this is successful, you will see: Groups synchronized from Azure. If you select Accept again, 
it will do a full synchronization (can take time!). In Microsoft Azure, this will add the enterprise 
application printix-cloud-sync.
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Troubleshooting
• Could not verify group synchronization
• The Groups page does not load any groups
• Groups do not seem to synchronize any more
• Why does a group have no or missing users?

Could not verify group synchronization
The account you used to sign in with did not have the global administrator role in Microsoft Entra 
ID.

Resolution: On the Microsoft sign-in page, sign in with an account that has the global administrator 
role.

The Groups page does not load any groups
Only groups added to print queues will appear.

Resolution: Add groups to a print queue.

Groups do not seem to synchronize any more
This can happen if the printix-cloud-sync application has been deleted. The application is 
responsible for synchronizing groups from Microsoft Entra ID.
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Resolution: On the Authentication page, select the Microsoft Entra ID tab. Select the Accept again
link to have Groups synchronized from Azure again.

1. Open a new browser window and sign in to Microsoft Azure (portal.azure.com) using your 
work account credentials.

2. In the portal menu, select All Services.
3. In the Identity category, select Microsoft Entra ID.
4. On the left pane, select Enterprise applications.
5. Search for printix.
6. Verify that Printix and printix-cloud-sync are in the results.

How to enable Google groups
If you have enabled Google authentication, you can use Google groups to deploy and control access 
to printers based on users' group membership. You must have a Google Workspace administrator 
account.

 Nested groups are not supported. Computer groups are not supported.

1. On the Authentication  page, select the Google tab.
2. For Synchronize groups, select Accept.
3. On the Sign in with Google page, sign in using your Google Workspace administrator account 

(john.smith@acme.com):
• Enter your administrator account.
• Enter Password.
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4. Select Next.

5. You are prompted to allow Printix to:
• View groups on your domain.

6. Select Allow, so Printix can synchronize groups.
If this is successful, you see: Groups synchronized from Google. If you select Accept again, it 
does a full synchronization (can take time!).
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Troubleshooting
• Could not verify group synchronization
• The Groups page does not load any groups

Could not verify group synchronization
The account you used to sign in with was not a Google Workspace administrator account.

Resolution: On the Sign in with Google page, sign in using your Google Workspace administrator 
account.

The Groups page does not load any groups
Only groups added to print queues will appear.

Resolution: How to add groups to a print queue.
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How to add groups to a print queue

1. Open the Print queue properties page.
2. Select the Groups  tab.

Only available if groups (Microsoft Entra or Google) are enabled.
3. Select Add groups  to add groups.
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4. Select Show all to show all groups, including those that have not been added to a print queue.
Depending on your organization, you may see a large number of groups, perhaps even 1000s.
• Clear Show all to show only groups that have been added to print queues.
• Select Search  to search by group name.

The search is not case-sensitive.

 If the group cannot be found, select Show all and select Resynchronize groups (dialog 
box will close) and repeat the Search.

5. Select the groups to be added to the print queue.
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6. Select Continue.
• Select Back to go back to change the selection of groups.
• Select Exclusive access if you want to give the group members exclusive access to the print 

queue.
• Select Add print queue automatically if you want the print queue to be added 

automatically to the computers in the group. Users in the group will have the print queue 
added to the computer when they sign in.

• Select Set as default printer if you want the print queue to become the default printer for 
the users and computers in the group.


• If Set as default printer is selected for multiple print queues, it will be random which one 

will be set as default. Printix Client will override the user's selection of default printer every 
time the Printix Service is started and or it receives updates to its list of printers and their 
configuration.

• If Exclusive access is selected for one group, then if you select Add print queue 
automatically for any other groups, those groups should also have Exclusive access
selected.

7. Select Confirm.
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How to add print queues to a group

1. Open the Group properties page.
Only available if groups (Microsoft Entra or Google) are enabled.

2. Select the Print queues  tab.
3. Select Modify .
4. Select the print queues to be added to the group.

For each print queue, select the relevant options:
• Select Exclusive access if you want to give the group members exclusive access to the print 

queue.
• Select Add print queue automatically if you want the print queue to be added 

automatically to the computers in the group. Users in the group will have the print queue 
added to the computer when they sign in.

• Select Set as default printer if you want the print queue to become the default printer for 
the users and computers in the group.
• Only one print queue in the group can have this selected.

783



Tungsten Printix Administrator Guide

• If Set as default printer is selected for multiple print queues, it will be random which 
one will be set as default. Printix Client will override the user's selection of default printer 
every time the Printix Service is started and or it receives updates to its list of printers and 
their configuration.

5. Select Save.
Print queues with no options selected will not be members of the group.

How to delegate printing
Sometimes, you may want another person to collect your printed documents, but the printer only 
accepts cards that belong to you. To work around this:

Register a card that you will only use for delegate printing.
Whenever you print a document, you can give this card to your assistant who can then collect your 
documents from the printer.

How to get started with capture and workflow
We recommend that you, as the system manager, go through the below steps so you and your 
users can get started with capture and workflow.

1. Check the requirements.
2. Evaluate from which sources (printer and/or mobile) your users need to capture data from.

• Optionally, select Act as capture gateway if you prefer Printix Client on a particular 
Windows computer on the printer's network to handle scanned documents and delivering 
these to the selected workflowdestination. Printix Cloud will otherwise automatically select 
an online Printix Client on the printer's network if none of the preferred computers are 
online.

3. Decide the kinds of workflows you need to create and to whom should workflows be available.
• Verify that the workflow works as expected.
• Activate the workflow.

Requirements for capture at the printer
• Computer with Printix Client version 1.3.1253.0 or higher for Windows must be online on the 

printer's network during the use of Printix Capture.
• It must be possible to ping computers by hostname. This is a requirement for HP and Konica 

Minolta because the printer/computer scan connection uses secure HTTPS communication, and 
to avoid having to renew certificates whenever the computer changes IP address it must be 
possible to reference the computer by hostname.

• Printer must support Capture (see below).
• Install Printix Capture on the printer.
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Vendor Go version Capture

Brother 2.3.0.0 No

Epson 2.3.0.0 No

Fujifilm 2.3.0.3 No

HP 2.3.0.0
Capture version 2.3.0.0

Yes

HP Workpath 2.3.0.10 No

Konica Minolta 2.3.0.0
Capture version 2.3.0.0

Yes

Kyocera 2.3.0.5
Capture version 2.3.0.5

Yes

Lexmark 2.3.0.4 No

Ricoh 2.1.3.21
Capture version 2.1.3.19
Installer version 2.1.3.17

Yes

Xerox 2.3.0.0 No

Requirements for capture with mobile
• Users need to update their Printix App version.

Platform Version Capture

Apple iOS/iPadOS 3.0.1 Yes

Google Android 3.0.1 Yes

Checklist
• Want to capture at the printer?
• Want to capture with mobile?
• What workflows do you want to create?
• To whom should workflows be available?

Want to capture at the printer?
• Install Printix Capture  so users can sign in at the printer with ID code or card to capture 

documents: [ Yes | No ]
• Check requirements.

Want to capture with mobile?
• Users want to use Printix App on their phone to capture and deliver images to their selected 

workflow destination: [ Yes | No ]
• Check requirements.
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What workflows do you want to create?
• Email  as workflow destination: [ Yes | No ]

• You can configure the subject of the email to not be empty by default.
• How to create a workflow for email.

• Microsoft OneDrive  as workflow destination: [ Yes | No ]
• You must have the global administrator role in Microsoft Entra ID to grant access to Microsoft 

OneDrive.
• You must use Microsoft Entra groups if you have any users whose email addresses are 

different from their User Principal Names (UPNs).
• How to create a workflow for Microsoft OneDrive.

• Microsoft SharePoint Online  as workflow destination: [ Yes | No ]
• You must have the global administrator role in Microsoft Entra ID to grant access to Microsoft 

SharePoint Online.
• How to create a workflow for Microsoft SharePoint Online.

• Connector  as workflow destination: [ Yes | No ]
• How to create a workflow for Connector.

To whom should workflows be available?
• Want to make workflow available to selected groups: [ Yes | No ]

• You must have the global administrator role in Microsoft Entra ID to enable Microsoft Entra 
groups.

• You must have a Google Workspace administrator account to enable Google groups.
• How to make a workflow available to selected groups.

• If no group is selected, the activated workflow becomes available to all users.
• Workflows that are not active can only be used by you as an administrator.

How to get started with Capture Connector API
The Printix Capture Connector API allows integration of third-party systems with Printix Capture by 
delegating the responsibility of document processing and delivery to custom systems.

For this, the Connector destination profile has been introduced. Using this, Printix can send an 
HTTP request to notify a custom service that new document should be processed and delivered. 
This notification contains information about the file to process.

The following figure shows how Printix and the connector communicate with each other to deliver 
documents to custom systems.
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When a connector destination profile is assigned to a capture workflow, Printix first generates the 
output document with the desired file format (such as pdf or docx), then uploads this new file to 
the configured Azure Blob Storage and sends an HTTP POST notification to the connector indicating 
that a new file needs to be processed.

At this point, the connector must respond to Printix with an HTTP 2xx status code if it is willing to 
process the file delivery job. If the connector returns this status code, Printix acknowledges that 
the connector took over the file delivery job and waits for a callback request of the file delivery (see
FileDeliveryJobReady event).

In the meantime, the connector can optionally query capture workflow metadata from Printix (see
Querying metadata).

After the processing is completed, the connector must send a callback request to Printix (see
Callback after processing). In this request, the connector can indicate whether the processing 
was completed successfully or with errors. Based on this callback, Printix can release all resources 
related to the file delivery. If the connector does not send the callback request, Printix automatically 
closes the capture workflow with Timeout error and releases the resources associated with the file 
delivery job. The timeout period can be configured for the capture workflows which have assigned 
connector destination profile. The timeout value is 10 minutes by default and can be increased up to 
two hours.

Connector prerequisites
Two-way communication happens between Printix and the connector through HTTPS/HTTP.

Because of this, the connector must be hosted on a web server so that it can receive notification 
requests from Printix. The actual URL where the notification requests are sent can be configured in 
the Printix Administrator through the Connector URL parameter of connector destination profiles.
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If the connector hosting web server is publicly available, Printix can send this notification request 
without any problems.

However, if the web server is available only in a specific private network, further configuration 
needs to be made:
• At least one computer that is connected to the private network must run the Printix Client 

desktop application. This functions as a gateway between the Printix Cloud and the connector 
hosted on the private network.

• Additionally, the proper network must be selected for the connector destination profile in Printix 
Administrator.

To ensure the authenticity of incoming requests, the Connector API relies on shared secret key 
based HMAC signatures. For this to work, both Printix and the connectors must implement the 
same signature calculation algorithm. Currently, two algorithms are supported: HMAC-SHA256 and 
HMAC-SHA512. The actual algorithm used for the signature calculation depends on the Signature 
Algorithm setting of the related destination connector profile. Connectors need to implement only 
one of the supported signature calculation algorithms.

The shared secret keys - required by the HMAC algorithms - can be generated as part of the 
connector destination profile configuration. The generated secrets must be copied to the 
connector's configuration by an administrator.

The connector's developer and administrators must ensure that the shared secret keys are always 
kept secure.

Signature calculation and verification
An HTTP message is considered signed if it contains ALL the following custom HTTP headers:
• X-Printix-Request-Id
• X-Printix-Timestamp
• X-Printix-Signature

When a request arrives to the connector, the X-Printix-Signature custom HTTP header contains the 
signature. This signature value is calculated using the previously exchanged shared secret key and 
some details of the HTTP request. If the signature calculated by the connector for the incoming 
HTTP request matches with the signature that is received in the X-Printix-Signature header, the 
request is considered valid, and must be processed. Otherwise, the HTTP request is invalid, and the 
connector must not process it.

Signatures are calculated from the following input:

• SecretKey: This is a Base-64 encoded random byte array. For the HMAC-SHA256 algorithm, 
the array contains 32 bytes (256 bit). For the HMAC-SHA512 algorithm, the array contains 64 
bytes (512 bit). The connector must use the same Base-64 encoded value that is specified for the 
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connector destination profile in Printix Administrator. The secret key value must be managed and 
stored securely, should not be written to the log without redacting.

• Request ID: The request sender must generate a new UUID for every request. This can be used 
for logging and to find the related activity on both the connector and the Printix side.

• Timestamp: The request sender must get the current time in Unix Epoch format. This value 
represents the number of seconds passed since January 1st, 1970, at 00:00:00 UTC.

• The HTTP method verb and the request URI path without the host name, port, and schema.

• The full request body.

In case of the HMAC SHA256 algorithm, the signature can be calculated like this:
StringToSign = RequestId + "." + Timestamp + "." + Method + "." + RequestPath + "." + 
 RequestBody
Signature = Base64 ( HMAC-SHA256( SecretKey, UTF-8-Encoding-Of( StringToSign ) ) )

In case of the HMAC SHA512 algorithm, the signature can be calculated like this:
StringToSign = RequestId + "." + Timestamp + "." + Method + "." + RequestPath + "." + 
 RequestBody
Signature = Base64 ( HMAC-SHA512( SecretKey, UTF-8-Encoding-Of( StringToSign ) ) )

• RequestId is the value of the X-Printix-Request-Id HTTP header.
Example: b09a9408-90fd-4eb0-b7d8-e88f3ec53e73

• Timestamp is the value of the X-Printix-Timestamp HTTP header.
Example: 1700257249

• Method is the lowercase HTTP verb of the request.
Example: post

• RequestPath is the path and query parameters of the request URI. To get this value, the request 
schema (https), the hostname, and the port must be removed from the request URI.
Example: If the request URI is https://host.domain.com:5001/networkshare?profile=a&options=1, 
the related RequestPath value is this:
/networkshare?profile=a&options=1

• RequestBody is the raw request body as string.
• SecretKey is the shared secret key copied from Printix Administrator and stored in the 

connector's configuration securely.

Request senders must:
• Set the X-Printix-Request-Id header to the generated RequestId value that was used during the 

signature calculation.
• Set the X-Printix- Timestamp header to the Timestamp value that was used during the signature 

calculation.
• Set the X-Printix-Signature header from the calculated Signature.

Request verifiers must:
• Calculate the signature using the above-described algorithm.
• If the calculated signature matches with the value received in the X-Printix-Signature header, the 

message can be considered valid.
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• Otherwise, the message must be rejected.

 On some platforms, querying the URI of the currently received request is not possible. To 
allow integration with such platforms, Printix additionally sends the RequestPath value used 
for signature calculation in the X-Printix-Request-Path header. Using the value of this header 
for signature calculation should be avoided if the current request URI can be queried from the 
connector hosting platform.

When the connector sends a request to Printix, it must not add the X-Printix-Request-Path header 
in the request. This header is sent only by Printix for connectors that have no access to the current 
request URI.

Example for HMAC-SHA256
Input

Parameter Value

Secret PMB3y4so+7XCXC4CavP+WjUhBAjQl
+f5T2o4Ma1vRc4=

RequestId 0c442a21-4cc9-4516-90a1-c94218111db9

Timestamp 1707229621

Method POST

RequestPath /destination-connector/tenants/ef3aa41d-
ab85-44e6-bf83-fbfbb527a0bb/fileDeliveries/
c23e3a87-6897-468f-82b7-88fef0a07e5e/finish-
dispatch

RequestBody {}

StringToSign 0c442a21-4cc9-4516-90a1-
c94218111db9.1707229621.post./
destination-connector/tenants/ef3aa41d-
ab85-44e6-bf83-fbfbb527a0bb/fileDeliveries/
c23e3a87-6897-468f-82b7-88fef0a07e5e/finish-
dispatch.{}

Result

Header name Value

X-Printix-Request-ID 0c442a21-4cc9-4516-90a1-c94218111db9

X-Printix-Timestamp 1707229621

X-Printix-Signature 52dY
+cmDL2qEcRwbEK96oOVxPfs6dnym5Zq3+8OAOkA=
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Example for HMAC-SHA512
Input

Parameter Value

Secret ulZYM3hEopynzCPrNBkCsHTPC116+dRaL+6QczTzam/
UNX8Ojd8Sk0E/BtcyartTvft7FFMCK11Rf5Q0Q99sng==

RequestId 13044d14-6eb2-4d74-80ce-451faef78708

Timestamp 1707229979

Method POST

RequestPath /destination-connector/tenants/ef3aa41d-
ab85-44e6-bf83-fbfbb527a0bb/fileDeliveries/
c23e3a87-6897-468f-82b7-88fef0a07e5e/finish-
dispatch

RequestBody {“errorMessage”:“File delivery error occurred.”}

StringToSign 13044d14-6eb2-4d74-80ce-451faef78708.1707229979.post./
destination-connector/tenants/ef3aa41d-
ab85-44e6-bf83-fbfbb527a0bb/fileDeliveries/
c23e3a87-6897-468f-82b7-88fef0a07e5e/finish-
dispatch.{“errorMessage”:“File delivery error 
occurred.”}

Result

Header name Value

X-Printix-Request-ID 13044d14-6eb2-4d74-80ce-451faef78708

X-Printix-Timestamp 1707229979

X-Printix-Signature WofSX0Urk9×7KQVHdIsqCog6xojS
+aOQ4QgTaaqZCUsqFXZJdfy0SFXyti6bAjUdDHLnWhESlC1/
D7zMX+1pfw==

Zero-downtime key rotation
Shared secret keys can ensure the authenticity of HTTP requests. However, to keep this mechanism 
secure in the longer term, it is recommended to periodically replace the secret keys with new ones.

Ideally, the secret key change should be performed on both the Printix and the connector side at 
the same time. However, this task cannot be achieved simultaneously resulting in some system 
downtime. In this downtime period, the connector and Printix cannot communicate with each other, 
causing processing failure for the active FileDeliveryJobs.

In some systems, this downtime period may not be acceptable. Therefore, Printix supports a 
mechanism for zero-downtime key rotation. However, to take advantage of this feature, the 
connector must support this as well.
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To support zero-downtime key rotation, both Printix and the connector must allow defining multiple 
secret keys for the connector profile. In this case, the sender must calculate the request's signature 
using ALL secret keys and then place the comma separated list of calculated signatures to the X-
Printix-Signature header. After this, the recipient must also calculate signatures for the incoming 
request using ALL configured secret keys. After this, the request should be considered valid if any 
of the calculated signatures is present in the list of signatures received in the X-Printix-Signature 
header.

To allow zero-downtime key rotation, the following steps must be performed:

1. Modify the connector destination profile in Printix Administrator and add a new secret key to 
the profile.

2. Copy this new secret to the connector's configuration as well. Make sure that the old secret key 
is not yet removed.

3. Remove the old secret key from the connector destination profile.

4. Remove the old secret key from the connector's configuration.

To support zero-downtime key rotation:
• The connector should be able to store multiple secret keys in its configuration.
• The connector should always calculate the signatures using all secret keys. The calculated secret 

keys must be concatenated using comma characters and this comma-separated list of signatures 
should be set to the X-Printix-Signature header as usual.

• The signature verification must be modified a bit. The message should be considered valid if ANY 
of the comma-separated signatures received in the X-Printix-Signature header matches ANY of 
the calculated signatures.

What makes this algorithm functional is that at the time when the old secret key is removed from 
one side, both parties already have the new shared secret key that they can use for communication. 
So, from this point on, the old secret key can be removed from the other side as well.

 Due to some limitations, Printix does not support changing destination profiles, so the list of 
secret keys cannot be modified. This might change with a coming update.

FileDeliveryJobReady event
After Printix generated a new document from the scanned pages, it notifies the connector that 
a new document is ready to be processed. For this, an HTTP POST request is sent to the URL 
configured for the connector destination profile.

In the request body of this HTTP POST request, Printix sends the following JSON object:
{ 
   "eventType": "string", 
   "jobId": "string", 
   "fileName": "string", 
   "callbackUrl": "string", 
   "documentUrl": "string", 
   "metadataUrl": "string"
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}

• eventType: This indicates the type of event about which Printix sent the notification. For now, this 
will always be FileDeliveryJobReady. However, in the future, Printix may send notifications about 
other events as well, that is why this property has been introduced.

• jobId: An UUID representing the unique identifier of the file delivery job. This can be useful for 
logging.

• filename: The name of the file to be created at the connector's target including its extension.

 If a file with this name already exists at the target, it is the connector's responsibility to 
manage this file name collision.

• callbackUrl: The URL where the connector should send an HTTP POST request once the 
processing of the FileDeliveryJob is done. For more details, see Callback after processing.

• documentUrl: The URL from where the connector can download the binaries of the file to deliver. 
Currently, this is an Azure Blob Storage SAS token URL.

• metadataUrl: The URL from where the connector can query metadata for the job. For more 
details, see Querying metadata.

When the connector receives this notification from Printix, first, it needs to verify if the request's 
signature is valid. If the signature is invalid, an HTTP 401 (Unauthorized) response must be sent, 
and the job must be rejected. If the signature was correct, the connector can still decide based on 
custom business logic whether it accepts or rejects the job.

If the job is accepted, an HTTP 2xx response should be sent, and the job should be added to the 
connector's internal processing queue for later processing. This is needed because the actual 
processing can take several minutes but Printix expects the response for the notification message 
to arrive in a few seconds. If the job is rejected, an HTTP 4xx or 5xx error status code should be sent 
with some details about the reason for the rejection in the response body.

Example

Request:
POST /networkshare/123e4567-e89b-42d3-a456-556642440000 HTTP/1.1
Host: connector.domain.com:5000
X-Printix-Request-Id: 18d7611c-1323-4197-9de4-7a599153d228
X-Printix-Timestamp: 1704289680
X-Printix-Signature: CU/U2Z0Ml+QjU7gQBn5NS8qszhJuH5PBhYjs4zEBThs=
Content-Type: application/json
Content-Length: 927
{ 
  "eventType": "FileDeliveryJobReady", 
  "jobId": "3db15c16-9165-4e86-bf00-daafadad05f8", 
  "fileName": "Test Document.pdf", 
  "callbackUrl": "https://api.printix.net/destination-connector/tenants/762c733c-
ff00-49aa-b350-50b59cae9366/fileDeliveries/3db15c16-9165-4e86-bf00-daafadad05f8/finish-
dispatch", 
  "documentUrl": "https://
ptx.blob.core.windows.net/00000000-0000-0000-0000-000000000000/scans/f8071deb-
ef5e-4c18-94ea-ced453e6dc76/activities/7f1191d2-c59e-408d-ae0e-8a2ce4e97fea/
ff17bdf9-4fbc-4eb6-86b9-455315143250?sig=a3bn77r0rqpHhneKhM%2BszZ7DP6ivbbl6dlQCkuZxi3Y
%3D&st=2024-02-02T13%3A10%3A04Z&se=2024-02-02T14%3A25%3A04Z&sv=2019-02-02&rscd=attachment
%3B%20filename%3D%22Test%20Document-2024-02-02.pdf%22&sp=r&sr=b",     

793



Tungsten Printix Administrator Guide

  "metadataUrl": "https://api.printix.net/destination-connector/tenants/762c733c-
ff00-49aa-b350-50b59cae9366/fileDeliveries/3db15c16-9165-4e86-bf00-daafadad05f8/
metadata?query="
}

Response:
HTTP/1.1 200 OK  
Content-Length: 0

Querying metadata
Connectors can optionally query metadata related to the capture workflow of the file delivery 
job. For this, an HTTP GET request should be sent to the "metadataUrl" received in the request 
body of FileDeliveryJobEvent. The comma-separated list of requested metadata names must be 
added to the end of the string received in the "metadataUrl" property. This request must have 
valid signatures, including the X-Printix-Request-Id, X-Printix-Timestamp, and X-Printix-Signature 
headers.

The list of available metadata names:
• deviceId: This refers to the 3-letter unique identifier of the device.
• deviceLocation: The name of the location where the device is.
• deviceModelName: The full name of the device model.
• username: The display name of the user who logged in at the device.
• userEmail: The email address of the user who logged in at the device.
• workflowName: The display name of the capture workflow to which the file delivery job belongs 

to.
• workflowStartTime: The capture workflow's start date and time in UTC. The value is formatted 

according to ISO 8601.

Example

Request:
GET /destination-connector/tenants/762c733c-ff00-49aa-b350-50b59cae9366/
fileDeliveries/3db15c16-9165-4e86-bf00-daafadad05f8/metadata?
query=deviceId,deviceLocation,deviceModelName,userName,userEmail,workflowName,workflowStartTime 
 HTTP/1.1
Host: api.printix.net
X-Printix-Timestamp: 1707203941
X-Printix-Request-Id: 79889b6e-0a94-4e3d-8582-003ed1ecf1b3
X-Printix-Signature: 2fRd5QgSDzznJ1MAsK99jhiPpzQPE2/nSVs9Oe7dAl4=

Response:
{ 
    "metadata": [ 
        { 
            "name": "deviceId", 
            "value": "ASD" 
        }, 
        { 
            "name": "deviceLocation", 
            "value": "New York Office" 
        }, 
        { 
            "name": "deviceModelName", 
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            "value": "HP Color LaserJet MFP E87740" 
        }, 
        { 
            "name": "userEmail", 
            "value": "john.doe@company.com" 
        }, 
        { 
            "name": "userName", 
            "value": "John Doe" 
        }, 
        { 
            "name": "workflowName", 
            "value": "Send to Connector" 
        }, 
        { 
            "name": "workflowStartTime", 
            "value": "2023-12-15T16:10:02.818Z" 
        } 
    ]
}

Callback after processing
The actual processing of the FileDeliveryJob can mean anything from simply storing the file in an 
external system or even performing per page image processing, OCR, form recognition, and so on.

After the processing is done, the connector MUST send an HTTP POST request to the "callbackUrl" 
received in the request body of FileDeliveryJobReady event. This request must have valid signatures 
including the X-Printix-Request-Id, X-Printix-Timestamp, and X-Printix-Signature headers.

Additionally, connectors must send a JSON object in the request body with the following structure:
{ 
  "errorMessage": "string"
}

• errorMessage: A message that describes details about the error in case of failed processing. If 
this property is null, empty string or not present in the JSON, Printix assumes that the processing 
has been completed successfully.

 The maximum length of the error message is 1000 characters.

Example

Request:
POST /destination-connector/tenants/762c733c-ff00-49aa-b350-50b59cae9366/
fileDeliveries/3db15c16-9165-4e86-bf00-daafadad05f8/finish-dispatch HTTP/1.1
Host: api.printix.net
X-Printix-Request-Id: b6e140de-99b0-4c29-8e17-68d6d15a0601
X-Printix-Timestamp: 1707147441
X-Printix-Signature: b373/37u+UWrW47VVCpYcRWnzzUIIn/sbquiMWGyUHc=
Content-Type: application/json
Content-Length: 28
{ 
  "errorMessage": null
}

Response:
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HTTP/1.1 200 OK
X-Printix-Request-ID: b6035c41-928e-4a74-be94-732f88d1a623
Content-Length: 0

How to create a workflow for email
1. Select Menu    > Settings  .
2. Select the Capture workflows  tab.
3. Select Create workflow.
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4. In the Settings section:
• In Workflow name, enter the name of the workflow.
• In Active, leave this cleared for now.
• Leave All users can use this workflow selected for now.
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• When you have verified that the workflow works as expected, you can:
• Activate the workflow
• Make the workflow available to selected groups.

5. In the Source section:
• Select Printer for scanning of pages on printers with Printix Go and Printix Capture.

• Make your selection for the printer scan settings: Orientation, Paper size, Color,
Resolution, and 2-sided.

• Select Mobile for a phone or tablet with the Printix App version 3.0.1 or higher installed.
6. In the Destination section:

• Leave Destination profiles on Email.
• In Send to user email, leave it on To if the user is to receive the email, as represented by the

variable {user_email}. Select CC or BCC if you would rather have the user be on copy or blind 
copy.

• In To, there must be at least one email recipient. Use comma to separate multiple remail 
recipients.

• Optionally, select CC. Leave it empty or enter one or more email recipients.
• Optionally, select BCC. Leave it empty or enter one or more email recipients.
• In Subject, enter an optional subject. It is possible to select and paste variables, such as 

{workflow_name}.
• In File name, enter the file name. It is possible to select and paste variables, such as 

{workflow_name}.
• Date and time are in UTC (Coordinated Universal Time).
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 To make sure that people outside your organization do not receive unwanted emails, 
email recipients must either be registered users in your Printix Home, or have an enabled 
authentication method (such as Microsoft Entra ID, Google, OIDC) and an email address with 
the domain of your organization (such as @acme.com). Self-registered users do not count as 
having an enabled authentication method.
If the same email recipient is listed multiple times, the user receives multiple emails.

7. In the File type section:
• Select PDF to output document in PDF format.

• In Image quality, select an image quality.
• In PDF compatibility, select a PDF compatibility.
• In Language for OCR use, select Select language, then select the languages for OCR use.

• Select Word to output document in DOCX format.
• In Image quality, select an image quality.
• In Language for OCR use, select one or more languages.

8. In the Image processing section:
If Source is Mobile, image processing is controlled on the mobile.
• In Delete blank pages, optionally, select this to have blank pages deleted.
• In Rotation, select a rotation. The rotation is performed before any OCR.
• In Deskew, optionally, select this to have captured images deskewed automatically.
• In Crop, optionally, to have captured images cropped automatically.

9. Select Create.
10. Verify that the workflow works as expected.
11. Activate the workflow.
12. Optionally, make the workflow available to selected groups.

How to create a workflow for Microsoft OneDrive
1. Select Menu    > Settings  .
2. Select the Capture workflows  tab.
3. Select Create workflow.
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4. In the Settings section:
• In Workflow name, enter the name of the workflow.
• In Active, leave this cleared for now.
• Leave All users can use this workflow selected for now.
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• When you have verified that the workflow works as expected, you can:
• Activate the workflow
• Make the workflow available to selected groups.

5. In the Source section:
• Select Printer for scanning of pages on printers with Printix Go and Printix Capture.

• Make your selection for the printer scan settings: Orientation, Paper size, Color,
Resolution, and 2-sided.

• Select Mobile for a phone or tablet with the Printix App version 3.0.1 or higher installed.
6. In the Destination section:

• In Destination profiles, select Microsoft OneDrive.
• In Select destination profile, select among existing OneDrive destination profiles.
• Select Create destination profile to create a new destination profile.

• How to create a destination profile for Microsoft OneDrive
• How to grant access to Microsoft OneDrive
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• In Folder, enter an optional folder. It is possible to select and paste variables, such as 
{workflow_name}.
Root is the user's My files in OneDrive.

• In File name, enter the file name. It is possible to select and paste variables, such as 
{workflow_name}.
• Date and time are in UTC (Coordinated Universal Time).

7. In the File type section:
• Select PDF to output document in PDF format.

• In Image quality, select the image quality.
• In PDF compatibility, select the PDF compatibility.
• In Language for OCR use, select Select language, then select the languages for OCR use.

• Select Word to output document in DOCX format.
• In Image quality, select the image quality.
• In Language for OCR use, select one or more languages.

8. In the Image processing section:
If Source is Mobile, image processing is controlled on the mobile.
• In Delete blank pages, optionally, select this to have blank pages deleted.
• In Rotation, select a rotation. The rotation is performed before any OCR.
• In Deskew, optionally, select this to have captured images deskewed automatically.
• In Crop, optionally, to have captured images cropped automatically.

9. Select Create.
10. Verify that the workflow works as expected.
11. Activate the workflow.
12. Optionally, make the workflow available to selected groups.
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How to create a destination profile for Microsoft OneDrive
1. Select Create destination profile.
2. Select Destination.

If only one is available, it is selected automatically. Otherwise, select one.
3. Select Sign in method (a Microsoft Entra directory configured on the Authentication page).

If only one is available, it is selected automatically. Otherwise, select one.
4. Grant access to the selected destination by selecting Grant access to Microsoft OneDrive.
5. On the Microsoft sign-in page:

• Enter your administrator account.
You must have the global administrator role in Microsoft Entra ID to grant access to 
Microsoft OneDrive.

• Enter Password.
6. Select Sign in.
7. Printix will ask you for permission to:

• Sign in and read user profile.
• Read and write files in all site collections.

8. Select Accept.
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9. Fill in the form.
• In Name, enter a name for the destination profile.

 The destination profile must be named differently than any existing Microsoft OneDrive 
destination profile.
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10. Select Create.


• A Microsoft OneDrive destination profile can be used only with users from the same 

Microsoft Entra directory that was selected in Step 1 when configuring the destination 
profile. Otherwise, the capture workflow configured with a OneDrive destination profile will 
fail.

• If you do NOT use Microsoft Entra groups, the User Principal Name MUST be the same as 
the user's email address. Otherwise, the capture workflow configured with a OneDrive 
destination profile will fail.

How to create a workflow for Microsoft SharePoint Online
1. Select Menu    > Settings  .
2. Select the Capture workflows  tab.
3. Select Create workflow.
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4. In the Settings section:
• In Workflow name, enter the name of the workflow.
• In Active, leave this cleared for now.
• Leave All users can use this workflow selected for now.
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• When you have verified that the workflow works as expected, you can:
• Activate the workflow.
• Make the workflow available to selected groups.

5. In the Source section:
• Select Printer for scanning of pages on printers with Printix Go and Printix Capture.

• Make your selection for the printer scan settings: Orientation, Paper size, Color,
Resolution, and 2-sided.

• Select Mobile for a phone or tablet with the Printix App version 3.0.1 or higher installed.
6. In the Destination section:

• In Destination profiles, select Microsoft SharePoint Online.
• In Select destination profile, select among existing SharePoint Online destination profiles.
• Select Create destination profile to create a new destination profile.

• How to create a workflow for Microsoft SharePoint Online
• How to grant access to Microsoft SharePoint Online
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• In Folder, enter an optional folder. It is possible to select and paste variables, such as 
{workflow_name}.
Folder will be created as a subfolder to the Folder defined in the Destination profile.

• In File name, enter a file name. It is possible to select and paste variables, such as 
{workflow_name}.
• Date and time are in UTC (Coordinated Universal Time).

7. In the File type section:
• Select PDF to output document in PDF format.

• In Image quality, select the image quality.
• In PDF compatibility, select the PDF compatibility.
• In Language for OCR use, select Select language, then select the languages for OCR use.

• Select Word to output document in DOCX format.
• In Image quality, select the image quality.
• In Language for OCR use, select one or more languages.

8. In the Image processing section:
If Source is Mobile, image processing is controlled on the mobile.
• In Delete blank pages, optionally, select this to have blank pages deleted.
• In Rotation, select the rotation. The rotation is performed before any OCR.
• In Deskew, optionally, select this to have captured images deskewed automatically.
• In Crop, optionally, to have captured images cropped automatically.

9. Select Create.
10. Verify that the workflow works as expected.
11. Activate the workflow.
12. Optionally, make the workflow available to selected groups.
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How to create a destination profile for Microsoft SharePoint Online
1. Select Create destination profile.
2. Select Destination.

If only one is available, it is selected automatically. Otherwise, select one.
3. Select Sign in method (a Microsoft Entra directory configured on the Authentication page).

If only one is available, it is selected automatically. Otherwise, select one.
4. Grant access to the selected destination by selecting Grant access to Microsoft SharePoint 

Online.
5. On the Microsoft sign-in page:

• Enter your administrator account.
You must have the global administrator role in Microsoft Entra ID to grant access to 
Microsoft SharePoint Online.

• Enter Password.
6. Select Sign in.
7. Printix will ask you for permission to:

• Sign in and read user profile.
• Read and write items in all site collections.

8. Select Accept.
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9. Fill in the form.
• In Name, enter a name for the destination profile.
• In Site, select site.
• In Document library, select document library.
• In Folder, select folder. There might not be any folders. Folders can also be specified when 

you create a workflow for SharePoint.

 The destination profile must be named differently than any existing Microsoft SharePoint 
Online destination profile.
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10. Select Create.

How to create a workflow for Connector
1. Select Menu  > Settings .
2. Select the Capture workflows  tab.
3. Select Create workflow.
4. In the Settings section:

• In Workflow name, enter the name of the workflow.
• In Active, leave this unchecked for now.
• Leave All users can use this workflow checked for now.
• When you have verified that the workflow works as expected, you can:

• Activate the workflow.
• Make the workflow available to selected groups.
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5. In the Source section:
• Select Printer to scan pages with a printer using Printix Go and Printix Capture.

• Make your selection for the printer scan settings: Orientation, Paper size, Color,
Resolution, and 2-sided.

• Select Mobile to scan pages with a phone or tablet using Printix App version 3.0.1 or higher 
on Android or iOS/iPadOS.

6. In the Destination section:

• In Destination profiles, select Connector.
• In Select destination profile, select among existing connector destination profiles.
• Select Create destination profile to create a new destination profile.

• How to create a destination profile for Connector

• In File name, enter the file name.
It is possible to select and paste variables, such as {workflow_name}.
• Date and time are in UTC (Coordinated Universal Time).
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• In Timeout (in minutes), specify the maximum amount of time a workflow can wait for the 
connector to process the capture job and notify Printix of the result before it is automatically 
closed with a failed state. Must be between 10 and 120 minutes (2 hours). The default is 10 
minutes.
This setting is useful to prevent a workflow from indefinitely waiting for a response.

7. In the File type section:
• Select PDF to generate the output document in PDF format.

• In Image quality, select the image quality.
• In PDF compatibility, select the PDF compatibility.
• In Language for OCR use, select Select language, then select the languages for OCR use.

• Select Word to generate the output document in DOCX format.
• In Image quality, select the image quality.
• In Language for OCR use, select one or more languages.

8. In the Image processing section:
If Source is Mobile, the image processing is controlled on your phone or tablet.
• Optionally, select Delete blank pages to have blank pages deleted.
• In Rotation, select the rotation. The rotation is performed before any OCR.
• Optionally, select Deskew to have captured images deskewed automatically.
• Optionally, select Crop to have captured images cropped automatically.

9. Select Create.
The workflow is created.

10. Verify that the workflow works as expected.
11. Activate the workflow.
12. Optionally, make the workflow available to selected groups.

How to create a destination profile for Connector
1. Select Create destination profile.
2. Select Connector as the destination.

If only one destination is available, it is selected automatically.
3. Fill in the form.

• In Name, enter a name for the destination profile.

 The destination profile must be named differently than any existing connector 
destination profile.

• In Connector URL, enter the URL of the connector to which Printix has to send the 
notification of the new documents for the connector to process and deliver them when the 
workflow selected by the user on the device is configured with this destination profile.

• In Network, optionally, select the Modify  icon, then select a network where the 
connector is hosted. Leave it blank if the connector is hosted on a public URL.

• In Signature algorithm, select the signature algorithm the connector supports for 
communication with Printix.
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• In Shared secrets, select Create secret, then select the green check mark to create a new 
shared secret.
If you want to use a shared secret that was previously copied from a destination profile of a 
different connector, select Create secret, replace the generated value by pasting the copied 
value from clipboard, then select the green check mark.

4. Copy the shared secret value.
The shared secret value is used again later at the connector side.

 You can only copy the shared secret at this point. After you leave this page, you are not 
able to retrieve it. If you leave this page without copying the shared secret, you must repeat 
the corresponding steps above and create a new connector destination and shared secret.

5. Select Create.

How to activate a workflow
1. Select Menu    > Settings  .
2. Select the Capture workflows  tab.
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3. Select the Workflow name to open the Workflow properties page.
4. Select Active.
5. Select Save.

Workflows that are not active can only be used by you as an administrator:
• You can select the workflow in  Printix Capture .

How to make a workflow available to selected groups
1. Select Menu    > Settings  .
2. Select the Capture workflows  tab.
3. Select the Workflow name to open the Workflow properties page.
4. Select Selected groups can use this workflow.
5. Select Add group to open the Select groups dialog box.

• Select Search . The search is not case-sensitive.
• Select the groups.

6. Select Select.
• Select X to remove a group.

7. Select Save.
Workflows are visible to users in the groups and you as an administrator.

How to grant access to Microsoft OneDrive
You must have the global administrator role in Microsoft Entra ID to grant access to Microsoft 
OneDrive.

1. On the Authentication  page, select the Microsoft Entra ID tab.
2. For Grant access to OneDrive, select Accept.
3. On the Microsoft sign-in page:

• Enter your administrator account. You must have the global administrator role in Microsoft 
Entra ID to grant access to Microsoft OneDrive.

• Enter Password.
4. Select Sign in.
5. Printix will ask you for permission to:

• Sign in and read user profile.
• Read and write files in all site collections.

6. Select Accept.
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How to grant access to Microsoft SharePoint Online
You must have the global administrator role in Microsoft Entra ID to grant access to Microsoft 
SharePoint Online.

1. On the Authentication  page, select the Microsoft Entra ID tab.
2. For Grant access to SharePoint, select Accept.
3. On the Microsoft sign-in page:

• Enter your administrator account. You must have the global administrator role in Microsoft 
Entra ID to grant access to Microsoft SharePoint Online.

• Enter Password.
4. Select Sign in.
5. Printix will ask you for permission to:

• Sign in and read user profile.
• Read and write items in all site collections.

6. Select Accept.

How to add Azure Blob Storage
Enable storage of pending documents in your secure cloud storage. That way, the user's computer 
does not need to be online to release Print Later and Print Anywhere documents. However, a Printix 
Client still needs to be online on the printer's network to release the documents.

816



Tungsten Printix Administrator Guide

Create storage account
1. Open a new browser window and sign in to Microsoft Azure (portal.azure.com) using your 

work account credentials.
2. In the portal menu, select All Services.
3. In the Storage category, select Storage accounts.
4. Select Create.
5. On the Basics tab:

• In the Project details section:
• In Subscription, select the type of subscription.
• In Resource group, select a resource group or select Create new.

• In the Instance details section:
• In Storage account name, enter the name of the storage account.

Example: printixcloudstorage
• In Region, select the data center closest to you.

Example: (US) East US
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• In Performance, leave it at Standard (default).
• In Redundancy, select Locally-redudant storage (LRS) to get the lowest-cost option.

6. Select the Advanced tab or select Next: Advanced.
7. On the Advanced tab:

• In the Security section:
• Leave Require secure transfer for REST API operations selected.
• Clear Allow enabling anonymous access on individual containers.
• Leave Enable storage account key access selected.
• Leave Default to Azure Active Directory authorization in the Azure portal cleared.
• In Minimum TLS version, leave it on Version 1.2.
• In Permitted scope for copy operations, select the scope or leave it on the default From 

any storage account.
• In the Hierarchical Namespace section:

• Leave Enable hierarchical namespace cleared.
• In the Access protocols section:

• Leave Enable SFTP cleared.
• Leave Enable network file system v3 cleared.

• In the Blob storage section:
• Leave Allow cross-tenant replication cleared.
• In Access tier, select Hot.

• In the Azure Files section:
• Leave Enable large file shares cleared.

8. Select the Networking tab or select Next: Networking.
9. On the Networking tab:

• In the Network connectivity section:
• In Network access, select Enable public access from all networks or Enable public 

access from selected virtual networks and IP addresses. Both the Printix Cloud and 
computers with Printix Client (even when on a public network) must be allowed to access 
the blob storage.

• In the Network routing section:
• In Routing preference, select Microsoft network routing.

10. Select the Data protection tab or select Next: Data protection.
11. On the Data protection tab:

• In the Recovery section:
• Leave Enable point-in-time restore for containers cleared.
• Clear Enable soft delete for blobs.
• Clear Enable soft delete for containers.
• Clear Enable soft delete for file shares.

• In the Tracking section:
• Leave Enable versioning for blobs cleared.
• Leave Enable blob change feed cleared.

818



Tungsten Printix Administrator Guide

• In the Access control section:
• Leave Enable version-level immutability support cleared.

12. Select the Encryption tab or select Next: Encryption.
13. On the Encryption tab:

• In Encryption type, select Microsoft-managed keys (MMK).
• In Enable support for customer-managed keys, leave the selection on All service types 

(blobs, files, tables, and queues).
• Leave Enable infrastructure encryption cleared.

14. Select the Tags tab or select Next: Tags.
15. On the Tags tab:

• Optionally, create tags for the resource.
16. Select the Review tab or select Next: Review.
17. On the Review tab:

• Review the settings.
18. Select Create.

It may take a couple of minutes to create the account.

Configure access to cloud storage
If you selected Enable public access from selected virtual networks and IP addresses  in step 9 of 
creating the storage account, perform the following steps to configure Printix to access your cloud 
storage.

1. In the Microsoft Azure portal menu, select All Services.
2. In the Storage category, select Storage accounts.
3. Select the storage account you created.

Example:  printixcloudstorage
4. In the Firewall section, in Address range:

• Enter the following IP addresses according to your data center where your Printix Home 
resides:
• EU Data Center:

• 51.124.91.26
• 52.142.203.47
• 52.142.207.220

• Enter the static outbound IP of those networks where Printix Client, Printix App for iOS/
iPadOS, Printix App for Android, and Printix Chromebook reside.
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 When a user prints or runs a capture workflow (using the Printix Client, the Printix App, 
or Printix Chromebook) from an unknown network (at home or while traveling), and if
documents go via the user's own cloud storage:
• The user must connect via VPN to the Corporate network, and the own cloud storage 

must be reached via this VPN connection.
• The static outbound IP of this network must be allowed on the firewall of the own cloud 

storage.

Otherwise, the printing or the capture workflow fails.

5. Select Save to save your modifications.

Get the key
1. In the Microsoft Azure portal menu, select All Services.
2. In the Storage category, select Storage accounts.
3. Select the storage account you created.

Example:  printixcloudstorage
4. On the left pane, select Access keys to see the access keys for the selected storage account.

You can use the search bar to quickly find this option.
5. Select Show next to the Key value of key1, then select Copy to clipboard.

You need to paste this value in step 6 when adding the Azure Blob Storage.
6. In Endpoint suffix, specify the storage account endpoint suffix or leave it blank if you use the 

default core.windows.net value.

Add Azure Blob Storage
1. Select Menu    > Settings  .
2. Select the Cloud storage  tab.
3. Select Add cloud storage.
4. Select Azure Blob Storage.
5. In Name, enter the storage account name you entered in step 5 of creating the storage 

account.
Example:  printixcloudstorage

6. In Key, paste the key1 value you copied in step 5 of getting the key.
7. Select Add cloud storage.
8. Optionally, check the type of pending documents you want to store.

 If you use a web proxy and/or SSL inspection, you must unblock the URL referencing the 
storage account:
https://{storage_account_name}.blob.{endpoint suffix}
Example: https://printixcloudstorage.blob.core.windows.net

820



Tungsten Printix Administrator Guide

See also:
• Which documents go via the cloud?

Permissions needed to access Azure Blob Storage
Printix uses access keys for Azure Blob Storage to generate Shared Access Signatures (SAS) signed 
read, write, and delete links for the Azure Blob Storage. At regular intervals, Printix Cloud uploads a 
4-byte file to test connection to the Azure Blob Storage (links for write, read, delete). If the test fails, 
it is displayed in Printix Administrator.
• Allowed services

Checked Blob, Checked File, Checked Queue, Checked Table.
• Allowed resource types

Unchecked Service, Unchecked Container, Unchecked Object.
• Allowed permissions

Checked Read, Checked Write, Checked Delete, Checked List, Checked Add, Checked Create, 
Checked Update, Checked Process, Checked Immutable storage, Checked Permanent delete.

• Blob versioning permissions
Checked Enable deletion of versions.

• Allowed blob index permissions
Checked Read/write, Checked Filter.

How to set up Azure Blob Storage CORS
Capture with mobile requires properly configured Cross-origin Resource Sharing (CORS) rules to be 
set up for the used Azure Blob Storage.

1. In Microsoft Azure, select All Services, scroll to Storage, and select Storage accounts.
2. Select the storage account you created.

Example:  printixcloudstorage
3. On the storage account blade, select CORS.
4. On the Blob service tab:

• In Allowed origins, leave the wildcard character (asterixis) to allow all domains.
• In Allowed methods, select the following: GET, POST, OPTIONS, and PUT.
• In Allowed headers, select x-ms-blob-type,content-type.
• In Exposed headers, select x-ms-blob-type.
• In Max age, enter 0 (in seconds).

5. Select Save.
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How to add Google Cloud Storage
Enable storage of pending documents in your secure cloud storage. That way, the user's computer 
does not need to be online to release Print Later and Print Anywhere documents. However, a Printix 
Client still needs to be online on the printer's network to release the documents.
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Create a role
1. Open a new browser window and sign in to Google Cloud Platform (console.cloud.google.com) 

using your work account credentials.
2. In Google Cloud Platform, select the Navigation menu and select IAM & admin, and then

Roles.
3. On the Roles blade, select Create role.
4. In Create role:

• In Title, enter the name of the role.
Example: printix storage

• In Role launch stage, select General availability.
5. Select Add permissions.

6. In Filter, type storage.objects and press Enter.
7. Select the Permissions:

• storage.objects.create
• storage.objects.delete
• storage.objects.get

823

https://console.cloud.google.com/


Tungsten Printix Administrator Guide

• storage.objects.list
8. Select Add.
9. Select Create.

Create a service account
1. In Google Cloud Platform, select the Navigation menu and select IAM & admin, and then

Service accounts.
2. On the Service accounts blade, select Create service account.
3. In Service account details:

• In Service account name, enter the name of the service account.
Example: printix

• Optionally, in Service account description, enter a description for the service account.
Example: printix cloud storage service account

4. Select Create and continue.
5. In Grant this service account access to project:

• In Role, select the role you created in step 4 of creating a role (printix storage).
6. Select Continue.
7. In Grant users access to this service account:

• Enter Service account users role.
• Enter Service account admins role.

8. Select Done.
9. Create a key as follows:

a. Click on the created service account.

b. Select the Keys tab.

c. Select Create new key in the Add key list.

d. Select JSON.

e. Select Create.
The private key is saved to your computer and you need to paste the content of it later in step
6 of adding the Google Cloud Storage.

10. Select Done.

Create a storage bucket
1. In Google Cloud Platform, in the Navigation menu, select Cloud Storage.
2. On the Browser blade, select Buckets.
3. Select Create.
4. Enter your bucket information and select Continue to complete each step:

• Specify a Name, subject to the bucket name requirements. Enter, for example: printix-cloud-
storage. You need to enter the name in step 5 of adding the Google Cloud Storage.

• As Default storage class for the bucket, select Standard. Next, select a Location where the 
bucket data will be permanently stored.
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• Leave Access control model at Set object-level and bucket-level permissions.
• Optionally, in Advanced settings, you can add bucket labels, set a retention policy, and 

choose an encryption method. Leave Encryption at Google managed keys.
5. Select Create.
6. On the Bucket details pane, select Permissions.
7. Select Add members.

• In New members, add the service account you created in step 3 of creating a service 
account.
Example: printix

• Select roles. Scroll to Storage and then select Storage Object Creator.
• Select Add another role. Scroll to Storage and then select Storage Object Viewer.
• Select Save.

Add Google Cloud Storage
1. In Printix Administrator, select Menu    > Settings  .
2. Select the Cloud storage  tab.
3. Select Add cloud storage.
4. Select Google Cloud Storage.
5. In Name, enter the bucket name you entered in step 4 of creating a storage bucket.

Example:  printix-cloud-storage
6. In Key, paste the content from your Google JSON Key File created in step 7 of creating a 

service account.
7. Select Add cloud storage.
8. Optionally, check type of pending documents you want to store.

 If you use a web proxy and/or SSL inspection, you need to unblock the URL referencing 
the bucket name (For example: printix-cloud-storage): https://storage.cloud.google.com/
printix-cloud-storage

See also:
• Which documents go via the cloud?

How to set up analytics
Set up analytics to get insights into your Printix-managed print environment.

This is how you set it up:
• Extract data collected by Printix into a SQL database.

The database can either be:
• A Printix database in the Printix Cloud.
• An own database (Azure SQL).
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• View and analyze the data with:
• Printix Power BI solution
• A tool of your own

See also:
• How to extract data to Printix database
• How to extract data to own database
• How to set up Power BI
• How to interact with the Printix Power BI report
• How to include scan details in data extracts

 Try this interactive Power BI demo report.

How to set up Power BI
You can use Microsoft Power BI Desktop with the Printix Power BI solution to get insights about 
your print usage, printers, print queues, and much more.

1. Install Power BI Desktop.
2. Download the Power BI template.
3. Connect to your Printix extracted data.

• Printix database
• Own database

See also:
• How to interact with the Printix Power BI report
• How to publish to Power BI on the web

DISCLAIMER
• The Power BI report is for one Printix Home only and can not be used to present data from 

multiple Printix Homes.
• Printix, or any contributor to these reports is not responsible and therefore not liable for any 

damage caused by usage of these reports.
• These reports are purely indicative.
• Values in, for example, the Cost report may vary and show different amounts and volumes than 

stated on invoices issued by your print provider.

Install Power BI Desktop
1. Visit powerbi.microsoft.com.
2. Download and install Power BI Desktop (it is free) on a Windows computer.
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Download the Power BI template
1. In Printix Administrator, select Menu    > Software .
2. Scroll to the Power BI section and select Power BI Template (PBIT).

The Power BI template is downloaded to a folder you specify.

Connect to your Printix extracted data
• Printix database
• Own database

Printix database
1. Open Power BI Desktop.
2. On the File menu select Open, and browse to the folder where you downloaded the Power BI 

template.
3. Select Power BI template files (.pbit) as the file type.
4. Select the file PowerBI/Printix.pbit and select Open.

5. Enter your values and select currency. Select Load.
• Sheets per tree

Recommended value: 8333. Enter the number of sheets produced from a tree. Used in the 
report: Tree-O-Meter.

• Cost per mono sheet
Enter the cost per mono impression (BW). Suggested value (in US dollar): 0.0134.

• Cost per color sheet
Enter the cost per color impression (Color). Suggested value (in US dollar): 0.0336.

• Cost per sheet
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Enter the cost per sheet printed (Paper). Suggested value (in US dollar): 0.0067.
• Display currency

Select the currency.
Example: US Dollar

 Familiarize yourself with how the cost calculation is done. You can subsequently change 
the currency and cost values in Power BI Desktop by selecting Edit queries and then Edit 
parameters.

6. On the File menu, select Options and settings, and then select Data source settings.
7. In Data source settings, select Edit permissions to open the Edit permissions dialog box.
8. Select Database and select Credentials select Edit.

• Copy Username from the Analytics  tab and paste it into User name.
• Copy Password from the Analytics  tab and paste it into Password.

9. Select Save.
10. Select OK.
11. Select Close.
12. Select Refresh on the ribbon menu to get the latest data from the Printix SQL database.
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Own database
1. Open Power BI Desktop.
2. On the File menu, select Open, and browse to the folder where you extracted the Power BI 

files.
3. Select Power BI template files (.pbit) as the file type.
4. Select the file PowerBI/Printix.pbit and select Open.
5. Enter your values and select currency. Select Load.
6. On the File menu, select Options and settings, then select Data source settings.
7. In Data source settings, select Change source to open the SQL Server database dialog box.

• Copy the Database server address from the Analytics  tab and paste it into Server.
• Copy the Database name from the Analytics  tab and paste it into Database.

8. Select OK.
9. In Data source settings, select Edit permissions to open the Edit permissions dialog box.

10. Select Database, and under Credentials, select Edit.
• Copy the Username from the Analytics  tab and paste it into User name.
• Copy the Password from the Analytics  tab and paste it into Password.

11. Select Save.
12. Select OK.
13. Select Close.
14. Select Refresh on the ribbon menu to get the latest data from your own SQL database.

How to use the Printix Power BI solution template
The Printix Power BI solution template is designed to give you insights into your print usage, and 
contains visualizations of data regarding users, workstation, printers, print queues, and much more.

This solution contains multiple key components:

• A Power BI solution template.
• A set of PowerPoint design templates and icons, which you can download from here.

The most simple usage of this Power BI template consists of opening it and analyzing your 
Printix data in Power BI Desktop on your own computer. Furthermore, you can publish it to your 
organization's online Power BI service to share the report with other users (or even guests), embed 
visuals into your application, and more.

A demo of a Printix solution template can be viewed here.

Read more about what you can find in the report here.

To start using the Printix Power BI solution:
1. Set up Printix analytics.
2. Set up Power BI.
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3. Optionally, publish the report to Power BI.
To publish the Power BI report, you need a Power BI Pro license.

 When you change the Display Currency parameter, you must manually refresh the whole 
report. Only selecting Apply in the report is not enough.

How the cost calculation is done
Although it is not possible to accurately calculate the total cost of the printer environment, we can 
estimate the cost based on what is being printed through Printix.

To allow anyone to define their own cost for different variables, you must provide some input the 
first time you set up the report:

Sheets Per Tree
Number of sheets created from a single tree

Cost Per Mono Sheet
Cost per page when printed in black and white

Cost Per Color Sheet
Cost per page when printed with colors

Cost Per Sheet
Cost per sheet printed

Display Currency
Currency displayed in all cost-related columns

Based on the actually printed documents (Jobs table), we calculate the cost the following way:

• Sheet cost
• This takes into consideration if the document is duplex, and multiples the sum of pages with 

the cost per sheet.

Code: SWITCH( TRUE (); jobs[duplex] = TRUE(); ROUNDUP(jobs[page_count] / 
2;0 ) * sum('Cost Per Sheet'[Cost Per Sheet]); jobs[duplex] = FALSE(); 
(jobs[page_count] * SUM('Cost Per Sheet'[Cost Per Sheet]) ) + 0)

• Cost per page, printed in black and white
• If the document is printed in black and white, it multiplies the number of pages with the toner 

cost (black and white).

Code: SWITCH( TRUE (); jobs[color] = TRUE(); 0 ; jobs[color] = FALSE(); 
(jobs[page_count] * SUM('Cost Per Mono Sheet'[Cost Per Mono Sheet]) ) + 0)

• Cost per page, printed in color
• If the document is printed in color, it multiplies the number of pages with the toner cost (color).

Code: SWITCH( TRUE (); jobs[color] = TRUE(); 0 ; jobs[color] = FALSE(); 
(jobs[page_count] * SUM('Cost Per Mono Sheet'[Cost Per Mono Sheet]) ) + 0)
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• Total cost
• Sums all of the previously mentioned calculations to display the total cost per job.

Code: Total_Cost = jobs[Sheet_Cost] + jobs[Toner_Cost_BW] + 
jobs[Toner_Cost_Color]

All 4 of these calculations have another column with the same name but with (Currency formatted)
appended to them. These columns consider the formatting of the selected Display Currency and 
change the sum to be more user-friendly. These columns are used for all the graphics.

 Merging the calculation and the formatting into a single measure can cause severe 
performance issues with larger data sets, so it should be avoided.

Editing the Power BI template
You can freely alter the Power BI template as needed for your organization.

Changing the Power BI design
The Power BI design is created in PowerPoint and can easily be edited. You can find the design 
under the PowerPoint folder. The design is mostly built using Storyboards.

When you alter the design in PowerPoint and export the slides as PNG, you can set them as 
background images in Power BI. This is done from the Visualizations view. Remember to set the
Image Fit setting to Fit. The images from PowerPoint are saved under the Images\PowerPoint 
directory.
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Changing the Power BI theme
The theme for the report is branded with the same style as https://printix.net. You can create your 
own themes by following Microsoft's official guide.

The included theme is a great start for a customized template and is found under the Themes 
folder.
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How to publish to Power BI on the web
If your organization is using Power BI service, you can Publish reports to the Power BI service and 
set up a Scheduled refresh.

1. Open Power BI Desktop.
2. On the File menu, select Publish, then select Publish to Power BI.
3. Select Save.
4. In the Publish to Power BI dialog box, select a destination and select Select.

5. Select the link Open 'Printix.pbix' in Power BI to open Power BI on the web. Select Got it.
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6. On the Power BI web page, navigate to the Dataset Printix.
7. Select Data source credentials, select Edit permissions to open the Configure dialog box.
8. In Authentication method, select Basic and then:

• Copy Username from the Analytics  tab and paste it into User name.
• Copy Password from the Analytics  tab and paste it into Password.

9. Select Sign in.
10. Select Scheduled refresh.
11. Enable Keep your data up to date and set the Refresh frequency to Daily.

The refresh should NOT happen more often than the number of times per day data is extracted 
from Printix.

12. Select Apply.
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How to interact with the Printix Power BI report
After you have set up analytics, the Printix Power BI report provides a multi-perspective view into 
your Printix-managed print environment.

 Try this interactive Power BI demo report.
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The report has the following pages (or tabs):

1. About the report

2. Overview

3. Printers - Overview

4. Printer - History

5. Printers - Service Status

6. Job - History

7. Locations - Overview

8. Users - Overview

9. User - Print Details

10. User - Scan Details

11. Workstations - Overview

12. Workstations - Details

13. Tree-O-Meter

14. Cost

15. Service Desk

 The report uses Coordinated Universal Time (UTC) to display hours. The displayed time may 
differ from the time zone of your printer.

Popular analysis
• How to see who prints the most
• How to see print costs
• How to see when a user printed
• How to see who printed on a specific printer
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How to see who prints the most
Open page Users - Overview.

How to see print costs
1. Set up your own cost the first time you set up the report.
2. Familiarize yourself with how the cost calculation is done.
3. Open page Cost.

How to see when a user printed
1. Open page Job - History.
2. Select User.

How to see who printed on a specific printer
1. Open page Job - History.
2. Select Printer.

How to see what happened
Select  Menu   >   History .

Printer
See what was printed on the printer and what changes were made to the printer.

1. Open the Printers  page.
2. Select the printer and select Modify.
3. Select the History  tab.

User
See what the user did and what changes were made to the user.

1. Open the Users  page.
2. Select the user and select Modify.
3. Select the History  tab.

Computer
See what was printed and what changes were made to Printix Client on the computer.

1. Open the Computers  page.
2. Select the computer and select Modify.
3. Select the History  tab.
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How to stop and start Printix Service
• On Windows 
• On Mac 

How to stop and start Printix Service on Windows
1. Press Windows+R.

The Run dialog box appears.
2. Type: services.msc, and select OK.
3. Right-click Printix Service.
4. Depending on what you want to do, select Stop or Start.

 On Windows, Printix Client (PrintixClient.exe) will restart the Printix Service 
(PrintixService.exe) automatically as soon as it finds the service has stopped. So, if you want 
to stop it, without having it start automatically, you should first open the Task Manager, and 
on the Processes tab, right-click the Printix Client process and then select End task. Starting 
Printix Client (PrintixClient.exe) will automatically start the Printix Service.

From the command line as administrator:
• Stop the Printix Service with the stop command by typing:

net stop PrintixService
• Start the Printix Service with the start command by typing:

net start PrintixService

How to stop and start Printix Service on Mac
1. In Spotlight Search, type: activity monitor, and select Enter.
2. In Activity Monitor, use the search box in the upper right corner and type: Printix Service
3. If you see a Printix Service process, then double-click it, select Quit, and then Force Quit.
4. While the service restarts, the Printix Client window appears with a spinner. After a few 

minutes the Printix Client icon on menu bar should work again.
Do the following steps from the command line as administrator:

5. Select the search icon in the top right corner.
6. Type: terminal, and select Enter.
7. In the Terminal window, type the relevant command:

Printix Service:
• Stop Printix Service with the unload command by typing:

sudo launchctl unload /Library/LaunchDaemons/net.printix.Service.plist
• Start Printix Service with the load command by typing:

sudo launchctl load /Library/LaunchDaemons/net.printix.Service.plist

Printix Client user interface:
• Stop Printix Client UI with the unload command by typing:
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launchctl unload /Library/LaunchAgents/net.Printix.UI.plist
• Start Printix Client UI with the load command by typing:

launchctl load /Library/LaunchAgents/net.Printix.UI.plist

How to see the version of Printix Client
• On a Windows computer
• On a Mac computer

On a Windows computer
1. Hold the Ctrl key while you open the client menu.

Help is toggled to Diagnostics.
2. Select Diagnostics.

• Version is that of the currently installed Printix Client.

Alternatively, you can open a command prompt and type:
wmic datafile where name="C:\\Program Files\\printix.net\\Printix Client\
\PrintixClient.exe" get Version /value

On a Mac computer
1. Open the client menu.
2. Press the Option key to toggle Help to Diagnostics.

On a Windows keyboard, the Alt key corresponds to the Option key.
3. Select Diagnostics.

• Version is that of the currently installed Printix Client.

In Printix Administrator
Open Printix Administrator.
• The Software page lists the version of the Printix Client.
• On the Computers page, the Version column shows the version.

If you select Search  to search for the computer, the Version is also shown on the Computer 
properties page.

Version of a file
• Windows
• Mac

Windows
1. Right-click the EXE or MSI file and select Properties.
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2. Select the Details tab.
• The version will show as Product version, File version, or as part of the Title.

Mac
1. Open Applications.
2. Right-click Printix Client and select Get info.

• The version will show as Version.

The version is not shown for DMG and PKG files.

How to start the Print Spooler
•
•

Windows 
If you cannot find any printers on your computer, it could be because the Print Spooler is 
unresponsive, possibly beacause of a print driver. Follow these steps to start the Print Spooler 
again.

1. Press Windows+R.
The Run dialog box appears.

2. Type: services.msc, and select OK.
3. Right-click Spooler.
4. Select Start.

From the command line as administrator:
• Start Print Spooler service with the start command by typing:

net start spooler

Mac 
From the command line as administrator:

1. Select the search icon in the top right corner.
2. Type: terminal, and select Enter.
3. In the Terminal window, type the relevant command:

• Stop the printing system CUPS with the stop command by typing:
sudo launchctl stop org.cups.cupsd

• Start the printing system CUPS with the start command by typing:
sudo launchctl start org.cups.cupsd
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Reset the printing system

 Resetting the system deletes all printers on the Mac. Only use this option if all other 
troubleshooting options failed.

1. Select Apple menu  > System Settings, then select Printers & Scanners.
2. Select the Control ^ key and select in the left side printer list and select Reset Printing System.
3. Select Reset to confirm you want to delete all printers.
4. Enter administrator Password when requested.

Reset the printing system on macOS version 12 or lower
1. Select Apple menu  > System Preferences, then select Printers & Scanners.
2. Select the Control ^ key and select in the left side printer list and select Reset printing system.
3. Select Reset to confirm you want to delete all printers.
4. Enter administrator Password when requested.

How to uninstall the Printix Client
• Windows
• Mac

Windows
1. Open the Control Panel and select Programs and Features.
2. Select Printix Client and select Uninstall.

If the Printix Client was installed with Windows Installer (MSI), select the Printix Client without 
Printix logo (smallest size).

3. You are prompted to confirm the uninstallation. Select Yes.
The uninstallation is complete.

4. Select OK.
Alternatively, you can run unins000.exe in the Printix Client installation folder.

 If your organization has used, for example, Microsoft Endpoint Manager to deploy Printix 
Client as a required application, then Printix Client will be installed again.

Mac
1. Open the Printix Client menu.
2. Press the Option key to toggle Sign in to Uninstall.

On a Windows keyboard, press the Alt key instead of the Option key.
3. Select Uninstall.
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If the uninstallation does not work, it could be because you are not signed in. Select Sign in
and then select Uninstall again. Alternatively, you can run the script:
sh /Users/Shared/.Printix.net/Service/uninstallMac.sh

On macOS 10.15 or older, you should use:
sudo /Users/Shared/.Printix.net/Service/uninstallMac.sh

How to submit a support request

Before you submit a support request, we recommend you to check if your problem is already listed 
in Troubleshooting.

See also:
• Product Support

1. Open the Support  page.
2. Fill out the form.

To help us investigate and reproduce the issue, include as much detail as possible, such as:
• The name of the involved user, computer, printer, and print queue.
• Can the issue be reproduced, or does it happen randomly?
• When did the issue occur?

3. As Priority, optionally, select Urgent, High, Normal (default), or Low.
4. Select Send.
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Use the form on the Support page for a quicker response. If you cannot access Printix 
Administrator, go to the Printix - Quick Links page, then see the Alternate method to open a 
technical support case for Printix section near the bottom of the page.

How to do a network trace
Advanced troubleshooting may involve our support asking for network trace of the communication 
between the computer printing and the printer. The instructions below is for use with software
Wireshark.

1. Download and install Wireshark on the computer.
• Wireshark can be downloaded from wireshark.org.
• The software should be installed on the computer that prints, and the computer should be 

on the same network as the printer.
2. Start Wireshark and select the network interfaces.
3. As capture filter, enter: ip.addr == 192.168.1.3, where 192.168.1.3 should be the IP address of 

the printer.

4. Open the Capture menu and select Start.
5. Print the document.

Wait until the document has printed (or when the printer stops receiving data).
6. Open the Capture menu and select Stop.
7. Open the File menu, select Save as and save the trace.

 If the file is larger than 7 MB, you should provide a link to the file rather than attach it to 
your Printix support request.
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How to get Printix App logs
This is relevant if you have been advised to get the logs and submit these to support with one of 
these methods:
• Upload logs to the cloud
• Email logs

Upload logs to the cloud
1. Open the Printix App.

You must be signed in to the Printix App to upload logs.
2. Select Menu  > Diagnostics .
3. Select Upload logs to the cloud.
4. Enter your Support request number.

Example:  1234
If the support request number does not exist, the logs are not uploaded.

5. Select Send.

Email logs
1. Open the Printix App.
2. Select Menu  > Diagnostics .
3. Select Email logs.
4. In the email application, enter the email address supplied by your support representative 

handling your submitted support request.
• If you enter your own email address, you can subsequently save and then attach the logs to 

your existing support request.
5. Select Send.

How to get Windows logs
In connection with advanced troubleshooting, you may be advised to access and supply the below 
logs from Windows.
• Windows System logs
• Windows Application logs
• Windows PrintService logs
• Printix Client logs
• Create dump file of PrintixService.exe
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How to get the Windows System log

1. Press Windows+R.
The Run dialog box appears.

2. Type: eventvwr, and select OK.
3. In Event Viewer, browse to:

Windows Logs\System

4. Select Filter Current Log.
5. In Logged, change Any time to Last 7 days.
6. Select OK to close the Filter Current Log dialog box.
7. Select the Action menu and select Save Filtered Log As.
8. Name the file.

Example:  computername-system.evtx
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How to get the Windows Application log
1. Press Windows+R.

The Run dialog box appears.
2. Type: eventvwr, and select OK.
3. In Event Viewer, browse to:

Windows Logs\Application

4. Select Filter Current Log.
5. In Logged, change Any time to Last 7 days.
6. Select OK to close the Filter Current Log dialog box.
7. Select the Action menu and select Save Filtered Log As.
8. Name the file.

Example:  computername-application.evtx

How to see Printix Service events
1. In Event Viewer, browse to:

Windows Logs\Application

2. If you want, you can select Filter Current Log, and as Event sources, select:
• PrintixService to filter for these events:

• "Service stopped successfully". The Event level is Information.
• "Service started successfully". The Event level is Information.

• PrintixClient to filter for these events:
• "Printix Service Unavailable". The Event level is Warning.
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How to get the Windows PrintService logs
It is typically the Operational log that is needed for troubleshooting. If logging is disabled, you will 
first have to Enable log and then reproduce the issue.

How to Enable log for the Windows PrintService
1. Press Windows+R.

The Run dialog box appears.
2. Type: eventvwr, and select OK.

 You can open the Operational log directly by typing: eventvwr /c:Microsoft-Windows-
PrintService/Operational.

3. In Event Viewer, browse to:
Applications and Services Logs\Microsoft\Windows\PrintService

4. Depending on your system, you may see:
• Admin
• Debug
• Operational

5. Right-click each of the above and select Enable log.
6. Right-click each of the above and select Clear log.
7. Print to the Printix printer.
8. Check that the Event Viewer logs contain Events.

How to save Operational logs for the Windows PrintService
1. In Event Viewer, browse to:

Applications and Services Logs\Microsoft\Windows\PrintService
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2. In Logged, change Any time to Last 7 days.
3. Select OK to close the Filter Current Log dialog box.
4. Select the Action menu and select Save Filtered Log As.
5. Name the file.

Example:  computername-operational.evtx

How to create dump file of PrintixService.exe
1. Open the Task Manager.
2. Select the Services tab.
3. Right-click PrintixService.exe and select Go to details.
4. Right-click PrintixService.exe and select Create dump file.

A PrintixService.DMP is created.

How to get Mac logs
In connection with advanced troubleshooting, you may be advised to access and supply logs from 
Mac.
• How to get logs from the macOS printing system CUPS
• How to enable and disable debug of the macOS printing system CUPS

How to get logs from the macOS printing system CUPS
The logs are stored in this folder:
• /var/log/cups/error_log

Keyboard shortcut to open Finder and go to the folder:
1. Press Shift+Command+G.
2. In Go to the folder, enter /Users/Shared/.Printix.net
3. Select Go.

How to enable and disable debug of the macOS printing system CUPS
From the command line as administrator:

1. Select the search icon in the top right corner.
2. Type: terminal, and press Enter.
3. In the Terminal window, type the relevant command:

• Enable CUPS debugging with the cupsctl command by typing:
cupsctl -debug-logging

• Disable CUPS debugging with the cupsctl command by typing:
cupsctl -no-debug-logging

4. Stop the printing system CUPS with the stop command by typing:
sudo launchctl stop org.cups.cupsd
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5. Start the printing system CUPS with the start command by typing:
sudo launchctl start org.cups.cupsd

How to get Printix Client logs
If advised to do so, you should ZIP the content of the Logs folder and submit to support.

Log files are stored on the computer.
• PrintixClient-{user}.{number}.log
• PrintixService.{number}.log

There will be a maximum of 2 × 6 log files with a size of 1 MB each. The log file without a number is 
the current one. Previous versions are numbered 1–5 with 5 being the oldest.
• Location of logs on Windows
• Location of logs on macOS

Location of logs on Windows
The logs are stored in this folder:
• C:\ProgramData\printix.net\Printix Client\Logs

 ProgramData is a Hidden folder and may not appear in File Explorer when you open Local disk 
(C:).

1. Open File Explorer.
2. Type: C:\ProgramData to access the hidden folder.
3. Browse to C:\ProgramData\printix.net\Printix Client\Logs.

Install logs
If the issue relates to the installation of Printix Client, include the Setup Log file. The Setup Log file 
name includes the date (2017-12-31) and a number (001).
• Example: Setup Log 2017-12-31 #001.txt

If you installed the MSI file, there will also be a MSI Log file. The MSI log file name includes a 
random number (28897).
• Example: MSI28897.LOG

The Setup Log file and MSI Log file are stored in the folder pointed to by the TEMP variable.

Open a command prompt and type: echo %TEMP%
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The result is probably one of these two:
• C:\Windows\Temp
• C:\Users\{username}\AppData\Local\Temp

If you do not find the files there, look in C:\Windows\Temp.

Uninstall logs
When you uninstall Printix Client, it creates a PrintixRestore.log file stored in the folder pointed to 
by the TEMP variable.

Open a command prompt and type: echo TEMP%
The result is probably one of these two:
• C:\Windows\Temp
• C:\Users\{username}\AppData\Local\Temp

If you do not find the file there, look in C:\Windows\Temp.

Location of logs on macOS
The logs are stored in this folder:
• /Users/Shared/.Printix.net/Logs

 .Printix.net is a Hidden folder and will not appear in Finder.

Keyboard shortcut to open Finder and go to the folder:
1. Press Shift+Command+G.
2. In Go to the folder, enter /Users/Shared/.Printix.net
3. Select Go.

Install logs
If the issue relates to the installation of Printix Client, include the install.log file, which is stored in 
the folder:
• /var/log
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FAQ

This topic contains answers to the following frequently asked questions:

• Why subscribe to Printix?
• What is Printix Anywhere?
• How secure is Printix printing?
• What if the Internet connection is lost?

• Why are printers named ASD, BNM?
• Why are there additional print queues?
• Are documents printed in the order they were submitted?

• I started a trial at home, but why does it not work at my company?
• What happens when I install the Printix Client?
• What happens if users uninstall the Printix Client?

• Why does a group have no or missing users?
• Can I use label printers?

 If you have any questions or feedback, contact us or submit a support request and we will get 
back to you.

Why subscribe to Printix?
If you subscribe to the Printix Cloud Print Management Service, you can remove print servers, 
improve efficiency, and reduce costs. Plus, you also get flexible, secure, and mobile printing.

• Automated print infrastructure
Automate print driver and queue management and eliminate the need for a print server. 
Unlimited scaling at no extra cost. The Printix software automatically updates itself to the latest 
approved version.

• Print when and where you want
Print Anywhere makes it possible to roam between printers and release the document at the 
printer you choose.

• Prevent others from collecting your documents at the printer
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Wait until you arrive at the printer, then release the documents using your phone. That way, you 
prevent others from collecting your confidential and sensitive documents.

• Make fewer visits to the printer
Submit documents to a print queue, but postpone the printing and collection of the documents 
until it suits you to release them.

• Delete unwanted documents from the print queue
You can use your phone, tablet, or computer to delete unwanted documents from the print 
queue before they are printed. Without Print Later, such documents would go straight from the 
printer's output bin to the wastepaper basket.

• Reprint documents
You can reprint documents until 12 hours after they are marked for deletion. You can reprint 
documents straight from your phone without having to return to your computer to reprint them.

Printix also creates a win-win situation for your organization and the environment:

• Reduced printing saves on paper and toner
By minimizing the number of printed documents, your organization saves money on paper, 
toner, maintenance, and electricity.

• Environmental benefits
Fewer trees are cut down to produce paper, thus reducing the carbon footprint and water usage.

What is Printix Anywhere?
Print Anywhere makes it possible to roam between printers and collect your document at any 
Printix printer.

• When you select Printix Anywhere as your printer, your document is always kept until you release 
it using your phone, tablet, computer, or at the printer.

• Document is sent as PDF, unless the printer does not support PDF printing or Process PDF/XPS is 
selected. In this case, the PDF document is processed using a matching print driver.

If you do not care about finishing options, Printix Anywhere could very well turn out to be the only 
printer you need on your computer. Number of copies is not supported (only 1 copy is printed).
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How secure is Printix printing?
Printing with Printix is at least as secure as traditional network printing.

All Printix communication inside and outside the network is secured with encryption and the use of 
HTTPS (SSL/TLS).

Secure printing: Wait until you have arrived at the printer, then release the documents using your 
phone. No more stressful print and sprint.
• Documents are encrypted and stored until they expire and/or get deleted.
• Documents do not need to leave your network.

What if the Internet connection is lost?
When the Printix Client loses connection to the Internet, a yellow dot is displayed on the Printix 
Client icon , indicating the Printix Client is in the state Connection failed.

When the connection fails, a red dot is displayed on the Printix Client icon  instead. The yellow 
dot can also appear next to the red dot  if additionally, your Printix Client is also on an unknown 
network.

Without an Internet connection, you are temporarily unable to:
• Sign in to Printix Administrator.
• Configure Printix and manage printers with Printix Administrator.
• Access online documentation.
• Users cannot print Via the cloud, Mobile print, and Chrome print.

See also: Which documents go via the cloud?

As long as users remain signed in and keep their computer powered on, they can:
• Print directly to printers on the network.

To print in offline mode, the following condition must be fulfilled:
• The Printix Client and the target printer must be on the same network.

• Use Print Anywhere, but they cannot release any documents.
• The Printix Client displays the message Printix is currently offline. Your document {file name} 

can be released when Printix is online again.
• Starting from Printix Client version 1.3.1286.0, if the setting Allow direct print if offline is 

selected, the Printix Client displays the message Printix is currently offline. You cannot release 
your document from Printix Anywhere until Printix is online again. Consider printing your 
document now by selecting a different printer, and it prompts you to select a printer. Printers 
are listed only if they are on the same network as your computer, AND if you have previously 
released documents to them.
If users select Printix Anywhere, their document can only be released when the Internet 
connection is restored. Alternatively, they can print their document immediately at another 
printer that is listed.
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• Use Print Later, but they cannot release any documents.
• If the setting Allow direct print if offline is selected, the Printix Client displays the message

Printix is currently offline. If you select Print Later, you can only release your document when 
Printix is online again, and it prompts you to print now or use Print Later.
If you still decide to use Print Later, your document can only be released when the Internet 
connection is restored. Alternatively, you can Print the document immediately at the printer 
you originally selected.

• If the setting Allow direct print if offline is not selected, the Printix Client displays the message
Printix is currently offline. Your document {file name} can be released when Printix is online 
again, and it does not prompt you to make a choice.

If the Printix Client is offline and the printer is also unreachable (for example, it is offline or on 
another network), the print fails, then the Printix Client displays the message Document {file name} 
deleted. Your document cannot be printed, because Printix Client is offline and cannot reach the 
target printer ({printer name}).

When the Internet connection is restored, all functionality is working again and users can:
• Release documents

Including any Print Anywhere and Print Later documents users submitted while the Internet 
connection was lost.

• Reprint documents
Including any documents users submitted with direct print while the Internet connection was 
lost.

Why are printers named ASD, BNM?
The name of all Printix printers is automatically extended with a unique, three-letter ID, also known 
as the printer ID. This ID makes it efficient to search for printers and easy to identify the printers.
• Searching for a printer is efficient.

• If Printix manages 26 or fewer printers, you need to only enter the first letter when searching 
for a printer.

• The search is not case-sensitive.
• Identifying the printer is made easy.

• The printer ID sign mounted on the physical printer includes the printer ID.
• Print queues are named so they include the printer ID.

How many printers can be supported?
Up to 2200 printers can be assigned with three-letter IDs. If more printers are added, the software 
automatically uses four-letter IDs.

Keyboard sequence
The sequence of letters for the first 78 printer IDs are grouped together on the keyboard to 
optimize searching for printers by their ID.
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Printer ID examples:
• Reception ASD
• Sales BNM

Keyboard sequence for printers ASD and BNM

Why are there additional print queues?
You have set up print queues, and made them Active, so users can add these through the Printix 
Client. You have then deployed Printix Client on more computers, and suddenly new print queues 
start to be listed in Printix Administrator.

For example, when you look at the ASD printer, it has four print queues. You know of the first 
two print queues (Reception and Reception Stapler), they are Active, and they are installed on 
respectively 149 and 11 computers. However, you do not know of the other two print queues and 
wonder why they are listed.
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You do not know of the two print queues:
• Reception (HP Officejet Color X555)
• HP Officejet Color X555 PCL 6

No reason to panic. Printix is trying to put you, the administrator, in the driver seat with full 
transparency of what printers, print queues, and print drivers are in use and allow you to centrally 
manage the print infrastructure in a way that is not even possible with traditional, on-premise print 
servers.

On each computer, Printix Client registers any print queue it finds that points to a Printix-managed 
printer, and reports this to the Printix Cloud, so it can be shown in Printix Administrator. These 
additionally found print queues are not marked as active, and therefore users will not be able to 
add these through the Printix Client.

Reception (HP Officejet Color X555) is installed on 3 computers. The print queue was initially set 
up to use a WSD port. Examples of print queue name formats:
• hostname (model name)

Example HP: Reception (HP Officejet Color X555)
• model name (hostname)

Example Lexmark: Lexmark X792 (ET0021B719COP)
• hostname

Example Lexmark: ET0021B719COP
• model name
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Example Ricoh: RICOH Aficio SP C420DN

HP Officejet Color X555 PCL 6 is installed on 1 computer. The print queue was initially set up to use 
a standard TCP/IP port. The print queue is the name of the print driver:
• print driver name

Example: HP Officejet Color X555 PCL 6

Copy 1, Copy 2, ... may appear at the end of the print queue name. This is appended by Windows to 
handle when a user has added a print queue with a name that was already in use on the computer.
• printer name (Copy N)

Example: HP Officejet Color X555 PCL 6 (Copy 1)

How to get rid of the additional print queues
You can choose to ignore these print queues. You can Filter with Active: No. You can also choose 
to Delete the print queues from the computers where they are installed and then eventually delete 
them from the list in Printix Administrator. To find out which computer added the print queue, open 
the corresponding printer's Printer properties page, and select the History tab. There, you will see 
an entry, such as the following example:
• Print queue Reception added for printer ASD by COMPIX

Remember that as soon as someone creates an own print queue that points to a Printix-registered 
printer, Printix Client picks up on this and registers the print queue in the Printix Cloud. If Convert 
print queues is selected, Printix Client converts the print queue and it appears as managed.

I started a trial at home, but why does it not work at my 
company?

If you started the Printix trial at home, your computer (laptop) was put on Network1 (the first 
network). When you bring your laptop to work, it will appear as on an Unknown network. When the 
computer is on an Unknown network, a yellow dot is shown on the Printix Client icon .
• Add a new network.
• After a few minutes, select the Diagnostics tab on the Computer properties page and verify that

Proxy is Yes.
• If it does not start to act as proxy, it could be that your company is using Web proxy and SSL 

encryption and this is preventing communication between the Printix Client and Printix Cloud.

If none of the above resolves the problem within 5 minutes, report the problem to our support so 
we can help you.

Are documents printed in the order they were submitted?
Whether documents are printed in the order they were submitted/released depends on how you 
are printing through Printix.
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Documents printed directly to the printer
When you select Print in the application, the application starts to process the document, then sends 
it to the print queue, where data is processed by the print driver, and when done, Printix Client will 
send the data to the printer, which in turn will print the document. The time used for processing 
varies depending on the document, the application, the print driver and the computer. This implies 
that if a second document is submitted shortly after the first document, it can actually overtake the 
first document and be printed first.

Documents released to the printer
Secure printed documents (Print Anywhere and Print Later) can be released from within the Printix 
App or Printix Go. On the Print page in Printix App and Printix Go, the newest (last in) document 
is listed at the top. The time stamp of the document is the time recorded when the document is 
registered by Printix.

When you release documents, the documents will be sent to the printer in the same order 
(according to time stamp) as they appear on the Print page (last in first out).

However, a few exceptions exist where the order may not necessarily be maintained.

Exceptions:
• If the released documents are not stored in the cloud and need to be sent between networks (via 

the cloud).
• If the released documents are not stored in the cloud but are on different computers. This is not 

very likely, unless the user is using multiple computers.

You can avoid the above exceptions if you enable storage of pending documents in your secure
Cloud storage and select Store Print Anywhere documents and Store Print Later documents.

 If you do not have good Internet bandwidth, you may not want to enable cloud storage.

What happens when I install the Printix Client?
The first time you install the Printix Client prepares your setup and attempts to discover your 
printers and securely transfer necessary information to the Printix Cloud and thereby save you time. 
It installs the Printix Anywhere printer, converts print queues, and extends their name with a three-
letter printer ID to make it easy to search for and identify printers.
• Original: Reception
• Printix: Reception ASD

What happens if users uninstall the Printix Client?
If users uninstall the Printix Client, their Printix printers are converted to normal network printers.
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The name is stripped of the three-letter ID.
• Printix: Reception ASD
• After: Reception

If the stripped name is not unique, the text Copy is appended to the original name.

Why does a group have no or missing users?
Printix will only synchronize users/group membership for users when BOTH of the below two 
conditions are met:
• The user is registered in Printix.
• The group in question is used within Printix.

On the Groups page, you can filter groups as follows:
• Only groups used with Printix
• Only groups not used with Printix
• All available groups

Groups that are used with Printix:
• Group is used with print queues.
• Group is used to manage secure print, that is:

• Must print securely groups.
• Print Later by default groups.
• Secure print level groups.

• Group is used to manage the availability of workflows.
• Group is used to manage site managers.

If a user is missing from a group that is otherwise used in Printix, it is probably because that user is 
not yet registered.

A delay may occur before users appear as members.
• Groups are synchronized automatically at approximately 20 minute intervals. Only the changes 

are synchronized.

Can I use label printers?
We have many customers using label printers with Printix. However, to make your setup of your 
label printer successful, we have collected this information for you.

Label printers that are network-connected and have full SNMP support are easy to set up. However, 
some label printers have no or only a very limited implementation of SNMP, and some label printers 
are not networked, but are locally attached to a computer's USB port. Also, toner levels may not be 
supported for the label printers.
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SNMP support
If the printer does not support SNMP, it will appear as an unregistered printer, and from there, they 
can be added manually. You can use SnmpWalk to test that SNMP communication is working. You 
can use the  Printix Configurator  to add the printer if it does not support SNMP.

If the printer has a limited implementation of SNMP, it may have been registered, but information 
about the printer model name might be missing or be too generic, so it may not have been possible 
for Printix to automatically select a print driver. It might also be that the required print driver is not 
part of the driver store, and you first have to add the print driver.
• How to change the print driver
• How to add a print driver

USB connected
If the printer is locally attached to a computer's USB port, you can use Printix Redirector to add it.
• Enable USB printing

Printing
After the printer is registered, you can print to the Printix-managed print queue. The Printix Cloud 
Print API can also be used by applications that wish to push print jobs in printer-native or PDF 
format to label printers. You can access the API documentation at printix.github.io.
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Chapter 15

Troubleshooting

To troubleshoot an issue, we recommend that you explore the sections below. If you cannot find a 
resolution, submit a support request.

Top issues
• Sign in issues
• Print issues
• Add printer issues
• Printix Go issues

Relevant sections
• How to
• FAQ
• Error messages

History
• Look at history 

See what happened when, and who did what.

Product support
• Use Product Support

Changelog, videos, FAQ.
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Sign in issues

Open Printix Troubleshooter PDF
• I cannot sign in to Printix Administrator
• Your sign-in was successful but does not meet the criteria to access this resource
• Sign-in to Printix App does not allow user name and password to be entered
• Not signed in after signing in to the Printix Client
• Loops back to Sign in page
• Sign-in is not automatic first time on Microsoft Entra joined computer
• Sign in page shows: Website not found
• Printix Client icon does not appear

See also:
• Internet endpoints that must be unblocked

I cannot sign in to Printix Administrator
You are not able to sign in to Printix Administrator.

Resolution: Open your browser in Incognito or In private mode and enter the Printix Home (acme) 
followed by /admin.

Example: https://acme.printix.net/admin
• You will get Permission denied if you do not have the System manager or Site manager role.
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• If you Sign in with Email, you may have forgotten your password.
• How to reset your password

 If you are no longer able to sign in to Printix Administrator, you may have to clear browsing 
data.

Your sign-in was successful but does not meet the criteria to access this 
resource

Your organization have set Conditional access in Microsoft Entra ID and this access policy may have 
applied on the group or user.

Resolution: Follow the instructions in Microsoft Entra Conditional Access.

Sign-in to Printix App does not allow user name and password to be 
entered

In Printix App, you are not able to enter user name and password after you select Sign in with 
Microsoft or Sign in with Google.

During sign-in, Printix App will need to open a browser to complete the sign in process. If your 
phone or tablet is subject to Mobile Device Management (MDM), with conditional access, your 
phone and tablet will, according to the set conditions, block use of a regular browser, and thereby, 
also block the sign-in process.

Resolution: On the phone or tablet, install a protected Intune browser (Microsoft Edge) so the sign-
in process will work.

Not signed in after signing in to the Printix Client
After signing in to the Printix Client and closing the browser window (as instructed), the Printix 
Client menu still does not display you as signed in and a yellow dot is shown on the Printix Client 
icon  indicating the Printix Client is in the state Connection failed.

 When connection to the Printix Client fails, a red dot is displayed on the Printix Client icon 
instead. The yellow dot can also appear next to the red dot  if additionally, your Printix Client is 
also on an unknown network.

One possible reason is when a previous Printix Client was uninstalled, the files were not removed 
from C:\ProgramData\printix.net\Printix Client\Configuration.

Resolution: Uninstall the Printix Client, remove the old ProgramData files manually, then install the 
client again.

Another reason could be that the Printix Client is reading some legacy/invalid proxy settings. 
Printix Client uses a Windows function WinHttpGetProxyForUrl (implements WPAD) to get the proxy 
settings from the PAC file. However, it also looks at the proxy settings configured for the users 
on the computer. If it finds a suitable set of proxy settings for a user, it remembers them in the 
Windows Registry under the LSA user (HKEY_USERS\S-1-5-18\Software\Microsoft\Windows
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\CurrentVersion\Internet Settings\Connections). This is done to allow the Printix Service 
to communicate with the Printix Cloud when no user is signed in.

You can open the PrintixService.log file and search for: DefaultConnectionSettings:S-1-5. You should 
see an entry for each user that is known on the computer. The information is written to the log file 
every 15 minutes.

You can open the PrintixService.log file and search for: ServerComm: running with proxy. You 
should see the address of the web proxy it is using.

Example: proxy1: http://172.23.100.13:8080/.

Resolution: First, try to follow the steps below to delete settings from LSA user in the Windows 
Registry.

1. Press Windows+R.
The Run dialog box appears.

2. Type regedit, then select OK.
Select Yes if prompted.
The Registry Editor appears.

3. Browse to HKEY_USERS\S-1-5-18\Software\Microsoft\Windows\CurrentVersion
\Internet Settings\Connections.

4. Delete the two entries called DefaultConnectionSettings and SavedLegacySettings.
5. Restart the computer.
6. Sign in to Printix Client again.

If the issue persists, you may have to delete the DefaultConnectionSettings and
SavedLegacySettings for each user setting.

Loops back to Sign in page
• Printix Client does not know its Printix Home
• Is a web proxy and/or SSL inspection used?
• I do not recognize the used web proxy
• Is FIPS (Federal Information Processing Standards) enabled on the computer?

Printix Client does not know its Printix Home
When this is the case, the Printix ID in Windows Registry is not set. This can happen if:
• The Printix Client installation file was renamed before installation.
• The Printix Client MSI file was deployed through, for example, Microsoft Endpoint Manager, but 

in command line arguments, :/id was not set correctly.

Resolution: Do NOT rename the file before installation. Type the Command line arguments
correctly, for example: WRAPPED_ARGUMENTS=/id:cbfce0b5-da2a-4cb6-b7f7-a04ee31cac90. 
Replace the /id value with your Printix ID as shown in the name of the MSI file.
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Is a web proxy and/or SSL inspection used?
In this case, the PrintixService.log file will contain the text: SrvComm Exception: Status: 
ProxyAuthenticationRequired.

Resolution: You MUST add the printix.net domain and subdomains as exceptions so traffic is not 
blocked. See also: Internet endpoints that must be unblocked.

I do not recognize the used web proxy
In this case, the PrintixService.log file contains text such as: ServerComm: running with proxy1: 
http://172.23.100.13:8080/ and Unable to connect to the remote server.

Resolution: See How does the Printix Client find the web proxy?

Is FIPS (Federal Information Processing Standards) enabled on the 
computer?
Enabling FIPS disallows the use of the MD5 hashing algorithm, which is used by the Printix Client to 
make some entries in the Windows Registry "tamper-resistant."

Resolution: Disable FIPS.
1. Press Windows+R.

The Run dialog box appears.
2. Type regedit, then select OK.

Select Yes if prompted.
The Registry Editor appears.

3. Browse to HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Lsa
\FipsAlgorithmPolicy.

4. Change the value Enabled to 0.
5. If present, also change the value MDMEnabled to 0.
6. Restart the computer.

PowerShell script
Set-ItemProperty -Path "HKLM:\SYSTEM\CurrentControlSet\Control\Lsa\FipsAlgorithmPolicy" 
 -Name "MDMEnabled" -Value 0

Sign-in is not automatic first time on Microsoft Entra joined computer
Sign-in to the Printix Client is automatic on Microsoft Entra joined Windows 10 and 11 computers 
and works with the Pro, Enterprise, and Education editions. Microsoft does not support Microsoft 
Entra join on Windows Home editions. However, if you have not accepted Printix for all users, users 
will be prompted to accept this the first time they sign in.
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Resolution: Verify that Printix is accepted for all users, so the automatic sign-in to the Printix Client 
works on Microsoft Entra joined Windows 10 and 11 computers.
• If more than one Microsoft Entra directories exist, sign-in to the Printix Client is no longer 

automatic the first time on Microsoft Entra joined Windows 10 and 11 computers. The user must 
select a directory (acme.com or ajax.com) and then sign in, but only the first time.

• If you have either renamed the Printix Client installation file, or are installing through Microsoft 
Endpoint Manager and have not specified the Command line arguments, this also breaks the 
SSO, because the sign-in occurs through sign-in.printix.net/tenanthub.

See also:
• How to find out if the computer supports SSO
• Microsoft documentation about Microsoft Entra joined computers

Sign in page shows: Website not found
Follow the suggestions shown on the page. If this does not help, submit a support request where 
you describe the issue and supply the information obtained by following these steps:

1. Right-click the page and select Properties.
2. Double-click on the text: https.
3. Copy the entire text to the clipboard by pressing Ctrl+A and then Ctrl+C.
4. Paste Ctrl+V the content into the support request.

The copied content will look similar to the following:
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https://sign-in.printix.net/signIn?authURL=https:%2F
%2Fauth.printix.net&jwt=eyJhbGciOiJIUzI1NiJ9.eyJ0ZW5JRCI6ImNkYjdkNGI5LWViM2UtNDE1Ni05MWU3LTE2OWI0OGFiOWU5NyIsInN0YXRlIjoibGFyc2UiLCJwcm9tcHQiOiJsb2dpbiIsIlNQUklOR19TRUNVUklUWV9TQVZFRF9SRVFVRVNUIjp7InJlcXVlc3RVcmwiOiJodHRwczpcL1wvYXV0aC5wcmludGl4Lm5ldFwvb2F1dGhcL2F1dGhvcml6ZVwvdGVuYW50XC9jZGI3ZDRiOS1lYjNlLTQxNTYtOTFlNy0xNjliNDhhYjllOTc_cmVzcG9uc2VfdHlwZT1jb2RlJmNsaWVudF9pZD1wcmludLm5ldCZjbGllbnRfc2VjcmV0PTEyMzQmc3RhdGU9bGFyc2UmcmVkaXJlY3RfdXJpPWh0dHA6XC9cL2xvY2FsaG9zdDoyMTMzOVwvb2F1dGhcL2F1dGhvcml6ZSZwcm9tcHQ9bG9naW4iLCJxdWVyeVN0cmluZyI6InJlc3BvbnNlX3R5cGU9Y29kZSZjbGllbnRfaWQ9cHJpbnRpeC5uZXQmY2xpZW50Y3JldD0xMjM0JnN0YXRlPWxhcnNlJnJlZGlyZWN0X3VyaT1odHRwOlwvXC9sb2NhbGhvc3Q6MjEzMzlcL29hdXRoXC9hdXRob3JpemUmcHB0PWxvZ2luIn19.OqY3l3JORS5uDwg_hcmFjQKubeIbjgli5zJOOjUNo

Printix Client icon does not appear
The Printix Client icon  does not appear. The PrintixClient-{user}.{number}.log file includes the 
following message:
System.NotSupportedException: The requested security protocol is not supported. 
  at System.Net.ServicePointManager.ValidateSecurityProtocol(SecurityProtocolType 
 value) 
  at WindowsUI.PixWindowsClient.StartGUIWorkers() 
  at WindowsUI.Program.Main(String[] args)

Resolution: Enable TLS 1.2.
1. Press Windows+R.

The Run dialog box appears.
2. Type regedit, then select OK.

Select Yes if prompted.
The Registry Editor appears.

3. Browse to HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control
\SecurityProviders\SCHANNEL\Protocols\TLS 1.2\Client.

4. Add the DWORD value name DisabledByDefault with a value of 0.
5. Restart the computer.

Print issues
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Open Printix Troubleshooter PDF
• When I want to release a document, it says: Document is unavailable
• When I release a document, it says: Working on it
• The submitted document does not appear in Printix App
• Printix App displays Document release is not possible at the moment due to system error
• Printix App displays Internal error
• The submitted document does not get printed
• Data light on the printer flashes, but nothing is printed
• Document is empty

See also:
• How to add an unknown network to a network
• How to change the print driver
• Exclusive access examples

When I want to release a document, the Printix App displays "Document 
is unavailable"

In the Printix App, you may notice the following scenario:
• One or more selected documents are labeled: Document is unavailable.
• After selecting all documents, an Unavailable documents dialog box appears with the question:

Deselect unavailable documents?

The preceding behavior is expected and happens because the Printix App checks if printing is 
possible based on the availability of the selected printer and documents. The Printix App considers 
whether the selected documents are stored in the cloud or on a computer. If the document is 
stored on a computer that is not reachable from the selected printer, then the document is labeled:
Document is unavailable. If Select all is used to select documents (including unavailable ones), 
the Unavailable documents dialog box appears and you can select OK to deselect the unavailable 
documents.

Resolution: Deselect the unavailable documents.

When I release a document, the Printix App displays "Working on it"
If you are releasing a Print Anywhere document to a printer you did not use before, it may require 
your computer to first add the printer. This may take 1–5 minutes depending on the print driver. 
During this time, the Printix App displays the state Working on it before transitioning to Printing
and then Printed. The printer is kept after printing, so it does not have to be added again when you 
release subsequent Print Anywhere documents.

Resolution: Wait for the print queue to be created.

The submitted document does not appear in Printix App
In Printix Client and Printix App, look at who is listed as Signed in as and verify that it is the same 
user.
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Resolution: Sign in as the same user in Printix Client and Printix App.

Printix App displays "Document release is not possible at the moment 
due to system error"

An issue occurred with the Printix Cloud and therefore, it is not possible to release documents from 
the Printix App. You can check the Announcements section on the Printix website and look for any 
ongoing system errors.

Resolution: Try again when the system error is fixed.

Printix App displays "Internal error"
An internal error occurred in the Printix App. Select the message to see the details. If the issue 
continues, take a screen shot and submit a support request.

Resolution: Stop and restart the Printix App.

The submitted document does not get printed
This can happen if a policy is on the computer that:
• Prevents the Windows feature Internet Printing Client from being turned on.
• Prevents direct printing.

Look in the Windows PrintService logs to see if a policy (GPO) or Windows Registry setting
prevents direct printing. If required, submit support request if you need assistance. Include the 
Windows PrintService log from the failed print attempt.
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Enable Internet Printing Client
1. Open the Control Panel and select Programs and Features.
2. Select Turn Windows features on or off.

The Windows Features dialog box appears.
3. Scroll to and expand Print and Document Services.
4. Select Internet Printing Client.
5. Select OK.
6. Restart the computer.

Windows Registry setting DisableHTTPPrinting prevents printing with 
Printix

1. Press Windows+R.
The Run dialog box appears.

2. Type regedit, then select OK.
Select Yes if prompted.
The Registry Editor appears.

3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows NT\Printers
\.

4. If a DWORD value name DisableHTTPPrinting has a value of 1, it prevents printing with 
Printix.

Check that Internet Print Provider is set to inetpp.dll
1. Press Windows+R.

870



Tungsten Printix Administrator Guide

The Run dialog box appears.
2. Type regedit, then select OK.

Select Yes if prompted.
The Registry Editor appears.

3. Browse to HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Control\Print\Providers
\Internet Print Provider.

4. Check that Name is inetpp.dll.

See also:
• FAQ: Printing has stopped working after Windows Defender update

Data light on the printer flashes, but nothing is printed
This can happen if you are trying to release a Print Anywhere document to a printer that has been 
registered as supporting PDF, but in reality, it does not support PDF printing. This has been reported 
for some Konica Minolta printers, such as KONICA MINOLTA C652 Series.

Resolution: Contact Product Support if you have this issue, so we can register the printer as not 
supporting PDF print.

Test if the printer supports PDF
You can use the lpr command to test if the printer supports PDF printing. To send the document C:
\test.pdf to the printer with the IP address 192.16.8.1.11, open a command prompt and type:
lpr -S 192.16.8.1.11 -P1 "C:\test.pdf"

The LPR Port Monitor feature must be enabled:
1. Open the Control Panel and select Programs and Features.
2. Select Turn Windows feature on or off.

The Windows Features dialog box appears.
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3. Scroll to and expand Print and Document Services.
4. Select LPR Port Monitor.
5. Select OK.

Document is empty
Some print drivers can make print jobs that contain 0 bytes. If you look in the Windows PrintService
event logs, you will also see a message that displays that the print job contains 0 bytes.

On the computer in question:
1. Remove the print queue that uses the print driver.
2. Remove the print driver and driver packages.
3. Restart the Print Spooler.
4. Add the print queue again and try to print.

Add printer issues
Open Printix Troubleshooter PDF
• Check that a print driver is selected for the OS
• Firewall blocks download of print driver
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• Device setup in progress
• Computer failed to install print driver: -2,147,467,259

See also:
• Can I use label printers?
• How to remove print drivers
• Exclusive access examples

Firewall blocks download of print driver
If the Printix Client has issues adding a print queue on a Windows computer, it may be that a 
firewall has prevented the download of the print driver from the Printix driver store (https://
drivers.printix.net/). The print driver is downloaded as a ZIP file into the folder: C:\Windows\Temp
\Printix-drivercache.

Resolution: Set up your firewall to not have any size restrictions on the ZIP files it can download 
from https://drivers.printix.net/ and/or set it up to not scan files downloaded from the Printix driver 
store.

Device setup in progress
On Windows, when you open the Control Panel and Devices and Printers, your newly added 
printer is shown as installed, but the status is stuck in: Device setup in progress. You may also 
notice that the printer is listed under Unspecified devices. Despite this, the printer can be selected 
from applications and printed to.

This may happen if Windows has issues downloading the correct icon for the printer. Issue has been 
reported for Windows 10, version 1903.

Resolution: If restarting the computer does not solve the issue, disable automatic download of 
custom icons available for your printers.

1. Press Windows+R.
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The Run dialog box appears.
2. Type regedit, then select OK.

Select Yes if prompted.
The Registry Editor appears.

3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion
\Device Metadata.

4. Change the value PreventDeviceMetadataFromNetwork from 0 to 1.
5. Restart the computer.

Computer failed to install print driver: -2,147,467,259
For Printix Client to be able to add a printer to a computer, the print driver MUST be Authenticode 
signed by Microsoft, or the print driver MUST be installed on the computer in advance, or you can 
install the print driver's certificate.

If you manually install an unsigned print driver, it will present the Windows Security dialog box 
asking Would you like to install this device software. To proceed with the installation, you MUST 
select Always trust software from XXX and then select Install.

When the Printix Client fails to install an unsigned print driver, the History will include:
• Computer COMPIX failed to install print driver XXX for print queue XXX (printer ASD): 

-2,147,467,259

So, you have three options:
• You change the print driver to one that is signed by Microsoft.
• You install the unsigned print driver in advance.
• You can install the print driver's certificate.

Printix Go issues
• Printix Go troubleshooting
• How to test communication to Printix Cloud from the printer
• How to troubleshoot scan to email
• How to investigate Printix Go screen layout issues
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Printix Go troubleshooting
Categories:
• General

• Verify sign in profile failed
• Sign in to printer failed
• No Printix Client acts as proxy on this network
• Changed Go configuration does not take effect
• Printix Go installation status is Failed
• Troubleshooting card readers
• How to test communication to Printix Cloud from the printer
• How to troubleshoot scan to email

• Brother
• Brother printer displays Error: 80015

• Epson
• Epson printer displays (Error: 204) Please try to reload the page or contact your administrator

• Fujifilm
• Fujifilm printer says: Unknown vendor is detected
• Fujifilm printer only offers ID code as sign-in method, even though a card reader is installed
• Installation of Printix Go Fujifilm fails
• Fujifilm printer is unable to release Print and Print Later documents

• HP
• HP Access Control web page settings discrepancy
• HP printer displays The item is restricted
• HP printer displays Sign-in failed. The default sign-in method (Printix) is currently unavailable
• HP printer displays USB error
• Printing a large document fails and takes hours to recover if an HP Workpath printer loses 

connection to the Printix Client
• Native scan does not appear to be locked for guests, even though the Go configuration 

restricts it on HP Workpath printers
• HP printer displays WRONG_AUTHENTICATION_STATE
• Printix Capture fails to complete on an HP printer

• Konica Minolta
• Konica Minolta printer displays Error: 500
• Konica Minolta printer will not install
• Konica Minolta printer displays Certificate security credentials could not be verified
• Printix Capture fails to complete on a Konica Minolta printer

• Kyocera
• Guest users can access third-party functions on a Kyocera printer
• A printer alert appears when you want to use a Kyocera printer
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• Home button does not respond while signing in to a Kyocera printer
• Printing a large document fails and takes hours to recover if a Kyocera printer loses connection 

to the Printix Client
• Installation of Printix Go fails and KYOCERA Net Viewer says: Device status error - Add toner
• KYOCERA Net Viewer says: User does not exist (or it says: The application is not yet configured)

• Lexmark
• Lexmark printer displays Error: WRONG_AUTHENTICATION_STATE
• Card reader not registered on Lexmark printer
• Printer functions are locked on a Lexmark printer, even though Printix Go is uninstalled
• Installation or update failed

• Ricoh
• Ricoh printer displays Whitelabel Error Page
• Ricoh printer displays Webpage not available
• Installation status is Failed
• Installation status is Installed, but nothing seems to be installed
• Uninstallation status is failed
• Documents do not print when released at the Ricoh printer
• Printing a large document fails and takes hours to recover if a Ricoh printer loses connection to 

the Printix Client
• Capture is not uninstalled from Ricoh printer
• Ricoh printer cannot get through the loading screen when attempting to log in
• History tab in Printix Administrator shows wrong step if Printix Go Ricoh installation fails
• Scan to email does not auto populate the To field with the user's name on a Ricoh printer
• Guest users can access functions they are not supposed to on a Ricoh printer
• The version number for Printix Go Ricoh is different on the printer's web page
• Printix Go cannot register a Ricoh printer
• The Printix Capture icon disappears from a Ricoh printer
• The Ricoh printer's Scan function cannot be used
• Failure occurs after installing or uninstalling Printix Go Ricoh

• Xerox
• Xerox printer displays Could not log in
• After uninstalling Printix Go, Xerox VersaLink printer says: Internal Server Error
• Xerox card reader does not recognize card
• Printix Go cannot be updated or uninstalled and Xerox printer says: Internal Error

General
Verify sign in profile failed
The user name and password specified in the sign in profile does not match that of the printer. Or 
no password has been set on the printer.

Resolution: Set password on the printer and make sure it matches the sign in profile.
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Sign in to printer failed
The user name and password specified in the sign in profile does not match that of the printer. Or 
no password has been set on the printer.

Resolution: Set password on the printer and make sure it matches the sign in profile.

No Printix Client acts as proxy on this network
This network has no Printix Client to facilitate the communication from the Printix Cloud to the 
printer.

Resolution: Bring a computer with Printix Client online on the printer's network.

Changed Go configuration does not take effect
If you change or modify a Go configuration, it will not take effect on the printer until you apply the 
changes to the printer.

Resolution: To apply the changes you must Update the Go configuration on the printer.

Printix Go installation status is Failed
On the Printix Go tab on the Printer properties page, the installation Status is Failed.

Resolution: Update the printer firmware to the latest version and try again.
• See also: HP documentation on: HP Enterprise, HP Managed - Update the printer firmware

Brother
• Brother printer displays Error: 80015

Brother printer displays "Error: 80015"
The sign-in profile does not match the SNMP configuration of the Brother printer.

Resolution: Change your sign-in profile for Printix Go Brother. An SNMP configuration must be 
selected in the sign-in profile and the specified parameters must match the parameters of the 
printer. The parameters of the printer can be found on the Setup tab of the Printer properties page.

Epson
• Epson printer displays (Error: 204) Please try to reload the page or contact your administrator

Epson printer displays "(Error: 204) Please try to reload the page or contact 
your administrator"
The ID code (and/or PIN code) you entered in Sign in is wrong. This is also the case if you used a 
card to sign in, and then entered a wrong PIN code.

Resolution: Sign in with the correct ID code (and PIN code). The codes can be seen in Printix App on 
the Cards and codes page.
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Fujifilm
• Fujifilm printer says: Unknown vendor is detected
• Fujifilm printer only offers ID code as sign-in method, even though a card reader is installed
• Installation of Printix Go Fujifilm fails
• Fujifilm printer is unable to release Print and Print Later documents

Fujifilm printer says: Unknown vendor is detected
This occurs if computers on the printer's network do not have the minimum required version of 
the Printix Client. In this case, the Printix Client is unable to collect the vendor information of the 
printer, preventing the installation of Printix Go.

Resolution: Ensure that computers on the network use the latest version of the Printix Client.

Fujifilm printer only offers ID code as sign-in method, even though a card 
reader is installed
This can occur if the sign-in method of the Go configuration is set to Select automatically.

Resolution 1: If users must only sign in with card, update the sign-in method of the Go configuration
to Card instead of Select automatically.

Resolution 2: If users can also sign in with ID code:
1. Restart the printer.

If the printer is in Power Saver mode, you can wake up the printer instead of restarting it.
2. Sign in to the printer with ID code once.

When the user signs in to the same printer next time, the user will be able to sign in with card.

Installation of Printix Go Fujifilm fails
Background tasks running on the printer might prevent successful installation if the printer is not in 
Power Saver mode when the installation is started.

Resolution:
1. While the printer is on, press the Power button and select Enter Power Saver on it.

The printer enters Power Saver mode.
2. Start the installation again.

Fujifilm printer is unable to release Print and Print Later documents
You must perform these steps on each computer.

1. In the print queue properties of Printix Administrator, on the Drivers tab, ensure that you are 
using a Fujifilm (FF) print driver.

2. On your Windows control panel, open the printer properties.
3. Select the Configuration tab and open Accounting.
4. For Accounting system, select None, then confirm and save the settings.
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HP
• HP Access Control web page settings discrepancy
• HP printer displays The item is restricted
• HP printer says: Sign-in failed. The default sign-in method (Printix) is currently unavailable…
• HP printer displays USB error
• Printing a large document fails and takes hours to recover if an HP Workpath printer loses 

connection to the Printix Client
• Native scan does not appear to be locked for guests, even though the Go configuration restricts it 

on HP Workpath printers
• HP printer displays WRONG_AUTHENTICATION_STATE
• Printix Capture fails to complete on an HP printer

HP Access Control web page settings discrepancy
If you sign in to the HP printer's web page, select Security and then select Access Control, you will 
see the text:
• Some security settings on this page are unavailable because they are managed by Printix Go.

This means that the settings shown on the HP printer's web page are not necessarily reflecting what 
is being applied by the Printix Go configuration. The printer's touchscreen control panel should 
reflect what has been configured with Printix Go.

HP printer displays "The item is restricted"
On the HP printer, when you try to sign in, you get the error message The item is restricted. Try 
using another account, or contact the system administrator or the person who set up the product.

Resolution: See How to get Application ID from a Printix Go HP printer and then submit a support 
request.
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HP printer displays "Sign-in failed. The default sign-in method (Printix) is 
currently unavailable"
On the HP printer, when you select an application, you get the error message The default sign-in 
method (Printix) is currently unavailable. Choose an alternate method and sign in again. This can be 
caused by the printer's date, time and time zone not being set correctly. It is particularly important 
to set this correctly of a reset to factory settings. If the date and time is off the certificates does 
not work. Another possibility is that the printer's default gateway is not set correctly and therefore 
blocks communication to the Printix Client/Printix Cloud.

Resolution: Set the correct date and check that the default gateway is correct.

HP printer displays "USB error"

The printer will report USB error if:
• An otherwise supported card reader is connected to the HP printer before Printix Go is installed.
• An unsupported card reader is connected to the HP printer even after Printix Go is installed. Try 

to get the card reader's vendor ID and product ID.

880



Tungsten Printix Administrator Guide

Printing a large document fails and takes hours to recover if an HP Workpath 
printer loses connection to the Printix Client
If the Printix Client loses connection to the Internet while printing a large document on an HP 
Workpath printer and you restore the network connection while the printer is still attempting to 
print, the document takes hours to recover from "Printing" state, and it eventually fails. If you print 
less than 10 pages, you only need to wait a few minutes instead of hours. The document that failed 
to print is highlighted in orange color.

Native scan does not appear to be locked for guests, even though the Go 
configuration restricts it on HP Workpath printers
If Scan is restricted by the Go configuration on HP Workpath printers, the native Scan button on the 
printer does not appear locked to guests. However, when a guest tries to use the scan function, all 
scan functions are locked.

HP printer displays "WRONG_AUTHENTICATION_STATE"
If the printer displays WRONG_AUTHENTICATION_STATE, it might be because the Print or Capture
application was selected to be the Home screen of the printer. These options are not supported.

Resolution: Change the Home Screen App to HP:
1. Open the printer's web page and Login as administrator.
2. On the General tab, go to Control Panel Customization > Home Screen Customization.
3. In Home Screen App, select HP.

Printix Capture fails to complete on an HP printer
During the capture process, a computer on the printer's network is randomly assigned to 
temporarily store the captured file. If you see the error message "Capture failed (Scan). Reason: 
Unexpected error encountered when starting scan on printer" on a HP printer, it might be because 
the assigned computer has a name that contains invalid characters.

Resolution: Change the name of computers on the printer's network to only contain ASCII 
characters. If you only want to change the name of the computer that caused the problem, contact 
Printix Support to help find it.

Konica Minolta
• Konica Minolta printer displays Error: 500
• Konica Minolta printer will not install
• Konica Minolta printer displays Certificate security credentials could not be verified
• Printix Capture fails to complete on a Konica Minolta printer

Konica Minolta printer displays "Error: 500"
On the Konica Minolta printer when you Sign in, you get the message 500 Internal Server Error. 
Printix Administrator may show the message: Cannot be done while someone is also signed in on 
the printer's web page.
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Resolution: This will happen if an administrator is signed in to the printer's web page at the same 
time. Wait until the administrator is signed out and try again after another 60 seconds (the printer's 
inactivity timeout).

Konica Minolta printer will not install
This can happen if the prerequisites are not met. To help you troubleshoot further, open the Printer 
properties page, select Verify sign in profile, then open the History tab and look for items that 
could have failed.

Examples:
• WebBrowser should be enabled
• OpenAPI enabled
• OpenAPI 'SSL only' enabled
• OpenAPI SSL port is 50003
• OpenAPI 'Setup v5.1' available

If the TCP Socket Setting is not configured correctly, the History may include entries such as:
OpenAPI communication returned 'SSL' (FAIL) and OpenAPI communication returned 'Error:Already.

Konica Minolta printer displays "Certificate security credentials could not be 
verified"
Resolution: In the Web Browser Settings, allow the printer to connect to the contents.

1. Open the printer's web page and Login as administrator.
2. Select System Settings in the main menu.
3. Select Web Browser Setting.
4. Select SSL Certificate Verification error settings.
5. For OpenAPI - IWS Application, select Connect to the contents.

Printix Capture fails to complete on a Konica Minolta printer
During the capture process, a computer on the printer's network is randomly assigned to 
temporarily store the captured file. If you see the error message "Capture failed (Scan). Reason: 
Unexpected error encountered when starting scan on printer" on a Konica Minolta printer, it might 
be because the assigned computer has a name that contains invalid characters.

Resolution: Change the name of computers on the printer's network to only contain ASCII 
characters. If you only want to change the name of the computer that caused the problem, contact 
Printix Support to help find it.

Kyocera
• Guest users can access third-party functions on a Kyocera printer
• A printer alert appears when you want to use a Kyocera printer
• Home button does not respond while signing in to a Kyocera printer
• Printing a large document fails and takes hours to recover if a Kyocera printer loses connection to 

the Printix Client
• Printix Go fails and KYOCERA Net Viewer says: Device status error - Add toner
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• KYOCERA Net Viewer says: User does not exist (or it says: The application is not yet configured)

Guest users can access third-party functions on a Kyocera printer
In Printix Administrator, if only Everything else is selected in the Access control settings in the Go 
configuration, guests can use third-party functions on a Kyocera printer.

A printer alert appears when you want to use a Kyocera printer
If you sign in to a Kyocera printer and use a printer function (for example, print or copy) while the 
printer has any printer alerts (for example, Tray Empty, Toner Out, or Paper Jam), the printer alerts 
appear instead of the preferred function. While seeing the alerts, nothing happens when you select
Logout.

Resolution: Resolve the printer alerts before using any of the printer functions.

Home button does not respond while signing in to a Kyocera printer
While signing in to a Kyocera printer, selecting the Home button has no effect. The sign-in process 
is not cancelled and the Home screen is not displayed until completing the sign-in process. This 
scenario applies to all screens during sign-in, including the screen for forgotten codes.

Printing a large document fails and takes hours to recover if a Kyocera 
printer loses connection to the Printix Client
If the Printix Client loses connection to the Internet while printing a large document on a Kyocera 
printer and you restore the network connection while the printer is still attempting to print, the 
document takes hours to recover from "Printing" state, and it eventually fails. If you print less than 
10 pages, you only need to wait a few minutes instead of hours. The document that failed to print is 
highlighted in orange color.

Installation of Printix Go fails and KYOCERA Net Viewer displays "Device 
status error - Add toner"
If no toners are available in a Kyocera printer while installing Printix Go with KYOCERA Net Viewer, 
the installation fails, and the following reason is given: Device status error (Add toner).

Resolution: Add toners to the Kyocera printer before installing Printix Go on it.

KYOCERA Net Viewer says: User does not exist (or it says: The application is 
not yet configured)
The KYOCERA Net Viewer displays the message User does not exist until Printix Go is properly 
installed. On newer versions, the message The application is not yet configured is displayed instead.

Resolution: Continue the installation of Printix Go.

Lexmark
• Lexmark printer displays Error: WRONG_AUTHENTICATION_STATE
• Card reader not registered on Lexmark printer
• Printer functions are locked on a Lexmark printer, even though Printix Go is uninstalled
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• Installation or update failed

Lexmark printer displays "Error: WRONG_AUTHENTICATION_STATE"
This can happen if access control has not been configured on the Lexmark printer.

Resolution: Configure access control on the Lexmark printer.

Card reader not registered on Lexmark printer
The connected card reader has not been registered and does not appear on the Printer properties
page.

Resolution: Keep the card reader connected and restart the printer. Alternatively, you can just 
restart the Printix Print app:

1. Open the printer's web page and Log in as administrator.
2. On the menu, select Apps.
3. Select Print.
4. Select Stop and OK to stop Printix Print.
5. Select Start and OK to restart Printix Print.
6. Verify that the card reader is now registered on the Printer properties page.

Printer functions are locked on a Lexmark printer, even though Printix Go is 
uninstalled
Some printer functions request a user name and a password to be used, even though Printix Go is 
uninstalled. This occurs if access control was previously configured using Printix.

Resolution: Install Printix Go with a Go configuration that does not lock any printer functions, then 
optionally, uninstall Printix Go again.

Installation or update failed
While installing or updating the Printix Go Lexmark configuration, if you press Install/Update more 
than once on a tenant, you might receive the following error message: "The printer was not at the 
ready state. It may have an active intervention or somebody else may be in the process of flashing 
or printing."

Resolution: Do not press Install/Update until the first installation or update is complete. If you 
receive the error, wait for 10 minutes or reboot the device then try again.

Ricoh
• Ricoh printer displays Whitelabel Error Page
• Ricoh printer displays Webpage not available
• Installation status is Failed
• Installation status is Installed, but nothing seems to be installed
• Uninstallation status is failed
• Documents do not print when released at the Ricoh printer
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• Printing a large document fails and takes hours to recover if a Ricoh printer loses connection to 
the Printix Client

• Capture is not uninstalled from Ricoh printer
• Ricoh printer cannot get through the loading screen when attempting to log in
• History tab in Printix Administrator shows wrong step if Printix Go Ricoh installation fails
• Scan to email does not auto populate the To field with the user's name on a Ricoh printer
• Guest users can access functions they are not supposed to on a Ricoh printer
• The version number for Printix Go Ricoh is different on the printer's web page
• Printix cannot register a Ricoh printer
• The Printix Capture icon disappears from a Ricoh printer
• The Ricoh printer's Scan function cannot be used
• Failure occurs after installing or uninstalling Printix Go Ricoh

Ricoh printer displays "Whitelabel Error Page"
This can happen if the installation of Printix Go has not completed or if Printix Go has been 
uninstalled.

Resolution: On the printer's touchscreen, select Logout to close the message. The Printix Go sign in 
screen should appear if Printix Go has been installed.

Ricoh printer displays "Webpage not available"
Happens after a printer restart (installation) because the printer tries to load the web page before it 
has established its network connection.

Resolution: On the printer's touchscreen, select Login to refresh the page and close the message. 
The Printix Go sign in screen should appear if Printix Go has been installed.

Printix Go on the printer has not yet been configured.

Resolution: Open the Printer properties of the printer, select the  Printix Go  tab, and select Install
or Update.

Communication is blocked to Printix Cloud URLs (device-api.printix.net and/or api.printix.net).

Resolution: Test communication to Printix Cloud and unblock URLs.

Installation status is Failed

 If the Ricoh printer has some kind of error/warning, such as waiting for paper to be loaded, it 
can also prevent successful installation. Ensure the printer is idle (Status icon is  green in Printix 
Administrator), then try again.

On Ricoh, the Status changes to Installing as the installation takes 10–25 minutes (printer restarts 
2 times). If the installation fails, the status changes to Failed. To help you troubleshoot further, open 
the History tab on the Printer properties page and look for items that could have failed.

Printix Go programmatically preconfigures the following:
• ACCESS_CONTROL__SDK_CERTIFICATION_DEVICE: "1"

885



Tungsten Printix Administrator Guide

• ADMINISTRATOR_AUTHENTICATION_MANAGEMENT__MACHINE_ADMINISTRATOR_AUTHENTICATION_SETTING: 
"1"

• ADMINISTRATOR_AUTHENTICATION_MANAGEMENT__USER_ADMINISTRATOR_AUTHENTICATION_SETTING: 
"1"

• USER_AUTHENTICATION_MANAGEMENT: "4"
• MF_KEYCARD_JOB_PERMIT_SETTING: "1"
• ACCESS_CONTROL__DETAIL_OPTION: "0"
• ACCOUNTING_COUNTER: "1"
• OPTIONAL_COUNTER_TYPE__DEFAULT_OPTIONAL_COUNTER_TYPE: "0"
• OPTIONAL_COUNTER_TYPE__EXTERNAL_OPTIONAL_COUNTER_TYPE: "0"
• PRINTER_JOB_AUTHENTICATION_LEVEL: "0"
• AUTO_DELETE_USER_IN_ADDRESS_BOOK: "1"
• TRACK_PERMISSION: "0"
• STOP_PRINT_SETTING: "0"
• MACHINE_ACTION_WHEN_LIMIT_REACHED: "0"
• USER_AUTHENTICATION__PRINTER: "1"
• USER_AUTHENTICATION__COPY: "0"
• USER_AUTHENTICATION__FAX: "0"
• USER_AUTHENTICATION__SCANNER: "0"

Installation fails:
• HTTP communication on port 80 is not open.

Resolution: Set up the SSL/TLS communication correctly.

Installation fails with: unable to find valid certification path to requested target (FAIL):
• SSL/TLS communication is not set up correctly.

Resolution: Set up the SSL/TLS communication correctly.

Installation can fail in Step HOMESCREEN if:
• The default password (ricoh) for the web server has been changed. This scenario applies to Ricoh 

SOP printers Generation 2.
Resolution: Set the web server password to the default.

A Windows 10 ×64 or 11 computer (Server, Desktop, or Laptop) must be online on the printer's 
network.

Installation status is Installed, but nothing seems to be installed
On Ricoh, the Status changes to Installing as the installation does take 10–25 minutes (printer 
restarts 2 times). To help you troubleshoot further, open the History tab on the Printer properties
page. If History does not contain steps such as Step INSTALL, it is an indication that it did not 
succeed, or at least the status was not communicated back to the Printix Cloud.

Resolution: Do an Uninstall (wait 5–10 minutes) and then try to install again. If it still fails, check 
that the printer is running the latest firmware version, and if not, then update the firmware (may 
take ½ hour to an hour).
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Uninstallation status is failed
On Ricoh, the Status changes to Uninstalling as the uninstallation takes 5–10 minutes (printer 
restarts 1 time). If the uninstallation fails, the status changes to Failed. To help you troubleshoot 
further, open the History tab on the Printer properties page and look for items that could have 
failed.

Documents do not print when released at the Ricoh printer
Printer Job Authentication is not Simple (All) on the printer's web page.

Resolution: Select Device management > Configuration > Device Settings > User Authentication 
Management, and for Printer Job Authentication, select Simple (All).

Printing a large document fails and takes hours to recover if a Ricoh printer 
loses connection to the Printix Client
If the Printix Client loses connection to the Internet while printing a large document on a Ricoh 
printer and you restore the network connection while the printer is still attempting to print, the 
document takes hours to recover from Printing state, and it eventually fails. If you print less than 
10 pages, you only need to wait a few minutes instead of hours. The document that failed to print is 
highlighted in orange color.

Capture is not uninstalled from Ricoh printer
The capture application appears on a Ricoh printer, even though the printer is not configured to 
have capture functionality. In this case, the application does not work properly.

This can happen if Printix Go was uninstalled from a Ricoh printer that had capture functionality 
enabled, or if the Go configuration was overwritten to only have print functionality enabled.

Resolution 1:

1. Open the printer's web page and log in as administrator.

2. On the menu, select Device Management, and then Configuration.

3. In the Extended Feature Settings section, select Uninstall.

4. Browse through the list and select Printix Capture and select Uninstall.

Resolution 2:

1. Temporarily, assign a Go configuration with capture functionality to the Ricoh printer.

2. Uninstall Printix Go from Printix Administrator.

3. Assign a new Go configuration to the printer without capture functionality.

4. Install Printix Go again.

Ricoh printer cannot get through the loading screen when attempting to log 
in
When attempting to log in to a Ricoh printer, you cannot proceed to card or ID code authentication, 
because the printer cannot get through the loading screen. This can happen for multiple reasons:
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Reason 1: The printer was previously assigned to a network with no active computers, and later, the 
Go configuration was updated. This problem can persist even after changing to a network with at 
least one active computer.

Resolution 1:
1. Connect the printer to a network with at least one active computer.
2. Make sure a Go configuration is assigned to the printer.
3. Install Printix Go.
4. Make sure the printer's Auto Logout Timer is less than the Sleep Mode Timer.

Reason 2: After a printer restart (installation), the printer tries to load the web page before it has 
established a network connection.

Resolution 2: On the printer's touchscreen, select Login to refresh the page and close the message. 
The Printix Go sign-in screen should appear if Printix Go has been installed.

History tab in Printix Administrator shows wrong step if Printix Go Ricoh 
installation fails
This can happen in multiple scenarios. For example, Printix Go Ricoh installation fails if all Printix 
Client computers on the printer's network are offline. In this case, the History displays that 
installation failed in step 2, even though it never even advanced beyond step 1.

Scan to email does not auto populate the To field with the user's name on a 
Ricoh printer
When using the printer's scan to email function on a Ricoh printer, the To field is not auto populated 
with the logged in user's name.

Resolution: Setup scan to email according to this topic. If the problem persists, check your printer 
manual whether the setting Login User Address Priority is supported. Contact Ricoh support if the 
details are not found in the manual.

Guest users can access functions they are not supposed to on a Ricoh printer
Guest users can access functions that are locked in the Access control section of the Go 
configuration.

Resolution:
1. Open the printer's web page and log in as administrator.
2. In the Device Management menu, select Address Book.
3. Select the check box of the printix_guest user.
4. Select the Detail Input tab, then select Change.
5. In Authentication Information and under Available Functions, make sure none of the check 

boxes are selected.
6. Save the changes.

If the issue is still not fixed, try the following steps too:
7. On the Change User page under the Protection section, select Change next to Access 

Privilege.
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8. Under Public and All Users, make sure none of the check boxes are selected.
9. Select OK.

The version number for Printix Go Ricoh is different on the printer's web 
page
When uninstalling a Printix component from a Ricoh printer's web page (for example, Printix 
Capture), you might see a version number that is different from what is mentioned in Printix 
Administrator.

For example, you might see version 2.0.0.X in Printix Administrator but version 2.0.X on the printer's 
web page.

Printix cannot register a Ricoh printer
If a Ricoh printer has no IPP settings, Printix cannot automatically add it to the list of printers. The 
printer is then listed as an unregistered printer.

Resolution: Register the printer manually.

The Printix Capture icon disappears from a Ricoh printer
Within four seconds after signing in to a Ricoh printer, the Printix Capture icon disappears from 
the printer's touchscreen control panel. Without the icon, capture functions cannot be accessed on 
the printer.

Resolution:
1. Sign in to the printer as an administrator.
2. Open the Settings.

It may not be on the first page of the printer.
3. Select System Settings.
4. On the left pane, select Settings for Administrator.
5. Scroll down and select Authentication/Charge.
6. Select Administrator Authentication/User Authentication/App Auth.
7. Select User's Own Customization.
8. Set User's Own Customization to Prohibit.

The Ricoh printer's Scan function cannot be used
On some Ricoh printers, the installation of Printix Go changes the configuration of the printer, and 
the printer's Scan function cannot be used as a result.

Resolution:
1. Open the printer's web page and sign in as administrator.
2. In the Device Management menu, select Configuration.
3. In the Scanner section, select General Settings.
4. Change the Print & Delete Scanner Journal setting to one of the following:

• Print and Delete All
• Do not Print: Delete Oldest
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5. Select OK.

Failure occurs after installing or uninstalling Printix Go Ricoh
A failure might occur if you perform certain operations too quickly after installing or uninstalling 
Printix Go on Ricoh.

Resolution: Some Ricoh devices, such as IM 460F or IM 370F, require more time after completing an 
install or uninstall.
• After installing, wait 20 minutes before performing another installation or update.
• After uninstalling, wait 20 minutes before performing another installation.

Xerox
• Xerox printer displays Could not log in
• After uninstalling Printix Go, Xerox VersaLink printer says: Internal Server Error
• Xerox card reader does not recognize card
• Printix Go cannot be updated or uninstalled and Xerox printer says: Internal Error

Xerox printer displays "Could not log in"
This can happen if the printer was not restarted after the installation or update of Printix Go.

Resolution: Restart the printer.

After uninstalling Printix Go, Xerox VersaLink printer displays "Internal 
Server Error"
This can happen if the printer was not restarted after the uninstallation of Printix Go.

Resolution: Restart the printer.

Xerox card reader does not recognize card
This can happen if the printer was not restarted after the installation or update of Printix Go.

Resolution: Restart the printer.

Printix Go cannot be updated or uninstalled and Xerox printer displays
"Internal Error"
When you try to log in to a Xerox printer, you get the internal error message Unable to proceed. Try 
again. If the problem persists, contact your local System Administrator. Furthermore, sometimes 
if you select Update or Uninstall on the Printix Go tab in Printix Administrator, an internal server 
error appears and the update or uninstallation fails.

These can happen if Print is set as the default walkup screen.

Resolution for AltaLink printers:

1. In Properties, select General Setup.

2. In Entry Screen Defaults, set the default walkup screen to be anything other than Print.
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Resolution for VersaLink printers:

1. Select Apps.

2. In Preferences, set the walkup screen to be anything other than Print.

How to test communication to Printix Cloud from the printer
Printix Go on the printer needs to be able to communicate to the Printix Cloud Internet endpoints:
• https://device-api.printix.net
• https://api.printix.net
• https://on-device-printer-sign-in.printix.net
• https://on-device-printer-release-documents.printix.net

You need to open the web browser on the printer. If the printer does not have web browser, try 
to access the Internet endpoints from a computer on the printer's network. See the printer's 
documentation on how to open the web browser. If Printix Go is already installed and sign in is 
required to access any function, including the web browser, you may need to Uninstall Printix Go
from the printer to perform the tests. To perform the tests on Ricoh printers, you can sign in as 
machine administrator and then open the web browser.

1. On the printer's touchscreen, open the web browser.
• In the browser, type: https://device-api.printix.net/ws/ok

If communication works, you should see a padlock next to the address and a page showing
ok.

• In the browser, type: https://on-device-api.printix.net/ws/ok
If communication works, you should see a padlock next to the address and a page showing
ok.

• In the browser, type: https://api.printix.net
If communication works, you should see a padlock next to the address and a page showing 
two brackets {}.

• In the browser, type: https://on-device-printer-sign-in.printix.net
If communication works, you should see a padlock next to the address and a page showing a 
red circle with an exclamation mark.

• In the browser, type: https://on-device-printer-release-documents.printix.net
If communication works, you should see a padlock next to the address and a page showing a 
red circle with an exclamation mark.

2. If communication fails, you need to have your network administrator unblock/whitelist the 
Internet endpoints (complete list of Internet endpoints).

See also:
• About the Internet endpoints device-api.printix.net and on-device-api.printix.net

How to troubleshoot scan to email
Use Telnet from the command line to troubleshoot scan to email.
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Install Telnet Client
These instructions apply to Windows 10 and 11.

1. Open the Control Panel and select Programs and Features.
2. Select Turn Windows Features on or off.
3. Scroll down the list and select Telnet Client.
4. Select OK.

Send email from the command line via Telnet
Connect to the SMTP server:

1. Open a Command prompt.

2. To connect to the SMTP server (example: acme-com.mail.protection.outlook.com) on port 25, 
type:
telnet acme-com.mail.protection.outlook.com 25

Replace acme-com.mail.protection.outlook.com with your SMTP server address.
Should respond with its welcome banner.

Send the HELO command:

Some mail servers will accept the HELO on its own, others will require you to also provide a host or 
domain name along with it.

1. To send the HELO command, type:
helo acme.com

Replace acme.com with your email domain.
Should respond with Hello.

Use the MAIL FROM command:

1. Use the MAIL FROM command to specify the sender. Type:
mail from: john@acme.com

Replace john@acme.com with a valid email address.
Should respond with Sender OK.

Use the RCPT TO command:

1. Use the RCPT TO command to specify the receiver. Type:
rcpt to: jane@acme.com

Replace jane@acme.com with a valid email address.
Should respond with Recipient OK.

Use the DATA command to send data:

1. Use the DATA command to send data. Type:
data
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If you just want to send a blank message, type a period (.) and press Enter. Otherwise, you can 
set a subject line for the message if you want. Use SUBJECT and then type your subject line, 
and press enter.
Should respond with Start mail input; end with ..

2. Use SUBJECT and end message with period.
subject: this is a test.

Should respond with Queued mail for delivery.

How to investigate Printix Go screen layout issues
1. Open the Sign in with ID code dialog box.
2. Select the C (clear) key 4 times consecutively.

This will present information about the screen resolution and web browser.

 Selecting the C key 4 times in the Sign in with PIN code dialog box will also present the 
information.

3. Take a photo of the screen and attach it to your support request.
4. Select the presented information to make it disappear.
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Chapter 16

Error messages

In this topic, you can read about possible error causes and solutions.

• An error occurred
• Connecting to service

• Email already exists
• Email domain is not allowed
• Email invite has already been used or is expired
• Email is too large

• Fetching data
• Found no printers compatible with your computer

• ID provider not found
• ID provider does not match
• Image is too large
• Item does not exist

• Missing print driver
• Missing printer information

• No Printix Client acts as proxy on this network
• No connection to Active Directory server
• No connection to Microsoft Entra server
• No printer port selected on Windows
• No printers to add
• Not responding

• Permission denied
• Print issues
• Printer already exists

• Restriction for modifying multiple items exceeded

• Sign in issues
• Wrong ID code
• Wrong PIN code

• Tenant already exists
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• Tenant does not exist
• This is not a printer
• Timeout

• Unable to perform action while Printix Client is on an unknown network
• Unknown model name
• Unknown reason
• User already exists
• User does not exist
• Username or password is wrong

No Printix Client acts as proxy on this network
This network has no Printix Client to facilitate the communication from the Printix Cloud to your
network.

Resolution:
• Start Printix Client on your computer.
• Install Printix Client on at least one computer that is powered on at all times.
• If your company has multiple sites and/or separate network exist, a Printix Client should be 

running on each network.
• If you get this message despite computers being online on the network, it could be that one 

or more of the gateways of this network are wrong. Talk to you network administrator. To 
troubleshoot, you can try to delete that gateway from the network, and then select Unknown 
networks and open the Gateway properties page and select the Computers tab to check which 
computers are using the gateway (probably none, if it was a wrong gateway). Otherwise, add the 
gateway to the network again, and try the next one.

See also:
• I started a trial at home, but why does it not work at my company?

If none of the above resolves the problem within 5 minutes, report the problem to our support, so 
we can help you.

Unable to perform action while Printix Client is on an 
unknown network

You have selected Discover printers on the Computer properties page, but the computer is 
unable to perform this, because it is currently on an unknown network.

Resolution: Discover printers from the Printers page.
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Connecting to service
The Printix Client is trying to connect to the Printix Service on the computer. The message typically 
appears for a few seconds, followed by the message:Fetching data. However, if the message is 
displayed for several minutes, it could be because:
• Blocked by Antivirus product
• Printix Client for Mac reports: Connecting to service
• Printix Client for Mac reports: The Printix Client could not be started
• Printix Service is stopped

Blocked by Antivirus product
Antivirus products are constantly having their definitions updated, and this may lead to an incorrect 
classification of the Printix Client software as malware.

Resolution: See your Antivirus product documentation on how to make exclusions for the Printix 
Client. Typically, you need to do this for:
• Folder: C:\Program Files\printix.net\Printix Client\*
• File: C:\Program Files\printix.net\Printix Client\PrintixClient.exe
• File: C:\Program Files\printix.net\Printix Client\PrintixService.exe
• Processes: C:\Program Files\printix.net\Printix Client\PrintixClient.exe
• Processes: C:\Program Files\printix.net\Printix Client\PrintixService.exe

If an Antivirus product has quarantined the PrintixService.exe and/or removed it, you may have to 
install the Printix Client again. You can download both the EXE and MSI from the Software page.

Antivirus software might also mistakenly set alerts for:
• File: C:\Program Files\printix.net\Printix Client\PrintixServiceTask.xml

This XML file is used for situations where the PrintixClient.exe finds that the Printix Service is 
not running, and then it can use this to start the Printix Service with the command: net start 
PrintixService.

It is expected behavior for PrintixClient.exe to use SNMP and do a network discovery. Also, it uses 
the commands:
• netsh wlan show interfaces

• arp -a

Printix Client for Mac reports: Connecting to service
If you have run, for example, CleanMyMac or a similar product, this may have broken the Printix 
Client installation on the Mac.

Resolution: In Activity Monitor, find Printix Service and Force Quit it, then install the Printix Client 
again.
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Another reason can be if localhost is not configured on the computer.

1. Select the search icon in the top right corner.

2. Type: terminal, and press Enter.

3. In the Terminal window, type: ping localhost.

Resolution: If you get no response from ping, then open Finder.

1. Select the search icon in the top right corner.

2. Type: finder, and press Enter.

3. In Go to the folder, enter /private/etc/hosts.

4. Select Go.

5. Select and drag the hosts file and drop it on the desktop.
You can freely edit the file on the desktop.

6. Open the hosts file in, for example, TextEdit, and add the line: 127.0.0.1 localhost.

7. Save the file.

8. Select and drag the edited hosts file and drop it on the /private/etc folder in Finder.

Printix Client for Mac reports: The Printix Client could not be started
This can occur if an earlier version than 5.4.1 of Mono is installed on the Mac. Printix Client 
will, during startup, generate a certificate that is used for internal (within the computer itself) 
communication. On Mac computers, this is done using the Mono framework. The Mono framework 
is a C# emulating framework where you can execute C# (.Net) code on a Mac or Linux computer. 
The PrintixService.log will typically include the error message: Input data cannot be coded as a valid 
certificate.

Check if an older version of Mono is installed. Use the keyboard shortcut to open Finder and go to 
the folder:

1. Press Shift+Command ⌘+G.
2. In Go to the folder, enter /Library/Frameworks/Mono.framework/Versions.
3. Select Go.
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If an older version (2.10.9) is installed, use the below commands to remove it:
4. Select the search icon in the top right corner.
5. Type: terminal, and press Enter.
6. To uninstall the Printix Client, type:

sudo /Users/Shared/.Printix.net/Service/uninstallMac.sh

7. To navigate to /Library/Frameworks/Mono.framework/Versions, type:
cd /Library/Frameworks/Mono.framework/Versions

8. To remove the Current folder, type:
sudo rm Current

9. To link the 5.4.1 version to Current, type:
sudo ln Current /Library/Frameworks/Mono.framework/Versions/5.4.1

10. Reinstall the Printix Client, and verify that it is working.

Printix Service is stopped

 When the Printix Client is unable to connect to the Printix Service on the computer, a red circle 
with a line will be displayed on the Printix Client icon .

Resolution: Start the Printix Service or restart the computer. You may also want to check if another 
process is using the ports 21338 and 21339. Submit a support request if it keeps happening. Include 
the name of the computer and the approximate time, when this happened. If possible, also supply 
the following from the computer that seems to be stuck in Connecting to service:
• Windows logs
• Printix Client logs

How to check what ports are in use on Windows
1. Open a command prompt and type: netstat -ab -p TCP.
2. In the output, look for ports 21338 and 21339.
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3. Look for the name of the process that uses the ports. If the process is System or 4, restart the 
computer.

How to check what ports are in use on Mac
1. Select the search icon in the top right corner.
2. Type: Network Utility, and press Enter.
3. Select the Port Scan tab.
4. In IP address, type: 127.0.0.1.
5. Select Scan.
6. Look for the name of the process that uses the ports.

No printer port selected on Windows
On a Windows computer, when you open the Printer properties dialog box and select the Ports
tab, the Printix printer does not have a selected Internet port.

Resolution: Enable Internet Printing Client on the computer.

When Printix Client is installed, it should automatically enable Internet Printing Client on the 
computer. However, there might be a policy on the computer that prevents this Windows feature 
from being turned on.

1. Open the Control Panel and select Programs and Features.
2. Select Turn Windows feature on or off.

3. In the Windows Features dialog, scroll to and expand Print and Document Services.
4. Select Internet Printing Client.
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5. Select OK.
6. Restart the computer.

An error occurred
An unknown error occurred.

Resolution: Try again. If the problem persist, report the problem with as much detail as possible.

Item does not exist
• The printer, user, or computer you are modifying has meanwhile been deleted, perhaps by 

another user with administrative rights.
Resolution: The list with the item, for example, the list of printers, is automatically refreshed. 
After the refresh, the item you were working on should be gone from the list. To find out more 
about the deleted item, use History .

• Attempting to access the Printix Download page (Example: https://acme.printix.net/download), 
but the tenant name (acme) does not exist or is misspelled.
Resolution: Enter the correct download address in the web browser.

User already exists
User is already added.

Resolution: Do not add the user again.

User does not exist
The user does not exist. The user may have been deleted.

Resolution: Refresh the list of users. After the refresh, the user you were working on should be gone 
from the list. To find out more about the deleted user, use History .

User name or password is wrong
Sign-in reports: Username or password is wrong.

Resolution: Enter your correct user name and password. If you registered with your email address, 
enter your email address as the user name.
• See also: How to reset your password
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Email already exists
The email is already in use.

Resolution: Use another email.

Email domain is not allowed
You are trying to self-register, but your email is not allowed.

Resolution: Contact an administrator and ask to be invited.

Email invitation has already been used or is expired
The link in the email can only be used once for activation, and it must happen within 72 hours.
• You signed up and got your Printix Home, but you did not download, install, and sign in to the 

Printix Client on a Windows or Mac computer, and now you have tried to resume the setup by 
selecting the Get started link in the email with the subject Welcome to Printix.
Resolution: Open the email with the subject Get started with Printix, then resume and complete 
the setup. Use a Windows or Mac computer to complete the steps described in Getting started.

• You have already registered by selecting Get started in the email with the subject Welcome to 
Printix, but you did not download the Printix Client.
Resolution: Open the email with the subject Get started with Printix, then use a Windows or 
Mac computer to complete the steps described in Install Printix Client.

• More than 72 hours passed before you selected Get started in the email with the subject
Welcome to Printix.
Resolution: Contact the sender and ask for a new invitation email.

No connection to Active Directory server
You cannot sign in with your network user name and password.

Resolution for user: Contact your administrator.

Resolution for administrator:
• Select Active Directory authentication settings.
• A computer with Printix Client must be online on Network1, otherwise, the on-premise Active 

Directory server cannot be contacted for authentication.
• If it does not work with secure LDAPS, it could be a result of certificate errors.
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Secure LDAPS certificate errors
•
•
•

Verify certificates and the certificate chain
Follow the instructions below to verify the certificates on the Active Directory server (Domain 
Controller):

1. Press Windows+R.
The Run dialog box appears.

2. Type: mmc, and select OK to open the Microsoft Management Console.
3. On the File menu, select Add/Remove Snap-in.
4. In the Add or Remove Snap-ins dialog box, select Certificates and select Add.
5. In the Certificates snap-in dialog box, select Computer account and select Next.
6. In the Select computer dialog box, select Another computer, and select Browse.
7. In Enter the object name to select, type the hostname of the Domain Controller. (Example: 

DC01.) Select Check Names.
8. Select OK.
9. Select Finish.

10. Select OK.

11. The Microsoft Management Console now includes the Certificates snap-in for the Domain 
Controller (DC01).

12. Expand Trusted Root Certification Authorities to see a list of the certificates.
13. Open each certificate. Select the Certification Path tab, and select the Certificate status.
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14. Verify that the certificates in the certificate path are stored accordingly in:
• Trusted Root Certification Authorities
• Intermediate Certification Authorities

Import certificate to the local machine certificate store
As the Printix Service (PrintixService.exe) runs under the local system account, the certificate 
used for Secure LDAPS connection, must be in the Local machine certificate store on the users' 
computers. If any of the certificates in the certification path are only stored in the Current user 
certification store, then Active Directory authentication will not work.
• Local machine certificate store

This type of certificate store is local to the computer and is global to all users on the computer. 
This certificate store is located in the registry under the HKEY_LOCAL_MACHINE root.

• Current user certificate store
This type of certificate store is local to a user account on the computer. This certificate store is 
located in the registry under the HKEY_CURRENT_USER root.

To resolve this, the certificate file must be installed on each computer:

 The steps below are the same if you use certmgr.msc instead of mmc. To update multiple 
computers, consider using command line utility, Microsoft Certificate Manager Tool (certmgr.exe).

1. Right-click Trusted Root Certification Authorities, select All Tasks and select Import.
The Certificate Import Wizard appears.

2. Select Next.
3. Browse to and select the folder with the certificate file.
4. Select X.509 Certificate (.cer or .crt) and select All files.
5. Select the certificate file and select Open.
6. Select Next.
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7. Select Browse.
8. In the Select Certificate Store, select Show physical stores.
9. Scroll to the top and select Trusted Root Certification Authorities.

10. Select Local Computer, select OK.
11. Select Next.
12. Select Finish.

Microsoft certificate error codes
• CertEXPIRED = 0×800B0101
• CertVALIDITYPERIODNESTING = 0×800B0102
• CertROLE = 0×800B0103
• CertPATHLENCONST = 0×800B0104
• CertCRITICAL = 0×800B0105
• CertPURPOSE = 0×800B0106
• CertISSUERCHAINING = 0×800B0107
• CertMALFORMED = 0×800B0108
• CertUNTRUSTEDROOT = 0×800B0109
• CertCHAINING = 0×800B010A

The certificate chain up to the Root Certification Authority (CA) is not found or invalid.
• CertREVOKED = 0×800B010C
• CertUNTRUSTEDTESTROOT = 0×800B010D
• CertREVOCATION_FAILURE = 0×800B010E
• CertCN_NO_MATCH = 0×800B010F

The certificate does not contain the name of the host we are trying to connect to.
• CertWRONG_USAGE = 0×800B0110
• CertUNTRUSTEDCA = 0×800B0112

No connection to Microsoft Entra ID
You cannot sign in with your Microsoft work or school account.

Resolution for user: Contact your administrator.

Resolution for administrator: Check Microsoft Entra authentication settings.

ID provider not found
• You tried to sign in with an account that is not configured to work with this Printix Home.
• You selected Sign in with Google, but instead of using your work account, you used your private 

gmail account.
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Resolution: Sign in with the correct account. If this also fails, contact your administrator.

ID provider does not match
• You tried to sign in with an account that is not configured to work with this Printix Home.
• You selected Sign in with Google, but instead of using your work account, you used your private 

gmail account.

Resolution: Sign in with the correct account. If this also fails, contact your administrator.

Permission denied

• You are trying to sign in to Printix Administrator, but your role does not allow this.
Resolution: Do not attempt to sign in to Printix Administrator. Alternatively, contact your 
administrator and ask to have your role changed.

• You are a site manager and you are trying to change a setting you are not allowed to change.
Resolution: Do not attempt to change the setting.

• You are trying to save changes in Printix Administrator, but your Printix account has expired.
Resolution: Add a credit card on the Subscription page. Alternatively, contact us or submit a
support request and we will get back to you.

Wrong ID code
You attempted to sign in at the printer (Printix Go), but you entered the wrong ID code.

Resolution: Try again, but this time, select the Eye  to see the digits entered and verify that they 
are the correct digits.
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See also:
• How to sign in with an ID code at the printer
• How to see and reset the ID code

Wrong PIN code
You attempted to sign in at the printer (Printix Go), but you entered the wrong PIN code.

Resolution: Try again, but this time, select the Eye  to see the digits entered and verify that they 
are the correct digits.

Other PIN code messages:
• PIN code disabled

This message appears after three consecutive, failed sign-in attempts. In this case, you must 
open the Printix App, reset the PIN code, and enter a new and different value. Otherwise, the 
Printix App displays The new PIN code must be different from the previous one.

• Wrong PIN code. Remaining attempts: X
This message appears when the wrong PIN code is entered.

• You need to create a PIN code
This message appears if a PIN code is required but not yet created by the user. You must open 
the Printix App and create a PIN code.

See also:
• How to sign in with an ID code at the printer
• How to sign in with card at the printer
• How to see and reset the ID code
• How to create and reset the PIN code

No printers to add
Printix Client reports: No printers to add.
• Resolution for user: Your computer may be on an unknown network (the Printix Client icon has a 

yellow dot ). Try adding a printer when you are back on a known network. Alternatively, contact 
your administrator.

• Resolution for administrator: Add printer in Printix Administrator.

Found no printers compatible with your computer
No printers are listed in the Printix Client.
• Resolution for user: If a yellow dot is shown on the Printix Client icon , it could be that your 

computer is on an unknown network, probably because you are at home or traveling. Try again at 
work. Otherwise, contact your administrator.
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• Resolution for administrator: No printer driver is selected for the Windows/Mac edition. See How 
to change the print driver.

Printer already exists
The printer you are trying to add is already known by Printix.

Resolution: If you fail to add the printer, delete the printer from the Unregistered printers page 
and then add it again.

Printer registration issues
For troubleshooting, see:
• Discover printers does not find printer
• No Printix Client acts as proxy on this network
• Not responding
• This is not a printer
• Missing printer information
• Missing print driver
• Fetching data
• Unknown model name
• Unknown reason
• Timeout

See also: Unregistered printers

Discover printers does not find printer
• A Discover printers does not add the printer as expected.

Resolution: Confirm the following requirements.
• Ensure that the printer is powered on.
• Ensure that the printer is connected to the network.
• If the printer is on a different subnet than the computer doing the discovery, add a printer 

from that subnet manually, then do a discovery to find additional printers on that subnet.
• Ensure that the printer address is the IP address (such as 192.168.2.10) or hostname of the 

printer.
• The Discover printers process takes a very long time.

• If you run Discover printers on a print server, the process may take several minutes 
depending on the number of printers and subnets.

Resolution: Be patient.
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• The Discover printers process seems to time out.
• During the Discover printers process, the Printix Client uses ping and SNMP to verify the 

connection to the printer and retrieve information about the printer and its properties. If 
networks are switched with certain security features enabled, this could result in the computer 
being temporarily disconnected from the network. This condition may last for several minutes, 
and during this time you would not be able to get Diagnostics from the computer. You can use
SnmpWalk to test that SNMP communication is working.

Resolution: Contact your network administrator.

Not responding
The printer is not responding.

Resolution: Confirm the following requirements.
• Ensure that the printer is powered on.
• Ensure that the printer is connected to the network.
• Ensure that the printer address is the IP address (such as 192.168.2.10) or hostname of the 

printer.

See also: How to give a printer a static IP address

This is not a printer
The entered address does not point to a printer.

Resolution: Correct the address so it points to the printer.

Missing printer information
Unable to get any information from the printer.

Resolution: Confirm the following requirements, then try again.
• Ensure that SNMP is not disabled on the printer.
• Ensure that the communication is not blocked by a firewall.

We recommend to restart the printer after having made changes to its SNMP configuration. You can 
use SnmpWalk to test that SNMP communication is working.

For SNMP communication to work, UDP port 161 must be open. Consult you printer's 
documentation to find out where SNMP is configured on your printer's web page. If the printer does 
not support SNMP, you can use Manual registration on the Unregistered printers page.

Missing print driver
No print driver is selected.

Resolution: Add the print driver to the Printix driver store.
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Fetching data
• Trying to fetch data from the printer, or the Printix Client is trying to contact the Printix Cloud.
• Verify that you can reach the printer, that is, you can ping the printer from a computer with 

Printix Client on the printer's network.

Resolution: Wait until data has been fetched. Submit a support request if the issue persists.
• An unregistered printer displays the message "Fetching data." This is an expected issue with HP 

Gemstone 2 printers.

Resolution: Add the printer manually in Printix Administrator.

Unknown model name
Unable to get the model name from the printer.

Resolution: Confirm the following requirements, then try again.
• Ensure that SNMP is not disabled on the printer.
• Ensure that the communication is not blocked by a firewall.

We recommend to restart the printer after having made changes to its SNMP configuration. You can 
use SnmpWalk to test that SNMP communication is working.

Unknown reason
An unknown reason.

Resolution: Try again. If the problem persist, report the problem.

Timeout
A timeout occurred.

Resolution: Try again.

Capture issues
• Email is too large
• Image is too large
• Capture failed (Scan). Reason: Transfer failed to computer

Email is too large
The attachment to the email is too large. The hard size limit is 25 MB, but as the data is base64-
encoded, the file size limit is closer to 18 MB.
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Image is too large
For capture, the minimum width or height for an image file is 16 by 16 pixels; the maximum is 8400 
pixels (71 cm or 28 inches at the resolution 201 to 600 dpi).

Capture failed (Scan). Reason: Transfer failed to computer
You have been trying to use Printix Capture on HP or Konica Minolta, but the printer is unable 
to reach the Printix Client computer by hostname. This is a requirement, because the printer/
computer scan connection uses secure HTTPS communication, and to avoid having to renew 
certificates whenever the computer changes IP address, it must be possible to reference the 
computer by hostname.
• Computer must have a fully qualified domain name (FQDN).

If the computer is running on a VM, see the Microsoft documentation: Create a fully qualified 
domain name for a VM in the Azure portal.

Ping Windows computer by hostname
Use the below command from another computer on the printer's network to verify that you can 
ping the computer by hostname, that is, the computer that was responsible for the transfer.

1. Open a Command prompt and type: ping {COMPIX.acme.com}
{COMPIX.acme.com} is the computer's fully qualified domain name.

Tenant already exists
You are signing up for Printix, but the text you entered in your Printix Home is already in use by 
another tenant.

Resolution: Change the value and try again.

Tenant does not exist
The web address you are entering is not the Printix Home of your company (acme).
• Example: https://acme.printix.net

Resolution: Correct the web address.

Do not put www in front of the address, because your browser will report the page as not private, 
untrusted, or as having problems with the security certificate.
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